IBM SPSS Modeler Text Analytics
18.1.1 — podrecznik uzytkownika

<||I




Uwaga
Przed skorzystaniem z niniejszych informacji oraz produktu, ktérego one dotycza, nalezy zapoznac¢ si¢ z informacjami zamieszczonymi w

sekcji[“Uwagi” na stronie 217}

Informacje o produkcie

Niniejsze wydanie publikacji dotyczy wersji 18.1.1, wydania 0, modyfikacji 0 produktu IBM SPSS Modeler Text Analytics oraz
wszystkich nastepnych wydan i modyfikacji do czasu, az w kolejnym wydaniu publikacji zostanie zawarta informacja o stosowne;j
zmianie.
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Przedmowa

Produkt IBM® SPSS Modeler Text Analytics oferuje wydajne mozliwosci analiz tekstu, ktore wykorzystuja
zaawansowane rozwiazania lingwistyczne oraz przetwarzanie jezyka naturalnego (NLP, Natural Language Processing)
w celu szybkiego przetwarzania zroznicowanych nieustrukturyzowanych danych tekstowych, a takze wyodrgbniania i
porzadkowania kluczowych poje¢ z uzyskanego tekstu. Ponadto IBM SPSS Modeler Text Analytics moze grupowac te
pojecia w kategorie.

Okoto 80% danych przechowywanych w organizacji ma posta¢ dokumentéw tekstowych i sa to na przyktad raporty,
strony WWW, wiadomosci e-mail i notatki z centrow zgloszeniowych. Tekst jest kluczowym czynnikiem, dzigki
ktéremu organizacja moze lepiej zrozumie¢ zachowania swoich klientow. System, ktory wykorzystuje NLP, moze
inteligentnie wyodrgbniac pojecia, a wérdd nich frazy ztozone. Ponadto znajomos$¢ jezyka bazowego umozliwia
przypisywanie terminéw do powiazanych z nimi grup, takich jak produkty, organizacje i osoby — na podstawie
znaczen 1 kontekstow. W rezultacie mozna szybko okresli¢ istotno$¢ informacji w odniesieniu do konkretnych potrzeb.
Te wyodrebnione pojgcia i kategorie mozna taczy¢ z istniejacymi danymi ustrukturyzowanymi, takimi jak dane
demograficzne, a nastgpnie stosowa¢ w celu modelowania, korzystajac z produktu IBM SPSS Modeler i zawartego w
nim pelnego pakietu narzedzi do eksploracji danych, aby w rezultacie takiego potaczenia podejmowac lepsze decyzje
przy zmniejszonej ilosci zaktdcen.

Systemy lingwistyczne sa zalezne od ilosci wiedzy — im wigcej informacji zawieraja ich stowniki, tym wyzsza jest
jakos¢ wynikow. Produkt IBM SPSS Modeler Text Analytics jest dostarczany z zestawem zasobow lingwistycznych,
takich jak biblioteki, szablony, stowniki terminéw i synoniméw. Ten produkt pozwala na dalsze rozwijanie i
dostosowywanie tych zasobow lingwistycznych w zaleznosci od potrzeb. Precyzyjne dostosowywanie zasobow
lingwistycznych to czgsto proces interaktywny, niezbgdny do doktadnego odczytywania i klasyfikowania pojgc.
Produkt zawiera rowniez niestandardowe szablony, biblioteki i stowniki dla konkretnych domen, takich jak CRM i
genomika.

Informacje o programie IBM Business Analytics

Oprogramowanie IBM Business Analytics dostarcza kompletne, spojne i doktadne informacje, na ktorych moga

olega¢ osoby decyzyjne chcac polepszy¢ wyniki biznesowe. Wszechstronne portfolio obejmujace moduty [analiz
biznesowal analiza prognostycznal [zarzadzanie wynikami i strategiami finansowymil oraz faplikacje analityczne]
zapewnia jasny, natychmiastowy i pozwalajacy na podjgcie dziatan wglad w biezace wyniki oraz daje mozliwos¢
przewidywania przysztych wynikow. W polaczeniu z licznymi rozwiazaniami branzowymi, sprawdzonymi praktykami
i profesjonalnymi ustugami organizacje o réznych rozmiarach moga wspomagac najwyzsza produktywno$¢, w sposob
pewny zautomatyzowac decyzje i uzyska¢ lepsze wyniki.

Oprogramowanie IBM SPSS Predictive Analytics, bedac czgsécia tego portfolio, wspomaga organizacje w zakresie
przewidywania przysztych zdarzen oraz pozwala proaktywnie wptywac na ten wglad w celu wspomagania lepszych
wynikow finansowych. Klienci komercyjni, rzadowi i uczelnie na catym $wiecie polegaja na technologii IBM SPSS
zapewniajacej przewage konkurencyjna przyciagajaca, zatrzymujaca i rozwijajaca klientdw, zmniejszajac nieuczciwosc
i ryzyko. Wdrazajac oprogramowanie IBM SPSS do swojej codziennej dziatalnos$ci, organizacje staja sig
przewidujacymi przedsigbiorstwami, zdolnymi do zarzadzania i automatyzacji decyzji w celu realizacji celow
biznesowych i osiagnigcia mierzalnej przewagi konkurencyjnej. W celu uzyskania dalszych informacji lub
skontaktowania si¢ z przedstawicielem prosze wejs¢ na strong fhttp://www.ibm.com/spss|
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http://www-01.ibm.com/software/data/businessintelligence/
http://www-01.ibm.com/software/data/businessintelligence/
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http://www-01.ibm.com/software/data/cognos/financial-performance-management.html
http://www-01.ibm.com/software/data/cognos/products/cognos-analytic-applications/
http://www.ibm.com/spss

Wsparcie techniczne

Wsparcie techniczne jest dostepne w celu zapewnienia klientom obstugi technicznej. Klienci moga si¢ kontaktowac z
dziatem Wsparcia technicznego w celu uzyskania pomocy dotyczacej korzystania z produktéw IBM Corp. lub pomocy
w instalacji dla jednego z obstugiwanych srodowisk sprzgtowych. Aby skontaktowac si¢ z dzialem Wsparcia
technicznego, wejdz na strone internetowa IBM Corp. pod adresem http://www.ibm.com/support, W przypadku prosby

o pomoc nalezy przygotowac swoje dane identyfikacyjne, dane swojej organizacji, a takze dane dotyczace ustug
wsparcia.

viii  IBM SPSS Modeler Text Analytics 18.1.1 — podrgcznik uzytkownika


http://www.ibm.com/support

Rozdziat 1. O programie IBM SPSS Modeler Text Analytics

Produkt IBM SPSS Modeler Text Analytics oferuje wydajne mozliwosci analiz tekstu, ktore wykorzystuja
zaawansowane rozwiazania lingwistyczne oraz przetwarzanie jezyka naturalnego (NLP, Natural Language Processing)
w celu szybkiego przetwarzania zroznicowanych nieustrukturyzowanych danych tekstowych, a takze wyodregbniania i
porzadkowania kluczowych poje¢ z uzyskanego tekstu. Ponadto IBM SPSS Modeler Text Analytics moze grupowac te
pojgcia w kategorie.

Okoto 80% danych przechowywanych w organizacji ma posta¢ dokumentéw tekstowych i sa to na przyktad raporty,
strony WWW, wiadomosci e-mail i notatki z centrow zgloszeniowych. Tekst jest kluczowym czynnikiem, dzigki
ktéremu organizacja moze lepiej zrozumie¢ zachowania swoich klientéw. System, ktdry wykorzystuje NLP, moze
inteligentnie wyodrebniac pojgcia, a wsrdd nich frazy zlozone. Ponadto znajomo$¢ jezyka bazowego umozliwia
przypisywanie termindw do powiazanych z nimi grup, takich jak produkty, organizacje i osoby — na podstawie
znaczen 1 kontekstow. W rezultacie mozna szybko okresli¢ istotnos¢ informacji w odniesieniu do konkretnych potrzeb.
Te wyodrebnione pojgcia i kategorie mozna taczy¢ z istniejacymi danymi ustrukturyzowanymi, takimi jak dane
demograficzne, a nastgpnie stosowac¢ w celu modelowania, korzystajac z produktu IBM SPSS Modeler i zawartego w
nim pelnego pakietu narzedzi do eksploracji danych, aby w rezultacie takiego polaczenia podejmowac lepsze decyzje
przy zmniejszonej ilosci zaktocen.

Systemy lingwistyczne sa zalezne od ilosci wiedzy — im wigcej informacji zawieraja ich stowniki, tym wyzsza jest
jako$¢ wynikow. Produkt IBM SPSS Modeler Text Analytics jest dostarczany z zestawem zasobdw lingwistycznych,
takich jak biblioteki, szablony, stowniki terminéw i synoniméw. Ten produkt pozwala na dalsze rozwijanie 1
dostosowywanie tych zasobow lingwistycznych w zaleznosci od potrzeb. Precyzyjne dostosowywanie zasobow
lingwistycznych to czgsto proces interaktywny, niezbgedny do doktadnego odczytywania i klasyfikowania pojgc.
Produkt zawiera réwniez niestandardowe szablony, biblioteki i stowniki dla konkretnych domen, takich jak CRM i
genomika.

Wdrozenie. Strumienie eksploracji tekstu mozna wdraza¢ za pomoca produktu IBM SPSS Modeler Solution Publisher
w celu oceniania danych nieustrukturyzowanych w czasie rzeczywistym. Mozliwo$¢ wdrazania tych strumieni pozwala
na pomyslne zaimplementowanie eksploracji tekstu w zamknigtej petli. Przyktad: organizacja moze analizowa¢ notatki
z rozmow wychodzacych i przychodzacych, stosujac modele predykcyjne w celu zwigkszenia doktadnosci przekazu
marketingowego w czasie rzeczywistym.

Aby uzywac IBM SPSS Modeler Text Analytics z komponentem IBM SPSS Modeler Solution Publisher, dodaj katalog
<katalog_instalacyjny>/ext/bin/spss. TMWBServer do zmiennej srodowiskowej $LD_LIBRARY_PATH.

Uwaga: Japanese Adapter dla programu IBM SPSS Modeler Text Analytics ma status nieaktualnego poczawszy od
wersji 18.1.

Aktualizowanie produktu IBM SPSS Modeler Text Analytics do wersji
18.1.1

Aktualizacja z poprzednich wersji produktu PASW Text Analytics lub Text Mining for Clementine.

Przed zainstalowaniem produktu IBM SPSS Modeler Text Analytics w wersji 18.1.1 nalezy zapisa¢ i wyeksportowac
wszelkie protokoty TAP, szablony oraz biblioteki z biezacej wersji, ktore maja by¢ uzywane w nowej wersji. Zalecamy
zapisanie tych plikéw w katalogu, ktory nie zostanie usunigty ani nadpisany podczas instalacji najnowszej wersji.

Po zainstalowaniu najnowszej wersji produktu IBM SPSS Modeler Text Analytics mozna zatadowac¢ zapisany plik

TAP, doda¢ zapisane biblioteki oraz zaimportowac i zaladowa¢ wszelkie zapisane szablony, aby nastgpnie uzywac ich
W najnowszej wersji.

© Copyright IBM Corp. 2003, 2017 1



Wazne: W przypadku deinstalacji biezacej wersji bez zapisywania i wyeksportowania potrzebnych plikow wszelkie
efekty pracy z pakietami TAP, szablonami oraz bibliotekami publicznymi zostana utracone i nie beda dostgpne w
produkcie IBM SPSS Modeler Text Analytics 18.1.1.

Informacje o eksploracji tekstu

Coraz wigksza ilo$¢ informacji jest dzi$ przechowywana w formatach nieustrukturyzowanych Iub czgsciowo
ustrukturyzowanych, takich jak wiadomosci e-mail od klientow, notatki konsultantéw infolinii, odpowiedzi na otwarte
pytania ankietowe, kanaly informacyjne, formularze WWW itd. Ta obfito$¢ informacji sprawia, ze wiele organizacji
staje przed problemem ich zbierania, eksplorowania i wykorzystania.

Eksploracja tekstu to proces polegajacy na analizowaniu zbiorow materiatldw tekstowych w celu wychwycenia w nich
najwazniejszych pojeé, tematéw i motywoOw oraz ujawnienia ukrytych relacji i trendow bez uprzedniej znajomosci
konkretnych wyrazéw lub termindw, ktorych autorzy tekstu uzyli do wyrazenia tych pojeé. Eksploracja tekstu niekiedy
nieslusznie mylona jest z wyszukiwaniem informacji, jest jednak zupelnie innym procesem. Precyzyjne wyszukiwanie i
niezawodne przechowywanie informacji jest olbrzymim wyzwaniem; rownie waznymi procesami jest wyodrgbnianie
wysokiej jakosci tresci, terminologii i relacji ukrytych w tych informacjach oraz zarzadzanie nimi.

Eksploracja tekstu a eksploracja danych

Wynikiem lingwistycznej eksploracji kazdego pojedynczego tekstu, np. artykutu, jest indeks pojeé¢ oraz informacje o
tych pojeciach. Te oczyszczone i ustrukturyzowane informacje mozna powiazaé¢ z innymi zrédtami danych, by uzyskac
odpowiedzi na takie pytania, jak:

» Ktore pojecia wystepuja razem?

* Z jakimi innymi pojgciami sa powiazane?

» Jakie kategorie wyzszego poziomu mozna utworzy¢ na podstawie wyodrgbnionych informacji?
* Co mozna przewidzie¢ na podstawie poje¢ lub kategorii?

» Jak mozna przewidzie¢ zachowania na podstawie poje¢ lub kategorii?

Laczne zastosowanie technik eksploracji tekstu i eksploracji danych umozliwia bardziej poglebiona analiz¢ informacji
niz operowanie wylacznie na danych ustrukturyzowanych albo wytacznie na danych nieustrukturyzowanych. Taki
proces zwykle sktada si¢ z nastgpujacych etapow:

1. Identyfikacja tekstu do eksploracji. Przygotowanie tekstu do eksploracji. Jesli tekst jest zapisany w wielu plikach
— zapisanie plikdw w jednym miejscu. W przypadku baz danych — okreslenie, w ktorych polach (zmiennych)
znajduje sig tekst.

2. Eksploracja tekstu i wyodrebnienie danych ustrukturyzowanych. Zastosowanie algorytmow eksploracji do
tekstu zrodtowego.

3. Zbudowanie modeli pojec i kategorii. Zidentyfikowanie kluczowych pojec i/lub uklasyfikowanie. Zwykle
wynikiem eksploracji danych nieustrukturyzowanych jest bardzo duza liczba pojeé. Identyfikacja najlepszych pojeé¢
i kategorii, ktore nalezaloby wykorzysta¢ do oceny.

4. Analiza danych ustrukturyzowanych. Zastosowanie tradycyjnych technik eksploracji danych, takich jak
tworzenie i analiza skupien, klasyfikacja i modelowanie predykcyjne do ujawnienia relacji migdzy pojgciami.
Scalenie wyodrgbnionych poje¢ z pozostatymi danymi ustrukturyzowanymi w celu prognozowania przysztych
zachowan na podstawie pojec.

Analiza i kategoryzacja tekstu

Analiza tekstu, ktdra jest jedna z postaci analizy jakosciowej, polega na wyodrebnieniu uzytecznych informacji z tekstu
, aby mozliwe bylo pogrupowanie kluczowych idei i poje¢ zawartych w tekscie w odpowiednia liczbe kategorii.
Analizg tekstu mozna prowadzi¢ na tekstach dowolnego rodzaju i dowolnej dtugosci, jednak strategie analizy beda
rozne w zaleznos$ci od charakteru tekstu.

Kroétsze rekordy lub dokumenty najtatwiej poddaja sig kategoryzacji, poniewaz nie sa tak bardzo ztozone i zwykle
zawieraja mniej niejednoznacznych wyrazow i odpowiedzi. Na przyktad jesli poprosimy respondentow o wskazanie
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trzech ulubionych form spedzania wakacji w krotkiej odpowiedzi na pytanie otwarte, to mozemy spodziewac si¢ wielu
krotkich odpowiedzi, takich jak opalanie sie na plazy, zwiedzanie parkéw narodowych lub nicnierobienie. Z kolei
dhuzsze, otwarte odpowiedzi moga by¢ ztozone i dlugie, zwlaszcza jesli respondenci sa wyksztatceni, zmotywowani i
maja dos¢ czasu na wypelnienie kwestionariusza. Jesli poprosimy respondentéw o opisanie ich przekonan politycznych
lub analizujemy blogi o tematyce politycznej, mozemy spodziewac si¢ dtugich komentarzy na przerézne tematy oraz
bardzo réznych stanowisk.

Mozliwos$¢ wyodregbniania kluczowych pojec i definiowania warto§ciowych analitycznie kategorii na podstawie
dhuzszych tekstéw w bardzo krétkim czasie jest najwazniejsza korzyscia ze stosowania produktu IBM SPSS Modeler
Text Analytics. Korzys¢ ta wynika z zastosowania kombinacji zautomatyzowanych technik lingwistycznych i
statystycznych w celu uzyskania najbardziej wiarygodnych wynikdéw na kazdym etapie procesu analizy tekstu.

Przetwarzanie lingwistyczne i przetwarzanie jezyka naturalnego (NLP)

Glownym problemem przy pracy z tekstem nieustrukturyzowanym jest brak standardowych regut pisania tekstu w
sposob zrozumiaty dla komputera. Wypowiedzi jezykowe, a tym samym takze znaczenia, bardzo roznia si¢ migdzy
dokumentami i fragmentami tekstu. Jedynym sposobem na precyzyjne wyszukanie i uporzadkowanie informacji w
takich danych nieustrukturyzowanych jest analiza wypowiedzi i interpretacja ich znaczenia. Istnieje kilka
zautomatyzowanych metod wyodrebniania poje¢ z informacji nieustrukturyzowanych. Strategie te mozna ogdlnie
podzieli¢ na dwie grupy: lingwistyczne i nielingwistyczne.

Niektore organizacje probowaty stosowaé zautomatyzowane rozwiazania nielingwistyczne oparte na statystyce i
sieciach neuronowych. Rozwigzania te, gdy zostana zaimplementowane w systemie komputerowym, przegladaja i
kategoryzuja kluczowe pojgcia szybciej niz ludzie. Niestety, doktadno§¢ wynikow uzyskiwanych za pomoca tych
rozwiazan jest raczej niska. Wigkszos$¢ systemdw statystycznych po prostu zlicza wystapienia wyrazow i oblicza ich
statystyczne bliskosci do poje¢ pokrewnych. Systemy takie generuja liczne wyniki bezwartosciowe (tzw. szum) i nie
wychwytuja wynikow, ktére powinny znalez¢ (tzw. cisza).

Aby skompensowac t¢ ograniczona doktadnos$¢ w niektorych rozwiazaniach stosuje si¢ ztozone reguty
nielingwistyczne, ktdre pomagaja w odroznianiu wynikow istotnych od nieistotnych. Takie techniki nazywa si¢
eksploracjq tekstu w oparciu o reguly.

Natomiast lingwistyczna eksploracja tekstu polega na zastosowaniu technik przetwarzania jgzyka naturalnego (NLP —
natural language processing), czyli komputerowej analizy ludzkich wypowiedzi, do analizy wyrazow, fraz i sktadni lub
struktury tekstu. System, ktory wykorzystuje NLP, moze inteligentnie wyodrebnia¢ pojecia, a wérod nich frazy ztozone.
Co wigcej, znajomos¢ jezyka tekstu umozliwia klasyfikowanie poje¢ w grupy poje¢ pokrewnych, takich jak produkty,
organizacje lub osoby, na podstawie znaczenia i kontekstu.

Lingwistyczna eksploracja tekstu znajduje znaczenia w tekscie podobnie, jak robia to ludzie — rozpoznajac rozne
formy wyrazéw jako bliskoznaczne i analizujac strukturg zdan bgdaca rusztowaniem, na ktdrym opiera sig interpretacja
tekstu. Ta strategia jest rownie szybka i ekonomiczna, jak systemy statystyczne, ale oferuje znacznie wigksza
doktadnos¢ i wymaga mniejszego zaangazowania czlowieka.

Aby zilustrowa¢ roznicg migdzy statystyczna a lingwistyczna strategia wyodrebniania,zobaczmy, jakie wyniki
wygeneruje kazda z tych strategii w odpowiedzi na pytanie o powielanie dokumentdéw. Zaréwno rozwiazanie
statystyczne, jak i lingwistyczne musi rozwina¢ wyraz powielanie, by uwzglednic¢ jego synonimy, takie jak
kopiowanie i reprodukcja. Nieuwzglednienie synonimow prowadzitoby do potencjalnego pominigcia waznych
informacji. Jesli rozwiazanie statystyczne sprobuje wyszukaé inne terminy o tym samym znaczeniu, to
prawdopodobnie zwrdci takze termin birth, generujac liczne nieistotne wyniki. Interpretacja jezyka pozwala pokonaé
niejednoznacznosci, czyniac z lingwistycznej eksploracji tekstu strategie z definicji bardziej niezawodna.

Zrozumienie dzialania procesu wyodrgbniania pomoze w podejmowaniu kluczowych decyzji dotyczacych
optymalizacji zasobdw lingwistycznych (biblioteki, typy, synonimy itd.). Oto etapy procesu wyodrebniania:

* Przeksztalcenie danych zrédlowych do formatu standardowego
* Identyfikacja terminow kandydackich
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* Identyfikacja klas rownowaznosci i integracja synonimow
* Przypisanie typow

* Indeksowanie, a nast¢pnie — w razie potrzeby — dopasowanie wzorcoéw przy uzyciu dodatkowego analizatora.
Etap 1. Przeksztalcenie danych zrodlowych do formatu standardowego

W pierwszym etapie zaimportowane dane sa przeksztalcane do jednolitego formatu, ktéory moze by¢ uzywany do
dalszej analizy. To przeksztalcenie odbywa si¢ wewngtrznie i nie powoduje zmiany oryginalnych danych.

Etap 2. Identyfikacja terminow kandydackich

Wazne jest zrozumienie roli zasobow lingwistycznych w identyfikacji terminow kandydackich podczas wyodrgbniania
lingwistycznego. Zasoby lingwistyczne sa uzywane przy kazdym wyodrebnianiu. Maja posta¢ szablondw, bibliotek i
zasobow skompilowanych. Biblioteki zawieraja listy wyrazow, relacji i inne informacje stuzace do definiowania i
optymalizacji wyodrgbniania. Skompilowanych zasobow nie mozna przeglada¢ ani edytowac. Jednak pozostate zasoby
mozna edytowaé w edytorze Template Editor lub, jesli pracujesz na interaktywnym pulpicie roboczym, w edytorze
Resource Editor.

Zasoby skompilowane to podstawowe, wewngtrzne komponenty mechanizmu wyodrgbniania w produkcie IBM SPSS
Modeler Text Analytics. Do zasobow tych nalezy ogdlny stownik zawierajacy listg form podstawowych z kodami
czgsci mowy (rzeczownik, czasownik, przymiotnik itd.).

Oprocz tych zasobéw skompilowanych razem z produktem dostarczanych jest kilka bibliotek, ktore mozna
wykorzysta¢ jako dopetnienie definicji typow i poje¢ zawartych w zasobach skompilowanych, a takze jako zrodia
synonimow. Biblioteki te — oraz biblioteki utworzone samodzielnie przez uzytkownika — sktadaja si¢ z kilku
stownikow. Sa to: stowniki typow, stowniki synoniméw oraz stowniki wykluczen.

Po zaimportowaniu i przeksztalceniu danych mechanizm wyodrebniania rozpoczyna wykrywanie termindéw
kandydackich do wyodrebnienia. Terminy kandydackie to wyrazy lub grupy wyrazéw identyfikujace pojecia w tekscie.
W trakcie przetwarzania tekstu pojedyncze wyrazy (terminy pojedyncze) i ztozenia wyrazow (terminy wielowyrazowe)
sa identyfikowane na podstawie wzorcow czgsci mowy. Nastgpnie poprzez analiz¢ powiazan opartych na sentymencie
identyfikowane sa kandydackie stowa kluczowe sentymentu.

Uwaga: Terminy w slowniku reprezentuja ogdlne wymienione powyzej skompilowanej listy wszystkich stow, ktore sa
prawdopodobnie nieinteresujace lub lingwistycznie niejednoznaczny jako uniterms. Wyrazy te sa wykluczane z
wynikdw wyodrebniania terminéw pojedynczych. Jednak sa ponownie analizowane przy okreslaniu czgsci mowy lub
wyszukiwaniu dtuzszych terminéw wielowyrazowych.

Etap 3. Identyfikacja klas rownowaznosci i integracja synonimow

Po zidentyfikowaniu terminéw pojedynczych i terminéw wielowyrazowych oprogramowanie, korzystajac ze stownika
normalizacji, tworzy klasy rownowaznosci. Klasa rownowaznosci jest podstawowa forma frazy lub pojedyncza forma
dwoch wariantow tej samej frazy. Aby okresli¢, ktérego pojecia uzy¢ w klasie rownowaznosci, mechanizm
wyodrebniania stosuje ponizsze reguly w kolejnosci, w jakiej zostaty tutaj wymienione:

* Forma okres$lona przez uzytkownika w bibliotece.

* Najczesciej uzywana forma, zgodnie z prekompilowanymi zasobami.
Etap 4. Przypisanie typow

Nastepnie do wyodrgbnionych pojgc¢ przypisywane sa typy. Typ jest semantyczna grupa pojec. Na tym etapie uzywane
sa zard6wno zasoby skompilowane, jak i biblioteki. Typy odzwierciedlaja pojgcia poziomowe, kwalifikatory i okreslenia
o wydzwieku pozytywnym i negatywnym, imiona, miejsca, organizacje i nie tylko. Wigcej informacji zawiera temat
[‘Stowniki typéw” na stronie 173|
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Systemy lingwistyczne sa zalezne od ilosci wiedzy — im wigcej informacji zawieraja ich stowniki, tym wyzsza jest
jakos¢ wynikow. Odpowiednia modyfikacja zawartosci stownikow, np. definicji synonimow, moze uprosci¢ uzyskane
wyniki. Czgsto mamy tu do czynienia z procesem iteracyjnym, ktory jest niezbedny do precyzyjnego wyszukania
poje¢. Zasadniczym elementem programu IBM SPSS Modeler Text Analytics jest mechanizm przetwarzania jezyka
naturalnego (NLP).

Jak dziata wyodrebnianie

W trakcie wyodrebniania kluczowych poje¢ i koncepcji z odpowiedzi IBM SPSS Modeler Text Analytics
przeprowadza lingwistyczna analizg tekstu. Ta strategia zapewnia szybko$¢ i ekonomiczno$¢ typowa dla systemoéw
statystycznych. Ale oferuje znacznie wyzszy poziom doktadnosci i wymaga mniejszego zaangazowania uzytkownika.
Lingwistyczna analiza tekstu jest oparta jest na przetwarzaniu jgzyka naturalnego (spotyka si¢ tez nazwe: lingwistyka
komputerowa).

Zrozumienie dzialania procesu wyodrgbniania pomoze w podejmowaniu kluczowych decyzji dotyczacych
optymalizacji zasobow lingwistycznych (biblioteki, typy, synonimy itd.). Oto etapy procesu wyodrgbniania:
* Przeksztalcenie danych zrédlowych do formatu standardowego

* Identyfikacja terminéw kandydackich

* Identyfikacja klas rownowaznosci i integracja synonimow

* Przypisanie typow

* Indeksowanie

* Dopasowywanie wzorcow i wyodregbnianie zdarzen
Etap 1. Przeksztatcenie danych zrédtowych do formatu standardowego

W pierwszym etapie zaimportowane dane sa przeksztalcane do jednolitego formatu, ktéry moze by¢ uzywany do
dalszej analizy. To przeksztalcenie odbywa si¢ wewngtrznie i nie powoduje zmiany oryginalnych danych.

Etap 2. Identyfikacja terminéw kandydackich

Wazne jest zrozumienie roli zasobow lingwistycznych w identyfikacji terminow kandydackich podczas wyodrebniania
lingwistycznego. Zasoby lingwistyczne sa uzywane przy kazdym wyodrebnianiu. Maja posta¢ szablondw, bibliotek i
zasobow skompilowanych. Biblioteki zawieraja listy wyrazow, relacji i inne informacje stuzace do definiowania i
optymalizacji wyodrebniania. Skompilowanych zasobow nie mozna przeglada¢ ani edytowac. Jednak pozostate zasoby
(szablony) mozna edytowa¢ w oknie Template Editor lub, jesli aktywna jest sesja interaktywnego pulpitu roboczego, w
oknie Resource Editor.

Zasoby skompilowane to podstawowe, wewngtrzne komponenty mechanizmu wyodrgbniania w produkcie IBM SPSS
Modeler Text Analytics. Do zasobdw tych nalezy ogdlny stownik zawierajacy list¢ form podstawowych z kodami
czgSci mowy (rzeczownik, czasownik, przymiotnik, przystowek, imiestoéw przymiotnikowy, spojnik, okreslnik lub
przyimek). Do zasobow naleza takze zastrzezone typy wbudowane, ktore umozliwiaja przypisywanie wielu
wyodrebnionych termindéw do typow <Location> (miejsce), <Organization> (organizacja) lub <Person> (osoba).
Wiecej informacji zawiera temat[“Typy wbudowane” na stronie 174

Oprocz tych zasobdéw skompilowanych razem z produktem dostarczanych jest kilka bibliotek, ktére mozna
wykorzysta¢ jako dopehnienie definicji typow i poje¢ zawartych w zasobach skompilowanych, a takze jako zrodta
innych typow i synonimow. Biblioteki te — oraz biblioteki utworzone samodzielnie przez uzytkownika — sktadaja si¢
z kilku stownikéw. Sa to: stowniki typow, stowniki zastapien (synonimdw i elementdw opcjonalnych) oraz stowniki
wykluczen. Wigcej informacji zawiera[Rozdziat 15, “Praca z bibliotekami”, na stronie 163]

Po zaimportowaniu i przeksztalceniu danych mechanizm wyodrebniania rozpoczyna wykrywanie terminéw
kandydackich do wyodrebnienia. Terminy kandydackie to wyrazy lub grupy wyrazéw identyfikujace pojgcia w tekscie.
Podczas przetwarzania tekstu pojedyncze wyrazy (terminy pojedyncze), ktdrych nie ma w zasobach skompilowanych,
sa traktowane jako terminy kandydackie. Kandydackie terminy wielowyrazowe sa identyfikowane na podstawie
wzorcodw czesci mowy. Na przyktad termin wieclowyrazowy Sports car, ktory jest zgodny ze wzorcem czgsci mowy
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"przymiotnik rzeczownik", sktada sie z dwoch elementéw. Termin wielowyrazowy fast sports car, ktory jest zgodny
ze wzorcem czgs$ci mowy "przymiotnik przymiotnik rzeczownik", sktada sig z trzech elementow.

Uwaga: Terminy w stowniku reprezentuja ogdlne wymienione powyzej skompilowanej listy wszystkich stow, ktore sa
prawdopodobnie nieinteresujace lub lingwistycznie niejednoznaczny jako uniterms. Wyrazy te sa wykluczane z
wynikéw wyodrebniania terminéw pojedynczych. Jednak sa ponownie analizowane przy okreslaniu czgsci mowy lub
wyszukiwaniu dluzszych terminow wielowyrazowych.

Wreszcie, specjalny algorytm analizuje tancuchy zapisane wielkimi literami, takie jak nazwy dzialow, co pozwala na
wyodrebnienie takich specjalnych wzorcow.

Etap 3. Identyfikacja klas rownowaznosci i integracja synonimow

Po zidentyfikowaniu terminéw pojedynczych i termindéw wielowyrazowych oprogramowanie, korzystajac z zestawu
algorytmow, porownuje je i tworzy klasy rownowaznosci. Klasa rownowaznosci to podstawowa forma frazy Iub jedna
forma dwoch wariantéw tej samej frazy. Frazy przypisuje si¢ do klas rownowaznosci, aby mie¢ pewnos¢, ze np. frazy
president of the company i company president nie zostana potraktowane jako rdzne pojecia. Aby okresli¢, ktorego
pojecia uzy¢ w klasie rOwnowaznosci, tj. czy terminem wiodacym ma by¢ president of the company, czy company
president, mechanizm wyodrebniania stosuje ponizsze reguty w kolejnosci, w jakiej zostaly tutaj wymienione:

* Forma okreslona przez uzytkownika w bibliotece.

* Forma wystgpujaca najczesciej w calej tresci tekstu.

* Najkrétsza forma wystgpujaca w calej tresci tekstu (ktora zwykle odpowiada formie podstawowe;j).
Etap 4. Przypisanie typéw

Nastepnie do wyodregbnionych pojeé¢ przypisywane sa typy. Typ jest semantyczna grupa pojgc. Na tym etapie uzywane
sa zarowno zasoby skompilowane, jak i biblioteki. Typy odzwierciedlaja pojgcia poziomowe, kwalifikatory i okreslenia
o wydzwigku pozytywnym i negatywnym, imiona, miejsca, organizacje i nie tylko. Uzytkownik moze zdefiniowaé
dodatkowe typy. Wiecej informacji zawiera temat[“Stowniki typéw” na stronie 173|

Krok 5. Indeksowanie

Caty zbidr rekordow lub dokumentéw jest indeksowany, co polega na utworzeniu, dla kazdej klasy rownowaznosci,
wskaznikow migdzy pozycjami w tekscie a reprezentatywnymi terminami. Zaktada si¢ przy tym, ze wszystkie
odmienione wystapienia pojgcia kandydackiego sa indeksowane jako forma podstawowa tego pojgcia. Obliczana jest
globalna liczebnos¢ wystapien kazdej formy podstawowe;.

Krok 6. Dopasowywanie wzorcow i wyodrebnianie zdarzen

IBM SPSS Modeler Text Analytics potrafi wykrywac nie tylko typy i pojecia, lecz takze relacje migedzy nimi. W
produkcie dostgpnych jest kilka algorytméw i bibliotek, ktére umozliwiaja wyodrebnianie relacji miedzy typami i
pojeciami. Sa szczegolnie przydatne, gdy interesuja nas okreslone opinie (np. reakcje na produkt) lub powiazania
odzwierciedlajace relacje migdzy osobami lub obiektami (na przyktad powiazania migedzy grupami politycznymi lub
genomami).

Jak dziata kategoryzacja

Podczas tworzenia modeli kategorii w programieIlBM SPSS Modeler Text Analytics istnieje kilka technik, ktéore mozna
zastosowac do tworzenia kategorii. Poniewaz kazdy zbior danych jest inny, liczba metod tworzenia kategorii i
kolejnos¢ ich stosowania moze si¢ z czasem zmienia¢. Jako ze kazdy uzytkownik moze inaczej interpretowac te same
wyniki, konieczne moze by¢ wyprébowanie roznych technik i wybranie tej, ktora przynosi najlepsze wyniki w analizie
konkretnych danych tekstowych. W programie IBM SPSS Modeler Text Analytics mozna tworzy¢ modele kategorii na
interaktywnym pulpicie roboczym, ktory stwarza warunki do dalszej eksploracji i optymalizacji kategorii.
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W niniejszym podreczniku budowanie kategorii oznacza generowanie definicji kategorii i klasyfikacje przy uzyciu
jednej lub wielu wbudowanych technik, natomiast kategoryzacja oznacza ocenianie, czyli proces przypisywania
unikalnych identyfikatorow (nazwa/identyfikator/warto$¢) do definicji kategorii dla kazdego rekordu lub dokumentu.

W trakcie budowania kategorii wyodrgbnione pojgcia i typy sa uzywana jako elementy sktadowe kategorii. Podczas
budowania kategorii rekordy lub dokumenty sa automatycznie przypisywane do kategorii, jesli zawieraja tekst pasujacy
do elementu definicji tej kategorii.

IBM SPSS Modeler Text Analytics oferuje kilka zautomatyzowanych technik budowania kategorii, ktére pomagaja w
szybkiej kategoryzacji dokumentéw lub rekorddw.

Techniki grupowania

Kazda z dostgpnych technik dobrze nadaje si¢ do pracy z okreslonymi rodzajami danych i w okreslonych warunkach,
jednak czgsto przydatna jest mozliwos¢ potaczenia w jednej analizie roznych technik w celu wydobycia bogatszego
zbioru informacji z dokumentdw lub rekordow. Pojecie moze znalez¢ si¢ w wigeej niz jednej kategorii, moga tez
pojawic sig kategorie nadmiarowe.

Concept Root Derivation. Te technika tworzy kategorie, wybierajac jedno pojecie i wyszukujac pojecia mu pokrewne
poprzez analizg relacji morfologicznych lub wspolnych rdzeni migdzy komponentami tych pojec. Technika ta jest
bardzo przydatna do rozpoznawania synonimicznych poje¢ ztozonych z wigcej niz jednego wyrazu, poniewaz pojgcia
w kazdej wygenerowanej kategorii sa synonimami lub sa bardzo bliskie znaczeniowo. Technika ta dziata z danymi o
roznych dlugosciach i generuje mniejsza liczbg bardziej zwartych kategorii. Na przyktad pojecie opportunities to
advance zostatoby potaczone w grupe z pojeciami opportunity for advancement i advancement opportunity.
Wiecej informacji mozna znalez¢ w temacie [*Wywodzenie rdzenia pojecia” na stronie 105]

Semantic Network. Ta technika najpierw rozpoznaje mozliwe sensy kazdego pojgcia na podstawie obszernego indeksu
relacji migdzy wyrazami, a potem tworzy kategorie poprzez grupowanie poje¢ pokrewnych. Sprawdza sig najlepie;j,
gdy pojecia sa znane sieci semantycznej i nie sa zbyt niejednoznaczne. Jest mniej uzyteczna, gdy tekst zawiera
terminologig specjalistyczna lub Zzargon nieznany sieci. Przyktadowo pojecie granny smith apple mogtoby zostac¢
potaczone w grupe z pojeciami gala apple i winesap apple, poniewaz podobnie jak ,,granny smith” oznaczaja
odmiany jabtoni. Natomiast pojecie animal mogloby zosta¢ potaczone w grupe z pojeciami cat i kangaroo, poniewaz
sa one hiponimami stowa animal (tj. zawezaja jego znaczenie). W tej wersji technika ta jest dostepna tylko w
odniesieniu do jezyka angielskiego. Wiecej informacji zawiera temat [‘Sieci semantyczne” na stronie 107}

Concept Inclusion. Ta technika buduje kategorie, taczac z w grupg z jednym pojeciem inne pojgcia ztozone z wielu
termindéw (wielu wyrazdw) w zaleznosci od tego, czy zawieraja one wyrazy bgdace podzbiorami czy nadzbiorami

wystepujacego w nim wyrazu. Na przyklad pojecie seat zostatoby potaczone w grupe z pojeciami safety seat, seat
belt i seat belt buckle. Wigcej informacji zawiera temat|“Wtaczanie poje¢” na stronie 106

Co-occurrence. Ta technika tworzy kategorie na podstawie wspotwystapien znalezionych w tekscie. Koncepcja
dziatania tej techniki opiera si¢ na tym, ze gdy pojgcia lub wzorce poje¢ czgsto wystgpuja razem w dokumentach i
rekordach, takie wspotwystapienia odzwierciedlaja potencjalna relacjg, ktora warto uwzgledni¢ w definicjach kategorii.
Istotne wspolwystapienia wyrazow powoduja utworzenie regulty wspotwystgpowania, ktora mozna wykorzystac jako
deskryptor dla nowej podkategorii. Na przyktad, jesli wiele rekordow zawiera wyrazy price i availability (ale niewiele
rekorddw zawiera jeden z tych wyrazéw bez drugiego), to pojgcia te zostana potaczone w regute wspotwystepowania,
(price & available) i przypisane na przyktad do podkategorii kategorii price. Wiecej informacji zawiera temat
[‘Reguty wspotwystepowania” na stronie 108]

Minimalna ilo$¢ rekordéw documents. Aby moc lepiej ocenic, na ile interesujace sa wspotwystapienia, mozna
zdefiniowa¢ minimalna liczbe dokumentow lub rekordéw, jaka musi zawiera¢ dane wspotwystapienie, aby byto
uzywane jako deskryptor w kategorii.
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Wezly produktu IBM SPSS Modeler Text Analytics

Wraz z wieloma standardowymi weztami dostarczanymi z produktem IBM SPSS Modeler uzytkownik ma do
dyspozycji takze wezty eksploracji tekstu, ktore umozliwiaja zastosowanie zaawansowanych technik analizy tekstu w
strumieniach. IBM SPSS Modeler Text Analytics oferuje kilka weztdw eksploracji tekstu. Wezty te sa dostepne na
karcie IBM SPSS Modeler Text Analytics palety weztow.

Dostepne sa nastgpujace wezly:

Wezel zrodlowy File List generuje liste nazw dokumentdéw jako dane wejsciowe do procesu eksploracji tekstu.
Mozliwosc¢ ta jest przydatna, jesli tekst znajduje si¢ w dokumentach zewngtrznych, a nie w bazie danych lub innym
pliku ustrukturyzowanym. Wezet generuje jedna zmienna z jednym rekordem dla kazdego dokumentu lub folderu na
liscie; zmienne te mozna wybra¢ jako dane wejsciowe dla kolejnego wezta eksploracji tekstu. Wigcej informacji
zawiera temat[“Wezet File List” na stronie 11}

Wezel zrodlowy Web Feed umozliwia odczyt tekstu z kanalow informacyjnych WWW, takich jak blogi, lub
kanatéw informacyjnych w formacie RSS lub HTML, a potem wykorzystanie tego tekstu w procesie eksploracji.
Wezel generuje jedna lub wigeej zmiennych dla kazdego rekordu znalezionego w kanatach informacyjnych.
Zmienne te mozna wybra¢ jako dane wejsciowe dla kolejnego wezla eksploracji tekstu. Wigcej informacji zawiera
temat [“Wezet Web Feed” na stronie 13|

Wezel Language Identifier skanuje tekst zrodtowy w celu okreslenia, w ktéorym jezyku naturalnym zostat napisany,
a nastgpnie umieszcza o tym informacje w nowej zmiennej. Wezet ten, wykorzystywany gtownie podczas pracy z
duzymi ilosciami danych, okazuje si¢ bardzo przydatny, gdy w zrodtach danych wystepuje kilka jezykow, z ktdrych
przetworzony ma by¢ tylko jeden. Wigcej informacji zawiera temat[“Wezel jezyka” na stronie 17,

Wezel Test Mining uzywa metod lingwistycznych, aby wyodrebni¢ kluczowe pojecia z tekstu, tworzy kategorie na
podstawie tych pojg¢ i innych danych i oferuje mozliwos¢ identyfikowania relacji i powiazan migdzy pojgciami na
podstawie znanych wzorcow (jest to tzw. analiza powiazan w tekscie). Wezet ten moze by¢ uzywany do
eksplorowania tresci tekstowych lub do wygenerowania modelu poje¢ albo modelu kategorii. Pojecia i kategorie
mozna taczy¢ z istniejacymi danymi ustrukturyzowanymi, takimi jak dane demograficzne, a nast¢pnie stosowac w
modelowaniu. Wigcej informacji zawiera temat[“Wezet modelowania Text Mining” na stronie 20}

Wezel Text Link Analysis pozwala na wyodrgbnianie pojg¢, a takze identyfikuje relacje migdzy pojeciami na
podstawie znanych wzorcow w tekscie. Wyodrgbnianie wzorcdw umozliwia wykrywanie relacji migdzy pojgciami, a
takze opinii lub kwalifikatoréw skojarzonych z tymi pojeciami. Wezet Text Link Analysis oferuje bardziej
bezposredni sposdb identyfikowania i wyodrgbniania wzorcdéw z tekstu, a takze moze dodawa¢ wynikowe wzorce do
zbioru danych w strumieniu. Jednak analiz¢ TLA mozna réwniez prowadzi¢ na interaktywnym pulpicie
modelowania, w ramach wezta modelowania Text Mining. Wigcej informacji zawiera temat|[“Wezet Text Link]
[Analysis” na stronie 47

Podczas eksploracji tekstu z dokumentéw zewnetrznych wezel wynikowy Text Mining umozliwia wygenerowania
strony HTML zawierajacej odsylacze do dokumentéw, z ktérych zostaty wyodrgbnione pojecia. Wigcej informacji
zawiera temat[“Wezet File Viewer” na stronie 55|

Zastosowania

Zasadniczo kazdy, kto czgsto musi przeglada¢ duze ilosci dokumentdw, aby zidentyfikowac kluczowe elementy do
dalszej eksploracji, moze odnies$¢ korzysci z zastosowania produktu IBM SPSS Modeler Text Analytics.

Oto niektore obszary zastosowan produktu:

8

Badania naukowe i medyczne. Eksploracja materiatdw pomocniczych, takich jak raporty patentowe i artykuty w
czasopismach specjalistycznych. Wykrywanie powiazan, ktore byty dotychczas nieznane (np. powiazanie migdzy
lekarzem a okreslonym produktem), i wytyczanie na ich podstawie kierunkow dalszej eksploracji. Przyspieszenie
prac nad nowymi lekami. Badania genetyczne.

Analizy inwestycyjne. Analiza codziennych raportéw analitycznych, artykutow prasowych i informacji dla prasy
publikowanych przez spotki w celu wykrycia kluczowych elementow strategii i zmian na rynku. Analiza trendow w
zbiorach takich informacji ujawnia potencjalne problemy lub szanse stojace przed jedna firma lub cata branza w
danym okresie.
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Wykrywanie oszustw. Wykrywanie anomalii i potencjalnych zagrozen oszustwem w obszernych danych
tekstowych w sektorze bankowosci lub stuzby zdrowia.

Badania rynku. Badania majace na celu rozpoznanie najwazniejszych tematéw w odpowiedziach respondentow na
pytania otwarte.

Analiza blokéw i kanalow WWW. Eksploracja i budowanie modeli na podstawie kluczowych poje¢ pojawiajacych
si¢ w kanatach z wiadomosciami, blogach itd.

Zarzadzanie relacjami z klientami (CRM). Budowanie modeli na podstawie danych z wszystkich punktow
interakcji z klientem, takich jak poczta elektroniczna, transakcje i ankiety.

Rozdziat 1. O programie IBM SPSS Modeler Text Analytics 9
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Rozdziat 2. Wczytywanie tekstu zrédiowego

Dane do eksploracji tekstu moga by¢ zapisane w dowolnym standardowym formacie uzywanym przez program IBM

SPSS Modeler, w tym takze w bazach danych i innych formatach ,,tabelarycznych” ztozonych z wierszy i kolumn, a

takze w formatach dokumentdw, takich jak Microsoft Word, Adobe PDF lub HTML, ktore nie maja takiej struktury.

* Aby wczytywac w postaci tekstowej dokumenty nieposiadajace standardowej struktury danych, zapisane w takich
formatach, jak Microsoft Word, Microsoft Excel, i Microsoft PowerPoint, a takze w formatach Adobe PDF, XML,
HTML i innych, mozna uzy¢ wezta File List do wygenerowania listy dokumentdw lub folderow stanowiacych dane
wejsciowe dla procesu eksploracji tekstu. Aby uzyska¢ wigcej informacji, patrz|[“Wezet File List’}

* Aby wczytywac tekst z kanatow WWW, takich jak blogi lub kanaty z aktualno$ciami w formacie RSS lub HTML,
mozna wykorzysta¢ wezet Web Feed do formatowania danych z kanatu WWW do postaci odpowiedniej dla procesu
eksploracji tekstu. Aby uzyska¢ wiecej informacji, patrz[“Wezet Web Feed” na stronie 13|

* Do wczytywania tekstu w dowolnym standardowym formacie danych uzywanym przez program SPSS Modeler, na
przyktad w formie bazy danych zawierajacej jedno lub wigcej pol tekstowych z uwagami klientow, mozna uzywac
dowolnych standardowych weztéw zrodtowych programu SPSS Modeler. Aby uzyska¢ wigcej informacji, patrz
dokumentacj¢ wezta SPSS Modeler.

* Podczas przetwarzania duzych ilo$ci danych, ktore moga zawiera¢ tekst w wielu jezykach, nalezy uzy¢ wezta
i'e;zika, abi wskazac jezyk uzywany w okreslonej zmiennej. Aby uzyska¢ wigcej informacji, patrz|“Wezet jezyka’

Wezet File List

Aby wezytywaé w postaci tekstowej dokumenty nieustrukturyzowane zapisane w takich formatach, jak Microsoft
Word, Microsoft Excel i Microsoft PowerPoint, a takze w formatach Adobe PDF, XML, HTML i innych, mozna uzy¢
wezta File List do wygenerowania listy dokumentow lub folderdw stanowiacych dane wejsciowe dla procesu
eksploracji tekstu. Jest to konieczne, poniewaz nieustrukturyzowanych dokumentow tekstowych nie da si¢ przedstawic
w formie zmiennych i rekordéw (wierszy i kolumn), tak jak innych danych, z ktérych korzysta IBM SPSS Modeler.

Wezet File List dziata jako wezet zrodlowy.

Wezel ten znajduje sig na karcie IBM SPSS Modeler Text Analytics palety weztdéw w oknie IBM SPSS Modeler.
Wigcej informacji zawiera temat [“Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8|

Wazne: Wszelkie nazwy katalogow i plikow zawierajace znaki nieuwzglgdnione w standardzie kodowania
obowiazujacym na lokalnym komputerze nie sa obstugiwane. Przy probie wykonania strumienia zawierajacego wezet
File List wszelkie nazwy plikow lub katalogdw zawierajace takie znaki spowoduja niepowodzenie wykonania. Taka
sytuacja moze wystapi¢ w przypadku nazw katalogéw lub plikéw w jezykach obcych, na przyktad nazw plikow w
jezyku niemieckim na komputerze z francuskimi ustawieniami regionalnymi.

Local data support. Jezeli masz potaczenie ze zdalnym serwerem IBM SPSS Modeler Text Analytics Server i
strumien zawierajacy wezet File List, to dane powinny znajdowac si¢ na tym samym komputerze, co IBM SPSS
Modeler Text Analytics Server , lub komputer serwera musi mie¢ dostgp do folderu, w ktérym przechowywane sa dane
zrodlowe wezta File List.

Uwaga: Nie mozna uzywac wezla File List do oceny w ramach konfiguracji IBM SPSS Collaboration and
Deployment Services - Scoring.

Wezet File List: karta Settings

Na tej karcie mozna definiowac¢ katalogi, rozszerzenia plikéw i dane wejsciowe dla wezta.
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Uwaga: Mechanizm wyodregbniania w ramach eksploracji tekstu nie moze przetwarzac plikow Microsoft Office i
Adobe PDF na platformach innych niz Microsoft Windows. Jednak pliki XML, HTML lub tekstowe zawsze moga by¢
przetwarzane.

Wszelkie nazwy katalogow i plikow zawierajace znaki nieuwzglgdnione w standardzie kodowania obowiazujacym na
lokalnym komputerze nie sa obstugiwane. Przy probie wykonania strumienia zawierajacego wezet File List wszelkie
nazwy plikow lub katalogéw zawierajace takie znaki spowoduja niepowodzenie wykonania. Taka sytuacja moze
wystapi¢ w przypadku nazw katalogow lub plikéw w jezykach obcych, na przyktad nazw plikow w jezyku niemieckim
na komputerze z francuskimi ustawieniami regionalnymi.

Directory Okresla katalog gtowny zawierajacy dokumenty, ktérych liste chcesz utworzyc.
* Include subdirectories Okresla, ze przeszukiwane maja by¢ takze podkatalogi.

File type(s) to include in list: Mozna wybiera¢ typy plikow i rozszerzenia lub anulowa¢ ich wybor. Anulowanie
wyboru rozszerzenia powoduje ignorowanie plikow o tym rozszerzeniu. Mozna filtrowa¢ wedlug nastepujacych
rozszerzen:

Tabela 1. Filtry typow plikow wediug rozszerzern nazw.

* .rtf,.doc, .docx, .docm e .xls, .xlsx, .xlsm * .ppt, .pptx, .pptm e .Ixt, .text

e htm, .html, .shtml e xml e pdf e .8

Uwaga: Aby uzyska¢ wiecej informacji, patrz|[*Wezet File List” na stronie 11}

Jesli masz pliki bez rozszerzen lub z nazwami zakonczonymi kropka (na przyktad Plik01 lub Plik01.),to aby je
wybraé, skorzystaj z opcji No extension.

Input encoding Jesli zmienna wyjsciowa bedzie zawiera¢ doktadny tekst, wybierz odpowiednia warto$¢ z ponizszej
listy:

* Automatic (European)

* UTEF-8

 UTF-16

* ISO-8859-1

* 1SO-8859-2

* Windows-1250

* US ascii

Wyniki sa prezentowane w formie dokumentow tekstowych UTF-8.

Wazne: Poczawszy od wersji 14 opcja List of directories nie jest juz dostgpna i generowana jest tylko lista plikdw.

Wezel List Node: pozostate karty
Karta Typy jest standardowa karta w wezlach programu IBM SPSS Modeler, podobnie jak karta Adnotacje.

Korzystanie z wezta File List w eksploraciji tekstu

Wezet File List jest uzywany, gdy dane tekstowe rezyduja w zewnetrznych dokumentach nieustrukturyzowanych, w
takich formatach, jak Microsoft Word, Microsoft Excel i Microsoft PowerPoint, a takze w formatach Adobe PDF,
XML, HTML i innych.

Zalézmy na przyklad, ze potaczylismy wezet File List z wegzlem Text Mining, aby uzyskac tekst przechowywany w
zewnetrznych dokumentach:
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1. Wezel File List (karta Settings). Najpierw dodaliSmy ten wezet do strumienia, aby okresli¢, gdzie sa
przechowywane dokumenty tekstowe. Wybralismy katalog zawierajacy wszystkie dokumenty, na ktorych chcemy
przeprowadzac eksploracjg tekstu.

2. Wezel Text Mining (karta Fields). Nastepnie dodalismy wezet Text Mining i potaczyliSmy go z weztem File List.
W tym wezle zdefiniowali$my format wejsciowy, szablon zasobow i format wyjsciowy. WybraliSmy nazwe
zmiennej wygenerowana z wezta File List, zmienna tekstowa oraz inne ustawienia. Wigcej informacji zawiera
temat |“Korzystanie z wezta Text Mining w strumieniu” na stronie 29|

Wigcej informacji o korzystaniu z wezta Text Mining zawiera sekcja[‘Wezel modelowania Text Mining” na stronie 20}

Wezel Web Feed

Wezet Web Feed moze by¢ uzywany do przygotowywania danych z kanaldw informacyjnych WWW na potrzeby
eksploracji tekstu. Ten wezet przyjmuje kanaty informacyjne WWW w dwoch formatach:

* Format RSS. RSS to prosty standaryzowany format oparty na XML dla tresci WWW. Adres URL dla tego formatu
wskazuje na strong, na ktorej znajduje si¢ zestaw dowiazanych artykutow, takich jak syndykowane zrodta
wiadomosci i blogi. RSS jest formatem standaryzowanym, dlatego kazdy dowiazany artykut jest automatycznie
identyfikowany i traktowany jako osobny rekord w wynikowym strumieniu danych. Nie sa wymagane zadne
dodatkowe dane wej$ciowe umozliwiajace identyfikowanie istotnych danych tekstowych oraz rekordéw z kanatu
informacyjnego, chyba ze wzgledem tekstu zastosowano technike filtrowania.

* Format HTML. Na karcie Input mozna zdefiniowac¢ jeden lub wigksza liczbg adreséow URL do stron HTML.
Nastepnie na karcie Records nalezy zdefiniowa¢ znacznik poczatku rekordu, a takze wskaza¢ znaczniki
ograniczajace tres¢ docelowa i przypisac te znaczniki do wybranych pdl wyjsciowych (opis, tytul, data modyfikacji
itp.). Wigcej informacji zawiera temat [*Wezet Web Feed: karta Records™ na stronie 14}

Wazne! Jesli informacje maja by¢ pobierane z sieci WWW za posrednictwem serwera proxy, nalezy w pliku
net.properties wlaczy¢ serwer proxy zarowno dla klienta, jak i serwera IBM SPSS Modeler Text Analytics.
Szczegdtowe instrukcje postgpowania znajduja si¢ w samym pliku. Dotyczy to sytuacji, w ktorej dostgp do sieci WWW
odbywa si¢ za posrednictwem wezla Web Feed lub pobierana jest licencja na oprogramowanie SDL Software as a
Service (SaaS), poniewaz odpowiednie potaczenia przechodza przez Java' . Wspomniany plik domyslnie znajduje sig
w lokalizacji C:\Program Files\IBM\SPSS\Modeler\18.1.1\jre\lib\net.properties.

Wynikiem tego wezla jest zestaw pdl uzywanych do opisywania rekordéw. Pole Description jest czgsto uzywane,
poniewaz zawiera wigkszo$¢ zawartosci tekstowej. Jednak uzytkownik moze by¢ rowniez zainteresowany innymi
polami, na przyktad krotkim opisem rekordu (pole Short Desc) lub tytutem rekordu (pole Title). Dowolne pola
wyjsciowe mozna wybrac jako dane wyjsciowe dla nastgpnego w kolejnosci wezta Text Mining.

Uwaga: Nie mozna uzywa¢ wezta Web Feed do oceny w ramach konfiguracji produktu IBM SPSS Collaboration and
Deployment Services - Scoring.

Wezel ten znajduje si¢ na karcie IBM SPSS Modeler Text Analytics palety weztéw w oknie IBM SPSS Modeler.
Wiecej informacji zawiera temat [*Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8

Wezel Web Feed: karta Input

Karta Input jest uzywana do okreslania co najmniej jednego adresu WWW lub URL w celu przechwycenia danych
tekstowych. W kontekscie eksploracji tekstu mozna okresla¢ adresy URL dla kanatow informacyjnych zawierajacych
dane tekstowe.

Wazne: W przypadku pracy z danymi innymi niz RSS lepszym rozwiazaniem moze by¢ uzycie narzgdzia do ekstrakcji
danych ze stron WWW, takiego jak WebQL®, ktére postuzy do automatyzacji gromadzenia tresci, a nastepnie

tworzenia odniesien z tego narzedzia przy uzyciu innego wezta zrodtowego.

Mozna ustawié¢ nastgpujace parametry:
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Enter or paste URLs. Do tego pola mozna wpisac¢ lub wkleja¢ adresy URL (co najmniej jeden). Jesli wprowadzasz
wigcej niz jeden adres, wprowadz tylko jeden na wiersz i uzyj klawisza Enter/Return, aby rozdzieli¢ wiersze.
Wprowadz petny adres URL do pliku. W przypadku kanatéw informacyjnych te adresy URL moga przyjmowac¢ jeden z
dwoch formatow:

» Format RSS. RSS to prosty standaryzowany format oparty na XML dla tresci WWW. Adres URL dla tego formatu
wskazuje na strong, na ktdorej znajduje si¢ zestaw dowiazanych artykutow, takich jak syndykowane zrodta
wiadomosci i blogi. RSS jest formatem standaryzowanym, dlatego kazdy dowiazany artykut jest automatycznie
identyfikowany i traktowany jako osobny rekord w wynikowym strumieniu danych. Nie sa wymagane zadne
dodatkowe dane wejsciowe umozliwiajace identyfikowanie istotnych danych tekstowych oraz rekordow z kanatu
informacyjnego, chyba ze wzgledem tekstu zastosowano technikg filtrowania.

* Format HTML. Na karcie Input mozna zdefiniowac jeden lub wigksza liczbe adresow URL do stron HTML.
Nastgpnie na karcie Records nalezy zdefiniowac znacznik poczatku rekordu, a takze wskaza¢ znaczniki
ograniczajace tre$¢ docelowa i przypisac te znaczniki do wybranych pol wyjsciowych (opis, tytut, data modyfikacji
itp.). W przypadku pracy z danymi innymi niz RSS lepszym rozwiazaniem moze by¢ uzycie narzedzia do ekstrakcji
danych ze stron WWW, takiego jak WebQL®, ktére postuzy do automatyzacji gromadzenia tresci, a nastepnie
tworzenia odniesien z tego narzedzia przy uzyciu innego wezta zrédlowego. Wigcej informacji zawiera temat
[“Wezet Web Feed: karta Records™

Number of most recent entries to read per URL. To pole okresla maksymalna liczbg rekordow do odczytu dla
kazdego adresu URL okreslonego w polu, poczawszy od pierwszego rekordu znalezionego w kanale informacyjnym.
Tlosé tekstu wptywa na szybko$¢ przetwarzania podczas dalszego wyodregbniania w wezle Text Mining lub wezle Text
Link Analysis.

Save and reuse previous web feeds when possible. Ta opcja umozliwia skanowanie kanatow informacyjnych WWW,
a przetworzone wyniki sa buforowane. Nastgpnie po kolejnych wykonaniach strumienia, jesli zawarto$¢ konkretnego
kanatu informacyjnego nie ulegta zmianie lub jesli kanal informacyjny jest niedostgpny (na przyktad z powodu braku
dostepu do Internetu), wowczas w celu przyspieszenia przetwarzania uzywana jest zbuforowana wersja. Kazda nowa
tre$¢ wykryta w tych kanatach informacyjnych réwniez jest buforowana przy nastgpnym wykonaniu wezta.

» Etykieta. W przypadku wybrania opcji Save and reuse previous web feeds when possible nalezy okresli¢ nazwe
etykiety dla wynikéw. Ta etykieta bedzie uzywana do opisywania kanatow informacyjnych buforowanych na
serwerze. Jesli zadna etykieta nie zostanie okreslona lub nie zostanie rozpoznana, wéwczas ponowne uzycie nie
bedzie mozliwe. Buforami kanatow informacyjnych WWW mozna zarzadzac¢ w tabeli sesji produktu IBM SPSS
Text Analytics Administration Console zawartej w IBM SPSS Deployment Manager. Wigcej informacji zawiera
dokument Deployment Manager — Podrecznik uzytkownika.

Wezel Web Feed: karta Records

Karta Records stuzy do okreslania zawartosci tekstowej kanatow informacyjnych innych niz RSS poprzez
wskazywanie poczatku kazdego rekordu, a takze poprzez podawanie innych istotnych informacji dotyczacych
poszczegolnych rekordow. Jesli wiadomo, ze kanatl informacyjny inny niz RSS (HTML) zawiera tekst znajdujacy si¢ w
wielu rekordach, wowczas na tej karcie nalezy wskaza¢ znacznik poczatku rekordu, poniewaz w przeciwnym wypadku
tekst bedzie traktowany jako jeden rekord. Kanaty RSS sa standaryzowane i nie wymagaja okreslania zadnych
znacznikow na tej karcie, ale nadal mozna wyswietli¢ podglad tresci na karcie Preview.

Wazne! W przypadku pracy z danymi innymi niz RSS lepszym rozwiazaniem moze by¢ uzycie narzgdzia do ekstrakcji
danych ze stron WWW, takiego jak WebQL®, ktore postuzy do automatyzacji gromadzenia tresci, a nastepnie
tworzenia odniesien z tego narzgdzia przy uzyciu innego wezta zrodtowego.

URL. Ta lista rozwijana zawiera adresy URL wprowadzone na karcie Input. Zawiera kanaty informacyjne w formacie
HTML i RSS. Jesli adres URL jest zbyt dtugi i nie zmiesci si¢ na liscie rozwijanej, zostanie automatycznie obcigty na
srodku, a obcicty tekst zostanie zastapiony wielokropkiem, np. http://www.ibm.com/example/start-of-address...rest-of-
address/path.htm.
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 Jesli kanal informacyjny w formacie HTML zawiera wigcej niz jeden rekord (lub wpis), wowczas mozna
zdefiniowa¢ znaczniki HTML zawierajace dane odpowiadajace polu widocznemu w tabeli. Mozna na przyktad
zdefiniowa¢ znacznik poczatkowy oznaczajacy, ze rozpoczat si¢ nowy rekord, znacznik daty modyfikacji albo
nazwiska autora.

* W przypadku kanaléw informacyjnych w formacie RSS nie pojawia si¢ zadna zachg¢ta do wprowadzania
znacznikow, poniewaz RSS jest formatem standaryzowanym. Jednak w razie potrzeby przyktadowe wyniki mozna
wyswietli¢ na karcie Preview. Wszystkie rozpoznane kanaty informacyjne RSS poprzedza obraz logo RSS.

Karta Source. Na tej karcie mozna wyswietli¢ kod zrodlowy dla dowolnych kanatéw informacyjnych HTML. Ten kod
nie jest dostgpny do edycji. Za pomoca pola Find mozna odszuka¢ konkretne znaczniki i informacje na tej stronie, ktore
nastgpnie mozna skopiowac i wklei¢ do tabeli ponizej. W polu Find nie jest rozrézniana wielko$¢ znakow i nie sa
znajdowane tancuchy czesciowe.

Karta Preview. Na tej karcie mozna sprawdzi¢ to, w jaki sposob rekord bedzie odczytywany przez wezet Web Feed.
Jest to szczegolnie uzyteczne w przypadku kanatow informacyjnych HTML, poniewaz umozliwia zmiang sposobu
odczytu rekordu poprzez zdefiniowanie znacznikow HTML w tabeli ponizej karty Preview.

Non-RSS record start tag. Ta opcja obowiazuje tylko w przypadku kanatéw informacyjnych innych niz RSS. Jesli
kanat informacyjny HTML zawiera duza ilo$¢ tekstu, ktory zostanie przez uzytkownika podzielony na wiele rekordow,
wowczas w tej opcji nalezy okresli¢ znacznik HTML wskazujacy poczatek rekordu (na przyktad artykut lub wpis w
blogu). Jesli w przypadku kanatu informacyjnego innego niz RSS Zaden taki znacznik nie zostanie zdefiniowany,
woweczas cala strona bedzie traktowana jako jeden rekord, cata zawarto$¢ bedzie dostgpna w polu Description, a data
wykonania wezta bedzie uzywana jako data modyfikacji (Modified Date), a takze jako data publikacji (Published
Date).

Field table. Ta opcja obowiazuje tylko w przypadku kanatéw informacyjnych innych niz RSS. W tej tabeli mozna
podzieli¢ zawartos¢ tekstowa na konkretne pola wynikowe. W tym celu nalezy wprowadzi¢ znacznik poczatkowy dla
dowolnego ze wstepnie zdefiniowanych pol wyjsciowych. Nalezy wprowadzi¢ tylko znacznik poczatkowy. Wszystkie
operacje dopasowania sa wykonywane poprzez analizg sktadni HTML i dopasowywanie zawartosci tabeli do nazw i
atrybutéw znacznikow znalezionych w kodzie HTML. Przyciski dostgpne na dole moga by¢ uzywane do kopiowania
zdefiniowanych znacznikéw i ich ponownego uzycia w pozostalych kanatach informacyjnych.

Tabela 2. MozZliwe pola wyjsciowe dla kanatow informacyjnych innych niz RSS (formaty HTML)

Nazwa pola wyjsciowego Oczekiwana zawarto$¢ znacznika

Title Znacznik ograniczajacy tytut rekordu (opcjonalny).

Short Desc Znacznik ograniczajacy krotki opis lub etykiete (opcjonalny).

Description Znacznik ograniczajacy tekst gtowny. Jesli to pole zostanie pozostawione puste, bedzie zawierato

cala pozostata zawarto$¢ w znaczniku <body> (jesli istnieje pojedynczy rekord) lub zawartosé
znaleziona w biezacym rekordzie (jesli okreslono ogranicznik rekordu).

Author Znacznik ograniczajacy nazwisko autora tekstu (opcjonalny).
Contributors Znacznik ograniczajacy nazwiska kontrybutoréw (opcjonalny).
Published Date Znacznik ograniczajacy date opublikowania tekstu. Jesli to pole pozostanie puste, wowczas

bedzie zawieralo datg odczytu danych przez wezet.

Modified Date Znacznik ograniczajacy date modyfikacji tekstu. Jesli to pole pozostanie puste, wowczas bgdzie
zawierato date odczytu danych przez wezet.

Jesli uzytkownik wprowadzi do tabeli znacznik, wowczas kanal informacyjny zostanie zeskanowany, przy czym ten
znacznik bedzie uzywany jako znacznik minimum, a nie jako znacznik doktadnej zgodnosci. Oznacza to, ze w
przypadku wprowadzenia znacznika <div> do pola Title ten znacznik bgdzie zgodny z dowolnym znacznikiem <div>
w kanale informacyjnym, co obejmuje takze znaczniki o okre$lonych atrybutach (np.<div class="post three”>), przez
co znacznik <div> bedzie rdOwny znacznikowi gtéwnemu (<div>) oraz wszelkim znacznikom pochodnym, ktore
zawieraja atrybut i uzywaja zawartosci dla pola wyjsciowego Title. Jesli zostanie wprowadzony znacznik gtéwny,
woweczas wszelkie pozostale atrybuty rowniez zostana uwzglednione.
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Tabela 3. Przyktady znacznikéw HTML, ktére identyfikuja tekst dla pdl wyjsciowych

Jesli wprowadzisz: Bedzie zgodny z: A takze zgodny z: Ale niezgodny z:

<div> <div> <div class="post™> kazdym innym tagiem

<p class="auth”> <p class="auth”> <p color="black” class="auth” <p color="black”>
id="85643">

Wezelt Web Feed: karta Content Filter

Karta Content Filter umozliwia stosowanie techniki filtrowania wzgledem zawartosci z kanatu informacyjnego RSS. Ta
karta nie ma zastosowania w przypadku kanaléw informacyjnych HTML. Za pomoca tej karty mozna filtrowac
zawartos$¢ z kanatu informacyjnego na podstawie tego, czy zawiera duzo tekstu w nagtowkach, stopkach, menu, w
postaci reklam itp. Przy uzyciu tej karty mozna usuna¢ z zawartosci niepozadane znaczniki HTML, JavaScript, a takze
skroci¢ stowa lub wiersze z zawartosci.

Content Filtering. Jesli technika czyszczenia nie bedzie uzywana, nalezy wybra¢ opcje None. W przeciwnym
wypadku nalezy wybrac opcje RSS Content Cleaner.

Opcje RSS Content Cleaner. Jesli zostanie wybrana opcja RSS Content Cleaner, wowczas mozna kasowaé wiersze
na podstawie niektorych kryteriow. Wiersz jest ograniczony znacznikiem HTML, takim jak <p> i <li>, ale nie dotyczy
to znacznikow znajdujacych si¢ w wierszu, takich jak <span>, <b> ani <font>. Nalezy zwroci¢ uwage na to, ze
znaczniki <br> sa przetwarzane jako podzialy wierszy.

* Discard short lines. Ta opcja powoduje ignorowanie wierszy zawierajacych zdefiniowana w opcji minimalna liczbg
stow (minimum number of words).

* Discard lines with short words. Ta opcja powoduje ignorowanie zawierajacych zdefiniowana w opcji minimalna
$rednig liczbe stow (minimum average word length).

* Discard lines with many single character words. Ta opcja powoduje ignorowanie wierszy zawierajacych wigcej
stow jednoznakowych (proportion of single character words) niz ustalona proporcja.

* Discard lines containing specific tags. Ta opcja powoduje ignorowanie tekstu w wierszach, ktore zawieraja
dowolne znaczniki okreslone w polu.

* Discard lines containing specific text. Ta opcja powoduje ignorowanie wierszy, ktore zawieraja dowolny tekst
okreslony w polu.

Korzystanie z wezla Web Feed w eksploraciji tekstu

Wezet Web Feed moze by¢ uzywany do przygotowywania danych tekstowych z kanatéw informacyjnych WWW na
potrzeby eksploracji tekstu. Ten wezet przyjmuje kanaty informacyjne WWW w formacie HTML i RSS. Te kanaty
informacyjne petnia rolg danych wejsciowych dla procesu eksploracji tekstu (dla dalszego wezta Text Mining lub
wezta Text Link Analysis).

W przypadku korzystania z wegzta Web Feed nalezy w wezle Text Mining lub Text Link Analysis wybra¢ opcjg Text
field represents actual text w celu wskazania, ze te kanaly informacyjne sa potaczone z poszczegolnymi artykutami lub
wpisami w blogu.

Wazne! Jesli informacje maja by¢ pobierane z sieci WWW za posrednictwem serwera proxy, nalezy w pliku
net.properties wiaczy¢ serwer proxy zaréwno dla klienta, jak i serwera IBM SPSS Modeler Text Analytics.
Szczegdtowe instrukcje postgpowania znajduja si¢ w samym pliku. Dotyczy to sytuacji, w ktérej dostgp do sieci WWW
odbywa sig za posrednictwem wezta Web Feed lub pobierana jest licencja na oprogramowanie SDL Software as a
Service (SaaS), poniewaz odpowiednie potaczenia przechodza przez Java. Wspomniany plik domyslnie znajduje si¢ w
lokalizacji C:\Program Files\IBM\SPSS\Modeler\18.1.1\jre\lib\net.properties.

Przyktad: wezel Web Feed (kanat informacyjny RSS) z weztem modelowania Text Mining

Zatézmy na przyktad, ze potaczylismy wezet Web Feed z weztem Text Mining w celu przekazania danych tekstowych
z kanalu informacyjnego RSS do procesu eksploracji tekstu.
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1. Wezel Web Feed (karta Input). Najpierw dodaliSmy ten wezet do strumienia, aby okresli¢, gdzie znajduje si¢
zawartos$¢ kanatu informacyjnego i zweryfikowa¢ strukturg zawartosci. Na pierwszej karcie udostgpnilismy adres
URL do kanatu informacyjnego RSS. Nasz przyktad dotyczy kanatu informacyjnego RSS, dlatego formatowanie
jest juz zdefiniowane i nie musimy wprowadza¢ zadnych dodatkowych zmian na karcie Records. W przypadku
kanatow informacyjnych RSS dostgpny jest opcjonalny algorytm filtrowania zawartosci, jednak w tym przypadku
nie byl on stosowany.

2. Wezel Text Mining (karta Fields). Nast¢pnie dodalismy i potaczyliSmy wezet Text Mining z weztem Web Feed.
Na tej karcie zdefiniowalismy wyjscie pola tekstowego wedtug wezta Web Feed. W tym przypadku chcielismy
uzy¢ pola Description. Ponadto wybralismy opcje Text field represents actual text, a takze inne ustawienia.

3. Wezel Text Mining (karta Model). Nastepnie na karcie Model wybralismy tryb budowania i zasoby. W tym
przyktadzie wybieramy zbudowanie modelu poje¢ bezposrednio z tego wezta przy uzyciu domyslnego szablonu
Zasobow.

Wigcej informacji o korzystaniu z wezta Text Mining zawiera sekcja[‘Wezel modelowania Text Mining” na stronie 20}

Wezel jezyka
Do identyfikacji jezyka naturalnego w polu tekstu w danych zrédtowych mozna uzy¢ wezta jezyka.

Wynikiem tego wezta jest pochodna zmienna, ktora zawiera wykryty kod jezyka.

Uwaga: Nie mozna uzy¢ wezla jezyka do oceny w ramach w konfiguracji IBM SPSS Collaboration and Deployment
Services - Scoring.

Wezel ten znajduje sig na karcie IBM SPSS Modeler Text Analytics palety weztéw w oknie IBM SPSS Modeler.
Wiecej informacji zawiera temat[*Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8

Wezel jezyka: karta Settings

Na tej karcie mozna okresli¢, w jaki sposdb przedstawiac szczegdty jezyka dotyczace wybranej zmiennej tekstowe;.
Text field Wybierz zmienna tekstowa, dla ktorej chcesz okreslic jezyk.

Derive field name Wprowadz nazwg zmiennej pochodnej, ktora bedzie zawiera¢ kod wykrytego jezyka. Wartoscia
domyslna jest Language.

Default value for when language cannot be identified Podaj nazwe zmiennej, ktdra zostanie utworzona, jesli jezyk
nie zostanie zidentyfikowany. Dostgpne sa nastgpujace opcje:

* Undefined Jesli wybrano tg opcjg, wowczas zmienna pochodna nie zawiera zadnych wartosci.

* Supported Jesli wybrano te opcje, wowcezas mozna wybraé jeden z nastgpujacych obstugiwanych jezykoéw ISO:
— Angielski (EN)
— Niemiecki (DE)
— Hiszpanski (ES)
— Francuski (FR)
— Wioski (IT)
— Niderlandzki (NL)
— Portugalski (PT)

* Custom Jesli zaden z obstugiwanych jezykow nie jest odpowiedni, nalezy uzyc¢ tej opcji, aby okresli¢, ze powinna
by¢ uzywana warto$¢ uzytkownika. Zwykle moga to by¢ 2 litery kodu jezyka ISO, ale rowniez dowolny tanicuch
tekstowy, ktory jest wymagany.
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Rozdziat 3. Eksploracja w poszukiwaniu pojec¢ i kategorii

Wezet Text Mining stuzy do generowania jednego z dwdch modeli uzytkowych eksploracji tekstu:
* Modele uzytkowe poje¢ ujawniaja 1 wyodrebniaja pojecia wyrozniajace si¢ wsrod ustrukturyzowanych i
nieustrukturyzowanych danych tekstowych.

* Modele uzytkowe kategorii oceniaja dokumenty oraz rekordy i przypisuja je do kategorii, ktdre sa tworzone z
wyodrgbnionych pojec¢ (i wzorcow).

Wyodrebnione pojecia i wzorce, a takze kategorie z modeli uzytkowych, moga by¢ taczone z istniejacymi danymi
ustrukturyzowanymi, takimi jak dane demograficzne, a nastepnie moga by¢ stosowane przy uzyciu petnego pakietu
narzedzi IBM SPSS Modeler w celu podejmowania lepszych decyzji przy zmniejszonej ilosci zaktocen. Na przyktad
jesli klienci czgsto wymieniaja problemy z logowaniem jako gldwne czynniki utrudniajace wykonywanie zadan
zarzadzania kontami online, wowczas w modelach mozna uwzgledni¢ “problemy z logowaniem”.

Ponadto wegzel modelowania Text Mining jest w pelni zintegrowany w produkcie IBM SPSS Modeler, dzigki czemu
strumienie eksploracji tekstu mozna wdraza¢ za posrednictwem programu IBM SPSS Modeler Solution Publisher,
ktéry umozliwia ocenianie danych nieustrukturyzowanych w czasie rzeczywistym w aplikacjach, takich jak
PredictiveCallCenter. Mozliwo$¢ wdrazania tych strumieni pozwala na pomy$lne implementacje eksploracji tekstu w
zamknigtej petli. Przyktad: organizacja moze analizowaé notatki z rozméw wychodzacych i przychodzacych, stosujac
modele predykcyjne w celu zwigkszenia doktadnosci przekazu marketingowego w czasie rzeczywistym. Wykazano, ze
wykorzystywanie wynikow modelu eksploracji tekstu w strumieniach poprawia doktadnos¢ predykcyjnych modeli
danych.

Aby uzywac IBM SPSS Modeler Text Analytics z komponentem IBM SPSS Modeler Solution Publisher, dodaj katalog
<katalog_instalacyjny>/ext/bin/spss. TMWBServer do zmiennej srodowiskowej $LD_LIBRARY_PATH.

W produkcie IBM SPSS Modeler Text Analytics czgsto odwotujemy si¢ do wyodrgbnionych poje¢ i kategorii. Wazne
jest zrozumienie znaczenia pojeé i kategorii, poniewaz moga one utatwia¢ podejmowanie bardziej swiadomych decyzji
podczas eksploracji i tworzenia modeli.

Pojecia i modele uzytkowe pojec

Podczas procesu wyodrgbniania dane tekstowe sa skanowane i analizowane w celu identyfikowania interesujacych lub
istotnych pojedynczych stow, takich jak wybory lub pokdj, a takze fraz, takich jak wybory prezydenckie, wybory na
prezydenta oraz traktaty pokojowe. Te stowa i frazy sa zbiorczo okreslane jako terminy. Istotne terminy sa
wyodrebniane z wykorzystaniem zasobow lingwistycznych, a podobne terminy sa grupowane pod terminem
wiodacym, nazywanym pojeciem.

W ten sposdb jedno pojecie moze reprezentowaé rdzne terminy w zaleznosci od tekstu i zestawu wykorzystywanych
zasobow jezykowych. Zatézmy na przyktad, ze mamy wyniki badania zadowolenia pracownikow i wyodrgbnilismy
pojecie salary (wynagrodzenie). Zatozmy rowniez, ze przy wyszukiwaniu wszystkich rekordow zwiazanych z
pojeciem salary zauwazyli$my, ze wyraz salary nie zawsze jest obecny w tek$cie — niektore rekordy zawieraty
podobne terminy, takie jak wage, wages i salaries. Terminy te sa zgrupowane pod pojeciem salary, poniewaz na
podstawie regut przetwarzania lub zasobdw lingwistycznych mechanizm wyodrgbniania uznat je za podobne lub
stwierdzil, ze sa synonimami. W tym przypadku wszystkie dokumenty lub rekordy zawierajace ktérykolwiek z tych
terminow beda traktowane, jak gdyby zawieraly wyraz salary.

W celu sprawdzenia, jakie terminy sa pogrupowane w ramach pojgcia, mozna eksplorowac pojecie w interaktywnym
srodowisku roboczym albo zapoznac¢ si¢ z tym, jakie synonimy zawiera model pojgcia. Wigcej informacji zawiera
temat [“Terminy w modelach poje¢” na stronie 32|
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Model uzytkowy pojecia zawiera zestaw pojec, ktére moga by¢ uzywane w celu wskazywania rekordow lub
dokumentéw mogacych rowniez zawierac pojgcie (w tym dowolne z jego synoniméw lub pogrupowanych terminow).
Model pojecia moze by¢ uzywany na dwa sposoby. Pierwszym jest eksploracja i analiza pojg¢ wykrytych w
oryginalnym tekscie zrodtowym albo szybka identyfikacja interesujacych dokumentow. Drugim jest zastosowanie tego
modelu wzglgdem nowych rekordéow lub dokumentow tekstowych w celu szybkiej identyfikacji tych samych pojec
kluczowych w nowych dokumentach/rekordach, np. wykrywanie w czasie rzeczywistym poje¢ kluczowych w danych z
notatnikow w centrum zgloszeniowym.

Wiecej informacji zawiera temat[‘Model uzytkowy Text Mining: model poje¢” na stronie 30}

Kategorie i modele uzytkowe kategorii

Mozliwe jest tworzenie kategorii, ktore w gruncie rzeczy reprezentuja bardziej ogolne pojecia albo tematy
przeznaczone do przechwytywania kluczowych idei, informacji i postaw wyrazonych w tekscie. Kazda kategoria
obejmuje zestaw deskryptorow, takich jak pojecia, typy i reguly. Razem te deskryptory stuza do okreslania, czy
konkretny rekord lub dokument nalezy do danej kategorii. Dokument lub rekord mozna przeskanowaé, aby sprawdzic,
czy jakikolwiek fragment tekstu jest zgodny z deskryptorem. W przypadku znalezienia dopasowania dokument/rekord
jest przypisywany do tej kategorii. Ten proces jest nazywany klasyfikowaniem.

Kategorie moga by¢ tworzone automatycznie przy wykorzystaniu dostgpnego w produkcie, niezawodnego zestawu
automatycznych technik; recznie z wykorzystaniem dodatkowych spostrzezen na temat danych albo przy uzyciu obu
tych metod. Mozliwe jest takze wczytanie zestawu wstgpnie utworzonych kategorii z pakietu analizy tekstu, za
posrednictwem karty Model w tym wezle. Rgezne tworzenie kategorii lub korygowanie definicji kategorii jest mozliwe
tylko za posrednictwem interaktywnego srodowiska roboczego. Wigcej informacji zawiera temat[“Wezet Text Mining|
karta Model” na stronie 23|

Model uzytkowy kategorii zawiera zestaw kategorii wraz z jego deskryptorami. Ten model moze stuzy¢ do
klasyfikowania zestawu dokumentow lub rekordow na podstawie tekstu zawartego w kazdym z nich. Kazdy dokument
lub rekord jest czytany, a nastgpnie przypisywany do kazdej kategorii, dla ktdrej znalezione zostato dopasowanie z
deskryptorem. W ten sposob dokument lub rekord moze zosta¢ przypisany do wigcej niz jednej kategorii. Modele
uzytkowe kategorii moga rowniez stuzy¢ na przyktad do zapoznawania sig z kluczowymi ideami w odpowiedziach na
otwarte pytania do ankiet albo w serii wpisow w blogu.

Wiecej informacji zawiera temat[‘Model uzytkowy Text Mining: model kategorii” na stronie 39|

Wezel modelowania Text Mining

Wezet Text Mining przy uzyciu technik analizy lingwistycznej i analizy liczebno$ci wystgpowania wyodrebnia
kluczowe pojecia z tekstu i tworzy kategorie zawierajace te pojgcia oraz inne dane. Wezet ten mozna wykorzystaé¢ do
eksploracji danych tekstowych lub do wygenerowania modelu uzytkowego poje¢¢ lub modelu uzytkowego kategorii.
Podczas wykonywania tego wezta modelowania wewngtrzny mechanizm lingwistyczny wyodrgbnia i porzadkuje
pojecia, wzorce i/lub kategorie, stosujac metody przetwarzania jezyka naturalnego.

Korzystajac z opcji Generate directly, mozna uruchomi¢ wezet Tex Mining, a po jego wykonaniu automatycznie
wygenerowa¢ model uzytkowy pojec lub kategorii. Alternatywa jest zastosowanie bardziej interaktywnego,
eksploracyjnego podejscia w trybie Build interactively, w ktorym mozna nie tylko wyodrebnia¢ pojecia, tworzy¢
kategorie i optymalizowac zasoby lingwistyczne, lecz takze prowadzi¢ analize powiazan w tekscie i eksplorowac
skupienia. Wigcej informacji zawiera temat|“que’r Text Mining: karta Model” na stronie 23[

Wezet ten znajduje sig na karcie IBM SPSS Modeler Text Analytics palety weztdéw w oknie IBM SPSS Modeler.
Wigcej informacji zawiera temat [*Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8}

Wymagania. Wezty modelowania Text Mining przyjmuja dane z wezta Web Feed, wezla File List i wszystkich
standardowych weztéw zrodtowych. Ten wezet jest instalowany razem z produktem IBM SPSS Modeler Text
Analytics i dostgpny na palecie IBM SPSS Modeler Text Analytics.
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Uwaga: Ten wezel zastepuje wezet Text Extraction oferowany w starszych wersjach produktu. Jesli masz starsze
strumienie korzystajace ze starszych weztdéw lub modeli uzytkowych, musisz przebudowac je, stosujac nowy wezet
Text Mining.

Wezel Text Mining: karta Fields

Karta Fields stuzy do okreslenia ustawien dotyczacych zmiennych zawierajacych dane, z ktérych maja by¢
wyodregbniane pojgcia. W przypadku pracy z obszernymi zbiorami danych warto rozwazy¢ uzycie przed tym wezltem
wezta proby w celu skrocenia czasu przetwarzania. Wigcej informacji zawiera temat[“Wczeéniejsze wybieranie proby|
W celu zaoszczedzenia czasu” na stronie 29|

Mozna ustawié¢ nastgpujace parametry:

ID field Wybierz zmienna zawierajaca identyfikator rekordow tekstowych. Identyfikatory musza by¢ liczbami
calkowitymi. Zmienna identyfikacyjna stuzy jako indeks dla poszczegodlnych rekordow tekstowych. Uzyj zmiennej
identyfikacyjnej, jesli zmienna tekstowa zawiera tekst, ktory ma by¢ eksplorowany.

Text field. Wybierz zmienna zawierajaca tekst do eksploracji. Zmienna ta zalezy od zrédta danych.

Language field Wybierz zmienna zawierajaca 2-literowy identyfikator jezyka ISO. Jesli nie wybierzesz zmiennej, dla
kazdego dokumentu przyjety zostanie jezyk na podstawie dostarczonego szablonu.

Document type. Typ dokumentu okresla strukturg tekstu. Wybierz jeden z nastgpujacych typow:

* Full text. Odpowiedni dla wigkszosci dokumentow i zrodet tekstowych. Podczas wyodrebniania przegladany jest
caly zbior tekstu. Z ta opcja, w odrdznieniu od pozostatych, nie sa zwiazane zadne ustawienia dodatkowe.

* Structured text. Odpowiedni do analizy formularzy bibliograficznych, patentow i innych plikow zawierajacych
regularne struktury dajace si¢ rozpoznac i przeanalizowa¢. Zastosowanie tego typu dokumentow wiaze si¢ z
pominigciem catosci lub czgsci procesu wyodrgbniania. Umozliwia zdefiniowanie separatorow termindw,
przypisywanie typow i okreslenie wymaganej minimalnej czgstotliwosci. W przypadku wybrania tej opcji nalezy
klikna¢ przycisk Settings i wprowadzi¢ separatory tekstu w obszarze Structured Text Formatting okna
dialoiowego Document Settings. Wiecej informacji zawiera temat|“Ustawienia dokumentow na karcie Zmienne” nal

Textual unity. Wybierz jeden z nastepujacych trybéw wyodrebniania:

* Document mode. Tryb odpowiedni do pracy z krétkimi i semantycznie jednorodnymi dokumentami, takimi jak
artykuty prasowe.

* Paragraph mode. Odpowiedni do stron WWW i dokumentow bez znacznikow. W procesie wyodrgbniania
dokumenty sa semantycznie dzielone na podstawie takich cech wewnetrznych, jak wewngtrzne znaczniki i sktadnia.
Wybranie tego trybu powoduje, ze ocenianie odbywa si¢ akapit po akapicie. Dlatego, na przyktad, reguta apple &
orange jest spelniona tylko wtedy, gdy apple i orange wystepuja w tym samym akapicie.

Uwaga: Z uwagi na sposob wyodrgbniania tekstu z dokumentow PDF tryb Paragraph mode nie dziata z takimi
dokumentami. Wynika to z faktu, ze podczas wyodrebniania pomijane sa znaki powrotu karetki.

Paragraph mode settings. Ta opcja jest dostegpna tylko wtedy, opcje zgodnosci tekstowej ustawiono na Paragraph
mode. Okresl progi liczby znakdéw obowiazujace we wszystkich procesach wyodrebniania. Rzeczywisty rozmiar jest
zaokraglany w gore lub w dot do najblizszej kropki. Aby mie¢ pewnos¢, ze asocjacje wyrazow wygenerowane z tekstu
zawartego w zbiorze dokumentow sa reprezentatywne, nalezy unikac okreslania zbyt malego rozmiaru wyodrgbniania.

* Minimum. Okre$l minimalna liczbg znakéw, jaka ma by¢ uzywana w kazdym wyodrebnianiu.

* Maksimum. Okre$l maksymalna liczbg znakow, jaka ma by¢ uzywana w kazdym wyodrgbnianiu.

Partition mode Tryb dzielenia na podzbiory pozwala zdecydowaé, czy podzial ma si¢ odbywac na podstawie ustawien
typu wezta, czy w inny sposéb. Dzielenie na podzbiory polega na podzieleniu danych na proby uczace i testujace.
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Ustawienia dokumentow na karcie Zmienne
Structured Text Formatting

Jesli cheesz pomina¢ wszystkie lub niektdre etapy procesu wyodrebniania, poniewaz dane wejsciowe sa
ustrukturyzowane lub cheesz okresli¢ reguty postgpowania z tekstem, jako typ dokumentéw wybierz Structured text i
zadeklaruj pola lub znaczniki zawierajace tekst w sekcji Structured Text Formatting okna dialogowego Document
Settings. W procesie wyodregbniania terminy beda wywodzone wytacznie z tekstu zawartego we wskazanych polach
lub znacznikach (i ich znacznikach podrzednych). Wszelkie niezadeklarowane pola i znaczniki bgda ignorowane.

W pewnych kontekstach przetwarzanie lingwistyczne nie jest wymagane, a mechanizm wyodrebniania lingwistycznego
mozna zastapi¢ jawnymi deklaracjami. W pliku bibliograficznym, w ktérym pola zawierajace stowa kluczowe sa
oddzielone separatorami, takimi jak §redniki (;) lub przecinki (,), wystarczy wyodrebni¢ tancuch spomigdzy dwoch
separatorow. Dlatego mozna zrezygnowac z petnego procesu wyodrgbniania i zamiast niego zastosowac specjalne
reguly postepowania z tekstem, ktore beda obejmowaty deklaracje separatorow migdzy terminami, przypisywaty typy
do wyodrgbnionego tekstu lub narzucaty minimalna liczebno$¢ wystapien przy wyodrgbnianiu.

Deklarujac elementy tekstu ustrukturyzowanego, nalezy przestrzegac nastgpujacych regut:

* W jednym wierszu mozna zadeklarowac tylko jedno pole, jeden znacznik lub jeden element. Zadeklarowane
pola/znaczniki/elementy nie musza by¢ obecne w danych.

* W deklaracjach rozrézniana jest wielkos$c¢ liter.

* Jesli deklarujesz znacznik z atrybutami, na przyktad <title id="1234">, i chcesz uwzgledni¢ wszelkie warianty lub,
w tym przypadku, wszystkie identyfikatory, dodaj znacznik bez atrybutu lub koncowego nawiasu (>), na przyktad
<title

* Dwukropek za nazwa pola lub znacznika sygnalizuje, Ze jest to tekst ustrukturyzowany. Dwukropek nalezy dopisac¢
bezposrednio za polem lub znacznikiem, ale przed ewentualnymi separatorami, typami lub wartosciami czgstosci, na
przyktad author: lub <place>:.

* Aby wskazac, ze pole lub znacznik zawiera wiele termindw rozdzielonych separatorem, zadeklaruj separator za
dwukropkiem, na przyktad: author:, lub <section>:;.

* Aby przypisa¢ typ do zawarto$ci znacznika, zadeklaruj nazwe typu za dwukropkiem i separatorem, na przyktad:
author:,Person lub <place>:;Location. Typy deklaruje si¢ przy uzyciu tych samych nazw, ktore uzywane sa w
oknie Resource Editor.

* Aby zdefiniowa¢ minimalna liczebnos¢ wystapien pola lub znacznika, okresl liczbe na koncu wiersza, na przyktad:
author:,Person1 lub <place>:;Location5. n jest liczebnoscia wystapien, co oznacza, ze termin znaleziony w polu
lub znaczniku musi wystapic¢ co najmniej n razy w calym zbiorze dokumentow, aby zostat wyodrebniony. W takiej
sytuacji wymagane jest takze zdefiniowanie separatora.

» Jesli znacznik zawiera dwukropek, to nalezy poprzedzi¢ ten dwukropek ukosnikiem odwrotnym, aby deklaracja nie
zostata zignorowana. Na przyktad, jesli jedno z pdl nosi nazwe <topic:source>, to nalezy je zadeklarowac jako
<topic\:source>.

Dla celow ilustracyjnych zatézmy, ze mamy w dokumentach nastgpujace powtarzalne pola bibliograficzne:

author:Morel, Kawashima

abstract:W artykule opisano metody deklarowania pél.
publication:Dokumentacja eksploracji tekstu
datepub:March 2010

Gdybysmy chcieli wyodrebniac tylko nazwiska autorow i streszczenia, ale ignorowac resztg tresci, moglibySmy
zadeklarowac nastgpujace pola:

author:,Personl
abstract:

Przyktadowa deklaracja author:,Personi oznacza, ze zawartos¢ pola nie powinna by¢ przetwarzania lingwistycznie.

Okresla natomiast, ze pole author zawiera wigcej niz jedno nazwisko, nazwiska sa oddzielone od siebie przecinkami i
powinny by¢ przypisywane do typu Person, a jesli nazwisko wystgpuje co najmniej raz w calym zbiorze dokumentow,
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to powinno zosta¢ wyodrebnione. Poniewaz pole abstract: jest wymienione bez zadnych dodatkowych deklaracji, to w
procesie wyodrebniania bedzie przegladane i bedzie podlegaé standardowemu przetwarzaniu lingwistycznemu oraz
przypisywaniu typow.

XML Text Formatting

Jesli cheesz ograniczy¢ proces wyodrgbniania tylko do tekstu wewnatrz okreslonych znacznikéw XML, uzyj typu
dokumentu XML text i zadeklaruj znaczniki zawierajace tekst w sekcji XML Text Formatting okna dialogowego
Document Settings. W procesie wyodrebniania terminy beda wywodzone wylacznie z tekstu zawartego we wskazanych
znacznikach i ich znacznikach podrzednych.

Wazne! Jesli chcesz pomina¢ proces wyodrgbniania i okresli¢ reguty dotyczace separatoréw migdzy terminami,
przypisa¢ typy do wyodrgbnianych termindéw lub okresli¢ wymagana minimalna liczebnos¢ wyodrebnianych terminow,
uzyj opcji Structured text opisanej ponizej.

Deklarujac znaczniki w celu okreslenia formatu tekstu XML, nalezy przestrzegac nastepujacych regut:
* W jednym wierszu mozna zadeklarowa¢ tylko jeden znacznik XML.
* W elementach znacznikéw rozrdzniana jest wielkos¢ liter.

* Jesli znacznik ma atrybuty, na przyktad <title id="1234">, i chcesz uwzgledni¢ wszelkie warianty lub, w tym
przypadku, wszystkie identyfikatory, dodaj znacznik bez atrybutu lub koncowego nawiasu (>), na przyktad <title

Dla celow ilustracyjnych zatozmy, ze mamy nastgpujacy dokument XML:
<section>Kodeks drogowy
<title id="01234">Znaki drogowe</title>
<p>Znaki drogowe sa przydatne.</p>
</section>
<p>ZnajomoS¢ przepisow jest istotna.</p>

Na potrzeby przyktadu zadeklarujemy nastepujace znaczniki:

<section>
<title

W tym przyktadzie, poniewaz zadeklarowalismy znacznik <section>, tekst w tym znaczniku oraz znacznikach w nim
zagniezdzonych Znaki drogowe i Znaki drogowe sg przydatne, bedzie przegladany w procesie wyodrgbniania
tekstu. Jednak tekst Znajomo$¢ przepisdw jest istotna bedzie ignorowany, bo znacznik <p> nie byt zadeklarowany
jawnie i nie jest zagniezdzony w zadnym ze znacznikow zadeklarowanych.

Wezet Text Mining: karta Model

Na karcie Model okresla si¢ metodg budowania i ogolne ustawienia dotyczace wynikow wykonania wezta.
Mozna ustawi¢ nastgpujace parametry:

Model name. Mozna wygenerowa¢ nazwe modelu, ktéra bedzie automatycznie oparta na zmiennej przewidywanej lub
identyfikacyjnej (albo na typie modelu w przypadkach, gdy zadna taka zmienna nie jest okreslona), albo okresli¢ nazwe
niestandardowa.

Uzyj danych podzielonych na podzbiory. Jesli zdefiniowano zmienna dzielaca na podzbiory, ta opcja umozliwia
uzycie podczas budowania modelu wytacznie danych z podzbioru uczacego.

Build mode Okresla sposob generowania modeli uzytkowych podczas wykonywania strumienia z weztem Text
Mining. Alternatywa jest zastosowanie bardziej interaktywnego, eksploracyjnego podejscia w trybie Build
interactively, w ktorym mozna nie tylko wyodrebnia¢ pojgcia, tworzy¢ kategorie i optymalizowac zasoby
lingwistyczne, lecz takze prowadzi¢ analize powiazan w tekscie i eksplorowac skupienia.
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* Build interactively Ta opcja powoduje, ze podczas wykonywania strumienia uruchamiany jest interaktywny
interfejs, w ktorym mozna wyodrebniaé pojecia i wzorce, eksplorowac i optymalizowa¢ wyodrebnione wyniki,
budowac i optymalizowac¢ kategorie, optymalizowac zasoby lingwistyczne (szablony, synonimy, typy, biblioteki
itd.)oraz budowa¢ modele uzytkowe kategorii. Wiecej informacji zawiera temat[‘Build Interactively”]

* Generate directly Ta opcja powoduje, ze podczas wykonywania strumienia automatycznie tworzony jest model.
Utworzony model dodawany jest do palety Modele. Inaczej niz w przypadku pulpitu interaktywnego, tutaj w czasie
wykonywania nie sa potrzebne zadne dodatkowe dziatania uzytkownika — wystarczy zdefiniowac ustawienia w
wezle. Po wybraniu tej opcji widoczne stang si¢ opcje charakterystyczne dla modelu, za posrednictwem ktdrych
mozna okresli¢ typ modelu, ktory ma zosta¢ wygenerowany. Wigcej informacji zawiera temat [“Generate Directly”’]

Store large models in AS Jesli istnieje potaczenie z serwerem IBM SPSS Analytic Server, zaznacz t¢ opcjg, aby
zapisa¢ modele zdalnie na serwerze.

Uwaga: Kazdy model, ktory jest tworzony i przechowywany na serwerze, mozna ocenia¢ tylko na danym serwerze.
Aby wznowic sesje¢ interaktywnego srodowiska roboczego zawierajaca taki model, niezbgdne jest potaczenie z
oryginalnym serwerem, ktdry zostat uzyty do utworzenia sesji.

Copy resources from Podczas eksploracji tekstu wyodrebnianie prowadzone jest nie tylko na podstawie ustawien na
karcie Expert, lecz rdéwniez na podstawie zasobow lingwistycznych. Zasoby te sa podstawa dla przetwarzania tekstu w
trakcie wyodrgbniania w celu uzyskania z niego poje¢, typow, a niekiedy takze wzorcow. Mozna skopiowa¢ zasoby do
tego wezta z szablonu zasobow albo z pakietu analizy tekstu (TAP). Wybierz jeden z tych elementdw i kliknij przycisk
Load, aby okresli¢ pakiet lub szablon, z ktérego zostana skopiowane zasoby. Podczas tadowania kopia zasobdéw
zapisywana jest w wezle. Jesli zatem w przysztosci zechcesz uzy¢ zmienionego szablonu lub pakietu TAP, musisz go
ponownie zatadowac¢ — tutaj lub w sesji na interaktywnym pulpicie roboczym. Dla utatwienia w wezle widoczna jest
data i godzina skopiowania i zatadowania zasobow. Wiecej informacji zawiera temat[“Kopiowanie zasobow 7|
kzablonéw i pakietow TAP” na stronie 26}

Text language. Okresla jezyk tekstu poddawanego eksploracji. Zasoby skopiowane w wgzle steruja wyswietlanymi
opcjami dotyczacymi jezyka. Wybierz jezyk, w ktéorym zasoby zostaty dostosowane.

Build Interactively

Na karcie Model wezta modelowania Text Mining mozna wybra¢ wezet budowania dla modeli uzytkowych. Wybranie

opcji Build interactively spowoduje otwarcie interaktywnego interfejsu podczas wykonywania strumienia. Na takim

interaktywnym pulpicie roboczym mozna:

* Wyodrebniaé¢ elementy i eksplorowac wyniki eksploracji, w tym pojecia i typy, aby odkrywaé wydatne tendencje,
koncepcje i trendy w danych tekstowych.

* Stosowac rézne metody budowania i uzupetniania kategorii na podstawie pojec¢, typow, wzorcow TLA i regut, aby
pbzniej mozliwe byto ocenianie dokumentdéw i rekordéw w oparciu o te kategorie.

* Optymalizowac¢ zasoby lingwistyczne (szablony zasobow, biblioteki, stowniki, synonimy i inne zasoby), aby
uzyskiwacé coraz lepsze wyniki w procesie iteracyjnego wyodrgbniania, analizowania i optymalizacji pojec.

* Prowadzi¢ analizg powiazan w tekécie (TLA — text link analysis) i uzywac ujawnionych wzorcéw TLA do
budowania lepszych modeli uzytkowych kategorii. Wezet Text Link Analysis nie oferuje takich opcji eksploracji ani
mozliwosci modelowania.

* Generowac skupienia w celu ujawniania nowych relacji i eksplorowac relacje migedzy pojeciami, typami, wzorcami i
kategoriami w panelu Visualization.

* Generowac zoptymalizowane modele uzytkowe kategorii na palecie Modele w programie IBM SPSS Modeler i
uzywac¢ ich w innych strumieniach.

Uwaga: Nie mozna zbudowac¢ modelu interaktywnego w przypadku tworzenia zadania IBM SPSS Collaboration and
Deployment Services.

Uzyj sesji (kategorii, TLA, zasobow itp.) z ostatniej aktualizacji wezla. Podczas pracy z interaktywnym pulpitem
roboczym mozna aktualizowa¢ wezet danymi sesji (parametrami wyodrebniania, zasobami, definicjami kategorii itd.).
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Opcja Use session work umozliwia ponowne uruchomienie interaktywnego pulpitu z zapisanymi danymi sesji. Ta
opcja jest nieaktywna przy pierwszym uzyciu we¢zta, poniewaz nie mogty by¢ jeszcze zapisane zadne dane sesji. Aby
dowiedzie¢ sig, jak zaktualizowa¢ wezet danymi sesji, by mozna byto korzystac z tej opcji, patrz[‘Aktualizowanie

weztow modelowania i zapisywanie” na stronie 76|

Jesli uruchomisz sesje z #q opcja, to ustawienia wyodregbniania, kategorie, zasoby i inne wyniki pracy z ostatniej sesji
interaktywnego pulpitu zapisane w wezle beda dostgpne w nowe;j sesji. Poniewaz ta opcja powoduje uzycie zapisanych
danych sesji, niektdre dane, takie jak zasoby skopiowane z szablonu i inne karty, sa wylaczone i ignorowane. Jesli
jednak uruchomisz sesjg bez tej opcji, to uzywana bedzie zawartos¢ wezta wedhug biezacego stanu, zatem praca
wykonana wczesniej na pulpicie bedzie niedostepna.

Uwaga: Jesli zmienisz wezet zrodlowy strumienia juz po zbuforowaniu wynikow wyodrgbniania za pomoca opcji Use
session work..., trzeba bgdzie uruchomi¢ nowe wyodrgbnianie po uruchomieniu sesji interaktywnego pulpitu
roboczego, aby moc korzysta¢ ze zaktualizowanych wynikow wyodrgbniania.

Skip extraction and reuse cached data and results. Mozna ponownie wykorzysta¢ wszelkie zbuforowane wyniki
wyodrebniania i dane w sesji pracy z interaktywnym pulpitem roboczym. Ta opcja jest szczegdlnie uzyteczna, gdy dla
zaoszczedzenia czasu checesz ponownie wykorzysta¢ posiadane wyniki wyodrebniania, zamiast czeka¢ na zakonczenie
nowego wyodrebniania. Aby mozna byto uzy¢ tej opcji, wezel powinien by¢ wezesniej zaktualizowany danymi z sesji
pracy z interaktywnym pulpitem roboczym, a opcja Keep the session work and cache text data with extraction
results for reuse musi by¢ wybrana. Aby dowiedziec¢ sig, jak zaktualizowaé wezel danymi sesji, by mozna byto
korzystaé z tej opcji, patrz[‘Aktualizowanie weztéw modelowania i zapisywanie” na stronie 76|

Begin session by. Wybierz opcje okreslajaca widok i dziatanie inicjowane zaraz po uruchomieniu sesji pracy z
interaktywnym pulpitem roboczym. Niezaleznie od wybranego widoku poczatkowego mozna w trakcie sesji przelaczac
sie na inne widoki.

* Using extraction results to build categories. Ta opcja powoduje uruchomienie interaktywnego pulpitu roboczego
w widoku Categories i Concepts oraz, w razie potrzeby, przeprowadzenie wyodrgbnienia. W tym widoku mozna
tworzy¢ kategorie i wygenerowac¢ model kategorii. Mozna takze przelaczy¢ si¢ na inny widok. Wigcej informacji
zawiera temat|Rozdziat 7, “Tryb pracy z interaktywnym pulpitem roboczym”, na stronie 67}

* Exploring text link analysis (TLA) results. Ta opcja powoduje, Ze po uruchomieniu pulpitu nastgpuje
wyodrgbnienie i rozpoznanie relacji migdzy pojgciami w tekscie, na przyktad opinii lub innych powiazan, w widoku
Text Link Analysis. Aby moc korzystac z tej opcji 1 uzyska¢ wyniki, nalezy wybrac¢ szablon lub pakiet analizy tekstu
zawierajacy reguty wzorcow TLA. Wyodregbnianie TLA z wigkszych zbioréw danych moze by¢ czasochtonne. W
takich sytuacjach warto rozwazy¢ zastosowanie wczesniej wezta proby. Wigcej informacji zawiera
[Eksplorowanie analizy powiazan w tekscie”, na stronie 139|

* Analyzing co-word clusters. Ta opcja powoduje uruchomienie pulpitu w widoku Clusters i zaktualizowanie
wszelkich nieaktualnych wynikow wyodrebniania. W widoku tym mozna przeprowadzi¢ analizg skupien
wspotwystepujacych wyrazow, ktéra wygeneruje zestaw skupien. Analiza skupien wspolwystepujacych wyrazow to
proces, ktéry rozpoczyna si¢ od analizy sity powiazania migdzy dwoma pojeciami na podstawie ich
wspotwystepowania w danym rekordzie lub dokumencie, a konczy sie na grupowaniu silnie powiazanych poje¢ w
skupienia. Wigcej informacji zawiera temat [Rozdziat 7, “Tryb pracy z interaktywnym pulpitem roboczym”, nal
_tronie 67

Generate Directly

Na karcie Model wezta modelowania Text Mining mozna wybra¢ wezet budowania dla modeli uzytkowych. Po
wybraniu opcji Generate directly mozesz ustawi¢ opcje wezta, a potem po prostu uruchomi¢ strumien. Wynikiem
bedzie model uzytkowy poje¢, ktory zostanie od razu umieszczony na palecie Modele. Inaczej niz w przypadku pulpitu
interaktywnego, tutaj w czasie wykonywania nie sa potrzebne zadne dodatkowe dziatania uzytkownika — wystarczy
zdefiniowa¢ ustawienia liczebno$ci w wezle.

Maximum number of concepts to include in model. Ta opcja, ktéra ma zastosowanie wylacznie przy automatycznym

(nieinteraktywnym) budowaniu modelu, wskazuje, ze ma zosta¢ utworzony model pojgé. Okresla takze, ze liczba pojec
w tym modelu nie powinna przekracza¢ podanej liczby maksymalne;j.
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* Check concepts based on highest frequency. Top number of concepts. Jest to liczba poje¢, ktore zostana
zaznaczone poczawszy od pojecia o najwigkszej czestosci (liczebno$ci wystapien). W tym miejscu czgsto$¢ oznacza
liczbg wystapien pojgcia (i wszystkich zwiazanych z nim terminéw) w catym zbiorze dokumentow/rekordow. Ta
liczba moze by¢ wyzsza od liczby rekordow, poniewaz jedno pojegcie moze wystgpowac wielokrotnie w tym samym
rekordzie.

* Uncheck concepts that occur in too many records. Percentage of records. Usuwa zaznaczenie pojg¢, ktorych
wyrazona procentowo liczba wystapien w rekordach jest wigksza od okreslonej. Ta opcja jest uzyteczna do
wykluczania pojec, ktore wystgpuja czgsto w tekscie lub w kazdym rekordzie, ale nie maja znaczenia w prowadzonej
analizie.

Optimize for speed of scoring. Opcja ta jest domys$lnie wybrana i powoduje, ze utworzony model bedzie zwarty i
bedzie szybko oceniat dane. Usunigcie zaznaczenia tej opcji spowoduje utworzenie znacznie wigkszego modelu, ktory
prowadzi oceng znacznie wolniej. Jednak wigkszy model gwarantuje, ze oceny wyswietlone poczatkowo w
wygenerowanym modelu poje¢ beda takie same, jak oceny uzyskane w wyniku analizy tego samego tekstu za pomoca
modelu uzytkowego.

Kopiowanie zasobdéw z szablondéw i pakietow TAP

Podczas eksploracji tekstu wyodrgbnianie prowadzone jest nie tylko na podstawie ustawien na karcie Expert, lecz
réwniez na podstawie zasobow lingwistycznych. Zasoby te sa podstawa dla przetwarzania tekstu w trakcie
wyodrebniania w celu uzyskania z niego pojec¢, typow, a niekiedy takze wzorcéw. Mozna skopiowac zasoby do tego
wezta z szablonu zasobow, a pracujac w wezle Text Mining, mozna takze wybra¢ pakiet analizy tekstu (TAP).

Domyslnie w momencie umieszczania wezta w obszarze roboczym zasoby sa kopiowane do niego z podstawowego
szablonu wlasciwego dla jezyka objetego licencja na produkt. Jesli masz licencje na wiele jezykdw, szablon do
automatycznego zatadowania wybierany jest na podstawie pierwszego wybranego jezyka.

Podczas tadowania kopia wybranych zasobow zapisywana jest w wezle. Kopiowana jest jedynie zawarto$¢ szablonu
lub pakietu TAP, nie jest natomiast tworzone powiazanie migdzy szablonem lub pakietem TAP a wezlem. Oznacza to,
ze jesli szablon lub pakiet TAP zostanie pdzniej zmieniony, to zmiany te nie beda automatycznie dostgpne w wezle.
Krétko mowiac, zawsze uzywane sa zasoby zatadowane do wezla, chyba ze ponownie zatadujesz kopig szablonu lub
pakietu TAP lub zaktualizujesz wezel Text Mining i wybierzesz opcje Use session work. Wigcej informacji mozna
znalez¢ w sekcji Korzystanie z danych z sesji w dalszej czesci tego tematu.

Woybieraj szablon lub pakiet TAP wiasciwy dla jezyka, w ktoérym zapisane sa dane tekstowe. Mozna uzywac tylko
szablonow lub pakietow TAP wlasciwych dla jezykow, na ktore masz licencjg. Jesli cheesz analizowa¢ powiazania w
tekscie, musisz wybrac¢ szablon zawierajacy wzorce TLA. Jesli szablon zawiera wzorce TLA, w kolumnie TLA okna
dialogowego Load Resource Template bgdzie widoczna odpowiednia ikona.

Uwaga: Nie mozna tadowac pakietow TAP do wezta Text Link Analysis.
Szablony zasobéw

Szablon zasobdw to predefiniowany zestaw bibliotek 1 zaawansowanych zasobow lingwistycznych oraz
nielingwistycznych, ktore zostaly zoptymalizowane pod katem konkretnej dziedziny lub zastosowania. Juz w
momencie umieszczania wgzta modelowania Text Mining w obszarze roboczym strumienia jest do niego fadowana
kopia zasoboéw z podstawowego szablonu, ale mozna zmieni¢ szablon lub zaladowa¢ pakiet analizy tekstu, wybierajac
opcje Resource template albo Text analysis package i klikajac przycisk Load. W przypadku szablonéw mozna
nastgpnie wybrac szablon w oknie dialogowym Load Resource Template.

Uwaga: Jezeli zadany szablon nie figuruje na liScie, ale masz na zapisana lokalnie w komputerze jego
wyeksportowana kopie, to mozesz ja teraz zaimportowa¢. Mozesz takze wyeksportowac szablon z tego okna
dialogowego, aby udostgpnic¢ go innym uzytkownikom. Wigcej informacji mozna znalez¢é w temacie.“ImEortowanie i|
Eksportowanie szablonéw” na stronie 161|
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Pakiety analizy tekstu (TAP)

Pakiet analizy tekstu (TAP — text analysis package) to predefiniowany zestaw bibliotek oraz zaawansowanych
zasobow lingwistycznych i nielingwistycznych potaczony w pakiet z jednym lub wicloma zestawami predefiniowanych
kategorii. IBM SPSS Modeler Text Analytics oferuje kilka gotowych pakietow TAP dla tekstow w jezyku angielskim,a
kazdy z tych pakietow jest zoptymalizowany pod katem konkretnej dziedziny. Nie mozna edytowac tych pakietow
TAP, ale mozna uzy¢ ich jako punktu wyjscia do budowania wlasnego modelu kategorii. Mozna takze tworzy¢ wlasne
ety TAP w sesji interaktywnej. Wigcej informacji zawiera temat|Eadowanie pakietow analizy tekstu” na stronie]
129

Uwaga: Nie mozna tadowac pakietow TAP do wezta Text Link Analysis.
Korzystanie z opcji ,,Use Session Work” (kata Model)

Wprawdzie zasoby sa kopiowane do we¢zta na karcie Model, ale mozna rowniez pozniej wprowadzaé interaktywnie
zmiany w zasobach i ewentualnie zaktualizowa¢ wezet modelowania z uwzglednieniem tych zmian. W takim
przypadku nalezatoby wybra¢ opcje Use session work na karcie Model wezta modelowania Text Mining.

Wybranie opcji Use session work powoduje wylaczenie przycisku Load w oknie wezta, co sygnalizuje, ze zasoby z
interaktywnego pulpitu roboczego zostang uzyte zamiast zasobow zatadowanych wczesniej do wezla.

Aby wprowadzi¢ zmiany w zasobach po wybraniu opcji Use session work, mozna edytowac¢ lub podmienia¢ zasoby
bezposrednio w sesji pracy z interaktywnym pulpitem roboczym, korzystajac z widoku Resource Editor. Wigcej
informacji zawiera temat [‘Aktualizowanie zasobow wezta po zatadowaniu” na stronie 160}

Wezel Text Mining: karta Expert

Karta Expert zawiera pewne zaawansowane parametry wptywajace na sposob wyodrebniania tekstu i postgpowania z
nim. Parametry w tym oknie dialogowym steruja podstawowym przebiegiem, a takze kilkoma funkcjami
zaawansowanymi procesu wyodrebniania. Jednak stanowia tylko czgs¢ wszystkich opcji dostgpnych dla uzytkownika.
Istnieje takze szereg zasobow lingwistycznych i opcji wplywajacych na wyniki wyodrgbniania i sterowanych za
osrednictwem szablonu zasobow wybieranego na karcie Model. Wigcej informacji zawiera temat
Mining: karta Model” na stronie 23|

Uwaga: Cala ta karta jest wylaczona, jesli na karcie Model wybrano tryb Build interactively i korzystanie z
zapisanych informacji z interaktywnego pulpitu roboczego. Wowczas obowiazuja ustawienia wyodrebniania z ostatniej
zapisanej sesji pracy z pulpitem.

Mozna ustawi¢ nastgpujace parametry wyodrgbniania:

Limit extraction to concepts with a global frequency of at least [n]. Okresla, ile razy wyraz lub fraza musi wystapic¢
w tekscie, aby zostat(a) wyodrgbniony/-a. Na przyktad wartos¢ 5 powoduje, ze wyodrgbnianie beda tylko te wyrazy i
frazy, ktore wystgpuja co najmniej pigc¢ razy w catym zbiorze rekordéw lub dokumentow.

W niektorych przypadkach zmiana tego limitu silnie wptywa na wyniki wyodrebniania, a w efekcie na utworzone
kategorie. Zalézmy, ze pracujemy nad danymi o sieci restauracji i opisywany limit jest ustawiony na 1. W tym
przypadku w wynikach wyodrebniania moga znalez¢ si¢ pojecia: pizza (1), thin pizza (2), spinach pizza (2) i favorite
pizza (2). Jesli jednak ograniczymy wyodrebnianie do poje¢ wystepujacych co najmniej 5 razy, powyzsze trzy pojecia
nie zostana wyodrgbnione. W wynikach uzyskamy natomiast pojgcie pizza (7), poniewaz pizza jest najprostsza forma, a
wyraz ten istnial juz jako potencjalny kandydat. W zaleznoS$ci od zawartosci reszty tekstu licznos¢ wystapien moze
przekracza¢ siedem, jesli w tekscie wyraz pizza wystgpuje jeszcze w innych frazach. Ponadto, jesli pojecie spinach
pizza bylto juz deskryptorem kategorii, to zamiast niego moze by¢ konieczne dodanie deskryptora pizza w celu
uwzglednienia wszystkich rekordéw. Dlatego, jesli kategorie zostaty juz wezesniej utworzone, limit wystapien nalezy
modyfikowac¢ ostroznie.
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Nalezy zauwazy¢, ze opisywana opcja dotyczy tylko wyodrebniania; jesli szablon zawiera terminy (a zwykle zawiera),
a termin z szablonu zostanie znaleziony w tekscie, to termin ten bedzie indeksowany niezaleznie od liczebnos$ci
wystapien.

Zatozmy na przyklad, ze szablon Basic Resources zawiera termin "los angeles" typu <Location> w bibliotece Core;
jesli dokument zawiera termin Los Angeles tylko raz, to Los Angeles zawsze znajdzie sig na liscie pojg¢. Aby temu
zapobiec, nalezy ustawi¢ filtr w celu uwidocznienia pojg¢ wystepujacych co najmniej tyle razy, ile wynosi limit
okreslony w polu Limit extraction to concepts with a global frequency of at least [n].

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrebniania tekst zawierajacy btedy
interpunkcyjne (na przyktad nieprawidtowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrgbniania pojgé. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krotkimi
tekstami o niskiej jako$ci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrotow.

Accommodate spelling for a minimum word character length of [n] Ta opcja powoduje zastosowanie techniki
grupowania rozmytego, ktora grupuje btednie napisane lub podobne wyrazy pod jednym pojeciem. Algorytm
grupowania rozmytego tymczasowo usuwa wszystkie samogtoski (z wyjatkiem pierwszej) oraz podwojne/potrojne
spotgtoski z wyodrebnianych wyrazdw, a nastepnie porownuje wyniki, by sprawdzi¢, czy sa identyczne. Zatem wyrazy
modeling i modelling zostalyby potaczone w jedna grupe. Jesli jednak kazdy termin ma przypisany inny typ, z
wyjatkiem typu <Unknown>, to grupowanie rozmyte nie bedzie stosowane.

Mozna tez okreslic minimalng liczbg znakdéw rdzennych wymagana do zastosowania grupowania rozmytego. Liczba
znakow rdzennych w terminie obliczana jest poprzez zsumowanie wszystkich znakéw i odjgcie znakow tworzacych
przyrostki przy odmianie, a w wypadku terminéw bedacych wyrazami ztozonymi, takze znakow tworzacych okreslniki
i przyimki. Na przyklad termin exercises ma 8 znakéw rdzennych w swojej postaci “exercise”, poniewaz litera s na
koncu tworzy odmiang (w tym przypadku liczbe mnoga). Podobnie, apple sauce ma 10 znakow rdzennych (“apple
sauce”), a manufacturing of cars ma 16 znakéw rdzennych (“manufacturing car”). Ta metoda liczenia znakow jest
stosowana tylko do sprawdzania, czy ma by¢ przeprowadzane grupowanie rozmyte, ale nie wptywa na sposob
dopasowywania wyrazow.

Uwaga: Jesli pozniej okaze sig, ze pewne wyrazy sa grupowane nieprawidtowo, mozna wykluczy¢ konkretne pary
wyrazow ze stosowania tej techniki, jawnie deklarujac je w sekcji Fuzzy Grouping: Exceptions na karcie Advanced
Resources. Wigcej informacji zawiera temat|“Grupowanie rozmyte” na stronie 187

Extract uniterms Ta opcja wyodregbnia pojedyncze wyrazy (terminy pojedyncze), o ile tylko nie sa juz cze$cia wyrazu
zlozonego i sa albo rzeczownikami, albo nierozpoznanymi czg$ciami mowy.

Extract nonlinguistic entities Ta opcja wyodrgbnia Obiekty nielingwistyczne, takie jak numery telefonow, numery
ubezpieczenia spolecznego, godziny, daty, waluty, cyfry, wartosci procentowe, adresy e-mail i adresy HTTP. W sekcji
Nonlinguistic Entities: Configuration karty Advanced Resources mozna uwzgledniaé i wykluczac okreslone typy
obiektow nielingwistycznych. Wykluczenie zbgdnych obiektow sprawi, ze mechanizm wyodrebniania nie bedzie
marnowal czasu na ich przetwarzanie. Wiecej informacji zawiera temat[“Konfiguracja” na stronie 191|

Uppercase algorithm Ta opcja wyodrebnia proste i zlozone terminy, ktore nie figuruja we wbudowanych stownikach,
o ile pierwsza litera terminu jest wielka. Jest to dobry sposob na wyodrebnienie wigkszo$ci rzeczownikow wiasnych.

Group partial and full person names together when possible Ta opcja grupuje imiona i nazwiska, ktore w tekscie
wystepuja w roznych postaciach. Jest to uzyteczne, poniewaz imiona i nazwiska czgsto na poczatku tekstu przytaczane
sa w petnym brzmieniu, ale pdzniej juz wystepuja tylko w wersji skroconej. W przypadku wybrania tej opcji program
probuje dopasowac kazdy pojedynczy termin typu <Unknown> do ostatniego wyrazu kazdego terminu ztozonego typu
<Person> (osoba). Na przyktad, jesli znaleziony zostanie wyraz nowak o poczatkowo przypisanym typie
<Unknown>, to mechanizm wyodrebniania sprawdzi, czy jakiekolwiek terminy ztozone typu <Person> zawieraja
jako ostatni wyraz wlasnie nowak, na przyktad piotr nowak. Ta opcja nie ma zastosowania do imion, poniewaz
wigkszo$¢ z nich nigdy nie jest wyodrebniana jako termin pojedynczy.
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Maximum nonfunction word permutation Ta opcja okresla maksymalna liczbe wyrazow niefunkcyjnych, ktore
moga by¢ obecne, gdy stosowana jest technika permutacji. Technika permutacji grupuje podobne frazy rozniace si¢
tylko wyrazami niefunkcyjnymi (na przyktad ,,of” lub ,,the”), niezaleznie od odmiany. Zalézmy na przyktad, ze wartos¢
ta jest ustawiona na maksymalnie dwa wyrazy i wyodrgbniono zardwno termin company officials, jak i termin
officials of the company. W tym przypadku oba terminy zostana potaczone w grupe, poniewaz po zignorowaniu
wyrazow Of the zostana uznane za identyczne.

Use derivation when grouping multiterms Podczas przetwarzania wielkich zbioréw danych wybierz t¢ opcje, aby
grupowac terminy wielowyrazowe wedhug regut derywacji.

Uwaga: Aby mozliwy byt eksport wynikow analizy powiazan w tekscie, nalezy rozpoczac sesj¢ z opcja Exploring
text link analysis results i wybra¢ zasoby zawierajace definicje TLA. Zawsze mozna wyodregbni¢ wyniki analizy TLA
pozniej, podczas sesji pracy z interaktywnym pulpitem roboczym, za posrednictwem okna dialogowego Extraction
Settings. Wigcej informacji zawiera temat [*Wyodrebnianie danych” na stronie 80}

Wczesniejsze wybieranie proby w celu zaoszczedzenia czasu

Gdy dane maja duza objgtos¢, przetwarzanie moze trwa¢ wiele minut, a nawet godzin — zwlaszcza w trakcie sesji
pracy z interaktywnym pulpitem roboczym. Im wigksza objgtos¢ danych, tym dtuzej beda trwaly procesy
wyodrebniania i kategoryzacji. Aby pracowac efektywniej, mozesz przed weztem Text Mining doda¢ wezty proby
programu IBM SPSS Modeler. Wezet proby pobiera losowa probe i umozliwia korzystanie z mniejszego podzbioru
dokumentéw lub rekordow podczas kilku pierwszych przebiegow.

Mniejsza proba jest czgsto catkowicie wystarczajaca do podjgcia decyzji o ewentualnych korektach zasobow, a nawet
do utworzenia wigkszosci lub wszystkich kategorii. Gdy analiza mniejszego zbioru danych przyniesie zadowalajace
wyniki, mozna zastosowac t¢ sama technike do utworzenia kategorii na podstawie catego zbioru danych. Nastgpnie
mozna wyszuka¢ dokumenty lub rekordy, ktére nie pasuja do utworzonych kategorii, i wprowadzi¢ niezbedne korekty.

Uwaga: Wezel proby jest standardowym weztem programu IBM SPSS Modeler.

Korzystanie z wezla Text Mining w strumieniu

Wezel modelowania Test Mining shuzy do uzyskiwania dostgpu do danych i wyodrebniania poj¢¢ w ramach strumienia.
Aby uzyskac dostgp do danych, mozna wykorzysta¢ dowolny wezet zrodtowy, na przyktad wezet Baza danych, wezet
Plik zmiennych, wezet Web Feed lub wezet Plik kolumnowy. W przypadku tekstu, ktdry znajduje si¢ w dokumentach
zewngtrznych, mozna uzy¢ wezla File List.

Przyktad 1: Uzycie wezlow File List i Text Mining do bezposredniego tworzenia
modelu uzytkowego pojec

Ponizszy przyklad ilustruje zastosowanie wezta File List razem z wezlem modelowania Text Mining do

wygenerowania modelu uzytkowego pojgé. Aby uzyska¢ wigcej informacji o korzystaniu z wezta File List, patrz

[‘Wezet File List” na stronie 11}

1. Wezel File List (karta Settings). Najpierw dodaliSmy ten wezet do strumienia, aby okresli¢, gdzie sa
przechowywane dokumenty tekstowe. Wybralismy katalog zawierajacy wszystkie dokumenty, na ktorych chcemy
przeprowadzac¢ eksploracjg tekstu.

2. Wezel Text Mining (karta Fields). Nastgpnie dodalismy wezet Text Mining i potaczylismy go z weztem File List.
W tym wezle zdefiniowalismy format wejSciowy, szablon zasobow i format wyjsciowy. Wybralismy nazwe
zmiennej wygenerowang z wezta File List i wybraliSmy zmienna tekstowa. OkresliliSmy rowniez inne ustawienia.
Wigcej informacji zawiera temat [*Korzystanie z wezta Text Mining w strumieniu’}

3. Wezel Text Mining (karta Model). Teraz na karcie Model wybrali$my tryb budowania, ktory pozwoli na
wygenerowanie modelu uzytkowego pojec¢ bezposrednio z tego wezta. Mozna wybra¢ inny szablon zasobow lub
zachowac zasoby podstawowe.
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Przyktad 2: Uzycie weziéw Plik programu Excel i Text Mining do interaktywnego
budowania modelu kategorii

Ten przyktad pokazuje, ze wezet Text Mining umozliwia réwniez uruchomienie sesji pracy z interaktywnym pulpitem
roboczym. Aby uzyskaé wiecej informacji o interaktywnym pulpicie roboczym, patrz|[Rozdziat 7, “Tryb pracy 7
interaktywnym pulpitem roboczym”, na stronie 67}

1. Wezel zrodlowy Plik programu Excel (karta Data). Najpierw dodaliSmy ten we¢zet do strumienia, aby okresli¢,
gdzie jest przechowywany tekst.

2. Wezel Text Mining (karta Fields). Nastgpnie dodaliSmy wezet Text Mining i potaczyliSmy go z weztem Plik
programu Excel. Na pierwszej karcie zdefiniowali§my format wejsciowy. WybraliSmy nazwe zmiennej z wegzta
zroédlowego.

3. Wezel Text Mining (karta Model). Nastepnie na karcie Model wybrali$my opcjg interaktywnego budowania

modelu uzytkowego kategorii oraz wykorzystania wynikow wyodrgbniania do automatycznego zbudowania
kategorii. W tym przyktadzie zatadowaliSmy kopi¢ zasobow i zestaw kategorii z pakietu analizy tekstu.

4. Sesja pracy z interaktywnym pulpitem roboczym. Nastgpnie uruchomili$my strumien, co spowodowato
otwarcie interaktywnego pulpitu roboczego. Po przeprowadzeniu wyodrgbniania rozpoczeliSmy eksploracje danych
i doskonalenie kategorii.

Model uzytkowy Text Mining: model poje¢

Model uzytkowy pojec jest generowany po pomyslnym wykonaniu wezta Text Mining, jesli na karcie Model wybrano
opcje Generate a model directly. Model uzytkowy pojec stuzy do wykrywania w czasie rzeczywistym kluczowych
poje¢ w innych danych tekstowych, na przyktad notatkach konsultantow telefonicznego centrum zgloszeniowego.

Sam model uzytkowy poje¢ sktada sig z listy pojec¢ przypisanych do typow. Mozna wybra¢ dowolne z poje¢ lub
wszystkie pojecia w modelu, by na ich podstawie ocenia¢ inne dane. W trakcie wykonywania strumienia zawierajacego
model uzytkowy Text Mining do danych sa dodawane nowe pola zgodnie z trybem budowania, ktdry jeszcze przed
rozpoczgciem budowania modelu wybrano na karcie Model wezta modelowania Text Mining. Wigcej informacji
zawiera temat[“Model pojec: karta Model” na stronie 31}

Jesli model uzytkowy zostat wygenerowany przy uzyciu dokumentdéw przettumaczonych, to ocena bedzie wykonywana
na jezyku docelowym ttumaczenia. Podobnie, jesli model uzytkowy zostat wygenerowany przy uzyciu jgzyka
angielskiego, mozna w tym modelu uzytkowym okresli¢ jezyk thumaczenia, poniewaz dokumenty beda tlumaczone na
jezyk angielski.

Wygenerowane modele uzytkowe Text Mining umieszczane sa na palecie modeli uzytkowych (ktora znajduje si¢ na
karcie Modele w prawym gdérnym rogu okna IBM SPSS Modeler).

Wyswietlanie wynikoéw

Aby wyswietli¢ informacje o modelu uzytkowym, kliknij prawym przyciskiem myszy wegzel na palecie modeli
uzytkowych i wybierz polecenie Browse z menu kontekstowego (lub Edit w przypadku modeli w strumieniu).

Dodawanie modeli do strumieni

Aby doda¢ model uzytkowy do strumienia, kliknij ikong na palecie modeli uzytkowych, a nastgpnie kliknij obszar
roboczy strumienia w miejscu, w ktorym chcesz umiesci¢ wezet. Zamiast tego mozna tez klikna¢ ikong i z menu
kontekstowego wybra¢ polecenie Add to Stream. Nastepnie potacz strumien z nowym weztem. Mozna teraz przekazac
do strumienia dane w celu wygenerowania predykcji.

Przestroga: Jesli chcesz uzy¢ modelu uzytkowego oceniania do ponownego wygenerowania wezla modelowania

zawierajacego i model kategorii, i uzyty szablon, zalecamy utworzenie, zamiast we¢zla modelowania, pakietu TAP i
uzycie go w sesji interaktywnej przed wygenerowaniem modelu uzytkowego oceniania.
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Model pojec¢: karta Model

Na karcie Model modelu poje¢ wyswietlana jest lista wyodrebnionych pojeé. Pojecia sg prezentowane w tabeli, w
ktorej kazdy wiersz zawiera jedno pojgcie. Karta ta stuzy do wybierania poje¢, ktore beda uzywane do oceniania.

Uwaga: Jesli wygenerowano model uzytkowy kategorii, a nie poje¢, to na tej karcie beda wyswietlane inne informacje.
Wigcej informacji zawiera temat [‘Model uzytkowy kategorii: karta Model” na stronie 39|

Domyslnie wszystkie pojecia sa wybrane jako uzywane do oceniania (pola wyboru w lewej skrajniej kolumnie).
Zaznaczenie sygnalizuje, ze pojecie bedzie uzywane podczas oceniania. Brak zaznaczenia sygnalizuje, ze pojecie
bedzie wykluczone z oceniania. Mozna zaznaczy¢ wiele wierszy naraz, wybierajac je i klikajac jedno z ich pol wyboru.

Dodatkowe informacje o kazdym z poje¢ znajduja si¢ w nastepujacych kolumnach:

Concept. Jest to wiodacy wyodrebniony wyraz lub wiodaca wyodrgbniona fraza. W niektorych przypadkach pojecie
reprezentuje termin bedacy jego nazwa oraz inne terminy powiazane z tym samym pojgciem. Aby sprawdzi¢, ktore
terminy naleza do pojgcia, wyswietl panel Underlying Term wewnatrz tej karty i wybierz pojecie, aby u dolu okna
dialogowego wyswietli¢ odpowiadajace mu terminy. Wigcej informacji zawiera temat [“Terminy w modelach poje¢” nal
_ronie 32

Global. W tym miejscu globalna czgstos¢ oznacza liczbg wystapien pojecia (i wszystkich zwigzanych z nim terminow)
w calym zbiorze dokumentow/rekordow.

* Bar chart. Globalna czgstos¢ tego pojecia w danych tekstowych przedstawiona w formie wykresu stupkowego.
Kolor stupka oznacza typ, do ktorego pojecie zostato przypisane. Dzigki temu tatwo mozna wizualnie rozréznic
typy.

* %. Globalna czgstosc¢ tego pojecia w danych tekstowych przedstawiona w formie procentowe;.

* N. Faktyczna liczba wystapien tego pojgcia w danych tekstowych.

Docs. Wartos¢ Docs oznacza tutaj liczbe dokumentdéw lub rekordow, w ktdrych wystepuje pojecie (i wszystkie jego
terminy).

* Bar chart. Liczba dokumentdw, w ktorych wystepuje to pojecie, przedstawiona w formie wykresu stupkowego.
Kolor stupka oznacza typ, do ktorego pojgcie zostato przypisane. Dzigki temu tatwo mozna wizualnie rozrézni¢
typy.

* %. Liczba dokumentdw, w ktorych wystepuje to pojecie, przedstawiona w formie procentowe;.

* N. Faktyczna liczba dokumentow lub rekordéw zawierajacych to pojgcie.

Typ. Typ, do ktdérego pojecie zostato przypisane. Dla kazdego pojecia kolumny Global i Docs wyswietlane sa w
kolorze oznaczajacym jego typ. Typ jest semantyczna grupa poje¢. Wiecej informacji zawiera temat [“Stowniki typow”]|

Praca z pojgciami

Kliknigcie komdrki tabeli prawym przyciskiem myszy umozliwia wy$wietlenie menu kontekstowego zawierajacego
nastegpujace opcje:

* Select All. Wszystkie wiersze w tabeli zostana wybrane.

* Copy. Wybrane pojecia sa kopiowane do schowka.

* Copy With Fields Wybrane pojgcia sa kopiowane do schowka razem z nagtowkiem kolumny.

Check Selected. Zaznacza wszystkie pola wyboru wybranych wierszy w tabeli, co powoduje, ze odpowiednie
pojgcia beda uzywane do oceniania.

* Uncheck Selected. Usuwa zaznaczenie wszystkich pol wyboru wybranych wierszy w tabeli.

Check All. Zaznacza wszystkie pola wyboru w tabeli. W efekcie wszystkie pojgcia zostang zastosowane w
ostatecznych wynikach.
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*  Uncheck All. Usuwa zaznaczenie wszystkich pol wyboru w tabeli. Anulowanie zaznaczenia pojecia spowoduje, ze
nie bedzie ono stosowane w ostatecznych wynikach.

* Include Concepts. Powoduje wyswietlenie okna dialogowego Include Concepts. Wigcej informacji zawiera temat
[<Opcje wiaczania pojeé do oceniania”}

Opcje wiaczania poje¢ do oceniania
Aby szybko zaznacza¢ lub usuwac zaznaczenie pojec, ktore maja by¢ uzywane przy ocenieniu, kliknij przycisk
Include Concepts..

I

Rysunek 1. Przycisk Include Concepts na pasku narzedzi

Kliknigcie tego przycisku na pasku narzedzi spowoduje otwarcie okna dialogowego Include Concepts, w ktorym
mozna wybra¢ pojgcia na podstawie regut. W ocenianiu uwzgledniane bgda wszystkie pojgcia zaznaczone na karcie
Model. Stosujac regutg¢ w tym podrzgdnym oknie dialogowym, mozesz zmieni¢ wybor poje¢ uzywanych podczas
oceniania.

Do wyboru dostepne sa nastgpujace opcje:

Check concepts based on highest frequency. Top number of concepts. Jest to liczba poje¢, ktdre zostana zaznaczone
poczawszy od pojecia o najwigkszej globalnej czestosci (liczebnosci wystapien). W tym miejscu czgsto$é oznacza
liczbg wystapien pojecia (1 wszystkich zwiazanych z nim terminow) w catym zbiorze dokumentow/rekordow. Ta liczba
moze by¢ wyzsza od liczby rekorddow, poniewaz jedno pojgcie moze wystgpowac wielokrotnie w tym samym
rekordzie.

Check concepts based on document count. Minimum count. Jest to najmniejsza liczba dokumentéw wymagana, by
pojecie zostato zaznaczone. Liczba dokumentow oznacza tutaj liczbe dokumentéw/rekordow, w ktorych wystepuje
pojecie (i wszystkie jego terminy).

Check concepts assigned to the type. Wybierz typ z listy rozwijanej, aby zaznaczy¢ wszystkie pojecia przypisane do
tego typu. Pojecia sa przypisywane do typow automatycznie w trakcie wyodrgbniania. Typ jest semantyczna grupa
poje¢. Typy odzwierciedlaja pojecia poziomowe, kwalifikatory i okreslenia o wydzwigku pozytywnym i negatywnym,
kwaliﬁkatoi kontekstowe, imiona, miejsca, organizacje i nie tylko. Wigcej informacji zawiera temat|“Stowniki typow’]

Uncheck concepts that occur in too many records. Percentage of records. Usuwa zaznaczenie pojec¢, ktdrych
wyrazona procentowo liczba wystapien w rekordach jest wigksza od okreslonej. Ta opcja jest uzyteczna do
wykluczania poje¢, ktore wystepuja czegsto w tekscie lub w kazdym rekordzie, ale nie maja znaczenia w prowadzonej
analizie.

Uncheck concepts assigned to the type. Usuwa zaznaczenia pojec, ktorym przypisany jest typ wybrany z listy
rozwijanej.

Terminy w modelach pojeé
Mozna sprawdzi¢, jakie terminy sa zdefiniowane w ramach poje¢ zaznaczonych w tabeli. Klikajac przycisk terminow
poje¢ na pasku narzedzi, mozna wyswietli¢ tabelg takich terminow w podzielonym panelu na dole okna dialogowego.

Do terminéw zdefiniowanych w ramach poje¢ (nazywanych tez terminami bazowymi pojec) naleza synonimy
zdefiniowane w zasobach lingwistycznych (niezaleznie od tego, czy wystapity w tekscie, czy nie), a takze wszelkie
znalezione w tekscie terminy w liczbie mnogiej/pojedynczej, permutacje termindw, terminy wygenerowane w wyniku
grupowania rozmytego itd.
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Rysunek 2. Przycisk Display Underlying Terms na pasku narzedzi

Uwaga: Listy terminéw w ramach pojgcia nie mozna edytowac. Lista jest generowana na podstawie stownika
zastapien, definicji synonimow (w stowniku zastapien), grupowania rozmytego i przy uzyciu innych technik wedtug
danych zawartych w zasobach lingwistycznych. Aby wplynac¢ na grupowanie terminéw w pojgcia i Sposob
postgpowania z terminami, nalezy bezposrednio zmodyfikowaé zasoby (mozna je edytowaé w oknie Resource Editor w
ramach interaktywnego pulpitu roboczego lub w oknie Template Editor, a potem ponownie zatadowa¢ do wezta), a
nastepnie ponownie wykonac¢ strumien, aby uzyska¢ nowy model uzytkowy ze zaktualizowanymi wynikami.

Kliknigcie komorki z terminem lub pojeciem prawym przyciskiem myszy umozliwia wyswietlenie menu
kontekstowego zawierajacego nastgpujace opcje:

* Copy. Wybrana komdrka zostanie skopiowana do schowka.

* Copy With Fields. Wybrana komorka zostanie skopiowana do schowka razem z nagtéwkami kolumn.

* Select All. Wszystkie komorki w tabeli zostana wybrane.

Model pojec¢: karta Settings

Karta Settings stuzy do okreslania wartosci zmiennej tekstowej w celu uwzglednienia nowych danych wejsciowych,
gdy zachodzi taka potrzeba. Jest ona takze miejscem, w ktérym mozna zdefiniowa¢ model danych dla wyniku (tryb
oceniania).

Uwaga: Ta karta jest dostepna tylko wtedy, gdy model uzytkowy zostat umieszczony w obszarze roboczym. Nie jest
wyswietlana, gdy to okno dialogowe zostanie otwarte bezposrednio z palety Modele.

Tryb oceniania: Concepts as records

W tym trybie oceniania dla kazdej pary pojgcie/dokument tworzony jest nowy rekord. Zwykle wyniki zawieraja
wigcej rekordow niz dane wejsciowe.

Oprocz zmiennych wejsciowych do danych dodawane sa takze nastgpujace zmienne:

Tabela 4. Zmienne wynikowe w trybie ,Concepts as records”.

Zmienna Opis
Concept Zawiera nazw¢ pojecia wyodrebniona ze zmiennej z danymi tekstowymi.
Type Zawiera typ pojecia w postaci petnej nazwy, na przyktad Location lub Person. Typ jest semantyczna grupa pojec.

Wiecej informacji zawiera temat|[“Stowniki typow” na stronie 173]

Count Wyswietla liczbg wystapien pojecia (i jego termindw) w treéci tekstu (rekordach/dokumentach).

Wybranie tej opcji powoduje wylaczenie wszystkich pozostatych opcji z wyjatkiem Accommodate punctuation
errors.

Tryb oceniania: Concepts as fields

W modelach poje¢ dla kazdego rekordu wejsciowego i pojecia wystepujacego w danym rekordzie/dokumencie
tworzony jest nowy rekord. Zatem liczba rekordéw wynikowych jest taka sama, jak w danych wejsciowych. Jednak
kazdy rekord (wiersz) zawiera teraz po jednej nowej zmiennej (kolumnie) dla kazdego pojgcia zaznaczonego na karcie
Model. Wartos¢ kazdej zmiennej pojgcia zalezy od tego, czy jako warto$¢ zmiennej na tej karcie wybrano Flags, czy
Counts.

Uwaga: Jesli zbior danych jest bardzo obszerny, np. jest baza danych Db2, wybranie opcji Concepts as fields moze
spowodowac problemy z przetwarzaniem. W takich przypadkach zaleca si¢ korzystanie z opcji Concepts as records.
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Field Values. Wybierz, czy nowa zmienna kazdego pojecia bedzie zawierac liczebnos$é, czy flage.

* Flags. Ta opcja stuzy do generowania wynikowych flag z dwiema mozliwymi wartosciami: na przyktad Tak/Nie,
True/False, T/F, albo 1 i 2. Typy sktadowania ustawiane sa automatycznie odpowiednio do wybranej wartosci. Na
przyktad, jesli wprowadzisz liczbowe wartosci flag, to automatycznie bgda traktowane jako wartosci
catkowitoliczbowe. Flagi moga by¢ sktadowane jako tancuchy, liczby catkowite, liczby rzeczywiste lub warto$ci
data/czas. Wprowadz wartos¢ flagi oznaczajaca True i wartos¢ oznaczajaca False.

* Counts. Shuzy do generowania liczebno$ci wystapien pojecia w danym rekordzie.

Rozszerzenie nazwy zmiennej. Okresl rozszerzenie nazwy zmiennej. Nazwy zmiennych generowane sa poprzez
polaczenie nazwy pojgcia z rozszerzeniem.

* Add as. Okresl, gdzie do nazwy zmiennej powinno by¢ dodawane rozszerzenie. Wybierz Prefix, aby dodawac
rozszerzenie na poczatku tancucha. Wybierz Suffix, aby dodawac rozszerzenie na koncu tancucha.

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrebniania tekst zawierajacy btedy
interpunkcyjne (na przyktad nieprawidtowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrebniania pojec. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krotkimi
tekstami o niskiej jako$ci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrotow.

Model pojec: karta Fields

Karta Fields okresla warto$¢ zmiennej tekstowej w celu uwzglednienia nowych danych wejsciowych, gdy zachodzi
taka potrzeba.

Uwaga: Ta karta jest dostepna tylko wtedy, gdy model uzytkowy zostat umieszczony w obszarze roboczym. Nie jest
wyswietlana, gdy to okno dialogowe zostanie otwarte bezposrednio z palety Modele.

Text field. Wybierz zmienna zawierajaca tekst do eksploracji. Zmienna ta zalezy od zrédta danych.

Document type. Typ dokumentu okresla strukture tekstu. Wybierz jeden z nastgpujacych typow:

* Full text. Odpowiedni dla wigkszosci dokumentow i zrodet tekstowych. Podczas wyodrgbniania przegladany jest
caly zbior tekstu. Z ta opcja, w odréznieniu od pozostatych, nie sa zwiazane zadne ustawienia dodatkowe.

* Structured text. Odpowiedni do analizy formularzy bibliograficznych, patentéw i innych plikow zawierajacych
regularne struktury dajace si¢ rozpoznac i przeanalizowaé. Zastosowanie tego typu dokumentow wiaze si¢ z
pominigciem catosci lub czgsci procesu wyodrgbniania. Umozliwia zdefiniowanie separatorow terminow,
przypisywanie typow i okreslenie wymaganej minimalnej czgstotliwosci. W przypadku wybrania tej opcji nalezy
klikna¢ przycisk Settings i wprowadzi¢ separatory tekstu w obszarze Structured Text Formatting okna
dialoiowego Document Settings. Wigcej informacji zawiera temat [“Ustawienia dokumentéw na karcie Zmienne” nal

Input encoding. Ta opcja jest dostgpna tylko wtedy, gdy wskazano, ze zmienna tekstowa zawiera $ciezki (opcja
Pathnames to documents). Okresla ona domyslne kodowanie tekstu. Dokonywana jest konwersja z okreslonego lub
rozpoznanego kodowania na ISO-8859-1. Zatem nawet jesli okreslono inne kodowanie, mechanizm wyodrebniania
przed przetworzeniem tekstu przekonwertuje go na kodowanie 1ISO-8859-1. Wszelkie znaki niewystepujace w
definicji kodowania ISO-8859-1 zostana przeksztatcone w spacje.

Text language. Okresla jezyk tekstu poddawanego eksploracji. Jest to gtowny jezyk wykryty podczas wyodrebniania.
Uzytkownicy zainteresowani zakupem licencji na obstugiwany jezyk, do ktérego obecnie nie maja dostepu, powinni
skontaktowac si¢ z przedstawicielem handlowym.

Model pojec¢: karta Summary

Na karcie Summary prezentowane sa informacje o samym modelu (folder Analiza), zmiennych uzywanych w modelu
(folder Zmienne), ustawieniach uzywanych przy budowaniu modelu (folder Ustawienia budowania) i o uczeniu modelu
(folder Podsumowanie uczenia).
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Gdy po raz pierwszy otworzysz wezel modelowania, foldery na karcie Podsumowanie sa zwinigte. Aby wyswietli¢
interesujace wyniki, skorzystaj z rozszerzanego elementu sterujacego po lewej stronie folderu albo kliknij przycisk
Expand All, co spowoduje wyswietlenie wszystkich wynikow. Aby ukry¢ wyniki po ich przejrzeniu, uzyj
rozszerzanego elementu sterujacego w celu zwinigcia konkretnego folderu albo kliknij przycisk Collapse All, aby
zwina¢ wszystkie foldery.

Korzystanie z modeli uzytkowych pojeé w strumieniu

Korzystajac z wezta modelowania Text Mining, mozna wygenerowa¢ model uzytkowy poje¢ lub model uzytkowy
kategorii (w ramach sesji pracy z interaktywnym pulpitem roboczym). Ponizszy przyktad ilustruje zastosowanie
modelu poje¢ w prostym strumieniu.

Przyktad: wezet Plik Statistics z modelem uzytkowym pojeé.

Ponizszy przyklad ilustruje zastosowanie modelu uzytkowego wygenerowanego przez wegzet Text Mining.
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Rysunek 3. Przyktadowy strumien: wezet Plik Statistics z modelem uzytkowym Text Mining

1. Wezel Plik Statistics (karta Data). Najpierw dodalismy ten wezel do strumienia, aby okresli¢, gdzie sa
przechowywane dokumenty tekstowe.

Rozdziat 3. Eksploracja w poszukiwaniu pojgc¢ i kategorii

35



J MUSIC_Survey.sav

o L@ Pr.eview] LQ Refresh_]

C\Documents and Settingstsvwebbivy DocumentsipubziText MiningtTAV S Dmusic_sury

i - || r 1
Dats | Fiter | Types | Annctations
Iimport file: iy DocumentsipubsiText_dining TAY S 04nusic_surveymusic_survey sav -

warigble names: @ Read names and labels  ©) Read labels a2 names

Values: (8 Read data and labels Read lahels as data

m Use field format information to determine storage

Rysunek 4. Okno dialogowe wezla Plik Statistics: karta Data

2. Model uzytkowy poje¢ wygenerowany przez wezel Text Mining (karta Model). Nastgpnie dodalismy wezet
modelu uzytkowego pojec i potaczyliSmy go z weztem Plik Statistics. Wybrali§my pojecia, ktore chcemy
wykorzysta¢ do oceniania danych.
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'\) Q2 What_do_you_like_least_about_this_portable_music_player
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] 1.594 120 2.963 1258 =Unknown=
= 1328 10 2,469 1005 =Megative=
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| ] 1.195 ] | 2222 4[5 «Characterist
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Concepts selected for scoring: 353 Total concepts available: 353

Undetlying terms of selected concepts

Concept Underlying Terms

hatte
& life, hattery lifes, batireries, battrery

ahbteries, abbtery, bateries, batery, batt,, batt.s, batteries, battery

Rysunek 5. Okno dialogowe modelu uzytkowego Text Mining: karta Model

3. Model uzytkowy poje¢ wygenerowany przez wezel Text Mining (karta Settings). Nastepnie zdefiniowalismy

format wyjsciowy i1 wybralismy opcje Concepts as fields. W wynikach dla kazdego pojecia zaznaczonego na karcie
Model zostanie utworzona jedna nowa zmienna. Nazwa kazdej zmiennej zostanie skonstruowana z nazwy pojecia i

przedrostka "Concept_"

'\) Q2 _What_do_you_like_least_about_this_portable_music_player
£} Generate e

\o File = Edit

abe

madel-’ Seﬁingsf- i Summary| Annotations

Scormg Maode: @ Concepts as ﬂelds (9] Concepts as records
@ Flags © Counts

Field values:

True value:

Field name extension:

Add as: © Suffix @ Prefix

[¥ Accommodate punctuation errars

Rysunek 6. Okno dialogowe modelu uzytkowego poje¢ wygenerowanego przez wezet Text Mining: karta Settings

Rozdziat 3. Eksploracja w poszukiwaniu pojgc¢ i kategorii
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4. Model uzytkowy poje¢ wygenerowany przez wezel Text Mining (karta Fields). Nastgpnie wybrali$my zmienna
tekstow Q2_What_do_you_like_least_about_this_portable_music_player, ktorej nazwa pochodzi z wezta Plik
Statistics. Ponadto wybralismy opcj¢ Text field represents: Actual text.

\} Q2 _What_do_you_like_least_about_this_portable_music_player @

\a File |5 Edit ) Generate I Preview EE

0y

abe

Model Settings Fields | Summary Annotations

Teut field: Iq% Q2 _What_do_you_like_least_ahout_this_portable_music_player [vE]

Textfield represents: @ Actual text © Pathnames to documents

Textlanguage:  |English ~ |

Rysunek 7. Okno dialogowe modelu uzytkowego poje¢ wygenerowanego przez wezet Text Mining: karta Fields

5. Wezel Tabela. Nastepnie dotaczyliSmy wezet Tabela, aby wyswietli¢ wyniki i wykona¢ strumien. Na ekranie
zostanie wyswietlona tabela wynikow.

Table (329 fields, 405 records) #2

\ahFile | = Ecit  {) Generate

Table || annotations

Respandent D | @1 _vv..| @2 ywhat_da_you_like_least_skout_this_portaiale_music_layer | concept_relabie | concept_downioading. . | Concept_white colar | Cancept_limited
1 1 little, li... expensive F F F F e
2 2 The ba... The screen is hard to see when outside. F F F F
3 3 cost a... difficutt software F F F F
4 4 Harving.... Mothing, | love: it F F F F
5 5 The sh.. Battery life seems sharter than advertised F F F F
[} ] Eatter... Ubiguitousness, everyone has one. F F F F
7 7 llikeit... |wizhthe 40GE model was =till available. | have a 20GE model and need more memory. F F F F
g 5] portaki... it dossnt have a light. F F F F
9 ] Small, ... Mothing. | love it F F F F
10 10 Ablzt.. iz inthe shop dus to s hardware failure. F F F F
11 11 It's por... smudges on the display F F F F
12 12 Living i... Battery life F F F F
ik 13 mokility  Technical difficulties sefting it up inttialy and managing the library of songsonmy PC. F F F F
14 14 | like th... It iz & [tle hesey, and the battery life isn't long enough. F F F F
i 13 It holdl... Battery life. F F F F
16 16 ft's fun... nothing F F F F
i 17 its coal  battery F F F F
18 18 lotz of it was very expensive F F F F
149 149 Cthers... | find the controlz hard to use. F F F F
20 20 lighitwy... =0 small afraid 'l loze it easily F F F F Z
[ [H

Rysunek 8. Tabela wynikdw przewinieta tak, by byly widoczne flagi pojec.
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Model uzytkowy Text Mining: model kategorii

Model uzytkowy kategorii jest generowany przez wezet Text Mining, gdy zazadasz wygenerowania go w
interaktywnym pulpicie roboczym. Ten model uzytkowy zawiera zestaw kategorii, ktorych definicje sktadaja si¢ z
pojec, typow, wzorcow TLA i/lub regut kategorii. Model uzytkowy stuzy do kategoryzacji odpowiedzi na ankiety,
wpisow w blogach, innych kanatéw WWW oraz wszelkich innych danych tekstowych.

Jesli uruchomisz sesjg pracy z interaktywnym pulpitem w wezle modelowania, mozesz eksplorowa¢ wyniki
wyodregbniania oraz zoptymalizowac zasoby i kategorie przed wygenerowaniem modeli kategorii. W trakcie
wykonywania strumienia zawierajacego model uzytkowy Text Mining do danych sa dodawane nowe pola zgodnie z
trybem budowania, ktory jeszcze przed rozpoczgciem budowania modelu wybrano na karcie Model wezta
modelowania Text Mining. Wigcej informacji zawiera temat [‘Model uzytkowy kategorii: karta Model|

Jesli model uzytkowy zostat wygenerowany przy uzyciu dokumentdéw przettumaczonych, to ocena bedzie wykonywana
na jezyku docelowym ttumaczenia. Podobnie, jesli model uzytkowy zostat wygenerowany przy uzyciu jgzyka
angielskiego, mozna w tym modelu uzytkowym okresli¢ jezyk thumaczenia, poniewaz dokumenty beda thumaczone na
jezyk angielski.

Wygenerowane modele uzytkowe Text Mining umieszczane sa na palecie modeli uzytkowych (ktora znajduje si¢ na
karcie Modele w prawym gérnym rogu okna IBM SPSS Modeler).

Wyswietlanie wynikoéw

Aby wyswietli¢ informacje o modelu uzytkowym, kliknij prawym przyciskiem myszy wezel na palecie modeli
uzytkowych i wybierz polecenie Browse z menu kontekstowego (lub Edit w przypadku modeli w strumieniuy).

Dodawanie modeli do strumieni

Aby doda¢ model uzytkowy do strumienia, kliknij ikong na palecie modeli uzytkowych, a nastgpnie kliknij obszar
roboczy strumienia w miejscu, w ktorym chcesz umiesci¢ wezet. Zamiast tego mozna tez klikna¢ ikong i z menu
kontekstowego wybra¢ polecenie Add to Stream. Nastepnie potacz strumien z nowym weztem. Mozna teraz przekazac
do strumienia dane w celu wygenerowania predykcji.

Przestroga: Jesli cheesz uzy¢ modelu uzytkowego oceniania do ponownego wygenerowania we¢zta modelowania
zawierajacego 1 model kategorii, i uzyty szablon, zalecamy utworzenie, zamiast we¢zla modelowania, pakietu TAP i
uzycie go w sesji interaktywnej przed wygenerowaniem modelu uzytkowego oceniania.

Model uzytkowy kategorii: karta Model

Karta Model modelu kategorii zawiera listg kategorii ujetych w modelu (po lewej stronie) i deskryptory wybranej
kategorii (po prawej stronie). Kazda kategoria ztozona jest z szeregu deskryptorow. Deskryptory powiazane z wybrana
kategoria sa wyswietlane w tabeli. Deskryptorami moga by¢ pojecia, reguly kategorii, typy i wzorce TLA.
Wyswietlany jest takze typ deskryptora, jak rowniez przyktady ilustrujace, co takiego reprezentuje dany deskryptor.

Ta karta shuzy do wyboru kategorii, ktore maja by¢ uzywane podczas oceniania. Model kategorii ocenia dokumenty i
rekordy, przypisujac je do kategorii. Jesli w tekscie lub terminach poje¢ dokumentu lub rekordu wystepuje jeden lub
wigcej deskryptordw, to dokument lub rekord jest przypisywany do kategorii, do ktorej nalezy ten deskryptor. Do
termindéw zdefiniowanych w ramach poje¢ (nazywanych tez terminami bazowymi poje¢) naleza synonimy
zdefiniowane w zasobach lingwistycznych (niezaleznie od tego, czy wystapity w tekscie, czy nie), a takze wszelkie
znalezione w tekscie terminy w liczbie mnogiej/pojedynczej, permutacje termindéw, terminy wygenerowane w wyniku
grupowania rozmytego itd.

Uwaga: Jesli wygenerowano model uzytkowy poje¢, a nie kategorii, to na tej karcie beda wyswietlane inne informacje.
Wiecej informacji zawiera temat[‘Model poje¢: karta Model” na stronie 31}

Drzewo kategorii
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Aby wyswietli¢ dodatkowe informacje o kategorii, wybierz ja— zostana wyswietlone informacje o jej deskryptorach.
Przy kazdym deskryptorze dost¢pne sa nastepujace informacje:

* Nazwa deskryptora (Descriptor). To pole zawiera ikong oznaczajaca rodzaj deskryptora oraz jego nazwe.

Tabela 5. Ikony deskryptorow

% Pojecia ala Wzorce TLA

= Typy fl Reguty kategorii

* Typ. To pole zawiera nazwe typu deskryptora. Typy sa zbiorami podobnych poje¢ (grupami semantycznymi), takich
jak nazwy organizacji lub produktéw albo pozytywne opinie. Reguly nie sa przypisywane do typow.

* Details. To pole zawiera listg elementéw wchodzacych w sktad deskryptora. W zaleznosci od listy dopasowan
wyswietlana jest cata lista lub tylko jej czgs¢. Wynika to z ograniczen rozmiaru okna dialogowego.

Wybieranie i kopiowanie kategorii

Domyslnie wszystkie kategorie najwyzszego poziomu sa wybrane jako uzywane do oceniania (pola wyboru w lewym
panelu). Zaznaczenie sygnalizuje, ze kategoria bedzie uzywana podczas oceniania. Brak zaznaczenia sygnalizuje, ze
kategoria bedzie wykluczona z oceniania. Mozna zaznaczy¢ wiele wierszy naraz, wybierajac je i klikajac jedno z ich
pol wyboru. Ponadto, jesli wybrana jest kategoria lub podkategoria, ale jedna z jej podkategorii nie jest wybrana, to
pola wyboru beda miaty niebieskie tto, ktdre oznacza, ze wybrana jest tylko czgs¢ kategorii podrzednych.

Kliknigcie kategorii w drzewie prawym przyciskiem myszy umozliwia wyswietlenie menu kontekstowego
zawierajacego nastgpujace opcje:

* Check Selected. Zaznacza wszystkie pola wyboru wybranych wierszy w tabeli.

* Uncheck Selected. Usuwa zaznaczenie wszystkich pol wyboru wybranych wierszy w tabeli.

* Check All. Zaznacza wszystkie pola wyboru w tabeli. W efekcie wszystkie kategorie zostana zastosowane w
ostatecznych wynikach. Mozna tez uzy¢ odpowiedniej ikony zaznaczonego pola wyboru na pasku narzedzi.

* Uncheck All. Usuwa zaznaczenie wszystkich pél wyboru w tabeli. Usunigcie zaznaczenia kategorii spowoduje, ze
nie bedzie ona stosowana w ostatecznych wynikach. Mozna tez uzy¢ odpowiedniej ikony pustego pola wyboru na
pasku narzedzi.

Kliknigcie komorki tabeli prawym przyciskiem myszy umozliwia wy$wietlenie menu kontekstowego zawierajacego
nastepujace opcje:

* Copy. Wybrane pojecia sa kopiowane do schowka.

» Copy With Fields. Wybrany deskryptor jest kopiowany do schowka razem z nagtéwkami kolumn.

* Select All. Wszystkie wiersze w tabeli zostang wybrane.

Model uzytkowy kategorii: karta Settings

Karta Settings stuzy do okreslania wartosci zmiennej tekstowej w celu uwzglednienia nowych danych wejsciowych,
gdy zachodzi taka potrzeba. Jest ona takze miejscem, w ktérym mozna zdefiniowa¢ model danych dla wyniku (tryb
oceniania).

Uwaga: Ta karta jest dostgpna w oknie dialogowym wezla tylko wtedy, gdy model uzytkowy zostal umieszczony w

obszarze roboczym lub w strumieniu. Nie jest wySwietlana, gdy okno dialogowe modelu uzytkowego zostanie otwarte
bezposrednio z palety Modele.
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Tryb oceniania: Categories as fields

Zatem liczba rekordow wynikowych jest taka sama, jak w danych wejsciowych. Jednak kazdy rekord zawiera teraz po
jednej nowej zmiennej dla kazdej kategorii zaznaczonej na karcie Model. Dla kazdej zmiennej wprowadz wartos¢ flagi
oznaczajaca True i wartos¢ oznaczajaca False, na przyktad Tak/Nie, Prawda/Falsz, T/F, albo I i 2. Typy sktadowania
sq ustawiane automatycznie odpowiednio do wybranej wartosci. Na przyktad, jesli wprowadzisz liczbowe wartosci
flag, to automatycznie beda traktowane jako wartosci catkowitoliczbowe. Flagi moga by¢ sktadowane jako tancuchy,
liczby catkowite, liczby rzeczywiste lub wartosci data/czas.

Uwaga: Jesli zbior danych jest bardzo obszerny, np. jest baza danych Db2, wybranie opcji Categories as fields moze
spowodowac problemy z przetwarzaniem. W takich przypadkach zaleca si¢ korzystanie z opcji Categories as records.

Rozszerzenie nazwy zmiennej. Mozna wybra¢ opcjg okreslania przedrostka/przyrostka (rozszerzenia) nazwy zmiennej
lub uzy¢ kodow kategorii. Nazwy zmiennych generowane sa poprzez potaczenie nazwy kategorii z rozszerzeniem.

* Add as. Okresl, gdzie do nazwy zmiennej powinno by¢ dodawane rozszerzenie. Wybierz Prefix, aby dodawac
rozszerzenie na poczatku tancucha. Wybierz Suffix, aby dodawac rozszerzenie na koncu tancucha.

If a subcategory is unselected. Ta opcja umozliwia okreslenie, w jaki sposob traktowane beda deskryptory nalezace
do podkategorii niewybranych do oceny. Dostepne sa dwie opcje.

* Opcja Exclude its descriptors completely from scoring powoduje, ze deskryptory niezaznaczonych podkategorii
beda ignorowane i nie bgda uzywane podczas oceniania.

* Opcja Aggregate descriptors with those in parent category powoduje, ze deskryptory niezaznaczonych
podkategorii beda uzywane jako deskryptory kategorii nadrzednej wobec tych podkategorii. Jesli niezaznaczone sa
kategorie na kilku poziomach, deskryptory beda agregowane az do pierwszej dostepnej kategorii nadrzedne;j.

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrgbniania tekst zawierajacy btedy
interpunkcyjne (na przyktad nieprawidtowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrebniania poje¢. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krotkimi
tekstami o niskiej jako$ci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrétow.

Tryb oceniania: Categories as records

W tym trybie oceniania dla kazdej pary kategoria, dokument tworzony jest nowy rekord. Zwykle wyniki zawieraja
wigcej rekordow niz dane wejsciowe. Oprocz zmiennych wejsciowych do danych dodawane sa takze zmienne
wynikowe — zaleznie od rodzaju modelu.

Tabela 6. Zmienne wynikowe w trybie ,Categories as records”.

Nowa zmienna wynikowa Opis

Category Zawiera nazwg kategorii, do ktorej dokument tekstowy zostat przypisany. Jesli kategoria jest
podkategoria innej, petna $ciezka kategorii jest sterowana przez warto$¢ wybrana w tym oknie
dialogowym.

Values for hierarchical categories. Ta opcja okresla, w jaki sposob nazwy podkategorii sa wyswietlane w wynikach.

* Full category path. Ta opcja wyswietli nazwe kategorii oraz petna $ciezkg kategorii nadrzednych, w razie potrzeby
uzywajac ukosnikow do rozdzielania nazw kategorii od nazw podkategorii.

* Short category path. Ta opcja wyswietli tylko nazwe kategorii, ale uzyje wielokropkdéw do wyswietlenia liczby
kategorii nadrzednych dla okreslonej kategorii.

* Bottom level category. Ta opcja wyswietli tylko nazwg kategorii bez petnej sciezki i bez wyswietlonych kategorii
nadrzednych.

If a subcategory is unselected. Ta opcja umozliwia okreslenie, w jaki sposob traktowane beda deskryptory nalezace
do podkategorii niewybranych do oceny. Dostepne sa dwie opcje.
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* Opcja Exclude its descriptors completely from scoring powoduje, ze deskryptory niezaznaczonych podkategorii
beda ignorowane i nie beda uzywane podczas oceniania.

* Opcja Aggregate descriptors with those in parent category powoduje, ze deskryptory niezaznaczonych
podkategorii beda uzywane jako deskryptory kategorii nadrzednej wobec tych podkategorii. Jesli niezaznaczone sa
kategorie na kilku poziomach, deskryptory beda agregowane az do pierwszej dostepnej kategorii nadrzedne;j.

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrgbniania tekst zawierajacy btedy
interpunkcyjne (na przyktad nieprawidtowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrebniania pojec. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krotkimi
tekstami o niskiej jakosci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrotow.

Model uzytkowy kategorii: karta Other

Karta Fields i karta Settings dla modelu uzytkowego kategorii sa takie same, jak dla modelu uzytkowego pojecia.

* Karta Fields. Wigcej informacji zawiera temat[‘Model poje¢: karta Fields” na stronie 34|

+ Karta Summary. Wigcej informacji zawiera temat [‘Model pojeé: karta Summary” na stronie 34|

Uzywanie modeli uzytkowych kategorii w strumieniu

Model uzytkowy kategorii eksploracji tekstu jest generowany z sesji interaktywnego pulpitu roboczego. Mozna uzy¢
tego modelu uzytkowego w strumieniu.

Przyktad: wezet Plik Statistics z modelem uzytkowym kategorii

W ponizszym przyktadzie przedstawiono sposdb uzycia modeli uzytkowych Text Mining.

/ A
@ Q1 _What_do_you_like_..
rnusi|:_suwey.sew\‘L ’ EEEE
oy —» |
abt
21 _What_do_you_like_.. Tahle

Rysunek 9. Przyktadowy strumien: wezet Plik Statistics z modelem uzytkowym kategorii

1. Wezel Plik Statistics (karta Data). Najpierw dodaliSmy ten wezet do strumienia, aby okresli¢, gdzie sa
przechowywane dokumenty tekstowe.
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Rysunek 10. Okno dialogowe wezia Plik Statistics: karta Data

2. Model uzytkowy kategorii (karta Model). Nastgpnie dodalismy wezet modelu uzytkowego Kategoria i
potaczylismy go z weztem Plik Statistics. Wybralismy kategorie, ktdre chcieliSmy wykorzysta¢ do oceniania

danych.
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Rysunek 11. Okno dialogowe modelu uzytkowego Text Mining: karta Model

3. Model uzytkowy Text Mining (karta Settings). Nastgpnie zdefiniowalismy format wyjsciowy Categories as
fields.

\g:'f 01 What_do_you_like_rmost_ahout_this_portable_music_player

|;, Eile = Edit £y Generate P Er_evigw BEE

B 4

Model Setings Fields  Summary Annotations

Scoring Mode: @éCategories as fields © Categories as records

I Categories as fislds

Field name extension: iUSE category codes ™ |

Add as: @ Sufiix. @ Prefix

If a subcategory is unselected: @ Exclude its descriptors completely from scoring

© Aggregate descriptors with those in parent category
[ Accommodate punctuation errors

Rysunek 12. Okno dialogowe modelu uzytkowego kategorii: karta Settings
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4. Model uzytkowy kategorii (karta Fields). Nast¢pnie wybraliSmy zmienna tekstowa, czyli nazwe zmiennej z
wezla Plik Statistics, i wybraliSmy opcj¢ Text field represents Actual text oraz inne ustawienia.

@ Q1 What_do_you_like_rmost_about_this_portable_music_player

lo File |5 Edit ¢ Generate W Ereview

‘:L( y

Model | Seftings  Fields | Summary Annotations

el=lo)

Textfield: o] @1 _What_do_you_like_most_about_this_portable_music_player

<A

Textfield represents: @ Actual text © Pathnames to documents

Text language: EEninsh = |

Rysunek 13. Okno dialogowe modelu uzytkowego Text Mining: karta Fields

5. Wezel Tabela. Nastgpnie dotaczyliSmy wezel Tabela, aby wyswietlic wyniki i wykona¢ strumien.

[Ed Table (3 fields, 844 records)

BE]

|ad File |5 Edt ) Generate E
| Table || Annotations
18] |G1 _Whiat_do_you_like_most_about_this_portable_music_player Category |

1 1 little:, ligght lighit

2 2 The hattery poseer is great. licght

3 2 The battery povwer is great. electronicz/battery

4 2 The battery povver is great. electronics

a2 3 cost and size size

5] g Battery life. Portahbilty . Accessories. Style. ligght

7 E Battery life. Portabilty . Accessories, Style, electronics/battery

5] E Eattery life. Portahilty. Accessories. Style. electronics

=] 7 | like t= ability to store all of my music. 1 alzo like the ability to create playlists. playlizts

10 7 | like it= ahility to store all of my music. | also like the abilty to creste playlists. iyt

11 7 | like it= ability to store all of my music. 1 alzo like the ability to create playlists. MUEIc

12 g portability, capacity, sound quality, durability ligght

13 g portakility, capacity, sound quality, durakility electronics/audicszound

14 g portakility, capacity, sound quality, durakbility electronics/audio

=

Rysunek 14. Wyniki w formie tabeli

Rozdziat 3. Eksploracja w poszukiwaniu pojgc¢ i kategorii 45



46 1BM SPSS Modeler Text Analytics 18.1.1 — podrecznik uzytkownika



Rozdziat 4. Eksploracja w poszukiwaniu powigzan w tekscie

Wezet Text Link Analysis

Wezet Text Link Analysis (TLA) uzupetnia wyodrebnianie poje¢ o technike dopasowywania wzorcéw w celu
zidentyfikowania relacji miedzy pojeciami w danych tekstowych na podstawie znanych wzorcow. Te relacje moga
opisywac odczucia klientdéw wobec produktu, wspotprace migdzy firmami, a nawet relacje migdzy genami lub
substancjami leczniczymi.

Na przyktad samo wyodrgbnienie nazwy produktu naszego konkurenta moze nie dostarczy¢ wartoSciowej wiedzy. Za
pomoca tego wegzta mozna jednak dowiedzie¢ sig takze, jakie odczucia klienci maja wobec tego produktu, jesli tylko
odpowiednie opinie kryja si¢ w dostgpnych danych. Relacje i powiazania sa identyfikowane i wyodrgbniane przez
dopasowywanie znanych wzorcow do danych tekstowych.

Mozna uzy¢ regut wzorcéw TLA dostepnych w niektorych szablonach zasobdw dostarczanych razem z produktem
IBM SPSS Modeler Text Analytics lub utworzy¢/edytowaé wilasne. Reguty wzorcow zawieraja makra, listy wyrazow i
odstepy migdzy wyrazami, ktore sktadaja si¢ na zapytanie boolowskie Iub regute stosowana wobec tekstu wejsciowego.
Za kazdym razem, gdy reguta wzorca TLA znajdzie pasujacy tekst, tekst ten moze by¢ wyodrebniony jako wynik
analizy TLA i zrestrukturyzowany do postaci danych wynikowych. Wigcej informacji Zawiera
{‘Informacje o regutach powiazan w tekécie”, na stronie 197}

Wezel Text Link Analysis oferuje bardziej bezposredni sposob identyfikowania i wyodrebniania wzorcow z tekstu, a
takze moze dodawa¢ wynikowe wzorce powiazan TLA do zbioru danych w strumieniu. Jednak wezet analizy
odsytaczy tekstowych nie jest jedynym dostepnych sposobem analizy powiazan w tekscie. Mozna réwniez uzy¢
interaktywnego pulpitu roboczego w wezle modelowania Text Mining.

W interaktywnym pulpicie roboczym mozna eksplorowa¢ wynikowe wzorce TLA i uzy¢ ich jako deskryptorow
kategorii i/lub wykorzysta¢ do analizy zstgpujacej wynikow i tworzenia wykresow. Wigcej informacji zawiera
Rozdziat 11, “Eksplorowanie analizy powiazan w tekécie”, na stronie 139l W istocie wyodrebnianie wynikéw TLA za
pomoca wezta Text Mining jest doskonalym sposobem eksploracji i precyzyjnego dopasowywania szablonéw do
konkretnych danych — z mysla o pdzniejszym wykorzystaniu tych szablonéw w wezle TLA.

Definicja wynikdw moze sktada¢ si¢ maksymalnie z 6 parametrow (czesci). Wigcej informacji zawiera temat
wezta TLA” na stronie 50}

Wezet ten znajduje si¢ na karcie IBM SPSS Modeler Text Analytics palety weztow w oknie IBM SPSS Modeler.
Wigcej informacji zawiera temat [“Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8|

Wymagania. Wezel Text Link Analysis akceptuje dane tekstowe wezytane do zmiennej za pomoca dowolnego ze
standardowych weztow zrodtowych (Baza danych, Plik ptaski itd.) lub, takze w zmiennej, listg Sciezek do
zewnetrznych dokumentéw wygenerowana przez wezel File List lub Web Feed.

Mocne strony. Wezet Text Link Analysis wychodzi poza proste wyodrebnianie pojeé, dostarczajac informacji na temat
relacji miedzy pojeciami, a takze o powiazanych z danymi opiniach i kwalifikatorach.

Wezel Text Link Analysis: karta Fields

Karta Fields stuzy do okreslenia ustawien dotyczacych zmiennych zawierajacych dane, z ktoérych maja by¢
wyodregbniane pojgcia. Mozna ustawic¢ nastgpujace parametry:

Zmienna identyfikacyjna. Wybierz zmienna zawierajaca identyfikator rekordow tekstowych. Identyfikatory musza

by¢ liczbami catkowitymi. Zmienna identyfikacyjna stuzy jako indeks dla poszczegdlnych rekordow tekstowych. Uzyj
zmiennej identyfikacyjnej, jesli zmienna tekstowa zawiera tekst, ktory ma by¢ eksplorowany.
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Text field. Wybierz zmienna zawierajaca tekst do eksploracji. Zmienna ta zalezy od zrédta danych.

Language field. Wybierz zmienna zawierajaca 2-literowy identyfikator jezyka ISO. Jesli nie wybierzesz zmiennej, dla
kazdego dokumentu przyjety zostanie jezyk na podstawie dostarczonego szablonu.

Document type. Typ dokumentu okresla strukturg tekstu. Wybierz jeden z nastgpujacych typow:

* Full text. Odpowiedni dla wigkszosci dokumentow i zrodet tekstowych. Podczas wyodrgbniania przegladany jest
caly zbior tekstu. Z ta opcja, w odréznieniu od pozostatych, nie sa zwiazane zadne ustawienia dodatkowe.

* Structured text. Odpowiedni do analizy formularzy bibliograficznych, patentow i innych plikow zawierajacych
regularne struktury dajace si¢ rozpoznac i przeanalizowaé. Zastosowanie tego typu dokumentow wiaze si¢ z
pominigciem catosci lub czgsci procesu wyodrebniania. Umozliwia zdefiniowanie separatoréw terminow,
przypisywanie typow i okreslenie wymaganej minimalnej czgstotliwosci. W przypadku wybrania tej opcji nalezy
klikna¢ przycisk Settings i wprowadzi¢ separatory tekstu w obszarze Structured Text Formatting okna
dialoiowego Document Settings. Wigcej informacji zawiera temat [“Ustawienia dokumentéw na karcie Zmienne” nal

Textual unity. Wybierz jeden z nastepujacych tryboéw wyodregbniania:

* Document mode. Tryb odpowiedni do pracy z krétkimi i semantycznie jednorodnymi dokumentami, takimi jak
artykuty prasowe.

* Paragraph mode. Odpowiedni do stron WWW i dokumentow bez znacznikow. W procesie wyodrgbniania
dokumenty sa semantycznie dzielone na podstawie takich cech wewngtrznych, jak wewngtrzne znaczniki i sktadnia.
Wybranie tego trybu powoduje, ze ocenianie odbywa si¢ akapit po akapicie. Dlatego, na przyktad, reguta apple &
orange jest spetniona tylko wtedy, gdy apple i orange wystepuja w tym samym akapicie.

Uwaga: Z uwagi na sposob wyodrebniania tekstu z dokumentow PDF tryb Paragraph mode nie dziata z takimi
dokumentami. Wynika to z faktu, ze podczas wyodrebniania pomijane sa znaki powrotu karetki.

Paragraph mode settings. Ta opcja jest dostgpna tylko wtedy, opcje zgodnosci tekstowej ustawiono na Paragraph
mode. Okresl progi liczby znakdéw obowiazujace we wszystkich procesach wyodrgbniania. Rzeczywisty rozmiar jest
zaokraglany w gore lub w dot do najblizszej kropki. Aby mie¢ pewnosc¢, Ze asocjacje wyrazow wygenerowane z tekstu
zawartego w zbiorze dokumentow sa reprezentatywne, nalezy unika¢ okreslania zbyt matego rozmiaru wyodrebniania.

* Minimum. Okre$l minimalna liczbg znakdw, jaka ma by¢ uzywana w kazdym wyodrgbnianiu.

* Maksimum. Okre$l maksymalna liczbg znakow, jaka ma by¢ uzywana w kazdym wyodrebnianiu.

Copy resources from. Podczas eksploracji tekstu wyodrebnianie prowadzone jest nie tylko na podstawie ustawien na
karcie Expert, lecz rowniez na podstawie zasobow lingwistycznych. Zasoby te sa podstawa dla przetwarzania tekstu w
trakcie wyodrgbniania w celu uzyskania z niego pojec, typow, a takze wzorcow TLA. Zasoby mozna kopiowac do tego
wezla z szablonu zasobu.

Szablon zasobdw to predefiniowany zestaw bibliotek i zaawansowanych zasobow lingwistycznych oraz
nielingwistycznych, ktore zostaly zoptymalizowane pod katem konkretnej dziedziny lub zastosowania. Zasoby te sa
podstawa dla przetwarzania danych w trakcie wyodrgbniania. Kliknij opcj¢ Load i wybierz szablon, z ktorego checesz
skopiowa¢ zasoby.

Szablony sa tadowane zaraz po wybraniu, a nie podczas wykonywania strumienia. Podczas tadowania kopia zasobow
zapisywana jest w danym wezle. Jesli zatem w przysztosci zechcesz uzy¢ zmienionego szablonu lub pakietu, musisz go
Elgnownie zatadowaé. Wiccej informacji zawiera temat[“Kopiowanie zasobow z szablonow i pakietow TAP” na stronie]

Text language. Okresla jezyk tekstu poddawanego eksploracji. Zasoby skopiowane w wgzle steruja wyswietlanymi
opcjami dotyczacymi jezyka. Wybierz jezyk, w ktéorym zasoby zostaty dostosowane.
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Wezel Text Link Analysis: karta Expert

W tym wezle automatycznie wlaczane jest wyodrebnianie wzorcow analizy powiazan w tekscie (TLA). Karta Expert
zawiera pewne zaawansowane parametry wplywajace na sposob wyodrebniania tekstu i postgpowania z nim. Parametry
w tym oknie dialogowym steruja podstawowym przebiegiem, a takze kilkoma funkcjami zaawansowanymi procesu
wyodrgbniania. Istnieje takze szereg zasobow lingwistycznych i opcji wptywajacych na wyniki wyodrgbniania i
sterowanych za posrednictwem wybranego szablonu zasobow.

Limit extraction to concepts with a global frequency of at least [n]. Okresla, ile razy wyraz lub fraza musi wystapi¢
w tekscie, aby zostal(a) wyodregbniony/-a. Na przyklad warto$¢ 5 powoduje, ze wyodrebnianie beda tylko te wyrazy i
frazy, ktore wystepuja co najmniej pigc¢ razy w catym zbiorze rekordow lub dokumentow.

W niektorych przypadkach zmiana tego limitu silnie wptywa na wyniki wyodrebniania, a w efekcie na utworzone
kategorie. Zatozmy, ze pracujemy nad danymi o sieci restauracji i opisywany limit jest ustawiony na 1. W tym
przypadku w wynikach wyodrgbniania moga znalez¢ sig pojgcia: pizza (1), thin pizza (2), spinach pizza (2) i favorite
pizza (2). Jesli jednak ograniczymy wyodrgbnianie do poje¢ wystgpujacych co najmniej 5 razy, powyzsze trzy pojgcia
nie zostana wyodrebnione. W wynikach uzyskamy natomiast pojecie pizza (7), poniewaz pizza jest najprostsza forma, a
wyraz ten istniat juz jako potencjalny kandydat. W zaleznosci od zawarto$ci reszty tekstu licznos¢ wystapien moze
przekraczac siedem, jesli w tek$cie wyraz pizza wystgpuje jeszcze w innych frazach. Ponadto, jesli pojgcie spinach
pizza bylto juz deskryptorem kategorii, to zamiast niego moze by¢ konieczne dodanie deskryptora pizza w celu
uwzglednienia wszystkich rekordow. Dlatego, jesli kategorie zostaly juz wezesniej utworzone, limit wystapien nalezy
modyfikowac ostroznie.

Nalezy zauwazy¢, ze opisywana opcja dotyczy tylko wyodregbniania; jesli szablon zawiera terminy (a zwykle zawiera),
a termin z szablonu zostanie znaleziony w tekscie, to termin ten bedzie indeksowany niezaleznie od liczebnosci
wystapien.

Zatdzmy na przyktad, ze szablon Basic Resources zawiera termin "los angeles" typu <Location> w bibliotece Core;
jesli dokument zawiera termin Los Angeles tylko raz, to Los Angeles zawsze znajdzie sig na liscie pojec. Aby temu
zapobiec, nalezy ustawi¢ filtr w celu uwidocznienia poje¢ wystgpujacych co najmniej tyle razy, ile wynosi limit
okreslony w polu Limit extraction to concepts with a global frequency of at least [n].

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrgbniania tekst zawierajacy biedy
interpunkcyjne (na przyktad nieprawidtowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrebniania pojec. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krotkimi
tekstami o niskiej jako$ci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrétow.

Accommodate spelling for a minimum word character length of [n] Ta opcja powoduje zastosowanie techniki
grupowania rozmytego, ktora grupuje btednie napisane lub podobne wyrazy pod jednym pojeciem. Algorytm
grupowania rozmytego tymczasowo usuwa wszystkie samogtoski (z wyjatkiem pierwszej) oraz podwojne/potrojne
spotgloski z wyodrgbnianych wyrazow, a nastgpnie porownuje wyniki, by sprawdzi¢, czy sa identyczne. Zatem wyrazy
modeling i modelling zostalyby potaczone w jedna grupe. Jesli jednak kazdy termin ma przypisany inny typ, z
wyjatkiem typu <Unknown>, to grupowanie rozmyte nie bgdzie stosowane.

Mozna tez okresli¢ minimalna liczbg znakdéw rdzennych wymagana do zastosowania grupowania rozmytego. Liczba
znakow rdzennych w terminie obliczana jest poprzez zsumowanie wszystkich znakow i odjecie znakow tworzacych
przyrostki przy odmianie, a w wypadku terminow bedacych wyrazami ztozonymi, takze znakow tworzacych okreslniki
i przyimki. Na przyktad termin exercises ma 8 znakéw rdzennych w swojej postaci “exercise”, poniewaz litera s na
konicu tworzy odmiang (w tym przypadku liczbe mnoga). Podobnie, apple sauce ma 10 znakow rdzennych (“apple
sauce”), a manufacturing of cars ma 16 znakéw rdzennych (“manufacturing car”). Ta metoda liczenia znakow jest
stosowana tylko do sprawdzania, czy ma by¢ przeprowadzane grupowanie rozmyte, ale nie wptywa na sposéb
dopasowywania wyrazow.
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Uwaga: Jesli pdzniej okaze sig, ze pewne wyrazy sa grupowane nieprawidtlowo, mozna wykluczy¢ konkretne pary
wyrazow ze stosowania tej techniki, jawnie deklarujac je w sekcji Fuzzy Grouping: Exceptions na karcie Advanced
Resources. Wigcej informacji zawiera temat[“Grupowanie rozmyte” na stronie 187,

Extract uniterms Ta opcja wyodrgbnia pojedyncze wyrazy (terminy pojedyncze), o ile tylko nie sa juz czgscia wyrazu
ztozonego i sa albo rzeczownikami, albo nierozpoznanymi czgsciami mowy.

Extract nonlinguistic entities Ta opcja wyodrgbnia Obiekty nielingwistyczne, takie jak numery telefonow, numery
ubezpieczenia spolecznego, godziny, daty, waluty, cyfry, wartosci procentowe, adresy e-mail i adresy HTTP. W sekcji
Nonlinguistic Entities: Configuration karty Advanced Resources mozna uwzglednia¢ i wykluczaé okreslone typy
obiektow nielingwistycznych. Wykluczenie zbednych obiektow sprawi, ze mechanizm wyodrebniania nie bedzie
marnowat czasu na ich przetwarzanie. Wigcej informacji zawiera temat[“Konfiguracja” na stronie 191|

Uppercase algorithm Ta opcja wyodrebnia proste i ztozone terminy, ktore nie figuruja we wbudowanych stownikach,
o ile pierwsza litera terminu jest wielka. Jest to dobry sposéb na wyodrgbnienie wigkszosci rzeczownikow wilasnych.

Group partial and full person names together when possible Ta opcja grupuje imiona i nazwiska, ktore w tekscie
wystepuja w roznych postaciach. Jest to uzyteczne, poniewaz imiona i nazwiska czgsto na poczatku tekstu przytaczane
sa w pelnym brzmieniu, ale pdzniej juz wystepuja tylko w wersji skroconej. W przypadku wybrania tej opcji program
probuje dopasowac kazdy pojedynczy termin typu <Unknown> do ostatniego wyrazu kazdego terminu ztozonego typu
<Person> (osoba). Na przyktad, jesli znaleziony zostanie wyraz nowak o poczatkowo przypisanym typie
<Unknown>, to mechanizm wyodrgbniania sprawdzi, czy jakiekolwiek terminy ztozone typu <Person> zawieraja
jako ostatni wyraz wlasnie nowak, na przyktad piotr nowak. Ta opcja nie ma zastosowania do imion, poniewaz
wigkszo$¢ z nich nigdy nie jest wyodrebniana jako termin pojedynczy.

Maximum nonfunction word permutation Ta opcja okresla maksymalna liczbg wyrazéw niefunkcyjnych, ktore
moga by¢ obecne, gdy stosowana jest technika permutacji. Technika permutacji grupuje podobne frazy rozniace si¢
tylko wyrazami niefunkcyjnymi (na przyktad ,,of” lub ,,the”), niezaleznie od odmiany. Zatézmy na przyktad, ze wartos¢
ta jest ustawiona na maksymalnie dwa wyrazy i wyodrebniono zaréwno termin company officials, jak i termin
officials of the company. W tym przypadku oba terminy zostana potaczone w grupe, poniewaz po zignorowaniu
wyrazow of the zostana uznane za identyczne.

Use derivation when grouping multiterms Podczas przetwarzania wielkich zbioréw danych wybierz tg opcjg, aby
grupowac terminy wielowyrazowe wedlug regut derywacji.

Wyniki wezta TLA

Po uruchomieniu wezta Text Link Analysis dane sa restrukturyzowane. Wazne jest, aby zrozumie¢ sposob
restrukturyzacji danych w procesie eksploracji tekstu. Jesli chcesz uzy¢ innej struktury do eksploracji danych, mozesz
uzy¢ weztow na palecie Zmienne. Na przyktad, jesli masz dane, w ktoérych kazdy wiersz reprezentuje jeden rekord
tekstowy, to zostanie utworzony jeden wiersz dla kazdego wzorca wykrytego w zrodtowych danych tekstowych. Kazdy
wiersz wynikow zawiera 15 zmiennych:

* Szes$¢ zmiennych (Concept#, na przyktad Conceptl, Concept2, ... i Concept6) reprezentuje wszystkie pojecia
znalezione w procesie dopasowywania Wzorcow.

* Szes$¢ zmiennych (Type#, such as Typel, Type2, ... i Type6) reprezentuje typy pojec.
* Rule Name reprezentuje nazwe reguty TLA uzytej do dopasowania tekstu i wygenerowania wyniku.

* Zmienna o nazwie zmiennej identyfikacyjnej okreslonej w wezle i reprezentujaca rekord lub identyfikator
dokumentu przeniesiony wprost z danych wejsciowych.

* Matched Text przedstawia czgs¢ danych tekstowych w pierwotnym rekordzie lub dokumencie, ktora zostata
dopasowana do wzorca TLA.

Uwaga: Wszystkie istniejace juz strumienie zawierajace wezet Text Link Analysis z wersji wezesniejszych niz 5.0
moga nie by¢ w petni wykonywalne do momentu zaktualizowania weztow. Niektore udoskonalenia wprowadzone w
nowszych wersjach produktu IBM SPSS Modeler wymagaja zastapienia starszych weztow nowszymi wersjami, ktore
sa bardziej elastyczne we wdrazaniu i zaawansowane.
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Mozliwe jest rowniez automatyczne ttumaczenie niektdrych jezykow. Ta funkcja umozliwia eksplorowanie
dokumentéw w jezyku, ktorego uzytkownik nie zna. Aby uzy¢ funkcji thumaczenia, musisz mie¢ dostep do
odpowiedniego oprogramowania Saa$S firmy SDL. Wiecej informacji zawiera temat[Ustawienia thimaczenial

Buforowanie wynikow analizy TLA

Buforowanie wynikéw analizy powiazan w tekscie powoduje zapisywanie tych wynikéw w pamigci podreczne;j
strumienia. Aby unikna¢ powtarzania wyodrebniania wynikdéw analizy TLA za kazdym razem, gdy strumien jest
wykonywany, wybierz wezet Text Link Analysis i wybierz z menu opcje Edit > Node > Cache > Enable. Przy
nastgpnym wykonaniu strumienia wyniki zostana zbuforowane w wezle. Przy ikonie wezta wyswietlany jest symbol
graficzny dokumentu, ktérego kolor zmienia si¢ z biatego na zielony, gdy pami¢é podrgczna jest wypetniona. Pamigé¢
podreczna jest zachowywana przez caty czas trwania sesji. Aby zachowaé pamigé podreczna na inny dzien (gdy
strumien zostanie zamknigty i ponownie otwarty), wybierz we¢zel, a nastgpnie wybierz z menu opcje Edit > Node >
Cache > Save Cache. Przy nastgpnym otwarciu strumienia mozna bgdzie zatadowa¢ dane z pamigci podrgczne;j
zamiast ponownie uruchamia¢ ttumaczenie.

Mozna tez zapisa¢ lub wlaczy¢ pamig¢ podreczna wezta, klikajac wezel prawym przyciskiem myszy i wybierajac opcje
Cache z menu kontekstowego.

Korzystanie z wezla Text Link Analysis w strumieniu

Wezet Text Link Analysis jest uzywany w strumieniu do uzyskiwania dostgpu do danych i wyodrebniaja pojeé. Aby
uzyska¢ dostep do danych, mozna wykorzysta¢ dowolny wezetl zrodlowy,

Przyktad: wezet Plik Statistics z weztem Text Link Analysis

W ponizszym przykladzie przedstawiono sposdb uzycia wezta Text Link Analysis.

Music_sumvey. say Text Link Analysis Table
Rysunek 15. Przykiad: wezet Plik Statistics z weztem Text Link Analysis

1. Wezel Plik Statistics (karta Data). Najpierw dodalismy ten wezet do strumienia, aby okreslic, gdzie jest
przechowywany tekst.
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J MUSIC_Survey.sav

o L@ Pr.eview] LQ Refresh_]

C\Documents and Settingstsvwebbivy DocumentsipubziText MiningtTAV S Dmusic_sury

i - || r 1
Dats | Fiter | Types | Annctations
Iimport file: iy DocumentsipubsiText_dining TAY S 04nusic_surveymusic_survey sav -

warigble names: @ Read names and labels  ©) Read labels a2 names

Values: (8 Read data and labels Read lahels as data

m Use field format information to determine storage

Rysunek 16. Okno dialogowe wezta Plik Statistics: karta Data

2. Wezel Text Link Analysis (karta Fields). Nastepnie podlaczylismy ten wezet do strumienia w celu wyodrgbnienia
pojec¢ dla dalszego modelowania lub przegladania. OkresliliSmy zmienna identyfikacyjna i nazwe zmiennej
tekstowej zawierajacej dane, a takze inne ustawienia.
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Fields uw

1D field:

Text field:
e M
Document fype: |F““ Text = | Seftings. .
Textual unity: |Docurnem mode v|

Paragraph mode settings

1k

S - ) T
Minimurm: 16 Maximum: 300

Copy Resources From

Resource template: E

COpinions (English)

Loaded: Oct25, 2016 2:52:44 PM

Textlanguage:
Lok J (cancel ooy ]| Beset

Rysunek 17. Okno dialogowe wezia Text Link Analysis: karta Fields

3. Wezel Tabela. Na koniec dotaczyliSmy wezet Tabela, aby wyswietli¢ pojecia, ktore zostalty wyodrebnione z
naszych dokumentow tekstowych. W tabeli znajduja si¢ wynikowe wzorce TLA znalezione w danych po
wykonaniu tego strumienia z wezlem Text Link Analysis. Niektore wyniki zawieraja tylko jedno dopasowane
pojecie/typ. Inne wyniki sa bardziej ztozone i zawieraja kilka typow i poje¢. Dodatkowo, w wyniku przepuszczenia
danych przez wezet Text Link Analysis i wyodrgbnienia poje¢, zmienilo sig kilka aspektow danych. Oryginalne
dane uzyte w tym przyktadzie sktadaty si¢ z 8 zmiennych i 405 rekordow. Po wykonaniu wezta Text Link Analysis
mamy 15 zmiennych 640 rekordow. Istnieje po jednym wierszu dla kazdego wynikowego wzorca TLA. Na
przyktad ID 7 zmienia si¢ w trzy wiersze, poniewaz wyodrebniono trzy wynikowe wzorce TLA. Mozna uzy¢ wezta
faczenia, aby potaczy¢ te wyniki z oryginalnymi danymi.
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Table (15 fields, 640 records) #4 E]

]

3

la Flle |5 Ecit &) Generste

Tahle || Annctations

Conceptl |Type1 |Concept2 |T\fpe2 |Conc... |T\fp53 |Con... |Type4 |Conc - |Types ‘Con. N |TypeE |Ru|e Mumber |\D |Matched Text

1 EXpENSivE MegativeBudget Mull Bull Ml Bull Mull kol ull Ml Mull Mull 0M350_opinian 1 =*expensive®s

2 SCreen Unknown difficut Megs... Mull Mull Mull Mull Mull Mull Mull Mull 070145 _topic + opinion 2 The =*screen®s is <*hard®= to see when outside

3 zoftware Unknown difficult  Mega... Mull Mull Bull Rl Mull ull hull Mull 00211 _opinion + topic 3 =tifficult*= =*software®=

4 nothing Uncertsin Mull Mull Mull Mull Mull Ml Mull Mull Mull Mull 0/ 53_topic/opinion 4 =*Mothing®= =* *= | love it

B like: Pozitive MUl Mull Ml Mull Mol Rl Mull Mull Mull Mull 0M350_opinion 4 Mothing | =* love it*=

6 battery life Unknowen toolong  Mega.. Nl ull Mull bl ull Ml Mull Mull 0401 45_topic: + opinion 5 =*Battery ife*= seems <*shorter*= than advertised

7 ubiguitousness  Unknown Ml Mull Mull Mull Mull Mull Mull Ml MUl Mull 00500 _topic 1 =Hhiguitousness®=

& 40gh mocel Unknowen available  Positi. hull Il Mull kol Bl Tl Mull Blull 0401 45_topic + opinion 7 | wizh the =*40GE model*= was still =*available*>

9 20gk model Unknown Ml Mull Mull Mull Mull Ml Mull Mull Mull Mull 00102_topic + Megative +topic 7 | have & =*20GE model® and =*need more®= <*memory®=

10 MEmary Unknower need mare Megs... kull Mull Full il Mull Il Rull Mull 00102 _topic + Negsative + topic 7 | have & =*20GE model*= and =*need more*= <*metmary*=
W_Iﬂ

Rysunek 18. Wezet wynikowy Tabela

Rozdziat 5. Przegladanie tekstu ze zrodta zewnetrznego

Wezet File Viewer

Eksplorujac zbidr dokumentdw, mozna przekazac pelne nazwy $ciezek plikow bezposrednio do weztow Text Mining.
Jednak w przypadku skierowania wynikow do wezta Tabela widoczna bgdzie tylko petna Sciezka dokumentu zamiast
tekstu, ktory ten dokument zawiera. Wezet File Viewer moze by¢ uzywany zamiast wezla Tabela i umozliwia dostep do
rzeczywistego tekstu w obrebie kazdego z dokumentow bez koniecznosci scalania ich wszystkich razem w jednym
pliku.

Wezet File Viewer pomaga lepiej zrozumie¢ wyniki z ekstrakcji tekstu, umozliwiajac dostep do tekstu zrédtowego
(nieprzettumaczonego), z ktdrego zostaty wyodrebnione pojecia; bez tego wezta bytby on niedostgpny w strumieniu.
Ten wezel dodaje si¢ do strumienia za weztem File List, aby uzyskac list¢ odsytaczy do wszystkich plikow.

Wynikiem tego wezta jest okno z lista wszystkich dokumentow, ktore zostaty odczytane i wykorzystane do
wyodrgbnienia poje¢. W tym oknie mozna klikna¢ odpowiednia ikong na pasku narzedzi, aby w zewngtrznej
przegladarce wywota¢ raport z lista nazw dokumentéw przeksztalconych w odsyltacze hipertekstowe. Mozna klikna¢
taki odsylacz, aby otworzy¢ odpowiedni dokument. Wigcej informacji zawiera temat[‘Korzystanie z wezta File|
[Viewer” na stronie 56|

Wezet ten znajduje sig na karcie IBM SPSS Modeler Text Analytics palety weztdéw w oknie IBM SPSS Modeler.
Wiecej informacji zawiera temat[*Wezty produktu IBM SPSS Modeler Text Analytics” na stronie 8

Uwaga: Jesli uzytkownik pracuje w trybie klient-serwer i wezty File Viewer sa czg$cia strumienia, zbiory
dokumentéw musza by¢ przechowywane w katalogu serwera WWW na serwerze. Poniewaz wezet wynikowy Text
Mining tworzy liste dokumentéw przechowywanych w katalogu serwera WWW, ustawienia zabezpieczen serwera
WWW wplywaja na uprawnienia dostepu do tych dokumentéw.

Ustawienia wezta File Viewer

Mozna okresli¢ nast¢pujace ustawienia wegzta File Viewer.

Document field. Wybierz zmienna nalezaca do danych, ktéra zawiera petna nazwe i Sciezke dokumentow, ktore maja
by¢ wyswietlane.

Title for generated HTML page. Utworz tytul, ktéry ma by¢ wyswietlany w gornej czgsci strony zawierajace;j listg
dokumentow.

55



Korzystanie z wezla File Viewer

Ponizszy przyktad ilustruje zastosowanie wezta File Viewer.

Przyktad: wezet File List i wezel File Viewer

File List File Yiewer
Rysunek 19. Strumieri ilustrujacy uzycie wezta File Viewer

1. Wezel File List (karta Settings). Najpierw dodaliSmy ten wezet, aby okresli¢, gdzie sa przechowywane
dokumenty tekstowe.

w4 File List
(> Erevew] 21

=
elals

Settings| Filter Types | Annotations

Ditsstar: |z:1pubsltemminingmatalmenst | [:]

[ Include subdirectaries
File typets) to include in list
[ Yord processing (*.f, *.dac, *.docy, *.docm)
(& Excelfile (*xls, *xlsx, *xlsm)
[& Powerpaint (* ppt, = ppte, *pptm)
W Textfiles (bt *texh)
¥ Web pages (htm, *html, * shtml)
[« Extensible Markup Language &#xml)
(& Portable Document Format & pef
[+ Wao extension

Dutput field represents: © Actual text @ Pathnameas to documents

Rysunek 20. Okno dialogowe wezta File List: karta Settings

2. Wezel File Viewer (karta Settings). Nastgpnie dolaczyliSmy wezel File Viewer, aby utworzy¢ liste dokumentow
w formacie HTML.
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Settings

Document field:

Title for generated HTML page; |List of Documents

Rysunek 21. Okno dialogowe wezia File Viewer: karta Settings

3. Okno dialogowe File Viewer Output. Nastgpnie uruchomili$my strumien, ktory wygenerowat liste dokumentow
w nowym oknie.

E File Viewer ﬁutput’

List of Documents o

1- Eignibaeatminingelata SleBs 12011 4 1580

2 - Ziguibattentenininglela i BeBsA2011 4 30.tat

3 - Z 1 A5t

4 - Zipubalte utmininglla i B RIA2011 5 3.8t

= ZipubatieuteniningelataBeBs 82011 & 150t

& - Ziprubatte wtenininglela i BsB1 92011 § 3000t

7 - Zipuabatte tenininglelaiMBeBIAZ011 T 15001

& - Zipubaistmininglela B B2 T 3.t

5 - Zipubatisatmininglcla M EEA2011 3 1580t

10 - Rgubaltminingelatal s S5 farestop 10023 pof
11 - Eigebsextiningdata s BaAMC TWIE 0409 e putl
12 - Zigubsleatminingdata ke R MM TAN 15 P L0109 pot

L4]

Rysunek 22. File Viewer Output

Rozdziat 5. Przegladanie tekstu ze zrodta zewnetrznego 57



4. Aby wyswietli¢ dokumenty, klikneliSmy na pasku narzedzi przycisk kuli ziemskiej z czerwona strzatka.
Spowodowalo to otwarcie listy odsytaczy do dokumentow w przegladarce.
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Rozdziat 6. Wtasciwosci weztéw uzywane w skryptach

IBM SPSS Modeler udostepnia jezyk skryptowy, ktdry umozliwia wykonywanie strumieni z poziomu wiersza komend.
W tym miejscu mozna zapoznac si¢ z informacjami na temat wlasciwosci weztow dostarczonych z produktem IBM
SPSS Modeler Text Analytics. Wigcej informacji na temat standardowego zestawu wezlow dostarczonych z produktem
IBM SPSS Modeler zawiera Podrgcznik tworzenia skryptéw i automatyzacji.

Wezet File List: filelisthode

Wtasciwosci przedstawione w tabeli ponizej mozna stosowaé do tworzenia skryptow. Sam wezel nosi nazwe

filelistnode.

Tabela 7. Wiasciwosci wezta File List uzywane w skryptach

Wilasciwosci skryptow Typ danych
path string
recurse flag
word_processing flag
excel_file flag
powerpoint_file flag
text_file flag
web_page flag
xml_file flag
pdf_file flag
no_extension flag

Uwaga: Parametr ,,Create list” nie jest juz dostgpny, a wszelkie skrypty zawierajace te opcj¢ zostana automatycznie
przeksztalcone w skrypty generujace pliki (Files).

Wezel Web Feed: webfeednode

Wtasciwosci przedstawione w tabeli ponizej mozna stosowaé do tworzenia skryptow. Sam wezel nosi nazwe

webfeednode.

Tabela 8. Wiasciwosci wezta Web Feed uzywane w skryptach

Wiasciwosci skryptow

Typ danych

Opis wlasciwosci

urls stringl string?2 ...stringn Kazdy adres URL jest okreslony w strukturze listy. Lista
adreséw URL jest rozdzielana znakami “\n”

recent_entries flag

limit_entries integer Liczba najnowszych wpiséw do odczytu na adres URL.

use_previous flag Umozliwia zapisanie i ponowne uzycie buforu Web Feed.

use_previous_label string Nazwa zapisanego bufora WWW.

start_record string Znacznik poczatku inny niz RSS.

url n title string Dla kazdego adresu URL na liscie nalezy okresli¢ jeden w tej

whasciwosci. Pierwszym bedzie url1 title, przy czym numer
jest zgodny z pozycja na liscie adreséw URL. Jest to znacznik
poczatkowy zawierajacy tytut tresci.
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Tabela 8. Wiasciwosci wezta Web Feed uzywane w skryptach (kontynuacja)

Wilasciwosci skryptow Typ danych Opis wlasciwosci

url n .short_description string Tak samo, jak w przypadku url » .itle.

url n .short_description string Tak samo, jak w przypadku url » .title.

url n .authors string Tak samo, jak w przypadku url z .title.

url n .contributors string Tak samo, jak w przypadku url n .title.

url n .published_date string Tak samo, jak w przypadku url » .title.

url ».modified_date string Tak samo, jak w przypadku url » .title.

html_alg None Metoda filtrowania zawartosci.

HTMLCleaner

discard_lines flag Powoduje odrzucenie krotkich wierszy. Uzywane z
min_words

min_words integer Minimalna liczba stow.

discard_words flag Powoduje odrzucenie krotkich wierszy. Uzywane z
min_avg_len

min_avg_len integer

discard_scw flag Powoduje odrzucenie wierszy zawierajacych wiele stow
jednoznakowych. Uzywane z max_scw

max_scw integer Maksymalna proporcja od 0 do 100 procent stow
jednoznakowych na wiersz

discard_tags flag Powoduje odrzucenie wierszy zawierajacych konkretne
znaczniki.

tags string W przypadku stow specjalnych wymagane jest zastosowanie
ukosnika odwrotnego (\) jako znaku zmiany znaczenia.

discard_spec_words flag Powoduje odrzucenie wierszy zawierajacych okreslone
tancuchy.

words string W przypadku stéw specjalnych wymagane jest zastosowanie
ukosnika odwrotnego (\) jako znaku zmiany znaczenia.

Wezel jezyka: languageidentifier

Wtasciwosci przedstawione w tabeli ponizej mozna stosowaé do tworzenia skryptow. Sam wezel nosi nazwe
languageidentifier.

Tabela 9. Wiasciwosci wezia jezyka uzywane w skryptach

Wiasciwosci skryptow Typ danych Opis wlasciwosci
text field
language_field_name string Nazwa zmiennej, ktora jest generowana w wyniku.
unidentified_language_value Undefined Wartos¢ domyslna, ktora ma by¢ uzywana, gdy jezyk nie
Supported zostanie zidentyfikowany.
Custom
unidentified_language_supporteden Kod Iso. Dostepny tylko wtedy, gdy atrybut
de unidentified_language_value ma wartos¢ Supported.
es
fr
it
ja
nl
pt
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Tabela 9. Wiasciwosci wezia jezyka uzywane w skryptach (kontynuacja)

Wiasciwosci skryptow

Typ danych

Opis wlasciwosci

unidentified_language_custom

string

Dostepny tylko wtedy, gdy atrybut
unidentified_language_value ma wartos¢ Custom.

Wezet Text Mining: TextMiningWorkbench

Mozna uzy¢ nastepujacych parametréw, aby zdefiniowac lub zaktualizowac wezet za pomoca skryptu. Sam wezet nosi

nazwe TextMiningWorkbench.

Wazne: Nie mozna okresli¢ innego szablonu zasobu za posrednictwem skryptow. Jesli uwazasz, ze potrzebujesz
szablonu, nalezy go wybra¢ w oknie dialogowym wezta.

Tabela 10. Wtasciwosci wezta modelowania Text Mining uzywane w skryptach

Wiasciwosci skryptow Typ danych Opis wlasciwosci
text field
method ReadText
ReadPath
docType integer Mozliwe wartosci to (0,1,2), gdzie 0 = petnotekstowe,
1 = tekst ustrukturyzowany, a 2 = XML
encoding Automatic Nalezy zwroci¢ uwage, ze wartosci ze znakami
"UTF-8" specjalnymi, takie jak "UTF-8", powinny by¢ ujgte w
"UTF-16" cudzystow, aby znaki nie zostaly potraktowane jak
"ISO-8859-1" operatory matematyczne.
"US-ASCII"
"CP850"
"EUC-JP"
"SHIFT-JIS"
"1ISO2022-JP"
unity integer Mozliwe warto$ci to (0,1), gdzie 0 = tryb akapitow, a 1
= tryb dokumentoéw
para_min integer
para_max integer
mtag string Zawiera wszystkie ustawienia mtag (z okna dialogowego
ustawien dla plikéw XML)
mclef string Zawiera wszystkie ustawienia mclef (z okna
dialogowego ustawien dla plikow tekstowych
ustrukturyzowanych)
partition field
custom_field flag Wskazuje, czy zostanie okre$lona zmienna dzielaca na
podzbiory.
use_model_name flag
model_name string
use_partitioned_data flag Jesli zdefiniowana jest zmienna dzielaca na podzbiory,
do budowania modelu uzywane sa wytacznie dane
uczace.
model_output_type Interactive Interactive powoduje generowanie modelu kategorii.
Model Model powoduje generowanie modelu pojec.
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Tabela 10. Wtasciwosci wezta modelowania Text Mining uzywane w skryptach (kontynuacja)

Wiasciwosci skryptow Typ danych Opis wlasciwosci
use_interactive_info flag Tylko do tworzenia interaktywnego w sesji pulpitu
roboczego
reuse_extraction_results flag Tylko do tworzenia interaktywnego w sesji pulpitu
roboczego
interactive_view Categories Tylko do tworzenia interaktywnego w sesji pulpitu
TLA roboczego
Clusters
extract_top integer Ten parametr jest uzywany, gdy model_type =
Concept
use_check_top flag
check_top integer
use_uncheck_top flag
uncheck_top integer
iezyk de
en
es
fr
it
ja
nl
pt
frequency_limit integer Nieaktualna w wersji 14.0.
concept_count_limit integer Ogranicza wyodrgbnianie do pojec, ktorych globalna
liczebnos¢ rowna jest co najmniej tej wartosci.
fix_punctuation flag
fix_spelling flag
spelling_limit integer
extract_uniterm flag
extract_nonlinguistic flag
upper_case flag
group_names flag
permutation integer Maksymalna liczba permutacji wyrazu niefunkcyjnego

(domyslnie 3).

Model uzytkowy Text Mining: TMWBModelApplier

Wilasciwosci przedstawione w tabeli ponizej mozna stosowaé¢ do tworzenia skryptow. Model uzytkowy nosi nazwe

TMWBModelApplier.

Tabela 11. Wiasciwosci modelu uzytkowego Text Mining

Wiasciwosci skryptow Typ danych Opis wlasciwosci
scoring_mode Fields
Records
field_values Flags Ta opcja nie jest dostgpna w modelu uzytkowym
Counts kategorii. Dla wlasciwosci Flags ustaw wartos¢ TRUE
lub FALSE.
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Tabela 11. Wiasciwosci modelu uzytkowego Text Mining (kontynuacja)

Wiasciwosci skryptow Typ danych Opis wlasciwosci

true_value string Za posrednictwem wilasciwosci Flags zdefiniuj warto$¢
oznaczajaca true.

false_value string Za po$rednictwem wiasciwosci Flags zdefiniuj wartosé¢
oznaczajaca false.

extension_concept string Okresl rozszerzenie nazwy zmiennej. Nazwy zmiennych
generowane sa poprzez potaczenie nazwy pojecia z
rozszerzeniem. Okresl miejsce, w ktdrym ma zostac
umieszczone to rozszerzenie, przy uzyciu wartosci
add_as.

extension_category string Rozszerzenie nazwy zmiennej. Mozna wybrac opcje
okreslania przedrostka/przyrostka (rozszerzenia) nazwy
zmiennej lub uzy¢ kodow kategorii. Nazwy zmiennych
generowane sa poprzez potaczenie nazwy kategorii z
rozszerzeniem. Okresl miejsce, w ktorym ma zostac
umieszczone to rozszerzenie, przy uzyciu wartosci
add_as.

add_as Suffix

Prefix
fix_punctuation flag

excluded_subcategories_descriptors

RollUpToParent
Ignore

Tylko w przypadku modeli kategorii. Jesli podkategoria
nie jest wybrana. Ta opcja umozliwia okreslenie, w jaki
sposob traktowane beda deskryptory nalezace do
podkategorii niewybranych do oceny. Dostgpne sa dwie
opcje.

* Ignore. Opcja Exclude its descriptors completely
from scoring powoduje, ze deskryptory
niezaznaczonych podkategorii beda ignorowane i nie
beda uzywane podczas oceniania.

* RollUpToParent. Opcja Aggregate descriptors with
those in parent category powoduje, ze deskryptory
niezaznaczonych podkategorii beda uzywane jako
deskryptory kategorii nadrzednej wobec tych
podkategorii. Jesli niezaznaczone sa kategorie na
kilku poziomach, deskryptory beda agregowane az do
pierwszej dostgpnej kategorii nadrzednej

check_model flag Nieaktualna w wersji 14

text field

method ReadText
ReadPath

docType integer Mozliwe wartosci to (0,1,2), gdzie 0 = petnotekstowe,

1 = tekst ustrukturyzowany, a 2 = XML

encoding Automatic Nalezy zwrdci¢ uwagg, ze wartosci ze znakami
"UTF-8" specjalnymi, takie jak "UTF-8", powinny by¢ ujete w
"UTF-16" cudzystow, aby znaki nie zostaty potraktowane jak
"ISO-8859-1" operatory matematyczne.
"US-ASCII"
"CP850"
"EUC-JP"
"SHIFT-JIS"
"ISO2022-JP"
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Tabela 11. Wiasciwosci modelu uzytkowego Text Mining (kontynuacja)

Wiasciwosci skryptow

Typ danych

Opis wlasciwosci

jezyk

de
en
es
fr
it
ja
nl
pt

Wezel Text Link Analysis: textlinkanalysis

Mozna uzy¢ parametréw z ponizszej tabeli, aby zdefiniowac lub zaktualizowaé wezet za pomoca skryptu. Sam wezet

nosi nazwe textlinkanalysis.

Wazne: Nie mozna okresli¢ szablonu zasobdw za posrednictwem skryptu. Aby wybra¢ szablon, nalezy zrobi¢ to w

oknie dialogowym wezta.

Tabela 12. Wiasciwosci wezta Text Link Analysis (TLA) uzywane w skryptach

Wiasciwosci skryptow Typ danych Opis wlasciwosci
id_field field
text field
method ReadText
ReadPath
docType integer Mozliwe wartosci to (0,1,2), gdzie 0 = petnotekstowe, 1
= tekst ustrukturyzowany, a 2 = XML
encoding Automatic Nalezy zwroci¢ uwage, ze wartosci ze znakami
"UTF-8" specjalnymi, takie jak "UTF-8", powinny by¢ ujete w
"UTF-16" cudzystow, aby znaki nie zostaly potraktowane jak
"1ISO-8859-1" operatory matematyczne.
"US-ASCII"
"CP850"
"EUC-JP"
"SHIFT-JIS"
"ISO2022-JP"
unity integer Mozliwe warto$ci to (0,1), gdzie 0 = tryb akapitow, a 1
= tryb dokumentéw
para_min integer
para_max integer
mtag string Zawiera wszystkie ustawienia mtag (z okna dialogowego
ustawien dla plikow XML)
mclef string Zawiera wszystkie ustawienia mclef (z okna dialogowego
ustawien dla plikéw tekstowych ustrukturyzowanych)
iezyk de
en
es
fr
it
ja
nl
pt
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Tabela 12. Wtasciwosci wezta Text Link Analysis (TLA) uzywane w skryptach (kontynuacja)

Wiasciwosci skryptow Typ danych Opis wlasciwosci

concept_count_limit integer Ogranicza wyodrebnianie do poje¢, ktorych globalna
liczebnos¢ rowna jest co najmniej tej wartosci.

fix_punctuation flag

fix_spelling flag

spelling_limit integer

extract_uniterm flag

extract_nonlinguistic flag

upper_case Slag

group_names Slag

permutation integer Maksymalna liczba permutacji wyrazu niefunkcyjnego

(domyslnie 3).

Rozdziat 6. Whasciwosci weztow uzywane w skryptach
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Rozdziat 7. Tryb pracy z interaktywnym pulpitem roboczym

Z poziomu wezta modelowania Text Mining mozna uruchomi¢ sesjg interaktywnego pulpitu roboczego w trakcie
wykonywania strumienia. Na tym pulpicie mozna wyodrgbnia¢ kluczowe pojecia z danych tekstowych, budowac
kategorie i eksplorowa¢ wzorce analizy powiazan w tekscie oraz skupienia, a takze generowac¢ modele kategorii. W
tym rozdziale omawiamy interfejs pulpitu roboczego z perspektywy wysokopoziomowej oraz przedstawiamy
najwazniejsze elementy, z ktorymi pracuja uzytkownicy, takie jak:

* Wyniki wyodrebniania. Po przeprowadzeniu wyodrgbniania sa to kluczowe wyrazy i frazy wyodrgbnione z danych
tekstowych, nazywane takze pojeciami. Pojgcia te sa pogrupowane w typy. Korzystajac z tych pojec i typow, mozna
eksplorowac dane i tworzy¢ kategorie. Elementami tymi zarzadza si¢ w widoku Categories and Concepts.

» Kategorie. Korzystajac z deskryptorow (takich jak wyniki wyodrebniania, wzorce i reguty) jako definicji, mozna
recznie lub automatycznie utworzy¢ zestaw kategorii, do ktorych beda przypisywane rekordy w zaleznosci od tego,
czy zawieraja czes¢ definicji kategorii, czy nie. Elementami tymi zarzadza si¢ w widoku Categories and Concepts.

* Skupienia. Skupienia sa to grupy poje¢, migdzy ktorymi wykryto powiazane $wiadczace o istnieniu relacji. Pojecia
sa grupowane przy uzyciu ztozonego algorytmu, ktory bierze pod uwage, miedzy innymi, jak czgsto dwa pojgcia
wystepuja razem, a jak czgsto wystepuja osobno. Elementami tymi zarzadza si¢ w widoku Clusters. Pojecia
tworzace skupienie mozna tez doda¢ do kategorii.

* Wzorce analizy powiazan w tekscie. Jesli zasoby lingwistyczne zawieraja reguly wzorcow powiazan w tekscie lub
probujesz uzywacé szablonu zasobow, ktdry zawiera juz jakies reguly TLA, mozesz wyodrgbnia¢ wzorce z danych
tekstowych. Wzorce te pomagaja w ujawnianiu interesujacych relacji miedzy pojeciami w danych. Mozna takze
uzy¢ ich jako deskryptorow w definicjach kategorii. Zarzadza si¢ nimi w widoku Text Link Analysis.

* Zasoby lingwistyczne. Proces wyodrebniania realizowany jest w oparciu o zestaw parametrdw i definicji
lingwistycznych, ktore rzadza sposobem wyodrgbniania poje¢ z tekstu. Tymi parametrami i definicjami zarzadza si¢
w ramach szablonéw i bibliotek w widoku Resource Editor.

Potencjalne problemy dotyczace interaktywnego pulpitu roboczego

* Wiele interaktywnych pulpitdw roboczych moze spowalnia¢ dziatanie programu. Podczas pracy z interaktywnym
pulpitem roboczym SPSS Modeler Text Analytics i SPSS Modeler wspétuzytkuja wspolny mechanizm srodowiska
wykonawczego Java. W zaleznos$ci od liczby otwartych interaktywnych pulpitow roboczych podczas sesji programu
SPSS Modeler pamig¢ systemowa moze spowalnia¢ dziatanie aplikacji, nawet w przypadku uruchamiania i
zamykania tej samej sesji. Efekt jest szczegolnie wyrazny gdy uzytkownik pracuje z duza iloscia danych lub gdy
komputer dysponuje mniejsza iloscia pamigeci RAM niz zalecane 4 GB. Jesli komputer wolno reaguje, zaleca si¢
zapisa¢ wszystkie zmiany, zamkna¢ program SPSS Modeler i ponownie uruchomi¢ aplikacjg. uruchamianie
produktu SPSS Modeler Text Analytics na komputerze z mniejsza ilo$cia pamigci niz zalecana, zwlaszcza podczas
pracy z duzymi zestawami danych lub przez dluzszy czas, moze spowodowac wyczerpanie zasobéw pamigciowych
srodowiska wykonawczego Java i wylaczenie systemu. W przypadku pracy z duza iloscia danych zdecydowanie
zaleca sig rozbudowe pamigci do zalecanego lub wyzszego poziomu (albo wykorzystanie produktuSPSS Modeler
Text Analytics Server).

* Klientowi programu SPSS Modeler moze zabrakna¢ pamigci w przypadku uruchomienia wielu interaktywnych
pulpitéw roboczych programu SPSS Modeler Text Analytics bez restartowania aplikacji. Nalezy monitorowaé
uzycie pamigci w wierszu statusu i, jesli jej poziom jest niski, zamkna¢ i ponownie otworzy¢ klienta programu SPSS
Modeler.

Widok Categories and Concepts

Interfejs aplikacji sktada sig z kilku roznych widokow. Widok Categories and Concepts to okno, w ktorym mozna
tworzy¢ i1 eksplorowac kategorie, a takze eksplorowac i optymalizowa¢ wyniki wyodrebniania. Kategorie sa to grupy
Scisle pokrewnych poje¢ i wzorcow, do ktérych dokumenty i rekordy sa przypisywane w procesie oceniania. Natomiast
pojecia sa to najbardziej podstawowe wyniki wyodrebniania, ktorych mozna uzywac jako deskryptoréw bedacych
elementami sktadowymi kategorii.
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Rysunek 23. Widok Categories and Concepts

Widok Categories and Concepts jest podzielony na cztery panele, a kazdy z nich mozna ukrywac lub uwidaczniac,
wybierajac jego nazwe z menu View. Wiecej informacji zawiera [Rozdziat 9, “Kategoryzacja danych tekstowych”, nal
“ tronie 91

Panel Categories

Ten znajdujacy si¢ w lewym gornym rogu obszar przedstawia tabeleg, w ktérej mozna zarzadzaé¢ wszystkimi
zbudowanymi kategoriami. Po zakonczeniu wyodrebniania pojec i typow z danych tekstowych mozna rozpoczac
automatyczne tworzenie kategorii za pomoca takich technik, jak sieci semantyczne, wlaczanie pojgc¢ itp., albo recznie.
Jesli klikniesz dwukrotnie nazwe kategorii, zostanie otwarte okno dialogowe Category Definitions z lista wszystkich
deskryptorow (takich jak pojecia, typy i reguly), ktore sktadaja si¢ na definicj¢ kategorii. Wigcej informacji zawiera
temat [Rozdziat 9, “Kategoryzacja danych tekstowych”, na stronie 91} Nie wszystkie techniki automatyczne sa dostepne
dla wszystkich jezykow.

Po wybraniu wiersza w panelu w panelach Data i Visualization mozna wyswietli¢ informacje na temat odpowiednich
dokumentéw/rekordow lub deskryptorow.

Panel Extraction Results

Ten obszar znajdujacy si¢ w lewym dolnym rogu przedstawia wyniki wyodrgbniania. Po uruchomieniu wyodrgbniania
mechanizm wyodregbniania odczytuje dane tekstowe, identyfikuje istotne pojgcia i przypisuje kazdemu z nich typ.
Pojecia to wyrazy lub frazy wyodrebnione z danych tekstowych. Typy sa semantycznymi zbiorami poje¢ zapisanymi w
stownikach typow. Po zakonczeniu wyodregbniania pojecia i typy wyswietlane sa w réznych kolorach na panelu
Extraction Results. Wigcej informacji zawiera |“Wyniki wyodrebniania: pojecia i typy” na stronie 79[
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Zestaw termindw bazowych danego pojecia mozna wyswietli¢, zatrzymujac wskaznik myszy nad nazwa pojecia.
Spowoduje to wyswietlenie podpowiedzi z nazwa pojecia i maksymalnie kilkoma wierszami terminow zgrupowanych
pod tym pojeciem. Do tych bazowych termindéw naleza synonimy zdefiniowane w zasobach lingwistycznych
(niezaleznie od tego, czy wystapily w tekscie, czy nie), a takze wszelkie wyodrgbnione terminy w liczbie
mnogiej/pojedynczej, permutacje terminow, terminy wygenerowane w wyniku grupowania rozmytego itd. Mozna
skopiowac te terminy bazowe, by wyswietli¢ ich kompletna listg. Nalezy w tym celu klikna¢ nazwg pojgcia prawym
przyciskiem myszy i wybra¢ opcj¢ z menu kontekstowego.

Eksploracja tekstu jest procesem iteracyjnym, w ktorym wyniki wyodrebniania sa przegladane z uwzglednieniem
kontekstu danych tekstowych, optymalizowane w celu wygenerowania nowych wynikéw i ponownie oceniane. Wyniki
wyodrebniania mozna optymalizowaé, modyfikujac zasoby lingwistyczne. T¢ optymalizacje mozna przeprowadzic¢
bezposrednio w panelu Extraction Results lub Data, ale takze bezposrednio w widoku Resource Editor. Wigcej
informacji zawiera temat [“Widok edytora zasobow” na stronie 73

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej wynikow, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czegsci panelu, aby przeglada¢ wyniki, lub wprowadzi¢ numer strony i przejs¢ do niej.

Panel Visualization

Ten obszar, ktory znajduje si¢ w prawym gornym rogu, z roznych perspektyw przedstawia wspdlne elementy
kategoryzacji dokumentdéw/rekordow. Kazdy wykres zawiera podobne informacje, ale zaprezentowane w inny sposob i
na innym poziomie szczegdtowosci. Wykresy umozliwiaja analizowanie wynikow kategoryzacji i pomagaja w
optymalizacji kategorii lub raportéw. Na przyktad na wykresie mozna wykry¢ kategorie zbyt podobne (na przyktad
majace wigcej niz 75% wspolnych dokumentéw lub rekordow) lub zbyt odmienne. Zawartos¢ wykresu odpowiada
wyborom dokonanym w innych panelach. Wigcej informacji zawiera temat|[“Wykresy i tabele kategorii” na stronie 145|

Panel Data

Panel Data znajduje si¢ w prawym dolnym rogu. Jest on tabela zawierajaca dokumenty lub rekordy odpowiadajace
elementom wybranym w innym obszarze widoku. W panelu Data widoczny jest tekst zalezny od tego, co wybrano. Po
dokonaniu wyboru kliknij przycisk Display, aby zapetni¢ panel Data odpowiednim tekstem.

Jesli w innym panelu dokonano wyboru, to w odpowiednich dokumentach lub rekordach pojgcia beda wyrdznione
kolorem, aby tatwiej byto je odszuka¢ w tekscie. Mozna takze zatrzymacé wskaznik myszy nad elementem oznaczonym
kolorem, aby wyswietli¢ podpowiedz z nazwa pojgcia, pod ktdérym dany termin zostal wyodregbniony, oraz typem, do
ktorego zostal przypisany. Wiecej informacji zawiera temat[‘Panel Data” na stronie 99|

Wyszukiwanie i znajdowanie w widoku Categories and Concepts

W niektorych przypadkach konieczne jest szybkie wyszukanie informacji w okreslonej sekcji. Za pomoca narzedzi
wyszukiwania mozna wprowadzi¢ tancuch do wyszukania i zdefiniowa¢ inne kryteria wyszukiwania, takie jak
rozroznianie wielkosci liter lub kierunek wyszukiwania. Nastgpnie mozna wybrac¢ panel, w ktorym ma by¢ prowadzone
wyszukiwanie.

Aby uzy¢ funkcji Find
1. W widoku Categories and Concepts wybierz z menu opcje Edit > Find. Nad panelem Categories i panelem
Visualization pojawi si¢ pasek narzedzi wyszukiwania.

2. W polu tekstowym wprowadz tancuch wyrazéw, ktory cheesz wyszukac. Za pomoca przyciskow na pasku narzedzi
mozna sterowa¢ uwzglednianiem wielkosci liter, dopasowywaniem czgsciowym i kierunkiem wyszukiwania.

3. W pasku narzedzi kliknij nazwe panelu, w ktéorym checesz wyszukiwaé. W przypadku znalezienia dopasowania
tekst w oknie zostanie podswietlony.

4. Aby wyszukac nastgpne dopasowanie, nalezy klikna¢ nazwe panelu ponownie.
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Widok Clusters

W widoku Clusters mozna budowac¢ i eksplorowac skupienia znalezione w danych tekstowych. Skupienia sa grupami
poje¢ wygenerowanymi przez algorytmy tworzenia skupien na podstawie tego, jak czgsto pojecia wystgpuja w tekscie i
jak czesto wystepuja razem. Skupienia stuza do grupowania poje¢ wspotwystepujacych, natomiast kategorie stuza do
grupowania dokumentow lub rekordéw na podstawie dopasowania zawartego w nich tekstu do deskryptorow (pojee,
regut, wzorcow) dla kazdej kategorii.

Skupienie tym lepiej ujawnia interesujace relacje migdzy pojgciami, im czgsciej pojecia w skupieniu wystepuja razem i
im rzadziej wystepuja z innymi pojeciami. Dwa pojecia wspolwystepuja, gdy oba (lub gdy ich synonimy lub terminy)
wystepuja tym samym dokumencie lub rekordzie. Wigcej informacji zawiera temat|Rozdziat 10, “Analiza skupien”, nal
ﬂtro ie 133

Mozesz budowac¢ skupienia i eksplorowac je na wykresach ulatwiajacych wykrywanie relacji migdzy pojeciami,
ktorych znalezienie bez pomocy skupien bytoby zbyt czasochtonne. Wprawdzie nie mozna dodawac¢ catych skupien do
kategorii, jednak mozna dodawac pojecia ze skupienia do kategorii, korzystajac z okna dialogowego Cluster
Definitions. Wigcej informacji zawiera temat [‘Definicje skupien” na stronie 137

Mozliwe jest wprowadzanie zmian w ustawieniach tworzenia skupien. Zmiany ustawien wptyna na wyniki. Wigcej
informacji zawiera temat[“Tworzenie skupien” na stronie 134|
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Rysunek 24. Widok Clusters

Widok Clusters jest podzielony na trzy panele, a kazdy z nich mozna ukrywa¢ lub uwidacznia¢, wybierajac jego nazwe
z menu View. Zwykle widoczny jest tylko panel Clusters i panel Visualization.
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Panel Clusters

Ten panel znajdujacy si¢ po lewej stronie, przedstawia skupienia ujawnione w danych tekstowych. Mozesz
wygenerowa¢ wyniki tworzenia skupien, klikajac przycisk Build. Algorytm tworzy skupienia, probujac zidentyfikowac
pojecia, ktore czgsto wystgpuja razem.

W trakcie nowego wyodrebniania wyniki tworzenia skupien sa kasowane i konieczne jest odbudowanie skupien w celu
uzyskania aktualnych wynikow. Mozna zmieni¢ pewne ustawienia budowania skupien, takie jak maksymalna liczba
skupien, maksymalna liczba poje¢ w skupieniu lub maksymalna liczba powiazan z pojgciami zewngtrznymi. Wigcej
informacji zawiera temat |“Eksplorowanie skupien” na stronie 136[

Panel Visualization

Ten panel znajduje si¢ w prawym gérnym rogu i udostgpnia dwa ujgcia skupien: wykres sieciowy pojec i wykres
sieciowy skupien. Jesli panel nie jest widoczny, mozna uzyskac¢ do niego dostep z menu View (View>Visualization).
W zaleznosci od wyboru dokonanego w panelu skupien mozna wyswietli¢ odpowiednie interakcje migdzy skupieniami
lub wewnatrz skupien. Wyniki sa prezentowane w wielu formatach:

* Concept Web. Ten wykres przedstawia wszystkie pojecia w wybranych skupieniach, a takze pojgcia powiazane
spoza skupienia.

* Cluster Web. Wykres sieciowy przedstawiajacy powiazania z wybranych skupien do innych skupien oraz
powiazania migdzy tymi innymi skupieniami.

Uwaga: Aby mozna bylo wyswietli¢ wykres sieciowy skupien, nalezy wczesniej stworzy¢ skupienia z powiazaniami
zewngetrznymi. Powiazania zewngtrzne sa to powiazania migdzy parami poje¢ w odrebnych skupieniach (jedno pojecie
w jednym skupieniu, a drugie pojecie w innym). Wiecej informacji zawiera temat[*Wykresy skupien” na stronie 147

Panel Data

Panel Data znajduje si¢ w prawym dolnym rogu i jest domyslnie ukryty. Nie mozna wyswietli¢ zadnych wynikdéw na
panelu Data z panelu Clusters, poniewaz skupienia obejmuja wiele dokumentdéw/rekordow, przez co dane nie niosa
zadnych interesujacych informacji. Mozna jednak wyswietli¢ dane odpowiadajace dokonanemu wyborowi, korzystajac
z okna dialogowego Cluster Definitions. W panelu Data widoczny jest tekst zalezny od tego, co wybrano w tym oknie
dialogowym. Po dokonaniu wyboru kliknij przycisk Display &, aby wypetni¢ panel Data dokumentami lub aktami
zawierajacymi facznie wszystkie pojecia.

W odpowiednich dokumentach lub rekordach pojgcia beda wyroznione kolorem, aby tatwiej byto je odszukaé w
teks$cie. Mozna takze zatrzymac wskaznik myszy nad elementem oznaczonym kolorem, aby wyswietli¢ nazwe pojecia,
pod ktoérym dany termin zostal wyodrebniony, oraz typ, do ktérego zostat przypisany. Panel Data moze zawierac¢ wiele
kolumn, ale kolumna zmiennej tekstowej jest zawsze widoczna. Ma nazwe taka sama, jak zmienna tekstowa uzyta
podczas wyodrgbniania, albo jak nazwa dokumentu, jesli dane tekstowe znajduja si¢ w wielu réznych plikach.
Dostepne sa takze inne kolumny. Wigcej informacji zawiera temat [‘Panel Data” na stronie 99|

Widok Text Link Analysis

W widoku Text Link Analysis mozna budowac¢ i eksplorowa¢ wzorce analizy powiazan w tek$cie znalezione w danych
tekstowych. Analiza powiazan w teksécie (TLA) jest to technika dopasowywania wzorcéw, ktora umozliwia
definiowanie regutl i pordwnywanie ich z faktycznie wyodregbnionymi pojeciami i relacjami wystepujacymi w tekscie.

Wzorce sa najbardziej uzyteczne wtedy, gdy probujemy poznac relacje migdzy pojgciami lub opinie na okreslony
temat. Do niektorych zastosowan tej techniki nalezy wyodrgbnianie opinii o produkcie z danych ankietowych,
wyszukiwanie relacji migdzy genami w artykutach naukowych z dziedziny medycyny lub ujawnianie relacji migdzy
osobami i miejscami zawartych w informacjach wywiadowczych.

Po wyodrebnieniu wzorcéw TLA mozna przegladac je w panelach Data lub Visualization, a nawet dodawac je do
kategorii w widoku Categories and Concepts. Aby mozliwe byto wyodrebnienie wynikéw TLA, w uzywanym
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szablonie zasobow lub w uzywanych bibliotekach, musza by¢ zdefiniowane reguty wzorcow TLA. Wigcej informacji
zawiera [Rozdziat 18, “Informacije o regulach powiazan w tekscie”, na stronie 197]

W tym widoku prezentowane sa wyniki wyodrgbniania wzorcéw TLA. Jesli nie przeprowadzono jeszcze
wyodrgbniania, nalezy uzy¢ przycisku Extract i wybra¢ opcj¢ wlaczenia wyodrgbniania wzorcow .
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Rysunek 25. Widok Text Link Analysis

Widok Text Link Analysis jest podzielony na cztery panele, a kazdy z nich mozna ukrywac¢ lub uwidacznia¢,
wybierajac jego nazwe z menu View. Wiecej informacji zawiera[Rozdziat 11, “Eksplorowanie analizy powiazan w
tekscie”, na stronie 139}

Panele Type Patterns i Concept Patterns

Po lewej stronie panele Type Patterns i Concept Patterns to dwa polaczone panele, w ktérych mozna eksplorowac i
wybiera¢ wyniki wzorca TLA. Wzorce skladaja si¢ z szeregdw do szesciu typow lub szesciu pojgc. Reguta wzorca
TLA zdefiniowana w zasobach lingwistycznych dyktuje stopien skomplikowania wynikéw wzorca. Wigcej informacji
zawiera temat|Rozdziat 18, “Informacje o regutach powiazan w tekécie”, na stronie 197}

Wyniki wzorca sa najpierw grupowane na poziomie typu, a nastgpnie dzielone na wzorce pojec. Z tego powodu istnieja

dwa rozne panele wynikow: Type Patterns (po lewej stronie na gorze) i Concept Patterns (po lewej stronie na dole).

* Type Patterns. Panel Type Patterns przedstawia wyodrebnione wzorce sktadajace si¢ z dwdch lub wigkszej liczby
powiazanych typow odpowiadajacych regule wzorca TLA. Wzorce typu sa przedstawione jako <Organization> +
<Location> + <Positive>, co moze zapewnia¢ pozytywna opini¢ o organizacji w okreslonej lokalizacji.
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* Concept Patterns. Panel Concept Patterns prezentuje wyodregbnione wzorce na poziomie pojec¢ dla wszystkich
wzorcéw wybranych w tym momencie w znajdujacym si¢ wyzej panelu Type Patterns. Wzorce poje¢ maja strukture,
taka jak np. hotel + paris + wonderful.

Tak jak w przypadku wynikéw wyodrgbniania w widoku Categories and Concepts mozesz tu przejrze¢ wyniki. Jesli
chcesz doprecyzowac typy i pojecia, z ktorych sktadaja sig te wzorce, mozna to zrobi¢ w panelu Extraction Results
widoku Categories and Concepts lub bezposrednio w narzedziu Resource Editor, a nastgpnie wyodrebni¢ ponownie
wzorce.

Panel Visualization

Ten panel znajduje si¢ w prawym gornym rogu widoku Text Link Analysis i prezentuje wykres sieciowy wybranych
wzorcow jako wzorce typu lub wzorce pojeé. Jesli panel nie jest widoczny, mozna uzyskaé do niego dostgp z menu
View (View > Visualization). W zaleznosci od tego, co wybrano w innych panelach, mozna wyswietli¢ powiazane
interakcje migdzy dokumentami/rekordami i wzorcami.

Wyniki sg prezentowane w wielu formatach:

* Concept Graph. Ten wykres przedstawia wszystkie pojgcia w wybranych wzorcach. Szerokos¢ linii 1 wielkosci
wezlow (jesli nie sa pokazane ikony typu) na wykresie poje¢ przedstawia liczbg globalnych wystapien w wybrane;j
tabeli.

* Type Graph. Ten wykres przedstawia wszystkie typy w wybranych wzorcach. Szerokos¢ linii i wielko$ci weztow
(jesli nie sa pokazane ikony typu) na wykresie przedstawia liczbg globalnych wystapien w wybranej tabeli. Wezty sa
przedstawiane w okreslonym kolorze lub w formie ikony.

Wigcej informacji zawiera temat[“Wykresy analizy powiazan w tekécie” na stronie 148}

Panel Data

Panel Data znajduje si¢ w prawym dolnym rogu. Jest on tabela zawierajaca dokumenty lub rekordy odpowiadajace
elementom wybranym w innym obszarze widoku. W panelu Data widoczny jest tekst zalezny od tego, co wybrano. Po
dokonaniu wyboru kliknij przycisk Display, aby zapetni¢ panel Data odpowiednim tekstem.

Jesli w innym panelu dokonano wyboru, to w odpowiednich dokumentach lub rekordach pojgcia bgda wyrdznione
kolorem, aby tatwiej byto je odszuka¢ w tekscie. Mozna takze zatrzymac wskaznik myszy nad elementem oznaczonym
kolorem, aby wyswietli¢ podpowiedz z nazwa pojgcia, pod ktérym dany termin zostal wyodregbniony, oraz typem, do
ktorego zostal przypisany. Wiecej informacji zawiera temat[“Panel Data” na stronie 99|

Widok edytora zasobow

IBM SPSS Modeler Text Analytics szybko i doktadnie wyodrgbnia kluczowe pojecia z danych tekstowych, korzystajac
z elastycznego mechanizmu wyodrebniania. Dziatanie tego mechanizmu w duzej mierze zalezy od zasobow
lingwistycznych, ktore steruja analiza i interpretacja obszernych nieustrukturyzowanych danych tekstowych.

Widok Resource Editor stanowi srodowisko przegladania i optymalizacji zasobow lingwistycznych shuzacych do
wydobywania poje¢, grupowania ich w typy, wykrywania wzorcow w danych tekstowych i realizacji wielu innych
zadan. IBM SPSS Modeler Text Analytics oferuje kilka wstepnie skonfigurowanych szablondéw zrédlowych. Ponadto
w przypadku niektorych jezykéw mozna korzystaé z zasobéw w pakietach analizy tekstu. Wigcej informacji zawiera
temat [*Korzystanie z pakietow analizy tekstu (TAP)” na stronie 127

Poniewaz zasoby te nie zawsze sa idealnie dopasowane do kontekstu danych, uzytkownik moze w oknie Resource
Editor tworzy¢ i edytowac¢ wlasne zasoby wiasciwe dla konkretnego kontekstu lub domeny, a takze zarzadza¢ tymi
zasobami. Wigcej informacji zawiera[Rozdziat 15, “Praca z bibliotekami”, na stronie 163]

Aby uprosci¢ proces optymalizacji zasobow lingwistycznych, mozna wykonywac typowe zadania stownikowe
bezposrednio z widoku Categories and Concepts, korzystajac z menu kontekstowych w panelach Extraction Results i
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Data. Wigcej informacji zawiera temat |“Optymalizacj a wynikéw wyodrgbniania” na stronie 86I
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Rysunek 26. Widok Resource Editor

Operacje wykonywane przez uzytkownikow w widoku Resource Editor zwiazane sa z zarzadzaniem i optymalizacja
zasobow lingwistycznych. Zasoby te sa przechowywane w postaci szablondw i bibliotek. Widok Resource Editor jest
podzielony na cztery czg$ci: panel drzewa bibliotek (Library Tree), panel stownika typow (Type Dictionary), panel

stownika zastapien (Substitution Dictionary) i panel stownika wykluczen (Exclude Dictionary).

Uwaga: Wiccej informacji zawiera temat[“Interfejs edytora” na stronie 156

Okreslanie opciji

Ogolne opcje programu IBM SPSS Modeler Text Analytics mozna ustawi¢ w oknie dialogowym Options. To okno

dialogowe zawiera nastgpujace karty:
* Session. Ta karta zawiera ogdlne opcje i separatory.
* Display. Ta karta zawiera opcje kolorow uzywanych w interfejsie.

* Sounds. Ta karta zawiera opcje dotyczace sygnatow dzwigkowych.

Aby edytowac opcje
1. Z menu wybierz opcje Tools > Options. Zostanie otwarte okno dialogowe Options.
2. Wybierz karte zawierajaca informacje, ktore chcesz zmienic.

3. Zmien dowolne opcje.
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4. Kliknij przycisk OK, aby zapisa¢ zmiany.

Okno dialogowe Options: karta Session

Na tej karcie mozna wybra¢ niektore ustawienia podstawowe.

Data Pane and Category Graph Display. Ta opcja wptywa na sposob prezentacji danych w panelu Data oraz w
panelu Visualization w ramach widoku Categories and Concepts.

* Display limit for Data pane and Category Web. Ta opcja okresla maksymalna liczbg dokumentow, jaka ma by¢
wyswietlana w panelu Data oraz na wykresach i diagramach w widoku Categories and Concepts.

* Show categories for documents/records at Display time. Gdy ta opcja jest wybrana, dokumenty lub rekordy sa
oceniane po kazdym kliknigciu przycisku Display, zatem wszelkie kategorie, do ktdrych one naleza, moga by¢
wyswietlone w kolumnie Categories panelu Data oraz na wykresach kategorii. W niektorych przypadkach,
zwlaszcza gdy zbidr danych jest obszerny, celowe moze by¢ wyltaczenie tej opcji w celu istotnego przyspieszenia
wyswietlania danych i wykresow.

Add to Category from Data Pane. Ta opcja wptywa na to, jakie elementy beda dodawane do kategorii podczas
dodawania dokumentow i rekordéw z panelu Data.

* In Categories and Concepts view, copy. Dodanie dokumentu lub rekordu z panelu Data w tym widoku spowoduje
skopiowanie albo tylko pojg¢ (Concepts only), abo zaréwno pojg¢, jak i wzorcow (Concepts and Patterns).

* In Text Link Analysis view, copy. Dodanie dokumentu lub rekordu z panelu Data w tym widoku spowoduje
skopiowanie albo tylko wzorcow (Patterns only), abo zaroéwno pojg¢, jak i wzorcow (Concepts and Patterns).

Resource Editor delimiter. Wybierz znak, jaki ma by¢ uzywany w charakterze ogranicznika (separatora) przy
wprowadzaniu takich elementéw, jak pojecia, synonimy i elementy opcjonalne, w widoku Resource Editor.

Okno dialogowe Options: karta Display

Na tej karcie mozna edytowac opcje wptywajace na ogolny wyglad i zachowanie aplikacji oraz kolory uzywane do
rozrdznienia elementow.

Uwaga: Aby przelaczy¢ produkt na wyglad klasyczny lub wyglad jednej z wczesniejszych wersji, otworz okno
dialogowe Opcje uzytkownika z menu Narzedzia gtoéwnego okna programu IBM SPSS Modeler.

Custom Colors. Edytuj kolory elementow wyswietlanych na ekranie. Dla kazdego z elementow w tabeli mozna
zmieni¢ kolor. Aby okresli¢ kolor niestandardowy, kliknij obszar koloru na prawo od elementu, ktory chcesz zmienic, a
nastgpnie wybierz kolor z listy rozwijane;.

* Non-extracted text. Dane tekstowe, ktore nie zostaly wyodrgbnione, ale sa widoczne w panelu Data.

» Highlight background. Kolor tta zaznaczenia podczas wybierania elementow w panelach lub zaznaczania tekstu w
panelu Data.

* Extraction needed background. Kolor tta, ktory w panelach Extraction Results, Patterns i Clusters sygnalizuje
dokonanie zmian w bibliotekach i potrzebg przeprowadzenia wyodrebniania.

* Category feedback background. Kolor tta kategorii, ktore pojawia si¢ po operacji.

* Default type. Domyslny kolor dla typow i poje¢ wyswietlanych w panelu Data i panelu Extraction Results. Ten
kolor zostanie zastosowany do wszystkich typow niestandardowych utworzonych w edytorze Resource Editor.
Mozna zmieni¢ ten kolor domyslny dla danego stownika typu uzytkownika, edytujac wlasciwosci tego stownika
typoéw w edytorze Resource Editor. Wigcej informacji zawiera temat|[“Tworzenie typow” na stronie 175|

 Striped table 1. Pierwszy z dwoch koloréw uzywanych na zmiang w tabeli w oknie dialogowym Edit Forced
concepts w celu odrdznienia zestawow wierszy.

* Striped table 2. Drugi z dwoch koloréw uzywanych na zmiang w tabeli w oknie dialogowym Edit Forced concepts
w celu odroznienia zestawOw wierszy.

Uwaga: Jesli klikniesz przycisk Reset to Defaults wszystkie opcje w oknie dialogowym zostana przywrocone do stanu
z chwili instalacji produktu.
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Okno dialogowe Options: karta Sounds

Na tej karcie mozna edytowac opcje wplywajace na dzwigki. W obszarze Sound Events mozna okresli¢ dzwigki, ktore
maja by¢ uzywane do powiadamiania o zdarzeniach. Dostepnych jest szereg roznych dzwigkow. Uzyj przyciskow z
wielokropkiem (...), aby wyszuka¢ i wybra¢ dzwigk. Pliki .wav z dzwigkami dla programu IBM SPSS Modeler Text
Analytics sa przechowywane w podkatalogu media w katalogu instalacyjnym. Jesli chcesz zrezygnowac z wszelkich
dzwigkdw, wybierz opcje Mute All Sounds. Dzwigki sa wyciszone domyslnie.

Uwaga: Jesli klikniesz przycisk Reset to Defaults wszystkie opcje w oknie dialogowym zostana przywrdocone do stanu
z chwili instalacji produktu.

Ustawienia pomocy w programie Microsoft Internet Explorer
Ustawienia programu Microsoft Internet Explorer

Wigkszo$¢ funkcji pomocy tej aplikacji dziata w oparciu o przegladarke Microsoft Internet Explorer. Niektore wersje
przegladarki Internet Explorer (w tym wersja dostarczona z systemem Microsoft Windows XP z dodatkiem Service
Pack 2) domyslnie blokuja ,,zawarto$¢ aktywna” w oknach przegladarki na komputerze lokalnym. Ustawienie
domyslne moze powodowac blokowanie niektorych tresci pomocy. Aby cata tres¢ pomocy byta dostgpna, mozna
zmieni¢ domyslne ustawienie w programie Internet Explorer.

1. Z menu programu Internet Explorer wybierz:
Narzedzia > Opcje internetowe...
2. Kliknij karte¢ Zaawansowane.
3. Przewin do sekcji Zabezpieczenia.
4. Zaznacz opcjg Zezwalaj zawartoSci aktywnej na dzialanie w plikach na moim komputerze.

Generowanie modeli uzytkowych i weztéw modelowania

W sesji interaktywnej mozesz wykorzysta¢ efekty dotychczasowej pracy do wygenerowania:

* Wezla modelowania eksploracji tekstu. We¢zet modelowania wygenerowany z interaktywnego pulpitu roboczego
to wezet Text Mining, ktorego ustawienia i opcje beda odzwierciedla¢ ustawienia i opcje zachowane w otwartej sesji
interaktywnej. Moze by¢ przydatny, gdy nie masz juz pierwotnego wezla Text Mining lub gdy cheesz utworzy¢
nowa wersje. Wiecej informacji zawiera [Rozdziat 3, “Eksploracja w poszukiwaniu pojeé i kategorii”, na stronie 19|

* Model uzytkowy kategorii. Model uzytkowy wygenerowany z interaktywnego pulpitu roboczego jest modelem
uzytkowym kategorii. Aby moc wygenerowaé model uzytkowy kategorii, musisz mie¢ co najmniej jedna kategorig
w widoku Categories and Concepts. Wigcej informacji zawiera temat [‘Model uzytkowy Text Mining: model|
[kategorii” na stronie 39|

Aby wygenerowac wezet modelowania eksploracja tekstu

1. Z menu wybierz opcje Generate > Generate Modeling Node. Wezel modelowania Text Mining zostanie dodany
do obszaru roboczego ze wszystkimi ustawieniami wybranymi obecnie w sesji interaktywnej. Nazwa wezta
zostanie utworzona na podstawie nazwy zmiennej tekstowe;j.

Aby wygenerowac¢ model uzytkowy kategorii

1. Z menu wybierz opcje Generate > Generate Model. Model uzytkowy generowany jest bezposrednio na palecie
Model z nazwa domyslna

Aktualizowanie weziéw modelowania i zapisywanie

Zaleca sig, aby podczas pracy w sesji interaktywnej od czasu do czasu aktualizowa¢ wezet modelowania w celu
zapisania zmian. We¢zet modelowania nalezy rdwniez aktualizowac po zakonczeniu pracy w sesji interaktywnej, by
zapisa¢ wyniki pracy. Aktualizacja wezta modelowania powoduje zapisanie zawartosci sesji interaktywnej w wezle
Text Mining, z ktorego ta sesja zostata uruchomiona. Nie powoduje to zamknigcia okna wynikow.
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Wazne! Ta aktualizacja nie powoduje zapisania strumienia. Chcac zapisa¢ strumien, nalezy zrobi¢ to w oknie gldéwnym
IBM SPSS Modeler po zmianie wezta modelowania.

Aby zaktualizowac¢ wezetl modelowania

1. Z menu wybierz opcje File > Update Modeling Node. Wezet modelowania zostanie zaktualizowany z
uwzglednieniem ustawien tworzenia i wyodrgbniania oraz opcji i kategorii uzytkownika.

Zamykanie i koiczenie sesji

Po zakonczeniu pracy w danej sesji mozna ja opusci¢ na trzy rozne sposoby:

» Save. Ta opcja pozwala najpierw zapisaé¢ efekty pracy z powrotem do macierzystego wezta modelowania na
potrzeby przysztych sesji, a takze opublikowac biblioteki do ponownego wykorzystania w innych sesjach. Wigcej
informacji zawiera temat [*Wspotuzytkowanie bibliotek” na stronie 170] Po zapisaniu okno sesji zostanie zamknicte,
a sesja zostanie usunigta z menedzera wynikow w oknie IBM SPSS Modeler.

» Exit. Ta opcja spowoduje odrzucenie wszystkich niezapisanych zmian, zamknigcie okna sesji i usunigcie sesji z
menedzera wynikow w oknie IBM SPSS Modeler. Aby zwolni¢ pamig¢, zaleca si¢ zapisywanie wszystkich istotnych
prac i zamykanie sesji.

* Close. Ta opcja nie spowoduje zapisania ani odrzucenia efektow pracy. Zamyka okno sesji, ale sesja bedzie nadal
dziata¢. Mozna otworzy¢ okno sesji ponownie, wybierajac t¢ sesj¢ w menedzerze wynikéw w oknie IBM SPSS
Modeler.

Aby zamkna¢ sesje pulpitu roboczego

1. Z menu wybierz opcje File > Close.

Utatwienia dostepu z uzyciem klawiatury

Interfejs interaktywnego pulpitu roboczego udostepnia skroty klawiaturowe, ktore utatwiaja dostep do funkcji
produktu. Na najbardziej podstawowym poziomie klawisz Alt w potaczeniu z innymi klawiszami (np. kombinacja
Alt+F rozwija menu Plik) stuzy do aktywacji menu poszczegdlnych okien, natomiast klawisz Tab do przechodzenia do
kolejnych elementéw sterujacych w oknie dialogowym. W tej sekcji przedstawiono podstawowe skroty klawiaturowe
stanowiace alternatywna formg nawigacji. W interfejsie programu IBM SPSS Modeler dostgpne sa takze inne skroty
klawiaturowe.

Tabela 13. Ogdlne skroty klawiaturowe

Klawisz skrétu Funkcja

Ctrl+1 Wyswietlenie pierwszej karty na panelu podzielonym na karty.

Ctrl+2 Wyswietlenie drugiej karty na panelu podzielonym na karty.

Ctrl+A Zaznaczenie wszystkich elementéw w aktywnym panelu.

Ctrl+C Skopiowanie zaznaczonego tekstu do schowka.

Ctrl+E Rozpoczgcie wyodrgbniania w widokach Categories and Concepts oraz Text Link Analysis.
Ctrl+F Wyswietlenie paska narzedzi Find w oknie Resource Editor/Template Editor, jesli nie jest jeszcze

widoczny, 1 uaktywnienie go.

Ctrl+I W widoku Categories and Concepts uruchomienie okna dialogowego Category Definitions dla wybranej
kategorii. W widoku Cluster uruchomienie okna dialogowego Cluster Definitions dla wybranej kategorii.

Ctrl+R Otwarcie okna dialogowego Add Terms w oknie Resource Editor/Template Editor.

Ctrl+T Otwarcie okna dialogowego Type Properties w celu utworzenia nowego typu w oknie Resource
Editor/Template Editor.

Ctrl+V Wklejenie zawartosci schowka.
Ctrl+X Wycigcie zaznaczonych elementoéw z okna Resource Editor/Template Editor.
Ctrl+Y Powtdrzenie ostatniej czynnosci w widoku.
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Tabela 13. Ogdlne skroty klawiaturowe (kontynuacja)

Klawisz skrotu

Funkcja

Ctrl+Z Cofhnigcie ostatniej czynnosci w widoku.

F1 Wyswietlenie pomocy, a w oknie dialogowym — wyswietlenie pomocy kontekstowej do elementu.
F2 Wiaczanie/wylaczanie trybu edycji komorek tabeli.

F6 Przenoszenie aktywnos$ci miedzy gtdéwnymi panelami w aktywnym widoku.

F8 Przeniesienie aktywnosci do paskow dzielacych panele w celu umozliwienia zmiany rozmiaru.

F10 Rozwinigcie glownego menu Plik.

strzatka w gore, strzatka
w dot

Zmiana rozmiaru panelu w pionie po wybraniu paska dzielacego.

strzatka w lewo, strzatka
W prawo

Zmiana rozmiaru panelu w poziomie po wybraniu paska dzielacego.

Home, End Maksymalne pomniejszenie lub powigkszenie panelu po wybraniu paska dzielacego.
Tabulator Przechodzenie naprzod pomigdzy elementami w oknie, panelu lub oknie dialogowym.
Shift+F10 Wyswietlenie menu kontekstowego elementu.

Shift+Tab Przechodzenie wstecz pomigdzy elementami w oknie lub oknie dialogowym.
Shift+strzatka Zaznaczanie znakow w polu edycji w trybie edycji (F2).

Ctrl+Tab Przeniesienie aktywnosci do nastgpnego gtdéwnego obszaru w oknie.

Shift+Ctrl+Tab Przeniesienie aktywnosci do poprzedniego gtownego obszaru w oknie.

Skroty w oknach dialogowych

Dostepnych jest kilka skrotow klawiaturowych i klawiszy lektora ekranowego przydatnych podczas korzystania z
okien dialogowych. Po wejsciu do okna dialogowego konieczne moze by¢ nacisnigcie klawisza Tab w celu ustawienia
aktywnosci na pierwszym elemencie sterujacym i zainicjowaniu lektora ekranowego. Petna lista specjalnych skrotow
klawiaturowych i skrotow do obstugi lektora ekranowego znajduje si¢ w ponizszej tabeli.

Tabela 14. Skroty w oknach dialogowych

Klawisz skrotu

Funkcja

Tabulator Przechodzenie naprzod pomigdzy elementami w oknie lub oknie dialogowym.

Ctrl+Tab Przejscie naprzod z pola tekstowego do nastgpnego elementu.

Shift+Tab Przechodzenie wstecz pomigdzy elementami w oknie lub oknie dialogowym.

Shift+Ctrl+Tab Przejscie wstecz z pola tekstowego do poprzedniego elementu.

spacja Wybor aktywnego elementu sterujacego lub przycisku.

Esc Anulowanie zmian i zamknigcie okna dialogowego.

Wprowadzanie Zatwierdzenie zmian i zamknigcie okna dialogowego (rdwnowazne nacisnigciu przycisku OK). Jesli
aktywne jest pole tekstowe, nalezy najpierw nacisna¢ kombinacjg klawiszy Ctrl+Tab, aby z niego wyjsc¢.
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Rozdziat 8. Wyodrebnianie pojec i typow

Po kazdym uruchomieniu strumienia, ktory otwiera interaktywny pulpit roboczy, przeprowadzane jest automatycznie
wyodrgbnianie z danych tekstowych w strumieniu. Wynikiem tego wyodrebniania jest zbior pojec, typdw oraz — jesli
zasoby lingwistyczne obejmuja wzorce TLA — takze wynikowe wzorce. Mozna wyswietla¢ pojecia i typy oraz
Elracowaé z nimi w panelu Extraction Results. Wiecej informacji zawiera temat|“Jak dziata wyodrebnianie” na stronie|

Jesli cheesz zoptymalizowaé wyniki wyodrebniania, mozesz zmodyfikowaé zasoby lingwistyczne i ponowic
wyodrebnianie. Wigcej informacji zawiera temat |“Optyma1izacja wynikdw wyodrebniania” na stronie 86l Proces
wyodregbniania przebiega w oparciu o zasoby oraz parametry okreslone w oknie dialogowym Extract. To one dyktuja
sposob wyodrebniania i organizacji wynikéw. Wyniki wyodrgbniania mozna wykorzysta¢ do zdefiniowania
wigkszosci, a nawet wszystkich definicji kategorii.

Wyniki wyodrebniania: pojecia i typy

W trakcie wyodrebniania cale dane tekstowe sa przegladane, a istotne pojgcia sa rozpoznawane, wyodrebniane i
przypisywane do typow. Po zakonczeniu wyodrgbniania wyniki tego procesu pojawiaja si¢ na panelu Extraction
Results, ktory znajduje sig¢ w lewym dolnym rogu widoku Categories and Concepts. Po pierwszym uruchomieniu sesji
szablon zasobu lingwistycznego wybranego w wezle uzywany jest do wyodregbnienia i zorganizowania tych poje¢ i
typow.

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej wynikow, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czgSci panelu, aby przeglada¢ wyniki, lub wprowadzi¢ numer strony i przejs¢ do niej.

Wyodrebnione pojgcia, typy i wzorce TLA sa tacznie nazywane wynikami wyodrebniania i pelnia rolg deskryptorow
lub elementéw sktadowych kategorii. Pojec¢, typdw 1 wzorcoéw mozna tez uzywacé w regulach kategorii. Ponadto
techniki automatyczne korzystaja z poje¢ i typdw przy konstruowaniu kategorii.

Eksploracja tekstu jest procesem iteracyjnym, w ktorym wyniki wyodrebniania sa przegladane z uwzglednieniem
kontekstu danych tekstowych, optymalizowane w celu wygenerowania nowych wynikow i ponownie oceniane. Po
przeprowadzeniu wyodrgbniania nalezy przejrze¢ wyniki i wprowadzi¢ niezbedne zmiany poprzez zmodyfikowanie
zasobow lingwistycznych. Zasoby mozna po czgsci optymalizowa¢ bezposrednio w panelu Extraction Results, panelu
Data, oknie dialogowym Category Definitions oraz oknie dialogowym Cluster Definitions. Wigcej informacji zawiera
temat [‘Optymalizacja wynikow wyodrebniania” na stronie 86| Mozna takze robi¢ to bezposrednio w widoku Resource
Editor. Wigcej informacji zawiera temat[“Widok edytora zasobéw” na stronie 73|

Po optymalizacji mozna powtdrzy¢ wyodrebnianie, aby zobaczy¢ nowe wyniki. Optymalizacja wynikoéw
wyodrebniania od samego poczatku gwarantuje, ze przy kazdym ponownym wyodrebnieniu uzyska si¢ identyczne
wynikowe definicje kategorii — idealnie dopasowane do kontekstu danych. W ten sposdb dokumenty/rekordy zostana
przypisane do definicji kategorii w sposob bardziej doktadny i powtarzalny.

Pojecia

W procesie wyodrebniania dane tekstowe sa przegladane i analizowane w celu wykrycia w tek$cie interesujacych lub
istotnych pojedynczych stow (takich jak wybory lub pokdj) i fraz wielowyrazowych (takich jak wybory
prezydenckie, wybory prezydenta lub traktaty pokojowe). Te stowa i frazy sa zbiorczo okreslane jako terminy. Na
podstawie zasobdw lingwistycznych istotne terminy sa wyodrebniane, a nastgpnie podobne terminy sa grupowane pod
jednym terminem wiodacym, ktory nazywamy pojeciem.

Zestaw termindw bazowych danego pojecia mozna wyswietli¢, zatrzymujac wskaznik myszy nad nazwa pojgcia.
Spowoduje to wyswietlenie podpowiedzi z nazwa pojgcia i maksymalnie kilkoma wierszami terminéw zgrupowanych
pod tym pojeciem. Do tych bazowych termindw naleza synonimy zdefiniowane w zasobach lingwistycznych

79



(niezaleznie od tego, czy wystapily w tekscie, czy nie), a takze wszelkie wyodrebnione terminy w liczbie
mnogiej/pojedynczej, permutacje terminow, terminy wygenerowane w wyniku grupowania rozmytego itd. Mozna
skopiowac¢ te terminy bazowe, by wyswietli¢ ich kompletna listg. Nalezy w tym celu klikna¢ nazweg pojgcia prawym
przyciskiem myszy i wybra¢ opcj¢ z menu kontekstowego.

Domyslnie pojgcia sa zapisane malymi literami i posortowane malejaco wedhug liczby wystapien w dokumentach
(kolumna Doc. ) . Kazdemu wyodregbnionemu pojgciu przypisywany jest typ. Typy pomagaja w grupowaniu
podobnych poje¢. Pojecia sa oznaczone kolorami zgodnie ze swoimi typami. Kolory definiuje si¢ we wlasciwosciach
typu w oknie Resource Editor. Wigcej informacji zawiera temat [*Stowniki typow” na stronie 173|

Gdy jakies pojecie, typ lub wzorzec uzywany jest w definicji kategorii, w dajacej si¢ sortowaé¢ kolumnie In widoczna
jest ikona .

Typy

Typy grupuja pojecia pod wzgledem semantycznym. Kazdemu wyodrebnionemu pojeciu przypisywany jest typ. Typy
pomagaja w grupowaniu podobnych pojeé. W produkcie IBM SPSS Modeler Text Analytics dostgpnych jest od razu
kilka gotowych typow, takich jak <Location> (miejsce), <Organization> (organizacja), <Person> (osoba),
<Positive> (pozytywne), <Negative> (negatywne) itd. Na przyktad typ <Location> grupuje stowa kluczowe
zwiazane z potozeniem geograficznym i okreslajace miejsca. Ten typ bytby przypisywany do takich pojec, jak
warszawa, londyn i tokio. W wiekszosci jezykow pojecia nieznalezione w zadnym stowniku typu, ale wyodrebnione
z tekstu otrzymuja automatycznie przypisywany typ <Unknown>Wigcej informacji zawiera temat[“Typy wbudowane™]|
i

W widoku Type wyodrebnione typy sa domyslnie wyswietlane w kolejnosci malejacej wedtug czgstotliwosci globalne;j.
Typy sa oznaczone réznymi kolorami, aby bylo je tatwiej rozrézniaé. Kolory sa zapisane we wlasciwosciach typu.
Wigcej informacji zawiera temat[“Tworzenie typéw” na stronie 175| Mozna takze tworzy¢ whasne typy.

Wzorce

Z danych tekstowych moga by¢ takze wyodrebniane wzorce. Jednak jest do tego potrzebna (w oknie Resource Editor)
biblioteka zawierajaca reguly analizy powiazan w tekscie (TLA — Text Link Analysis (TLA). Nalezy takze wybrac¢
opcje wyodrgbniania wzorcow w ustawieniach wezta IBM SPSS Modeler Text Analytics lub w oknie dialogowym
Extract za pomoca opcji Enable Text Link Analysis pattern extraction. Wigcej informacji zawiera
[‘Eksplorowanie analizy powiazan w tekécie”, na stronie 139|

Wyodrebnianie danych

Kiedy wymagane jest wyodregbnianie, panel Extraction Results staje si¢ zolty i ponizej paska narzedzi w tym panelu
pojawia si¢ komunikat Press Extract Button to Extract Concepts.

wyodrgbnianie moze by¢ konieczne, jesli nie ma jeszcze wynikéw wyodrebniania, wprowadzono zmiany do zasobow
lingwistycznych i wymagana jest aktualizacja wynikéw wyodrgbniania lub otwarto ponownie sesjg, gdzie nie zapisano
wynikow wyodrgbniania (Tools > Options).

Uwaga: Jesli zmienisz wezel zrédlowy strumienia juz po zbuforowaniu wynikéw wyodrebniania za pomoca opcji Use
session work..., trzeba bedzie uruchomi¢ nowe wyodrgbnianie po uruchomieniu sesji interaktywnego pulpitu
roboczego, aby moc korzystaé ze zaktualizowanych wynikoéw wyodrebniania.

Po uruchomieniu wyodrgbniania pojawia si¢ wskaznik postepu informujacy o statusie wyodrgbniania. W tym czasie
mechanizm wyodrebniania odczytuje wszystkie dane tekstowe i identyfikuje powiazane terminy i wzorce oraz
wyodrebnia je i przypisuje do typu. Nastgpnie mechanizm probuje grupowac terminy-synonimy pod jednym terminem
nazywanym pojeciem. Kiedy proces sig¢ zakonczy, wynikowe pojegcia, typy i wzorce pojawiaja si¢ w panelu Extraction
Results.
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Proces wyodrebniania powoduje powstanie zestawu pojec 1 typow, jak rowniez wzorcow TLA (Text Link Analysis),
jesli sa wlaczone. Mozna przegladac i pracowac z tymi pojgciami i typami w panelu Extraction Results widoku
Categories and Concepts. Jesli wyodrgbniono wzorce TLA, widac je w widoku Text Link Analysis.

Uwaga: Istnieje relacja pomigdzy wielkoscia zbioru danych i czasem, jaki jest wymagany do zakonczenia procesu
wyodrgbniania. Zawsze mozna rozwazy¢ wstawienie wegzta Sample we wczesniejszej czgsci strumienia lub
optymalizacje konfiguracji komputera.

Aby wyodrebnié¢ dane

1. W menu wybierz kolejno nastgpujace opcje Tools > Extract. Lub kliknij przycisk Extract na pasku.

2. Jesli ustawiono wyswietlanie okna dialogowego Extraction Settings, mozna w nim wprowadzi¢ zmiany. Dalej w
tym temacie opisano wszystkie ustawienia.

3. Kliknij przycisk Extract, aby rozpoczac proces wyodrebniania. Po rozpoczeciu wyodrebniania otwiera sig okno
dialogowe postepu. Po wyodrebnianiu wyniki pojawiaja si¢ w panelu Extraction Results. DomysSlnie pojecia sa
zapisane matymi literami i posortowane malejaco wedtug liczby wystapien w dokumentach (kolumna Doc. ) .

Mozna przejrze¢ wyniki, uzywajac opcji paska narzedzi, aby posortowaé wyniki inaczej, odfiltrowac¢ wyniki lub
przetaczyc¢ na inny widok (pojecia lub typy). Mozna rowniez doprecyzowaé wyniki wyodrgbniania, pracujac z
zasobami lingwistycznymi. Wiecej informacji zawiera temat[“Optymalizacja wynikow wyodrebniania” na stronie 86}

Potencjalne problemy zwigzane z wyodrebnieniem

Wiele interaktywnych pulpitow roboczych moze spowalnia¢ dziatanie programu. Podczas pracy z interaktywnym
pulpitem roboczym SPSS Modeler Text Analytics i SPSS Modeler wspotuzytkuja wspdlny mechanizm srodowiska
wykonawczego Java. W zaleznos$ci od liczby otwartych interaktywnych pulpitow roboczych podczas sesji programu
SPSS Modeler, nawet w przypadku uruchamiania i zamykania tej samej sesji, pamig¢ systemowa moze spowalnia¢
dziatanie aplikacji. Efekt jest szczegolnie wyrazny gdy uzytkownik pracuje z duza iloscia danych Iub gdy komputer
dysponuje mniejsza iloscia pamigci RAM niz zalecane 4 GB. Jesli komputer wolno reaguje, zaleca si¢ zapisac
wszystkie zmiany, zamkna¢ program SPSS Modeler i ponownie uruchomi¢ aplikacjg. uruchamianie produktu SPSS
Modeler Text Analytics na komputerze z mniejsza ilo$cia pamigci niz zalecana, zwlaszcza podczas pracy z duzymi
zestawami danych lub przez dtuzszy czas, moze spowodowaé wyczerpanie zasobow pamigciowych srodowiska
wykonawczego Java 1 wylaczenie systemu. W przypadku pracy z duza iloscia danych zdecydowanie zaleca si¢
rozbudowe pamigci do zalecanego lub wyzszego poziomu (albo wykorzystanie produktuSPSS Modeler Text Analytics
Server).

Informacje dotyczace jezyka angielskiego, francuskiego, hiszpanskiego, holenderskiego, niemieckiego,
portugalskiego i wloskiego

Okno dialogowe Extraction Settings zawiera podstawowe opcje wyodrebniania.

Enable Text Link Analysis pattern extraction. Okres$la, czy chcesz wyodrebni¢ wzorce TLA z danych tekstowych.
To ustawienie zaktada réwniez, ze istnieja reguty wzorcow TLA w jednej z bibliotek narzedzia Resource Editor. Ta

opcja moze znacznie wydtuzy¢ czas wyodrebniania. Wigcej informacji zawiera IRozdzial 11, “Eksplorowanie analizyl
powiazan w tekécie”, na stronie 139]

Accommodate punctuation errors. Ta opcja powoduje, ze podczas wyodrebniania tekst zawierajacy bledy
interpunkcyjne (na przyktad nieprawidlowo uzyte znaki interpunkcyjne) bedzie tymczasowo normalizowany w celu
poprawienia efektywnosci wyodrebniania pojec. Ta opcja jest bardzo uzyteczna, gdy mamy do czynienia z krétkimi
tekstami o niskiej jako$ci (np. odpowiedziami na pytania otwarte w ankietach, wiadomos$ciami e-mail i danymi z
systemow CRM) lub gdy system zawiera wiele skrotow.

Accommodate spelling for a minimum word character length of [n] Ta opcja powoduje zastosowanie techniki
grupowania rozmytego, ktora grupuje blednie napisane lub podobne wyrazy pod jednym pojgciem. Algorytm
grupowania rozmytego tymczasowo usuwa wszystkie samogloski (z wyjatkiem pierwszej) oraz podwojne/potrdjne
spotgtoski z wyodrgbnianych wyrazow, a nastgpnie porownuje wyniki, by sprawdzi¢, czy sa identyczne. Zatem wyrazy
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modeling i modelling zostalyby potaczone w jedna grupe. Jesli jednak kazdy termin ma przypisany inny typ, z
wyjatkiem typu <Unknown>, to grupowanie rozmyte nie bedzie stosowane.

Mozna tez okresli¢ minimalng liczbg znakdéw rdzennych wymagana do zastosowania grupowania rozmytego. Liczba
znakow rdzennych w terminie obliczana jest poprzez zsumowanie wszystkich znakéw i odjgcie znakow tworzacych
przyrostki przy odmianie, a w wypadku termindw bgdacych wyrazami ztozonymi, takze znakow tworzacych okreslniki
i przyimki. Na przyktad termin exercises ma 8 znakow rdzennych w swojej postaci “exercise”, poniewaz litera s na
koncu tworzy odmiang (w tym przypadku liczbe mnoga). Podobnie, apple sauce ma 10 znakow rdzennych (“apple
sauce”), a manufacturing of cars ma 16 znakéw rdzennych (“manufacturing car”). Ta metoda liczenia znakow jest
stosowana tylko do sprawdzania, czy ma by¢ przeprowadzane grupowanie rozmyte, ale nie wplywa na sposéb
dopasowywania wyrazow.

Uwaga: Jesli pozniej okaze sig, ze pewne wyrazy sa grupowane nieprawidtowo, mozna wykluczy¢ konkretne pary
wyrazow ze stosowania tej techniki, jawnie deklarujac je w sekcji Fuzzy Grouping: Exceptions na karcie Advanced
Resources. Wigcej informacji zawiera temat|“Grupowanie rozmyte” na stronie 187,

Extract uniterms Ta opcja wyodregbnia pojedyncze wyrazy (terminy pojedyncze), o ile tylko nie sa juz cze$cia wyrazu
ztozonego i sa albo rzeczownikami, albo nierozpoznanymi czg$ciami mowy.

Extract nonlinguistic entities Ta opcja wyodrgbnia Obiekty nielingwistyczne, takie jak numery telefonow, numery
ubezpieczenia spotecznego, godziny, daty, waluty, cyfry, wartoéci procentowe, adresy e-mail i adresy HTTP. W sekcji
Nonlinguistic Entities: Configuration karty Advanced Resources mozna uwzgledniaé i wykluczac okreslone typy
obicktow nielingwistycznych. Wykluczenie zbgdnych obiektow sprawi, ze mechanizm wyodrgbniania nie bedzie
marnowat czasu na ich przetwarzanie. Wiecej informacji zawiera temat|Konfiguracja” na stronie 191]

Uppercase algorithm Ta opcja wyodrebnia proste i zlozone terminy, ktore nie figuruja we wbudowanych stownikach,
o ile pierwsza litera terminu jest wielka. Jest to dobry sposob na wyodrebnienie wigkszo$ci rzeczownikow wiasnych.

Group partial and full person names together when possible Ta opcja grupuje imiona i nazwiska, ktore w tekscie
wystepuja w roznych postaciach. Jest to uzyteczne, poniewaz imiona i nazwiska czgsto na poczatku tekstu przytaczane
sa w pelnym brzmieniu, ale pdzniej juz wystepuja tylko w wersji skroconej. W przypadku wybrania tej opcji program
probuje dopasowac kazdy pojedynczy termin typu <Unknown> do ostatniego wyrazu kazdego terminu ztozonego typu
<Person> (osoba). Na przyktad, jesli znaleziony zostanie wyraz nowak o poczatkowo przypisanym typie
<Unknown>, to mechanizm wyodrebniania sprawdzi, czy jakiekolwiek terminy ztozone typu <Person> zawieraja
jako ostatni wyraz wlasnie nowak, na przyktad piotr nowak. Ta opcja nie ma zastosowania do imion, poniewaz
wigkszo$¢ z nich nigdy nie jest wyodrebniana jako termin pojedynczy.

Maximum nonfunction word permutation Ta opcja okresla maksymalna liczbe wyrazow niefunkcyjnych, ktore
moga by¢ obecne, gdy stosowana jest technika permutacji. Technika permutacji grupuje podobne frazy rozniace si¢
tylko wyrazami niefunkcyjnymi (na przyktad ,,of” lub ,,the”), niezaleznie od odmiany. Zalézmy na przyktad, ze wartos¢
ta jest ustawiona na maksymalnie dwa wyrazy i wyodrgbniono zaréwno termin company officials, jak i termin
officials of the company. W tym przypadku oba terminy zostana potaczone w grupe, poniewaz po zignorowaniu
wyrazow Of the zostana uznane za identyczne.

Use derivation when grouping multiterms Podczas przetwarzania wielkich zbioréw danych wybierz t¢ opcjg, aby
grupowac terminy wielowyrazowe wedlug regut derywacji.

Index Option for Concept Map Okresla, ze w momencie wyodrgbniania ma zosta¢ zbudowany indeks mapy, aby
mozna bylo szybko narysowa¢ pdzniej mapy pojeé. Aby edytowac ustawienia indeksu, kliknij przycisk Settings.
Wigcej informacji zawiera temat [‘Budowanie indekséw map poje¢” na stronie 86|

Always show this dialog before starting an extraction Okresl, czy chcesz wyswietla¢ okno dialogowe Extraction
Settings za kazdym razem, gdy wykonywane jest wyodrgbnianie, czy nigdy nie chcesz wyswietla¢ tego okna, tylko po
przejsciu do menu Tools lub czy checesz widzie¢ pytanie, czy chcesz edytowaé ustawienia wyodrebniania za kazdym
razem, gdy wykonywane jest wyodrebnianie.
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Filtrowanie wynikéw wyodrebniania

Podczas pracy na bardzo obszernych zbiorach danych proces wyodrgbniania moze wygenerowac¢ miliony wynikow.
Wielu uzytkownikom tak obszerne wyniki utrudnia lub uniemozliwia analizg. Dlatego, aby skupic si¢ na najbardziej
interesujacych wynikach, mozna je odfiltrowaé za pomoca okna dialogowego Filter dostepnego w panelu Extraction
Results.

Nalezy pamictac, ze wszystkie ustawienia wybrane w oknie dialogowym Filter sa uzywane tacznie do filtrowania
wynikdw wyodrebniania dostgpnych na potrzeby tworzenia kategorii.

Filter by Frequency Mozna odfiltrowa¢ wyniki tak, by byly wyswietlane tylko wyniki o okreslonej liczebnos$ci
globalnej lub liczebnosci dokumentow.

* Global frequency to taczna liczba wystapien pojgcia w catym zbiorze dokumentdw i rekordow. Podana jest w
kolumnie Global.

* Document frequency to taczna liczba dokumentdéw lub rekordow, w ktorych wystgpuje pojecie. Podana jest w
kolumnie Docs.

Na przyktad, jesli pojgcie nato wystepuje 800 razy w 500 rekordach, to globalna liczebnos$¢ tego pojgcia wynositaby
800, a liczebnos¢ dokumentéw wynositaby 500.

And by TypeMozna odfiltrowaé¢ wyniki tak, by wyswietlane byly tylko wyniki nalezace do okreslonego typu. Mozna
wybra¢ wszystkie typy lub tylko okreslone typy.

And by Match Text Mozna odfiltrowa¢ wyniki tak, by wyswietlane byty tylko wyniki zgodne ze zdefiniowana tutaj
reguta. Wprowadz zbior znakdow, ktore maja by¢ wyszukiwane, w polu Match text , a nastgpnie wybierz warunek
dopasowania.

Tabela 15. Warunki dopasowywania tekstu

Warunek Opis

Contains Tekst zostanie dopasowany, jesli tancuch wystapi w dowolnym miejscu. (Opcja domyslna)
Starts with Tekst zostanie dopasowany, jesli pojecie lub nazwa typu zaczyna sig od okreslonego tekstu.
Ends with Tekst zostanie dopasowany, jesli pojecie lub nazwa typu konczy si¢ okreslonym tekstem.
Exact match Caly tekst musi by¢ dopasowany do pojecia lub nazwy typu.

Wyniki wyswietlane w panelu Extraction Result

Oto przyktady wynikow (w jezyku angielskim) wyswietlanych na pasku narzedzi panelu Extraction Results w
zalezno$ci od wybranych filtrow.

Tabela 16. Przykiady wynikow filtrowania

Wryniki filtrowania Opis
7 ,m Pasek narzgdzi zawiera liczbe wynikéw. Poniewaz nie zastosowano filtru dopasowujacego

tekst i nie osiagnigto maksimum, nie sa wyswietlane dodatkowe ikony.

7 Na pasku narzedzi widaé, ze liczba wynikow zostala ograniczona do maksimum

358 concepts 9 , , . . . .
okreslonego dla filtru, ktére w tym przypadku wynosi 300. Fioletowa ikona oznacza, ze

osiagnigto maksymalna liczbg poje¢. Zatrzymaj wskaznik nad ikona, aby wyswietli¢

wigcej informacji.

Na pasku narzedzi widag, ze liczba wynikow zostata ograniczona przez filtr dopasowujacy
W ja e
cncseiakl tekst. Sygnalizuje to ikona lupy.
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Aby filtrowaé wyniki
1. Z menu wybierz opcje Tools > Filter. Zostanie otwarte okno dialogowe Filter.
2. Wybierz i doprecyzyj filtry, ktorych cheesz uzywac.

3. Kliknij przycisk OK, aby zastosowac¢ filtry i wyswietli¢ nowe wyniki w panelu Extraction Results.

Eksplorowanie map pojec¢

Mozna utworzy¢ mapg pojec, aby poznaé sposob, w jaki pojecia sa ze soba potaczone relacjami. Wybierajac jedno
pojecie i klikajac opcje Map, mozna otworzy¢ okno mapy pojeé, w ktdrym mozna eksplorowaé zestaw pojec
pokrewnych wybranemu pojgciu. Mozna odfiltrowac pojecia, ktore sa wyswietlane, edytujac ustawienia, takie jak typy
do uwzglednienia, rodzaje relacji do wyszukania itd.

Wazne: Zanim bedzie mozna utworzy¢ mape, nalezy wygenerowac indeks. Ten proces moze potrwac kilka minut.
Jednak po wygenerowaniu indeksu nie trzeba generowaé go ponownie do czasu ponownego wyodrebnienia. Jesli
indeks ma by¢ generowany automatycznie po kazdym wyodrebnianiu, wybierz odpowiednia opcje w ustawieniach
wyodrebniania. Wiecej informacji zawiera temat [*Wyodrebnianie danych” na stronie 80|
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Rysunek 27. Mapa poje¢ dla wybranego pojecia
Aby wyswietli¢ mape poje¢
1. W panelu Extraction Results wybierz jedno pojecie.
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2. Na pasku narzedzi tego panelu kliknij przycisk Map. Jesli indeks mapy zostat juz wygenerowany, mapa pojeé
otworzy si¢ w osobnym oknie dialogowym. Jesli indeks mapy nie zostat wygenerowany lub jest nieaktualny, musi
zosta¢ odbudowany. Ten proces moze potrwaé kilka minut.

3. Kliknij po mapie, aby ja eksplorowac. Jesli dwukrotnie klikniesz powiazane pojgcie, mapa zostanie odswiezona i
pojawia si¢ pojecia zewnetrzne z tym, ktdre zostalo kliknigte.

4. Pasek narzedzi udostgpnia podstawowe narzgdzia do pracy z mapa, takie jak powrét do poprzedniej mapy,
filtrowanie powiazan wedtug sily relacji, a takze otwieranie okna dialogowego filtrowania, w ktorym mozna
okresli¢ typy pojec, ktore beda wyswietlane, a takze rodzaj relacji, ktére maja by¢ przedstawiane. Drugi wiersz
paska narzedzi zawiera narzedzia edycji wykresu. Wigcej informacji zawiera temat|[“Uzywanie paskow narzedzi il
[palet wykresow” na stronie 149]

5. Jesli znajdowane powiazania sa niezadowalajace, przejrzyj ustawienia tej mapy po jej prawej stronie.
Ustawienia mapy: Include Concepts from Selected Types

Tylko pojgcia, ktore naleza do typow wybranych w tabeli, sa pokazywane na mapie. Aby ukry¢ pojecia okreslonego
typu, anuluj wybdr tego typu w tabeli.

Ustawienia mapy: Relationships to Display

Show co-occurrence links. Aby wyswietli¢ powiazania wspolwystapien, wybierz tryb. Tryb wptywa na sposob

obliczania sity powiazan.

* Discover (similarity metric). W przypadku tej metryki sita powiazan jest obliczana przy uzyciu bardziej ztozonego
algorytmu, ktory uwzglednia, jak czgsto dwa pojgcia wystgpuja osobno, a takze, jak czgsto wystepuja razem. Duza
sila oznacza, ze para poje¢ wystepuje czgsciej razem niz pojecia te wystgpuja osobno. W ponizszym wzorze
wszystkie wartosci zmiennopozycyjne sa przeksztalcane w liczby catkowite.

(Coff
(CrxCy)

simnilarity coeffidient =

Rysunek 28. Wzor na wspdifczynnik podobieristwa

W tym wzorze C, to liczba dokumentéw lub rekordéw, w ktorych wystepuje pojecie 1.
C, to liczba dokumentdw lub rekordow, w ktdrych wystgpuje pojecie J.
C,; to liczba dokumentow lub rekordow, w ktorych para pojec | i J wspotwystepuje w zestawie dokumentow.

* Organize (document metric). Sita polaczen dla tej metryki jest obliczana na podstawie surowej liczby
wspotwystapien. Ogolnie, im wigksza liczebno$¢ maja dwa pojecia, tym bardziej prawdopodobne jest, ze czasami
beda wystepowac razem. Duza sita oznacza, Ze pojgcia czgsto wystgpuja razem.

Show other links (confidence metric). Mozna nakaza¢ wyswietlanie innych powiazan: semantycznych, wywodzenia
(morfologicznych) Iub wiaczajacych (sktadniowych). Ich sita zalezy od liczby krokow, ktora dzieli jedno pojgcie od
drugiego. Mozliwosci te pomagaja w optymalizacji zasobow, a zwlaszcza synonimow, oraz usuwaniu
niejednoznacznosci. Krotkie opisy poszczegdlnych technik grupowania zawiera temat|“Zaawansowane ustawienial
jezykowe” na stronie 102

Uwaga: Nalezy pamigtac, ze jesli ich nie wybrano podczas budowania indeksu lub jesli nie znaleziono relacji, to nie
zostanie wy$wietlona zadna informacja. Wiecej informacji zawiera temat[‘Budowanie indeksow map poje¢” na stronie

Ustawienia mapy: Map Display Limits

Apply extraction results filter. Jesli nie chcesz uzywac¢ wszystkich poje¢, mozna uzy¢ filtru wynikow wyodrgbniania.
Nastepnie nalezy wybrac tg opcjg, a IBM SPSS Modeler Text Analytics wyszuka pojecia pokrewne w przefiltrowanym
zestawie. Wigcej informacji zawiera temat[“Filtrowanie wynikéw wyodrebniania” na stronie 83|
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Minimum strength. Tutaj ustaw minimalna sit¢ powiazania. Wszystkie pojecia pokrewne o sile relacji nizszej niz ta
granica zostang ukryte na mapie.

Maximum concepts on map. Okres$l maksymalna liczbg relacji do wyswietlenia na mapie.

Budowanie indekséw map pojeé

Zanim bedzie mozna utworzy¢ mape, nalezy wygenerowac indeks relacji miedzy pojeciami. Za kazdym razem, gdy
uzytkownik tworzy mapg pojec¢, IBM SPSS Modeler Text Analytics odwoluje si¢ do tego indeksu. Mozna wybrac,
ktére relacje beda indeksowane, okreslajac techniki w tym oknie dialogowym.

Grouping techniques. Wybierz jedna lub wiecej technik. Krotki opis kazdej z tych technik zawiera sekcja
b technikach lingwistycznych” na stronie 105] Nie wszystkie techniki sa dostepne dla wszystkich jezykow tekstu.

Prevent pairing of specific concepts. Zaznacz to pole wyboru, aby w wynikach nie grupowac¢ lub nie taczy¢ w pary
dwoch poje¢. Aby tworzy¢ pary pojec¢ lub nimi zarzadza¢, kliknij przycisk Manage Pairs. Wigcej informacji zawiera
temat [‘Zarzadzanie parami wyjatkéw powiazan” na stronie 104}

Budowanie indeksu moze potrwac¢ kilka minut. Jednak po wygenerowaniu indeksu nie trzeba generowa¢ go ponownie
do czasu ponownego wyodrebnienia, chyba ze chcesz zmieni¢ ustawienia, by uwzgledni¢ wiecej relacji. Jesli indeks
ma by¢ generowany automatycznie po kazdym wyodrebnianiu, wybierz odpowiednia opcje w ustawieniach
wyodrebniania. Wigcej informacji zawiera temat[“Wyodrebnianie danych” na stronie 80|

Optymalizacja wynikéw wyodrebniania

Wyodrebnianie jest procesem iteracyjnym, w ktorym mozliwe jest wyodrebnianie pojg¢, przegladanie wynikow,
wprowadzanie zmian i ponowne wyodrgbnianie w celu zaktualizowania wynikéw. Poniewaz warunkiem powodzenia
eksploracji tekstu i kategoryzacji jest doktadnos$¢ i ciaglos¢, optymalizacja wynikow juz na samym poczatku procesu
zagwarantuje, ze kazde ponowne wyodrebnianie przyniesie doktadnie te same wyniki w definicjach kategorii. W ten
sposéb rekordy 1 dokumenty zostana przypisane do kategorii w sposob bardziej doktadny i powtarzalny.

Wyniki wyodrebniania sa elementami sktadowymi kategorii. Podczas tworzenia kategorii na podstawie tych wynikow
wyodregbniania rekordy i dokumenty sa automatycznie przypisywane do kategorii, jesli zawieraja tekst pasujacy do
jednego lub wielu deskryptorow tej kategorii. Mimo ze mozna rozpoczac kategoryzacjg przed zoptymalizowaniem
zasobow lingwistycznych, lepiej jest co najmniej raz przejrze¢ wyniki wyodrgbniania, zanim przystapi si¢ do tworzenia
kategorii.

Wstepna weryfikacja wynikow moze ujawni¢ elementy, ktore mechanizm wyodrgbniania powinien potraktowac inaczej

niz zrobil to przy pierwszym wyodrebnianiu. Rozwazmy nastepujace przyktady:

* Nierozpoznane synonimy. Zalézmy, ze znalezlismy kilka pojg¢, ktdre uznajemy za synonimy, na przyklad smart,
intelligent, bright i knowledgeable, a wszystkie one figuruja jako odrgbne pojecia na liscie wynikow. Mozemy
utworzy¢ definicje synonimu, w ktorej intelligent, bright i knowledgeable zostana zgrupowanej pod docelowym
pojeciem smart. W ten sposdb wszystkie te pojecia zostana zgrupowane z pojeciem smart, a globalna liczebnos¢
bedzie wyzsza. Wigcej informacji zawiera temat |“Dodawanie synonimow’’ na stronie 87l

* Pojecie z blednie przypisanym typem. Zalézmy, Ze pojecia w wynikach wyodregbniania sa przypisane do jednego
typu, ale chcemy je przypisa¢ do innego. Inny przyktad: wyobrazmy sobie, ze w wynikach wyodrebniania
znajdujemy 15 poje¢ oznaczajacych warzywa i chcemy, aby wszystkie byty przypisane do nowego typu o nazwie
<Vegetable>. W wigkszosci jezykow pojecia nieznalezione w zadnym stowniku typu, ale wyodrebnione z tekstu
otrzymuja automatycznie przypisywany typ <Unknown> Mozliwe jest dodawanie poje¢ do typow. Wiecej
informacji zawiera temat[“Dodawanie poje¢ do typéw” na stronie 88|

* Pojecia nieistotne. Zatézmy, ze znalezlisSmy wyodrebnione pojecie o bardzo duzej liczebnosci, tj. wystepujace w
bardzo wielu rekordach lub dokumentach. Uznajemy jednak, ze to pojgcie jest nieistotne dla naszej analizy. Mozemy
’iwykluczyc' z wyodrebniania. Wigcej informacji zawiera temat|[“Wykluczanie pojeé¢ z wyodrebniania” na stroniel
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* Nieprawidlowe dopasowania. Zalézmy, ze przegladamy rekordy lub dokumenty zawierajace okreslone pojecie i
odkrywamy, ze dwa wyrazy zostaty btednie zgrupowane (na przyktad faculty i facility). Takie dopasowanie moze
by¢ skutkiem dziatania wewngtrznego algorytmu grupowania rozmytego, ktéry tymczasowo ignoruje ciagi dwoch
lub trzech spdtglosek i samogtosek, aby pogrupowaé czgsto spotykane btedne formy zapisu tego samego wyrazu.
Mozemy doda¢ te dwa wyrazy do listy par, ktore nie powinny by¢ grupowane. Wigcej informacji zawiera temat
[Grupowanie rozmyte” na stronie 187}

* Niewyodrebnione pojecia. Zatézmy, ze spodziewamy si¢ znalez¢ w wynikach wyodrebniania okreslone pojgcia, ale
przegladajac tekst w rekordach lub dokumentach zauwazamy, ze niektore wyrazy lub frazy nie zostaty
wyodrebnione. Czgsto sa to nieinteresujace nas czasowniki lub przymiotniki. Jednak czgsto chcemy uzy¢ wyrazu,
ktory nie zostat wyodrgbniony, w definicji jednej z kategorii. Aby wyodregbni¢ pojecie, mozna wymusi¢ wpisanie
terminu do stownika typu. Wiecej informacji zawiera temat [*“Wymuszanie wyodrebniania wyrazéw” na stronie 90}

Wiele z tych zmian mozna wprowadzi¢ bezposrednio na panelu Extraction Results, panelu Data, w oknie dialogowym
Category Definitions lub w oknie dialogowym Cluster Definitions poprzez wybieranie elementdéw i klikanie prawym
przyciskiem myszy w celu wywotania menu kontekstowego.

Po prowadzeniu zmian kolor tta panelu zmieni si¢, wskazujac, ze trzeba ponownie przeprowadzi¢ wyodregbnianie.
Wigcej informacji zawiera temat [“Wyodrebnianie danych” na stronie 80| W przypadku pracy z obszernymi zbiorami
danych bardziej efektywnym rozwiazaniem moze okaza¢ si¢ ponawianie wyodrebniania po wprowadzeniu kilku zmian,
a nie po kazdej zmianie.

Uwaga: Caly zbidr edytowalnych zasobdw lingwistycznych wykorzystany do wygenerowania wynikow
wyodrebniania mozna wys$wietli¢ w widoku Resource Editor (View > Resource Editor). Zasoby te maja postac
bibliotek i stownikdw. Mozna modyfikowaé pojecia i typy bezposrednio w bibliotekach i stownikach. Wigcej
informacji mozna znalez¢ w temacie [Rozdziat 15, “Praca z bibliotekami”, na stronie 165]

Dodawanie synonimow

Synonimy kojarza dwa lub wigksza liczbg wyrazoéw o tym samym znaczeniu. Mozna roéwniez uzy¢ synonimow do
grupowania terminow z ich skrétami lub do grupowania najczesciej wystepujacych biednie zapisanych form terminu z
jego poprawna forma. Uzycie synonimow zwigksza czgstos¢ wystepowania pojecia docelowego, co utatwia
odkrywanie podobnych informacji wyrazonych w danych w rézny sposob.

Szablony zasobdw lingwistycznych i biblioteki dostarczone z produktem zawieraja wiele predefiniowanych
synonimow. Jesli jednak odkryjesz nierozpoznane synonimy, mozesz je zdefiniowac, aby zostaly rozpoznane przy
nastgpnym wyodrebnianiu.

Pierwszym krokiem jest wybor pojgcia docelowego, czyli wiodacego. Pojecie docelowe to wyraz lub fraza, pod
ktérym/ktora cheesz zgrupowac wszystkie synonimy w ostatecznych wynikach. W trakcie wyodrgbniania synonimy sa
grupowane pod tym pojeciem docelowym. Drugim krokiem jest identyfikacja wszystkich synoniméw tego pojecia.
Wszystkie synonimy w ostatecznych wynikach wyodrebniania zostana zastapione pojeciem docelowym. Aby termin
mogt by¢ synonimem, musi zosta¢ wyodrebniony. Jednak pojecie docelowe nie musi by¢ koniecznie wyodrebnione,
aby miato miejsce zastapienie. Na przyklad, jesli termin intelligent ma by¢ zastepowany terminem smart, to
intelligent jest synonimem, a smart jest pojeciem docelowym.

Gdy utworzysz nowa definicj¢ synonimu, do stownika zostanie dodane nowe pojgcie docelowe. Nastgpnie musisz
doda¢ synonimy do pojecia docelowego. Kazde utworzenie lub zmiana synonimu jest rejestrowana w stownikach
synoniméw w edytorze Resource Editor. Jesli cheesz przejrze¢ cata zawartos¢ tych stownikow synoniméw lub
wprowadzi¢ duza liczbe zmian, lepszym wyjsciem moze by¢ praca bezposrednio w oknie Resource Editor. Wigcej
informacji zawiera temat[“Stowniki zastapien/synonimow” na stronie 180}

Wszystkie nowe synonimy sa automatycznie zapisywane w pierwszej bibliotece wymienionej w drzewie bibliotek
edytora Resource Editor; domyslnie jest to biblioteka o nazwie Local Library.
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Uwaga: Jesli nie mozesz znalez¢ definicji synonimu za posrednictwem menu kontekstowych lub bezposrednio w
oknie Resource Editor, to by¢ moze doszto do dopasowania w wyniku wewnetrznego grupowania rozmytego. Wigcej
informacji zawiera temat [*Grupowanie rozmyte” na stronie 187}

Aby utworzy¢ nowy synonim

1. W panelu Extraction Results, panelu Data, oknie dialogowym Category Definitions lub oknie dialogowym Cluster
Definitions wybierz pojgcia, dla ktdrych checesz utworzy¢ nowy synonim.

2. Z menu wybierz opcje Edit > Add to Synonym > New. Zostanie otwarte okno dialogowe Create Synonym.

3. Wprowadz pojgcie docelowe w polu tekstowym Target. Jest to pojecie, pod ktorym zostana zgrupowane wszystkie
synonimy.

4. Aby dodac wigcej synonimow, wprowadz je w polu listy Synonyms. Oddzielaj synonimy separatorem globalnym.
Wigcej informacji zawiera temat [‘Okno dialogowe Options: karta Session” na stronie 75|

5. Kliknij przycisk OK, aby zastosowa¢ zmiany. Okno dialogowe zostanie zamknigte, a kolor tta panelu Extraction
Results zmieni sig, wskazujac, ze trzeba ponownie przeprowadzi¢ wyodrgbnianie, aby zobaczy¢ wprowadzone
zmiany. Jesli chcesz wprowadzi¢ kilka zmian, wprowadz je wszystkie przed ponownym wyodrgbnianiem.

Aby doda¢ synonim

1. W panelu Extraction Results, panelu Data, oknie dialogowym Category Definitions lub oknie dialogowym Cluster
Definitions wybierz pojgcia, ktore cheesz dodac do istniejacej definicji synonimu.

2. Z menu wybierz opcje Edit > Add to Synonym. Menu zawiera zestaw synonimow, a ostatnio utworzony znajduje
si¢ na poczatku listy. Wybierz nazwe synonimu, do ktérego chcesz doda¢ wybrane pojecia. Jesli wyswietlana jest
nazwa synonimu, ktérego szukasz, wybierz go, a wybrane pojecia zostana dodane do tej definicji synonimu. Jesli
zadany synonim nie jest widoczny, wybierz opcje More, aby wyswietli¢ okno dialogowe All Synonyms.

3. W oknie dialogowym All Synonyms mozna posortowac liste wedtug kolejnosci naturalnej (kolejnosci tworzenia)
lub w porzadku rosnacym lub malejacym. Wybierz nazwe synonimu, do ktorego chcesz doda¢ wybrane pojecia, a
nastepnie kliknij przycisk OK. Okno dialogowe zostanie zamknigte, a pojecia zostana dodane do definicji
synonimu.

Dodawanie poje¢ do typow

W trakcie wyodrgbniania wyodrgbnione pojgcia sa przypisywane do typéw w celu zgrupowania termindw, ktére maja
ze soba cos$ wspolnego. IBM SPSS Modeler Text Analytics jest dostarczany z wieloma typami wbudowanymi. Wigcej
informacji zawiera temat [“Typy wbudowane” na stronie 174] W wigkszosci jezykow pojecia nieznalezione w zadnym
stowniku typu, ale wyodrebnione z tekstu otrzymuja automatycznie przypisywany typ <Unknown>

Przegladajac wyniki, mozesz dostrzec pojecia, ktorym zostat przypisany niewlasciwy typ. Bywa, ze pewna grupa
wyrazow powinna mie¢ swoj wlasny typ. W tych przypadkach celowe byloby przypisanie poje¢ do innego typu lub
utworzenie zupetnie nowego typu.

Zatézmy na przyktad, ze pracujemy z danymi z ankiety dotyczacej samochoddw i interesuje nas kategoryzacja wedtug
réznych obszaréw pojazdu. Mozemy utworzy¢ typ <Dashboard>, ktory bedzie grupowat wszystkie pojecia zwiazane
ze wskaznikami, przyciskami itp. na deskach rozdzielczych pojazdow. Nastgpnie moglibysmy przypisac¢ do tego
nowego typu takie pojecia, jak gas gauge, heater, radio i odometer.

Inny przyktad: zatozmy ze pracujemy z danymi ankietowymi dotyczacymi uczelni wyzszych, a mechanizm
wyodrebniania przypisat nazwe uczelni Johns Hopkins (chodzi o uniwersytet) do typu <Person> zamiast do typu
<Organization>. W takim przypadku mozemy doda¢ to pojecie do typu <Organization>.

Za kazdym razem, gdy tworzysz typ lub dodajesz pojecia do listy termindw typu zmiany te sa rejestrowane w
stownikach typow nalezacych do bibliotek zasobow lingwistycznych w edytorze Resource Editor. Jesli chcesz
przejrze¢ zawartosci tych bibliotek lub wprowadzi¢ duza liczbg zmian, lepszym wyjsciem moze by¢ praca
bezposrednio w oknie Resource Editor. Wigcej informacji zawiera temat|“Dodawanie termindw” na stronie 176
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Aby dodac¢ pojecie do typu

1. W panelu Extraction Results, panelu Data, oknie dialogowym Category Definitions lub oknie dialogowym Cluster
Definitions wybierz pojgcia, ktére cheesz doda¢ do istniejacego typu.

2. Kliknij prawym przyciskiem myszy, aby otworzy¢ menu kontekstowe.

3. Z menu wybierz opcje Edit > Add to Type. Menu zawiera zestaw typow, a ostatnio utworzony znajduje si¢ na
poczatku listy. Wybierz nazwe typu, do ktorego cheesz doda¢ wybrane pojecia. Jesli wyswietlana jest nazwa typu,
ktérego szukasz, wybierz go, a wybrane pojecia zostana dodane do tego typu. Jesli zadany typ nie jest widoczny,
wybierz opcj¢ More, aby wyswietli¢ okno dialogowe All Types.

4. W oknie dialogowym All Synonyms mozna posortowac liste wedtug kolejnosci naturalnej (tworzenia) lub w
porzadku rosnacym lub malejacym. Wybierz nazwe typu, do ktorego cheesz doda¢ wybrane pojgcia, a nastgpnie
kliknij przycisk OK. Okno dialogowe zostanie zamknigte, a pojgcia zostana dodane jako terminy do typu.

Aby utworzy¢ nowy typ

1. W panelu Extraction Results, panelu Data, oknie dialogowym Category Definitions lub oknie dialogowym Cluster
Definitions wybierz pojgcia, dla ktdrych cheesz utworzy¢ nowy typ.

2. Z menu wybierz opcje Edit > Add to Type > New. Zostanie otwarte okno dialogowe Type Properties.

3. Wprowadz nowa nazwe dla tego typu w polu tekstowym Name i wprowadz zmiany do innych pol. Wigcej
informacji zawiera temat [“Tworzenie typow” na stronie 175

4. Kliknij przycisk OK, aby zastosowa¢ zmiany. Okno dialogowe zostanie zamknigte, a kolor tta panelu Extraction
Results zmieni si¢, wskazujac, ze trzeba ponownie przeprowadzi¢ wyodrgbnianie, aby zobaczy¢ wprowadzone
zmiany. Jesli chcesz wprowadzi¢ kilka zmian, wprowadz je wszystkie przed ponownym wyodrgbnianiem.

Wykluczanie pojec¢ z wyodrebniania

Przegladajac wyniki, mozesz trafi¢ na pojgcia, ktore nie powinny by¢ wyodrebniane ani wykorzystywane przez
techniki zautomatyzowanego budowania kategorii. W niektérych przypadkach pojecia te maja bardzo duza liczebnos¢,
ale sa catkowicie nieistotne dla analizy. Wowczas mozna oznaczy¢ pojecie jako wykluczone z ostatecznych wynikow
wyodrebniania. Zwykle do tego stownika dodaje si¢ wyrazy wypehniajace lub frazy uzywane w tekscie dla zapewnienia
jego ciagloscei, ale nie wnoszace nic waznego, ktore moglyby tylko zaciemni¢ wyniki wyodrebniania. Dodajac te
pojecia do stownika wykluczen powodujesz, ze nie beda nigdy wyodrgbniane.

Wykluczenie pojgcia powoduje, ze wszystkie warianty wykluczonego pojecia znikna z wynikéw nastgpnego
wyodrebniania. Jesli wykluczone pojecie jest juz deskryptorem jakiej$ kategorii, to po ponownym wyodrebnianiu
pozostanie w tej kategorii z liczno$cia zerowa.

Wykluczenia sa rejestrowane w stowniku wykluczen w edytorze Resource Editor. Jesli chcesz przejrze¢ wszystkie
definicje wykluczen i edytowac je bezposrednio, lepszym wyjscie moze by¢ praca bezposrednio w oknie Resource
Editor. Wiecej informacji zawiera temat[“Stowniki wykluczen” na stronie 183|

Aby wykluczyé¢ pojecia

1. W panelu Extraction Results, panelu Data, oknie dialogowym Category Definitions lub oknie dialogowym Cluster
Definitions wybierz pojgcia, ktdre cheesz wykluczy¢ z wyodrebniania.

2. Kliknij prawym przyciskiem myszy, aby otworzy¢ menu kontekstowe.

3. Wybierz opcj¢ Exclude from Extraction. Pojgcie zostanie dodane do stownika wykluczen w edytorze Resource
Editor, a kolor tta panelu Extraction Results zmieni sig, wskazujac, ze trzeba ponownie przeprowadzi¢
wyodrgbnianie, aby zobaczy¢ wprowadzone zmiany. Jesli chcesz wprowadzi¢ kilka zmian, wprowadz je wszystkie
przed ponownym wyodrgbnianiem.

Uwaga: Wszystkie wykluczone terminy sa automatycznie zapisywane w pierwszej bibliotece wymienionej w drzewie
bibliotek edytora Resource Editor; domyslnie jest to biblioteka o nazwie Local Library.
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Wymuszanie wyodrebniania wyrazow

Przegladajac dane tekstowe w panelu Data po zakonczeniu wyodrebniania, mozesz zauwazy¢ wyrazy lub frazy, ktore
nie byly wyodrgbnione. Czgsto sa to nieinteresujace nas czasowniki lub przymiotniki. Jednak czgsto chcemy uzy¢
wyrazu, ktory nie zostal wyodrebniony, w definicji jednej z kategorii.

Jesli cheesz wyodrebnic te wyrazy i frazy, mozesz wymusi¢ wpisanie terminu do stownika typu. Wigcej informacji
zawiera temat[“Wymuszanie terminéw” na stronie 178}

Wazne! Oznaczenie terminu w stowniku jako wymuszonego nie zawsze gwarantuje pozadany skutek. Nawet jesli
jawnie dodasz termin do stownika, moze on nie pojawic si¢ w wynikach ponownego wyodrgbniania lub pojawi sig, ale
nieco inaczej niz zostat zadeklarowany. Cho¢ takie sytuacje sa rzadkoscia, moga wystapic, jesli wyraz lub fraze
wyodrebniono juz wezesniej jako czes¢ dtuzszej frazy. Aby temu zapobiec, w stowniku typu dla tego terminu wybierz
Q dopasowywania Entire (no compounds). Wiecej informacji zawiera temat[‘Dodawanie terminow” na stronie|
176
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Rozdziat 9. Kategoryzacja danych tekstowych

W widoku Categories and Concepts mozna tworzy¢ kategorie, ktore zasadniczo reprezentuja bardziej ogolne pojgcia
albo tematy i pozwola wychwyci¢ kluczowe idee, informacje i postawy wyrazone w tekscie.

Poczawszy od wersji 14 produktu IBM SPSS Modeler Text Analytics, kategorie moga rowniez mie¢ strukturg
hierarchiczna, co oznacza, ze moga zawiera¢ podkategorie, a te podkategorie moga zawiera¢ wtasne podkategorie itd.
Istnieje mozliwo$¢ zaimportowania predefiniowanych struktur kategorii, uprzednio zwanych ramkami kodu, z
hierarchiczna struktura kategorii, a takze tworzenia kategorii hierarchicznych bezposrednio w programie.

W rezultacie kategorie hierarchiczne umozliwiaja zbudowanie struktury drzewa z jedna lub wigksza liczba podkategorii
w celu bardziej doktadnego grupowania elementow, takich jak rézne pojecia lub obszary tematyczne. Oto prosty
przyktad zwiazany ze spedzaniem wolnego czasu: odpowiedz na pytanie What activity would you like to do if you had
more time? moze przynies¢ kategorie najwyzszego poziomu sports, art and craft, fishing itd.; na poziomie o jeden
nizszym niz sports mozemy mie¢ kategorie odpowiadajace roznym grupom dyscyplin: ball games, water-related itd.

Kategoria sklada si¢ z zestawu deskryptordw, takich jak pojecia, typy, wzorce i reguly kategorii. Razem te deskryptory
shuza do okreslania, czy konkretny dokument lub rekord nalezy do danej kategorii. Tekst w dokumencie lub rekordzie
mozna przeszukac, aby sprawdzi¢, czy jakikolwiek jego fragment pasuje do deskryptora. Jesli zostanie znalezione
dopasowanie, dokument/rekord jest przypisywany do tej kategorii. Ten proces jest nazywany klasyfikowaniem.

Mozna opracowywac, budowac i wizualnie eksplorowac kategorie, korzystajac z danych prezentowanych w czterech
panelach widoku Categories and Concepts, z ktorych kazdy moze by¢ ukryty lub wyswietlany poprzez wybranie
odpowiedniej nazwy panelu z menu View.

* Panel Categories. Ten panel stuzy do tworzenia kategorii i zarzadzania nimi. Wigcej informacji zawiera temat
[Panel Categories” na stronie 92|

* Panel Extraction Results. Ten panel stuzy do eksploracji i pracy z wyodrebnionymi pojeciami i typami. Wigcej
informacji zawiera temat |“Wyniki wyodregbniania: pojgcia i typy” na stronie 79l

* Panel Visualization. W tym panelu mozliwe jest wizualne eksplorowanie kategorii i ich interakcji. Wigcej
informacji zawiera temat [*Wykresy i tabele kategorii” na stronie 143|

* Panel Data. Ten panel stuzy do eksplorowania i przegladania tekstu zawartego w dokumentach i rekordach
odpowiadajacych wyborom dokonanym w tym panelu. Wiecej informacji zawiera temat|“Panel Data” na stronie 99|
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Rysunek 29. Widok Categories and Concepts

Mozna zacza¢ pracg od zestawu kategorii zaimportowanego z pakietu analizy tekstu (TAP) Iub zaimportowac¢ kategorie
z predefiniowanego pliku kategorii, mozna takze tworzy¢ wlasne kategorie. Kategorie moga by¢ tworzone
automatycznie przy wykorzystaniu dostgpnego w produkcie, wszechstronnego zestawu technik automatycznych, ktdre
uzywaja wynikow wyodrebniania (pojec¢, typow i wzorcow) do generowania kategorii i ich deskryptoréw. Kategorie
moga by¢ rowniez tworzone recznie na postawie dodatkowych spostrzezen uzytkownika. Jednak reczne tworzenie
kategorii lub ich optymalizowanie jest mozliwe tylko w interaktywnym pulpicie roboczym. Wigcej informacji zawiera
temat [*Wezet Text Mining: karta Model” na stronie 23| Definicje kategorii mozna tworzy¢ recznie, przeciagajac i
upuszczajac wyniki wyodrebniania do kategorii. Mozna wzbogacac te kategorie lub puste kategorie poprzez dodawanie
regut kategorii, przy uzyciu wlasnych predefiniowanych kategorii lub poprzez zastosowanie kombinacji tych metod.

Kazda z dostgpnych technik dobrze nadaje si¢ do pracy z okreslonymi rodzajami danych i w okreslonych warunkach,
jednak czesto przydatna jest mozliwos¢ potaczenia w jednej analizie réznych technik w celu wydobycia bogatszego
zbioru informacji z dokumentdéw lub rekordow. W trakcie kategoryzacji uzytkownik moze tez dostrzec inne zmiany,
ktére warto byloby wprowadzi¢ w zasobach lingwistycznych.

Panel Categories

Panel Categories to obszar, w ktorym mozna tworzy¢ kategorie i zarzadza¢ nimi. Ten panel znajduje si¢ w lewym
gornym rogu widoku Categories and Concepts. Po zakonczeniu wyodrgbniania pojec i typow z danych tekstowych
mozna rozpocza¢ automatyczne tworzenie kategorii za pomoca takich technik, jak wlaczenie pojgcia, wspotwystapienia
itp., albo recznie. Wigcej informacji zawiera temat [“Tworzenie kategorii” na stronie 101}

Za kazdym razem, gdy kategoria jest tworzona lub aktualizowana, dokumenty lub rekordy mozna oceni¢, klikajac
przycisk Score w celu sprawdzenia, czy jakikolwiek fragment tekstu jest zgodny z deskryptorem w danej kategorii.
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Jesli zostanie znalezione dopasowanie, dokument lub rekord jest przypisywany do tej kategorii. W rezultacie wigkszos¢
(jesli nie sto procent) dokumentow lub rekorddw zostaje przypisana do kategorii na podstawie deskryptorow w
kategoriach.

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej kategorii, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czgsci panelu, aby przeglada¢ kategorie, lub wprowadzi¢ numer strony i przej$¢ do nie;j.

Tabela drzewa kategorii

Tabela drzewa w tym panelu prezentuje zestaw kategorii, podkategorii i deskryptorow. Drzewo zawiera réwniez kilka
kolumn prezentujacych informacje o kazdym elemencie drzewa. Do wyswietlania moga by¢ dostepne nastgpujace
kolumny:

* Code Wyswietla warto$¢ kodu dla kazdej kategorii. Ta kolumna jest domy$lnie ukryta. Te kolumng mozna
wyswietli¢ za pomoca menu: View > Categories Pane.

» Category. Zawiera drzewo kategorii z nazwami kategorii i podkategorii. Dodatkowo, jesli zostanie kliknigta ikona
deskryptorow na pasku narzedzi, zostanie wyswietlony takze zestaw deskryptorow.

* Descriptors. Liczba deskryptorow, ktore sktadaja sig na definicjg. Ta liczba nie zawiera liczby deskryptorow w
podkategoriach. Liczba nie jest podana, gdy nazwa deskryptora jest widoczna w kolumnie Categories. Mozesz
wyswietla¢ lub ukrywac deskryptory w drzewie samodzielnie za posrednictwem menu: View > Categories Pane >
All Descriptors.

* Docs Po zakonczeniu oceniania ta kolumna zawiera liczbe dokumentdéw lub rekordow, ktore sa skategoryzowane w
kategorii 1 wszystkich jej podkategoriach. Jesli wigc 5 rekordéw odpowiada kategorii najwyzszego poziomu na
podstawie deskryptordw, a 7 innych rekordow odpowiada podkategorii na podstawie deskryptoréw, to taczna liczba
dokumentéw dla kategorii najwyzszego poziomu jest suma obu tych liczb (12). Jesli jednak ten sam rekord pasuje
do kategorii najwyzszego poziomu i jej podkategorii, wéwczas liczba wynositaby 11.

Jesli nie istnieja zadne kategorie, tabela nadal zawiera dwa wiersze. Najwyzszy wiersz o nazwie All Documents,
zawiera taczna liczbe dokumentow lub rekordow. Drugi wiersz o nazwie Uncategorized zawiera liczbe
dokumentéw/rekordow, ktdre maja jeszcze zostac sklasyfikowane.

Dla kazdej kategorii w panelu mata zotta ikona poprzedza nazwe kategorii. Jesli klikniesz dwukrotnie kategorig lub
wybierzesz opcj¢ View > Category Definitions w menu, zostanie otwarte okno dialogowe Category Definitions ze
wszystkimi elementami, nazywanymi deskryptorami, ktore sktadaja si¢ na definicje kategorii, takimi jak pojgcia, typy,
wzorce i reguty kategorii. Wiecej informacji zawiera temat [“Informacije o kategoriach” na stronie 98| DomysInie tabela
drzewa kategorii nie prezentuje deskryptoréw w kategoriach. Jesli chcesz wyswietli¢ deskryptory bezposrednio w
drzewie, a nie w oknie dialogowym Category Definitions, kliknij przycisk przelacznika z otowkiem na pasku narzedzi.
Jesli ten przetacznik jest wybrany, mozna rozwina¢ drzewo, aby wyswietli¢ takze deskryptory.

Ocenianie kategorii

Kolumna Docs. w tabeli drzewa kategorii wyswietla liczbg dokumentéw Iub rekordow, ktdre sa przypisane do tej
konkretnej kategorii. Jesli liczby sa nieaktualne lub nie sa obliczone, w kolumnie tej wyswietlana jest ikona. Mozna
klikna¢ przycisk Score na pasku narzedzi panelu, aby ponownie obliczy¢ liczbe dokumentow. Nalezy pamigtac, ze w
przypadku pracy z duzymi zbiorami danych proces oceniania moze zaja¢ duzo czasu.

Wybieranie kategorii w drzewie
Dokonujac wyboru w drzewie, mozna wybiera¢ tylko kategorie rownorzedne — tj. jesli wybierzesz kategorie
najwyzszego poziomu, nie mozesz wybra¢ podkategorii. A jesli wybierzesz 2 podkategorie danej kategorii, nie mozesz

réwnoczesnie wybra¢ podkategorii innej kategorii. Proba wybrania nieciaglego zestawu kategorii spowoduje utrate
poprzedniego wyboru.
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Wyswietlanie paneli Data i Visualization

Po wybraniu wiersza w tabeli mozna klikna¢ przycisk Display, aby od$wiezy¢ panele Visualization i Data z
uwzglednieniem informacji wynikajacych z dokonanego wyboru. Jesli panel nie jest widoczny, kliknigcie przycisku
Display spowoduje wyswietlenie panelu.

Optymalizacja kategorii

Kategoryzacja za pierwszym razem moze nie przynies$¢ idealnych wynikdéw i moga pojawic si¢ kategorie, ktore
zechcesz usuna¢ lub potaczy¢ z innymi kategoriami. Moze rowniez okazac si¢ — po dokonaniu przegladu wynikow
wyodrebniania — Ze istnieja kategorie, ktdre nie zostaly utworzone, a bytyby przydatne. W takiej sytuacji mozna
wprowadzi¢ reczne zmiany do wynikow, aby lepiej dostosowacé je do konkretnego kontekstu. Wigcej informacji
zawiera temat[“Edytowanie i optymalizacja kategorii” na stronie 130}

Metody i strategie tworzenia kategorii

Jesli jeszeze nie przeprowadzono wyodrgbniania lub wyniki wyodrgbniania sa nieaktualne, proba uzycia jednej z
technik budowania lub uzupetniania kategorii spowoduje wyswietlenie monitu o przeprowadzenie wyodrgbniania. Po
zastosowaniu wybranej techniki pojecia i typy pogrupowane w kategorig nadal moga by¢ wykorzystywane do
tworzenia kategorii przy uzyciu innych technik. Oznacza to, ze jedno pojecie moze wystapi¢ w wielu kategoriach,
chyba ze wprost zabroniono ich ponownego wykorzystania.

Przestrzeganie ponizszych wskazdéwek pomoze w tworzeniu optymalnych kategorii:
* Metody tworzenia kategorii

* Strategie tworzenia kategorii

* Porady dotyczace tworzenia kategorii

Metody tworzenia kategorii

Poniewaz kazdy zestaw danych jest inny, liczba metod tworzenia kategorii i kolejnos¢ ich stosowania moze si¢ z
czasem zmienia¢. Ponadto, poniewaz takze cele eksploracji roznych zbioréw danych moga by¢ rdzne, niekiedy
konieczne jest eksperymentowanie z réznymi metodami w celu wybrania tej, ktora przyniesie najlepsze rezultaty
analizy konkretnych danych tekstowych. Zadna z technik automatycznych nie zapewni idealnej kategoryzacji danych;
dlatego zalecamy wyprobowanie roznych technik automatycznych i stosowanie tych, ktére najlepiej sprawdzaja si¢
przy pracy z konkretnymi danymi.

Oprocz zastosowania pakietow analizy tekstu (TAP, *.zap) z gotowymi zestawami kategorii mozna takze

kategoryzowac¢ odpowiedzi przy uzyciu dowolnej kombinacji nast¢pujacych metod.

* Techniki budowania automatycznego. Dostepnych jest kilka opcji automatycznego tworzenia kategorii na
podstawie analizy lingwistycznej lub analizy liczebnosci wystapien. Wigcej informacji zawiera temat
[kategorii” na stronie 101|

* Techniki uzupelniania automatycznego. Dostgpnych jest kilka technik lingwistycznych umozliwiajacych
uzupehnianie istniejacych kategorii o nowe lub ulepszone deskryptory, tak aby wychwytywaly wigcej rekordow.
Wigcej informacji zawiera temat [‘Uzupelnianie kategorii” na stronie 110}

* Techniki reczne. Istnieje kilka technik recznych, takich jak przeciaganie i upuszczanie. Wigcej informacji zawiera
temat [‘Reczne tworzenie kategorii” na stronie 113|

Strategie tworzenia kategorii

Ponizsza lista strategii w zadnej mierze nie nie jest wyczerpujaca, ale daje ogdlne pojecie o mozliwych podejsciach do

procesu budowania kategorii.

* Gdy definiujesz wezet Text Mining, wybierz zestaw kategorii z pakietu analizy tekstu (TAP), aby na poczatku
analizy mie¢ juz do dyspozycji pewne gotowe kategorie. Mozliwe, ze kategorie te wystarcza do zadowalajace;j
kategoryzacji tekstu. Jesli jednak chcesz dodac wigeej kategorii, mozesz edytowaé ustawienia budowania kategorii
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(Categories > Build Settings). Otworz okno dialogowe Advanced Settings: Linguistics i wybierz opcj¢ danych
wejsciowych do tworzenia kategorii Unused extraction results, a nastgpnie zbuduj dodatkowe kategorie.

* Gdy definiujesz wezet, wybierz zestaw kategorii z pakietu TAP w widoku Categories and Concepts na
interaktywnym pulpicie roboczym. Nastepnie przeciagaj i upuszczaj nieuzywane pojecia lub wzorce do kategorii,
tak jak uznasz to za stosowne. Teraz uzupelnij istniejace i zmodyfikowane wlasnie kategorie (Categories > Extend
Categories), aby uzyskac wigcej deskryptorow zwiazanych z istniejacymi deskryptorami kategorii.

* Zbuduj kategorie automatycznie, korzystajac z zaawansowanych ustawien lingwistycznych (Categories > Build
Categories). Nastgpnie recznie zoptymalizuj kategorie, usuwajac deskryptory, usuwajac kategorie lub scalajac
podobne kategorie az do uzyskania zadowalajacych definicji kategorii. Ponadto, jesli pierwotnie kategorie
zbudowano bez uzycia opcji Generalize with wildcards where possible, mozesz podjac¢ probe automatycznego
uproszczenia kategorii za pomoca opcji Generalize.

» Zaimportuj predefiniowany plik kategorii z bardzo opisowymi nazwami kategorii i/lub adnotacjami. Ponadto, jesli
pierwotnie przeprowadzano import bez opcji importowania lub generowania deskryptoréw na podstawie nazw
kategorii, mozesz pozniej przejs¢ do okna dialogowego Extend Categories i wybrac opcj¢ Extend empty categories
with descriptors generated from the category name . Nastepnie ponownie uzupelnij te kategorie, ale tym razem
korzystaj z technik grupowania.

* Recznie utwoérz pierwszy zestaw kategorii, sortujac pojecia lub wzorce poje¢ wedtug liczebnosci, a nastgpnie
przeciagajac i upuszczajac najbardziej interesujace w panelu Categories. Po zapisaniu pierwszego zestawu kategorii
uzyj funkcji Extend (Categories > Extend Categories) w celu uzupeinienia i zoptymalizowania wszystkich
wybranych kategorii, aby uwzglednialy inne powiazane deskryptory i w efekcie znajdowaly wigcej rekordow.

Zalecamy, aby po zastosowaniu tych technik dokona¢ przegladu wynikowych kategorii 1 recznie wprowadzi¢ drobne
korekty, usuna¢ wszelkie btedy w klasyfikacji lub doda¢ pominigte rekordy lub wyrazy. Ponadto, poniewaz uzycie
kilku réznych technik moze doprowadzi¢ do powstania nadmiarowych kategorii, mozna takze scali¢ lub usuna¢ zbedne
kategorie. Wiecej informacji zawiera temat[“Edytowanie i optymalizacja kategorii” na stronie 130}

Porady dotyczace tworzenia kategorii

Aby utatwi¢ uzytkownikom tworzenie optymalnych kategorii, przedstawiamy pewne wskazowki, ktore moga pomdc w
podejmowaniu decyzji o wyborze strategii dziatania.

Wskazowki dotyczace wspotczynnika kategorie/dokumenty

Kategorie, do ktorych dokumenty i rekordy sa przypisywane, rzadko wykluczaja si¢ wzajemnie w jako$ciowej analizie
tekstu. Jest to spowodowany co najmniej dwiema przyczynami:

* Po pierwsze, z reguly im dtuzszy tekst w dokumencie lub rekordzie, tym bardziej jednoznaczne idee i opinie wyraza.
Dlatego prawdopodobienstwo, ze dokument lub rekord zostanie przypisany do wielu kategorii, jest znacznie
wieksze.

* Po drugie, czesto istnieja rozne sposoby pogrupowania i interpretacji dokumentow lub rekordéw tekstowych, a
sposoby te nie sa logicznie odrgbne. W przypadku ankiety z pytaniem otwartym o przekonania polityczne
respondenta moglibysmy utworzyc¢ takie kategorie, jak Liberal i Conservative albo Republican 1 Democrat, a takze
bardziej szczegotowe kategorie, takie jak Socially Liberal, Fiscally Conservative itd. Te kategorie nie musza by¢
wzajemnie wykluczajace sig i doktadne.

Wskazowki dotyczace liczby kategorii do utworzenia

Kategorie powinny wynikaé¢ bezposrednio z danych — widzac co$ ciekawego w danych, mozna utworzy¢ kategorig

reprezentujaca t¢ informacje. W ogdlnym przypadku nie ma zalecanego gornego limitu liczby kategorii, ktore mozna

utworzy¢. Istnieje mozliwo$¢ utworzenia zbyt wielu kategorii, by dato si¢ z nimi pracowa¢. Obowiazuja dwie zasady:

* Liczebnos¢ kategorii. Aby kategoria byta uzyteczna, musi zawiera¢ minimalna liczbg dokumentow lub rekordow.
Jeden lub dwa dokumenty moga zawierac cos$ bardzo intrygujacego, ale jesli sa to tylko nieliczne z 1000
dokumentéw, to zawarte w nich informacje moga nie by¢ wystarczajaco czgste w populacji, by byty praktycznie
uzyteczne.
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» Zlozonos$¢. Im wigcej kategorii utworzysz, tym wigcej musisz przejrzec i podsumowac po zakonczeniu analizy.
Jednak zbyt wiele kategorii moze tylko skomplikowac prace, nie wnoszac uzytecznych szczegotow.

Niestety, nie ma regut pozwalajacych okreslic, ile kategorii to ,,zbyt wiele”, ani jaka jest minimalna liczba rekordow w
kategorii. Takich ustalen trzeba dokonac¢ na podstawie konkretnej sytuacji i potrzeb.

Mamy jednak kilka wskazéwek utatwiajacych rozpoczecie pracy. Pomimo tego, ze liczba kategorii nie powinna by¢
zbyt duza, na wezesnych etapach analizy lepiej jest mie¢ za duzo niz za mato kategorii. Latwiej jest grupowac
kategorie, ktére sa wzglednie podobne do siebie, niz dzieli¢ obserwacje miedzy nowe kategorie, dlatego strategia pracy
od wigkszej do mniejszej liczby kategorii jest zwykle najlepsza. Ze wzgledu na iteracyjny charakter eksploracji tekstu
oraz tatwos¢, z jaka mozna ja prowadzi¢ za pomoca tego programu oprogramowania, stworzenie na poczatku wigkszej
liczby kategorii jest w petni akceptowalne.

Wybor najlepszych deskryptoréw

Ponizej przedstawiamy wytyczne dotyczace wybierania i optymalnego tworzenia deskryptorow kategorii (pojgc,
typow, wzorcow TLA i regut kategorii). Deskryptory sa elementami sktadowymi kategorii. Gdy niektdre lub wszystkie
elementy tekstu w dokumencie lub rekordzie pasuja do deskryptora, ten dokument lub rekord jest przypisywany do
kategorii zawierajacej deskryptor.

Jesli deskryptor nie odpowiada wyodregbnionemu pojeciu lub wzorcowi, nie zostanie on dopasowany do zadnych
dokumentéw ani rekordéw. Dlatego nalezy uzywac pojeé, typow, wzorcow i regut kategorii tak, jak opisano w
ponizszych akapitach.

Poniewaz pojgcia reprezentuja nie tylko same siebie, lecz rowniez zestaw powiazanych termindw, np. formy
pojedyncze/mnogie, synonimy i odmiany pisowni, to wylacznie samo pojgcie powinno by¢ deskryptorem lub czgscia
deskryptora. Aby dowiedzie¢ si¢ wigcej na temat terminéw danego pojecia, nalezy klikna¢ nazwe pojgcia w panelu
Extraction Results w widoku Categories and Concepts. Po zatrzymaniu wskaznika myszy nad nazwa pojgcia pojawi si¢
podpowiedz z terminami znalezionymi w tekscie podczas ostatniego wyodrebniania. Nie wszystkie pojecia zawieraja
terminy. Na przyktad, jesli car i vehicle sa synonimami, ale car wyodrebniono jako pojecie zawierajace termin
vehicle, to w deskryptorze nalezy uzy¢ tylko pojecia car, poniewaz zostanie ono dopasowane automatycznie takze do
dokumentéw lub rekordéw zawierajacych termin vehicle.

Pojgcia i typy jako deskryptory

Uzyj pojecia jako deskryptora, jesli chcesz znalez¢ wszystkie dokumenty lub rekordy zawierajace pojgcie (lub dowolne
z jego termindw). W tym przypadku stosowanie bardziej ztozonych regut kategorii nie jest konieczne, poniewaz
dostowna nazwa pojecia jest wystarczajaca. Nalezy pamigtaé, ze w przypadku uzycia zasobow, ktére wyodregbniaja
opinie, niekiedy pojgcia moga zmieni¢ sig¢ podczas wyodrebniania wzorcéw TLA w celu wychwycenia rzeczywistego
sensu zdania (w nastgpnej sekcji zamieszczono przyktad analizy TLA).

Na przyktad na podstawie odpowiedzi respondentow opisujacych ich ulubione owoce, takich jak ,,Apple and pineapple
are the best”, moglyby zosta¢ wyodrebnione wyrazy apple i pineapple. Jesli dodasz pojgcie apple jako deskryptor do
kategorii, wszystkie odpowiedzi z pojeciem apple (lub dowolnym z jego terminéw) beda przypisywane do tej
kategorii.

Jesli jednak chcesz wiedzie¢, w ktorych odpowiedziach pojecie apple wystepuje w jakimkolwiek kontekscie, mozesz
napisa¢ np. regute kategorii * apple *, ktéra wychwyci takze odpowiedzi zawierajace takie pojecia, jak apple, apple
sauce lub french apple tart.

Mozna réwniez wychwyci¢ wszystkie dokumenty lub rekordy, ktore zawieraja pojecia tego samego typu, podajac
bezposrednio typ jako deskryptor (np. <Fruit>). Nalezy pamigta¢, ze nie mozna uzywa¢ znaku * z typami.

Wiecej informacji zawiera temat[“Wyniki wyodrebniania: pojecia i typy” na stronie 79|

Wzorce analizy powiazan w tekscie (TLA) jako deskryptory
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Zastosowanie wzorca TLA jako deskryptora jest celowe, gdy chcemy wychwytywac¢ zniuansowane idee wyrazone nie
wprost. Podczas wyodrebniania TLA tekst jest przetwarzany zdanie po zdaniu lub klauzula po klauzuli, a nie
catosciowo (jako caty dokument lub rekord). Jednoczesne uwzglednienie wszystkich czgsci zdania umozliwia
zidentyfikowanie np. opinii, relacji migdzy dwoma elementami lub negacji, a tym samym trafniejsze wychwycenie
rzeczywistego sensu zdania. Istnieje mozliwo$¢ uzycia wzorcow pojec lub wzorcoéw typow jako deskryptorow. Wigcej
informacji zawiera temat[“Wzorce typéw i poje¢” na stronie 141}

Jesli na przyktad mamy tekst "the room was not that clean", to moglyby zosta¢ wyodrgbnione pojecie: room i clean.
Jesli jednak wiaczone jest wyodrebnianie TLA, to analiza TLA moze wykry¢, ze warto$¢ clean zostata uzyta w
kontekscie negacji i w rzeczywistosci oznacza not clean, co jest synonimem pojecia dirty. Widzimy, ze uzycie samego
pojecia clean jako deskryptora spowodowatoby wychwycenie tego tekstu, ale takze innych dokumentow lub rekordéw,
w ktorych mowa o czystosci. Z tego powodu lepszym rozwiazaniem moze by¢ uzycie wzorca pojecia TLA z pojeciem
wynikowym dirty, poniewaz ono takze pasuje do naszego tekstu, a prawdopodobnie jest bardziej odpowiednim
deskryptorem.

Reguty biznesowe kategorii jako deskryptory

Reguty kategorii sa instrukcjami, ktére automatycznie klasyfikuja dokumenty lub rekordy w kategorie na podstawie
wyrazenia logicznego, uzywajac wyodrebnionych pojec¢, typdw i wzorcéw oraz operatoréw boolowskich. Na przyktad,
mozna napisa¢ wyrazenie, ktore oznacza uwzglednij w tej kategorii wszystkie rekordy zawierajqce wyodrebnione
pojecie embassy, ale nie argentina.

Mozna zapisywac i stosowac reguly kategorii jako deskryptory w kategorii, aby wyrazi¢ kilka réznych idei. Stuza do
tego operatory boolowskie &, | i !() . Szczegdétowe informacje o sktadni regut oraz sposobie ich pisania i edytowania
zawiera sekcja [“Korzystanie z regut kategorii” na stronie 114]

* Uzycie regut kategorii z operatorem boolowskim & (AND) ulatwia znajdowanie dokumentéw lub rekordow, w
ktorych wystgpuja co najmniej 2 pojecia. Aby nastapito dopasowanie do kategorii, dwa lub wigcej pojec
potaczonych operatorami & nie musi wystgpowa¢ w tym samym zdaniu lub frazie, ale moze wystapi¢ w dowolnym
miejscu tego samego dokumentu lub rekordu. Na przyktad, jesli jako deskryptor utworzymy regute kategorii food &
cheap, to znajdzie ona rekord zawierajacy tekst ,,the food was pretty expensive, but the rooms were cheap”, mimo
ze to nie rzeczownik food zostat okreslony mianem cheap. Dopasowanie wynika po prostu z obecnosci wyrazow
food i cheap.

» Uzywajac jako deskryptora reguly kategorii z operatorem boolowskim !() (NOT), mozna znalez¢ dokumenty lub
rekordy, w ktorym niektore elementy wystepuja, a inne nie. W ten sposob mozna unikna¢ grupowania informacji,
ktére wydaja si¢ powiazane na podstawie wyrazow, ale nie kontekstu. Na przyktad, jesli utworzysz jako deskryptor
regule kategorii <Organization> & !(ibm), to znajdzie ona tekst SPSS Inc. was a company founded in 1967, ale nie
tekst the software company was acquired by IBM..

» Uzycie regut kategorii z operatorem boolowskim| (OR) utatwia znajdowanie dokumentéw lub rekordéw, w ktorych
wystepuje jedno z kilku pojec i lub jeden z kilku typéw. Na przyktad, jesli utworzysz jako deskryptor regulte
kategorii (personnel|staffiteam|coworkers) & bad, to znajdzie ona kazdy dokument lub rekord, w ktorym
dowolny z tych rzeczownikdéw wystepuje razem z pojeciem bad.

* Uzyj typoéw w regutach kategorii, aby uczyni¢ je bardziej ogolnymi potencjalnie fatwiejszymi do wdrozenia.
Zatézmy, ze operujesz na danych dotyczacych hotelu i chcesz dowiedzie¢ sig, co klienci mys$la o personelu hotelu.
Do termindéw powiazanych z tym zagadnieniem naleza np. receptionist, waiter, waitress, reception desk, front desk
itd. W takim przypadku mozesz utworzy¢ nowy typ o nazwie <HotelStaff> i doda¢ wszystkie powyzsze terminy do
tego typu. Wprawdzie mozna utworzy¢ jedna regute kategorii dla kazdego rodzaju personelu, na przyktad [*
waitress * & nice], [* desk * & friendly], [* receptionist * & accommodating], mozna tez utworzy¢ bardziej
0golna regute kategorii w oparciu o typ more generic <HotelStaff>, aby wychwytywaé wszystkie pozytywne opinie
o personelu hotelu: [<HotelStaff> & <Positive>].

Uwaga: Stosujac wzorce TLA w regutach kategorii, mozna uzywac zaréwno +, jak i & Wigcej informacji zawiera
temat [‘Uzywanie wzorcow TLA w regulach kategorii” na stronie 116]

Przyktady réznic migdzy dopasowywaniem pojeé¢, wzorcoéw TLA i regul kategorii
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Ponizszy przyktad ilustruje wplyw uzycia pojgcia, reguly i wzorca TLA jako deskryptora na kategoryzacje
dokumentéw lub rekordow. Zatdézmy, ze masz 5 ponizszych rekordow.

* A: "awesome restaurant staff, excellent food and rooms comfortable and clean."
* B: "restaurant personnel was awful, but rooms were clean."

* C: "Comfortable, clean rooms."

* D: "My room was not that clean."

* E: "Clean."

Poniewaz rekordy zawieraja stowo clean i chcesz wychwyci¢ tg informacjg, mozesz utworzy¢ jeden z deskryptorow
przedstawionych w ponizszej tabeli. W zaleznosci od idei, ktora chcesz wychwyci¢, mozesz wybiera¢ deskryptory
generujace rozne wyniki.

Tabela 17. W jaki sposob przyktadowe rekordy zostaty dopasowane do deskryptoréw.

Deskryptor \%4 P V4 D E Objasnienie

clean match match match match match Deskryptor jest wyodrgbnionym pojeciem.
Kazdy rekord zawieral pojecie clean,
nawet rekord D, poniewaz bez analizy
TLA nie wiadomo, ze ,,not clean” oznacza
w istocie dirty.

clean +. - - - - match Deskryptor jest wzorcem TLA
reprezentujacym samo pojecie clean.
Zostanie dopasowany tylko do rekordu, w
ktérym clean wyodrebniono bez
powiazanego pojecia podczas analizy
TLA.

[clean] match match match - match Deskryptor jest regula kategorii szukajaca
reguly TLA zawierajacej pojgcie clean
(samo lub w potaczeniu z innymi).
Dopasowane zostaty wszystkie rekordy,
ktorych wyniki TLA zawieraty clean,
niezaleznie od tego, czy pojecie clean
byto powiazane z innym pojeciem, takim
jak room, i niezaleznie od tego, na ktorej
byto pozycji.

Informacje o kategoriach

Kategorie dotycza grupy blisko powiazanych pojec¢, opinii lub postaw. Aby kategoria byta przydatna, powinna
umozliwia¢ tatwe opisanie za pomoca krotkiego zwrotu lub etykiety, ktora oddaje jej znaczenie.

Na przyktad: jesli analizowane sa odpowiedzi w ankiecie przeprowadzonej wsrod konsumentow dotyczacej nowego
proszku do prania, mozna utworzy¢ kategorig z etykieta odor, ktéra zawiera wszystkie odpowiedzi opisujace zapach
produktu. Jednak taka kategoria nie rozréznitaby pomigdzy osobami, ktdre uwazaty zapach za mity i takimi, ktore
uwazaly przeciwnie. Poniewaz produkt IBM SPSS Modeler Text Analytics moze wyodrebnia¢ opinie, kiedy uzywane
sa odpowiednie zasoby, mozna utworzy¢ dwie inne kategorie, aby identyfikowac respondentdw, ktorym podobat sie
zapach i respondentow, ktorym nie podobat sie zapach.

Kategorie mozna utworzy¢ i obstugiwaé¢ w panelu Categories w lewym gérnym rogu widoku Categories and Concepts .
Kazda kategoria jest definiowana przez jeden lub wiele deskryptorow. Deskryptory to pojgcia, typy i wzorce, jak
rowniez reguty kategorii, ktore zostaty uzyte do zdefiniowania kategorii.

Aby zobaczy¢ deskryptory, ktore tworza dana kategorig, kliknij ikong otdéwka na pasku narzedzi panelu Categories, a

nastegpnie rozwin drzewo, aby zobaczy¢ deskryptory. Mozna tez wybra¢ kategorig i otworzy¢ okno dialogowe Category
Definitions (View > Category Definitions).
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Kiedy budujesz kategorie automatycznie, uzywajac technik budowania kategorii, takich jak wtaczenie pojecia, techniki
beda uzywac pojec i typow jako deskryptordw, aby tworzy¢ kategorie. Jesli wyodrgbniasz wzorce TLA, mozesz
rowniez dodawa¢ wzorce lub czgsci tych wzorcdw jako deskryptory kategorii. Wigcej informacji zawiera
[‘Eksplorowanie analizy powiazan w tekscie”, na stronie 139] Jesli budujesz grupy, mozesz doda¢ pojecia w grupie do
nowych lub istniejacych kategorii. Mozna tez recznie utworzy¢ reguly kategorii, aby uzywac ich jako deskryptorow w
swoich kategoriach. Wiecej informacji zawiera temat|Korzystanie z regut kategorii” na stronie 114}

Wiasciwosci reguty
Oprocz deskryptorow kategorie maja takze wlasciwosci, ktore mozna edytowac, aby zmienia¢ nazwy kategorii,
dodawac etykiety, dodawac¢ adnotacje.

Istnieja nastepujace wiasciwosci:

* Name. Ta nazwa jest domyslnie wyswietlana w drzewie. Kategoriom tworzonym przy uzyciu technik
automatycznych nazwy nadawane sa automatycznie.

* Label. Etykiety umozliwiaja utworzenie bardziej czytelnych opiséw kategorii, ktore mozna wykorzysta¢ w innych
programach, tabelach lub na wykresach. Wybranie opcji wyswietlania etykiet powoduje, ze kategoria bedzie w
interfejsie oznaczona ta etykieta.

* Code. Numer kodowy odpowiadajacy wartosci kodowej tej kategorii. .

* Annotation. W tym polu do kazdej kategorii mozna doda¢ krétki opis. Gdy kategoria jest generowana za pomoca
okna Build Categories, do tej adnotacji automatycznie dodawana jest notatka. Mozna tez dodac¢ do adnotacji
przyktadowy tekst bezposrednio z panelu Data, zaznaczajac tekst i wybierajac z menu opcjg Categories > Add to
Annotation.

Panel Data

Podczas tworzenia kategorii moze wystapi¢ potrzeba przejrzenia niektérych danych tekstowych, z ktérym pracujesz.
Na przyktad, jesli utworzysz kategorig, do ktorej nalezy 640 dokumentow, interesujaca moze by¢ tres¢ tych
dokumentdéw i faktyczne brzmienie tekstu. Istnieje mozliwos¢ przegladania rekordow lub dokumentéw w panelu Data,
ktéry znajduje si¢ w prawym dolnym rogu. Jesli domyslnie panel ten nie jest wyswietlony, z menu wybierz kolejno
opcje View > Panes > Data.

W panelu Data wys$wietlany jest jeden wiersz na kazdy dokument Iub rekord odpowiadajacy wyborom dokonanym na
panelu Categories, panelu Extraction Results lub oknie dialogowym Category Definitions, przy czym liczba wierszy
nie moze przekroczy¢ okreslonego limitu. Domys$lnie liczba dokumentéw lub rekordow wyswietlanych w panelu Data
jest ograniczona, aby mozliwe bylo szybsze wyswietlanie danych. Mozna jednak zmieni¢ t¢ liczbe w oknie
dialogowym Options. W przypadku bardzo duzych zbioréw danych szybko$¢ wyswietlania moze by¢ zwigkszona przez

wylaczenie opcji, aby wyswietli¢ kategorie. Wigcej informacji zawiera temat|“0kno dialogowe Options: karta Session”|
_

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej rekordow, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czegsci panelu, aby przeglada¢ rekordy, lub wprowadzi¢ numer strony i przejs¢ do niej.

Wyswietlanie i od§wiezanie panelu Data

Panel Data nie jest od$wiezany automatycznie, poniewaz w przypadku wigkszych zbioréw danych automatyczne
ods$wiezanie mogloby by¢ czasochlonne. Oznacza to, ze za kazdym razem, gdy dokonasz wyboru w innym panelu w
tym widoku lub w oknie dialogowym Category Definitions, musisz klikna¢ przycisk Display, aby odswiezy¢ zawartos¢
panelu Data.

Dokumenty lub rekordy tekstowe

Jesli dane tekstowe maja posta¢ rekordow, a tekst jest stosunkowo kroétki, to zmienna tekstowa w panelu Data zawiera

cate dane tekstowe. Jednak podczas pracy z rekordami i wigkszymi zbiorami danych w kolumnie zmiennej tekstowej
wyswietlany jest krotki fragment tekstu, a w panelu Text Preview po prawej stronie wyswietlana jest wigksza czgs$¢ lub
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catos¢ tekstu z rekordu zaznaczonego w tabeli. Jesli dane tekstowe maja posta¢ odrebnych dokumentéw, to w panelu
Data wyswietlana jest nazwa pliku dokumentu. Po wybraniu dokumentu otwierany jest panel Text Preview z tekstem
zaznaczonego dokumentu.

Kolory i wyroznienia

W wyswietlanych danych pojecia i deskryptory znalezione w dokumentach lub rekordach sa wyrézniane kolorami, aby
latwiej bylo je odszuka¢ w tekscie. Kolory odpowiadaja typom poje¢. Mozna takze zatrzymac wskaznik myszy nad
elementem oznaczonym kolorem, aby wyswietli¢ nazwe pojecia, pod ktorym dany termin zostat wyodrebniony, oraz
typ, do ktérego zostatl przypisany. Tekst niewyodrebniony jest wyswietlany kolorem czarnym. Te niewyodrebnione
wyrazy sa zwykle spdjnikami (and lub with), zaimkami (me lub they) oraz czasownikami (is, have lub take).

Kolumny panelu Data

Kolumna zmiennej tekstowej jest widoczna zawsze, ale mozna tez wyswietli¢ inne kolumny. Aby wyswietli¢ inne
kolumny, wybierz z menu opcje View > Data Pane, a nastgpnie wybierz kolumneg, ktdra chcesz wyswietlic w panelu
Data. Do wyswietlania moga by¢ dostgpne nastgpujace kolumny:

* "Text field name" (#)/Documents Dodaje kolumng z danymi tekstowymi, z ktérych wyodrebnione byty pojgcia i
typy. Jesli dane sa zawarte w dokumentach, kolumna nosi nazwg Dokumenty i widoczna jest tylko nazwa
dokumentu lub petna $ciezka. Wiasciwy tekst z dokumentow jest widoczny w panelu Text Preview. Po nazwie tej
kolumny podana jest w nawiasach liczba wierszy w panelu Data. Niekiedy nie beda wyswietlane wszystkie
dokumenty lub rekordy. Wynika to z limitu ustawionego w oknie dialogowym Options, ktéry wprowadza si¢ w celu
przyspieszenia tadowania. Po osiagnigciu limitu po liczbie pojawi si¢ dopisek - Max. Wigcej informacji zawiera
temat|“0kno dialogowe Options: karta Session” na stronie 7Sl

» Categories Zawiera listg wszystkich kategorii, do ktorych nalezy rekord. Gdy ta kolumna jest widoczna,
odswiezanie panelu Data w celu wyswietlenia najbardziej aktualnych informacji moze trwac¢ nieco dhuze;j.

* Relevance Rank Zawiera rangi poszczegolnych rekordow w jednej kategorii. Ranga informuje o tym, jak dobrze
dany rekord pasuje do kategorii na tle innych rekordow w tej samej kategorii. Aby wyswietli¢ range, wybierz
kategorie w panelu Categories (lewym gérnym). Wigcej informacji zawiera temat|“Istotno$é kategorii’]

* Category Count Zawiera liczbg kategorii, do ktérych nalezy rekord.

Istotnos¢ kategorii

Aby budowac lepsze kategorie, mozesz przeglada¢ istotnos¢ dokumentdéw lub rekordéw w kazdej kategorii, a takze
istotno$¢ wszystkich kategorii, do ktorych nalezy dokument lub rekord.

Istotnos¢ przypisania kategorii do rekordu

Za kazdym razem, gdy dokument lub rekord pojawia si¢ w panelu Data, wszystkie kategorie, do ktorych nalezy, sa

wymienione w kolumnie Categories. Gdy dokument lub rekord nalezy do wielu kategorii, kategorie w tej kolumnie sa
wyswietlane w kolejnosci od najbardziej do najmniej istotnych dopasowan. Pierwsza kategoria na liscie to z zatozenia
ta, ktora najlepiej pasuje do tego dokumentu lub rekordu. Wigcej informacji zawiera temat|“Panel Data” na stronie 99|

Istotnos$ci przypisania rekordu do kategorii

Po wybraniu kategorii mozna sprawdzic istotno$¢ kazdego z rekordow w kolumnie Relevance Rank w panelu Data.
Ten ranking istotnosci okresla, na ile dobrze dokument lub rekord pasuje do wybranej kategorii w poréwnaniu z innymi
rekordami w tej kategorii. Aby wyswietli¢ ranking rekordéw dla pojedynczej kategorii, nalezy wybrac tg kategorig w
panelu Categories (lewy gorny panel), a ranga dokumentu lub rekordu pojawi si¢ w kolumnie. Ta kolumna domyslnie
niewidoczna, ale mozna ja wyswietli¢. Wiecej informacji zawiera temat[‘Panel Data” na stronie 99|

Im nizsza liczbowa ranga rekordu, tym lepsze dopasowanie lub wigksza istotnos¢ tego rekordu w wybranej kategorii,
zatem | oznacza najlepsze dopasowanie. Jesli wigcej niz jeden rekord ma taka sama istotnos¢, kazda pojawia sig z ta
sama ranga i znakiem réwnosci (=), co oznacza, ze istotnosci sa rowne. Na przyklad moga pojawi¢ si¢ rangi 1=, 1=, 3,
4 itd., co bedzie oznaczac, ze istnieja dwa rekordy uznane za najlepiej dopasowane do tej kategorii.
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Wskazowka: Mozna dodac tekst z najbardziej istotnego rekordu do adnotacji kategorii jako jej opis. Tekst mozesz
dodac bezposrednio w panelu Data, zaznaczajac tekst 1 wybierajac z menu opcje Categories > Add to Annotation.

Tworzenie kategorii

Cho¢ mozna korzystac z kategorii zawartych w pakiecie analizy tekstu, mozna rowniez utworzy¢ kategorie
automatycznie, korzystajac z szeregu technik lingwistycznych i opartych na okreslaniu liczebnosci wystapien. W oknie
dialogowym Build Categories Settings mozna zastosowa¢ zautomatyzowane techniki lingwistyczne i oparte na
okreslaniu liczebnosci, aby utworzy¢ kategorie na podstawie pojec lub wzorcodw pojec.

W ogo6lnym wypadku kategoria moze sktada¢ sig¢ z rdznych rodzajéw deskryptorow (typow, pojec, wzorcoéw TLA,
regut kategorii). Podczas tworzenia kategorii za pomoca technik zautomatyzowanych wynikowe kategorie otrzymuja
nazwy na podstawie pojeé lub wzorcow pojec (w zaleznosci od wybranych danych wejsciowych), a kazda kategoria
zawiera zestaw deskryptorow. Te deskryptory moga mie¢ postac regut, kategorii lub pojeé i uwzgledniac¢ wszystkie
pojgcia pokrewne wykryte za pomoca technik.

Po zbudowaniu kategorii mozna dowiedzie¢ si¢ wiele na ich temat, przegladajac je w panelu Categories i eksplorujac je
na wykresach i w tabelach. Nastgpnie mozna zastosowac¢ techniki reczne, aby wprowadzi¢ drobne korekty, usuna¢
wszelkie bledy w klasyfikacji lub doda¢ pominigte rekordy lub wyrazy. Po zastosowaniu wybranej techniki pojgcia,
typy 1 wzorce pogrupowane w kategori¢ nadal moga by¢ wykorzystywane do tworzenia kategorii przy uzyciu innych
technik. Ponadto, poniewaz uzycie kilku réznych technik moze doprowadzi¢ do powstania nadmiarowych lub
niewlasciwych kategorii, mozna takze scali¢ lub usunac zbg¢dne kategorie. Wigcej informacji zawiera temat
[‘Edytowanie i optymalizacja kategorii” na stronie 130|

Wazne! We wczesniejszych wersjach produktu reguly wspotwystgpowania i synonimow byly ujmowane w nawiasy
kwadratowe. W tej wersji nawiasy kwadratowe oznaczaja wzorzec wynikowy analizy powiazan w tekscie. Natomiast
reguly wspotwystepowania i synoniméw sa ujmowane w nawiasy okragle, na przyklad (speaker systems|speakers).

Aby tworzy¢ kategorie

1. Z menu wybierz opcje Categories > Build Categories. O ile nie wytaczono wszystkich monitéw, zostanie
wyswietlony komunikat.

2. Wybierz, czy chcesz utworzy¢ kategorie teraz, czy najpierw edytowac ustawienia.

» Kliknij przycisk Build Now, aby rozpocza¢ tworzenie kategorii przy uzyciu biezacych ustawien. Ustawienia
wybrane domyslnie sa czgsto wystarczajace do rozpoczecia procesu klasyfikowania. Proces tworzenia kategorii
rozpocznie si¢ i zostanie wyswietlone okno dialogowe postgpu.

» Kliknij przycisk Edit, aby przejrze¢ i zmodyfikowa¢ ustawienia budowania.

Uwaga: Maksymalna liczba kategorii, ktore moga by¢ wyswietlane, wynosi 10 000. Osiagnigcie lub przekroczenie tej
liczby spowoduje wyswietlenie ostrzezenia. W takiej sytuacji nalezy zmieni¢ opcje tworzenia lub uzupetniania
kategorii, aby ograniczy¢ liczbe tworzonych kategorii.

Wejscia

Kategorie sa tworzone na podstawie deskryptoréw wywiedzionych ze wzorcéw typdw lub z typoéw. W tej tabeli mozna
wybra¢ pojedyncze typy obiektow lub wzorce, ktdre maja zosta¢ uwzglednione w procesie tworzenia kategorii.

Type patterns. Jesli wybierzesz wzorce typdw, kategorie beda budowane na podstawie wzorcow, a nie samych typow
lub pojeé. Dzigki temu skategoryzowane zostana rekordy lub dokumenty zawierajace wzorzec pojecia nalezacy do
wybranego wzorca typu. Zatem, jesli w tabeli wybierzesz wzorzec typu <Budget> i <Positive>, to moga zosta¢
wygenerowane takie kategorie, jak cost & <Positive> lub rates & excellent.

W przypadku zastosowania wzorcow typow jako danych wejsciowych dla automatycznego budowania kategorii w
niektorych przypadkach techniki moga budowac strukturg kategorii na rézne, alternatywne sposoby. Z technicznego
punktu widzenia nie ma jedynie stusznej struktury kategorii, jednak niektdre struktury kategorii moga by¢ lepiej niz
inne dostosowane do konkretnych potrzeb analitycznych. Aby wptyna¢ na uzyskiwane wyniki, mozna wyznaczy¢
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preferowany typ. Wszystkie kategorie najwyzszego poziomu tworzone beda na podstawie pojecia nalezacego do
wybranego tutaj typu (i zadnych innych typodw). Kazda podkategoria bedzie zawiera¢ wzorzec powiazan w tekscie
utworzony na podstawie tego typu. Gdy wybierzesz ten typ w polu Structure categories by pattern type:, tabela
zostanie zaktualizowana, aby wyswietli¢ tylko wzorce majace zastosowanie, tj. zawierajace wybrany typ. Zwykle
wstepnie wybrany bedzie typ <Unknown>. Skutkuje to wybraniem wszystkich wzorcow zawierajacych typ
<Unknown>. Tabela przedstawia typy w porzadku malejacym, rozpoczynajac od typu z najwigksza liczba rekordow
lub dokumentéw (Doc. count).

Types. Gdy wybierzesz typy, kategorie zostana zbudowane z poje¢ nalezacych do wybranych typow. Jesli zatem w
tabeli wybierzesz typ <Budget>, moga zosta¢ wygenerowane takie kategorie, jak cost lub price, poniewaz cost i
price sa pojeciami przypisanymi do typu <Budget>.

Domyslnie wybrane sa tylko typy, ktore wychwyca wigkszos¢ rekordow lub dokumentow. Ten wstgpny wybor pozwala
szybko skupi¢ si¢ na najbardziej interesujacych typach i unikna¢ budowania kategorii nieinteresujacych. Tabela
przedstawia typy w porzadku malejacym, rozpoczynajac od typu z najwigksza liczba rekordow lub dokumentow (Doc.
count). Typy z biblioteki Opinions domyslnie nie sa wybrane w tabeli typow.

Wybrane ustawienia wejsciowe maja wplyw na uzyskiwane kategorie. Jesli wybierzesz opcje uzycia typéw jako
danych wejsciowych, w wynikach uwypuklone beda jednoznacznie pokrewne pojecia. Na przyktad przy budowaniu
kategorii na podstawie typdw moglaby zosta¢ utworzona kategoria Fruit obejmujaca pojecia apple, pear, citrus fruits,
orange itd. Jesli jednak wybierzesz opcje Type Patterns i wzorzec <Unknown> + <Positive>, to mozesz uzyskac
kategorie fruit + <Positive> z jednym lub dwoma rodzajami owocdw, na przyktad fruit + tasty i apple + good. Ten
drugi wynik zawiera tylko 2 wzorce pojec, poniewaz w innych wystapieniach owoce nie zawsze sa pozytywnie
kwalifikowane. Taki rezultat moze wystarczy¢ do analizy biezacych danych tekstowych, jednak w badaniach
obejmujacych rozne zestawy dokumentow celowe moze okaza¢ si¢ dodanie innych deskryptorow, takich jak citrus fruit
+ positive lub przypadkow uzycia. Zastosowanie typow jako jedynych kryteriow wejsciowych pomoze wyszukaé
wszystkie mozliwe owoce.

Techniki

Poniewaz kazdy zbior danych jest inny, liczba metod tworzenia kategorii i kolejnos¢ ich stosowania moze si¢ z czasem
zmieniac. Jako ze rdzne zbiory danych moga by¢ eksplorowane w roéznych celach i pod réznym katem, konieczne moze
by¢ wyprobowanie réznych technik i wybranie tej, ktora przynosi najlepsze wyniki w analizie konkretnych danych
tekstowych.

Nie trzeba by¢ ekspertem, by korzysta¢ z tych technik. Domyslnie wybrane sa najczgsciej stosowane i przecigtne
ustawienia. Oznacza to, ze mozesz pomina¢ okna ustawien zaawansowanych i przejs¢ bezposrednio do budowania
kategorii. Podobnie, jesli wprowadzisz tutaj zmiany, nie musisz za kazdym razem wracac¢ do okna dialogowego
ustawien, poniewaz zawsze zachowywane sa najnowsze ustawienia.

Wybierz techniki lingwistyczne lub oparte na liczebnosci wystapien i kliknij przycisk Advanced Settings, aby
wyswietli¢ ustawienia dla wybranych technik. Zadna z technik automatycznych nie zapewni idealnej kategoryzacji
danych; dlatego zalecamy wyprobowanie roznych technik automatycznych i stosowanie tych, ktére najlepie;j
sprawdzaja si¢ przy pracy z konkretnymi danymi.Nie mozna jednocze$nie stosowac technik lingwistycznych i opartych
na liczebnosci.

+ Zaawansowane techniki lingwistyczne. Aby uzyska¢ wigcej informacji, patrz|Zaawansowane ustawienial

jezykowe”’

» Zaawansowane techniki oparte na liczebnosci wystapien. Aby uzyska¢ wigcej informacji, patrz
[ustawienia liczebnosci” na stronie 109}

Zaawansowane ustawienia jezykowe

Podczas tworzenia kategorii mozna wybiera¢ sposrod wielu zaawansowanych technik lingwistycznych budowania
kategorii, takich jak wywodzenie rdzenia pojecia, wlqczanie pojec¢, sieci semantyczne (tylko w tekstach w jezyku
angielskim) i reguly wspotwystepowania. Techniki te moga by¢ uzywane indywidualnie lub facznie do tworzenia
kategorii.
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Nalezy jednak pamigtac, ze poniewaz kazdy zbidr danych jest inny, liczba metod tworzenia kategorii i kolejnos¢ ich
stosowania moze si¢ z czasem zmieniaé. Jako ze rozne zbiory danych moga by¢ eksplorowane w roznych celach i pod
réznym katem, konieczne moze by¢ wyprdbowanie roznych technik i wybranie tej, ktdra przynosi najlepsze wyniki w
analizie konkretnych danych tekstowych. Zadna z technik automatycznych nie zapewni idealnej kategoryzacji danych;
dlatego zalecamy wyprobowanie roznych technik automatycznych i stosowanie tych, ktdre najlepiej sprawdzaja sig
przy pracy z konkretnymi danymi.

W oknie dialogowym Advanced Settings: Linguistics dostgpne sa nastgpujace obszary i pola:
Dane wejsciowe i wyjsciowe

Category input Wybierz, na podstawie czego beda tworzone kategorie:

* Unused extraction results. Ta opcja powoduje budowanie kategorii z wynikéw wyodrebniania, ktore nie sa
uzywane w zadnych istniejacych kategoriach. Minimalizuje to tendencj¢ do dopasowywania tych samych rekordéw
do wielu kategorii i ogranicza liczbe generowanych kategorii.

* All extraction results. Ta opcja powoduje budowanie kategorii przy uzyciu dowolnych wynikéw wyodrebniania.
Taki sposdb postepowania jest najbardziej uzyteczny, gdy nie istnieja jeszcze kategorie lub jesli istnieje niewiele
kategorii.

Category output Wybierz ogdlng strukture kategorii, ktore zostana utworzone:

* Hierarchical with subcategories. Ta opcja umozliwia tworzenie podkategorii i pod-podkategorii. Mozna ustawic¢
glebokos¢ hierarchii, wybierajac maksymalna liczbg poziomdéw (pole Maximum levels created), ktore moga by¢
utworzone. Jesli wybierzesz opcje 3, kategorie beda mogly zawiera¢ podkategorie i te podkategorie takze beda
mogty mie¢ podkategorie.

* Flat categories (single level only). Ta opcja dopuszcza zbudowanie tylko jednego poziomu kategorii, co oznacza, ze
nie beda generowane podkategorie.

Techniki grupowania

Kazda z dostgpnych technik dobrze nadaje si¢ do pracy z okreslonymi rodzajami danych i w okreslonych warunkach,
jednak czgsto przydatna jest mozliwos¢ potaczenia w jednej analizie roznych technik w celu wydobycia bogatszego
zbioru informacji z dokumentéw lub rekordow. Pojecie moze znalez¢ si¢ w wigcej niz jednej kategorii, moga tez
pojawic sig kategorie nadmiarowe.

Concept Inclusion. Ta technika buduje kategorie, taczac z w grupg z jednym pojeciem inne pojgcia ztozone z wielu
termindéw (wielu wyrazdw) w zaleznosci od tego, czy zawieraja one wyrazy bgdace podzbiorami czy nadzbiorami

wystepujacego w nim wyrazu. Na przyklad pojecie seat zostatoby potaczone w grupe z pojeciami safety seat, seat
belt i seat belt buckle. Wigcej informacji zawiera temat|“Wtaczanie poje¢” na stronie 106

Semantic Network. Ta technika najpierw rozpoznaje mozliwe sensy kazdego pojecia na podstawie obszernego indeksu
relacji migdzy wyrazami, a potem tworzy kategorie poprzez grupowanie poje¢ pokrewnych. Sprawdza si¢ najlepiej,
gdy pojecia sa znane sieci semantycznej i nie sa zbyt niejednoznaczne. Jest mniej uzyteczna, gdy tekst zawiera
terminologi¢ specjalistyczna lub zargon nieznany sieci. Przyktadowo pojecie granny smith apple mogtoby zostaé¢
polaczone w grupe z pojgciami gala apple i winesap apple, poniewaz podobnie jak ,,granny smith” oznaczaja
odmiany jabtoni. Natomiast pojecie animal mogloby zosta¢ potaczone w grupe z pojeciami cat i kangaroo, poniewaz
sa one hiponimami stowa animal (tj. zawezaja jego znaczenie). W tej wersji technika ta jest dostepna tylko w
odniesieniu do jezyka angielskiego. Wiecej informacji zawiera temat[Sieci semantyczne” na stronie 107

Uwaga: Opcja Maximum search distance jest dostgpna tylko wtedy, gdy zaznaczono opcje Semantic Network.
Maximum search distance Wybierz, jak daleko ma by¢ prowadzone wyszukiwanie, zanim wygenerowane zostana

kategorie. Im mniejsza wartos¢, tym mniej wynikow zostanie wygenerowanych, jednak wyniki te beda mniej
zaszumione i z wigkszym prawdopodobienistwem begda istotnie powiazane ze soba nawzajem. Im wigksza warto$¢, tym
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wigcej wynikow zostanie wygenerowanych, ale wyniki te moga by¢ mniej wiarygodne lub istotne. Cho¢ opcja ta
obowiazuje globalnie we wszystkich technikach, jej dziatanie jest najbardziej odczuwalne w sieciach semantycznych i
analizie wspotwystapien.

Prevent pairing of specific concepts. Zaznacz to pole wyboru, aby w wynikach nie grupowac¢ lub nie taczy¢ w pary
dwoch poje¢. Aby tworzy¢ pary pojec lub nimi zarzadza¢, kliknij przycisk Manage Pairs... Wigcej informacji zawiera
temat [‘Zarzadzanie parami wyjatkéw powiazan”|

Generalize with wildcards where possible Wybierz te opcje, aby umozliwi¢ generowanie ogolnych regut w
kategoriach przy uzyciu wieloznacznego symbolu gwiazdki. Na przyktad, zamiast tworzy¢ wiele deskryptorow, takich
jak [apple tart + .] i [apple sauce + .], program moze wygenerowac ogolny deskryptor [apple * + .]. Generalizacja
przy uzyciu znakow wieloznacznych prowadzi czgsto do uzyskania doktadnie takiej samej liczby rekordow lub
dokumentdw, jak poprzednio. Jednak zaleta tej opcji jest zmniejszenie liczby 1 uproszczenie deskryptorow kategorii.
Ponadto opcja ta umozliwia potencjalnie klasyfikowanie wigkszej liczby nowych rekordow lub dokumentow za
pomoca tych samych kategorii (na przyktad w badaniach podtuznych).

Inne opcje budowania kategorii
Oprdcz wybierania technik grupowania mozna zmodyfikowac¢ kilka innych opcji budowania:

Maximum number of top level categories created. Uzyj tej opcji, aby ograniczy¢ liczbe kategorii, ktore moga by¢
wygenerowane po kliknigciu przycisku Build Categories. W niektorych przypadkach lepsze wyniki uzyskuje sig,
wpisujac tutaj wysoka wartos¢, a potem usuwajac nieinteresujace kategorie.

Minimum number of descriptors and/or subcategories per category. Uzyj tej opcji, aby okresli¢ minimalna liczbg
deskryptorow i podkategorii, jaka musi zawiera¢ kategoria, aby zostata utworzona. Ta opcja pomaga ograniczy¢ liczbg
kategorii, ktore nie wychwytuja istotnej liczby rekordow lub dokumentow.

Allow descriptors to appear in more than one category Ta opcja dopuszcza uzycie deskryptordw w wigcej niz jedne;j
kategorii. Opcja ta jest zwykle wybrana, poniewaz elementy czg¢sto i w naturalny sposob pasuja do dwdch lub wigcej
kategorii, dlatego dopuszczenie takiej mozliwosci zwykle prowadzi do uzyskania kategorii wyzszej jakosci. Jesli ta
opcja nie zostanie wybrana, moze wystapi¢ mniejsze naktadanie si¢ rekordow w roznych kategoriach, co niekiedy jest
pozadane (w zaleznosci od typu danych). Jednak w przypadku wigkszosci typow danych ograniczanie deskryptorow do
pojedynczej kategorii zwykle powoduje utratg jakosci kategorii lub mniejszego pokrycia danych kategoriami. Zalézmy
na przyktad, ze mamy pojecie car seat manufacturer. Gdy opisywana opcja jest wybrana, to pojecie moze
wystgpowac w jednej kategorii na podstawie tekstu car seat, a w innej na podstawie manufacturer. Jesli jednak ta
opcja nie jest wybrana, mimo ze nadal mozna uzyskac¢ obie kategorie, pojecie car seat manufacturer bedzie ujete
tylko jako deskryptor w kategorii, do ktorej pasuje najlepiej na podstawie kilku czynnikow, w tym liczby rekordow, w
ktérych wystepuja terminy car seat i manufacturer (wystapienia zliczane sa osobno dla kazdego terminu).

Resolve duplicate category names by Wybierz, w jaki sposob postgpowac z nowymi kategoriami lub podkategoriami,
ktorych nazwy bylyby takie same, jak nazwy istniejacych kategorii. Mozna polaczy¢ nowe kategorie (i ich deskryptory)
z istniejacymi kategoriami o tej samej nazwie. Albo mozna pomina¢ tworzenie kategorii, jesli zostanie znaleziona
istniejaca kategoria o tej samej nazwie.

Zarzadzanie parami wyjatkow powiazan

Podczas tworzenia kategorii, grupowania i mapowania poje¢ wewngtrzne algorytmy grupuja wyrazy na podstawie
znanych zwiazkow. Aby nie dopusci¢ do powiazania dwdch poje¢ w parg, mozna wiaczy¢ odpowiednia funkcje w
oknie dialogowym Build Categories Advanced Settings, Build Clusters i Concept Map Index Settings, a nastgpnie
klikna¢ przycisk Manage Pairs.

W wyswietlonym oknie dialogowym Manage Link Exceptions mozna dodawa¢, edytowac lub usuwac pary pojec.
Wprowadz jedna parg na wiersz. Wprowadzenie pary w tym miejscu uniemozliwi utworzenie takiej pary podczas
budowania lub uzupetniania kategorii, grupowania i mapowania poje¢. Wprowadz wyrazy doktadnie w takiej postaci,
w jakiej maja by¢ uwzgledniane, na przyktad wyraz z akcentami nie jest rOwny wersji bez akcentow.
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Na przyktad, jesli chcesz mie¢ pewnosé, ze hot dog i dog nie zostang zgrupowane, dodaj t¢ par¢ w osobnym wierszu
tabeli.

Informacje o technikach lingwistycznych

Podczas tworzenia lub uzupetniania kategorii mozna wybiera¢ spos$rod wielu zaawansowanych technik
lingwistycznych budowania kategorii, takich jak wywodzenie rdzenia pojecia, wlqczanie pojec, sieci semantyczne
(tylko w jezyku angielskim) i reguty wspotwystepowania. Techniki te moga by¢ uzywane indywidualnie lub tacznie do
tworzenia kategorii.

Nie trzeba by¢ ekspertem, by korzystac z tych technik. Domyslnie wybrane sa najczgsciej stosowane i przecigtne
ustawienia. Jesli chcesz, mozesz pomina¢ to okno dialogowe zaawansowanych ustawien i przejs¢ bezposrednio do
tworzenia lub uzupekiania wlasnych kategorii. Podobnie, jesli wprowadzisz tutaj zmiany, nie musisz za kazdym razem
wracac¢ do okna dialogowego ustawien, poniewaz zawsze zachowywane sa najnowsze ustawienia.

Nalezy jednak pamigtac, ze poniewaz kazdy zbior danych jest inny, liczba metod i kolejnos¢ ich stosowania moze sig z
czasem zmienia¢. Jako ze rézne zbiory danych moga by¢ eksplorowane w réznych celach i pod réznym katem,
konieczne moze by¢ wyprobowanie réznych technik i wybranie tej, ktdra przynosi najlepsze wyniki w analizie
konkretnych danych tekstowych. Zadna z technik automatycznych nie zapewni idealnej kategoryzacji danych; dlatego
zalecamy wyprobowanie réznych technik automatycznych i stosowanie tych, ktore najlepiej sprawdzaja si¢ przy pracy
z konkretnymi danymi.

Oto gtowne techniki lingwistyczne automatycznego budowania kategorii:

* Concept root derivation. Te technika tworzy kategorie, wybierajac jedno pojecie i wyszukujac pojecia mu
pokrewne poprzez analiz¢ relacji morfologicznych lub wspdlnych rdzeni migdzy komponentami tych pojec. Wigceej
informacji zawiera temat [“Wywodzenie rdzenia pojecia”]

* Concept inclusion. Te technika tworzy kategorie, wybierajac jedno pojecie i wyszukujac pojecia, w ktérych jest ono
zawarte. Wiccej informacji zawiera temat|“Wtaczanie poje¢” na stronie 106|

* Semantic network. Ta technika najpierw rozpoznaje mozliwe sensy kazdego pojgcia na podstawie obszernego
indeksu relacji miedzy wyrazami, a potem tworzy kategorie poprzez grupowanie poje¢ pokrewnych. Wigcej
informacji zawiera temat[“Sieci semantyczne” na stronie 107| Ta opcja jest dostepna tylko w przypadku tekstu w
jezyku angielskim.

* Co-occurrence. Ta metoda tworzy reguty wspotwystepowania, ktorych mozna uzy¢ do utworzenia nowe;j kategorii,
uzupelnienia kategorii lub jako kryterium wejsciowego dla innej techniki kategoryzacji. Wigcej informacji zawiera
temat [‘Reguly wspotwystepowania” na stronie 108]

Wywodzenie rdzenia pojecia

Technika wywodzenia rdzenia pojecia tworzy kategorie, wybierajac jedno pojecie 1 wyszukujac pojecia mu pokrewne
poprzez analizg relacji morfologicznych migdzy komponentami tych pojg¢. Komponent jest wyrazem. Technika ta
probuje grupowacé pojecia, analizujac koncowki (przyrostki) kazdego komponentu w pojeciu i znajdujac inne pojecia,
ktére moga by¢ z tych komponentéow wywiedzione. Zaktada si¢ bowiem, gdy stowa pochodza od siebie, to
prawdopodobnie sa bliskie znaczeniowo. W celu identyfikacji koncowek uzywane sa reguly wewngetrzne wlasciwe dla
danego jezyka. Na przyktad pojecie opportunities to advance zostatoby potaczone w grupe z pojeciami opportunity
for advancement i advancement opportunity.

Wywodzenie rdzeni poje¢ mozna zastosowac¢ do dowolnego tekstu. Samodzielnie technika ta tworzy wzglednie mato
kategorii, a kazda kategoria zawiera zwykle mato pojg¢. Pojecia w kazdej kategorii sa synonimami lub pojgciami
pokrewnymi sytuacyjnie. Algorytm ten moze by¢ pomocny nawet w przypadku recznego budowania kategorii;
synonimy znalezione przez algorytm moga by¢ synonimami wiasnie tych pojec¢, ktorymi uzytkownik jest szczegdlnie
zainteresowany.

Uwaga: Mozna zapobiec grupowaniu poje¢, okreslajac je jawnie. Wigcej informacji mozna znalez¢ w temacie
[‘Zarzadzanie parami wyjatkow powiazan” na stronie 104}
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Komponentyzacja i usuwanie odmiany terminéw

Podczas wywodzenia rdzeni pojg¢ terminy w pierwszej kolejnosci sa dzielone na komponenty (wyrazy), a nastgpnie
komponenty te sa pozbawiane odmiany. Podczas stosowania tej techniki pojgcia i powiazane z nimi terminy sa
fadowane i dzielone na komponenty na podstawie separatorow, takich jak spacje, faczniki i apostrofy. Na przyktad
termin System administrator jest dzielony na sktadniki {administrator, system}.

Jednak niektore czgsci oryginalnego terminu moga nie zosta¢ wykorzystane. Sa to tzw. wyrazy ignorowane. W jezyku
angielskim do komponentéw ignorowanych moga naleze¢ wyrazy: a, and, as, by, for, from, in, of, on, or, the, to i
with.

Na przyktad termin examination of the data ztozony jest z komponentow {data, examination}, poniewaz wyrazy of
i the sa ignorowane. Ponadto zbiér komponentow jest nicuporzadkowany. W ten sposob nastepujace trzy sktadniki
moga by¢ rownowazne: cough relief for child, child relief from a cough i relief of child cough, poniewaz wszystkie
maja ten sam zbior komponentéw {child, cough, relief}. Gdy para terminéw zostanie zidentyfikowana jako
réwnowazna, odpowiednie pojecia sa taczone w celu utworzenia nowego pojgcia, ktore odwoluje si¢ do wszystkich
terminow.

Ponadto, poniewaz komponenty sktadnika moga by¢ odmieniane automatycznie, wewngtrznie stosowane regut jezyka
w celu zidentyfikowania terminéw rownowaznych niezaleznie od wariantow odmiany, np. liczby mnogiej. W ten
sposéb terminy level of support i support levels moga by¢ identyfikowane jako rownowazne, poniewaz pojedyncza
forma rzeczownika po usunigciu odmiany brzmi level.

Jak dziata wywodzenie rdzenia pojecia

Po komponentyzacji terminow i pozbawieniu jej odmiany (patrz poprzednia sekcja) algorytm wywodzenia rdzeni pojeé
analizuje koncowki (przyrostki) komponentéw, aby znalez¢ rdzen komponentu, a nastgpnie grupuje pojecia z innymi
pojeciami, ktore maja takie same lub podobne rdzenie. Koncowki sa identyfikowane przy uzyciu zestawu regut
lingwistycznych charakterystycznych dla jezyka tekstu. Na przyktad w jezyku angielskim istnieje reguta mowiaca, ze
termin pojecia konczacy sig przyrostkiem ical moze by¢ wywiedziony z pojgcia o tym samym rdzeniu i koncowce ic.
Przy uzyciu tej reguly (po usunigciu odmiany) algorytm bedzie mdgt zgrupowac pojecia epidemiologic study i
epidemiological studies.

Poniewaz terminy sa juz podzielone na komponenty, a komponenty do pominigcia (na przyktad in i of) zostaty juz
zidentyfikowane, algorytm wywodzenia rdzeni poje¢ potrafi takze zgrupowac pojecia studies in epidemiology i
epidemiological studies.

Zestaw regut wywodzenia rdzeni pojec¢ zostat wybrany w taki sposob, ze wigkszos¢ pojec grupowanych wedtug tego
algorytmu stanowi synonimy: pojecia epidemiologic studies, epidemiological studies i studies in epidemiology sa
terminami rownowaznymi. Aby zwigkszy¢ kompletnos¢ wynikow wprowadzono pewne reguly wywodzenia, ktore
umozliwiaja algorytmowi grupowanie pojg¢ pokrewnych sytuacyjnie. Na przyktad algorytm moze zgrupowac pojgcia
empire builder i empire building.

Wiaczanie pojec

Technika wlaczenia poje¢ buduje kategorie, identyfikujac pojecia zawarte w innych pojeciach za pomoca algorytmow
szeregu leksykalnego. Zaktada sig, ze jesli wyrazy w pojeciu sa podzbiorem innego pojecia, to miedzy tymi pojeciami
istnieje relacja semantyczna. Wiaczanie jest zaawansowana technika, ktora moze by¢ uzywana z dowolnym typem
tekstu.

Ta technika dziata dobrze w potaczeniu z sieciami semantycznymi, ale moga by¢ tez uzywane osobno. Wilaczanie pojgé
moze rowniez przynies¢ lepsze wyniki, gdy dokumenty lub rekordy zawieraja wiele terminow branzowych lub
zargonowych. Zwlaszcza, jesli stowniki zostaly wezesniej zoptymalizowane tak, by specjalistyczne terminy byty

wyodrebniane i odpowiednio grupowane (z synonimami).

Dziatanie techniki wiaczania pojec
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Zanim algorytm wiaczania pojec zostanie zastosowany, sktadniki sa komponentyzowane i pozbawiane odmiany.
Wigcej informacji zawiera temat[*Wywodzenie rdzenia pojecia” na stronie 105 Nastepny algorytm wiaczania pojeé
analizuje zbiory komponentow. Dla kazdego zbioru komponentéw algorytm wyszukuje kolejny zbior komponentdw,
ktory jest podzbiorem pierwszego zbioru.

Na przyktad, jesli masz pojecie continental breakfast ze zbiorem komponentow {breakfast, continental}, a takze
pojecie breakfast ze zbiorem komponentow {breakfast}, algorytm uzna continental breakfast za jeden z rodzajow
pojecia breakfast i zgrupuje oba pojecia.

A oto bardziej rozbudowany przyktad: jesli na panelu Extraction Results masz pojecie seat i zastosujesz opisywany
algorytm, to do tej samej kategorii trafia takze pojecia safety seat, leather seat, seat belt, seat belt buckle, infant
seat carrier i car seat laws.

Poniewaz terminy sa juz podzielone na komponenty, a komponenty do pominigcia (na przyktad in i of) zostaty juz
zidentyfikowane, algorytm wlaczania poje¢ potrafi zorientowac sig, ze advanced spanish course zawiera pojgcie
course in spanish.

Uwaga: Mozna zapobiec grupowaniu poje¢, okreslajac je jawnie. Wigcej informacji zawiera temat
barami wyjatkdw powiazan” na stronie 104[

Sieci semantyczne
W tej wersji produktu technika sieci semantycznych jest dostgpna tylko w przypadku tekstow w jgzyku angielskim.

Ta metoda tworzy kategorie przy uzyciu wbudowanej sieci relacji migdzy wyrazami. Z tego powodu ta technika moze
generowac bardzo dobre wyniki, gdy terminy sa konkretne i nie sa zbyt niejednoznaczne. Jednak nie nalezy oczekiwac,
ze technika ta znajdzie wiele powiazan migdzy wysoce technicznymi/specjalistycznymi pojgciami. W przypadku takich
poje¢ moze okazac sig, ze techniki wlaczania poje¢ i wywodzenia rdzeni pojec beda bardziej uzyteczne.

Dziatanie techniki sieci semantycznych

Istota techniki sieci semantycznych jest wykorzystanie znanych relacji migdzy wyrazami do tworzenia kategorii
synonimow lub hiponiméw. Z hiponimem mamy do czynienia, gdy jedno pojgcie jest rodzajem drugiego pojgcia, tak
ze istnieje relacja hierarchiczna, znana rowniez jako relacja ISA. Na przyktad, jesli animal jest pojeciem, to cat i
kangaroo sa hiponimami animal, poniewaz sa rodzajami zwierzat.

Oprocz synonimow i1 hiponiméw technika sieci semantycznej analizuje rowniez czg¢s¢ powiazan i cate powiazania
miedzy pojeciami typu <Location>. Na przyktad technika ta zgrupuje pojecia normandy, provence i france w jedne;j
kategorii, poniewaz Normandia i Prowansja sa regionami Francji.

Dziatanie techniki sieci semantycznych rozpoczyna si¢ od identyfikacji mozliwych znaczen poszczegolnych terminow
w sieci semantycznej. Gdy pojgcia zostana zidentyfikowane jako synonimy lub hiponimy, sa grupowane w jedna
kategorig. Na przyklad opisywana technika utworzytaby jedna kategorie zawierajaca trzy pojecia: eating apple,
dessert apple i granny smith, poniewaz sie¢ semantyczna zawiera informacje o tym, ze: 1) dessert apple jest
synonimem eating apple, 2) granny smith jest rodzajem eating apple (zatem jest hiponimem eating apple).

Wiele poje¢, zwlaszcza jednowyrazowych, ma charakter niejednoznaczny, jesli rozpatruje si¢ je osobno. Na przyktad
pojecie buffet moze oznacza¢ rodzaj positku lub mebel. Jesli zbior pojec¢ zawiera pojecia meal, furniture i buffet, to
algorytm musi wybra¢ pomigdzy zgrupowaniem pojecia buffet z pojeciem meal albo furniture. Nalezy pamigtac, ze w
niektorych przypadkach wybory dokonane przez algorytm moga nie by¢ odpowiednie w kontekscie konkretnego zbioru
rekordow lub dokumentow.

W przypadku niektérych typdw danych technika sieci semantycznych dziata lepiej niz wlaczanie pojec. Obie te

techniki rozpoznaja, ze apple pie jest rodzajem pie, ale tylko technika sieci semantycznej rozpozna, ze tart rowniez
jest rodzajem pie.
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Sieci semantyczne beda dziata¢ w potaczeniu z innymi technikami. Zatézmy na przyktad, ze wybrano zarowno
technike sieci semantycznych, jak i wlaczania pojeé, a sie¢ semantyczna zgrupowala pojecie teacher z pojeciem tutor
(poniewaz tutor jest rodzajem teacher). Algorytm wiaczania moze zgrupowac pojecie graduate tutor z pojeciem tutor,
a w rezultacie wspotpracy dwoch algorytmow powstanie kategoria wynikowa zawierajaca wszystkie trzy pojecia: tutor,
graduate tutor i teacher.

Opcje techniki sieci semantycznych

Istnieje szereg dodatkowych ustawien, ktére moga by¢ interesujace dla uzytkownika tej techniki.

* Zmien warto$¢ Maximum search distance. Wybierz, jak daleko ma by¢ prowadzone wyszukiwanie, zanim
wygenerowane zostana kategorie. Im mniejsza warto$¢, tym mniej wynikow zostanie wygenerowanych, jednak
wyniki te beda mniej zaszumione i z wigkszym prawdopodobienistwem beda istotnie powiazane ze soba nawzajem.
Im wigksza warto$¢, tym wiecej wynikow zostanie wygenerowanych, ale wyniki te moga by¢ mniej wiarygodne lub
istotne.

Na przyktad, w zaleznosci od odlegtosci, algorytm algorytm przeszukuje pojecia poczawszy od Danish pastry do
coffee roll (pojecie nadrzedne), potem bun (pojecie nadrzedne pojecia nadrzednego), a potem bread.

Zmniejszenie odleglosci wyszukiwania umozliwia tworzenie mniejszych kategorii, ktore moga by¢ latwiejsze w
praktycznym zastosowaniu, a takze bywa przydatne, gdy generowane kategorie sa zbyt obszerne lub grupuja zbyt wiele
pojec.

Wazne! Dodatkowo zaleca sig, aby w przypadku stosowania tej techniki nie uzywac opcji Accommodate spelling
errors for a minimum root character limit of (zdefiniowanej na karcie Expert wezta lub w oknie dialogowym
Extract) dla grupowania rozmytego, poniewaz nicktére grupy moga mie¢ bardzo niekorzystny wptyw na wyniki.

Reguly wspoétwystepowania

Reguly wspotwystepowania umozliwiaja wykrywanie i grupowanie pojec, ktore sa silnie powiazane w obrebie zbioru
dokumentéw lub rekordow. Koncepcja dzialania tej techniki zasadza si¢ na tym, ze gdy pojecia czgsto wystepuja razem
w dokumentach i rekordach, takie wspotwystapienia odzwierciedlaja potencjalna relacjg, ktora warto uwzgledni¢ w
definicjach kategorii. Ta metoda tworzy reguty wspotwystgpowania, ktorych mozna uzy¢ do utworzenia nowe;j
kategorii, uzupetnienia kategorii lub jako kryterium wejsciowego dla innej techniki kategoryzacji. Dwa pojecia silnie
wspotwystepuja, jesli czesto wystepuja razem w pewnym zbiorze rekorddéw i rzadko wystepuja oddzielnie w
pozostatych rekordach. Ta metoda moze przynies¢ dobre wyniki w przypadku duzych zbioréw danych obejmujacych
co najmniej kilkaset dokumentow lub rekordow.

Na przyktad, jesli wiele rekordow zawiera wyrazy price i availability, to pojecia te moga by¢ zgrupowane w regute
wspotwystepowania (price & available). Inny przyktad: jesli pojecia peanut butter, jelly, sandwich wystepuja
czesciej razem niz osobno, to zostana zgrupowane w jedna regute wspotwystepowania (peanut butter & jelly &
sandwich).

Wazne! We wczesniejszych wersjach produktu reguly wspotwystepowania i synonimow byly uyjmowane w nawiasy
kwadratowe. W tej wersji nawiasy kwadratowe oznaczaja wzorzec wynikowy analizy powiazan w tekscie. Natomiast
reguly wspolwystgpowania i synonimow sa ujmowane w nawiasy okragte, na przyktad (speaker systems|speakers).

Dziatanie regut wspolwystepowania

Ta technika przeglada dokumenty lub rekordy w poszukiwaniu dwoch lub wigkszej liczby poje¢, ktére maja tendencje
do tacznego wystgpowania. Dwa pojgcia silnie wspotwystepuja, jesli czgsto wystepuja razem w pewnym zbiorze
dokumentéw lub rekordow i rzadko wystepuja oddzielnie w pozostatych dokumentach lub rekordach.

Gdy znalezione zostana pojecia wspotwystgpujace, tworzona jest reguta kategorii. Reguly takie sktadaja si¢ z dwoch
lub wigkszej liczby poje¢ potaczonych za pomoca operatora boolowskiego &. Reguly sa instrukcjami logicznymi, ktore
beda automatycznie klasyfikowa¢ dokument lub rekord do kategorii, jesli zbior poje¢ w regule w catosci
wspotwystepuje w tym dokumencie lub rekordzie.
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Opcje regut wspotwystepowania

Jesli uzywana jest technika regut wspotwystgpowania, mozna zoptymalizowac kilka ustawien, ktdre maja wptyw na
koncowe reguty:

* Zmien wartos¢ Maximum search distance. Wybierz, jak daleko technika ma wyszuka¢ wspotwystapien. W
przypadku zwigkszenia odleglosci wyszukiwania zmniejsza si¢ minimalna warto$¢ podobienstwa wymagana do
stwierdzenia obecnosci wspotwystapienia. W rezultacie moze powstac¢ wiele regut wspotwystgpowania, ale reguty o
niskiej wartoséci podobienstwa beda czgsto mato istotne. W przypadku zmniejszenia odlegtosci wyszukiwania
zwigksza sig minimalna wymagana warto$¢ podobienstwa; w rezultacie powstanie mniej regut, ale o potencjalnie
wigkszej istotnosci.

* Minimum number of documents. Minimalna liczba rekordow lub dokumentow , ktére musza zawiera¢ dana pare
poj¢c, aby byla ona traktowana jako wspotwystapienie; im mniejsza jest ta warto$¢, tym tatwiej znalezé
wspotwystapienia. Zwigkszenie tej wartosci powoduje wygenerowanie mniejszej liczby wspotwystapien, ktore beda
jednak bardziej istotne. Na przyktad zatézmy, ze pojgcia "apple" "pear" wystgpuja razem w 2 rekordach (a zadne z
tych poje¢ nie wystgpuje w zadnych innych rekordach). Opcja Minimum number of documents. jest ustawiona na
2 (wartos¢ domyslna), technika wspdtwystapien utworzy regule kategorii (apple and pear). Jesli wartos¢ zostanie
zwigkszona do 3, regula nie zostanie utworzona.

Uwaga: W przypadku matych zbioréw danych (< 1000 odpowiedzi) znalezienie jakichkolwiek wspotwystapien z
ustawieniami domyslnymi moze by¢ niemozliwe. W takim przypadku sprobuj zwigkszy¢ odlegtos¢ wyszukiwania.

Uwaga: Mozna zapobiec grupowaniu pojec, okreslajac je jawnie. Wigcej informacji zawiera temat
parami wyjatkow powiazan” na stronie 104}

Zaawansowane ustawienia liczebnosci

Istnieje mozliwo$¢ utworzenia kategorii na podstawie prostej i mechanicznej techniki zliczania wystapien. Za pomoca
tej techniki mozna zbudowac¢ jedna kategorig dla kazdego elementu (typu, pojgcia lub wzorca), ktéry wystepuje co
najmniej w okreslonej liczbie rekordow lub dokumentow. Dodatkowo mozna utworzy¢ pojedyncza kategorig dla
wszystkich elementéw o mniejszej liczebnosci. Pod pojgciem liczebnosci rozumiemy liczbg rekordow lub dokumentow
zawierajacych wyodrgbnione pojgcie (lub jego synonimy), typ lub wzorzec, a nie taczna liczbg wystapien w catym
tekscie.

Grupowanie czgsto uzywanych elementdw moze przynies$¢ interesujace wyniki, poniewaz czgsto ujawnia typowe lub
istotne odpowiedzi. Technika ta jest bardzo przydatna do analizy niewykorzystanych wynikow wyodregbniania juz po
zastosowaniu innych technik. Inne zastosowanie polega na uzyciu tej techniki od razu po wyodrebnieniu, gdy nie
istnieja jeszcze inne kategorie, recznym usunigciu z wynikow nieinteresujacych kategorii, a nastgpnie uzupetnieniu
pozostalych kategorii, aby pasowaty do jeszcze wigkszej liczby rekordow lub dokumentow. Wigcej informacji zawiera
temat [“Uzupetnianie kategorii” na stronie 110}

Zamiast uzywac tej techniki, mozna posortowac pojecia lub wzorce pojg¢ malejaco wedtug liczby rekordéw lub
dokumentéw w panelu Extraction Results, a nastgpnie przeciagnac i upusci¢ pozycje z poczatku uzyskanej listy do
panelu Categories w celu utworzenia odpowiednich kategorii.

W oknie dialogowym Advanced Settings: Frequencies dostgpne sa nastgpujace pola

Generate category descriptors at. Wybierz rodzaj kryteriow wejsciowych dla deskryptorow. Wigcej informacji
zawiera temat[“Tworzenie kategorii” na stronie 101|

* Concepts level. Wybranie tej opcji oznacza, ze uzywane beda liczebnosci poje¢ lub wzorcow pojec. Pojecia beda
uzywane, jesli jako kryteria wejsciowe dla tworzenia kategorii wybrano typy, a wzorce poje¢ beda uzywane, jesli
wybrano wzorce typow. Z reguly zastosowanie tej techniki na poziomie poje¢ spowoduje wygenerowanie bardziej
szczegolowych wynikow, poniewaz pojgcia i wzorce pojec reprezentuja nizszy poziom pomiaru.
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* Types level. Wybranie tej opcji oznacza, ze uzywane beda liczebnosci typow lub wzorcow typow. Typy beda
uzywane, jesli jako kryteria wejsciowe dla tworzenia kategorii wybrano typy, a wzorce typow beda uzywane, jesli
wybrano wzorce typow. Stosowanie tej techniki na poziomie typow pozwala uzyskac szybki przeglad rodzajow
informacji obecnych w danych.

Minimum doc. count for items to have their own category. Ta opcja stuzy do tworzenia kategorii z czgsto
wystepujacych pozycji. Ta opcja ogranicza wyniki do tych kategorii zawierajacych deskryptor, ktore wystapity w co
najmniej X rekordéw lub dokumentdw, gdzie X jest wartoscia wprowadzona w tej opcji.

Group all remaining items into a category called. Ta opcja umozliwia grupowanie wszystkich rzadko wystepujacych
pojec i typow w pojedyncza kategorig ,,zbiorcza” o nazwie wybranej przez uzytkownika. Domyslnie ta kategoria ma
nazwe Other.

Category input. Wybierz grupg, do ktorej chcesz zastosowac techniki:

* Unused extraction results. Ta opcja powoduje budowanie kategorii z wynikéw wyodrebniania, ktore nie sa
uzywane w zadnych istniejacych kategoriach. Minimalizuje to tendencj¢ do dopasowywania tych samych rekordow
do wielu kategorii i ogranicza liczbg generowanych kategorii.

* All extraction results. Ta opcja powoduje budowanie kategorii przy uzyciu dowolnych wynikéw wyodrebniania.
Taki sposdb postepowania jest najbardziej uzyteczny, gdy nie istnieja jeszcze kategorie lub jesli istnieje niewiele
kategorii.

Resolve duplicate category names by. Wybierz, w jaki sposdb postepowaé z nowymi kategoriami lub
podkategoriami, ktorych nazwy bylyby takie same, jak nazwy istniejacych kategorii. Mozna potaczy¢ nowe kategorie (i
ich deskryptory) z istniejacymi kategoriami o tej samej nazwie. Albo mozna pomina¢ tworzenie kategorii, jesli zostanie
znaleziona istniejaca kategoria o tej samej nazwie.

Uzupetnianie kategorii

Uzupehianie to proces polegajacy na automatycznym dodawaniu i doskonaleniu deskryptoréw w celu ,,powigkszenia”
istniejacych kategorii. Celem jest uzyskanie lepszych kategorii wychwytujacych pokrewne rekordy lub dokumenty,
ktére nie byty poczatkowo do nich przypisane.

Wybrane techniki automatycznego grupowania probuja zidentyfikowaé pojgcia, wzorce TLA i reguty kategorii
zwiazane z istniejacymi deskryptorami kategorii. Te nowe pojgcia, wzorce i reguty kategorii sa nastgpnie dodawane
jako nowe deskryptory lub dodawane do istniejacych deskryptorow. Techniki grupowania uzywane do uzupetniania
kategorii to: wywodzenie rdzenia pojecia,wiqczanie pojecia, sieci semantyczne (tylko dla jezyka angielskiego) i regufy
wspolwystepowania. Metoda Extend empty categories with descriptors generated from the category name
generuje deskryptory na podstawie wyrazéw wystepujacych w nazwach kategorii, dlatego im bardziej opisowe nazwy
kategorii, tym lepsze wyniki.

Uwaga: Techniki oparte na liczebnos$ci nie moga by¢ stosowane do uzupelniania kategorii.

Uzupehianie jest doskonalym sposobem interaktywnej optymalizacji kategorii. Ponizej znajduja si¢ przyktady sytuacji,
w ktorych mozna potencjalnie uzupetnic¢ kategorig:

* Po zakonczeniu przeciagania/upuszczania wzorcow pojeé w celu utworzenia kategorii w panelu Categories.

* Po recznym utworzeniu kategorii i dodaniu prostych regut i deskryptorow.

* Po zaimportowaniu pliku predefiniowanych kategorii z bardzo opisowymi nazwami kategorii.

* Po zoptymalizowaniu kategorii pochodzacych z pakietu TAP, jesli wybrano opcje¢ .

Tg sama kategori¢ mozna uzupetnia¢ wielokrotnie. Na przyktad, jesli zaimportowano plik predefiniowanych kategorii z
bardzo opisowymi nazwami, mozna najpierw uzupetni¢ kategorie za pomoca opcji Extend empty categories with
descriptors generated from the category name, aby uzyska¢ pierwszy zestaw deskryptorow, a nastgpnie ponownie
uzupehi¢ te kategorie. Jednak w innych przypadkach wielokrotne uzupetnianie moze skutkowa¢ powstaniem zbyt
ogolnej kategorii, jesli deskryptory beda z kazdym uzupetnieniem coraz szersze i szersze. Poniewaz w technikach
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budowania i uzupetniania stosowane sg podobne algorytmy, uzupehnienie kategorii bezposrednio po ich zbudowaniu
prawdopodobnie nie dostarczy bardziej interesujacych wynikow.

Wskazowka:

» Jesli po prébie uzupetnienia kategorii okaze si¢, ze wyniki sa niezadowalajace, zawsze mozna cofna¢ operacje (Edit
> Undo) od razu po zakonczeniu uzupetiania.

* W procesie uzupehniania w jednej kategorii moga powsta¢ dwie lub wigksza liczba regut pasujacych doktadnie do
tego samego zestawu dokumentdw, poniewaz reguly sa tworzone niezaleznie od siebie. W razie potrzeby mozna
przejrzec kategorie i usuna¢ nadmiarowos¢ poprzez reczna edycje opisu kategorii. Wigeej informacji zawiera temat
[Edytowanie deskryptorow kategorii” na stronie 131]

Aby uzupetnié kategorie
1. W panelu Categories wybierz kategorie, ktore chcesz uzupehic.

2. Z menu wybierz opcje Categories > Extend Categories. O ile nie wylaczono wszystkich monitow, zostanie
wyswietlony komunikat.

3. Wybierz, czy chcesz utworzy¢ kategorie teraz, czy najpierw edytowac ustawienia.

» Kliknij przycisk Extend Now, aby rozpocza¢ uzupelnianie kategorii przy uzyciu biezacych ustawien. Proces
rozpocznie si¢, a nastepnie zostanie wyswietlone okno dialogowe postepu.

» Kliknij przycisk Edit, aby przejrzec¢ i zmieni¢ ustawienia.

Po prébie uzupetnienia wszystkie kategorie, dla ktérych znaleziono nowe deskryptory, sa oznaczone przez stowo
Extended w panelu Categories, dzigki czemu mozna je szybko zidentyfikowac. Stowo Extended pozostaje widoczne
do chwili, az ponownie uzupetnisz kategorig, zmienisz ja w inny sposdb lub skasujesz to oznaczenie za pomoca menu
kontekstowego.

Uwaga: Maksymalna liczba kategorii, ktore moga by¢ wyswietlane, wynosi 10 000. Osiagnigcie lub przekroczenie tej
liczby spowoduje wyswietlenie ostrzezenia. W takiej sytuacji nalezy zmieni¢ opcje tworzenia lub uzupetniania
kategorii, aby ograniczy¢ liczbe tworzonych kategorii.

Kazda z dostgpnych technik dobrze nadaje si¢ do pracy z okreslonymi rodzajami danych i w okre§lonych warunkach,
jednak czesto przydatna jest mozliwos¢ potaczenia w jednej analizie réznych technik w celu wydobycia bogatszego
zbioru informacji z dokumentéw lub rekordow. W interaktywnym pulpicie roboczym pojecia i typy pogrupowane w
kategorig nadal moga by¢ wykorzystywane do tworzenia kategorii. Pojecie moze znalez¢ sig w wigcej niz jedne;j
kategorii, moga tez pojawi¢ sig¢ kategorie nadmiarowe.

W oknie dialogowym Extend Categories: Settings dostgpne sa nastgpujace obszary i pola:

Zastepowanie $rednia. Wybierz kryterium wejsciowe, ktdre bedzie uzywane do uzupetniania kategorii:

* Unused extraction results. Ta opcja powoduje budowanie kategorii z wynikow wyodrebniania, ktdre nie sa
uzywane w zadnych istniejacych kategoriach. Minimalizuje to tendencj¢ do dopasowywania tych samych rekordow
do wielu kategorii i ogranicza liczbg generowanych kategorii.

» All extraction results. Ta opcja powoduje budowanie kategorii przy uzyciu dowolnych wynikéw wyodrebniania.
Taki sposob postgpowania jest najbardziej uzyteczny, gdy nie istnieja jeszcze kategorie lub jesli istnieje niewiele
kategorii.

Techniki grupowania

Krotki opis kazdej z tych technik zawiera temat [“Zaawansowane ustawienia jezykowe” na stronie 102] Do tych technik
naleza:

* Concept root derivation
* Semantic network (tylko dla tekstu angielskiego i nieuzywana, jesli wybrana jest opcja Generalize only).
* Concept inclusion

* Co-occurrence i podopcja Minimum number of docs.
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Niektdre typy sa trwale wytaczone z techniki sieci semantycznych, poniewaz te typy nie beda generowac istotnych
wynikow. Do typow tych naleza: <Positive>, <Negative>, <IP>, inne typy nielingwistyczne itd.

Maximum search distance Wybierz, jak daleko ma by¢ prowadzone wyszukiwanie, zanim wygenerowane zostana
kategorie. Im mniejsza warto$¢, tym mniej wynikéw zostanie wygenerowanych, jednak wyniki te bgda mniej
zaszumione i z wigkszym prawdopodobienistwem bgda istotnie powiazane ze soba nawzajem. Im wigksza wartos$¢, tym
wigcej wynikOw zostanie wygenerowanych, ale wyniki te moga by¢ mniej wiarygodne lub istotne. Cho¢ opcja ta
obowiazuje globalnie we wszystkich technikach, jej dziatanie jest najbardziej odczuwalne w sieciach semantycznych i
analizie wspolwystapien.

Prevent pairing of specific concepts. Zaznacz to pole wyboru, aby w wynikach nie grupowac lub nie taczy¢ w pary
dwoch poje¢. Aby tworzy¢ pary pojec lub nimi zarzadzac, kliknij przycisk Manage Pairs... Wigcej informacji zawiera
temat [Zarzadzanie parami wyjatkow powiazan” na stronie 104}

Tam, gdzie to mozliwe: Wybierz, czy tylko uzupehié, czy uogdlni¢ deskryptory za pomoca znakow wieloznacznych,

czy jedno i drugie.

» Extend and generalize. Ta opcja spowoduje uzupetnienie wybranych kategorii, a nastgpnie uogolnienie
deskryptorow. Jesli wybierzesz opcj¢ uogdlnienia, produkt utworzy ogolne reguty kategorii w kategoriach przy
uzyciu wieloznacznego symbolu gwiazdki. Na przyktad, zamiast tworzy¢ wiele deskryptorow, takich jak [apple tart
+.]i[apple sauce + .], program moze wygenerowac ogolny deskryptor [apple * + .]. Generalizacja przy uzyciu
znakéw wieloznacznych prowadzi czgsto do uzyskania doktadnie takiej samej liczby rekordéw lub dokumentow, jak
poprzednio. Jednak zaleta tej opcji jest zmniejszenie liczby i uproszczenie deskryptoréw kategorii. Ponadto opcja ta
umozliwia potencjalnie klasyfikowanie wigkszej liczby nowych rekordéw lub dokumentdéw za pomoca tych samych
kategorii (na przyktad w badaniach podtuznych).

» Extend only. Ta opcja spowoduje uzupetnienie kategorii bez uogolniania. Celowe moze by¢ wybranie najpierw
opcji Extend only dla kategorii utworzonych recznie, a potem ponownie uzupenienie tych samych kategorii przy
uzyciu opcji Extend and generalize.

* Generalize only. Ta opcja spowoduje uogolnienie deskryptorow bez uzupetniania kategorii w inny sposob.

Uwaga: Wybranie tej opcji powoduje wyltaczenie opcji Semantic network, poniewaz opcja Semantic network jest
dostepna tylko w przypadku, gdy opis ma zosta¢ uzupetniony.

Inne opcje uzupetniania kategorii
Oprocz wybierania technik do zastosowania mozna zmieni¢ dowolne z nastgpujacych opcji:

Maximum number of items to extend a descriptor by. W przypadku uzupetiania deskryptora o elementy (pojgcia,
typy i inne wyrazenia) zdefiniuj maksymalna liczbg elementow, ktére mozna doda¢ do jednego deskryptora. Jesli ten
limit zostanie ustawiony na 10, to do istniejacego deskryptora zostanie dodanych nie wigcej niz 10 elementow. Jesli
istnieje wigcej niz 10 elementéw do dodania, technika przerwie dodawanie nowych elementéw po dziesiatym
elemencie. W ten sposob mozna skréci¢ listg deskryptordw, ale nie ma gwarancji, ze najbardziej interesujace elementy
zostana uzyte w pierwszej kolejnosci. Preferowane moze by¢ ograniczenie wielko$ci uzupetnienia bez pogorszenia
jakosci dzigki opcji Generalize with wildcards where possible. Ta opcja dotyczy tylko deskryptorow, ktore zawieraja
boolowskie operatory & (I) lub ! (NIE).

Also extend subcategories. Ta opcja powoduje rowniez uzupetnienie wszystkich kategorii ponizej wybranych.

Extend empty categories with descriptors generated from the category name. Ta metoda ma zastosowanie tylko do
pustych kategorii, ktore maja 0 deskryptorow. Jesli kategoria zawiera juz deskryptory, nie zostanie w ten sposob
uzupetiona. Ta opcja stuzy do automatycznego tworzenia deskryptorow dla kazdej kategorii na podstawie wyrazow,
ktdére tworza nazwe kategorii. Nazwa kategorii jest przeszukiwana w celu sprawdzenia, czy wyrazy w nazwie pasuja do
wyodrebnionych pojeé. Jesli jakies pojecie zostanie rozpoznane, zostanie uzyte do znalezienia zgodnych wzorcow
pojecia, ktore razem z nim stana si¢ deskryptorami kategorii. Ta opcja daje najlepsze wyniki, gdy nazwy kategorii sa
dhugie i opisowe. Jest to szybka metoda generowania deskryptorow kategorii, ktore z kolei umozliwiaja kategorii
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wychwytywanie rekordow zawierajacych te deskryptory. Ta opcja jest uzyteczna w przypadku importowania kategorii
z innego miejsca lub podczas recznego tworzenia kategorii z dtugimi nazwami opisowymi.

Generate descriptors as. Ta opcja ma zastosowanie tylko wtedy, gdy poprzednia opcja jest wybrana.
* Concepts. Wybierz te opcje, aby wygenerowaé wynikowe deskryptory w formie poje¢, niezaleznie od tego, czy
zostaty one wyodrebnione z tekstu zrodtowego.

* Patterns. Wybierz t¢ opcjg, aby wygenerowa¢ wynikowe deskryptory w formie poje¢, niezaleznie od tego, czy
wynikowe deskryptory lub jakiekolwiek inne deskryptory zostaty wyodrebnione z tekstu zrédtowego.

Reczne tworzenie kategorii

Kategorie mozna tworzy¢, uzywajac zautomatyzowanych technik tworzenia kategorii oraz edytora regut, a dodatkowo

mozna tworzy¢ kategorie recznie. Istnieja nastgpujace metody reczne:

» Tworzenie pustej kategorii, do ktdrej elementy sa dodawane pojedynczo. Wigcej informacji zawiera temat
[“Tworzenie nowych kategorii lub zmienianie nazw kategorii’]

* Przeciaganie terminow, typow i wzorcow do panelu kategorii. Wiecej informacji zawiera temat[“Tworzenie kategorii|
[za pomoca metody przeciagania i upuszczania’}

Tworzenie nowych kategorii lub zmienianie nazw kategorii

Mozna utworzy¢ puste kategorie w celu dodawania do nich poje¢ i typdw. Mozna rowniez zmienia¢ nazwy kategorii.

Aby utworzy¢ nowa pusta kategorig
1. Przejdz do panelu Categories.

2. Z menu wybierz kolejno opcje Categories > Create Empty Category. Otworzy si¢ okno dialogowe Category
Properties.

3. Wprowadz nazwg dla tej kategorii w polu Name.

4. Kliknij przycisk OK, aby zatwierdzi¢ nazwe i zamkna¢ okno dialogowe. Okno dialogowe zamyka si¢ i w panelu
pojawia si¢ nowa nazwa kategorii.

Mozesz teraz rozpocza¢ dodawanie do tej kategorii. Wiecej informacji zawiera temat[‘Dodawanie deskryptoréw doj
kategorii” na stronie 130]

Aby zmieni¢ nazwe kategorii

1. Wybierz kategorig i wybierz opcje Categories > Rename Category. Otworzy si¢ okno dialogowe Category
Properties.

2. Wprowadz nowa nazwg dla tej kategorii w polu Name.

3. Kliknij przycisk OK, aby zatwierdzi¢ nazwg i zamkna¢ okno dialogowe. Okno dialogowe zamyka si¢ i w panelu
pojawia si¢ nowa nazwa kategorii.

Tworzenie kategorii za pomoca metody przeciggania i upuszczania

Technika przeciagania i upuszczania jest technika r¢czna, a nie bazujaca na algorytmach. Mozna utworzy¢ kategorie w
panelu Categories, przeciagajac:

* Wyodrebnione pojgcia, typy lub wzorce z panelu Extraction Results do panelu Categories.
* Wyodrgbnione pojgcia w panelu Data do panelu Categories.

» Catle wiersze z panelu Data do panelu Categories. Spowoduje to utworzenie kategorii sktadajacej si¢ ze wszystkich
wyodregbnionych poje¢ i wzorcow zawartych w tym wierszu.

Uwaga: Panel Extraction Results obstuguje wybor wielu elementéw na raz, aby utatwic¢ uzytkownikowi przeciaganie i
upuszczanie wielu elementow.
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Wazne! Z panelu Data nie mozna przeciagac i upuszczac pojeé, ktore nie zostaty wyodrebnione z tekstu. Jesli cheesz
wymusi¢ wyodregbnienie pojecia, o ktérym wiesz, ze wystepuje w danych, dodaj to pojecie do typu. Nastepnie uruchom
ponownie proces wyodrgbniania. Nowe wyniki wyodrebniania beda zawiera¢ pojecie, ktory wiasnie zostalo dodane.
Nastepnie mozna go uzy¢ w kategorii. Wiecej informacji zawiera temat [‘Dodawanie poje¢ do typéw” na stronie 88}

Aby utworzy¢ kategorie za pomoca metody przeciagania i upuszczania:

1. Na panelu Extraction Results lub Data wybierz jedno lub kilka pojec, wzorcow, typdw, rekordow lub rekordow
czastkowych.

2. Przytrzymujac wcisnigty przycisk myszy, przeciagnij element do istniejacej kategorii lub do obszaru panelu, aby
utworzy¢ nowa kategorig.

3. Po osiagnigciu tego obszaru, w ktdrym chcesz upuscic¢ element, zwolnij przycisk myszy. Element zostanie dodany
do panelu Categories. Kategorie, ktore zostaly zmodyfikowane, sa wyswietlane ze specjalnym kolorem tla. Jest to
tak zwane tlo informacyjne kategorii. Wiecej informacji zawiera temat[‘Okreslanie opcji” na stronie 74

Uwaga: Wynikowej kategorii zostata automatycznie przypisana nazwa. Mozesz zmieni¢ t¢ nazwe. Wigcej informacji
zawiera temat[“Tworzenie nowych kategorii lub zmienianie nazw kategorii” na stronie 113|

Aby sprawdzi¢, ktore rekordy sa przypisane do kategorii, wybierz kategori¢ w panelu Categories. Panel danych
zostanie automatycznie od$wiezony 1 wyswietli wszystkie rekordy dla tej kategorii.

Korzystanie z regut kategorii

Kategorie mozna tworzy¢ na wiele sposobow. Jeden z tych sposobow jest zdefiniowanie regut kategorii wyrazajacych
idee. Reguly kategorii sa instrukcjami, ktére automatycznie klasyfikuja dokumenty lub rekordy w kategorie na
podstawie wyrazenia logicznego, uzywajac wyodrgbnionych pojeé, typdw i wzorcOw oraz operatorow boolowskich. Na
przyktad, mozna napisa¢ wyrazenie, ktore oznacza uwzglednij w tej kategorii wszystkie rekordy zawierajqce
wyodrebnione pojecie embassy, ale nie argentina.

Niektore reguty kategorii sa tworzone automatycznie podczas tworzenia kategorii przy uzyciu techniki grupowania,
takiej jak analiza wspotwystapien 1 wywodzenie rdzeni poje¢ (Categories > Build Settings > Advanced Settings:
Linguistics), jednak mozna réwniez utworzy¢ reguty kategorii recznie w edytorze regul, na podstawie wilasnej
interpretacji danych i kontekstu. Kazda reguta jest przypisana do jednej kategorii, dzigki czemu kazdy dokument lub
rekord pasujacy do reguly jest przypisywany do tej kategorii.

Reguly kategorii sprzyjaja jakosci i produktywnosci eksploracji tekstu i dalszej analizy ilosciowej, poniewaz pozwalaja
na bardziej precyzyjna kategoryzacje odpowiedzi. Doswiadczenie i wiedza biznesowa uzytkownika pozwala czgsto na
poglebiona interpretacjg danych i kontekstu. Mozna wykorzystac tg interpretacjg, aby przeksztatci¢ posiadana wiedzg w
reguly kategorii w celu kategoryzowania dokumentéw lub rekordow z jeszcze wigksza efektywnoscia i doktadnoscia.
Istota takich regut jest taczenie wyodrebnionych elementéw za pomoca operatoréw boolowskich.

Mozliwos¢ tworzenia regut zwigksza doktadnos¢, efektywnos¢ i produktywnos¢ kodowania, pozwalajac potaczy¢
wiedzg biznesowa z technologia wyodrgbniania.

U-waga: Aby zapoznac si¢ z przyktadami znajdowania tekstu przez reguty, patrz[‘Przyktady regut kategorii” na stronie]
120

Sktadnia regut kategorii

Niektdre reguly kategorii sa tworzone automatycznie podczas tworzenia kategorii przy uzyciu techniki grupowania,
takiej jak analiza wspotwystapien 1 wywodzenie rdzeni poje¢ (Categories> Build Settings > Advanced Settings:
Linguistics), jednak mozna rowniez utworzy¢ reguly kategorii recznie w edytorze regut. Kazda reguta jest
deskryptorem jednej kategorii, dlatego kazdy dokument lub rekord pasujacy do reguty jest automatycznie
przypisywany do tej kategorii.
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Uwaga: Aby zapoznaé sie z przyktadami znajdowania tekstu przez reguty, patrz[“Przyktady regut kategorii” na stronie]

Chcac utworzy¢ lub edytowac regulg, nalezy ja otworzy¢ w edytorze regut. Mozna dodawac pojecia, typy lub wzorce
oraz uzywac symboli wieloznacznych, aby uelastyczni¢ dopasowanie. Uzywajac wyodrebnionych pojeé, typow i
wzorcow, mozna skorzystac z funkcji wyszukiwania wszystkich poje¢ pokrewnych.

Wazne! Zalecamy przeciaganie i upuszczanie pojec¢ bezposrednio z panelu Extraction Results, Text Link Analysis lub
Data do edytora regut albo dodawanie ich za posrednictwem menu kontekstowego, co pozwoli unikna¢ najprostszych

pomytek.

Rozpoznanie pojgcia, typu lub wzorca jest sygnalizowane ikona wyswietlana obok tekstu.

Tabela 18. lkony wyodrebniania

Ikona Opis

, Wyodrgbnione pojecie
=l Wyodrebniony typ

43 Wyodregbniony wzorzec

Sktadnia i operatory regut

Ponizsza tabela zawiera znaki uzywane do definiowania sktadni regut. Znakow tych uzywa si¢ wraz z pojeciami,
typami i wzorcami.

Tabela 19. Obstugiwana sktadnia

Znakowa Opis

& Boolowskie ,,i”. Na przyktad a & b zawieraa i b ; oto konkretne przyktady:
- invasion & united states
- 2016 & olympics
- good & apple
Operator boolowski ,,lub” oznacza sumg logiczna, czyli do dopasowania wystarczy obecnos¢ jednego elementu.
Na przyktad a | b zawiera a lub b lub oba te elementy:
- attack | france
- condominium | apartment

) Boolowskie ,,nie”. Na przyktad !(a) nie zawiera a:
I(good & hotel), assassination & !(austria) lub !(gold) & !(copper)

* Symbol wieloznaczny reprezentujacy od jednego znaku do catego wyrazu, w zaleznosci od tego, jak zostat uzyty.
Wiecej informacji zawiera temat [‘Uzywanie symboli wieloznacznych w regutach kategorii” na stronie 118}

() Ogranicznik wyrazenia. Warto$¢ wyrazenia w nawiasach jest wyznaczana w pierwszej kolejnosci.

+ Lacznik wzorcow shuzacy do utworzenia wzorcow o okreslonej kolejnosci. Musi by¢ uzywany razem z
nawiasami kwadratowymi. Wiecej informacji zawiera temat[‘Uzywanie wzorcow TLA w regutach kategorii” nal
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Tabela 19. Obstugiwana sktadnia (kontynuacja)

Znakowa Opis

0 Ogranicznik wzorca jest wymagany, jesli w regule kategorii chcesz dopasowywac pojecia na podstawie
wyodregbnionego wzorca TLA. Zawarto$¢ nawiasow kwadratowych jest traktowana jako wzorzec TLA i nigdy
nie bedzie dopasowywana do pojg¢ lub typow na podstawie prostego wspotwystepowania. Jesli nie
wyodregbniono danego wzorca TLA, to dopasowanie nie bgdzie mozliwe. Wigcej informacji zawiera temat
[“Uzywanie wzorcow TLA w regutach kategorii”} Nie nalezy uzywac nawiasow kwadratowych, chcac dopasowaé
pojecia i typy.

Uwaga: W starszych wersjach wspolwystapienia i reguly synoniméw wygenerowane za pomoca technik
budowania kategorii byly ujete w nawiasy kwadratowe. W przypadku wszystkich nowych wersji nawiasy
kwadratowe wskazuja na obecno$¢ wzorca TLA. Zamiast tego reguly tworzone przez technike wspotwystapien i
synonimow sa ujmowane w nawiasy okragte, na przyktad (speaker systems|speakers).

Operatory & i |saprzemienne, zatema &b= b &aia|b= b|a.
Poprzedzanie znakow ukos$nikiem odwrotnym

Jesli pojecie zawiera znak, ktory jest rowniez elementem sktadni, nalezy umiesci¢ ukosnik odwrotny przed tym
znakiem, by reguta zostata poprawnie zinterpretowana. Znak ukosnika odwrotnego (\) jest uzywany do zmiany
znaczenia znakow, ktore bez niego maja specjalne znaczenie. W przypadku przeciagania i upuszczania elementow do
edytora ukosniki odwrotne sa dodawane automatycznie.

Nastgpujace znaki sktadni regut musza by¢ poprzedzone ukosnikiem odwrotnym, jesli maja by¢ one traktowane
dostownie:

1 | +<>()[]~

Poniewaz pojecie r&d zawiera operator "and" (&), wymagane jest uzycie ukosnika lewego w edytorze regut, np.: N&d.
Uzywanie wzorcow TLA w regutach kategorii

Wzorce analizy powiazan w tekscie moga by¢ jawnie zdefiniowane w regutach kategorii, co pozwala uzyskac jeszcze
bardziej konkretne i kontekstowe wyniki. Definiujac wzorzec w regule kategorii, pomijasz wyniki prostego
wyodregbniania i zadasz dopasowywania dokumentow i rekordow wyodrgbnionych wynikowych wzorcow analizy
powiazan w tekscie.

Wazne! Aby dopasowywa¢ dokumenty na podstawie wzorcow TLA w regulach kategorii, nalezy wczes$niej uruchomié
wyodrebnianie z wlaczona analiza powiazan w tek$cie. Regula kategorii bedzie szuka¢ dopasowan znalezionych
podczas tego procesu. Jesli nie wybrano opcji eksplorowania wynikéw TLA na karcie Model wezta Text Mining,
mozna wlaczy¢ wyodrebnianie TLA w ustawieniach wyodrebniania w sesji interaktywnej, a nastepnie ponownie
przeprowadzi¢ wyodrebnianie. Wiecej informacji zawiera temat [*Wyodrebnianie danych” na stronie 80}

Ujmowanie w nawiasy kwadratowe. Wzorzec TLA musi by¢ ujety w nawiasy kwadratowe [ ], jesli jest uzywany
wewnatrz reguly kategorii. Ogranicznik wzorca jest wymagany, jesli chcesz dopasowywac pojgcia na podstawie
wyodrebnionego wzorca TLA. Poniewaz reguly kategorii moga zawiera¢ typy, pojgcia lub wzorce, nawiasy wskazuja,
ze ich zawarto$¢ jest wyodrebnionym wzorcem TLA. Jesli nie wyodrebniono danego wzorca TLA, to dopasowanie nie
bedzie mozliwe. Jesli w panelu Categories widzisz wzorzec bez nawiasow, np. apple + good, to prawdopodobnie
wzorzec zostal dodany bezposrednio do kategorii poza edytorem regut kategorii. Na przyktad, jesli dodasz wzorzec
pojecia bezposrednio do kategorii z widoku analizy powiazan w tekscie, to nie bgdzie on wyswietlany w nawiasach
kwadratowych. Jednak uzywajac wzorzec w obrebie reguty kategorii, nalezy uja¢ wzorzec w nawiasy kwadratowe, na
przyktad [banana + !(good)].

Uzywanie znaku + we wzorcach. W programie IBM SPSS Modeler Text Analytics wzorzec moze sktadac sig
maksymalnie z 6 czg$ci. Aby wskazac, Ze kolejnos¢ jest istotna, potacz elementy znakiem +, na przyktad [company1
+ acquired + company2]. W tym przypadku kolejnos¢ jest istotna, poniewaz powoduje zmiang znaczenia — ktéra
spotka byla przejmujaca, a ktdra przejmowana. Kolejno$¢ nie jest okreslana przez strukturg zdania, ale przez strukture
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wynikowego wzorca TLA. Na przyktad, jesli masz tekst "I love Paris" i chcesz wyodrebnic jego znaczenie, wzorzec
TLA prawdopodobnie bedzie miat posta¢ [paris + like] lub [<Location> + <Positive>], a nie [<Positive> +
<Location>], poniewaz w domyslnych zasobach stuzacych do analizy opinii zwykle opinia znajduje sie na 2. miejscu
we wzorcu 2-czgsciowym. Dlatego celowe moze by¢ uzycie wzorca bezposrednio jako deskryptora kategorii. Jesli
jednak chcesz uzy¢ wzorca jako czg$¢ ztozonej instrukcji, zwrd¢ szczegdlng uwage na kolejnosé elementow w obrgbie
wzorcow w widoku Text Link Analysis, poniewaz kolejno$¢ ma duzy wpltyw na mozliwos¢ znalezienia dopasowania.

Zatdézmy na przyktad, ze masz dwa teksty: "I like pineapple" 1 "1 hate pineapple. However, 1 like strawberries".
Wyrazenie like & pineapple pasuje do obu tekstow, bo jest wyrazeniem opisujacym pojecie, a nie reguta TLA (nie jest
umieszczone w nawiasach kwadratowych). Wyrazenie pineapple + like pasuje tylko do tekstu "I like pineapple",
poniewaz w drugim tekscie wyraz like jest powiazany z wyrazem strawberries.

Grupowanie przy uzyciu wzorcow. Mozna uprosci¢ reguly za pomoca wlasnych wzorcow. Zatdézmy, ze chcesz
wychwyci¢ nastepujace trzy wyrazenia: cayenne peppers + like, chili peppers + like i peppers + like. Mozna je
pogrupowac w regule pojedynczej kategorii, na przyktad [* peppers & like]. Jesli masz takze wyrazenie hot peppers
+ good, mozesz pogrupowac wszystkie cztery za pomoca takiej reguly, jak [* peppers + <Positive>].

Kolejnos¢ we wzorcach. W celu lepszego zorganizowania wynikow reguly analizy powiazan w tekscie dostarczone w
szablonach instalowanych z produktem prébuja generowac proste wzorce w tej samej kolejnosci, bez wzgledu na
kolejnos¢ wyrazow w zdaniu. Na przyktad, jesli masz rekord zawierajacy tekst "Good presentations." 1 inny rekord
zawierajacy tekst "the presentations were good", to oba teksty pasuja do tej samej reguty i zostana na liscie
wynikowych wzorcow poje¢ wygenerowane w tej samej kolejnosci presentation + good, a nie jako dwa wzorce
presentation + good oraz good + presentation. A we wzorcu dwuczgsciowym, takim jak w przyktadzie, pojecia
przypisane do typow z biblioteki Opinions beda domyslnie prezentowane w wynikach na koncu, na przyktad apple +
bad.

Tabela 20. Korzystanie ze sktadni wzorcow i operatoréw boolowskich

Wyrazenie Pasuje do dokumentu lub rekordu, ktory

[1 Zawiera dowolny wzorzec TLA. Ogranicznik wzorca jest wymagany w regutach kategorii, jesli chcesz
dopasowywac na podstawie wyodrebnionego wzorca TLA. Zawarto$¢ nawiaséw kwadratowych jest
traktowana jako wzorzec TLA, a nie jako proste pojgcie lub typ. Jesli nie wyodrgbniono danego wzorca
TLA, to dopasowanie nie bedzie mozliwe.

Aby utworzy¢ regule, ktora nie zawiera zadnych wzorcéw, mozna uzy¢ sktadni ([ ]).

[a] Zawiera wzorzec, ktérego co najmniej jednym elementem na dowolnej pozycji jest a. Na przyktad
[deal] pasuje do [deal + good] i do samego [deal + .]

[a+b] Zawiera wzorzec pojecia. Na przyklad [deal + good)].
Uwaga: Jesli cheesz wychwyci¢ tylko ten wzorzec bez dodawania zadnych innych elementow,
zalecamy dodanie wzorca bezposrednio do kategorii, a nie tworzenie reguly z jego uzyciem.

[a+b+c] Zawiera wzorzec pojecia. Znak + oznacza, ze kolejno$¢ dopasowywanych elementow jest istotna. Na
przyktad [company1 + acquired + company2].

[<A> + <B>] Zawiera dowolny wzorzec typu <A> na pierwszej pozycji i typu <B> na drugiej pozycji; istnieja
doktadnie dwie pozycje. Znak + oznacza, ze kolejnos¢ dopasowywanych elementow jest istotna. Na
przyktad [<Budget> + <Negative>].

Uwaga: Jesli cheesz wychwyci¢ tylko ten wzorzec bez dodawania zadnych innych elementdw,
zalecamy dodanie wzorca bezposrednio do kategorii, a nie tworzenie reguly z jego uzyciem.

[<A> & <B>] Zawiera dowolny wzorzec typu <A> i typu <B>. Na przyktad [<Budget> & <Negative>]. Ten wzorzec
TLA nigdy nie zostanie wyodrebniony; jednak zapisany jako taki wzorzec w istocie rdwny jest
[<Budget> + <Negative>]|[<Negative> + <Budget>]. Kolejnos¢ dopasowywanych elementow jest
nieistotna. Ponadto inne elementy moga nie wystgpowac we wzorcu, ale musza co najmniej by¢ typu
<Budget> i <Negative>.
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Tabela 20. Korzystanie ze sktadni wzorcow i operatoréw boolowskich (kontynuacja)

Wyrazenie Pasuje do dokumentu lub rekordu, ktory
[a+] Zawiera wzorzec, w ktorym a jest jedynym pojeciem, a pozostate pozycje tego wzorca sa puste. Na
przyktad

[deal + .] pasuje do wzorca pojecia, w ktorym jedynym wynikiem jest pojecie deal. Jesli dodano
pojecie deal jako deskryptora kategorii, zwrécone zostalyby wszystkie rekordy z pojeciem deal, w tym
pozytywne opinie o tym pojeciu. Jednak wzorzec [deal + .] pasuje tylko do rekorddéw reprezentujacych
pojecie deal, ale nie inne relacje lub opinie, wiec nie pasuje na przyktad do deal + fantastic.

Uwaga: Jesli cheesz wychwyci¢ tylko ten wzorzec bez dodawania zadnych innych elementow,
zalecamy dodanie wzorca bezposrednio do kategorii, a nie tworzenie reguly z jego uzyciem.

[<A> + <>] Zawiera wzorzec, w ktorym <A> jest jedynym typem. Na przyktad [<Budget> + <>] pasuje do wzorca,
ktérego jedynym wynikiem jest pojecie typu <Budget>.

Uwaga: Mozna uzy¢ <> do okreslenia typu pustego, ale wylacznie za symbolem + we wzorcu typu, na
przyktad [<Budget> + <>], a nie np. we wzorcu [price + <>].

Uwaga: Jesli cheesz wychwycié tylko ten wzorzec bez dodawania zadnych innych elementow,
zalecamy dodanie wzorca bezposrednio do kategorii, a nie tworzenie reguly z jego uzyciem.

[a+(b)] Zawiera co najmniej jeden wzorzec, ktory obejmuje pojecie a, ale nie obejmuje pojecia b. Musi
obejmowac co najmniej jeden wzorzec.

Na przyktad [price + !(high)]

Iub w przypadku typéw: [/(<Fruit>|<Vegetable>) + <Positive>]

I([<A> & <B>]) Nie zawiera okreslonego wzorca. Na przyktad !([<Budget> & <Negative>]).

Uwaga: Aby zapoznaé sig z przyktadami znajdowania tekstu przez reguty, patrz[“Przyktady regut kategorii” na stronie]

20

Uzywanie symboli wieloznacznych w regutach kategorii

Do pojec¢ w regutach mozna dodawaé¢ symbole wieloznaczne, aby reguly pasowaty do szerszego zbioru pojec. Symbol
wieloznaczny gwiazdki (*) mozna umiescic przed i/lub po wyrazie, aby wskazaé¢ sposob, w jaki pojecia moga by¢
dopasowywane. Wyrdznia si¢ dwa zastosowania symboli wieloznacznych:

Symbole wieloznaczne dolaczane. Te znaki wstawiane sa od razu po tancuchu znakéw lub przed nim i nie sa
oddzielone od niego spacja. Na przyktad operat® pasuje do operat, operate, operates, operations, operational i tak
dale;j.

Symbole wieloznaczne zastepujace wyrazy. Takie symbole wieloznaczne (gwiazdki) poprzedzaja pojecie lub
nastgpuja po nim, ale sa oddzielone od niego spacja. Na przyktad * operation pasuje do operation, surgical
operation, post operation i tak dalej. Ponadto symbol wieloznaczny zastepujacy wyraz moze by¢ uzywany razem z
dotaczanym symbolem wieloznacznym, na przyktad * operat* * pasuje do operation, surgical operation, telephone
operator, operatic aria i tak dalej. Jak wida¢ w ostatnim przykladzie, zaleca si¢ ostrozne stosowanie symboli
wieloznacznych, aby ,,sie¢” nie zostala zarzucona zbyt szeroko i nie wychwycita niepozadanych wynikow.

Wyjatki!

Symbol wieloznaczny nie moze by¢ stosowany autonomicznie. Na przyktad niedopuszczalny jest zapis (apple | *).
Symbol wieloznaczny nie moze by¢ uzywany do dopasowywania nazw typow. <Negative*> nie pasuje do zadnej
nazwy typu.

Nie mozna wykluczy¢ wybranych typow z dopasowywania do pojg¢ znalezionych za pomoca symboli
wieloznacznych. Typ jest przypisywany do pojgcia automatycznie.

Symbol wieloznaczny nie moze znajdowac si¢ posrodku sekwencji wyrazow, czy to na koncu lub poczatku wyrazu
(open* account), czy to jako autonomiczny komponent (open * account). Nie mozna uzywaé symboli
wieloznacznych w nazwach typow. Na przyktad reguta w postaci wyraz* wyraz, taki jak apple* recipe, nie pasuje
do applesauce recipe ani w ogole do zadnego tekstu. Jednak , apple* * pasuje do applesauce recipe, apple pie, apple
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i tak dalej. Oto inny przyktad: wyraz * wyraz, na przyktad apple * toast, nie pasuje do apple cinnamon toast ani do
zadnego innego tekstu, poniewaz gwiazdka pojawia si¢ miedzy dwoma wyrazami. Jednak apple * pasuje do apple
cinnamon toast, apple, apple pie i tak dalej.

Tabela 21. Stosowanie symboli wieloznacznych

Wyrazenie

Pasuje do dokumentu lub rekordu, ktory

*apple

Obejmuje pojecie, ktore konczy si¢ podanymi literami, ale moze mie¢ dowolna liczbg liter w przedrostku.
Na przyktad: *apple konczy sig literami apple, ale moze mie¢ przedrostek:

- apple

- pineapple

- crabapple

apple*

Obejmuje pojgcie, ktdre rozpoczyna si¢ od podanych liter, ale moze mie¢ dowolna liczbg liter jako
przyrostek. Na przyktad: apple* zaczyna sig od liter apple, ale moze mie¢ przyrostek lub go nie mie¢:
- apple

- applesauce

- applejack

Na przyktad reguta apple* & !(pear™ | quince), ktory obejmuje pojgcie rozpoczynajace sig od liter apple,
ale nie pojecie rozpoczynajace sig od liter pear i nie pojecie quince, NIE pasuje do: apple & quince

ale pasuje do:
- applesauce
- apple & orange

*product*

Obejmuje pojecie, ktore zawiera podane litery product, ale moze mie¢ dowolna liczbe liter jako przedrostek
i/lub przyrostek.

Na przyktad *product” pasuje do:
- product

- byproduct

- unproductive

* loan

Obejmuje pojecie zawierajace wyraz loan, ale moze by¢ ztozone z innym wyrazem go poprzedzajacym. Na
przyktad * loan pasuje do:

- loan

- car loan

- home equity loan

Na przyktad [* delivery + <Negative>] obejmuje pojecie koriczace si¢ wyrazem delivery na pierwszej
pozycji i pojecie o typie <Negative> na drugiej pozycji. Taka reguta pasuje na przyktad do pojec¢:

- package delivery + slow

- overnight delivery + late

event *

Obejmuje pojecie zawierajace wyraz event, ale moze by¢ ztozone z innym wyrazem nastgpujacym po tym
wyrazie. Na przyktad event * pasuje do:

- event

- event location

- event planning committee
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Tabela 21. Stosowanie symboli wieloznacznych (kontynuacja)

Wyrazenie Pasuje do dokumentu lub rekordu, ktory

* apple * Obejmuje pojecie, ktére moze zaczynaé si¢ od dowolnego wyrazu, po ktorym nastgpuje wyraz apple i
potencjalnie nastepny wyraz. * oznacza 0 lub n wystapien, wiec taka reguta pasuje tez do apple. Na przyktad
* apple * pasuje do:

- gala applesauce

- granny smith apple crumble

- famous apple pie

- apple

Na przyktad reguta [* reservation™ * + <Positive>], ktéra obejmuje pojecie zawierajace wyraz reservation
(na dowolnej pozycji wewnatrz tego pojecia) na pierwszej pozycji oraz pojecie typu <Positive> na drugiej
pozycji pasowataby do:

- reservation system + good

- online reservation + good

Uwaga: Aby zapoznaé sig z przyktadami znajdowania tekstu przez reguty, patrz[“Przyktady regut kategorii’|

Przyktady regut kategorii

W celu zademonstrowania, w jaki sposob reguly sa dopasowywane do rekordow w zaleznosci od sktadni, prezentujemy
ponizszy przyktad.

Rekordy przyktadowe

Zatézmy, ze mamy dwa rekordy:

]

* Rekord A: ,, when I checked my wallet, I saw I was missing 5 dollars.’
* Rekord B: ,, $5 was found at the picnic area, but the blanket was missing.”

Nastgpujace dwie tabele przedstawiaja oczekiwane wyniki wyodrgbniania pojeé, typdw oraz wzorcow pojec i typow.

Pojgcia i typy wyodrgbnione z przyktadowych rekordow
Tabela 22. Pojecia i typy wyodrebnione z przyktadowych rekordow

Wyodrebnione pojecie Typ pojecia
wallet <Unknown>
missing <Negative>
USD5 <Currency>
blanket <Unknown>
picnic area <Unknown>

Wzorce TLA wyodrebnione z przyktadowych rekordow
Tabela 23. Wynikowe wzorce TLA wyodrebnione z przyktadowych rekordéw

Wyodrebnione wzorce pojec Wyodrebnione wzorce typow Z rekordu
picnic area + . <Unknown> + <> Rekord B
wallet + . <Unknown> + <> Rekord A
blanket + missing <Unknown> + <Negative> Rekord B
USD5 +. <Currency> + <> Rekord B
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Tabela 23. Wynikowe wzorce TLA wyodrebnione z przyktadowych rekordéw (kontynuacja)

Wyodrebnione wzorce pojec

Wyodrebnione wzorce typow

Z rekordu

USDS5 + missing

<Currency> + <Negative>

Rekord A

Mozliwe dopasowania generowane przez reguly kategorii

Ponizsza tabela zawiera przyktady sktadni, ktore mozna wprowadzi¢ w edytorze regut kategorii. Nie wszystkie podane
tutaj reguly dziataja i nie wszystkie pasuja do tych samych rekordéw. Oto, jak réznice w zapisie wptywaja na wyniki

dopasowywania rekorddw.

Tabela 24. Przyktadowe reguty

Skladnia reguly

Wynik

USDS5 & missing

Pasuje do rekordow A i B, poniewaz oba zawieraja wyodrebnione pojecie missing
i wyodrebnione pojecie USDS5. Jest rownowazna:
(USD5 & missing)

missing & USD5

Pasuje do rekordow A i B, poniewaz oba zawieraja wyodrebnione pojecie missing
i wyodrebnione pojecie USDS5. Jest rownowazna:
(missing & USD5)

missing & <Currency>

Pasuje do rekordow A i B, poniewaz oba zawieraja wyodrebnione pojecie missing
i pojecie typu <Currency>. Jest rOwnowazna:
(missing & <Currency>)

<Currency> & missing

Pasuje do rekordéw A i B, poniewaz oba zawieraja wyodregbnione pojgcie missing
i pojecie typu <Currency>. Jest rownowazna:
(<Currency> & missing)

[USDS5 + missing]

Pasuje do rekordu A, ale nie do B, poniewaz rekord B nie wygenerowat zadnych
wynikowych wzorcéw TLA zawierajacych pojecia USD5 + missing (patrz
poprzednia tabela). Jest to odpowiednik wynikowego wzorca TLA:

USDS5 + missing

[missing + USD5]

Nie pasuje ani do rekordu A, ani do B, poniewaz zaden z wyodrgbnionych
wzorcow TLA (patrz poprzednia tabela) nie pasuje do podane;j tutaj kolejnosci
(missing na pierwszej pozycji). Jest to odpowiednik wynikowego wzorca TLA:
USD5 + missing

[missing & USD5]

Pasuje do A, ale nie do B, poniewaz z rekordu B nie wyodrebniono takiego wzorca
TLA. Znak & wskazuje, ze kolejnos¢ jest nieistotna; dlatego ta reguta szuka
zardwno [missing + USD5], jak i [USD5 + missing]. Pasuje tylko [USD5 +
missing] z rekordu A.

[missing + <Currency>]

Nie pasuje ani do rekordu A, ani do B, poniewaz zaden wyodrgbniony wzorzec
TLA nie pasuje do tej kolejnosci. Tutaj brak odpowiednika, poniewaz wyniki TLA
oparte sa na terminach (USD5 + missing) lub typach (<Currency> +
<Negative>), ale nie na kombinacjach pojec i typow.

[<Currency> + <Negative>]

Pasuje do rekordu A, ale nie do B, poniewaz z rekordu B nie wyodrgbniono
zadnego wzorca TLA. Jest to odpowiednik wynikowego wzorca TLA:
<Currency> + <Negative>

[<Negative> + <Currency>]

Nie pasuje ani do rekordu A, ani do B, poniewaz zaden wyodrgbniony wzorzec
TLA nie pasuje do tej kolejnosci. W szablonie Opinions znalezienie tematu z
opiniq powoduje, ze temat (<Currency>) zajmuje domyslnie pierwsza pozycje, a
opinia (<Negative>) zajmuje druga pozycje.

Tworzenie regut kategorii

Aby tworzy¢ lub edytowac regule, nalezy otworzy¢ ja w edytorze regut. Mozna dodawac pojecia, typy lub wzorce oraz
uzywac symboli wieloznacznych, aby uelastyczni¢ dopasowanie. Uzywanie rozpoznanych pojeé, typow i wzorcow jest
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dobrym wyborem, poniewaz umozliwia znajdowanie wszystkich poje¢ pokrewnych. Na przyktad uzycie pojecia
spowoduje, ze reguta bedzie takze znajdowala wszystkie powiazane z nim terminy, formy w liczbie mnogiej i
synonimy. Podobnie uzycie typu powoduje, ze reguta wychwytuje wszystkie pojgcia przypisane do tego typu.

Istniejaca regute mozna otworzy¢ w edytorze regut, klikajac prawym przyciskiem myszy nazwe kategorii i wybierajac
opcje Create Rule.

W edytorze mozna uzywaé menu kontekstowych, techniki przeciagania i upuszczania lub recznie wprowadzac¢ pojecia,
typy i wzorce. Elementy te mozna taczy¢ za pomoca operatoréw boolowskich. (&, |(), |) i yymowa¢ w nawiasy,
formutujac w ten sposdb wyrazenia opisujace reguty. Zalecamy przeciaganie i upuszczanie poje¢ bezposrednio z
panelu Extraction Results lub panelu Data do edytora regut, co pozwoli unikna¢ najprostszych pomytek. Aby uniknaé
b%ﬁiéw, nalezy $cisle przestrzegac¢ sktadni regut. Wigcej informacji zawiera temat|“Sktadnia regut kategorii” na stronie|
114

U-waga: Aby zapoznac sig z przyktadami znajdowania tekstu przez reguty, patrz|“‘Przyktady regut kategorii” na stronie]
120

Aby utworzy¢ regule

1. Jesli jeszcze nie zostaly wyodrebnione zadne dane lub wyniki wyodrebniania sa nieaktualne, przeprowadz teraz
wyodrebnianie. Wigcej informacji zawiera temat [*Wyodrebnianie danych” na stronie 80|

Uwaga: Jesli filtr wyodrebniania spowoduje, ze nie beda widoczne zadne pojgcia, to przy probie utworzenia lub
edytowania reguly kategorii zostanie wyswietlony komunikat o blgdzie. Aby temu zapobiec, zmodyfikuyj filtr
wyodrgbniania tak, by pojecia byly dostepne.

2. W panelu Categories wybierz kategorig, do ktdrej chcesz dodaé regule.

w

Z menu wybierz kolejno opcje Categories > Create Rule. W oknie zostanie otwarty panel edytora regut kategorii.

4. W polu Rule Name wprowadz nazwe reguly. Jesli nie podasz nazwy, za nazwg automatycznie przyjete zostanie
wyrazenie. Nazwg reguly mozesz pozniej zmienic.
5. W wigkszym polu tekstowym wyrazenia mozna:
* Bezposrednio wprowadzac tekst lub przeciaga¢ go z innych paneli. Uzywac¢ tylko wyodregbnionych pojeé, typow
1 wzorcow. Na przyklad, jesli wprowadzisz wyraz cats, ale na panelu Extraction Results figuruje on tylko w
liczbie pojedynczej (cat), to edytor nie rozpozna wyrazu cats. W takiej sytuacji mozliwe jest, ze forma
pojedyncza automatycznie uwzglednia takze liczbe mnoga. Jesli nie, to mozna uzy¢ symbolu wieloznacznego.
Wigcej informacji zawiera temat [‘Sktadnia regut kategorii” na stronie 114}

* Wybierz pojecia, typy lub wzorce, ktore chcesz dodaé do reguly, i skorzystaj z menu.

* Dodaj operatory boolowskie, aby powiaza¢ elementy reguty. Za pomoca przyciskow na pasku narz¢dzi mozesz
doda¢ do reguty operator ,,i” &, operator ,,lub” |, operator ,,nie” !(), nawiasy okragte () i nawiasy kwadratowe
oznaczajace wzorzec [ |.

6. Kliknij przycisk Test Rule, aby sprawdzi¢, czy reguta jest prawidlowo zdefiniowana. Wigcej informacji zawiera
temat|“Sktadnia regut kategorii” na stronie 114} Obok napisu Test result pojawi si¢ liczba znalezionych
dokumentéw lub rekordéw. Na prawo od tego napisu widoczna jest liczba elementow rozpoznanych przez regute
oraz ewentualne komunikaty o btedach. Jesli ikona obok typu, wzorca lub pojgcia jest opatrzona czerwonym
znakiem zapytania, oznacza to, ze dany element nie pasuje do zadnych znanych wyodrebnionych elementow. W
takim przypadku regula nie znajdzie zadnych rekordow.

7. Aby przetestowac czgs¢ reguly, zaznacz tg czg$¢ i kliknij przycisk Test Selection.
8. W razie napotkania probleméw wprowadz niezb¢dne zmiany i ponownie przetestuj regule.

9. Po zakonczeniu kliknij przycisk Save & Close, aby ponownie zapisac regulg i zamknac edytor. Nazwa nowe;j
reguly pojawi si¢ w kategorii.

Edytowanie i usuwanie regut

Po utworzeniu i zapisaniu reguty mozna ja w dowolnej chwili podda¢ edycji. Wigcej informacji zawiera temat
[‘Sktadnia regut kategorii” na stronie 114
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Jesli reguta nie jest juz potrzebna, mozna ja usunac.

Aby edytowa¢ reguty
1. Wybierz regute w tabeli Descriptors w oknie dialogowym Category Definitions.

2. Z menu wybierz kolejno opcje Categories > Edit Rule lub kliknij dwukrotnie nazwg reguly. Zostanie otwarte okno
edytora z wybrana reguta.

3. Wprowadz niezbedne zmiany w regule, korzystajac z wynikdw wyodrebniania i przyciskow na pasku narzedzi.
4. Ponownie przetestuj regule, aby upewnic sig, ze zwraca oczekiwane wyniki.
5. Kliknij przycisk Save & Close, aby ponownie zapisac¢ regulg i zamknac edytor.

Aby usunac regule
1. Wybierz regute w tabeli Descriptors w oknie dialogowym Category Definitions.

2. Z menu wybierz kolejno opcje Edit > Delete. Regula zostanie usunigta z kategorii.

Importowanie i eksportowanie predefiniowanych kategorii

Jesli wlasne kategorie sa zapisane w programie Microsoft Excel (*.xls, *.xlsx), mozna je zaimportowa¢ do produktu
IBM SPSS Modeler Text Analytics .

Mozna réwniez eksportowac kategorie, ktdre sa otwarte w projekcie interaktywnego pulpitu roboczego do formatu
plikéw Microsoft Excel (*.xIs, *.xlsx). Podczas eksportowania kategorii mozna zadecydowac, aby uwzgledni¢ lub
wylaczy¢ niektére informacje dodatkowe, takie jak deskryptory i oceny. Wigcej informacji zawiera temat
[‘Eksportowanie kategorii” na stronie 127]

Jesli twoje predefiniowane kategorie nie maja kodow lub gdy potrzebujesz nowych kodoéw, mozna automatycznie
wygenerowaé nowy zbior kodow dla zestawu kategorii w panelu Categories, wybierajac kolejno opcje Categories >
Manage Categories > Autogenerate Codes z menu. Spowoduje to usunigcie istniejacych kodow i1 automatyczne ich
ponumerowanie.

Importowanie predefiniowanych kategorii

Mozliwe jest importowanie predefiniowanych kategorii do produktu IBM SPSS Modeler Text Analytics . Przed
importowaniem upewnij si¢, ze plik predefiniowanej kategorii znajduje si¢ w pliku Microsoft Excel (*.xls, * x/sx) i ma
strukturg jednego z formatéw pomocniczych. Mozna ustawié¢, aby produkt automatycznie wykrywat format za
uzytkownika. Obshugiwane sa nastepujace formaty:

* Flat list format: Wiecej informacji mozna znalezé¢ w temacie [‘Plaski format listy” na stronie 124]

+ Compact format: Wiccej informacji mozna znalezé w temacie [‘Format kompaktowy” na stronie 125}

+ Indented format: Wigcej informacji mozna znalez¢ w temacie [ ‘Format wcigty” na stronie 126}

Aby importowac predefiniowane kategorie

1. W menu interaktywnego pulpitu roboczego wybierz kolejno opcje Categories > Manage Categories > Import
Predefined Categories. Wyswictlony zostaje kreator Import Predefined Categories.

Z listy rozwijanej Look In wybierz naped i folder, w ktérym znajduje sig plik.

Wybierz plik z listy. Nazwa pliku pojawia sig w polu tekstowym File Name.

Z listy wybierz arkusz zawierajacy predefiniowane kategorie. Nazwa arkusza pojawia si¢ w polu Worksheet.
Aby rozpocza¢ wybieranie formatu danych, kliknij przycisk Next.

oo kw0

Wybierz format dla swojego pliku lub wybierz opcjg, aby pozwoli¢ produktowi na probg automatycznego
wykrycia formatu. Automatyczne wykrywanie dziata najlepiej dla najbardziej powszechnych formatow.

* Flat list format: Wigcej informacji mozna znalez¢é w temacie|“P%aski format listy” na stronie 124l

+ Compact format: Wiecej informacji mozna znalez¢ w temacie [ ‘Format kompaktowy” na stronie 125

+ Indented format: Wiccej informacji mozna znalez¢ w temacie [“Format weiety” na stronie 126]
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7.

8.

10.

11.

12.

13.

14.

15.

16.

Aby zdefiniowa¢ dodatkowe opcje importowania, kliknij przycisk Next. Jesli zadecydujesz, aby automatycznie
wykry¢ format, przejdziesz do koncowego kroku.

Jesli jeden lub wigcej wierszy zawiera nagldwki kolumn lub inne informacje zewngetrzne, w opcji Start import at
row wybierz numer wiersza, od ktérego chcesz rozpocza¢ importowanie. Na przyktad: jesli nazwy kategorii
rozpoczynaja si¢ w wierszu 7, musisz wprowadzi¢ liczbg 7 dla tej opcji, aby poprawnie zaimportowaé plik.

Jesli plik zawiera kody kategorii, zaznacz opcj¢ Contains category codes. Pomaga to kreatorowi poprawnie
rozpozna¢ dane.

Sprawdz oznaczone kolorami komorki i legendg, aby upewnic€ sig, ze dane zostaty poprawnie zidentyfikowane.
Wszelkie btedy wykryte w pliku wyswietlone sa na czerwono i odwotanie do nich wyswietlane jest ponizej tabeli
podgladu formatu. Jesli wybrano nieprawidlowy format, cofnij i wybierz inny. Jesli chcesz wprowadzi¢ poprawki
w pliku, wprowadz zmiany i uruchom ponownie kreatora, wybierajac znéw plik. Przed zakonczeniem dziatania
kreatora nalezy poprawi¢ wszystkie btedy.

Aby sprawdzi¢ zestaw kategorii i podkategorii, ktore zostana zaimportowane i aby zdefiniowac, w jaki sposob
tworzy¢ deskryptory dla tych kategorii, kliknij przycisk Next.

Przejrzyj zestaw kategorii, ktory bedzie zaimportowany do tabeli. Jesli nie sa widoczne stowa kluczowe
oczekiwane jako deskryptory, mozliwe, ze nie zostaly rozpoznane podczas importu. Upewnij sig, ze maja
poprawny przedrostek i pojawiaja si¢ we wlasciwej komorce.

Wybierz, jak obstugiwac¢ istniejace wczesniej kategorie w sesji.

* Replace all existing categories. Ta opcja czysci wszystkie istniejace kategorie, a nastgpnie tylko nowo
zaimportowane kategorie sa uzywane na ich miejsce.

* Append to existing categories. Ta opcja zaimportuje kategorie i scali wszelkie wspolne kategorie z
istniejacymi kategoriami. Podczas dodawania elementow do istniejacych kategorii nalezy okresli¢, w jaki
sposob obstugiwane beda duplikaty. Jedna z mozliwosci (opcja: Merge) jest scalanie importowanych kategorii
z istniejacymi kategoriami, jesli maja wspolna nazwe kategorii. Kolejna mozliwoscia (opcja: Exclude from
import) jest zakazanie importowania kategorii, jesli istnieje juz taka o tej samej nazwie.

Import keywords as descriptors to opcja importowania stow kluczowych zidentyfikowanych w danych jako

deskryptorow dla powiazanej kategorii.

Extend categories by deriving descriptors to opcja, ktdra wygeneruje deskryptory ze stow, ktore reprezentuja
nazwg kategorii lub podkategorii i/lub stow, ktore tworza adnotacje. Jesli stowa odpowiadaja wyodrgbnionym
wynikom, sa dodawane jako deskryptory do kategorii. Opcja zapewnia najlepsze wyniki, gdy nazwy kategorii lub
adnotacje sa dtugie i opisowe. Jest to szybka metoda wygenerowania deskryptorow kategorii, ktora pozwala na
przechwycenie rekorddw zawierajacych te deskryptory.

* Pole From pozwala na wybranie, z jakiego tekstu tworzone beda deskryptory: z nazw lub kategorii i
podkategorii, czy stow w adnotacjach Iub z obu opcji.

* Pole As pozwala na wybranie, aby tworzy¢ te deskryptory w formie pojec lub wzorcow TLA. Jesli
wyodregbnianie TLA nie miato miejsca, opcje wzorcow sa wytaczone w tym kreatorze.

Aby zaimportowaé wstepnie zdefiniowane kategorie do panelu Categories, kliknij przycisk Finish.

Ptaski format listy
Na ptaskim formacie listy istnieje tylko gorny poziom kategorii bez hierarchii, co oznacza brak podkategorii lub
podsieci. Nazwy kategorii znajduja si¢ w pojedynczej kolumnie.

Plik w tym formacie moze zawiera¢ nastgpujace informacje:

Opcjonalna kolumna codes zawiera warto$ci numeryczne, ktére jednoznacznie identyfikuja kazda kategorig. Jesli
okreslisz, ze plik danych zawiera kody (opcja Contains category codes w kroku Content Settings), to kolumna

zawierajaca unikalne kody dla kazdej kategorii musi wystgpowa¢ w komorce bezposrednio po lewej stronie nazwy
kategorii. Jesli dane nie zawieraja kodow, ale chcesz wygenerowaé kody pozniej, zawsze mozesz to zrobié
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(Categories > Manage Categories > Autogenerate Codes).

Wymagana kolumna category names zawiera wszystkie nazwy kategorii. Ta kolumna jest wymagana do
importowania przy uzyciu tego formatu.

Opcjonalne adnotacje w komorce bezposrednio po prawej stronie nazwy kategorii. Adnotacja zawiera tekst
opisujacy kategorie/podkategorie.
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* Opcjonalne stowa kluczowe mozna zaimportowac jako deskryptory dla kategorii. Aby stowa kluczowe zostaty
rozpoznane, musza wystgpowac w komorce bezposrednio pod powiazana nazwa kategorii/podkategorii, a lista stow
kluczowych musi by¢ poprzedzona znakiem podkreslenia (_), np.: _firearms, weapons / guns. Komorka stow
kluczowych moze zawiera¢ jedno lub wiele stdéw uzywanych do opisania kazdej kategorii. Te stowa zostang
zaimportowane jako deskryptory lub zignorowane w zaleznosci od tego, co okreslono w ostatnim kroku kreatora.
Pozniej deskryptory sa pordownywane z wyodrgbnionymi wynikami z tekstu. Jesli znaleziono dopasowanie, to ten
rekord lub dokument jest oceniany w kategorii zawierajacej ten deskryptor.

Tabela 25. Ptaski format listy z kodami, stowami kluczowymi i adnotacjami

Kolumna A Kolumna B Kolumna C

Kod kategorii (opcjonalny) Nazwa kategorii Adnotacja

_Deskryptor/lista stow kluczowych
(opcjonalnie)

Format kompaktowy

Format kompaktowy ma podobna strukturg do ptaskiego formatu listy z taka roznica, ze format kompaktowy jest
uzywany z kategoriami hierarchicznymi. Dlatego tez wymagana jest kolumna poziomu kodu, aby zdefiniowac poziom
hierarchii kazdej kategorii i podkategorii.

Plik w tym formacie moze zawiera¢ nastgpujace informacje:

* Wymagana kolumna code level zawiera numery, ktore wskazuja pozycje hierarchiczna dla kolejnych informacji w
tym wierszu. Na przyktad: jesli okreslono wartosci 1, 2 lub 3 i istnieja zardwno kategorie, jak i podkategorie, to 1
oznacza kategorie, 2 podkategorie, a 3 pod-podkategorie. Jesli istnieja tylko kategorie i podkategorie, 1 oznacza
kategorie, a 2 podkategorie. I tak dalej, az do wymaganej glebokosci kategorii.

* Opcjonalna kolumna codes zawiera wartosci, ktore jednoznacznie identyfikuja kazda kategorig. Jesli okreslisz, ze
plik danych zawiera kody (opcja Contains category codes w kroku Content Settings), to kolumna zawierajaca
unikalne kody dla kazdej kategorii musi wystgpowac¢ w komorce bezposrednio po lewej stronie nazwy kategorii.
Jesli dane nie zawieraja kodow, ale chcesz wygenerowac kody pozniej, zawsze mozesz to zrobi¢ (Categories >
Manage Categories > Autogenerate Codes).

* Wymagana kolumna category names zawiera wszystkie nazwy kategorii 1 podkategorii. Ta kolumna jest wymagana
do importowania przy uzyciu tego formatu.

* Opcjonalne adnotacje w komorce bezposrednio po prawej stronie nazwy kategorii. Adnotacja zawiera tekst
opisujacy kategorie/podkategorie.

* Opcjonalne stowa kluczowe mozna zaimportowac¢ jako deskryptory dla kategorii. Aby stowa kluczowe zostaty
rozpoznane, musza wystgpowa¢ w komorce bezposrednio pod powiazana nazwa kategorii/podkategorii, a lista stow
kluczowych musi by¢ poprzedzona znakiem podkreslenia (_), np.: _firearms, weapons / guns. Komorka stow
kluczowych moze zawiera¢ jedno lub wiele stéw uzywanych do opisania kazdej kategorii. Te stowa zostang
zaimportowane jako deskryptory lub zignorowane w zaleznosci od tego, co okreslono w ostatnim kroku kreatora.
Poézniej deskryptory sa porownywane z wyodrgbnionymi wynikami z tekstu. Jesli znaleziono dopasowanie, to ten
rekord lub dokument jest oceniany w kategorii zawierajacej ten deskryptor.

Tabela 26. Przykiad formatu kompaktowego z kodami

Kolumna A Kolumna B Kolumna C
Poziom koddw hierarchicznych Kod kategorii (opcjonalny) Nazwa kategorii
Poziom kodow hierarchicznych Kod podkategorii (opcjonalny) Nazwa podkategorii

Tabela 27. Przykiad formatu kompaktowego bez kodéw

Kolumna A Kolumna B
Poziom kodow hierarchicznych Nazwa kategorii
Poziom kodow hierarchicznych Nazwa podkategorii
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Format wciety

We weietym formacie pliku zawarto$¢ jest hierarchiczna, co oznacza, ze zawiera kategorie i jeden lub wiele pozioméw
podkategorii. Dodatkowo jego struktura jest wcigta, aby oznaczy¢ t¢ hierarchig. Kazdy wiersz w pliku zawiera
kategorig lub podkategorig, ale podkategorie sa wcigte w stosunku do kategorii, a ewentualne pod-podkategorie sa
wecigte w stosunku do podkategorii itd. Mozna r¢cznie utworzy¢ te strukturg w programie Microsoft Excel lub uzy¢
struktury eksportowanej z innego produktu i zapisanej w formacie aplikacji Microsoft Excel.

Kody kategorii najwyzszego poziomu i nazwy Kkategorii zajmuja odpowiednio kolumny A i B. Jesli kody nie
wystepuja, nazwa kategorii znajduje si¢ w kolumnie A.

Kody podkategorii i nazwy podkategorii zajmuja odpowiednio kolumny B i C. Jesli kody nie wystgpuja, nazwa
podkategorii znajduje si¢ w kolumnie B. Podkategoria jest cztonkiem kategorii. Nie moga istnie¢ podkategorie, jesli
nie istnieja kategorie najwyzszego poziomu.

Tabela 28. Wecieta struktura z kodami

Kolumna A Kolumna B Kolumna C Kolumna D

Kod kategorii Nazwa kategorii

(opcjonalny)

Kod podkategorii (opcjonalny) | Nazwa podkategorii

Kod pod-podkategorii Nazwa pod-podkategorii
(opcjonalny)

Tabela 29. Wecieta struktura bez kodéw

Kolumna A Kolumna B Kolumna C

Nazwa kategorii

Nazwa podkategorii

Nazwa pod-podkategorii

Plik w tym formacie moze zawiera¢ nast¢pujace informacje:

Opcjonalne kody musza by¢ wartosciami, ktore jednoznacznie identyfikuja kazda kategorig lub podkategorig. Jesli
okreslisz, ze plik danych zawiera kody (opcja Contains category codes w kroku Content Settings), to unikalny kod
dla kazdej kategorii lub podkategorii musi wystgpowac¢ w komorce bezposrednio po lewej stronie nazwy
kategorii/podkategorii. Jesli dane nie zawieraja kodow, ale chcesz wygenerowaé kody pdzniej, zawsze mozesz to
zrobi¢ (Categories > Manage Categories > Autogenerate Codes).

Wymagana nazwa dla kazdej kategorii i podkategorii. Podkategorie musza by¢ wcigte wzgledem kategorii o jedna
kolumng w prawo w osobnym wierszu.

Opcjonalne adnotacje w komodrce bezposrednio po prawej stronie nazwy kategorii. Adnotacja zawiera tekst
opisujacy kategorie/podkategorie.

Opcjonalne stowa kluczowe mozna zaimportowac jako deskryptory dla kategorii. Aby stowa kluczowe zostaly
rozpoznane, musza wystgpowac w komorce bezposrednio pod powiazana nazwa kategorii/podkategorii, a lista stow
kluczowych musi by¢ poprzedzona znakiem podkreslenia (_), np.: _firearms, weapons / guns. Komorka stow
kluczowych moze zawiera¢ jedno lub wiele stéw uzywanych do opisania kazdej kategorii. Te stowa zostana
zaimportowane jako deskryptory lub zignorowane w zaleznosci od tego, co okreslono w ostatnim kroku kreatora.
Pdzniej deskryptory sa porownywane z wyodrebnionymi wynikami z tekstu. Jesli znaleziono dopasowanie, to ten
rekord Iub dokument jest oceniany w kategorii zawierajacej ten deskryptor.

Wazne! Jesli uzywasz kodu na jednym poziomie, musisz uwzgledni¢ kod dla kazdej kategorii i podkategorii. W
przeciwnym razie proces importowania zakonczy si¢ niepowodzeniem.
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Eksportowanie kategorii

Mozna réwniez eksportowac kategorie, ktdre sa otwarte w projekcie interaktywnego pulpitu roboczego do formatu
plikéw Microsoft Excel (*.xls, *.xlsx). Dane, ktore beda eksportowane pochodza gltéwnie z biezacej zawartosci panelu
Categories lub z wlasciwosci kategorii. Dlatego tez zalecamy ponowne wykonanie oceny, jesli planujesz eksportowac
wartos¢ oceny Docs .

Tabela 30. Opcje eksportu kategorii

Zawsze eksportowane Eksportowane opcjonalnie
» Kody kategorii, jesli istnieja * Oceny Docs. .

* Nazwy kategorii (i podkategorii) * Adnotacje kategorii

* Poziomy kodow, jesli istnieja (format Flat/Compact) * Nazwy deskryptorow

* Nagtéwki kolumn (format Flat/Compact) * Liczebnosci deskryptorow

Wazne! Kiedy eksportowane sa deskryptory, sa one przeksztalcane na tancuchy tekstowe z przedrostkiem w formie
podkreslenia. Przy ponownym importowaniu do produktu zostaje utracona zdolnos$¢ do rozréznienia pomigdzy
deskryptorami, ktore sa wzorcami, regutami kategorii i zwyktymi pojgciami. Jesli zamierzasz uzy¢ ponownie tych
kategorii w tym produkcie, stanowczo zalecamy utworzenie pliku TAP (text analysis package), poniewaz format TAP
zachowa wszystkie deskryptory w zdefiniowanej obecnie formie, jak rowniez wszystkie kategorie, kody oraz uzywane
zasoby lingwistyczne. Pliki TAP moga by¢ uzywane w programach IBM SPSS Modeler Text Analytics i IBM SPSS
Text Analytics for Surveys. Wigcej informacji zawiera temat [‘Korzystanie z pakietow analizy tekstu (TAP)|

Aby eksportowac predefiniowane kategorie

1. W menu interaktywnego pulpitu roboczego wybierz kolejno opcje Categories > Manage Categories > Export
Categories. Wyswietlony zostaje kreator Export Categories.

Wybierz lokalizacjg 1 wprowadz nazwg pliku, ktory bedzie eksportowany.
W polu tekstowym File Name wprowadz nazwe pliku wynikow.
Aby wybra¢ format, do ktorego beda eksportowane dane kategorii, kliknij przycisk Next.

ok 0N

Wybierz format sposrdd nastgpujacych:

* Flat or Compact list format: Wigcej informacji mozna znalezé w temacie |[“Plaski format listy”” na stronie 124]
Listy Flat nie zawieraja podkategorii. Wigcej informacji zawiera temat [“Format kompaktowy” na stronie 125|
Listy Compact zawieraja kategorie hierarchiczne.

+ Indented format: Wiccej informacji mozna znalez¢ w temacie [“Format wciety” na stronie 126]

6. Aby wybrac tresci do eksportowania i aby przejrze¢ proponowane dane, kliknij przycisk Next.
7. Przejrzyj tresci dla eksportowanego pliku.

8. Zaznacz lub usun zaznaczenie ustawien dodatkowych tresci, ktore maja by¢ eksportowane, takie jak Annotations
lub Descriptor names.

9. Aby eksportowac kategorie, kliknij przycisk Finish.

Korzystanie z pakietow analizy tekstu (TAP)

Pakiet analizy tekstu (TAP — text analysis package) pehni rolg szablonu kategoryzacji odpowiedzi tekstowych.
Korzystajac z pakietu TAP, mozna tatwo przeprowadzi¢ kategoryzacjg danych tekstowych przy minimalnym
zaangazowaniu uzytkownika. Pakiet zawiera bowiem gotowe zestawy kategorii i zasoby lingwistyczne potrzebne do
szybkiego i automatycznego zakodowania duzej liczby rekordéw. Przy uzyciu zasobow lingwistycznych dane tekstowe
sa analizowane i eksplorowane w celu wyodrebnienia kluczowych pojeé. Na podstawie kluczowych pojec i wzorcow
znalezionych w tek$cie mozna przypisac rekordy do kategorii z zestawu kategorii wybranego w pakiecie TAP. Mozna
utworzy¢ wilasny pakiet TAP lub zmodyfikowac istniejacy.

W sktad pakietu TAP wchodza nastgpujace elementy:
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» Zestaw(y) kategorii. Zestaw kategorii zasadniczo sktada si¢ z predefiniowanych kategorii, kodow kategorii,
deskryptorow poszczegolnych kategorii oraz nazwy catego zestawu. Deskryptory sa elementami lingwistycznymi
(pojeciami, typami, wzorcami i regutami), takimi jak termin cheap lub wzorzec good price. Deskryptory uzywane sa
do definiowania kategorii: gdy tekst pasuje do ktoregokolwiek z deskryptorow kategorii, dokument lub rekord jest
umieszczany w tej kategorii.

» Zasoby lingwistyczne. Zasoby lingwistyczne to zbidr bibliotek i zaawansowanych zasobow zoptymalizowanych
tak, by wyodrgbniaty kluczowe pojecia i wzorce. Te wyodrgbnione pojecia i wzorce sa z kolei uzywane jako
deskryptory umozliwiajace umieszczanie rekordéw we wlasciwych kategoriach nalezacych do zestawu kategorii.

Mozna utworzy¢ wilasny pakiet TAP, zmodyfikowac¢ istniejacy lub korzysta¢ z gotowych pakietow.

Po wybraniu pakietu TAP i zestawu kategorii, SPSS Modeler Text Analytics moze przeprowadzi¢ wyodregbnianie i
skategoryzowac rekordy.

Uwaga: Pakietow TAP utworzonych w produktach IBM SPSS Text Analytics for Surveys i SPSS Modeler Text
Analytics mozna uzywaé zamiennie. Nalezy jednak pamigtaé, ze reguty oceniania w systemie moga si¢ rozni¢ w
produkcie SPSS Modeler Text Analytics , w zaleznosci od tego, czy nalezy zatadowac pakiet analizy tekstu (TAP) z
produktu SPSS Modeler Text Analytics bezposrednio, lub czy mozna zatadowaé TAP z produktu IBM SPSS Text
Analytics for Surveys. Zalecane jest uzycie pakietoéw TAP, ktore sa wykonywane w produkcie SPSS Modeler Text
Analytics . Pakiety TAP wykonane w produkcie IBM SPSS Text Analytics for Surveys moga by¢ tworzone za pomoca
innej wersji zasobow lingwistycznych.

Tworzenie pakietow analizy tekstu

Zawsze, gdy istnieje sesja z co najmniej jedna kategoria i jakimi$ zasobami, mozna utworzy¢ pakiet analizy tekstu
(TAP) z zawartosci otwartej sesji pracy z interaktywnym pulpitem roboczym. Zestaw kategorii i deskryptorow (pojgc,
typow, regul lub wynikéw wzorcow TLA) mozna przeksztatci¢c w pakiet TAP razem z wszystkimi zasobami
lingwistycznymi otwartymi w edytorze zasobow.

Widoczny jest jezyk, dla ktdrego zasoby zostaty utworzone. Jezyk jest ustawiany na karcie Advanced Resources w
widoku Template Editor lub Resource Editor.

Aby utworzy¢ pakiet analizy tekstu

1. Z menu wybierz kolejno nastgpujace pozycje File > Text Analysis Packages > Make Package. Zostanie
wyswietlone okno dialogowe Make Package.

2. Przejdz do katalogu, w ktorym zostanie zapisany pakiet TAP. Domyslnie pakiety sa zapisywane w podkatalogu
\TAP katalogu instalacyjnego produktu.

3. Do pola File Name wprowadz nazwe dla pakietu TAP.
4. Wprowadz etykiete do pola Package Label. Po wprowadzeniu nazwy pola ta nazwa automatycznie pojawia sig
jako etykieta, ale tg etykiete¢ mozna zmienic.

5. W celu wykluczenia zestawu kategorii z pakietu TAP nalezy usuna¢ zaznaczenie pola wyboru Include. Dzigki
temu kategoria nie zostanie dodana do pakietu. Domyslnie pakiet TAP zawiera jeden zestaw kategorii na pytanie.
W pakiecie TAP musi istnie¢ co najmniej jeden zestaw kategorii

6. Zmien nazwy dowolnych zestawow kategorii. Kolumna New Category Set domyslnie zawiera nazwy ogdlne
wygenerowane poprzez dodanie przedrostka Cat_ do nazwy zmiennej tekstowej. Pojedyncze kliknigcie w komorce
powoduje, ze nazwa staje si¢ dostgpna do edycji. Nacisnigcie klawisza Enter lub kliknigcie w innym miejscu
powoduje zastosowanie zmienionej nazwy. Jesli zmienisz nazwe zestawu kategorii, wowczas nazwa zostanie
zmieniona tylko w pakiecie TAP, ale nazwa zmiennej w otwartej sesji nie zostanie zmieniona.

7. W razie potrzeby zmien kolejno$¢ zestawow kategorii, uzywajac klawiszy strzatek po prawej stronie tabeli zestawu
kategorii.

8. Kliknij opcje Save, aby utworzy¢ pakiet analizy tekstu. Okno dialogowe zostanie zamknigte.
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Ladowanie pakietow analizy tekstu

Podczas konfigurowania we¢zta modelowania eksploracji tekstu nalezy okresli¢ zasoby, ktore beda uzywane podczas
wyodregbniania. Zamiast wybiera¢ szablon zasobéw mozna wybra¢ pakiet analizy tekstu (TAP), aby skopiowa¢ do
wezla nie tylko jego zasoby, ale rowniez zestaw kategorii.

Pakiety TAP sa najbardziej interesujace w przypadku interaktywnego tworzenia modelu kategorii, poniewaz mozna
uzywac zestawu kategorii jako punktu poczatkowego do kategoryzacji. Podczas tworzenia strumienia uruchamiana jest
sesja pracy z interaktywnym pulpitem roboczym i ten zestaw kategorii pojawia si¢ w panelu Categories. Dzigki temu
uzytkownik moze natychmiast ocenia¢ dokumenty i rekordy przy uzyciu tych kategorii, a nastepnie modyfikowac,
budowac i rozszerzac te kategorie az spetnia potrzeby. Wigcej informacji zawiera temat |“Metody i strategie tworzenia|
kategorii” na stronie 94|

Poczawszy od wersji 14 kliknigcie opcji Load i wybranie pakietu TAP pozwala rowniez wyswietli¢ jezyk, dla ktorego
zdefiniowano zasoby w tym pakiecie TAP.

Aby zaladowac¢ pakiet analizy tekstu

1. Przeprowadz edycj¢ wezta modelowania Text Mining.

2. Na karcie Models wybierz opcje Text analysis package w sekcji Copy Resources From.
3. Kliknij przycisk Load. Zostanie otwarte okno dialogowe Load Text Analysis Package.
4

Wyszukaj lokalizacjg pakietu TAP zawierajacego zasoby i zestaw kategorii, ktory zamierzasz skopiowac do wezla.
Domyslnie pakiety sa zapisywane w podkatalogu \TAP katalogu instalacyjnego produktu.

o

Do pola File Name wprowadz nazwe dla pakietu TAP. Etykieta zostanie wy$wietlona automatycznie.

6. Wybierz zestaw kategorii, z ktorego chcesz skorzystac. Jest to zestaw kategorii, ktory pojawi si¢ w sesji pracy z
interaktywnym pulpitem. Nastgpnie mozliwe bedzie modyfikowanie i korygowanie tych kategorii r¢cznie albo przy
uzyciu opcji kategorii Build lub Extend.

7. Kliknij przycisk Load, aby skopiowa¢ do wezta zawartos$¢ pakietu analizy tekstu. Okno dialogowe zostanie
zamknigte. Gdy pakiet TAP zostanie zatadowany, jego kopia zostanie umieszczona w wezle; dzigki temu wszelkie
zmiany dotyczace zasobdw i kategorii nie zostana uwzglednione w pakiecie TAP, chyba ze zostanie on
zaktualizowany jawnie, a nastgpnie ponownie zatadowany.

Aktualizowanie pakietow analizy tekstu

Jesli wprowadzisz poprawki do zestawu kategorii, zasobow lingwistycznych lub utworzysz zupetnie nowy zestaw
kategorii, wowczas mozesz zaktualizowac¢ pakiet analizy tekstu (TAP), co utatwi pozniejsze korzystanie z tych
poprawek. Aby to zrobi¢, musisz przejs¢ do otwartej sesji zawierajacej informacje, jakie zamierzasz umiesci¢ w
pakiecie TAP. Podczas aktualizowania mozesz dotacza¢ zestawy kategorii, zastgpowac zasoby, zmienia¢ etykietg
pakietu, a takze zmienia¢ nazwe/kolejnos¢ zestawow kategorii.

Aby zaktualizowa¢ pakiet analizy tekstu

1. Z menu wybierz kolejno nastgpujace pozycje File > Text Analysis Packages > Update Package. Zostanie
wyswietlone okno dialogowe Update Package.

2. Przejdz do katalogu zawierajacego pakiet analizy tekstu, ktory zamierzasz zaktualizowac.

3. Do pola File Name wprowadz nazwe dla pakietu TAP.

4. Aby zastapi¢ zasoby lingwistyczne w pakiecie TAP na zasoby z biezacej sesji, wybierz opcje Replace the
resources in this package with those in the open session. Zwykle aktualizowanie zasobow lingwistycznych ma
sens, poniewaz te zasoby byly uzywane do wyodrebniania kluczowych poje¢ i wzorcow uzywanych do tworzenia
definicji kategorii. Korzystanie z najnowszych zasobdw lingwistycznych zapewnia uzyskanie najlepszych

rezultatéw klasyfikowania rekordow. Jesli ta opcja nie zostanie wybrana, wowczas zasoby lingwistyczne
znajdujace si¢ juz w pakiecie pozostana niezmienione.

5. Aby zaktualizowa¢ tylko zasoby lingwistyczne, wybierz opcje Replace the resources in this package with those
in the open session, a nastgpnie wybierz tylko biezace zestawy kategorii, ktore znajduja si¢ juz w TAP.
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6. W celu dotaczenia nowych zestawdw kategorii z otwartej sesji do pakietu TAP zaznacz pole wyboru dla kazdej
kategorii, ktora zamierzasz dodaé. Mozesz dodac jeden zestaw, wicle zestawow albo mozesz w ogole nie dodawaé
zestawow kategorii.

7. W celu usunigcia zestawow kategorii z pakietu TAP usun zaznaczenie pola wyboru Include. Mozesz usunaé
zestaw kategorii, ktory znajduje si¢ juz w pakiecie TAP, poniewaz dodajesz zestaw poprawiony. W tym celu usun
zaznaczenie pola wyboru Include odpowiedniego zestawu kategorii w kolumnie Current Category Set. W
pakiecie TAP musi istnie¢ co najmniej jeden zestaw kategorii

8. W razie potrzeby zmien nazwy zestawow kategorii. Pojedyncze kliknigcie w komorce powoduje, ze nazwa staje
si¢ dostgpna do edycji. Nacis$nigcie klawisza Enter lub kliknigcie w innym miejscu powoduje zastosowanie
zmienionej nazwy. Jesli zmienisz nazwe zestawu kategorii, wowczas nazwa zostanie zmieniona tylko w pakiecie
TAP, ale nazwa zmiennej w otwartej sesji nie zostanie zmieniona. Jesli dwa zestawy kategorii maja t¢ sama
nazwg, nazwy beda widoczne w kolorze czerwonym, az do czasu skorygowania zduplikowanej nazwy.

9. W celu utworzenia nowego pakietu z zawartoscia sesji scalona z zawartoscia wybranego pakietu TP kliknij opcje
Save As New. Zostanie otwarte okno dialogowe Save As Text Analysis Package. Zapoznaj si¢ z ponizszymi
instrukcjami.

10. Kliknij opcj¢ Update, aby zapisa¢ zmiany wprowadzone do wybranego pakietu TAP.

Aby zapisa¢ pakiet analizy tekstu

1. Przejdz do katalogu, w ktorym zostanie zapisany plik TAP. Domyslnie pliki TAP sa zapisywane w podkatalogu
TAP katalogu instalacyjnego.

2. Do pola File Name wprowadz nazwg dla pliku TAP.

3. Wprowadz etykiete do pola Package label. Po wprowadzeniu nazwy pola ta nazwa automatycznie pojawia si¢ jako
etykieta. T¢ etykiet¢ mozna zmienic. Etykieta jest wymagana.

4. Kliknij opcje Save, aby utworzy¢ nowy pakiet.

Edytowanie i optymalizacja kategorii

Po utworzeniu kategorii zawsze trzeba je sprawdzi¢ i wprowadzi¢ pewne korekty. Oprocz optymalizacji zasobow
lingwistycznych nalezy przejrze¢ kategorie, poszukujac mozliwosci potaczenia lub wyczyszczenia ich definicji, a takze
sprawdzi¢ niektore skategoryzowane dokumenty lub rekordy. Mozna takze przejrze¢ dokumenty lub rekordy w
kategorii i wprowadzi¢ korekty w taki sposob, by kategorie wychwytywaly niuanse i odrgbne idee.

Mozna wykorzysta¢ wbudowane zautomatyzowane techniki budowania kategorii; jednak prawdopodobnie konieczne
bedzie reczne skorygowanie efektow dziatania tych technik. Po zastosowaniu jednej lub wigkszej liczby technik w
oknie pojawi si¢ szereg nowych kategorii. Mozna teraz przeglada¢ dane w kategorii i wprowadzac korekty do
momentu, az definicje kategorii beda zadowalajace. Wigcej informacji zawiera temat [‘Informacje o kategoriach” nal
-tronie 98

Ponizej wymieniono niektére mozliwosci optymalizacji kategorii, z ktorych wigkszos¢ opisano na kolejnych stronach:

Dodawanie deskryptorow do kategorii

Po uzyciu technik zautomatyzowanych najprawdopodobniej nadal czg¢$¢ wynikow wyodregbniania nie zostanie
wykorzystana w zadnej z definicji kategorii. Nalezy przejrze¢ te liste¢ w panelu Extraction Results. Jesli znajdziesz
elementy, ktore powinny zosta¢ przeniesione do kategorii, mozesz je doda¢ do istniejacej lub nowej kategorii.

Aby dodac pojecie lub typ do kategorii
1. Z paneli Extraction Results i Data wybierz elementy, ktore chcesz doda¢ do nowej lub istniejacej kategorii.

2. Z menu wybierz opcje Categories > Add to Category. W oknie dialogowym All Categories zostanie wyswietlony
zestaw kategorii. Wybierz kategorig, do ktorej chcesz doda¢ wybrane elementy. Jesli chcesz dodac elementy do
nowej kategorii, wybierz opcj¢ New Category. Nowa kategoria zostanie wyswietlona w panelu Categories, pod
nazwa pierwszego wybranego elementu.
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Edytowanie deskryptorow kategorii

Po utworzeniu kategorii mozna otworzy¢ kazda kategorig, aby zobaczy¢ wszystkie deskryptory, ktore tworza jej
definicje. W oknie dialogowym Category Definitions mozna wprowadzi¢ szereg zmian w deskryptorach kategorii.
Ponadto, jesli kategorie sa wyswietlane w drzewie kategorii, mozna takze pracowac¢ z nimi w tym oknie.

Aby edytowac¢ kategorig
1. Wybierz kategorig, ktéra ma by¢ edytowana, w panelu Categories.
2. Z menu wybierz opcje View > Category Definitions. Zostanie otwarte okno dialogowe Category Definitions.

3. Wybierz deskryptor, ktéry chcesz edytowac, a nastgpnie kliknij odpowiedni przycisk na pasku narzedzi.

Ponizsza tabela zawiera opisy przyciskdw na pasku narzedzi, ktorych mozna uzywac do edytowania definicji kategorii.

Tabela 31. Przyciski paska narzedzi i ich opisy.

Ikony Opis
><- Usuwa wybrane deskryptory z kategorii.
ﬁ' Przenosi wybrane deskryptory do nowej lub istniejacej kategorii.
ﬁ' Przenosi wybrane deskryptory w postaci reguly kategorii & do kategorii. Wigcej informacji zawiera temat
[Korzystanie z regut kategorii” na stronie 114}
tjﬁ Powoduje przeniesienie kazdego z wybranych deskryptorow do osobnej nowej kategorii.
» Aktualizuje zawarto$¢ panelu Data i Visualization na podstawie wybranych deskryptorow.
Display

Przenoszenie kategorii
Jesli cheesz umiesci¢ kategorig w innej istniejacej kategorii lub przenies¢ deskryptory do innej kategorii, mozna
przenies¢ kategorig lub deskryptory.

Aby przenies¢ kategorig
1. W panelu Categories wybierz kategorie , ktore chcesz przenies¢ do innej kategorii.
2. Z menu wybierz opcje Categories > Move to Category. Menu zawiera zestaw kategorii, a ostatnio utworzona
kategoria znajduje sig na poczatku listy. Wybierz nazwe kategorii, do ktorej chcesz przenies¢ wybrane pojecia.
Jesli widzisz poszukiwana nazwe, wybierz ja, a wybrane elementy zostana dodane do tej kategorii.
» Jesli nazwa nie jest widoczna, wybierz opcje More, aby wyswietli¢ okno dialogowe All Categories, a nastgpnie
wybierz kategorig z listy.

Splaszczanie kategorii

W przypadku struktury hierarchicznej obejmujacej kategorie i podkategorie mozna zdecydowac si¢ na sptaszczenie
struktury. Splaszczenie kategorii polega na tym, ze wszystkie deskryptory w podkategoriach tej kategorii sa
przenoszone do wybranej kategorii, a puste podkategorie sa usuwane. W ten sposdb wszystkie dokumenty, ktore
pasowaty do podkategorii, sa teraz przypisane do wybranej kategorii.

Aby splaszczy¢ kategorig
1. W panelu Categories wybierz kategorig (najwyzszego poziomu lub podkategorig), ktdra chcesz sptaszczyc.
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2. Z menu wybierz opcje Categories > Flatten Categories. Podkategorie zostana usunigte i deskryptory zostana
przeniesione do wybranej kategorii.

Scalenie lub taczenie kategorii

Jesli cheesz potaczy¢ dwie lub wigceej istniejacych kategorii w nowa kategorig, mozesz je scali¢. Podczas scalania
kategorii tworzona jest nowa kategoria o nazwie ogolnej. Wszystkie pojgcia, typy i wzorce uzywane w deskryptorach
kategorii sa przenoszone do tej nowej kategorii. Mozna p6zniej zmieni¢ nazwg tej kategorii, edytujac jej wlasciwosci.

Aby scali¢ kategorig lub czg$¢ kategorii
1. W panelu Categories wybierz elementy, ktore maja zostac scalone.

2. Z menu wybierz opcje Categories > Merge Categories. Zostanie wyswietlone okno dialogowe Category
Properties, w ktorym mozna wprowadzi¢ nazwg nowo utworzonej kategorii. Wybrane kategorie zostana scalone w
nowa kategorig jako podkategorie.

Usuwanie kategorii

Jesli nie cheesz juz zachowywac jakiejs kategorii, mozesz ja usunac.

Aby usunac kategorie
1. W panelu Categories wybierz kategorig lub kategorie, ktore chcesz usunac.

2. Z menu wybierz kolejno opcje Edit > Delete.
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Rozdziat 10. Analiza skupien

Skupienia poje¢ mozna tworzy¢ i eksplorowa¢ w widoku Clusters (View > Clusters). Skupienie jest grupa pokrewnych
poje¢ wygenerowang przez algorytmy tworzenia skupien na podstawie liczebnosci wystepowania tych pojeé w
zestawie dokumentow/rekordow oraz liczebnosci ich tacznych wystapien w tym samym dokumencie (czyli tak
zwanych wspotwystagpien). Kazde pojgcie w skupieniu wspolwystgpuje z co najmniej jednym innym pojgeciem w tym
samym skupieniu. Skupienia stuza do grupowania poje¢ wspotwystepujacych, natomiast kategorie shuza do grupowania
dokumentéw lub rekordow na podstawie dopasowania zawartego w nich tekstu do deskryptoréw (pojec, regul,
wzorcdéw) dla kazdej kategorii.

Dobre skupienie to takie, w ktorym pojgcia sa silnie wzajemnie powiazane i czg¢sto wspotwystepuja, a takze maja
niewiele powiazan z pojeciami i innymi skupieniami. Podczas pracy z obszernymi zbiorami danych ta technika moze
spowodowac istotne wydtuzenie czasu przetwarzania.

Tworzenie skupien rozpoczyna si¢ od analizy zestawu pojec¢ i wyszukania poje¢, ktdre czgsto wspolwystepuja w
dokumentach. Dwa pojgcia, ktore wspotwystepuja w dokumencie, uznawane sa za parg pojec. Nastepnie proces
tworzenia skupien wyznacza podobienstwo kazdej pary poje¢, porownujac liczbe dokumentéw, w ktdrej para wystepuje
lacznie, z liczba dokumentow, w ktorych wystepuje kazde z pojec. Wigcej informacji zawiera temat
|wartos’ci powiazan na podstawie podobienstwa” na stronie 135[

Na koniec podobne pojgcia sa grupowane w skupienia w drodze agregacji, a algorytm uwzglednia ich wartosci
powiazan i ustawienia zdefiniowane w oknie dialogowym Build Clusters. Poprzez agregacjg rozumiemy dodawanie
poje¢ do skupien lub wiaczanie mniejszych skupien do wigkszych tak dtugo, az skupienie bgdzie nasycone. Skupienie
jest nasycone, gdy dodatkowe scalanie pojg¢ lub mniejszych skupien spowodowaloby przekroczenie przez skupienie
ustawien okreslonych w oknie dialogowym Build Clusters (chodzi o liczbg poje¢, wewngtrzne powiazania lub
zewnetrzne powiazania). Skupienie przyjmuje nazwe tego z zawartych w nim pojec, ktoére ma najwyzsza taczna liczbg
powiazan z innymi pojgciami w tym skupieniu.

Na koniec nie wszystkie pary poje¢ trafiaja do jednego skupienia, poniewaz moga istniec silniejsze powiazania w
innym skupieniu lub nasycenie uniemozliwi scalenie ich skupien. Dlatego istnicja zardwno powiazania wewngtrzne,
jak 1 zewngtrzne.

* Powiqzania wewnetrzne sa to powiazania miedzy parami poje¢ w obrgbie skupienia. Nie wszystkie pojgcia w
skupieniu sa ze soba powiazane. Jednak kazde pojgcie jest powiazane z co najmniej jednym innym pojgciem w tym
samym skupieniu.

* Powiqzania zewnetrzne sa to powiazania miedzy parami poje¢ w odrebnych skupieniach (jedno pojecie w jednym
skupieniu, a drugie pojgcie w innym).
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Rysunek 30. Widok Clusters

Widok Clusters jest podzielony na trzy panele, a kazdy z nich mozna ukrywa¢ lub uwidacznia¢, wybierajac jego nazwe
z menu View:

* Clusters pane W tym panelu mozna tworzy¢ powiazania i zarzadza¢ nimi. Wigcej informacji zawiera temat
[“Eksplorowanie skupien” na stronie 136}

* Visualization pane W tym panelu mozliwe jest wizualne eksplorowanie skupien i ich interakcji. Wigcej informacji
zawiera temat[“Wykresy skupien” na stronie 147

* Data pane Mozna eksplorowac i przegladac tekst zawarty w dokumentach i rekordach odpowiadajacych wyborom
dokonanim w oknie dialogowym Cluster Definitions. Wiecej informacji zawiera temat|“Definicje skupien” nal

Tworzenie skupien

Po uzyskaniu po raz pierwszy dostgpu do widoku Clusters zadne skupienia nie sa widoczne. Mozna utworzy¢ skupienia
za pomoca menu (Tools > Build Clusters) lub klikajac przycisk Build... na pasku narzedzi. Ta czynnos$¢ otwiera okno
dialogowe Build Clusters, w ktérym mozna zdefiniowac ustawienia i limity dla budowy skupien.

Uwaga: Gdy wyniki wyodregbniania nie beda juz zgodne z zasobami, ten panel stanie si¢ z6tty, podobnie jak Panel
Extraction Results. Mozesz ponowi¢ wyodrgbnianie, aby uzyska¢ najnowsze wyniki wyodrgbniania, a zotty kolor
zniknie. Jednak po kazdym wyodrgbnianiu panel Clusters jest czyszczony i konieczne jest odbudowanie skupien.
Podobnie, skupienia nie sa zachowywane migdzy sesjami.

W oknie dialogowym Build Clusters dostgpne sa nastgpujace obszary i pola:
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Wejscia

Inputs table Skupienia sa tworzone na podstawie deskryptorow wywodzonych z okreslonych typow. W tej tabeli
mozna wybrac typy, ktore maja zosta¢ uwzglednione w procesie budowania. Typy, ktore wychwytuja najwigcej
rekordow lub dokumentéw, sa wstgpnie zaznaczone.

Concepts to cluster: Wybierz metode wyboru pojec¢, ktére maja by¢ uzywane do tworzenia skupien. Zmniejszajac

liczbe poje¢, mozna przyspieszy¢ proces tworzenia skupien. Istnieje mozliwo$¢ utworzenia skupien przy uzyciu

okreslonej liczby najlepszych pojec, odsetka najlepszych poje¢ lub wszystkich pojec:

* Number based on doc. count Jesli wybrano opcje¢ Top number of concepts, wprowadz liczbg pojg¢, ktore maja
by¢ uwzgledniane przy tworzeniu skupien. Wybierane sa pojecia o najwigkszej liczbie dokumentow. Liczba
dokumentéw to liczba dokumentdéw lub rekordow, w ktérych wystepuje pojecie. Maksymalna warto$¢ to 150 000.

* Percentage based on doc. count Po wybraniu Top percentage of concepts wpisz procent pojeé, ktore maja by¢
uwzgledniane na potrzeby grupowania. Wybierane sa pojgcia o najwigkszej liczbie dokumentow.

Ograniczenie liczby skupien wyjsciowych

Maximum number of clusters to create Ta wartos¢ jest maksymalna liczba skupien do wygenerowania i
wyswietlenia w panelu Clusters. W trakcie tworzenia skupien nasycone skupienia sa prezentowane przed
nienasyconymi i dlatego wiele utworzonych skupien bgdzie nasyconych. Aby wyswietli¢ wigcej skupien
nienasyconych, mozna zmieni¢ to ustawienie na warto$¢ wigksza niz liczba nasyconych skupien.

Maximum concepts in a cluster Ta warto$¢ jest maksymalna liczba pojg¢, jaka moze zawiera¢ skupienie.

Minimum concepts in a cluster Ta warto$¢ jest minimalna liczba poje¢, jaka musi by¢ powiazana, aby powstato
skupienie.

Maximum number of internal links Ta warto$¢ jest maksymalna liczba pojeé, jaka moze zawiera¢ skupienie.
Powiazania wewngtrzne sa to powiazania migdzy parami poje¢ w obrebie skupienia.

Maximum number of external links Ta wartos$¢ jest maksymalna liczba powiazan z pojgciami poza skupieniem.
Powiazania zewngtrzne sa to powiazania migdzy parami poje¢ w odrgbnych skupieniach.

Minimum link value Najmniejsza warto§¢ powiazania akceptowana dla pary poje¢, ktore maja by¢ uwzgledniane przy
tworzeniu skupien. Warto$¢ powiazania jest obliczana za pomoca formuly podobienstwa. Wigcej informacji zawiera
temat [‘Obliczanie warto$ci powiazan na podstawie podobienstwa’]

Prevent pairing of specific concepts. Zaznacz to pole wyboru, aby w wynikach nie grupowac lub nie taczy¢ w pary
dwoch poje¢. Aby tworzy¢ pary pojec lub nimi zarzadzac, kliknij przycisk Manage Pairs. Wigcej informacji zawiera
temat [Zarzadzanie parami wyjatkow powiazan” na stronie 104}

Obliczanie wartosci powigzan na podstawie podobienstwa

Sama tylko liczba dokumentdw, w jakiej para poje¢ wspotwystepuje, nie mowi nic o podobienstwie tych pojeé. W
takich przypadkach przydatna jest wartos¢ podobienstwa. Warto$¢ powiazania na podstawie podobienstwa wyznacza
sig, porownujac liczebno$¢ dokumentéw ze wspotwystapieniami do liczebnosci dokumentéw dla kazdego pojecia
uczestniczacego w relacji. Jednostka miary podobienstwa jest liczba dokumentow, w ktorych wystepuje pojecie lub
para poje¢. Pojecie lub para pojec ,,wystepuje” w dokumencie, jesli zawarte/zawarta jest co najmniej w tym
dokumencie. Wybierajac odpowiednia opcj¢ mozna spowodowac, ze grubosé linii na wykresie poje¢ bedzie
odzwierciedlata warto$¢ powiazania na podstawie podobienstwa.

Algorytm ujawnia najsilniejsze relacje, tj. takie, w ktérych tendencja do wspotwystepowania poje¢ w danych jest
znacznie silniejsza niz tendencja do ich pojedynczego wystgpowania. Wewngtrznie algorytm oblicza wspdtczynnik
podobienstwa z zakresu od 0 do 1, gdzie 1 oznacza, ze dwa pojgcia zawsze wystepuja razem, a nigdy osobno.
Wynikowy wspdtczynnik podobienstwa jest mnozony przez 100 i zaokraglany do najblizszej liczby catkowite;.
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Wspotczynnik podobienstwa jest obliczany za pomoca wzoru przedstawionego na ponizszym rysunku.

(Cpff
(CrxCy)

similarity coefficient =

Rysunek 31. Wzor na wspdiczynnik podobieristwa

Gdzie:

* C, to liczba dokumentdw lub rekordéw, w ktérych wystepuje pojecie |.

* C, to liczba dokumentow lub rekordow, w ktorych wystepuje pojecie J.

* Cj to liczba dokumentéw lub rekordow, w ktorych para pojec¢ | i J wspotwystepuje w zestawie dokumentow.

Zatézmy na przyktad, ze mamy 5000 dokumentéw. Niech | oraz J beda wyodrebnionymi pojeciami, a |J niech bedzie
wspotwystapieniem pary | i J. W nastepujacej tabeli zaproponowano dwa scenariusze obliczania wspolczynnika i

warto$ci powiazania.

Tabela 32. Przyktad liczebnosci poje¢

Pojecie/para Scenariusz A Scenariusz B
Pojecie: | Wystepuje w 20 dokumentach Wystepuje w 30 dokumentach
Pojecie: J Wystepuje w 20 dokumentach Wystepuje w 60 dokumentach

Para poje¢: |J

Wspotwystepuje w 20 dokumentach

Wspotwystepuje w 20 dokumentach

Wspotczynnik podobienstwa 1 0,22222
Wartos¢ powiazania na podstawie 100 22
podobienstwa

W scenariuszu A pojecia | oraz J, a takze para |J wystepuja w 20 dokumentach, co przektada si¢ na wspotczynnik
podobienstwa 1, ktory oznacza, ze pojgcia te zawsze wystgpuja razem. Warto$¢ powiazania dla tej pary wynosi 100.

W scenariuszu B pojecie | wystepuje w 30 dokumentach, a pojecie J wystegpuje w 60 dokumentach, ale para |J
wystepuje tylko w 20 dokumentach. W rezultacie wspotczynnik podobienstwa wynosi 0,22222. Warto$¢ powiazania
dla tej pary zostanie zaokraglona w dét do 22.

Eksplorowanie skupien
Po zakonczeniu tworzenia skupien mozna wyswietli¢ zestaw wynikow w panelu Clusters. Dla kazdego skupienia
dostepne sa nastgpujace informacje w tabeli:

* Grupowanie. Jest to nazwa skupienia. Skupieniom nadawane sa nazwy na podstawie pojecia z najwigksza liczba
powiazan wewngtrznych.

* Concepts. Jest to liczba pojeé¢ w skupieniu. Wigcej informacji zawiera temat[“Definicje skupien” na stronie 137]

* Internal. Jest to liczba powiazan wewngtrznych w skupieniu. Powiazania wewngtrzne sa to powiazania migdzy
parami poje¢ w obrgbie skupienia.

» External. Jest to liczba powiazan zewnetrznych w skupieniu. Powiazania zewngtrzne sa to powiazania migdzy
parami poje¢ nalezacych do rdéznych skupien.

» Sat. Obecno$¢ symbolu wskazuje, ze skupienie mogloby by¢ wigksze, ale przekroczyto co najmniej jeden limit i
proces rozbudowy tego skupienia zostat przerwany, a skupienie jest nasycone. Na konicu procesu tworzenia skupien
nasycone skupienia sa prezentowane przed nienasyconymi, dlatego wiele utworzonych skupien bedzie nasyconych.
Aby wyswietli¢ wigcej skupien nienasyconych, mozna zmienic¢ ustawienie Maximum number of clusters to create
na warto$¢ wigksza niz liczba nasyconych skupien lub zmniejszy¢ ustawienie Minimum link value. Wigcej
informacji zawiera temat [“Tworzenie skupien” na stronie 134}
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* Threshold. Dla wszystkich par wspotwystepujacych w skupieniu jest to najnizsza w skupieniu warto§¢ powiazania
opartego na podobienstwie. Wigcej informacji zawiera temat [“Obliczanie wartosci powiazan na podstawie|
[podobienstwa” na stronie 135| Skupienie z wysokim progiem oznacza, ze pojecia w tym skupieniu maja wyzsze
ogolne podobienstwo i sa blizej spokrewnione niz pojgcia w skupieniu o nizszym progu.

Aby uzyska¢ wigcej informacji o skupieniu, mozna je wybraé¢, a wowczas na panelu wizualizacji po prawej stronie
pojawia sie dwa wykresy stuzace do jego eksploracji. Wigcej informacji zawiera temat[“Wykresy skupien” na stronie
H147

Mozna takze wycia¢ zawartosc¢ tabeli i wklei¢ ja do innej aplikacji.

Gdy wyniki wyodrebniania nie beda juz zgodne z zasobami, ten panel stanie si¢ zotty, podobnie jak Panel Extraction
Results. Mozesz ponowi¢ wyodregbnianie, aby uzyska¢ najnowsze wyniki wyodregbniania, a z6tty kolor zniknie. Jednak
po kazdym wyodrebnianiu panel Clusters jest czyszczony i konieczne jest odbudowanie skupien. Podobnie, skupienia
nie sa zachowywane migdzy sesjami.

Definicje skupien
Mozna wyswietli¢ wszystkie pojecia nalezace do skupienia, wybierajac to skupienie w panelu Clusters i otwierajac
okno dialogowe Cluster Definitions (View > Cluster Definitions).

Wszystkie pojecia z wybranego skupienia pojawia si¢ w oknie dialogowym Cluster Definitions. Jesli w oknie
dialogowym Cluster Definitions zaznaczysz jedno lub wigcej pojec i klikniesz przycisk Display &, na panelu Data
zostana wyswietlone wszystkie rekordy lub dokumenty, w ktorych wszystkie zaznaczone pojecia wystepujq wspolnie.
Jednak na panelu Data nie beda wys$wietlane rekordy ani dokumenty po wybraniu skupienia w panelu Clusters. Aby
uzyska¢ ogolne informacje o panelu Data, patrz[“Panel Data” na stronie 99|

Wybranie pojecia w tym oknie dialogowym wplywa takze na wykres sieciowy pojec. Wigcej informacji zawiera temat
[‘Wykresy skupien” na stronie 147} Podobnie, jesli w oknie dialogowym Cluster Definitions zaznaczysz jedno lub
wigcej pojec, na panelu Visualization zostana wyswietlone wszystkie powiazania zewngtrzne i wewngtrzne tych pojec.

Opisy kolumn

Ikony umozliwiaja tatwa identyfikacjg deskryptorow.
Tabela 33. Kolumny i ikony deskryptorow

Kolumny Opis

Descriptors Nazwa pojecia.

@ Wyswietla, ile razy ten deskryptor pojawia si¢ w catym zbiorze danych, wartos$¢ nazywana rowniez
liczebnoscia globalna.

Global

Liczba dokumentow lub rekordow, w ktorych ten deskryptor wystepuje, nazywana réwniez liczebnoscia
dokumentow.

Docs

Typ Wyswietla typ lub typy, do ktérych nalezy dany deskryptor. Jesli deskryptor jest reguta kategorii, zadna nazwa

typu nie jest wyswietlana w tej kolumnie.

Dziatania na pasku narzedzi

W tym oknie dialogowym mozna tez wybra¢ jedno lub wiele poje¢, ktore maja by¢ uzyte w kategorii. Istnieje kilka
sposobow wykonania tej czynnosci, ale najbardziej interesujaca jest mozliwo$¢ wybrania poje¢ wspotwystepujacych w
skupieniu i dodania ich jako reguty kategorii. Wiecej informacji zawiera temat[‘Reguty wspotwystepowania” na stronie|
MoZna uzywacé przyciskow paska narzedzi, aby dodawacé pojecia do kategorii.

Rozdziat 10. Analiza skupien 137



Tabela 34. Przyciski na pasku narzedzi stuzace do dodawania poje¢ do kategorii

Ikony Opis

-ﬁ' Dodaj wybrane pojecia do nowej lub istniejacej kategorii.

_ﬁ' Dod?j wybrane pojecia w postaci reguly kaﬁcgorii & d9 nowej lub istniejacej kategorii. Wigcej informacji
zawiera temat [“Korzystanie z regut kategorii” na stronie 114}

&5 Dodaj kazde z wybranych poje¢ jako osobna nowa kategorig.

Aktualizuje zawartos¢ panelu Data i Visualization na podstawie wybranych deskryptorow.

Uwaga: Mozna takze dodac¢ pojecia do typu, jako synonimy, lub wykluczy¢ elementy, uzywajac menu kontekstowych.
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Rozdziat 11. Eksplorowanie analizy powigzan w tekscie

W widoku Text Link Analysis (TLA) mozna eksplorowa¢ wzorce bgdace wynikami analizy powiazan w tekscie.
Analiza powiazan w tekscie jest to technika dopasowywania wzorcow, ktéra umozliwia definiowanie regut wzorcow i
poréwnywanie ich z faktycznie wyodrgbnionymi pojgciami i relacjami wystgpujacymi w tekscie.

Na przyktad samo wyodregbnienie pojec¢ dotyczacych organizacji moze nie dostarczy¢ warto§ciowej wiedzy.
Korzystajac z analizy TLA, mozemy takze uzyska¢ informacje o powiazaniach migdzy ta organizacja a innymi
organizacjami lub osobami wewnatrz organizacji. Mozna tez wykorzysta¢ analiz¢ TLA do wyodrgbniania opinii o
produktach, a w niektorych jezykach takze relacji migdzy genami.

Wynikowe wzorce TLA mozna przegladac na panelach Type i Concept Patterns w widoku Text Link Analysis. Wigcej
informacji zawiera temat [*Wzorce typéw i poje¢” na stronie 141| Dalsza eksploracja wynikéw jest mozliwa w panelach
Data i Visualization w tym widoku. Prawdopodobnie najwazniejsza jest mozliwos¢ dodawania ich do kategorii.

Jesli ta czynno$¢ nie zostata jeszcze wykonana, mozesz klikna¢ przycisk Extract i wybra¢ opcj¢ Enable Text Link
Analysis pattern extraction w oknie dialogowym Extract Settings. Wigcej informacji zawiera temat|“Wyodrgbnianie
wynikowych wzorcéw TLA” na stronie 140}

Aby mozliwe byto wyodrebnienie wynikowych wzorcow TLA, w uzywanym szablonie zasobow lub w uzywanych
bibliotekach musza by¢ zdefiniowane reguty wzorcow TLA. Mozna uzywac¢ wzorcow TLA z niektorych szablonow
zasobow dostarczanych razem z produktem IBM SPSS Modeler Text Analytics. Rodzaj relacji i wzorcow, jakie mozna
wyodregbnia¢, zalezy wylacznie od regut TLA zdefiniowanych w zasobach. Uzytkownik moze zdefiniowaé wlasne
reguly TLA.. Wzorce sktadaja si¢ z makr, list wyrazoéw i odstgpdéw migdzy wyrazami, ktore z kolei sktadaja si¢ na
zapytanie boolowskie lub regute stosowana wobec tekstu wejsciowego. Wigcej informacji zawiera
[Informacje o regulach powiazan w tekécie”, na stronie 197]

Za kazdym razem, gdy reguta wzorca TLA znajdzie pasujacy tekst, tekst ten moze by¢ wyodrgbniony jako wzorzec i
zrestrukturyzowany do postaci danych wynikowych. Wyniki sa widoczne w panelach widoku Text Link Analysis.
Kazdy z paneli mozna ukrywac lub uwidaczniaé, wybierajac jego nazwg z menu View:

* Panele Type i Concept Patterns. W tych panelach mozna tworzy¢ i eksplorowa¢ wzorce. Wigcej informacji
zawiera temat[“Wzorce typow i poje¢” na stronie 141|

* Panel Visualization. W tym panelu mozna wizualnie eksplorowa¢ interakcje migdzy pojeciami i typami we
wzorcach. Wigcej informacji zawiera temat [*Wykresy analizy powiazan w tekécie” na stronie 148

* Panel Data. Ten panel stuzy do eksplorowania i przegladania tekstu zawartego w dokumentach i rekordach
odpowiadajacych wyborom dokonanym w innym panelu. Wiecej informacji zawiera temat[‘Panel Data” na stronie]
i143
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Rysunek 32. Widok Text Link Analysis

Wyodrebnianie wynikowych wzorcow TLA

Proces wyodrgbniania powoduje powstanie zestawu pojec i typow, jak rowniez wzorcoéw TLA (Text Link Analysis),
jesli sa wlaczone. Wyodrebnione wzorce sa widoczne w widoku Text Link Analysis. Jesli wyniki wyodrebniania nie sa
zsynchronizowane zasobami, panel Patterns przyjmuje kolor zotty, co sygnalizuje ze ponowne wyodrebnienie datoby
inne wyniki.

Nalezy wybrac¢ opcjg wyodregbniania wzorcdw w ustawieniach wezta lub w oknie dialogowym Extract za pomoca opcji
Enable Text Link Analysis pattern extraction. Wiccej informacji zawiera temat [*Wyodrebnianie danych” na stronie]

Uwaga: Istnieje relacja pomigdzy wielkoscia zbioru danych i czasem, jaki jest wymagany do zakonczenia procesu
wyodrebniania. Zobacz instrukcje dotyczace instalacji, aby uzyska¢ informacje o statystykach wydajnosci i
zaleceniach. Zawsze mozna rozwazy¢ wstawienie wezta Sample we wczesniejszej czesci strumienia lub optymalizacje
konfiguracji komputera.

Aby wyodrebni¢ dane
1. Z menu wybierz opcje Tools > Extract. Lub kliknij przycisk Extract na pasku.
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2. Zmien dowolne z opcji, ktdrych chcesz uzy¢. Pamigtaj, ze opcja Enable Text Link Analysis pattern extraction
musi by¢ wybrana na tej karcie, a szablon musi zawiera¢ reguty TLA. W przeciwnym razie nie bedzie mozliwe
ﬁodrqbnianie wynikowych wzorcow TLA. Wigcej informacji zawiera temat [“Wyodrebnianie danych” na stronie]

3. Kliknij przycisk Extract, aby rozpoczac proces wyodrebniania.

Po rozpoczgciu wyodregbniania otwiera si¢ okno dialogowe postepu. Jesli cheesz przerwaé wyodrebnianie, kliknij
przycisk Cancel. Po zakonczeniu wyodrebniania okno dialogowe zostanie zamknigte, a wyniki pojawia si¢ w panelu.
Wigcej informacji zawiera temat [“Wzorce typow i pojec”|

Wzorce typow i pojeé

Wzorzec sktada si¢ z dwdch czgsci: kombinacji poje¢ i wbudowanych typdw. Wzorce sa najbardziej uzyteczne wtedy,
gdy probujemy pozna¢ opinie na okreslony temat lub relacje miedzy pojeciami. Na przyktad samo wyodrebnienie
nazwy produktu naszego konkurenta moze nie dostarczy¢ warto$ciowej wiedzy. Mozemy jednak przyjrze¢ sig
wyodrebnionym wzorcom, aby sprawdzi¢, czy dokument lub rekord zawiera wyrazenia oceniajace produkt jako dobry,
zty lub drogi.

Wzorce moga sktadac si¢ maksymalnie z szeSciu typow lub szesciu pojeé. Dlatego wiersze w obu panelach wzorcow
podzielone sa na szes$¢ pozycji. Kazda pozycja odpowiada konkretnej pozycji elementu w regule wzorca TLA
zdefiniowanej w zasobach lingwistycznych. W interaktywnym pulpicie roboczym pozycje bez wartosci nie sa
wyswietlane w tabeli. Na przyktad, jesli najdluzszy wzorzec wynikowy zawiera nie wigcej niz cztery pozycje, to dwie
ostatnie nie sa wyswietlane. Wiecej informacji zawiera temat[Rozdziat 18, “Informacje o regutach powiazan w
tekscie”, na stronie 197

Wzorce sa najpierw grupowane na poziomie typu, a nast¢pnie dzielone na wzorce pojec. Z tego powodu istnieja dwa
rozne panele wynikow: Type Patterns (po lewej stronie na gorze) i Concept Patterns (po lewej stronie na dole). Aby
wyswietli¢ wszystkie zwrdcone wzorce pojec, wybierz wszystkie wzorce typow. W dolnym panelu poje¢ pojawia sig
wtedy wszystkie wzorce poje¢ az do maksymalnej rangi (zdefiniowanej w oknie dialogowym Filter).

Type Patterns Ten panel przedstawia wynikowe wzorce skladajace sig z jednego lub wielu powiazanych typow i
pasujace do reguty TLA. Wzorce typu sa przedstawione jako <Organization> + <Location> + <Positive>, co moze
zapewnia¢ pozytywna opini¢ o organizacji w okreslonej lokalizacji. Sktadnia jest nastgpujaca

<Typl> + <Typ2> + <Typ3> + <Typ4> + <Typ5> + <Typ6>

Concept Patterns Panel ten prezentuje wynikowe wzorce na poziomie pojec¢ dla wszystkich wzorcow typow
wybranych w tym momencie w znajdujacym si¢ wyzej panelu Type Patterns. Wzorce poje¢ maja np. taka strukture:
hotel + paris + wonderful. Sktadnia jest nastepujaca

pojeciel + pojecie2 + pojecie3 + pojecied + pojecieb + pojecieb

Gdy wynikowe wzorce zajmuja mniej niz sze$¢ pozycji (maksymalna liczbg), wyswietlane sa tylko potrzebne pozycje
(lub kolumny). Puste pozycje migdzy zapelnionymi pozycjami sa odrzucane, zatem wzorzec
<Typ1>+<>+<Typ2>+<>+<>+<> moze by¢ przedstawiony jako <Typ1>+<Typ3>. W przypadku wzorca pojec:
pojeciel+.+pojecie2 (gdzie . oznacza wartos¢ null).

Tak jak w przypadku wynikéw wyodrgbniania w widoku Categories and Concepts mozesz tu przejrze¢ wyniki. Jesli
chcesz doprecyzowacé typy i pojecia, z ktorych sktadaja sig te wzorce, mozna to zrobi¢ w panelu Extraction Results
widoku Categories and Concepts lub bezposrednio w narzedziu Resource Editor, a nastgpnie wyodrgbni¢ ponownie
wzorce. Gdy pojecie, typ lub wzorzec jest uzywany w definicji kategorii lub jest czgscia reguty, w kolumnie In tabeli
Pattern lub Extraction Results wyswietlana jest ikona kategorii lub ikony.

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej wynikow, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czgSci panelu, aby przeglada¢ wyniki, lub wprowadzi¢ numer strony i przejs¢ do niej.
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Filtrowanie wynikéw analizy TLA

Podczas pracy na bardzo obszernych zbiorach danych proces wyodrgbniania moze wygenerowaé¢ miliony wynikow.
Wielu uzytkownikom tak obszerne wyniki utrudnia lub uniemozliwia analiz¢. Mozesz jednak odfiltrowa¢ wyniki, aby
skupi¢ si¢ na najbardziej interesujacych. Zmieniajac ustawienia w oknie dialogowym Filter, mozesz ograniczy¢ zbidr
wyswietlanych wzorcow. Wszystkie te ustawienia sa uzywane lacznie.

W widoku TLA okno dialogowe Filter zawiera nast¢pujace obszary i pola.

Filter by Frequency Mozna odfiltrowa¢ wyniki tak, by byly wyswietlane tylko wyniki o okreslonej liczebno$ci
globalnej lub liczebnosci dokumentdw.

* Global frequency to taczna liczba wystapien wzorca w catym zbiorze dokumentdw i rekordow. Podana jest w
kolumnie Global.

* Document frequency to taczna liczba dokumentdéw lub rekordow, w ktérych wystepuje wzorzec. Podana jest w
kolumnie Docs.

Na przyktad, jesli wzorzec wystepuje 300 razy w 500 rekordach, to globalna liczebno$¢ tego wzorca wynositaby 300, a
liczebnos¢ dokumentéw wynositaby 500.

And by Match Text Mozna odfiltrowac¢ wyniki tak, by wyswietlane byly tylko wyniki zgodne ze zdefiniowana tutaj
reguta. W polu Match text wprowadz zbior znakow, ktdry ma by¢ dopasowywany, po czym wybierz, czy ten tekst ma
by¢ wyszukiwany w pojeciach, czy w nazwach typdw, wskazujac numer pozycji lub wszystkie pozycje. Nastgpnie
wybierz warunek stosowania dopasowania (nie trzeba uzywaé¢ nawiasow katowych do oznaczania poczatku i konca
nazwy typu). Z listy rozwijanej wybierz And albo Or, aby reguta dopasowywata oba wyrazenia lub tylko jedno z nich,
po czym zdefiniuj drugie wyrazenie dopasowujace w taki sam sposob, jak pierwsze.

Tabela 35. Warunki dopasowywania tekstu

Warunek Opis

Contains Tekst zostanie dopasowany, jesli tancuch wystapi w dowolnym miejscu. (Opcja domyslna)
Starts with Tekst zostanie dopasowany, jesli pojgcie lub nazwa typu zaczyna si¢ od okreslonego tekstu.
Ends with Tekst zostanie dopasowany, jesli pojgcie lub nazwa typu konczy sig okre§lonym tekstem.
Exact Match Caly tekst musi by¢ dopasowany do pojecia lub nazwy typu.

Wyniki wyswietlane w panelu Patterns

Zatézmy ze uzywamy angielskiej wersji oprogramowania; oto niektore przyktady wynikéw na pasku narzedzi panelu
Patterns w zaleznosci od ustawien filtrowania.

@Extract .-;"»"'LTV ‘,i_l Y 19 patternz @
Rysunek 33. 1. przykiad filtrowania wynikéw

W tym przyktadzie na pasku narzedzi widzimy, ze liczba zwrdconych wzorcoéw zostata ograniczona z uwagi na
maksymalna range okreslona w filtrze. Fioletowa ikona oznacza, ze osiagni¢to maksymalna liczbg wzorcow. Zatrzymaj
wskaznik nad ikona, aby wyswietli¢ wigcej informacji. Patrz wezesniejsze objasnienia do filtru And by Rank.

ﬂ;ExTrad ,g‘é*v ..;",- Y | 22 patterns ﬂﬁ
Rysunek 34. 2. przykiad filtrowania wynikéw

W tym przyktadzie na pasku narzedzi wida¢, ze liczba wynikow zostata ograniczona przez filtr dopasowujacy tekst
(ikona lupy). Mozna zatrzyma¢ wskaznik nad ikona, aby wyswietli¢ dopasowywany tekst.
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Aby filtrowaé wyniki

1. Z menu wybierz opcje Tools > Filter. Zostanie otwarte okno dialogowe Filter.
2. Wybierz i doprecyzyj filtry, ktorych cheesz uzywac.

3. Kliknij przycisk OK, aby zastosowac filtry i wyswietli¢ nowe wyniki.

Panel Data

Podczas wyodrgbniania i eksplorowania wzorcow analizy powiazan w tekscie trzeba czasem przejrze¢ zrodlowe dane.
Na przyktad po to, aby zobaczy¢ tres¢ rekorddw, w ktorych wykryto grupe wzorcdw. Istnieje mozliwos¢ przegladania
rekordow lub dokumentow w panelu Data, ktory znajduje si¢ w prawym dolnym rogu. Jesli domyslnie panel ten nie
jest wyswietlony, z menu wybierz kolejno opcje View > Panes > Data.

W panelu Data wys$wietlany jest jeden wiersz na kazdy dokument lub rekord odpowiadajacy wyborom dokonanym w
widoku, przy czym liczba wierszy nie moze przekroczy¢ okreslonego limitu. Domyslnie liczba dokumentéw lub
rekorddw wyswietlanych w panelu Data jest ograniczona, aby mozliwe byto szybsze wyswietlanie danych. Mozna
jednak zmieni¢ te liczbe w oknie dialogowym Options. Wigcej informacji zawiera temat [‘Okno dialogowe Options|
karta Session” na stronie 75}

Uwaga: Jesli w widocznym panelu miesci si¢ wigcej wynikow, mozna uzy¢ przyciskow znajdujacych si¢ w dolnej
czgSci panelu, aby przeglada¢ wyniki, lub wprowadzi¢ numer strony i przejs$¢ do niej.

Wyswietlanie i odswiezanie panelu Data

Panel Data nie jest od$wiezany automatycznie, poniewaz w przypadku wigkszych zbioréw danych automatyczne
odswiezanie mogloby by¢ czasochtonne. Zatem za kazdym razem, gdy wybierzesz w tym widoku wzorzec typu lub
pojecia, mozesz klikna¢ przycisk Display, aby od$§wiezy¢ zawarto$¢ panelu Data.

Dokumenty lub rekordy tekstowe

Jesli dane tekstowe maja posta¢ rekordow, a tekst jest stosunkowo kroétki, to zmienna tekstowa w panelu Data zawiera
cale dane tekstowe. Jednak podczas pracy z rekordami i wigkszymi zbiorami danych w kolumnie zmiennej tekstowej
wyswietlany jest krotki fragment tekstu, a w panelu Text Preview po prawej stronie wyswietlana jest wigksza czgs$¢ lub
catos¢ tekstu z rekordu zaznaczonego w tabeli. Jesli dane tekstowe maja posta¢ odrgbnych dokumentéw, to w panelu
Data wyswietlana jest nazwa pliku dokumentu. Po wybraniu dokumentu otwierany jest panel Text Preview z tekstem
zaznaczonego dokumentu.

Kolory i wyroznienia

W wyswietlanych danych pojecia i deskryptory znalezione w dokumentach lub rekordach sa wyrozniane kolorami, aby
latwiej bylo je odszuka¢ w tekscie. Kolory odpowiadaja typom poje¢. Mozna takze zatrzymac wskaznik myszy nad
elementem oznaczonym kolorem, aby wyswietli¢ nazweg pojecia, pod ktorym dany termin zostat wyodrebniony, oraz
typ, do ktérego zostat przypisany. Tekst niewyodrebniony jest wyswietlany kolorem czarnym. Te niewyodrgbnione
wyrazy sa zwykle spdjnikami (and lub with), zaimkami (me lub they) oraz czasownikami (is, have lub take).

Kolumny panelu Data

Kolumna zmiennej tekstowej jest widoczna zawsze, ale mozna tez wyswietli¢ inne kolumny. Aby wyswietli¢ inne
kolumny, wybierz z menu opcje View > Data Pane, a nastgpnie wybierz kolumng, ktdra chcesz wyswietlic w panelu
Data. Do wyswietlania moga by¢ dostgpne nastgpujace kolumny:

* "Text field name" (#)/Documents Dodaje kolumng z danymi tekstowymi, z ktorych wyodrebnione byty pojgcia i
typy. Jesli dane sa zawarte w dokumentach, kolumna nosi nazwg Dokumenty i widoczna jest tylko nazwa
dokumentu lub petna $ciezka. Wiasciwy tekst z dokumentow jest widoczny w panelu Text Preview. Po nazwie tej
kolumny podana jest w nawiasach liczba wierszy w panelu Data. Niekiedy nie beda wyswietlane wszystkie
dokumenty lub rekordy. Wynika to z limitu ustawionego w oknie dialogowym Options, ktéry wprowadza si¢ w celu

Rozdziat 11. Eksplorowanie analizy powiazan w tekscie 143



przyspieszenia tadowania. Po osiagnigciu limitu po liczbie pojawi si¢ dopisek - Max. Wigcej informacji zawiera
temat [‘Okno dialogowe Options: karta Session” na stronie 75|

* Categories Zawiera listg¢ wszystkich kategorii, do ktorych nalezy rekord. Gdy ta kolumna jest widoczna,
odswiezanie panelu Data w celu wyswietlenia najbardziej aktualnych informacji moze trwa¢ nieco dhuze;j.

* Relevance Rank Zawiera rangi poszczegolnych rekordow w jednej kategorii. Ranga informuje o tym, jak dobrze
dany rekord pasuje do kategorii na tle innych rekordéw w tej samej kategorii. Aby wyswietli¢ range, wybierz
kategorie w panelu Categories (lewym gérnym). Wigcej informaciji zawiera temat[“Istotno$¢ kategorii” na stronie]
-1 00

* Category Count Zawiera liczbg kategorii, do ktorych nalezy rekord.
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Rozdziat 12. Wykresy wizualizacji

Widok Categories and Concepts, widok Clusters i widok Text Link Analysis wszystkie maja panel wizualizacji w

prawym gornym rogu okna. Mozna uzy¢ tego panelu, aby wizualnie eksplorowaé¢ dane. Dostgpne sa nastgpujace

wykresy.

*  Widok Categories and Concepts. Ten widok ma trzy wykresy: Category Bar, Category Web i Category Web
Table. W tym widoku wykresy sa aktualizowane tylko po kliknigciu opcji Display. Wigcej informacji zawiera temat
[“Wykresy i tabele kategorii’]

*  Widok Clusters. Ten wykres zawiera dwa wykresy sieciowe: Concept Web Graph i Cluster Web Graph. Wigcej
informacji zawiera temat [Wykresy skupien” na stronie 147}

*  Widok Text Link Analysis. Ten wykres zawiera dwa wykresy sieciowe: Concept Web Graph i Type Web Graph.
Wigcej informacji zawiera temat[“Wykresy analizy powiazan w tekécie” na stronie 148

Wigcej informacji o wszystkich ogolnych paskach narzedzi i paletach uzywanych do edycji wykresow mozna znalez¢
w sekcji dotyczacej edycji wykresdw pomocy online lub w pliku ModelerSPOnodes.pdyf, ktory jest dostepny jako czesc
pobranego produktu.

Wykresy i tabele kategorii

Podczas budowania kategorii nalezy doktadnie weryfikowac ich definicje, zawarte w nich dokumenty lub rekordy oraz
naktadanie si¢ kategorii. W panelu wizualizacji mozna przedstawia¢ kategorie z réznej perspektywy. Panel
Visualization znajduje si¢ w prawym gornym rogu widoku Categories and Concepts . Jesli panel nie jest jeszcze
widoczny, mozna uzyskac do niego dostep z menu View (View > Panes > Visualization).

W tym widoku panel wizualizacji oferuje trzy sposoby prezentacji wspdlnych elementow kategoryzacji dokumentow
lub rekordéw . Diagramy i wykresy wyswietlane w tym panelu umozliwiaja analizowanie wynikdéw kategoryzacji i
pomagaja w optymalizacji kategorii lub raportow. Podczas optymalizacji kategorii mozna uzywac tego panelu do
weryfikowania definicji kategorii, by wykry¢ kategorie zbyt podobne (na przyktad majace wigcej niz 75% wspdlnych
dokumentéw lub rekordoéw ) lub zbyt odmienne. Jesli dwie kategorie sa zbyt podobne, celowe moze by¢ potaczenie ich
w jedna. Mozna tez zoptymalizowa¢ definicje kategorii, usuwajac niektore deskryptory z jednej lub drugiej kategorii.

W zalezno$ci od wyboru dokonanego w panelu Extraction Results, panelu Categories lub oknie dialogowym Category
Definitions, mozna przeglada¢ interakcje migedzy dokumentami/rekordami i kategoriami na kazdej z kart tego panelu.
Kazda karta zawiera podobne informacje, ale zaprezentowane w inny sposob i na innym poziomie szczegoétowosci.
Aby jednak odswiezy¢ wykres z uwzglednieniem obecnie dokonanych wybordw, kliknij przycisk Display na pasku
narzedzi panelu lub okna dialogowego, w ktorym tego wyboru dokonano.

Panel Visualization w widoku Categories and Concepts udostgpnia nastgpujace wykresy i diagramy:

* Category Bar Chart. Tabela z wykresem stupkowym prezentujacym pokrywanie si¢ dokumentéw/rekordow
odpowiadajacych dokonanemu wyborowi oraz zwiazanych z nimi kategorii. Na wykresie stupkowym widoczne sa
takze stosunki dokumentow/rekorddw w kategoriach do tacznej liczby dokumentow/rekordow. Wigeej informacji
zawiera temat[“Wykres stupkowy kategorii” na stronie 146]

* Category Web Graph. Ten wykres przedstawia pokrywanie si¢ dokumentdéw/rekordow dla kategorii, do ktorych
dokumenty/rekordy naleza, zgodnie z wyborami dokonanymi w innych panelach. Wigcej informacji zawiera temat
[“Wykres sieciowy kategorii” na stronie 146]

* Category Web Table. Ta tabela przedstawia te same informacje, ktére widoczne sa na karcie Category Web, ale w
postaci tabelarycznej. Tabela zawiera trzy kolumny, ktdre mozna sortowac, klikajac ich nagtowki. Wigcej informacji
zawiera temat[“Tabela sieciowa kategorii” na stronie 146}

Wigcej informacji zawiera temat [Rozdziat 9, “Kategoryzacja danych tekstowych”, na stronie 91|
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Wykres stupkowy kategorii

Ta karta zawiera tabelg i wykres stupkowy przedstawiajacy naktadanie si¢ dokumentow/rekordéw odpowiadajacych
biezacemu wyborowi i powiazanym kategoriom. Na wykresie stupkowym widoczne sa takze stosunki
dokumentéw/rekordow w kategoriach do tacznej liczby dokumentéw/rekordéw . Nie mozna edytowac uktadu tego
wykresu. Mozna jednak posortowa¢ kolumny, klikajac nagtowki kolumn.

Wykres zawiera nastgpujace kolumny:

» Category. Ta kolumna zawiera wybranych nazwy kategorii. Domyslnie jako pierwsza wyswietlana jest najczesciej
wystgpujaca kategoria.

* Bar. Ta kolumna pokazuje, w formie wizualnej, stosunek liczby dokumentéw lub rekordow w danej kategorii do
facznej liczby dokumentow lub rekordow.

* Selection %. W tej kolumnie przedstawiona jest warto$¢ procentowa wyznaczona na podstawie stosunku taczne;j
liczby dokumentdéw lub rekordéw w kategorii do tacznej liczby dokumentdéw lub rekorddw w wyborze.

* Docs. . Ta kolumna przedstawia liczbg¢ dokumentéw lub rekordow w wyborze dla danej kategorii.

Wykres sieciowy kategorii

Na tej karcie wyswietlany jest wykres sieciowy kategorii. Ten wykres przedstawia pokrywanie si¢ dokumentéw lub
rekordow dla kategorii, do ktorych naleza dokumenty lub rekordy, zgodnie z wyborami dokonanymi w innych
panelach. Jesli istnieja etykiety kategorii, to bgda widoczne na wykresie. Mozna wybra¢ uktad wykresu (sieciowy,
kotowy, skierowany lub siatkowy) za pomoca przyciskéw na pasku narzedzi tego panelu.

W sieci kazdy wezet reprezentuje jedna kategorig. Za pomoca myszy mozna wybierac i przesuwa¢ wezty w panelu.
Wielkos¢ wezta odzwierciedla wielkos¢ wzgledna wyznaczona na podstawie liczny dokumentow lub rekordow tej
kategorii w biezacym wyborze. Grubos¢ i kolor linii migdzy dwiema kategoriami oznacza liczbg wspolnych
dokumentdw lub rekordow w tych kategoriach. Jesli zatrzymasz wskaznik myszy nad weztem w trybie eksploracji,
pojawi sig¢ podpowiedz z nazwa (lub etykieta) kategorii oraz taczna liczba dokumentéw lub rekordéw w kategorii.

Uwaga: Domyslnie wykresy dziataja w trybie eksploracji, w ktérym mozna przesuwaé wezly. Mozna jednak
przetaczy¢ sig do trybu edycji, aby edytowa¢ uktady wykresdw, w tym zmienia¢ kolory i czcionki, legendg itp Aby
uzyska¢ wigcej informacji, patrz[‘Uzywanie paskow narzedzi i palet wykresow” na stronie 149]

W przypadku skopiowania danych wykresu za pomoca przycisku Copy Visualization Data i wklejenia ich do arkusza
kalkulacyjnego Iub edytora tekstu dane zostana zaprezentowane w nagtéwkach kolumn takich jak V1 czy V2 —az do
V7. Kolumny te zawieraja nastgpujace informacje:

* V1, V2 Wartosci te odpowiadaja wspolrzednym ekranu (odpowiednio X i Y).
* V3, V5 Wyswietla kategorig pojgcia.
* Size, V6 Wyswietla liczbe dokumentow, w ktorych znaleziono pojecia.

* V7 Obecnie nieuzywana.

Tabela sieciowa kategorii

Ta tabela przedstawia te same informacje, ktore wyswietlane sa na karcie Category Web, ale w postaci tabelaryczne;.
Tabela zawiera trzy kolumny, ktére mozna sortowac, klikajac ich nagtowki:

* Count. Ta kolumna zawiera liczbg wspolnych dokumentow lub rekordow migdzy dwiema kategoriami.

* Category 1. Ta kolumna zawiera nazwg pierwszej kategorii, po ktorej nastgpuje taczna liczba zawartych w niej
dokumentéw lub rekordow ujgta w nawiasy.

* Category 2. Ta kolumna zawiera nazwe drugiej kategorii, po ktdrej nastgpuje taczna liczba zawartych w niej
dokumentéw lub rekordow ujeta w nawiasy.
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Wykresy skupien

Po zbudowaniu skupien mozna eksplorowac je wizualnie na wykresach sieciowych w panelu Visualization. Panel
wizualizacji udostepnia dwa ujgcia skupien: wykres sieciowy pojec i wykres sieciowy skupien. Wykresy sieciowe w
tym panelu moga by¢ uzywane do analizy wynikéw tworzenia skupien i pomagaja w ujawnieniu niektdrych pojeé i
regul, ktére warto bytoby doda¢ do kategorii. Panel Visualization znajduje si¢ w prawym gornym rogu widoku
Clusters. Jesli nie jest widoczny, mozna uzyska¢ dostep do niego z menu View (View > Panes > Visualization).
Woybierajac skupienie w panelu Clusters, mozna automatycznie wyswietli¢ odpowiednie wykresy w panelu
Visualization.

Uwaga: Domyslnie wykresy dzialaja w trybie interaktywnym/wyboru, w ktorym mozna przesuwaé wezty. Mozna
jednak edytowac uktady wykreséw w trybie edycji, w tym zmienia¢ kolory i czcionki, legendg itp Wigcej informacji
zawiera temat[“Uzywanie paskow narzedzi i palet wykreséw” na stronie 149|

Widok Clusters zawiera dwa wykresy sieciowe.

* Concept Web Graph. Ten wykres przedstawia wszystkie pojecia w wybranych skupieniach, a takze pojgcia
powiazane spoza skupienia. Ten wykres pozwala zobaczy¢, w jaki sposob pojecia w skupieniu sg powiazane, a takze
zorientowaé si¢ w powiazaniach zewnetrznych. Wiecej informacji zawiera temat[“Wykres sieciowy poje¢’]

* Wykres sieciowy skupien. Ten wykres przedstawia wybrane skupienia ze wszystkimi powiazaniami zewnetrznymi
wybranymi skupieniami pokazanymi jako linie kropkowane. Wigcej informacji zawiera temat |“Wykres sieciowyl
[skupien” na stronie 148|

Wigcej informacji zawiera temat|[Rozdziat 10, “Analiza skupien”, na stronie 133|

Wykres sieciowy pojec

Ta karta zawiera wykres sieciowy przedstawiajacy wszystkie pojecia w wybranych skupieniach, a takze pojecia
powiazane spoza skupienia. Ten wykres pozwala zobaczy¢, w jaki sposob pojecia w skupieniu sa powiazane, a takze
zorientowac si¢ w powiazaniach zewngetrznych. Kazde pojecie w skupieniu jest reprezentowana jako wezet o kolorze
odzwierciedlajacym typ. Wiecej informacji zawiera temat [“Tworzenie typow” na stronie 175|

Zostana narysowane wewngtrzne powiazania migdzy pojgciami w skupieniu, a grubos$¢ linii kazdego powiazania
bedzie bezposrednio odzwierciedla¢ liczbg dokumentow ze wspotwystapieniami kazdej pary pojec albo wartosc
powiazania na podstawie podobienstwa, w zaleznosci od wyboru dokonanego na pasku narzedzi wykresu. Widoczne sa
takze powiazania zewngtrzne migdzy pojgciami ze skupienia a pojgciami spoza skupienia.

Jesli w oknie dialogowym Cluster Definitions zostana wybrane pojecia, to na wykresie sieciowym poje¢ zostana
wyswietlone te pojecia oraz ich powiazania zewnetrzne i wewngtrzne. Wszelkie powiazania miedzy innymi pojgciami,
ktdre nie obejmuja zadnego z zaznaczonych, nie beda widoczne na wykresie.

Uwaga: Domyslnie wykresy dziataja w trybie interaktywnym/wyboru, w ktorym mozna przesuwac wezty. Mozna
jednak edytowac uktady wykreséw w trybie edycji, w tym zmienia¢ kolory i czcionki, legendg itp Aby uzyskac¢ wigcej
informaciji, patrz[“Uzywanie paskow narzedzi i palet wykresow” na stronie 149

W przypadku skopiowania danych wykresu za pomoca przycisku Copy Visualization Data i wklejenia ich do arkusza
kalkulacyjnego lub edytora tekstu dane zostang zaprezentowane w nagtéwkach kolumn takich jak V1 czy V2 —az do
V7. Kolumny te zawieraja nastepujace informacje:

* V1, V2 Wartosci te odpowiadaja wspolrzednym ekranu (odpowiednio X i Y).
* V3, V6 Wyswietla typ pojecia.

* V4, V5 Wyswietla etykiete pojecia.

* V7 Obecnie nieuzywana.
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Wykres sieciowy skupien

Ta karta zawiera wykres sieciowy przedstawiajacy wybrane skupienia. Powiazania zewngtrzne migdzy wybranymi
skupieniami, a takze wszelkie powiazania migdzy innymi skupieniami sa pokazane jako linie kropkowane. W widoku
sieciowym skupien kazdy wezet reprezentuje cate skupienie, a grubosci linii narysowanych migdzy skupieniami
reprezentuje liczbg powiazan zewngtrznych pomigdzy dwoma skupieniami.

Wazne! Aby mozna bylo wyswietli¢ wykres sieciowy skupien, nalezy wczesniej stworzy¢ skupienia z powiazaniami
zewngetrznymi. Powiazania zewngtrzne sa to powiazania migdzy parami poje¢ w odrebnych skupieniach (jedno pojgcie
w jednym skupieniu, a drugie pojgcie w innym).

Na przyktad zat6zmy, ze mamy dwa skupienia. Skupienie A zawiera trzy pojecia: A1, A2 i A3. Skupienie B zawiera
dwa pojecia: B1 u B2. Powiazane sa nastepujace pojecia: A1-A2, A1-A3, A2-B1 (zewnetrzne), A2-B2 (zewnetrzne),

A1-B2 (zewngtrzne) i B1-B2. Oznacza to, ze na wykresie sieciowym skupien grubos¢ linii bedzie reprezentowac trzy
powiazania zewngtrzne.

Uwaga: Domyslnie wykresy dziataja w trybie interaktywnym/wyboru, w ktorym mozna przesuwac¢ wezty. Mozna
jednak edytowa¢ uktady wykreséw w trybie edycji, w tym zmienia¢ kolory i czcionki, legendg itp Wigcej informacji
zawiera temat[“Uzywanie paskoéw narzedzi i palet wykreséw” na stronie 149]

Wykresy analizy powigzan w tekscie

Po wyodregbnieniu wzorcoéw analizy powiazan w tekscie (TLA) mozna eksplorowac je wizualnie na wykresach
sieciowych w panelu Visualization. Panel wizualizacji udostgpnia dwa ujgcia wzorcow TLA: wykres sieciowy
(wzorcow) pojec i wykres sieciowy (wzorcow) typow. Wykresy sieciowe na tym panelu umozliwiaja zwizualizowanie
wzorcow. Panel Visualization znajduje si¢ w prawym gornym rogu widoku Text Link Analysis. Jesli nie jest widoczny,
mozna uzyskac dostep do niego z menu View (View > Panes > Visualization). Jesli nie dokonano wyboru, obszar
wykresu jest pusty.

Uwaga: Domyslnie wykresy dzialaja w trybie interaktywnym/wyboru, w ktérym mozna przesuwa¢ wezly. Mozna
jednak edytowac uktady wykreséw w trybie edycji, w tym zmienia¢ kolory i czcionki, legendg itp Wigcej informacji
zawiera temat[“Uzywanie paskow narzedzi i palet wykreséw” na stronie 149|

Widok Text Link Analysis zawiera dwa wykresy sieciowe.

* Concept Web Graph. Ten wykres przedstawia wszystkie pojecia w wybranych wzorcach. Szerokos¢ linii i
wielkosci weztow (jesli nie sa pokazane ikony typu) na wykresie pojeé przedstawia liczbg globalnych wystapien w
wybranej tabeli. Wigcej informacji zawiera temat[“Wykres sieciowy pojeé’]

* Type Web Graph. Ten wykres przedstawia wszystkie typy w wybranych wzorcach. Szerokos¢ linii i wielkos$ci

wezlow (jesli nie sa pokazane ikony typu) na wykresie przedstawia liczbg globalnych wystapien w wybranej tabeli.
qu%i sq i rzedstawiane w okreslonym kolorze lub w formie ikony. Wigcej informacji zawiera temat

sieciowy typu”’

Wigcej informacji zawiera temat [Rozdziat 11, “Eksplorowanie analizy powiazan w tekscie”, na stronie 139]

Wykres sieciowy pojec

Ten wykres przedstawia wszystkie pojgcia reprezentowane w obecnym wyborze. Na przyktad, jesli wybrano wzorzec
typu z trzema pasujacymi wzorcami pojg¢, to na wykresie beda widoczne trzy zestawy powiazanych poje¢. Szerokos¢
linii 1 wielkosci weztdw na wykresie poje¢ odzwierciedlaja globalne liczebnosci. Wykres w formie wizualne;j
przedstawia te same informacje, ktdre zostalty wybrane w panelach wzorcéw. Typy pojec sa oznaczone kolorem lub
ikona, w zalezno$ci od wyboru dokonanego na pasku narzedzi wykresow. Wigcej informacji zawiera temat
paskow narzedzi i palet wykresow” na stronie 149|

Wykres sieciowy typu
Ten wykres przedstawia wszystkie wzorce typow reprezentowane w obecnym wyborze. Na przyktad, jesli wybrano
dwa wzorce poje¢, ten wykres przedstawial bedzie po jednym wezle na kazdy typ obecny w wybranych wzorcach oraz
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powiazania migdzy typami w tym samym wzorcu. Szerokosci linii i wielkosci weztow odzwierciedlaja globalne
liczebnosci dla zbioru. Wykres w formie wizualnej przedstawia te same informacje, ktore zostaty wybrane w panelach
wzorcow. Typy identyfikowane sa nie tylko przez nazwy typow widoczne na wykresie, lecz takze kolorami lub
ikonami, w zaleznosci od wyboru dokonanego na pasku narzedzi wykresow. Wigcej informacji zawiera temat

[‘Uzywanie paskow narzedzi i palet wykresow’]

Uzywanie paskow narzedzi i palet wykreséw

Dla kazdego wykresu istnieje pasek narzedzi, ktéry umozliwia szybki dostep do niektorych czgsto uzywanych palet, na
ktérych mozna wykonac¢ rozne czynnosci na wykresach. Kazdy widok (Categories and Concepts, Clusters i Text Link
Analysis) ma trochg inny pasek narzedzi. Mozna wybra¢ pomigdzy trybem widoku Explore i trybem widoku Edit.

Tryb eksploracji umozliwia analityczna eksploracje danych i wartoSci reprezentowanych przez wizualizacje, a tryb
edycji umozliwia zmiang wygladu i uktadu wizualizacji. Na przyktad mozna zmieni¢ czcionki i kolory tak, aby
pasowaty do oficjalne;j stylistyki danej organizacji. Aby wybrac ten tryb, z menu wybierz View > Visualization Pane >
Edit Mode (lub kliknij ikong paska narzedzi).

W trybie edycji dostepnych jest kilka paskdw narzedzi, ktore maja wptyw na rézne aspekty uktadu wizualizacji. Jesli
ktdres z tych paskow nie sa wykorzystywane, mozna je ukry¢. Dzigki temu zwigksza sig w oknie dialogowym ilo$¢
miejsca dostgpnego dla wykresu. Aby zaznaczy¢ lub usuna¢ zaznaczenie paskdw narzedzi, kliknij odpowiednia nazwe
paska narzedzi lub palety w menu View.

Wigcej informacji o wszystkich ogolnych paskach narzedzi i paletach uzywanych do edycji wykres6w mozna znalez¢
w sekcji dotyczacej edycji wizualizacji pomocy online lub w pliku ModelerSPOnodes.pdf, ktory jest dostgpny jako
cz¢s$¢ pobranego produktu.

Tabela 36. Przyciski paska narzedzi Text Analytics.

Przycisk/lista

Opis

&

Wiacza tryb Edit. Przetacz do trybu Edit, aby zmieni¢ wyglad wykresu, np. aby powigkszy¢ czcionke,
dopasowac kolory do korporacyjnych wytycznych stylu lub usuna¢ etykiety i legendy.

k

Wtacza tryb Explore. Domyslnie tryb Explore jest wiaczony, co oznacza, ze mozna przesuwac i przeciagac
wezly na wykresie, jak rowniez umieszcza¢ kursor myszy na obiektami wykresu, aby wyswietli¢
dodatkowe informacje podpowiedzi.

B,.oeé

Wybierz typ wyswietlania sieciowego w widoku Categories and Concepts, jak rowniez w widoku Text
Link Analysis.

* Circle Layout Uktad ogélny, ktory mozna zastosowac¢ wzgledem dowolnego wykresu. Rozmieszcza
wykres, zaktadajac, ze tacza sa nieukierunkowane i traktuje wszystkie wezty tak samo. Wezty sa
umieszczane tylko na obwodzie kota.

* Network Layout Uktad ogélny, ktéry mozna zastosowa¢ wzgledem dowolnego wykresu. Rozmieszcza
wykres, zaktadajac, ze tacza sa nieukierunkowane i traktuje wszystkie wezly tak samo. Weztly sa
umieszczane swobodnie w ramach uktadu.

* Directed Layout Uktad, ktory mozna uzywac tylko dla wykresow kierunkowych. Ten uktad tworzy
struktury przypominajace drzewa: od weztow glownych do weztdow-lisci, ktdre sa organizowane
kolorami. Dane hierarchiczne sa zazwyczaj dobrze wyswietlane w tym ukladzie.

* Grid Layout Uktad ogolny, ktéry mozna zastosowa¢ wzgledem dowolnego wykresu. Rozmieszcza
wykres, zaktadajac, ze tacza sa nieukierunkowane i traktuje wszystkie wezty tak samo. Wezly sa
umieszczane tylko na punktach siatki w ramach obszaru.

i

Reprezentacja wielkosci taczy. Wybierz, co oznacza grubo$¢ linii na wykresie. Dotyczy to tylko widoku
Clusters. Wykres sieciowy Clusters pokazuje tylko tacza pomigdzy grupami. Mozna wybra¢ pomigdzy:

* Similarity Grubos$¢ wskazuje na liczbeg zewngtrznych taczy pomigdzy dwiema grupami

* Co-occurrence Grubos¢ wskazuje liczbg dokumentdw, w ktérych wystepuje wspotwystgpowanie
deskryptordw.
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Tabela 36. Przyciski paska narzedzi Text Analytics (kontynuacja).

Przycisk/lista

Opis

Przycisk przetacznika, ktory po nacisnigciu wyswietla legendg. Jesli przycisk nie jest nacisnigty, legenda
nie jest wyswietlana.

Przycisk przetacznika, ktory po nacisnigciu wyswietla ikony typu na wykresie zamiast uzywac kolorow
typow. Dotyczy to tylko widoku Text Link Analysis.

Przycisk przetacznika, ktory po nacisnigciu wyswietla suwak taczy pod wykresem. Mozna filtrowac
wyniki, przesuwajac strzatke.

Bedzie wyswietla¢ wykres dla najwyzszego wybranego poziomu kategorii zamiast ich podkategorii.

Bedzie wyswietla¢ wykres dla najnizszego poziomu wybranych kategorii.

Ta opcja okresla, w jaki sposob nazwy podkategorii sa wyswietlane w wynikach.
* Full category path Ta opcja wyswietli nazwe kategorii oraz pelna Sciezke kategorii nadrzednych, w
razie potrzeby uzywajac uko$nikow do rozdzielania nazw kategorii od nazw podkategorii.

» Short category path Ta opcja wyswietli tylko nazwe kategorii, ale uzyje wielokropkéw do
wyswietlenia liczby kategorii nadrzednych dla okreslonej kategorii.

* Bottom level category Ta opcja wyswietli tylko nazwe kategorii bez petnej Sciezki i bez wyswietlonych
kategorii nadrzednych.
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Rozdziat 13. Edytor zasobow sesiji

IBM SPSS Modeler Text Analytics umozliwia szybkie i doktadne wyodrebnianie kluczowych poje¢ z danych
tekstowych. Ten proces wyodrebniania opiera si¢ w duzej mierze na zasobach lingwistycznych, od ktorych zalezy
sposob wyodrebniania informacji z danych tekstowych. Domyslnie te zasoby pochodza z szablonéw zasobow.

IBM SPSS Modeler Text Analytics jest dostarczany z zestawem specjalistycznych szablonéw zasobow, ktore
zawieraja zestaw zasobow lingwistycznych i nielingwistycznych w postaci bibliotek i zasobéw zaawansowanych.
Okreslaja one, w jaki sposob dane maja by¢ obstugiwane i wyodrgbniane. Wigcej informacji zawiera
[‘Szablony i zasoby”, na stronie 155]

W oknie dialogowym wezta mozna zatadowac kopig zasobow z szablonu do wezta. W razie potrzeby w interaktywnym
pulpicie roboczym mozna dostosowac te zasoby do konkretnych danych tego wezta. W interaktywnym pulpicie
roboczym mozna rdwniez pracowac z zasobami w widoku Resource Editor. Po kazdym uruchomieniu interaktywnego
pulpitu roboczego przeprowadzane jest wyodrgbnianie przy uzyciu zasobéw zatadowanych w oknie dialogowym
wezta, chyba w wezle sa zapisane zbuforowane dane i wyniki wyodrgbniania.

Edytowanie zasobow w oknie Resource Editor

Resource Editor zapewnia dostep do zestawu zasobdw uzywanego do wygenerowania wynikéw wyodrebniania (pojec,
typow i wzorcow) dla sesji interaktywnej Srodowiska roboczego. Ten edytor jest bardzo podobny do edytora Template
Editor, z ta roznica, ze w oknie Resource Editor edytuje si¢ zasoby dla biezacej sesji. Po zakonczeniu pracy nad
zasobami i wykonywania innych czynno$ci mozna zaktualizowa¢ wezet modelowania, aby zapisa¢ efekty pracy i
ewentualnie pdzniej wroci¢ do nich w kolejnej sesji pracy z interaktywnym pulpitem roboczym. Wigcej informacji
zawiera temat[“Aktualizowanie weztow modelowania i zapisywanie” na stronie 76|

Jesli cheesz pracowac bezposrednio na szablonach stuzacych do tadowania zasobdéw do weztdw, zaleca sig uzycie
edytora Template Editor. Wiele czynnosci, ktére mozna wykonywac w edytorze Resource Editor, wykonuje sig tak
samo, jak w edytorze Template Editor. Oto niektore z nich:

* Praca z bibliotekami. Wigcej informacji zawiera temat|Rozdzial 15, “Praca z bibliotekami”, na stronie 165}

* Tworzenie stownikow typow. Wigcej informacji zawiera temat [“Tworzenie typow” na stronie 175]

* Dodawanie terminéw do stownikéw. Wigcej informacji zawiera temat [‘Dodawanie terminéw” na stronie 176}

* Tworzenie synoniméw. Wigcej informacji zawiera temat [‘Definiowanie synoniméw” na stronie 181}

+ Importowanie i eksportowanie szablonéw. Wigcej informacji zawiera temat [“Importowanie i eksportowanie]
[szablonow” na stronie 161}

* Publikowanie bibliotek. Wigcej informacji zawiera temat [‘Publikowanie bibliotek” na stronie 171}

Informacje dotyczace jezyka angielskiego, francuskiego, hiszpanskiego, holenderskiego, niemieckiego,
portugalskiego i wloskiego
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Rysunek 35. Widok Resource Editor

Tworzenie i modyfikowanie szablonow

Za kazdym razem, gdy zmieniasz zasoby i chcesz te zmienione zasoby wykorzystac przysztosci, mozesz zapisac je jako
szablon. W takim przypadku mozna zapisa¢ zasoby pod nazwa istniejacego szablonu lub pod nowa nazwa. Nastgpnie
za kazdym razem, gdy zatadujesz ten szablon, uzyskasz dostep do tych samych zasobdw. Wigcej informacji zawiera
temat [“Kopiowanie zasobow z szablonow i pakietow TAP” na stronie 26|

Uwaga: Mozliwe jest takze publikowanie i udostepnianie bibliotek. Wigcej informacji zawiera temat
[‘Wspotuzytkowanie bibliotek” na stronie 170}

Aby utworzy¢ (lub zmodyfikowac) szablon

1. Z menu w widoku Resource Editor wybierz opcje Resources> Make Resource Template. Zostanie otwarte okno
dialogowe Make Resource Template.

2. Wprowadz nowa nazwe¢ w polu Template Name, jesli chcesz utworzy¢ nowy szablon. Wybierz szablon w tabeli,
jesli cheesz zastapic istniejacy szablon aktualnie zatadowanymi zasobami.

3. Kliknij przycisk Save, aby utworzy¢ szablon.

Wazne! Poniewaz szablony sa tadowane po ich wybraniu w wezle, a nie po uruchomieniu strumienia, koniecznie
zataduj szablon we wszystkich innych weztach, w ktdrych jest uzywany, jesli chcesz uwzgledni¢ najnowsze zmiany.
Wigcej informacji zawiera temat [“Aktualizowanie zasobow wezta po zatadowaniu” na stronie 160}
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Przelgczanie sie miedzy szablonami zasobow

Jesli cheesz zastapic zasoby obecnie zaladowane w tej sesji kopia zasobow z innego szablonu, mozesz przetaczy¢ si¢
na te inne zasoby. Spowoduje to nadpisanie obecnie zatadowanych zasoboww sesji. W przypadku przetaczania si¢ na
inne zasoby w celu skorzystania z predefiniowanych regut wzorcow TLA, koniecznie wybierz szablon, ktory ma
odpowiednie oznaczenie w kolumnie TLA.

Mozliwos¢ przetaczania si¢ migdzy szablonami jest szczegodlnie przydatna, jesli chcesz odtworzy¢ efekty pracy w sesji
(kategorie, wzorce i zasoby), ale chcesz zatadowac zaktualizowana kopig zasobow z szablonu bez utraty innych
efektéw pracy w sesji. Mozesz wybrac szablon, ktérego zawarto$¢ cheesz skopiowaé do edytora Resource Editor, a
nastepnie klikna¢ przycisk OK. Spowoduje to zastapienie zasobdw w biezacym sesji. Po zakonczeniu sesji koniecznie
zaktualizuj wezet modelowania, jesli cheesz zachowac te zmiany do nastgpnego uruchomienia interaktywnego pulpitu
roboczego.

Uwaga: Jesli przetaczysz sig na zawartos¢ innego szablonu podczas sesji interaktywnej, nazwa szablonu wymieniona
w wezle nadal bedzie nazwa ostatniego zaladowanego i skopiowanego szablonu. Aby skorzysta¢ z tych zasobow lub
innych efektow pracy interaktywnej, zaktualizuj wezel modelowania przed zakonczeniem sesji, a nastgpnie wybierz
opcje Use session work w wezle. Wigcej informacji mozna znalezé w temacie [“Aktualizowanie weztéw modelowania il
Fapisywanie” na stronie 76

Aby przelaczy¢ sie na inne zasoby

1. Z menu w widoku Resource Editor wybierz opcje Resources> Switch Resource Templates. Zostanie otwarte
okno dialogowe Switch Resources.

2. W tabeli wybierz szablon, ktorego chcesz uzyc.

3. Kliknij przycisk OK, aby odrzuci¢ zasoby obecnie zaladowane i zamiast nich zatadowac¢ kopig zasobow z
wybranego szablonu. Jesli wprowadzisz zmiany w zasobach i chcesz zapisac biblioteki do wykorzystania w

przysztosci, mozesz opublikowaé, zaktualizowa¢ i udostepnic je przed przetaczeniem. Wigcej informacji zawiera
temat |[“Wspohuzytkowanie bibliotek” na stronie 170}
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Rozdziat 14. Szablony i zasoby

IBM SPSS Modeler Text Analytics umozliwia szybkie i doktadne wyodrgbnianie kluczowych poje¢ z danych
tekstowych. Ten proces wyodregbniania opiera si¢ w duzej mierze na zasobach lingwistycznych, od ktorych zalezy
spos6b wyodrebniania informacji z danych tekstowych. Wigcej informacji zawiera temat [“Jak dziata wyodrebnianie’|
Mozna zoptymalizowac te zasoby w widoku Resource Editor.

Razem z produktem instalowany jest zestaw gotowych specjalistycznych zasoboéw. Zostaty one opracowane w toku

wieloletnich badan i optymalizacji pod katem specyfiki konkretnych jezykéw i zastosowan. Poniewaz dostarczone

zasoby nie zawsze sa idealnie dopasowane do kontekstu danych, mozna edytowac gotowe szablony zasobow, a takze

tworzy¢ wilasne biblioteki precyzyjnie dostosowane do danych organizacji. Zasoby te sa dostarczane w réznych

formach i moga by¢ uzywane w sesji pracy z programem . Zasoby znajduja sig w:

* Szablonach zasobow. Szablony skladaja si¢ z bibliotek, typéw i niektorych zasobéw zaawansowanych, ktére
wspolnie tworza wyspecjalizowany zestaw zasobow dostosowany do konkretnej dziedziny lub kontekstu, takiego jak
opinie o produktach.

* Pakietach analizy tekstu (TAP). Pakicty TAP wiaza szablon zasobow z jednym lub wieloma wyspecjalizowanymi
zestawami kategorii wygenerowanych przy uzyciu zasobdw z tego szablonu. Dzigki temu kategorie i zasoby sa
przechowywane razem i moga by¢ wielokrotnie wykorzystywane. Wigcej informacji zawiera temat
[pakietow analizy tekstu (TAP)” na stronie 127

* Bibliotekach. Biblioteki sa uzywane jako elementy sktadowe dla pakietow TAP i szablonéw. Mozna je rowniez
dodawac pojedynczo do zasobow w sesji. Kazda biblioteka sktada si¢ z kilku stownikow uzywanych do
definiowania typow, synonimdw i list wykluczen oraz zarzadzania tymi elementami. Cho¢ biblioteki sa rowniez

dostarczane indywidualnie, sa spakowane w szablonach i pakietach TAP. Wigcej informacji zawiera temat
[Rozdziat 15, “Praca z bibliotekami”, na stronie 165}

Uwaga: Podczas wyodrgbniania uzywane sa rowniez pewne skompilowane zasoby wewngtrzne. Te skompilowane
zasoby zawieraja duza liczbe definicji dopetiajacych typy w bibliotece Core. Tych skompilowanych zasobow nie
mozna edytowac.

Resource Editor zapewnia dostgp do zestawu zasobdéw uzywanych do generowania wynikéw wyodrebniania (pojec,
typow i wzorcow). W edytorze Resource Editor mozna wykonywac szereg roznych zadan, takich jak:

* Praca z bibliotekami. Wiecej informacji zawiera temat[Rozdziat 15, “Praca z bibliotekami”, na stronie 165|

+ Tworzenie stownikow typow. Wiecej informacji zawiera temat[“Tworzenie typow” na stronie 175

+ Dodawanie terminéw do stownikéw. Wiecej informacji zawiera temat [‘Dodawanie terminéw” na stronie 176|

+ Tworzenie synonimoéw. Wiecej informacji zawiera temat[‘Definiowanie synoniméw” na stronie 181}

+ Aktualizowanie zasobow w pakiecie TAP. Wiccej informacji zawiera temat|[“Aktualizowanie pakietow analizy|
ftekstu” na stronie 129]

+ Tworzenie szablonow. Wigcej informacji zawiera temat [“Tworzenie i modyfikowanie szablonéw” na stronie 152]

+ Importowanie i eksportowanie szablonéw. Wiecej informacji zawiera temat [‘Importowanie i eksportowanie|
[szablonoéw” na stronie 161}

* Publikowanie bibliotek. Wigcej informacji zawiera temat [‘Publikowanie bibliotek” na stronie 171|

Template Editor a Resource Editor

Istnieja dwie gtowne metody pracy z szablonami, bibliotekami i ich zasobami oraz edytowania ich. Na zasobach
lingwistycznych mozna operowa¢ w edytorze Template Editor lub w edytorze Resource Editor.

Template Editor
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Template Editor umozliwia tworzenie i edytowanie szablonéw zasobdw bez uzycia interaktywnego pulpitu roboczego i
niezaleznie od konkretnego wezta lub strumienia. Ten edytor stuzy do tworzenia lub edytowania szablonéw zasobow
przed zatadowaniem ich do wezta Text Link Analysis i wgzta modelowania Text Mining.

Template Editor jest dostgpny z gldwnego paska narzgdzi produktu IBM SPSS Modeler, za posrednictwem menu
Tools> Text Analytics Template Editor.

Resource Editor

Resource Editor jest dostepny w interaktywnym pulpicie roboczym, pozwala pracowac z zasobami w konteks$cie
konkretnego wezta i zbioru danych. Po dodaniu do strumienia wezta modelowania Text Mining mozna zatadowac
kopig zawartosci szablonu zasobow lub kopig pakietu analizy tekstu (zestawy kategorii i zasoby), aby okresli¢ sposob
wyodrgbniania tekstu do eksploracji. W przypadku uruchomienia interaktywnego pulpitu roboczego oprocz tworzenia
kategorii, wyodrgbniania wzorcow TLA i tworzenia modeli kategorii mozna rowniez zoptymalizowaé zasoby pod
katem danych sesji w zintegrowanym widoku Resource Editor. Wiecej informacji zawiera temat[“Edytowanie zasobow]
W oknie Resource Editor” na stronie 151}

Za kazdym razem, gdy operujesz na zasobach w interaktywnym pulpicie roboczym, zmiany te maja zastosowanie tylko
w biezacej sesji interaktywne;j. Jesli chcesz zapisa¢ swoja prace (zasoby, kategorie, wzorce itp.), aby kontynuowac

rac¢ podczas kolejnej sesji, musisz zaktualizowa¢ wezet modelowania. Wigcej informacji zawiera temat
‘Aktualizowanie weztéw modelowania i zapisywanie” na stronie 76|

Jesli cheesz zapisa¢ zmiany z powrotem do oryginalnego szablonu, ktorego zawarto$¢ zostata skopiowana do wezta
modelowania, tak aby ta aktualizacja szablonu mogta zosta¢ zatadowana do innych weztdw, mozesz utworzy¢ szablon
z zasobow. Wiecej informacji zawiera temat[“Tworzenie i modyfikowanie szablondw” na stronie 152}

Interfejs edytora

Operacje wykonywane w widoku Template Editor lub Resource Editor zwiazane sa z zarzadzaniem i optymalizacja
zasobow lingwistycznych. Zasoby te sa przechowywane w postaci szablondw i bibliotek. Wigcej informacji zawiera
temat [“Stowniki typow” na stronie 173

Karta Library Resources
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Rysunek 36. Edytor szablonéw eksploracji tekstu
Interfejs jest podzielony na cztery czg$ci w nastepujacy sposob:

1. Panel drzewa bibliotek. Znajduje si¢ w lewym gornym rogu i zawiera drzewo bibliotek. W drzewie tym mozna
wlaczaé 1 wytaczac biblioteki oraz filtrowa¢ widoki w innych panelach, wybierajac bibliotekg w drzewie. Za
posrednictwem menu kontekstowych mozna wykonywa¢ w tym drzewie wiele roznych operacji. Po rozwinigciu
biblioteki w drzewie widoczne staja sig typy, ktore ta biblioteka zawiera. Mozesz takze filtrowac tg listg za
posrednictwem menu View, jesli chcesz pracowac¢ tylko z jedna konkretna biblioteka.

2. Listy terminéw na panelu slownika typow. Panel ten znajduje si¢ na prawo od drzewa bibliotek i zawiera listy
termindéw stownikow typow dla bibliotek wybranych w drzewie. Slownik typu jest zbiorem termindéw pogrupowanych
pod jedna etykieta lub nazwa typu. Odczytujac dane tekstowe, mechanizm wyodrgbniania poréwnuje wyrazy
napotkane w tekscie z terminami w stownikach typow. Jesli wyodrgbnione pojecie figuruje jako termin w stowniku
typow, to jest mu przypisywana nazwa typu wlasciwa dla stownika. Stownik typu mozna postrzegac jako stownik
terminow, ktore maja ze soba cos wspdlnego. Na przyktad typ <Location> w bibliotece Core zawiera takie pojecia, jak
new orleans, great britain i new york. Wszystkie te terminy reprezentuja lokalizacje geograficzne. Jedna biblioteka
moze zawiera¢ jeden lub wiecej stownikéw typow. Wigcej informacji zawiera temat [‘Stowniki typow” na stronie 173|

3. Panel stownika wykluczen. Panel ten znajduje si¢ po prawej stronie i zawiera zbior terminéw, ktdre zostana
wykluczone z ostatecznych wynikéw wyodrebniania. Terminy figurujace w stowniku wykluczen nie pojawiaja si¢ w
panelu Extraction Results. Wykluczone terminy moga by¢ zapisane w bibliotece wybranej przez uzytkownika. Jednak
na panelu stownika wykluczen wyswietlane sa wszystkie wykluczone terminy dla wszystkich bibliotek widocznych w
drzewie biblioteki. Wigcej informacji zawiera temat [*Stowniki wykluczen” na stronie 183]
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4. Panel stownika zastapien. Panel ten znajduje si¢ w lewym dolnym rogu i na osobnych kartach zawiera synonimy
oraz elementy opcjonalne. Synonimy i elementy opcjonalne pomagaja w grupowaniu podobnych terminéw pod jednym
pojeciem wiodacym lub docelowym w ostatecznych wynikach wyodrgbniania. Stownik ten moze zawiera¢ znane
synonimy oraz synonimy i elementy zdefiniowane przez uzytkownika, jak réwniez czgsto spotykane btednie zapisane
formy terminéw potaczone w pary z terminami zapisanymi poprawnie. Definicje synonimow i elementy opcjonalne
moga by¢ zapisane w bibliotece wybranej przez uzytkownika. Jednak na panelu stownika zastapien wyswietlane sa
pozycje ze wszystkich bibliotek widocznych w drzewie biblioteki. Wprawdzie na panelu tym wyswietlane sa wszystkie
synonimy i elementy opcjonalne ze wszystkich bibliotek, zastapienia dla wszystkich bibliotek z drzewa sa widoczne w
tym panelu tacznie. Jedna biblioteka moze zawiera¢ tylko jeden stownik zastapien. Wigcej informacji mozna znalez¢ w
temacie [“Stowniki zastapien/synonimow” na stronie 180}

Uwagi:
* Jesli cheesz, aby byly widoczne tylko informacje dotyczace jednej biblioteki, mozesz zmieni¢ widok biblioteki,
korzystajac z listy rozwijanej na pasku narzedzi. Zawiera ona ogdlny wpis All Libraries (Wszystkie biblioteki) oraz

dodatkowe wpisy poszczegolnych bibliotek. Wigcej informacji zawiera temat[“Przegladanie bibliotek” na stronie]
-168

Karta Advanced Resources

Zaawansowane zasoby sa dostgpne na drugiej karcie w widoku edytora. Mozesz przegladac i edytowac zasoby
zaawansowane na tej karcie. Wigcej informacji zawiera [Rozdziat 17, “Informacje o zasobach zaawansowanych”, nal
stronie 185
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Rysunek 37. Edytor szablonéw eksploracji tekstu - karta Advanced Resources

Karta Text Link Rules
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Poczawszy od wersji 14 reguty analizy powiazan w tekscie sa edytowalne na odrebnej karcie w widoku edytora.
Mozesz pracowaé w edytorze regut, tworzy¢ wlasne reguty, a nawet uruchomic symulacije, aby zobaczy¢, w jaki sposob
reguly wptyna na wyniki analizy TLA. Wigcej informacji zawiera IRozdziai 18, “Informacje o regutach powiazan w|

tekscie”, na stronie 197]
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Text Link
Simulation

Begin by defining some data to be used to simulate the text link analysis results.
Mext, you can run a simulation to see the text link rules matched to your data.

Then, create new rules or edit existing ones as needed

Rysunek 38. Edytor szablonéw eksploracji tekstu — karta Text Link Rules

Otwieranie szablonow

Po uruchomieniu edytora Template Editor zostanie wy$wietlona zachgta do otwarcia szablonu. Mozna tez otworzy¢
szablon z menu File. Jesli potrzebujesz szablonu, ktory zawiera reguty analizy powiazan w tekscie (TLA), wybierz
szablon z ikona w kolumnie TLA. Jezyk, w ktorym szablon zostal utworzony, jest wyswietlany w kolumnie Language.

Jesli cheesz zaimportowac szablon, ktory nie jest wyswietlany w tabeli, lub jesli chcesz wyeksportowac szablon,
mozesz uzy¢ przyciskow w oknie dialogowym Open Template. Wigcej informacji zawiera temat

kksportowanie szablonéw” na stronie 161|

Aby otworzy¢ szablon

1.

2.

Z menu w oknie Template Editor wybierz opcje File > Open Resource Template. Zostanie otwarte okno
dialogowe Open Resource Template.

W tabeli wybierz szablon, ktdrego chcesz uzy¢.

Kliknij przycisk OK, aby otworzy¢ ten szablon. Jesli masz obecnie otwarty inny szablon w edytorze, kliknigcie
przycisku OK spowoduje odrzucenie otwartego szablonu i wyswietlenie szablonu wybranego w oknie dialogowym.
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Jesli wprowadzisz zmiany w zasobach i chcesz zapisac biblioteki do wykorzystania w przysztosci, mozesz
opublikowa¢, zaktualizowa¢ i udostepnic je przed otwarciem innego szablonu. Wigcej informacji zawiera temat
[“Wspotuzytkowanie bibliotek” na stronie 170}

Zapisywanie szablonow

W edytorze Template Editor mozna zapisa¢ zmiany wprowadzone do szablonu. Mozna zapisa¢ je pod nazwa
istniejacego szablonu lub pod nowa nazwa.

Jesli wprowadzisz zmiany w szablonie, ktory zostat juz wczesniej zaladowany do wezla, musisz ponownie zatadowac
zawartos$¢ szablonu do wezta, aby uwzgledni¢ najnowsze zmiany. Wigcej informacji zawiera temat
Fasobow z szablonow i pakietéw TAP” na stronie 26}

Lub, jesli na karcie Model wezta Text Mining wybrana jest opcja Use saved interactive work, co oznacza, ze uzywane
sa zasoby z poprzedniej sesji pracy z interaktywnym pulpitem roboczym, musisz przetaczy¢ si¢ na zasoby tego
szablonu w ramach sesji interaktywnej. Wigcej informacji zawiera temat|“Przelaczanie si¢ miedzy szablonamil
asobow” na stronie 153]

Uwaga: Mozliwe jest takze publikowanie i udostepnianie bibliotek. Wigcej informacji zawiera temat
[‘Wspotuzytkowanie bibliotek” na stronie 170}

Aby zapisa¢ szablon

1. Z menu w oknie Template Editor, wybierz opcje File > Save Resource Template. Zostanie otwarte okno
dialogowe Save Resource Template.

2. Wprowadz nowa nazwe w polu Template name, jesli chcesz zapisac ten szablon jako nowy. Wybierz szablon w
tabeli, jesli chcesz zastapi¢ istniejacy szablon aktualnie zatadowanymi zasobami.

3. W razie potrzeby wprowadz opis, aby w tabeli byt widoczny komentarz lub adnotacja.
4. Kliknij przycisk Save, aby zapisa¢ szablon.

Wazne! Poniewaz zasoby z szablonow i pakietow TAP sa tadowane/kopiowane do wezta, nalezy zaktualizowaé
zasoby, ponownie je tadujac, jesli wprowadzono zmiany w szablonie i zmiany te maja by¢ wykorzystane w istniejacym
strumieniu. Wigcej informacji zawiera temat [‘Aktualizowanie zasoboéw wezta po zatadowaniu’|

Aktualizowanie zasobow wezta po zatadowaniu

Domyslnie, gdy uzytkownik dodaje wezet do strumienia, zestaw zasobdw z domyslnego szablonu zostaje zatadowany i
osadzony w wezle. A w przypadku zmiany szablonu lub uzycia pakietu TAP zawarto$¢ nadpisuje dotychczasowe
zasoby. Poniewaz szablony i pakiety TAP nie sa powiazane z wezlem bezposrednio, wszelkie wprowadzone zmiany w
szablonie lub pakiecie TAP nie sa automatycznie dostepne w istniejacym wezle. Aby skorzystac z tych zmian, nalezy
zaktualizowa¢ zasoby w wezle. Zasoby mozna aktualizowac na dwa sposoby.

Metoda 1: Ponownie zaladowanie zasoboéw w karcie Model

Jesli cheesz zaktualizowac¢ zasoby w wezle przy uzyciu nowego lub zaktualizowanego szablonu lub pakietu TAP,
mozesz ponownie zatadowac zasoby na karcie Model wezta. Ponowne zatadowanie spowoduje zastapienie kopii
zasobow w wezle bardziej aktualna kopia. Dla wygody uzytkownika czas i data aktualizacji zostana wyswietlone na
karcie Model wraz z nazwa szablonu zrodlowego. Wiecej informacji zawiera temat[‘Kopiowanie zasobéw z szablonowl
i pakietow TAP” na stronie 26|

Jednak w przypadku pracy na interaktywnym pulpicie roboczym w wezle modelowania Text Mining i wybrania opcji
Use session work na karcie Model uzywane bgda zapisane efekty pracy i zasoby sesji, a przycisk Load bedzie
wylaczony. Wynika to z faktu, ze w przesztosci podczas sesji interaktywnej wybrano opcje Update Modeling Node i
zachowano kategorie, zasoby i inne efekty pracy. W tym przypadku, jesli chcesz zmieni¢ lub zaktualizowac¢ te zasoby,
mozesz skorzysta¢ z nastgpnej metody, czyli przetaczenia si¢ migdzy zasobami w edytorze Resource Editor.
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Metoda 2: Przetaczanie si¢ miedzy zasobami w edytorze Resource Editor

Za kazdym razem, gdy chcesz uzy¢ innych zasobow podczas sesji interaktywnej, mozesz podmienic te zasoby za
pomoca okna dialogowego Switch Resources. Jest to szczegolnie uzyteczne, jesli chcesz ponownie wykorzystac
istniejace definicje kategorii, ale zastapi¢ zasoby. W takim przypadku mozna wybrac opcjg Use session work na karcie
Model wezta modelowania Text Mining. W ten sposéb mozna zablokowa¢ mozliwos$¢ ponownego zaladowania
szablonu w oknie dialogowym wezta, a zamiast tego zachowac¢ ustawienia i zmiany dokonane podczas sesji. Nastgpnie
mozna uruchomi¢ sesj¢ interaktywnego pulpitu roboczego, uruchamiajac strumien i przelaczajac si¢ na inne zasoby w
ﬁtorze Resource Editor. Wigcej informacji zawiera temat [‘Przetaczanie si¢ miedzy szablonami zasobow” na stronie|
153

W celu zachowania efektéw pracy, w tym zasobow, do wykorzystania w przysztych sesjach nalezy zaktualizowaé
wezel modelowania z poziomu interaktywnego pulpitu roboczego, aby zasoby (i inne dane) zostaly zapisane z
%Iwrotem do wezta. Wigcej informacji zawiera temat [‘Aktualizowanie weztéw modelowania i zapisywanie” na stronie]

Uwaga: Jesli przelaczysz sig na zawartos¢ innego szablonu podczas sesji interaktywnej, nazwa szablonu wymieniona w
wezle nadal bedzie nazwa ostatniego zatadowanego i skopiowanego szablonu. Aby skorzysta¢ z tych zasobdw lub
innych efektow pracy interaktywnej, zaktualizuj wezet modelowania przed zakonczeniem sesji.

Zarzadzanie szablonami

Niekiedy trzeba wykona¢ pewne pewne podstawowe czynnosci zwiazane z zarzadzaniem szablonami, takie jak
zmienianie nazw szablonow, importowanie i eksportowanie szablonow lub usuwanie przestarzatych szablonow.
Czynnosci te wykonuje si¢ w oknie dialogowym Manage Templates. Importowanie i eksportowanie szablondw
umozliwia wspoluzytkowanie szablondéw z innymi uzytkownikami. Wigcej informacji zawiera temat
kksportowanie szablonow’]

Uwaga: Nie mozna zmieni¢ nazwy lub usuna¢ szablonu, ktory zostal zainstalowany (lub dostarczony) razem z
produktem. Jesli chcesz zmieni¢ nazwe takiego szablonu, mozesz otworzy¢ zainstalowany szablon i utworzy¢ nowy o
dowolnej nazwie. Mozesz usuwaé swoje wlasne szablony. Jesli jednak sprobujesz usunac szablon dostarczony z
produktem, to zostanie on przywrdcony do pierwotnego stanu z chwili instalacji.

Aby zmieni¢ nazwg szablonu

1. Z menu wybierz opcje Resources > Manage Resource Templates. Zostanie otwarte okno dialogowe Manage
Templates.

2. Wybierz szablon, ktorego nazwe chcesz zmienié, i kliknij opcje Rename. Pole nazwy staje si¢ polem dostgpnym
do edycji w tabeli.

3. Wpisz nowa nazwg, a nastgpnie nacisnij klawisz Enter. Zostanie otwarte okno dialogowe z potwierdzeniem.

4. Jesli zgadzasz si¢ na zmiang nazwy, kliknij przycisk Yes. Jesli nie, kliknij przycisk No.

Aby usunac¢ szablon

1. Z menu wybierz opcje Resources > Manage Resource Templates. Zostanie otwarte okno dialogowe Manage
Templates.

2. W oknie dialogowym Manage Templates wybierz szablon, ktory chcesz usunac.

w

Kliknij przycisk Delete. Zostanie otwarte okno dialogowe z potwierdzeniem.

4. Kliknij przycisk Yes, aby usunac, lub kliknij przycisk No, aby anulowa¢ zadanie. Jesli zostanie kliknigty przycisk
Yes, szablon zostanie usunigty.

Importowanie i eksportowanie szablonow

Szablony mozna wspotuzytkowac z innymi uzytkownikami lub komputerami przez importowanie i eksportowanie ich.
Szablony sa przechowywane w wewngtrznej bazie danych, ale moga by¢ eksportowane jako pliki *./rf na dysk twardy.
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Poniewaz istnieja okolicznosci, w ktdrych konieczne moze by¢ importowanie lub eksportowanie szablondw,
odpowiednie funkcje udostgpniono w kilku oknach dialogowych. Wymieniono je ponize;j.

* Okno dialogowe Open Template w edytorze Template Editor
* Okno dialogowe Load Resources w wezle modelowania Text Mining i wezle Text Link Analysis.
* Okno dialogowe Manage Templates w edytorach Template Editor i Resource Editor.

Aby zaimportowac szablon
1. W oknie dialogowym kliknij przycisk Import. Zostanie otwarte okno dialogowe Import Template.

2. Wybierz plik szablonu zasobow (*./rf) do zaimportowania i kliknij przycisk Import. Mozna zapisa¢
zaimportowany szablon pod inna nazwa lub nadpisac istniejacy. Okno dialogowe zostanie zamknigte, a szablon
zostanie wyswietlony w tabeli.

Aby wyeksportowac szablon

1. W oknie dialogowym wybierz szablon, ktdry chcesz wyeksportowac, a nastgpnie kliknij przycisk Export. Zostanie
otwarte okno dialogowe Select Directory.

2. Wybierz katalog, do ktorego chcesz wyeksportowac biblioteke, i kliknij przycisk Export. To okno dialogowe
zostanie zamknigte, a szablon zostanie wyeksportowany do pliku o rozszerzeniu *./rt.

Wychodzenie z edytora Template Editor

Po zakonczeniu pracy w edytorze Template Editor mozna zapisa¢ prace i wyjs$¢ z edytora.

Aby wyj$¢ z edytora Template Editor
1. Z menu wybierz opcje File > Close. Zostanie otwarte okno dialogowe Save and Close.
2. Wybierz opcje Save changes to template, aby zapisa¢ otwarty szablon przed zamknigciem edytora.

3. Wybierz opcje¢ Publish libraries, jesli chcesz opublikowa¢ ktorekolwiek z bibliotek w otwartym szablonie przed
zamknigciem edytora. Jesli ta opcja zostanie wybrana, pojawi si¢ zachgta do wybrania bibliotek do opublikowania.
Wigcej informacji zawiera temat [‘Publikowanie bibliotek” na stronie 171]

Tworzenie kopii zapasowej zasobow

Ze wzgledow bezpieczenstwa wskazane moze by¢ tworzenie kopii zapasowych zasobow.

Wazne! Podczas odtwarzania cala zawarto§¢ zasobow zostanie wyczyszczona, a w produkcie bgdzie dostgpna jedynie
zawartos¢ pliku kopii zapasowej. Dotyczy to takze efektow biezacej pracy.

Uwaga: Mozliwe jest tylko tworzenie i odtwarzanie kopii zapasowych do tej samej wersji gtéwnej oprogramowania.
Na przyktad, jesli kopia zapasowa zostata utworzona w wersji 15, to nie mozna jej odtworzy¢ w wersji 16.

Aby utworzy¢ kopig zapasowa zasobow

1. Z menu wybierz kolejno opcje Resources > Backup Tools > Backup Resources. Zostanie otwarte okno
dialogowe Backup.

2. Wprowadz nazwe pliku kopii zapasowej, a nastgpnie kliknij przycisk Save. Okno dialogowe zostanie zamknigte, a
plik kopii zapasowej zostanie utworzony.

Aby odtworzy¢ zasoby

1. Z menu wybierz kolejno opcje Resources > Backup Tools > Restore Resources. Pojawi si¢ alert informujacy o
tym, ze odtwarzanie spowoduje zastapienie biezacej zawartosci bazy danych.

2. Kliknij przycisk Yes, aby kontynuowac. Zostanie otwarte okno dialogowe.

3. Wybierz plik kopii zapasowej, ktora checesz odtworzy¢, i kliknij przycisk Open. Okno dialogowe zostanie
zamknigte, a zasoby zostana odtworzone w aplikacji.
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Importowanie plikéw zasobow

Jesli wprowadzono zmiany bezposrednio w plikach zasobow poza produktem, to mozna zaimportowac te pliki do
wybranej biblioteki, wybierajac t¢ biblioteke i inicjujac operacj¢ importu. Importujac stownik, mozna tez zaimportowac
wszystkie obstugiwane pliki do okreslonej otwartej biblioteki. Importowa¢ mozna wytacznie pliki *.txt.

Kazdy zaimportowany plik musi zawiera¢ po jednym wpisie w kazdym wierszu, a jesli zawartosc jest
ustrukturyzowana jako:

lista wyrazow lub fraz (po jednej na wiersz), plik jest importowany jako lista termindéw do stownika typu, przy czym
stownik typu przyjmuje nazwe pliku bez rozszerzenia.

lista terminow w postaci term1 <TAB> term2, wéwczas importowana jest jako lista synonimow, gdzie term1 jest
terminem podstawowym, a term2 jest terminem docelowym.

Aby zaimportowa¢ jeden plik zasobow

1.

Z menu wybierz kolejno opcje Resources > Import Files > Import Single File. Zostanie otwarte okno dialogowe
Import File.

Wybierz plik, ktory cheesz zaimportowac, i kliknij przycisk Import. Zawartos¢ pliku zostanie przeksztatcona do
formatu wewngtrznego i dodana do biblioteki.

Aby zaimportowa¢ wszystkie pliki z katalogu

1.

Z menu wybierz kolejno opcje Resources > Import Files > Import Entire Directory. Zostanie otwarte okno
dialogowe Import Directory.

Na liscie Import wybierz biblioteke, do ktorej chcesz zaimportowaé wszystkie pliki zasobow. Wybranie opcji
Default spowoduje utworzenie nowej biblioteki o nazwie wskazanego katalogu.

Wybierz katalog, z ktdrego maja by¢ importowane pliki. Zawarto$¢ podkatalogéw nie bedzie odczytywana.

Kliknij przycisk Import. Okno dialogowe zostanie zamknigte, a zawartos¢ importowanych plikow zasobdw pojawi
si¢ w edytorze w postaci stownikéw i plikow zasobow zaawansowanych.
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Rozdziat 15. Praca z bibliotekami

Zasoby uzywane do wyodrgbniania i grupowania terminéw wystgpujacych danych tekstowych zawsze zawieraja co
najmniej jedna biblioteke. Zestaw bibliotek widoczny jest drzewie bibliotek znajdujacym si¢ w lewej gornej czgsci
okna Template Editor i Resource Editor. Biblioteki sktadaja si¢ z trzech rodzajow stownikow: typow, zastapien i
wykluczen. Wiecej informacji zawiera [Rozdziat 16, “Informacje o stownikach w bibliotekach”, na stronie 173

Wybrany szablon zasobdw lub zasoby z wybranego pakietu TAP zawieraja kilka bibliotek, dzigki ktérym mozna
natychmiast rozpocza¢ wyodregbnianie poje¢ z danych tekstowych. Mozna jednak utworzy¢ wtasne biblioteki oraz
ikowac’ je do ponownego wykorzystania. Wigcej informacji zawiera temat [‘Publikowanie bibliotek” na stronie|

Zalézmy na przyktad, ze czgsto pracujemy z danymi tekstowymi z branzy motoryzacyjnej. Po przeanalizowaniu
danych decydujemy, ze chcemy utworzy¢ zasoby dostosowane do naszej branzy, aby uwzglednic¢ specjalistyczne
stownictwo lub zargon. Za pomoca edytora Template Editor mozna utworzy¢ nowy szablon, a w nim bibliotekg do
wyodrgbnienia i grupowania termindéw wiasciwych dla branzy motoryzacyjnej. Poniewaz informacje z tej biblioteki
beda wykorzystywane wielokrotnie, nalezy opublikowac¢ biblioteke w centralnym repozytorium, do ktérego mozna
uzyska¢ dostgp w oknie dialogowym Manage Libraries, aby mozna ja bylo ponownie wykorzysta¢ w innych sesjach
strumienia .

Zatdézmy, ze interesuje nasz takze pogrupowanie sktadnikow, ktdre sa specyficzne dla réznych poddziedzin, takich jak
urzadzenia elektroniczne, silniki, uktady chtodzenia, lub nawet konkretnego producenta lub rynku. Mozemy utworzy¢
biblioteke dla kazdej grupy, a nastgpnie opublikowac¢ biblioteki w taki sposob, aby mogtly by¢ uzywane z wieloma
zbiorami danych tekstowych. W ten sposob mozna dodac biblioteki, ktore najlepiej odpowiadaja kontekstowi danych
tekstowych.

Uwaga: Dodatkowe zasoby moga by¢ konfigurowane i zarzadzane na karcie Advanced Resources. Niektdre maja
zastosowanie do wszystkich bibliotek i zarzadzania obiektami nielingwistycznymi, wyjatkami grupowania rozmytego i
tak dalej. Ponadto na karcie Text Link Rules mozna edytowac reguty wzorcow analizy powiazan w tekscie, ktore sa

charakterystyczne dla biblioteki. Wigcej informacji zawiera [Rozdziat 17, “Informacje o zasobach zaawansowanych” |
ﬂ

Biblioteki dostarczone z produktem

Domyslnie pewne biblioteki sa instalowane razem z produktem IBM SPSS Modeler Text Analytics. Mozna uzy¢ tych
wstepnie sformatowanych bibliotek, aby uzyska¢ dostep do tysigey predefiniowanych terminéw i synoniméw, a takze
wielu réznych typdw. Dostarczone biblioteki sa zoptymalizowane pod katem kilku réznych dziedzin i sa dostgpne w
kilku réznych jezykach.

Istnieje wiele bibliotek, ale najczesciej uzywane sa nastgpujace:

* Biblioteka lokalna. Stuzy do przechowywania stownikdéw zdefiniowanych przez uzytkownika. Jest ona pusta
biblioteka dodana domyslnie do wszystkich zasobdw. Zawiera tez pusty stownik typow. Jest to szczegdlnie
przydatne podczas wprowadzania zmian lub udoskonalen do zasobow bezposrednio (na przyktad poprzez dodanie
wyrazu do typu) z widoku Categories and Concepts, widoku Clusters i widoku Text Link Analysis . W tym
przypadku te zmiany i udoskonalenia sg automatycznie zapisywane w pierwszej bibliotece wymienionej w drzewie
bibliotek edytora Resource Editor; domyslnie jest to biblioteka o nazwie Local Library. Nie mozna opublikowac tej
biblioteki, poniewaz jest ona charakterystyczna dla danych sesji . Jesli chcesz opublikowac jej zawartos¢, musisz
zmieni¢ jej nazwe.

* Biblioteka Core. Uzywana w wigkszos$ci przypadkow, poniewaz zawiera pi¢¢ wbudowanych typdéw podstawowych
reprezentujacych osoby, miejsca, organizacje, produkty i elementy nieznane. Cho¢ niekiedy w stownikach typow
biblioteki Core wymienione sa tylko nieliczne terminy, typy te sa w istocie tylko dopelnieniem wszechstronnych
typow zdefiniowanych w wewnetrznych zasobach skompilowanych, ktére zostaly dostarczone z produktem do
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eksploracji tekstu. Te wewngtrzne skompilowane zasoby zawieraja tysiace termindéw kazdego typu. Z tego powodu,
nawet jesli terminu nie ma na liScie stownika typu, termin ten moze zosta¢ wyodrgbniony i przypisany do tupu
podstawowego z biblioteki Core. Wyjasnia to, dlaczego imiona, takie jak George, moga by¢ wyodrgbniane i
przypisywane do typu <Person>, mimo ze w stowniku typu <Person> biblioteki Core figuruje tylko imig Jokn.
Podobnie, jesli nie uwzglgdnisz biblioteki Core, wyniki wyodrgbniania moga nadal zawierac te typy, poniewaz
mechanizm wyodregbniania nadal begdzie uzywat zawierajacych je skompilowanych zasobow wewngtrznych.

* Biblioteka opinii Opinions. Najczgsciej stuzy do wyodregbniania opinii i sentymentu z danych tekstowych.
Biblioteka ta zawiera tysiace wyrazow oznaczajacych postawy, kwalifikatory i preferencje, ktore — gdy uzywane sa
facznie z innymi terminami — wyrazaja opinie o temacie. Ta biblioteka zawiera szereg wbudowanych typow,
synonimow i wykluczen. Zawiera takze obszerny zestaw regut wzorcow uzywanych na potrzeby analizy powiazan w
tekscie. Aby mozna bylo korzysta¢ z regut analizy powiazan w tekscie zawartych w tej bibliotece oraz z
wynikowych wzorcdw generowanych przez te reguly, biblioteka ta musi by¢ okreslona na karcie Text Link Rules.
W-iqcej informacji mozna znalez¢ w temacie [Rozdziat 18, “Informacije o regutach powiazan w tekscie”, na stronie|
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* Biblioteka Budget. Stuzy do wyodrgbniania sktadnikow odnoszacych si¢ do kosztow czegos. Biblioteka ta zawiera
wiele wyrazow i fraz bedacych przymiotnikami, kwalifikatorami i wyrazajacymi oceny dotyczace cen i jakosci.

* Biblioteka Variations. Stuzy do uwzgledniania przypadkow, w ktorych pewne warianty jezykowe wymagaja
zdefiniowania synonimow, by byty prawidlowo grupowane. Ta biblioteka zawiera tylko definicje synonimow.

Mimo ze niektdre z bibliotek dostarczanych poza zasobami maja zawarto$¢ zblizona do niektorych szablonow,
szablony zostaly precyzyjnie dopasowane do konkretnych zastosowan i zawieraja dodatkowe zaawansowane zasoby.
Zalecamy, aby podja¢ probe uzycia szablonu zaprojektowanego dla rodzaju danych tekstowych, ktore maja by¢
analizowane, a potem wprowadza¢ zmiany w tych zasobach, a nie dodawac¢ poszczegdlne biblioteki do ogdlnego
szablonu.

Takze pewne skompilowane zasoby sa dostarczane z produktem IBM SPSS Modeler Text Analytics. Sa one zawsze
uzywane podczas procesu wyodrgbniania i zawieraja duza liczbg definicji uzupehiajacych wbudowane stowniki typow
w domyslnych bibliotekach. Poniewaz te zasoby sa kompilowane, nie moga by¢ wyswietlane ani edytowane. Mozna
jednak wymusi¢ wpisanie terminu o typie okreslonym w zasobach skompilowanych do dowolnego innego stownika.
Wiecej informacji zawiera temat [*Wymuszanie terminéw” na stronie 178|

Tworzenie bibliotek

Mozna utworzy¢ dowolna liczbg bibliotek. Po utworzeniu nowej biblioteki mozna rozpoczac tworzenie stownikow
typow w tej bibliotece, a nastgpnie wprowadzi¢ terminy, synonimy i wykluczenia.

Aby utworzy¢ biblioteke

1. Z menu wybierz opcje Resources > New Library. Zostanie otwarte okno dialogowe Library Properties .
2. Wprowadz nazwg biblioteki w polu tekstowym Name.

3. W razie potrzeby wpisz komentarz w polu tekstowym Annotation.

4

Kliknij przycisk Publish, jesli chcesz opublikowac te biblioteke teraz, przed wprowadzeniem jakichkolwiek zmian.
Wigcej informacji zawiera temat [“Wspotuzytkowanie bibliotek” na stronie 170} Mozna réwniez opublikowaé
bibliotekg pdzniej w dowolnym czasie.

5. Kliknij przycisk OK, aby utworzy¢ bibliotekg. Okno dialogowe zostanie zamknigte, a biblioteka zostanie
wyswietlona w widoku drzewa. Jesli rozwiniesz biblioteki w drzewie, zobaczysz, ze biblioteka zawiera utworzony
automatycznie pusty stownik typu. Mozna od razu rozpocza¢ dodawanie do niego terminow. Wigcej informacji
zawiera temat[“Dodawanie terminéw” na stronie 176}

Dodawanie bibliotek publicznych

Jesli cheesz ponownie wykorzystaé bibliotekg z innej sesji , mozesz dodac ja do biezacych zasobow, o ile tylko jest
biblioteka publiczna. Biblioteka publiczna to biblioteka, ktoéra zostala opublikowana. Wigcej informacji zawiera temat
[‘Publikowanie bibliotek” na stronie 171}
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Gdy dodajesz biblioteke publiczna, lokalna jej kopia jest osadzana w danych sesji. Mozesz wprowadzi¢ zmiany w
takiej bibliotece; jednak musisz ponownie opublikowac tg wersj¢ publiczna, jesli chcesz udostgpni¢ zmiany w innych
sesjach lub projektach.

Podczas dodawania biblioteki publicznej moze pojawic¢ si¢ okno dialogowe Resolve Conflicts, jesli zostana wykryte
konflikty migdzy terminami i typami w jednej bibliotece a terminami i typami w pozostatych bibliotekach lokalnych.
Uzytkownik musi rozstrzygnac¢ te konflikty lub zaakceptowaé¢ proponowane rozwiazania w celu zakonczenia operacji.
Wiecej informacji zawiera temat [‘Rozstrzyganie konfliktow” na stronie 172}

Uwaga: Jesli zawsze aktualizujesz biblioteki podczas uruchamiania interaktywnego pulpitu roboczego lub publikujesz
biblioteki przy zamykaniu pulpitu , ryzyko rozsynchronizowania bibliotek bedzie mniejsze. Wigcej informacji mozna
znalez¢ w temacie [“Wspotuzytkowanie bibliotek™ na stronie 170}

Aby dodac¢ biblioteke
1. Z menu wybierz opcje Resources > Add Library. Zostanie otwarte okno dialogowe Add Library.
2. Wpybierz biblioteke lub biblioteki z listy.

3. Kliknij przycisk Add. Jesli wystgpuja konflikty migdzy nowo dodanymi bibliotekami a jakimikolwiek
bibliotekami, ktore istniaty, pojawi si¢ monit o rozstrzygnigcie konfliktu lub wprowadzenie zmian, aby mozliwe
byto zakonczenie operacji. Wiecej informacji zawiera temat [‘Rozstrzyganie konfliktow” na stronie 172|

Znajdowanie terminow i typéw

Mozna wyszukiwa¢ w réznych oknach w edytorze przy uzyciu funkcji Find. W edytorze mozna wybra¢ z menu opcje
Edit > Find, co spowoduje wyswietlenie paska narzedzi wyszukiwania. Mozna uzy¢ tego paska narzedzi, aby
znajdowac pojedyncze wystapienia. Klikajac ponownie przycisk Find, mozna znalez¢ kolejne wystapienia
wyszukiwanego terminu.

Podczas wyszukiwania edytor przeszukuje tylko bibliotekg lub biblioteki wymienione na liScie rozwijanej
wyszukiwania na pasku narzedzi znajdowania. Jesli wybrana jest opcja All Libraries, program przeszuka wszystkie
elementy w edytorze.

Wyszukiwanie rozpoczyna si¢ w obszarze, ktory jest aktywny. Wyszukiwanie jest kontynuowane w kolejnych
sekcjach, wraca na poczatek i jest przerywane po powrocie do aktywnej komorki. Mozna odwroci¢ kolejnos¢
wyszukiwania za pomocg strzatek kierunkowych. Mozna réwniez wybrac, czy w wyszukiwaniu bedzie rozrézniana
wielkos¢ liter.

Aby znalez¢ tancuchy w widoku

1. Z menu wybierz opcje Edit > Find. Wyswietlony zostaje pasek narzedzi wyszukiwania.

2. Wprowadz tancuch, ktéry chcesz wyszukac.

3. Kliknij przycisk Find, aby rozpocza¢ wyszukiwanie. Zostanie wyroznione nastgpne wystapienie terminu lub typu.
4. Klikaj przycisk ponownie, aby przechodzi¢ od wystapienia do wystapienia.

Uzywanie znaku gwiazdki w terminach

Uzywanie znaku gwiazdki (*) w terminach jest szczegdlnie przydatne podczas pracy z jezykiem aglutynacyjnym, w
ktérym nowe wyrazy powstaja poprzez polaczenie innych wyrazow bez wstawiania spacji. Na przyktad w jezyku
niemieckim wyraz Ubernachtungspreis sktada sig¢ z nastgpujacych elementow: Ubernachtung + s + Preis.
Przyktadowo, podczas wyszukiwania w terminach wyrazu preis* w typie Budget zostanie ono dopasowane do

wyodrebnionych poje¢, takich jak preiserhéhung. W ten sam sposob wyraz *preis zostanie dopasowany do wyrazu
Ubernachtung, a *preis* do Ubernachtungspreiserhéhung.
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Przegladanie bibliotek

Mozna wyswietli¢ zawarto$¢ jednej biblioteki lub wszystkich bibliotek. Ta opcja moze by¢ przydatna podczas pracy z
wieloma bibliotekami lub gdy chcesz przejrze¢ zawartos¢ konkretnej biblioteki przed jej opublikowaniem. Zmiana
widoku wptywa tylko na widocznos¢ elementéw na karcie Library Resources, ale nie wyklucza bibliotek z uzytku
podczas wyodrebniania. Wiecej informacji zawiera temat[“Wytaczanie bibliotek lokalnych’]

Domyslnym widokiem jest widok All Libraries, ktory zawiera wszystkie biblioteki w drzewie i ich zawarto$¢ w
innych panelach. Wybor ten mozna zmieni¢ za pomoca listy rozwijanej na pasku narzedzi lub za pomoca opcji menu
(View > Libraries ). Gdy przegladana jest jedna biblioteka, wszystkie elementy z innych bibliotek sa usuwane z
widoku, ale nadal sa odczytywane podczas wyodregbniania.

Aby zmieni¢ widok bibliotek

1. Z menu na karcie Library Resources wybierz opcje View > Libraries. Zostanie otwarte menu ze wszystkimi
lokalnymi bibliotekami.

2. Wybierz biblioteke, ktore chcesz wyswietli¢, lub wybierz opcje All Libraries, aby wyswietli¢ zawarto$¢
wszystkich bibliotek. Zawarto§¢ widoku zostanie odfiltrowana zgodnie z dokonanym wyborem.

Zarzadzanie bibliotekami lokalnymi

Biblioteki lokalne sa to biblioteki rezydujace wewnatrz sesji pracy z interaktywnym pulpitem roboczym lub wewnatrz
szablonu, co odrdznia je od bibliotek publicznych. Wigcej informacji zawiera temat [Zarzadzanie bibliotekamil
publicznymi” na stronie 169 Do prostych operacji administracyjnych na bibliotekach lokalnych naleza: zmiana nazwy,
wylaczenie lub usunigcie biblioteki lokalne;.

Zmiana nazw bibliotek lokalnych

Mozna zmienia¢ nazwy bibliotek lokalnych. Zmiana nazwy biblioteki lokalnej spowoduje usunigcie jej powiazania z
wersja publiczna, jesli wersja publiczna istnieje. Oznacza to, ze kolejne zmiany nie beda wspdlne z wersja publiczna.
Mozna ponownie opublikowac tg biblioteke¢ lokalna pod nowa nazwa. Oznacza to réwniez, ze nie bedzie mozna
zaktualizowa¢ oryginalnej wersji publicznej z uwzglednieniem wszystkich zmian, ktére zostana wprowadzone do tej
wersji lokalnej.

Uwaga: Nie mozna zmieni¢ nazwy biblioteki publiczne;j.

1. Z menu wybierz opcje Edit > Library Properties. Zostanie otwarte okno dialogowe Library Properties.

Aby zmieni¢ nazwe biblioteki lokalne;j
1. W widoku drzewa wybierz biblioteke, ktorej nazwe chcesz zmienic.
2. Wprowadz nowa nazwg biblioteki w polu tekstowym Name.

3. Kliknij przycisk OK, aby zaakceptowa¢ nowa nazwe biblioteki. Okno dialogowe zostanie zamknigte, a nazwa
biblioteki zostanie zaktualizowana w widoku drzewa.

Wytaczanie bibliotek lokalnych

Jesli cheesz tymczasowo wylaczy¢ biblioteke z procesu wyodrgbniania, mozesz usuna¢ zaznaczenie pola wyboru po
lewej stronie nazwy biblioteki w widoku drzewa. Sygnalizuje to, ze chcesz zachowac bibliotekg, ale jej tre$¢ ma by¢
pomijana podczas wykrywania konfliktéw i podczas wyodrebniania.

Aby wylaczy¢ biblioteke
1. W panelu drzewa bibliotek wybierz biblioteke, ktora chcesz wyltaczyc.

2. Nacisnij klawisz spacji. Pole wyboru po lewej stronie nazwy nie jest zaznaczone.
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Usuwanie bibliotek lokalnych

Mozna usuna¢ bibliotekg bez usuwania jej wersji publicznej i odwrotnie. Usuwanie lokalnej biblioteki spowoduje
usunigcie biblioteki i calej jej zawartosci z sesji . Usunigcie lokalnej wersji biblioteki nie powoduje usunigcia tej
biblioteki z innych sesji, ani usunigcia wersji publicznej. Wigcej informacji zawiera temat|“Zarzadzanie bibliotekamil

publicznymi’’

Aby usuna¢ biblioteke lokalna

1. W widoku drzewa wybierz biblioteke, ktéra ma zosta¢ usunigta.
2. Z menu wybierz opcje Edit > Delete, aby usunac biblioteke. Biblioteka zostanie usunicta.

3. Jesli ta biblioteka nigdy nie byta opublikowana, pojawi si¢ komunikat z pytaniem, czy chcesz usunac, czy
zachowac te biblioteke. Kliknij przycisk Delete, aby kontynuowac¢, albo Keep, jesli chcesz zachowac tg biblioteke.

Uwaga: Musi pozosta¢ zawsze co najmniej jedna biblioteka.

Zarzadzanie bibliotekami publicznymi

W celu ponownego wykorzystania bibliotek lokalnych mozna je publikowac, a nastgpnie pracowac z nimi i je
wyswietli¢ za posrednictwem okna dialogowego Manage Libraries (Resources > Manage Libraries). Wigcej
informacji zawiera temat [“Wspotuzytkowanie bibliotek” na stronie 170] Do prostych operacji administracyjnych na
bibliotekach publicznych naleza: importowanie, eksportowanie lub usunigcie biblioteki publicznej. Nie mozna zmienié¢
nazwy biblioteki publiczne;j.

Importowanie bibliotek publicznych

1. W oknie dialogowym Manage Libraries kliknij przycisk Import.... Zostanie otwarte okno dialogowe Import
Library.

2. Wybierz plik biblioteki ( *./ib), ktéry ma zosta¢ zaimportowany, a jesli chcesz dodac te biblioteke takze lokalnie,
wybierz opcj¢ Add library to current project.

3. Kliknij przycisk Import. Okno dialogowe zostanie zamknigte. Jesli biblioteka publiczna o takiej nazwie juz
istnieje, pojawi si¢ prosba o zmiang nazwy biblioteki, ktora jest importowana, albo zgodg na nadpisanie biezacej
biblioteki publiczne;.

Eksportowanie bibliotek publicznych

Mozna eksportowac biblioteki publiczne w formacie ./ib, dzigki czemu mozna je wspotuzytkowac.
1. W oknie dialogowym Manage Libraries wybierz na liscie biblioteki, ktore chcesz wyeksportowac.
2. Kliknij przycisk Export. Zostanie otwarte okno dialogowe Select Directory.

3. Wybierz katalog, do ktorego chcesz wyeksportowac bibliotekg, i kliknij przycisk Export. Okno dialogowe zostanie
zamknigte, a plik biblioteki (*./ib) zostanie wyeksportowany.

Usuwanie bibliotek publicznych

Mozna usuna¢ biblioteke¢ lokalna bez usuwania wersji publicznej biblioteki i odwrotnie. Jesli jednak biblioteka zostanie
usuni¢ta w tym oknie dialogowym, nie mozna jej bedzie dodawaé zasobdw sesji, dopdki lokalna wersja nie zostanie
opublikowana ponownie.

Jesli usuniesz bibliotekg, ktora zostata zainstalowana z produktem, odtworzona zostanie pierwotnie zainstalowana

wersja.

1. W oknie dialogowym Manage Libraries wybierz biblioteke, ktora ma zosta¢ usunigta. List¢ mozna posortowac,
klikajac odpowiedni nagtowek.

2. Kliknij przycisk Delete, aby usuna¢ bibliotekg. IBM SPSS Modeler Text Analytics sprawdza, czy lokalna wersja
biblioteki jest taka sama, jak biblioteka publiczna. Jesli tak, biblioteka jest usuwana bez alertu. Jesli wersje
biblioteki réznia sig, zostanie otwarty alert z pytaniem, czy chcesz zachowac, czy usunac¢ wersje publiczna.
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Wspoétuzytkowanie bibliotek

Biblioteki umozliwiaja wykorzystanie tych samych zasobéw w rdznych sesjach pracy z interaktywnym pulpitem
roboczym . Biblioteki moga znajdowac si¢ w dwoch stanach Iub wersjach. Biblioteki edytowalne w edytorze i bedace
czegscia sesji pracy z interaktywnym pulpitem roboczym sa nazywane bibliotekami lokalnymi. Podczas pracy z
interaktywnym pulpitem roboczym mozesz na przyktad wprowadzi¢ liczne zmiany w bibliotece Vegetables. Jesli
uznasz, ze te zmiany beda przydatne rowniez do pracy z innymi danymi, mozesz udostgpni¢ zmienione zasoby, tworzac
publiczna wersje biblioteki Vegetables. Biblioteka publiczna, jak sama nazwa wskazuje, jest dostgpna dla wszelkich
innych zasobéw w dowolnych sesjach pracy z interaktywnym pulpitem roboczym.

Mozna wys$wietla¢ biblioteki publiczne w oknie dialogowym Manage Libraries. Jesli istnieje wersja publiczna
biblioteki, mozna ja doda¢ do zasobow w innych kontekstach, dzigki czemu niestandardowe zasoby lingwistycznych
moga by¢ wspotuzytkowane.

Biblioteki dostarczone z produktem sa od poczatku bibliotekami publicznymi. Mozliwe jest edytowanie zasobow w
tych bibliotekach, a nastgpnie utworzenie nowej wersji publicznej. Te nowe wersje beda dostepne w innych sesjach
pracy z interaktywnym pulpitem roboczym.

W miare kontynuowania pracy z bibliotekami i wprowadzania zmian wersje bibliotek beda tracity wzajemna
synchronizacje. W niektorych przypadkach wersja lokalna moze by¢ nowsza od wersji publicznej, a w innych
przypadkach wersja publiczna moze by¢ nowsza od wersji lokalnej. Zardwno wersja publiczna, jak i wersja lokalna
moze zawiera¢ zmiany, ktorych druga wersja nie zawiera. Taka sytuacja wystapi, jesli wersja publiczna zostanie
zaktualizowana z poziomu innej sesji pracy z interaktywnym pulpitem roboczym. Jesli wersje bibliotek
rozsynchronizuja sig, mozna zsynchronizowac je ponownie. Synchronizowanie wersji bibliotek polega na ponownym
opublikowaniu i/lub zaktualizowaniu bibliotek lokalnych.

Przy kazdym uruchomieniu lub zamknigciu interaktywnego pulpitu roboczego pojawi si¢ monit o zsynchronizowanie
wszystkich bibliotek, ktére wymagaja aktualizacji lub ponownej publikacji. Dodatkowo mozna tatwo ustali¢ stan
synchronizacji z biblioteki lokalnej za pomoca ikony znajdujacej si¢ obok nazwy biblioteki w widoku drzewa lub w
oknie dialogowym Library Properties. Mozesz rowniez zrobi¢ to w dowolnym momencie za pomoca opcji menu.
Ponizsza tabela zawiera opis pigciu mozliwych stanéw i powiazanych z nimi ikon.

Tabela 37. Stany synchronizaciji biblioteki lokalnej.

Ikona Opis statusu biblioteki lokalnej

E Nieopublikowana — biblioteka lokalna nie zostata nigdy opublikowana.

Zsynchronizowana — lokalna i publiczna wersja biblioteki sa identyczne. Dotyczy to rowniez biblioteki lokalnej,
ktérej nie mozna opublikowaé, poniewaz z zatozenia zawiera tylko zasoby charakterystyczne dla sesji.

Nieaktualna — wersja publiczna biblioteki jest nowsza od wersji lokalnej. Mozna zaktualizowac wersjg lokalng z
uwzglednieniem zmian.

Nowsza — wersja lokalna biblioteki jest nowsza niz wersja publiczna. Mozna ponownie opublikowa¢ lokalna
wersj¢ do wersji publiczne;.

B B R

Rozsynchronizowane — i biblioteka publiczna, i lokalna, zawiera zmiany, ktorych nie ma w drugiej bibliotece.
Musisz zdecydowac, czy zaktualizowac, czy opublikowac¢ biblioteke lokalna. W przypadku aktualizacji zostana
utracone wszystkie zmiany wprowadzone od czasu ostatniej aktualizacji lub publikacji. W przypadku publikowania
zmiany w wersji publicznej zostana nadpisane.

E

Uwaga: Jesli zawsze aktualizujesz biblioteki podczas uruchamiania interaktywnego pulpitu roboczego lub publikujesz
biblioteki przy zamykaniu pulpituotwierania lub publikujesz przy zamykaniu projektu, ryzyko rozsynchronizowania
bibliotek bedzie mniejsze.
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Mozesz w dowolnej chwili ponownie opublikowac biblioteke, gdy uznasz, ze wprowadzone zmiany bytyby korzystne
takze w innych zawierajacych ja strumieniach . Jesli zmiany bytyby korzystne w innych strumieniach, mozna nast¢pnie
zaktualizowac¢ lokalne wersje tych strumieni. W ten sposdb mozna tworzy¢ strumienie dla kazdego kontekstu lub
kazdej dziedziny zwiazanej z danymi, tworzac nowe biblioteki i/lub dodajac do zasobow dowolna liczbg bibliotek
publicznych.

Jesli publiczna wersja biblioteki jest wspotuzytkowana, istnieje wigksza szansa, ze pojawia si¢ roznice miedzy lokalna
a publiczna wersja. Za kazdym razem, gdy uruchamiasz lub zamykasz i publikujesz z sesji pracy z interaktywnym
pulpitem roboczym badz otwierasz lub zamykasz z poziomu formularza szablonu Template Editor , wyswietlany jest
komunikat umozliwiajacy opublikowanie i/lub zaktualizowanie bibliotek, ktérych wersje nie sa zsynchronizowane z
wersjami w oknie dialogowym Manage Libraries. Jesli publiczna wersja biblioteki jest nowsza niz wersja lokalna,
pojawi si¢ okno dialogowe z pytaniem, czy chcesz przeprowadzi¢ aktualizacje. Mozesz zachowac wersj¢ lokalna bez
zmian zamiast aktualizowac ja na podstawie wersji publicznej albo scali¢ aktualizacje do biblioteki lokalne;j.

Publikowanie bibliotek

Jesli okreslona biblioteka nie byta publikowana, to publikowanie polega na utworzeniu publicznej kopii biblioteki
lokalnej w bazie danych. W przypadku ponownego publikowania biblioteki zawartos¢ biblioteki lokalnej zastapi
istniejaca zawarto$¢ wersji publicznej. Po ponownej publikacji mozna zaktualizowa¢ tg biblioteke w dowolnych innych
sesjach strumienia, aby ich wersje lokalne byty zsynchronizowane z wersja publiczna Mimo ze mozliwe jest
opublikowanie biblioteki, wersja lokalna zawsze przechowywana jest w sesji .

Wazne! Jesli wprowadzisz zmiany w bibliotece lokalnej, a w migdzyczasie wersja publiczna biblioteki zostanie
réwniez zmieniona, biblioteka jest traktowana jako rozsynchronizowana. Zaleca sig¢ rozpoczgcie od zaktualizowania
wersji lokalnej z uwzglednieniem zmian publicznych, wprowadzenie zadanych zmian, a nastgpnie ponowne
opublikowanie wersji lokalnej, aby obie wersje byly identyczne. Jesli najpierw wprowadzisz zmiany i opublikujesz
biblioteke, spowoduje nadpisanie zmian wprowadzonych w wersji publiczne;j.

Aby opublikowac biblioteki lokalne w bazie danych

1. Z menu wybierz opcje Resources > Publish Libraries. Zostanie otwarte okno dialogowe Publish Libraries, a
wszystkie biblioteki wymagajace opublikowania bgda domyslnie wybrane.

2. Zaznacz pola wyboru po lewej stronie bibliotek, ktore chcesz opublikowac.
3. Kliknij przycisk Publish, aby opublikowa¢ biblioteki w bazie danych zarzadzania bibliotekami.

Aktualizowanie bibliotek

Gdy uruchamiasz lub zamykasz sesjg pracy z interaktywnym pulpitem roboczym, mozesz zaktualizowa¢ lub
opublikowa¢ biblioteki, ktore sa rozsynchronizowane z ich wersjami publicznymi. Jesli publiczna wersja biblioteki jest
nowsza niz wersja lokalna, pojawi si¢ okno dialogowe z pytaniem, czy chcesz przeprowadzi¢ aktualizacjg. Mozesz
zachowac¢ wersje lokalna bez zmian zamiast aktualizowac ja na podstawie wersji publicznej albo zastapi¢ wersje
lokalna wersja publiczna. Jesli publiczna wersja biblioteki jest nowsza od wersji lokalnej, mozesz zaktualizowaé wersje
lokalna, aby zsynchronizowac jej zawarto$¢ z zawartoscia wersji publicznej. Aktualizacja polega na uwzglednieniu w
wersji lokalnej wszelkich zmian znalezionych w wersji publiczne;.

Uwaga: Jesli zawsze aktualizujesz biblioteki podczas uruchamiania interaktywnego pulpitu roboczego lub publikujesz
biblioteki przy zamykaniu pulpitu otwierania lub publikujesz przy zamykaniu projektu, ryzyko rozsynchronizowania
bibliotek bedzie mniejsze. Wiecej informacji zawiera temat[“Wspotuzytkowanie bibliotek™ na stronie 170

Aby zaktualizowa¢ biblioteki lokalne

1. Z menu wybierz opcje Resources > Update Libraries. Zostanie otwarte okno dialogowe Update Libraries, a
wszystkie biblioteki wymagajace aktualizacji bgda domy$Inie wybrane.

2. Zaznacz pola wyboru po lewej stronie bibliotek, ktore chcesz opublikowac.
3. Kliknij przycisk Update, aby zaktualizowac¢ biblioteki lokalne.
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Rozstrzyganie konfliktow

Konflikty migdzy biblioteka lokalna a publiczna

Za kazdym razem, gdy uruchamiasz sesj¢ strumienia, IBM SPSS Modeler Text Analytics poréwnuje biblioteki lokalne

z wymienionymi w oknie dialogowym Manage Libraries. Jesli jakiekolwiek biblioteki lokalne w sesji nie sa

zsynchronizowane z wersjami opublikowanymi, otwierane jest okno dialogowe Library Synchronization Warning.

Mozna wybra¢ sposrdd nastepujacych opcji, aby zdecydowac, ktore wersje bibliotek maja by¢ uzywane:

* All libraries local to file. Ta opcja zachowuje wszystkie biblioteki lokalne bez zmian. Zawsze mozna ponownie
opublikowa¢ lub zaktualizowac¢ je poznie;j.

* All published libraries on this machine. Ta opcja spowoduje zastapienie widocznych bibliotek lokalnych wersjami
z bazy danych.

* All more recent libraries. Ta opcja spowoduje zastapienie starszych bibliotek lokalnych nowszymi wersjami
publicznymi z bazy danych.

* Inne. Ta opcja umozliwia rgczne wybranie wersji w tabeli.
Konflikty migdzy terminami objgtymi wymuszeniem

Gdy dodajesz biblioteke publiczna lub aktualizujesz biblioteke lokalna, moga zosta¢ wykryte terminy i typy kolidujace
z terminami i typami w innych bibliotekach nalezacych do zasobow albo bedace duplikatami. W takim przypadku
pojawi si¢ prosba o zweryfikowanie zgloszonych konfliktow lub wprowadzenie zmian przed dokonczeniem operacji w
oknie dialogowym Edit Forced Terms. Wigcej informacji zawiera temat [“Wymuszanie terminéw” na stronie 178

Okno dialogowe Edit Forced Terms zawiera wszystkie pary kolidujacych terminow lub typdéw. Aby utatwic
rozréznianie par, wyswietlane sa one na tle w naprzemiennych kolorach. Te kolory mozna zmienia¢ w oknie
dialogowym Options. Wiecej informacji zawiera temat|‘Okno dialogowe Options: karta Display” na stronie 75| Okno
dialogowe Edit Forced Terms zawiera dwie karty:

* Duplicates. Ta karta zawiera zduplikowane terminy znalezione w bibliotekach. Jesli za terminem wys$wietlana jest
ikona pinezki, oznacza to, ze to wystapienie terminu objgte jest wymuszeniem. Czarny znak X oznacza, ze to
wystapienie terminu zostanie pominigte podczas wyodrgbniania, poniewaz zostalo objgte wymuszeniem w innym
miejscu.

» User Defined. Ta karta zawiera listg terminow, ktore objgto recznym wymuszeniem na panelu stownika typu, a nie
w wyniku rozstrzygnigcia konfliktow.

Uwaga: Okno dialogowe Edit Forced Terms otwiera si¢ po zakonczeniu dodawania lub aktualizacji biblioteki.
Anulowanie tego okna dialogowego nie jest rOwnoznaczne z anulowaniem aktualizacji lub dodawania biblioteki.

Aby rozstrzygna¢ konflikty

1. W oknie dialogowym Edit Forced Terms wybierz przetacznik w kolumnie Use dla terminu, ktory chcesz objac
wymuszeniem.

2. Po zakonczeniu kliknij przycisk OK, aby zastosowa¢ wymuszenia termindw i zamkna¢ okno dialogowe. Kliknigcie
przycisku Cancel spowoduje anulowanie zmian wprowadzonych w tym oknie dialogowym.
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Rozdziat 16. Informacje o stownikach w bibliotekach

Zasoby uzywane do wyodrebniania danych tekstowych sa przechowywane w postaci szablonow i bibliotek. Biblioteka
moze sktadac sie z trzech stownikow.

* Slownik typu zawiera zbidr terminéw pogrupowanych pod jedna etykieta lub nazwa typu. Odczytujac dane
tekstowe, mechanizm wyodregbniania poréwnuje wyrazy napotkane w tekscie z terminami w stownikach typow. W
trakcie wyodrebniania terminy i synonimy w odmienionych formach sa grupowane pod jednym terminem
docelowym nazywanym pojgciem. Wyodregbnione pojgcia sa przypisywane do stownika typu, w ktérym figuruja
jako terminy. Stownikami typow mozna zarzadza¢ w lewym gdérnym i srodkowym panelu edytora — w panelu
drzewa bibliotek i panelu terminéw. Wigcej informacji zawiera temat [“Stowniki typow’]

* Slownik zastapien zawiera zbidr wyrazow zdefiniowanych jako synonimy lub elementy opcjonalne stuzacych do
grupowania podobnych terminow pod jednym terminem docelowym, nazywanym pojgciem. Stownikami zastapien
mozna zarzadza¢ w lewym dolnym panelu edytora na karcie Synonyms i na karcie Optional. Wigcej informacji
zawiera temat[“Stowniki zastapien/synonimow” na stronie 180]

* Slownik wykluczen zawiera zbior terminow i typdw, ktore beda usuwane z ostatecznych wynikow wyodrebniania.
Stownikami wykluczen mozna zarzadza¢ w prawym panelu edytora. Wiecej informacji zawiera temat
[wykluczen” na stronie 183]

Wigcej informacji zawiera temat [Rozdziat 15, “Praca z bibliotekami”, na stronie 165}

Stowniki typow

Stownik typu sktada si¢ z nazwy lub etykiety typu oraz listy termindéw. Stownikami typoéw zarzadza si¢ w lewym
goérnym i srodkowym panelu karty Library Resources w edytorze. Dostgp do tego widoku mozna uzyskac, wybierajac
opcje View > Resource Editor w menu, jesli jest aktywna sesja interaktywnego pulpitu roboczego. Jesli nie jest,
mozna edytowa¢ stowniki konkretnego szablonu w oknie Template Editor.

Odczytujac dane tekstowe, mechanizm wyodrgbniania poréwnuje wyrazy napotkane w tekscie z terminami w
stownikach typow. Terminy sa to wyrazy lub frazy figurujace w stownikach typow w zasobach lingwistycznych.

Gdy wyraz pasuje do terminu, jest przypisywany do nazwy typu wlasciwej dla tego terminu. W miarg odczytywania
zasobow w trakcie wyodrebniania terminy, ktore zostaty znalezione w tekscie, przechodza przez kilka krokow
przetwarzania, zanim stang si¢ pojgciami w panelu Extraction Results. Jesli mechanizm wyodrgbniania uzna kilka
termindw nalezacych do tego samego stownika typu za synonimy, to zostana one zgrupowane pod najcze¢sciej
wystepujacym terminem, ktdry nazywamy pojeciem. Na przyklad terminy question i query moglyby ostatecznie
pojawic si¢ w wynikach jako pojgcie question.
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Library Resources Advanced Resources | Text Link Rules

E| D Produd Satizfaction Opinions (English) il Resources

Local Library §

Product Satistaction Library (English) i [ # | M) ] '”if_"?id ] Tipe L =
%, after taste Ertire Term ]  Characteristics Product Satistaction Library (English)
§_ after-taste Ertire And Ay [ Characteristics Product Satistaction Library (English)
§_ aftertaste Ertire Term [ Characteristics Product Satistaction Library (English)
'%_ ae Ertire And Ay [ Characteristics Product Satistaction Library (English)
*§ appearance Erttire: &nd &ny [ Characteristics Product Satisfaction Library (English)
§_ appearence Ertire And Ay .? Characteristics Product Satistaction Library (English)
'%_ aroma Ertire And Ay i) Characteristics Product Satizfaction Library (English)

SZLFJ Registration(50) :§ aﬂripme Ent?re And Any ._ | Charader?sﬁcs Product Saﬁsfacﬁon L?brary (Engl?sh)
i : . N audio Ertire And Ay i) Characteristics Product Satizfaction Library (English)

Oplnlons.lerary (Engllsh) % behaviour Ertire And Ay [ Characteristics Product Satizfaction Library (English)

Budget. Library (En.gllsh) % Can Carry Ertire Term Characteristics Product Satizfaction Library (English)

Con.a L.|braryr (English) . % can store Ertire Term Characteristics Product Satizfaction Library (English)

Varistians torary (Enaish) "s capacity Ertire And Ay Characteristics Product Satistaction Library (Endglish)
%_ characteristic Ertire And Ay i) Characteristics Product Satizfaction Library (English)
%_ charatceristic Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)
%_ color Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)
%_ colaring Ertire And Ay i) Characteristics Product Satizfaction Library (English)
%_ colour Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)
%_ colouring Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)
%_ comfort Ertire And Ay i) Characteristics Product Satizfaction Library (English)
%_ component Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)
%_ confort Ertire And Ay ._ | Characteristics Product Satizfaction Library (English)

E] [¥] g consistence Erttire: &nd &ny [ Characteristics Product Satisfaction Library (English) =]

Rysunek 39. Panele drzewa bibliotek i termindw

Lista stownikow typow jest wyswietlana w panelu drzewa bibliotek po lewej stronie. Zawarto$¢ kazdego typu stownika
jest wyswietlana w panelu srodkowym. Stowniki typu sa czyms$ wigcej niz tylko listami termindw. Sposéb
dopasowywania wyrazow i fraz w danych tekstowych do terminow zdefiniowanych w stownikach typow zalezy od
wybranej opcji dopasowywania. Opcja dopasowywania okresla, w jaki sposob termin zostanie zakotwiczony
wzgledem kandydackiego (potencjalnego) wyrazu lub frazy w danych tekstowych. Wigcej informacji zawiera temat
[‘Dodawanie terminéw” na stronie 176}

Dodatkowo mozna uzupetnia¢ terminy w stowniku typu, okreslajac, czy maja by¢ automatycznie generowane i

dodawane ich odmienione formy. Generujac formy odmienione, mozna automatycznie doda¢ formy liczby mnogiej do
termindw w liczbie pojedynczej, formy w liczbie pojedynczej do terminow liczby mnogiej, a takze dodaé przymiotniki
do stownika typu. Wiecej informacji zawiera temat[‘Dodawanie terminéw” na stronie 176,

Uwaga: W wigkszosci jezykdw pojecia nieznalezione w zadnym stowniku typu, ale wyodrebnione z tekstu otrzymuja
automatycznie przypisywany typ <Unknown>

Uzywanie znaku gwiazdki w terminach

Uzywanie znaku gwiazdki (*) w terminach jest szczegdlnie przydatne podczas pracy z jgzykiem aglutynacyjnym, w
ktorym nowe wyrazy powstaja poprzez potaczenie innych wyrazow bez wstawiania spacji. Na przykiad w jezyku
niemieckim wyraz Ubernachtungspreis sktada sig z nastepujacych elementéw: Ubernachtung + s + Preis.

Przyktadowo, podczas wyszukiwania w terminach wyrazu preis* w typie Budget zostanie ono dopasowane do
wyodrebnionych poje¢, takich jak preiserhéhung. W ten sam sposob wyraz *preis zostanie dopasowany do wyrazu
Ubernachtung, a *preis* do Ubernachtungspreiserhéhung.

Typy wbudowane

IBM SPSS Modeler Text Analytics jest dostarczany z zestawem zasobow lingwistycznych w formie bibliotek i
skompilowanych zasobow. Dostarczone biblioteki zawieraja zestaw wbudowanych stownikow typow, takich jak
<Location>, <Organization>, <Person> i <Product>.

Mechanizm wyodrebniania uzywa tych stownikdéw typow do przypisywania typow do pojec, np. typu <Location> do

pojecia paris. Mimo ze w gotowych stownikach typow zdefiniowano duza liczbeg termindw, nie uwzgledniaja one
wszystkich mozliwosci. W zwiazku z tym stowniki mozna uzupehiac lub tworzy¢ wtasne stowniki. Aby zapoznac sig z
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opisem zawartosci okreslonego stownika typu dostarczonego z produktem, przeczytaj adnotacje w oknie dialogowym
Type Properties. Wybierz typ w drzewie i wybierz opcje Edit > Properties z menu kontekstowego.

Uwaga:

Oprdcz bibliotek dostarczonych z produktem réwniez zasoby skompilowane (z ktorych rowniez korzysta mechanizm
wyodregbniania) zawieraja duza liczbg definicji komplementarnych wobec wbudowanych stownikéw. Jednak zawartosé¢
tych zasobow nie jest widoczna w produkcie. Mozna jednak wymusi¢ wpisanie terminu o typie okre§lonym w zasobach
skompilowanych do dowolnego innego stownika. Wiecej informacji mozna znalez¢ w [*Wymuszanie termindw” nal
_ronie 178

Tworzenie typéw

Mozna tworzy¢ stowniki typow, ktore pomagaja w grupowaniu podobnych terminéw. Gdy podczas wyodrgbniania
zostanie napotkany termin wystgpujacy w tym stowniku, zostanie przypisany do typu i wyodrgbniony pod nazwa
pojecia. Gdy tworzysz biblioteke, tworzony jest w niej od razu pusty stownik typu, do ktorego od razu mozna zacza¢
wprowadzac terminy.

Jesli analizujesz tekst o zywnosci i cheesz pogrupowac terminy zwiazane z warzywami, mozesz utworzy¢ wlasny
stownik typu <Vegetables>. Mozesz do niego doda¢ wyrazy carrot, broccoli i spinach, jesli uwazasz, ze sa to wazne
terminy, ktore wystapia w tekscie. Jesli podczas wyodrebniania zostanie napotkany ktorykolwiek z tych termindw, to
zostanie wyodrebniony jako pojecie i przypisany do typu <Vegetables>.

Nie musisz definiowa¢ kazdej formy wyrazu lub wyrazenia, poniewaz istnieje mozliwo$¢ automatycznego
generowania form odmienionych terminow. Wybranie tej opcji spowoduje, ze mechanizm wyodrgbniania
automatycznie bedzie rozpoznawal formy pojedyncze i mnogie oraz inne formy nalezace do tego typu. Ta opcja jest
szczegolnie przydatna, gdy typ zawiera gtownie rzeczowniki, poniewaz mato prawdopodobne jest, by odmienione
formy czasownikow lub przymiotnikéw byly interesujace dla analityka.

Okno dialogowe Type Properties zawiera nastgpujace pola.

Nazwa. Nazwa nadawana tworzonemu stownikowi typu. Zaleca sig, aby nie uzywac spacji w nazwach typow,
zwlaszcza jesli co najmniej dwie nazwy typu rozpoczynaja si¢ od tego samego wyrazu.

Uwaga: Istnieja ograniczenia dotyczace nazw typdw i uzycia symboli. Na przyktad nie nalezy uzywac symboli, takich
jak "@" lub "!" w nazwach.

Default match. Domyslny domys$lnego dopasowania instruuje mechanizm wyodrebniania co do sposobu
dopasowywania tego terminu do danych tekstowych. Kazdorazowo po dodaniu terminu do tego stownika typu jest to
atrybut dopasowania automatycznie przypisywany do tego terminu. Zawsze mozna zmieni¢ sposob dopasowania
recznie na liscie terminow. Dostepne sa opcje: Entire Term, Start, End, Any, Start or End, Entire and Start, Entire
and End, Entire and (Start or End) i Entire (no compounds). Wigcej informacji mozna znalez¢ w temacie
[‘Dodawanie terminéw” na stronie 176}

Add to. To pole wskazuje biblioteke, w ktorej zostanie utworzony nowy stownik typow.

Generate inflected forms by default. Ta opcja nakazuje mechanizmowi wyodrgbniania wykorzystanie analizy
morfologii gramatycznej do wychwytywania i grupowania podobnych form termindw, ktore zostaty dodane do tego
stownika, np. form pojedynczych i mnogich. Ta opcja jest szczegdlnie uzyteczna, gdy typ zawiera przede wszystkim
rzeczowniki. Po wybraniu tej opcji wszystkie nowe terminy dodawane do tego typu beda automatycznie miaty
wlaczona tg opcje, ale mozna ja zmieni¢ r¢cznie na liscie.

Font color. To pole umozliwia odréznienie wynikdw konkretnego typu od innych w interfejsie. Wybranie opcji Use
parent color spowoduje, ze dla tego stownika typdéw bedzie uzywany domyslny kolor typu. Ten kolor domyslny jest
ustawiony w oknie dialogowym opcji. Wiecej informacji zawiera temat[“Okno dialogowe Options: karta Display” nal
Jesli wybrano opcje Custom, wybierz kolor z listy rozwijane;.
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Annotation. To pole jest opcjonalne i moze by¢ uzywane w przypadku dowolnych komentarzy i opisow.

Aby utworzy¢ stownik typu

1. Wybierz biblioteke, w ktorej cheesz utworzy¢ nowy stownik typu.

2. Z menu wybierz opcje Tools > New Type. Zostanie otwarte okno dialogowe Type Properties.
3. Wprowadz nazwe typu stownika w polu tekstowym Name i wybierz zadane opcje.
4

Kliknij przycisk OK, aby utworzy¢ stownik typu. Nowy typ pojawi si¢ w panelu drzewa bibliotek i w panelu
s’rodkowim. Mozna od razu rozpocza¢ dodawanie termindw. Aby uzyska¢ wigcej informacji, patrz

ermindow’’

Uwaga: Ta instrukcja dotyczy wprowadzania zmian w widoku Resource Editor lub oknie Template Editor. Nalezy
pamigtac, ze optymalizacje¢ mozna tez prowadzi¢ bezposrednio z panelu Extraction Results, panelu Data, panelu
Categories lub okna dialogowego Cluster Definitions w innych widokach. Wigcej informacji mozna znalez¢ w temacie
[‘Optymalizacja wynikow wyodrebniania” na stronie 86}

Dodawanie terminow

Panel drzewa biblioteki przedstawia biblioteki i mozna go rozwinac, aby wyswietli¢ stowniki typow zawarte w tych
bibliotekach. W $rodkowym panelu znajduje si¢ lista terminow zawartych w wybranej bibliotece lub stowniku typu, w
zaleznosci od wyboru dokonanego w drzewie.

W edytorze Resource Editor mozna dodawac¢ terminy do stownika typow bezposrednio w panelu terminu lub za
pomoca okna dialogowego Add New Terms. Dodawane terminy moga by¢ pojedynczymi wyrazami lub terminami
ztozonymi. Na poczatku listy zawsze dostgpny jest pusty wiersz, w ktorym mozna doda¢ nowy termin.

Uwaga: Ta instrukcja dotyczy wprowadzania zmian w widoku Resource Editor lub oknie Template Editor. Nalezy
pamigtac, ze optymalizacj¢ mozna tez prowadzi¢ bezposrednio z panelu Extraction Results, panelu Data, panelu
Categories lub okna dialogowego Cluster Definitions w innych widokach. Wigcej informacji mozna znalez¢ w temacie
[‘Optymalizacja wynikow wyodrebniania” na stronie 86|

Kolumna Term

W tej kolumnie nalezy wprowadzi¢ pojedynczy wyraz lub termin ztozony. Kolor terminu zalezy od koloru typu, do
ktérego termin jest przypisany (automatycznie lub przez wymuszenie). Mozna zmieni¢ kolory typdw w oknie
dialogowym Type Properties. Wigcej informacji mozna znalezé w temacie [“Tworzenie typow” na stronie 175|

Kolumna Force

Kliknigcie i umieszczenie ikony pinezki w tej komorce informuje mechanizm wyodrgbniania, ze ma zignorowaé
wszelkie pozostate wystapienia tego samego terminu w innych bibliotekach. Wigcej informacji mozna znalez¢ w
temacie [“Wymuszanie terminéw” na stronie 178

Kolumna Match

W tej kolumnie wybierz opcje dopasowywania, aby poinstruowa¢ mechanizm wyodrgbniania co do sposobu
dopasowywania tego terminu do danych tekstowych. Przyktady zamieszczono w tabeli. Wartos¢ domys$lna mozna
zmieni¢, edytujac whasciwosci typu. Wiecej informacji zawiera temat[“Tworzenie typéw” na stronie 175} Z menu
wybierz opcje Edit > Change Match. Ponizej znajduja si¢ podstawowe opcje dopasowania; mozliwe sa takze ich
kombinacje:

» Start. Jesli termin w stowniku pasuje do pierwszego wyrazu w pojeciu wyodrebnionym z tekstu, zostanie mu
przypisany ten typ. Na przyklad, jesli wprowadzisz apple, to znalezione zostanie wyrazenie apple tart.

* End. Jesli termin w stlowniku pasuje do ostatniego wyrazu w pojeciu wyodregbnionym z tekstu, zostanie mu
przypisany ten typ. Na przyktad, jesli wprowadzisz apple, to znalezione zostanie wyrazenie cider apple.
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* Any. Jesli termin w stowniku pasuje do dowolnego wyrazu w pojeciu wyodrebnionym z tekstu, zostanie mu
przypisany ten typ. Na przyktad, jesli wprowadzisz apple, to opcja Any spowoduje przypisanie tego samego typu
pojeciom apple tart, cider apple i cider apple tart.

* Entire Term. Jesli cale pojecie wyodregbnione z tekstu doktadnie pasuje do terminu ze stownika, to zostanie mu
przypisany ten typ. Dodanie terminu z opcja Entire term, Entire and Start, Entire and End, Entire and Any lub
Entire (no compounds) wymusza wyodrebnienie terminu.

Ponadto, poniewaz typ <Person> wyodrgbnia tylko imiona/nazwiska dwuczgsciowe (np. edith piaf lub mohandas
gandhi), celowe bywa jawne dodanie imion do tego stownika typu, jesli chcesz, by wyodrebniane byly imiona
figurujace w tekscie bez nazwisk. Na przyktad, jesli chcesz wychwyci¢ wszystkie wystapienia edith jako imiona
osoby, dodaj edith do typu <Person> z opcja Entire term lub Entire and Start.

* Entire (no compounds). Jesli cale pojecie wyodrebnione z tekstu doktadnie pasuje do terminu ze stownika, to
zostanie mu przypisany ten typ, a wyodrebnianie zostanie zatrzymane, aby termin nie zostat dopasowany do
dtuzszego zlozenia. Na przyklad, jesli wprowadzisz apple, opcja Entire (no compound) spowoduje przypisanie do
typu terminu apple, ale nie spowoduje wyodrebnienia ztozenia apple sauce, chyba ze jest wymuszone gdzie
indziej.

Analizujac ponizsza tabelg, zatozmy ze termin apple figuruje w stowniku typu. W tabeli przedstawiono, ktére pojgcia
bylyby wyodrebnione i opatrzone typem, gdyby zostaly znalezione w tekScie przy obowiazywaniu réznych opcji
dopasowywania.

Tabela 38. Przykiady dopasowywania

Opcje dopasowywania dla Wyodrebnione
terminu: pojecia
El
apple
apple apple rart ripe apple homemade
pp pPp ipe app apple tart
v
Entire Term
v
Start
v
End
v v
Start or End
v v
Entire and Start
v v
Entire and End
v v v
Entire and (Start or End)
v v v
Any
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Tabela 38. Przyktady dopasowywania (kontynuacja)

Opcje dopasowywania dla Wyodrebnione
terminu: pojecia
E‘
apple
apple apple rart ripe apple homemade
pPp pPp pe app apple art
v v v v
Entire and Any
v nigdy nie nigdy nie nigdy nie
Entire (no compounds) wyodrebnione wyodrebnione wyodrebnione

Kolumna Inflect

W tej kolumnie wybierz, czy mechanizm wyodrebniania powinien generowa¢ odmienione formy terminu podczas
wyodrebniania, tak aby byly grupowane ze soba. Domys$lna warto$¢ dla tej kolumny jest zdefiniowana we
wiasciwosciach typu (okno Type Properties), ale mozna ja zmienia¢ dla indywidualnych przypadkow w tej kolumnie. Z
menu wybierz opcje Edit > Change Inflection.

Kolumna Type

W tej kolumnie nalezy wybra¢ stownik typu z listy rozwijanej. Lista typdw jest filtrowana na podstawie wyboru
dokonanego w panelu drzewa bibliotek. Pierwszy typ w liScie to zawsze domyslny typ wybrany w oknie drzewa
bibliotek. Z menu wybierz opcje Edit > Change Type.

Kolumna Library

W tej kolumnie podana jest nazwa biblioteki, w ktorej zapisany jest termin. Mozesz przeciagnac i upusci¢ termin do
innego typu w panelu drzewa bibliotek, aby przenies¢ go do innej biblioteki.

Aby doda¢ jeden termin do biblioteki typu
1. W panelu drzewa bibliotek wybierz stownik typu, do ktérego ma zosta¢ dodany termin.

2. Na liscie termindw w panelu srodkowym wpisz termin w pierwszej dostgpnej pustej komorce i ustaw opcje dla tego
terminu.

Aby dodac¢ wiecej niz jeden termin do biblioteki typu
1. W panelu drzewa bibliotek wybierz stownik typu, do ktorego cheesz dodac terminy.
2. Z menu wybierz opcje Tools > New Terms. Zostanie otwarte okno dialogowe Add New Terms.

3. Wprowadz terminy, ktére chcesz doda¢ do wybranego stownika typu, wpisujac terminy lub wklejajac zestaw
terminow. Aby wprowadzi¢ wiele termindw, nalezy oddzieli¢ je za pomoca ogranicznika, ktory jest zdefiniowany
w oknie dialogowym Options, lub doda¢ kazdy termin w osobnym wierszu. Wigcej informacji zawiera temat
[Okreslanie opcji” na stronie 74

4. Kliknij przycisk OK, aby doda¢ terminy do stownika. Dla tej biblioteki typu automatycznie wybrana zostata
domyslna opcja dopasowywania. Okno dialogowe zostanie zamknigte, a nowe terminy pojawia si¢ w stowniku.

Wymuszanie terminéw

Jesli cheesz, aby termin byt przypisywany do konkretnego typu, mozesz doda¢ go do odpowiedniego stownika typu.
Jesli jednak istnieje wiele termindw tej samej nazwie, mechanizm wyodregbniania musi wiedzie¢, ktory typ ma by¢
uzywany. Oznacza to, ze pojawi si¢ prosba o wybranie, ktdry typ ma by¢ uzywany. Funkcja ta jest nazywana
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wymuszaniem typu terminu. Ta opcja jest najbardziej uzyteczna, gdy chcesz przestonic przypisanie typu przyjete w
skompilowanym stowniku (wewngtrznym i nieedytowalnym). Ogdlnie rzecz biorac, zaleca si¢ unikanie
zduplikowanych termindw.

Wymuszenie nie spowoduje usuniecia pozostatych wystapien terminu, zostang one jedynie zignorowane przez
mechanizm wyodrgbniania. Mozna pdzniej zmieni¢ wybdr wystapienia, ktdre powinno by¢ uzywane, przez
wymuszenie lub anulowanie wymuszenia terminu. Moze by¢ tez konieczne wymuszenie przypisania terminu do
stownika typu podczas dodawania biblioteki publicznej lub aktualizacji biblioteki publiczne;.

Mozna sprawdzi¢, ktore terminy sa objgte wymuszeniem lub ignorowane, w kolumnie Force (druga kolumna w panelu
terminu). Jesli wyswietlana jest ikona pinezki, oznacza to, ze to wystapienie terminu objgte jest wymuszeniem. Czarny
znak X oznacza, ze to wystapienie terminu zostanie pominigte podczas wyodregbniania, poniewaz zostalo objgte
wymuszeniem w innym miejscu. Dodatkowo, w przypadku wymuszenia typu terminu, termin zostanie wyswietlony w
kolorze wymuszonego typu. Oznacza to, ze jesli dla terminu nalezacego zaréwno do typu Typ 1, jak i Typ 2,
wymuszono Typ 1, to wszystkie wystapienia tego terminu w oknie bgda wyswietlane w kolorze wlasciwym dla typu

Typ 1.

Mozna dwukrotnie klikna¢ ikong w celu zmiany statusu. Jesli termin wystgpuje w innym miejscu, zostanie otwarte
okno dialogowe Resolve Conflict i nalezy zdecydowac, ktore wystapienie ma by¢ uzywane.

Zmiana nazw typow

Mozna zmieni¢ nazwe stownika typu lub zmieni¢ inne ustawienia stownika, edytujac wlasciwosci typu.

Wazne: Zaleca sig, aby nie uzywac spacji w nazwach typow, zwlaszcza jesli co najmniej dwie nazwy typu
rozpoczynaja si¢ od tego samego wyrazu. Zalecamy rowniez, aby nie zmienia¢ nazw typow w bibliotekach Core lub
Opinions, ani nie zmienia¢ ich domyslnych atrybutéw dopasowania.

Aby zmienié nazwe typu
1. W panelu drzewa bibliotek wybierz stownik typu, ktorego nazwe chcesz zmienicé.

2. Kliknij prawym przyciskiem myszy i wybierz opcje Type Properties z menu kontekstowego. Zostanie otwarte
okno dialogowe Type Properties.

3. Wprowadz nowa nazwe stownika typu w polu tekstowym Name.

4. Kliknij przycisk OK, aby zaakceptowac¢ nowa nazwe. Nowa nazwa typu bedzie widoczna w panelu drzewa
bibliotek.

Przenoszenie typow

Mozna przeciagna¢ stownik typu do innej lokalizacji w bibliotece lub do innej biblioteki w drzewie.

Aby zmieni¢ potozenie typu w obrebie biblioteki
1. W panelu drzewa bibliotek wybierz stownik typu, ktéry chcesz przeniesé.

2. Z menu wybierz opcje Edit > Move Up, aby przenie$¢ stownik typu o jedna pozycjg w gorg w panelu drzewa
bibliotek, albo opcj¢ Edit > Move Down, aby przenies¢ atrybut w dot o jedna pozycje.

Aby przeniesé typ do innej biblioteki
1. W panelu drzewa bibliotek wybierz stownik typu, ktéry chcesz przeniesé.

2. Kliknij prawym przyciskiem myszy i wybierz opcje Type Properties z menu kontekstowego. Zostanie otwarte
okno dialogowe Type Properties. (Mozna rowniez przeciagnac i upusci¢ typ do innej biblioteki).

3. W polu listy Add To wybierz biblioteke, do ktorej checesz przenies¢ stownik typu.

4. Kliknij przycisk OK. Okno dialogowe zostanie zamknigte, a typ bedzie teraz w bibliotece, ktora zostata wybrana.
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Wytaczanie i usuwanie typow
Aby tymczasowo usunac stownik typu, mozna go wylaczy¢, usuwajac zaznaczenie pola wyboru wyboru z lewej strony

nazwy stownika w panelu drzewa bibliotek. Sygnalizuje to, ze chcesz zachowac stownik w bibliotece, ale jego
zawarto$¢ ma by¢ ignorowania podczas wykrywania konfliktow i podczas wyodrebniania.

Mozna réwniez trwale usuna¢ stownik typu z biblioteki.

Aby wylaczyé stownik typu
1. W panelu drzewa bibliotek wybierz stownik typu, ktory chcesz wytaczy¢.
2. Nacisnij klawisz spacji. Pole wyboru po lewej stronie nazwy typu nie jest teraz zaznaczone.

Aby usuna¢ stownik typu
1. W panelu drzewa bibliotek wybierz stownik typu, ktory chcesz usunac.

2. Z menu wybierz opcje Edit > Delete, aby usuna¢ stownik typu.

Stowniki zastgpiern/synonimow

Stownik zastgpien to zbidr termindw, ktory pomaga w grupowaniu podobnych termindw pod jednym terminem
docelowym. Stownikami zastapien zarzadza si¢ w dolnym panelu karty Library Resources. Dostep do tego widoku
mozna uzyskac, wybierajac opcje View > Resource Editor w menu, jesli jest aktywna sesja interaktywnego pulpitu
roboczego. Jesli nie jest, mozna edytowa¢ stowniki konkretnego szablonu w oknie Template Editor.

Mozna w tym stowniku zdefiniowa¢ dwa rodzaje zastapien: synonimy i elementy opcjonalne. Mozna klika¢ karty w
tym panelu, aby przelaczac si¢ migdzy nimi.

Po przeprowadzeniu wyodrgbniania moze si¢ okazacé, ze kilka poje¢ wynikowych to w istocie synonimy lub
odmienione formy innych poje¢. Poprzez identyfikacje elementéw opcjonalnych i synonimoéw mozna zmusié¢
mechanizm wyodrebniania, aby odwzorowat je na jeden termin docelowy.

Zastgpowanie przy uzyciu synonimow i elementdw opcjonalnych zmniejsza liczbg poje¢ w panelu Extraction Results,
poniewaz taczy je w bardziej istotne, reprezentatywne pojgcia o wyzszej liczbie wystapien .

Synonimy

Synonimy kojarza dwa lub wigksza liczbe wyrazéw o tym samym znaczeniu. Mozna réwniez uzy¢ synonimow do
grupowania terminéw z ich skrétami lub do grupowania najczesciej wystepujacych blednie zapisanych form terminu z
jego poprawna forma. Synonimy mozna definiowa¢ na karcie Synonyms.

Definicja synonimu jest ztozona z dwdch czegsci. Pierwszy termin to termin docelowy (Target). To pod nim maja by¢
grupowane wszystkie synonimy. Jesli ten termin docelowy nie jest uzywany jako synonim innego terminu docelowego
lub wykluczony, to prawdopodobnie stanie si¢ pojgciem i pojawi sig¢ na panelu Extraction Results. Na drugim miejscu
znajduje sig lista synonimow, ktore zostana zgrupowane pod terminem docelowym.

Na przyktad, jesli chcesz, aby wartos¢ automobile byta zastepowana przez wartos¢ vehicle, to wartos¢ automobile
jest synonimem, a vehicle jest terminem docelowym.

Mozna wprowadzi¢ dowolne stowa w kolumnie Synonim, ale jesli wyraz nie zostanie znaleziony podczas
wyodrebniania i termin miat opcj¢ dopasowania Entire, to zastapienie nie bedzie mozliwe. Jednak termin docelowy nie
musi by¢ koniecznie wyodrgbniony, aby synonimy zostaty zgrupowane pod tym terminem.

Elementy opcjonalne

Elementy opcjonalne to wyrazy opcjonalne w terminie ztozonym, ktére moga by¢ ignorowane podczas wyodrgbniania,
tak aby podobne terminy byty traktowane jako rownowazne, nawet jesli maja nieznacznie rézne postacie w tekscie.
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Elementy opcjonalne sa pojedynczymi wyrazami, ktdrych usunigcie z terminu ztozonego moze doprowadzi¢ do
dopasowania z innym terminem. Te pojedyncze wyrazy moga znajdowac si¢ w dowolnym miejscu w obrgbie terminu
ztozonego na poczatku, w srodku lub na koncu. Opcjonalne elementy mozna definiowa¢ na karcie Optional.

Na przyktad, aby zgrupowac terminy ibm i ibm corp, nalezy zadeklarowa¢ corp jako element opcjonalny. Inny
przyktad: jesli okreslisz termin access jako element opcjonalny, a podczas wyodrgbniania zostana znalezione terminy
internet access speed i internet speed, to zostana zgrupowane pod tym z dwdch termindéw, ktéry wystepuje
czegsciej.

Definiowanie synoniméw

Na karcie Synonyms mozna wprowadzi¢ definicjg synonimow w pustym wierszu w gornej czesci tabeli. Rozpocznij od
definiowania terminu docelowego i jego synoniméw. Mozna rowniez wybrac biblioteke, w ktdrej chcesz zapisac tg
definicj¢. Podczas wyodrgbniania wszystkie wystapienia synonimow zostana pogrupowane pod terminem docelowym
w ostatecznym wyodrebnieniu. Wiecej informacji zawiera temat [‘Dodawanie termindw” na stronie 176}

Na przyktad, jesli dane tekstowe zawieraja duzo informacji o tematyce telekomunikacyjnej, moga w nich wystapi¢
terminy: cellular phone, wireless phone i mobile phone. W omawianym przyktadzie celowe moze by¢
zdefiniowanie termindw cellular i mobile jako synoniméw wireless. Jesli zdefiniujesz te synonimy, to kazde
wyodrebnione wystapienie cellular phone i mobile phone bedzie traktowane jako ten sam termin, co wireless
phone, i terminy te beda wystepowaty tacznie na liscie.

Tworzac biblioteke typu, mozesz wprowadzi¢ termin, a potem zastanowic si¢ nad trzema lub czterema synonimami
tego terminu. Wszystkie te terminy synonimiczne i termin docelowy wprowadz nastgpnie do stownika zastapien, po
czym przeciagnij synonimy.

Zastgpowanie synonimow dziata takze w odniesieniu do form odmienionych (np. liczby mnogiej) synoniméw. W
zaleznos$ci od kontekstu celowe moze by¢ wprowadzenie ograniczen w zastgpowaniu termindw. Niektdre znaki
umozliwiaja ograniczenie zasiggu przetwarzania synonimow:

* Wykrzyknik (!). Gdy wykrzyknik bezposrednio poprzedza synonim (lsynonim), to zakazuje zastgpowania
odmienionych form synonimu terminem docelowym. Jednak wykrzyknik bezposrednio poprzedzajacy termin
docelowy ltermin docelowy oznacza, ze zadna czg$¢ ztozonego terminu docelowego ani zaden jego wariant nie
powinny by¢ zastgpowane.

* Gwiazdka (*). Gwiazdka umieszczona bezposrednio za synonimem (Synonim*) oznacza, ze ten wyraz ma by¢
zastepowany przez termin docelowy. Na przyklad, jesli zdefiniowano manage™ jako synonim, a management jako
termin docelowy, to associate managers zostanie zastapione terminem docelowym associate management.
Mozna takze doda¢ spacje i gwiazdke za wyrazem (Synonim *), na przyktad internet *. Jesli zdefiniowano termin
docelowy jako internet, a synonimy jako internet * * i web *, to internet access card i web portal zostana
zastapione terminem internet. W tym stowniku wyraz ani fancuch nie moze zaczynac¢ si¢ od wieloznacznej
gwiazdki.

* Daszek (7). Daszek i spacja poprzedzajace synonim (* Synonim) oznaczaja, ze grupowanie synoniméw ma by¢
stosowane tylko wtedy, gdy termin rozpoczyna si¢ od synonimu. Na przyktad, jesli zdefiniowano * wage jako
synonim, a income jako termin docelowy i oba te terminy zostana wyodrebnione, to zostana zgrupowane pod
terminem income. Jesli jednak wyodrgbnione zostana terminy minimum wage i income, to nie zostana
zgrupowane, poniewaz minimum wage nie zaczyna si¢ od wage. Migdzy tym symbolem a synonimem musi
znajdowac si¢ spacja.

* Znak dolara ($). Spacja i znak dolara nastepujace po synonimie (Synonim $) oznaczaja, ze grupowanie synonimow
ma by¢ stosowane tylko wtedy, gdy termin konczy si¢ synonimem. Na przyklad, jesli zdefiniowano cash $ jako
synonim, a money jako termin docelowy i oba te terminy zostana wyodrgbnione, to zostana zgrupowane pod
terminem money. Jesli jednak wyodrebnione zostana terminy cash cow i money, to nie zostana zgrupowane,
poniewaz cash cow nie konczy si¢ wyrazem cash. Migdzy tym symbolem a synonimem musi znajdowac sig¢
spacja.

* Daszek (M) i znak dolara (8). Jesli daszek i znak dolara zostana uzyte tacznie, (* synonim $), to termin pasuje do
synonimu tylko wtedy, gdy jest doktadnie z nim zgodny. Oznacza to, ze aby nastapito grupowanie synonimu z
terminem, przed i po synonimie nie moga wystepowac zadne wyrazy. Na przyktad mozna zdefiniowaé * van $ jako
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synonim, a truck jako termin docelowy, aby tylko termin van byt grupowany z terminem truck, ale by nazwisko
marie van guerin pozostato niezmienione. Ponadto, gdy zdefiniujesz synonim z uzyciem daszka i znaku dolara, to
wystapienie tego wyrazu w tekscie zrodlowym spowoduje automatyczne wyodrebnienie synonimu.

Aby doda¢ synonim
1. Gdy widoczny bedzie panel zastapien, kliknij kart¢ Synonyms w lewym dolnym rogu.

2. W pustym wierszu na gorze tabeli wprowadz termin docelowy w kolumnie Target. Wprowadzony termin docelowy
pojawi si¢ w kolorze. Ten kolor oznacza typ terminu (przypisany lub wymuszony). Jesli termin jest wyswietlany w
kolorze czarnym, oznacza to, ze nie figuruje w zadnym stowniku typu.

3. Kliknij druga komorke po prawej stronie terminu docelowego i wprowadz zestaw synonimow. Oddziel pozycje za
pomoca separatora globalnego zdefiniowanego w oknie dialogowym Options. Wigcej informacji zawiera temat
[<Okreslanie opcji” na stronie 74| Wprowadzane terminy sa wyswietlane w kolorach. Ten kolor reprezentuje typ
terminu. Jesli termin jest wyswietlany w kolorze czarnym, oznacza to, ze nie figuruje w zadnym stowniku typu.

4. Kliknij ostatnia komorke, aby wybrac biblioteke, w ktorej ma zosta¢ zapisana ta definicja synonimu.

Uwaga: Ta instrukcja dotyczy wprowadzania zmian w widoku Resource Editor lub oknie Template Editor. Nalezy
pamigtac, ze optymalizacj¢ mozna tez prowadzi¢ bezposrednio z panelu Extraction Results, panelu Data, panelu
Categories lub okna dialogowego Cluster Definitions w innych widokach. Wigcej informacji mozna znalez¢ w temacie
[‘Optymalizacja wynikow wyodrebniania” na stronie 86|

Definiowanie elementéw opcjonalnych

W zaktadce Optional mozna zdefiniowac¢ opcjonalne elementy dla dowolnej biblioteki. Te elementy sa grupowane dla
kazdej biblioteki. Gdy biblioteka zostanie dodana do panelu drzewa bibliotek, na karcie Optional pojawia sig¢ pusty
wiersz elementu opcjonalnego.

Wszystkie wpisy sa automatycznie przeksztalcane w mate litery. Mechanizm wyodrgbniania dopasowuje wpisy do
wyrazow zapisanych w teks$cie zarowno matymi, jak i wielkimi literami.

Uwaga: Terminy rozdziela si¢ za pomoca separatora zdefiniowanego w oknie dialogowym Options. Wigcej informacji
zawiera temat[“Okreslanie opcji” na stronie 74} Jesli element opcjonalny, ktory wprowadzasz, zawiera ten sam
separator, nalezy poprzedzi¢ go ukosnikiem odwrotnym.

Aby dodac¢ wpis
1. Gdy widoczny bedzie panel zastapien, kliknij kart¢ Optional w lewym dolnym rogu edytora.
2. W kolumnie Optional Elements kliknij komdrke wlasciwa dla biblioteki, do ktorej checesz dodac wpis.

3. Wprowadz element opcjonalny. Oddziel pozycje za pomoca separatora globalnego zdefiniowanego w oknie
dialogowym Options. Wiecej informacji zawiera temat[‘Okreslanie opcji” na stronie 74

Wylaczanie i usuwanie zastapien

Mozna tymczasowo usunaé wpis, wylaczajac go w stowniku. Wylaczenie wpisu spowoduje, ze wpis bedzie
ignorowany w czasie wyodrgbniania.

Mozna réwniez usunac niepotrzebne lub nieaktualne wpisy ze stownika zastapien.

Aby wylaczy¢ wpis
1. W stowniku wybierz wpis, ktory chcesz wylaczy¢.

2. Nacisnij klawisz spacji. Pole wyboru po lewej stronie wpisu bgdzie teraz niezaznaczone.
Uwaga: Mozna takze usunac zaznaczenie pola wyboru po lewej stronie wpisu, aby go wylaczy¢.

Aby usuna¢ wpis synonimu

1. W stowniku wybierz wpis, ktory chcesz usunac.
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2. Z menu wybierz opcje Edit > Delete lub nacis$nij klawisz Delete na klawiaturze. Wpis zostanie usunigty ze
stownika.

Aby usunac wpis elementu opcjonalnego
1. W stowniku kliknij dwukrotnie wpis, ktdry chcesz usunac.
2. Recznie usun termin.

3. Nacisnij klawisz Enter, aby zastosowa¢ zmiang.

Stowniki wykluczen

Stownik wykluczen to lista wyrazow, fraz oraz fragmentow tancuchow. Wszelkie terminy pasujace do wpisu ze
stownika wykluczen lub zawierajace taki wpis beda ignorowane lub wykluczane z wyodrgbniania. Stownikami
wykluczen zarzadza si¢ w prawym panelu edytora. Zwykle do tego stownika dodaje si¢ wyrazy wypetniajace lub frazy
uzywane w tekscie dla zapewnienia jego ciaglo$ci, ale nie wnoszace nic waznego, ktore moglyby tylko zaciemnic
wyniki wyodrgbniania. Dodajac te terminy do stownika wykluczen powodujesz, ze nie beda nigdy wyodregbniane.

Stownikami typoéw zarzadza si¢ w prawym gérnym panelu karty Library Resources w edytorze. Dostgp do tego widoku
mozna uzyskac, wybierajac opcj¢ View > Resource Editor w menu, jesli jest aktywna sesja interaktywnego pulpitu
roboczego. Jesli nie jest, mozna edytowa¢ stowniki konkretnego szablonu w oknie Template Editor.

W stowniku wykluczen mozna wprowadzi¢ wyraz, fraz¢ lub czg$¢ tancucha w pustym wierszu w gornej czgsci tabeli.
Do stownika wykluczen mozna dodawac¢ tancuchy znakéw obejmujace jeden lub wigcej wyrazow, a nawet czgsci
wyrazow, postugujac sig¢ gwiazdka jako symbolem wieloznacznym. Wpisy zadeklarowane w stowniku wykluczen
uniemozliwia wyodrgbnienie zwiazanych z nimi termindw. Jesli wpis jest zadeklarowany takze w innym miejscu
interfejsu, na przyktad w stowniku typu, to w innych stownikach bedzie przekreslony. Lancuch nie musi wystgpowaé w
danych tekstowych ani by¢ zadeklarowany w jakimikolwiek stowniku typy, aby byt stosowany.

Uwaga: Jesli do stownika wykluczen dodasz pojecie, ktore jest takze terminem docelowym synonimu, to wykluczony
zostanie zardwno termin docelowy, jak i wszystkie jego synonimy. Wigcej informacji mozna znalez¢ w temacie
[‘Definiowanie synoniméw” na stronie 181]

Korzystanie z symboli wieloznacznych (*)

uzy¢ symbolu wieloznacznego w postaci gwiazdki, aby zasygnalizowa¢, ze wykluczany wpis ma by¢ traktowany jako
fancuch czgsciowy. Wszelkie terminy znalezione przez mechanizm wyodrebniania zawierajace wyraz, ktory
rozpoczyna sig lub konczy tancuchem wprowadzonym do stownika wykluczen, zostana wykluczone z ostatecznego
wyodrebniania. Istnieja jednak dwa przypadki, w ktorych zastosowanie symbolu wieloznacznego nie jest dozwolone.

* Lacznik (-) poprzedzony gwiazdka, na przyktad *-
* Apostrof (') poprzedzony gwiazdka, na przyktad *'s

Tabela 39. Przykiady wpisow wykluczania

Pozycja Przyklad Wyniki

wyraz next Nie beda wyodregbniane zadne pojgcia (ani ich terminy) zawierajace wyraz next.

fraza for example Nie beda wyodregbniane zadne pojecia (ani ich terminy) zawierajace frazg for example.

czastkowe copyright* Ten wpis wyklucza wszelkie pojecia (i ich terminy) pasujace do odmian wyrazu copyright lub
je zawierajace, na przyktad copyrighted, copyrighting, copyrights lub copyright 2010.

czastkowe *ware Ten wpis wyklucza wszelkie pojgcia (i ich terminy) pasujace do odmian wyrazu ware lub je
zawierajace, na przyktad freeware, shareware, software, hardware, beware lub
silverware.
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Aby doda¢ wpisy

* W pustym wierszu na gorze tabeli wprowadz termin. Wprowadzony termin zostanie wyswietlony w kolorze. Ten
kolor reprezentuje typ terminu. Jesli termin jest wyswietlany w kolorze czarnym, oznacza to, ze nie figuruje w
zadnym stowniku typu.

Aby wylaczyé wpisy

Mozna tymczasowo usunaé wpis, wyltaczajac go w stowniku wykluczen. Wyltaczenie wpisu spowoduje, ze wpis bedzie
ignorowany w czasie wyodrgbniania.

1. W stowniku wykluczen wybierz wpis, ktory chcesz wytaczy¢.

2. Nacisnij klawisz spacji. Pole wyboru po lewej stronie wpisu bedzie teraz niezaznaczone.
Uwaga: Mozna takze usuna¢ zaznaczenie pola wyboru po lewej stronie wpisu, aby go wytaczy¢.
Aby usuna¢ wpisy

Mozna usuna¢ niepotrzebne lub nieaktualne wpisy ze stownika wykluczen.
1. W stowniku wykluczen wybierz wpis, ktdry chcesz usunaé.

2. Z menu wybierz kolejno opcje Edit > Delete. Wpis zostanie usunigty ze stownika.
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Rozdziat 17. Informacje o zasobach zaawansowanych

W produkcie mozna korzystaé ze stownikow typdw, wykluczen i podstawien, a ponadto mozna pracowaé z roznymi
ustawieniami zasobow zaawansowanych, takimi jak ustawienia grupowania rozmytego, a takze definicje typow
nielingwistycznych. Z tymi zasobami mozna pracowac na karcie zasobéw zaawansowanych w widoku Template Editor
lub widoku Resource Editor.

Po przejsciu do karty zasobéw zaawansowanych mozna edytowac nastgpujace informacje:

* Jezyk docelowy dla zasobow. Okresla jezyk, w ktorym zasoby beda tworzone i dostosowywane. Wigcej informacji
zawiera temat[“Jezyk docelowy dla zasobow” na stronie 187

* Grupowanie rozmyte (wyjatki). Umozliwia wykluczanie par stdw z algorytmu grupowania rozmytego (poprawki
bledow pisowni). Wigcej informacji zawiera temat [“Grupowanie rozmyte” na stronie 187}

* Obiekty nielingwistyczne. Okreslanie obiektow nielingwistycznych, ktore beda wyodrebniane lub nie. Ponadto
okreslanie wyrazen regularnych i regut normalizacji stosowanych podczas ich wyodrebniania. Wigcej informacji
zawiera temat[“Obiekty nielingwistyczne” na stronie 188

* Obsluga jezykow. Deklarowanie sposobdw tworzenia struktur zdan (wzorce wyodrgbniania i definicje wymuszone),
a takze okreslanie sposobdw uzywania skrotow dla wybranego jezyka. Wigcej informacji zawiera temat

liezykow” na stronie 192}

\,;,‘- Interactive Warkbench - Q1 What do you like maost.. ’EHE
File  Edit W“iew Resources Tools  Help
Dy A RBEBXE S ﬂﬁ :ﬁ Categories and Concepts ™ |
Library Resources || Advanced Resources Tes Link Rules
Target language for resources: ﬂactin action =
" : 5 | active site activist
__E_r_1_;_1|_|_9_._r1_ s s albania albany
= Fuzzy Grouping albgrta albgrti
i aminge amino
. & E.xcep.tm_ns ” analog analogy
E] =1 Monlinguistic Entmes. - Ararsan Aridetend
& Regular Expression Definitions antarctic antarctica
&y Normalization appellation appleton
et) Configuration arm army
Bl Language Handling {English) attention attenuation
i &5 Extraction Patterns bacillus haycal
&5 Farced Definitians hacteremia hacterium
sion hakery haker
& Abbreviations { oarila batral
hasel basil
hasel hasle
hiscott hiscuits
bloody blood
hoard bored
hoast hoost
boating booting
hoson hosnia
hawer bowery
hrunt hurnett
burglar burglare
buttery butter
calcite calcutta
canoe cayenne =

Rysunek 40. Edytor szablonéw eksploracji tekstu - karta Advanced Resources

Uwaga: Za pomoca paska narzedzi Znajdz i zamien mozna szybko znajdowac informacje, a takze wprowadzac spdjne
zmiany w sekcji. Aby uzyskac¢ wiecej informaciji, patrz|“Zastepowanie” na stronie 186}

185



Aby edytowa¢ zasoby zaawansowane
1. Odszukaj i wybierz zasoby, ktore zamierzasz edytowac. Zawarto$¢ pojawi si¢ w panelu po prawej stronie.
2. Uzyj przyciskow menu lub na pasku narzedzi, aby wyciac, skopiowac lub wklei¢ zawartosc.

3. Przeprowadz edycje plikow wybranych do zmiany, korzystajac z regut formatowania z tej sekcji. Zmiany zostana
zapisane bezposrednio po ich wprowadzeniu. W celu przywrocenia poprzedniego stanu mozna uzy¢ strzatek
cofania i ponawiania na pasku narzedzi.

Znajdowanie

W niektorych przypadkach konieczne jest szybkie wyszukanie informacji w okreslonej sekcji. Na przyktad podczas
analizy powiazan w tekscie konieczne moze by¢ operowanie na setkach makr i definicji wzorcow. Korzystajac z
funkcji Find, mozna szybko znalez¢ okres$lona regute. Do wyszukiwania informacji w okreslonej sekcji mozna uzy¢
paska narzedzi Find.

Aby uzy¢ funkciji Find
1. Odszukaj i wybierz sekcjg zasobu, ktdra chcesz przeszukac. Zawartos¢ pojawi si¢ w prawym panelu edytora.

2. Z menu wybierz opcje Edit > Find. W gornej czesci okna dialogowego Edit Advanced Resources pojawi si¢ pasek
narzedzi Find.

3. W polu tekstowym wprowadz fancuch wyrazow, ktory chcesz wyszukaé. Za pomoca przyciskow na pasku narzedzi
mozna sterowa¢ uwzglednianiem wielkosci liter, dopasowywaniem czgsciowym i kierunkiem wyszukiwania.

4. Kliknij przycisk Find, aby rozpocza¢ wyszukiwanie. W przypadku znalezienia dopasowania tekst w oknie zostanie
podswietlony.

5. Ponownie kliknij przycisk Find, aby wyszuka¢ nastgpne dopasowanie.

Uwaga: Podczas pracy na karcie Text Link Rules opcja Find jest dostgpna tylko podczas przegladania kodu
zrddlowego.

Zastepowanie

W niektorych przypadkach konieczne jest wprowadzenie masowych zmian w zasobach zaawansowanych. Funkcja
Replace umozliwia takie powtarzalne modyfikacje.

Aby uzy¢ funkciji Replace
1. Odszukaj i wybierz sekcje zasobu, w ktorej cheesz szukac i zastgpowac. Zawarto$¢ pojawi si¢ w prawym panelu
edytora.
Z menu wybierz kolejno opcje Edit > Replace. Zostanie otwarte okno dialogowe Replace.
W polu tekstowym Find what wprowadz tancuch wyrazow, ktory chcesz wyszukac.
W polu tekstowym Replace with wprowadz tancuch, ktérym chcesz zastapic znaleziony tekst.

Zaznacz opcje Match whole word only, jesli chcesz znajdowac i zastgpowac tylko cale wyrazy.

ook 0D

Zaznacz opcj¢ Match case, jesli chcesz znajdowac i zastgpowac tylko wyrazy, w ktorych doktadnie zgadza sig
wielkosc¢ liter.

7. Kliknij przycisk Find Next, aby znalez¢ dopasowanie. W przypadku znalezienia dopasowania tekst w oknie
zostanie podswietlony. Jesli nie chcesz zastgpowac tego konkretnego wystapienia, klikaj ponownie przycisk Find
Next az do znalezienia dopasowania, ktore chcesz zastapic.

8. Kliknij przycisk Replace, aby zastapi¢ wybrane dopasowanie.

9. Kliknij przycisk Replace All, aby zastapi¢ wszystkie dopasowania w zaznaczonej sekcji. Zostanie otwarty
komunikat z liczba przeprowadzonych zamian.

10. Po zakonczeniu zastgpowania kliknij przycisk Close. Okno dialogowe zostanie zamknigte.
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Uwaga: W razie popehienia pomylki przy zastgpowaniu mozna cofnaé operacje zastapienia, zamykajac okno
dialogowe 1 wybierajac polecenie Edit > Undo z menu. Nalezy wykona¢ t¢ czynno$¢ po jednym razie dla kazde;j
zmiany, ktdra ma zosta¢ wycofana.

Jezyk docelowy dla zasobéw

Zasoby tworzone sa z mysla o konkretnym jezyku tekstu. Jgzyk, dla ktorego zoptymalizowane sa te zasoby, jest
zdefiniowany na karcie Advanced Resources. W razie potrzeby mozna przelaczy¢ sig na inny jezyk, wybierajac go w
polu kombi Target language for resources. Ponadto wskazany tutaj jezyk bedzie widoczny jako jezyk wszelkich
pakietéw analizy tekstu utworzonych przy uzyciu tych zasobow.

Wazne: Potrzeba zmiany jezyka w zasobach wystgpuje bardzo rzadko. Zmiana taka moze spowodowaé problemy, jesli
zasob przestanie pasowac do jezyka wyodrgbniania. Cho¢ mozliwosé ta jest rzadko wykorzystywana, mozna zmieni¢
jezyk, jesli planuje sie uzywanie opcji jezyka ALL podczas wyodrebniania, poniewaz oczekuje sie, ze tekst bedzie
zapisany w wigcej niz jednym jezyku. Zmieniajac jezyk, mozna np. uzyska¢ dostgp do wzorcow wyodrebniania,
skrotow 1 definicji wymuszonych dla dodatkowego jezyka. Jednak przed opublikowaniem lub zapisaniem dokonanych
zmian w zasobach lub uruchomieniem kolejnego wyodrebniania nalezy przywroci¢ jezyk gtéwny, ktory ma byc
wyodrebniany.

Grupowanie rozmyte

Wybranie opcji Accommodate spelling for a minimum root character limit of w wezle Text Mining i ustawieniach
wyodrebniania jest rownoznaczne z wlaczeniem algorytmu grupowania rozmytego.

Grupowanie rozmyte pomaga w grupowaniu wyrazow, ktore czgsto sa zapisywane bigdnie lub z drobnymi réznicami,
poprzez tymczasowe usunigcie wszystkich samogtosek (z wyjatkiem pierwszej) i podwdjnych lub potrdjnych
spotglosek z wyodrgbnionych wyrazow, a nastgpnie porownanie ich w celu sprawdzenia, czy rezultat jest identyczny.
W trakcie wyodrebniania funkcja grupowania rozmytego jest stosowana do wyodrgbnionych terminéw, a wyniki sa
poréownywane w celu wykrycia ewentualnych dopasowan. W razie znalezienia dopasowan pierwotne terminy sa
grupowane na ostatecznej liscie wyodrebnionych termindéw. Grupowane sa pod terminem, ktory najczesciej wystepuje
w danych.

Uwaga: Jesli dwa porownywane terminy przypisane sa do réznych typow, z wyjatkiem typu <Unknown>, to technika
grupowania rozmytego nie bgdzie stosowana do tej pary terminow. Innymi stowy, aby technika ta byla stosowana,
terminy musza naleze¢ do tego samego typu lub do typu <Unknown>.

Jesli po wlaczeniu opisywanej funkcji zorientujesz si¢, ze dwa wyrazy o podobnej pisowni zostaty nieprawidlowo
zgrupowane, mozesz wykluczy¢ je z grupowania rozmytego. Mozna to zrobi¢ wprowadzajac nieprawidtowo
dopasowane pary w sekcji Exceptions na karcie Advanced Resources. Wigcej informacji zawiera
f‘Informacje o zasobach zaawansowanych”, na stronie 183|

Nastgpujacy przyktad ilustruje dziatanie grupowania rozmytego. Jesli grupowanie rozmyte jest wiaczone, ponizsze
wyrazy beda traktowane jako identyczne i dopasowywane w nastgpujacy sposob:

color -> colr mountain -> montn
colour -> colr montana -> montn
modeling -> modlng furniture -> furntr
modelling -> moding furnature -> furntr

W powyzszym przyktadzie prawdopodobnie pozadane bytoby unikniecie zgrupowania wyrazéw mountain i montana.
Mozna je zatem wprowadzi¢ w sekcji Exceptions, w nastgpujacy sposob:
mountain montana

Wazne: W niektorych przypadkach wyjatki grupowania rozmytego nie zapobiegaja taczeniu 2 wyrazéw w pare,
poniewaz stosowane sa okreslone reguly synonimow. W takim przypadku mozna sprobowac¢ wprowadzi¢ synonimy z

Rozdziat 17. Informacje o zasobach zaawansowanych 187



zastosowaniem wykrzyknika (1) jako symbolu wieloznacznego, aby zapobiec traktowaniu wyrazow jak synonimoéw w
wynikach. Aby uzyskaé wiecej informacji, patrz[‘Definiowanie synoniméw” na stronie 181}

Reguly formatowania wyjatkow grupowania rozmytego

* W jednym wierszu definiuj tylko jedna pare stanowiaca wyjatek.

» Uzywaj wyrazow prostych lub ztozonych.

* W wyrazach uzywaj tylko matych liter. Wyrazy z wielkimi literami beda ignorowane.

* Wyrazy w kazdej parze oddzielaj znakiem TAB.

Obiekty nielingwistyczne

Podczas pracy z niektorymi typami danych szczegdlnie interesujace jest wyodrebnianie dat, numerow ubezpieczenia
spotecznego, wartosci procentowych lub innych obiektow nielingwistycznych. Obiekty te sa jawnie zadeklarowane w
liku konfiguracyjnym, w ktorym mozna je aktywowac lub dezaktywowac. Wigcej informacji zawiera temat
‘Konfiguracja” na stronie 191} W celu optymalizacji wynikow dziatania mechanizmu wyodrebniania dane
nielingwistyczne sa normalizowane tak, by byly grupowane zgodnie z predefiniowanymi formatami. Wigcej informacji
zawiera temat[“Normalizacja” na stronie 191}

Uwaga: Wyodrgbnianie obiektdw nielingwistycznych mozna wtaczaé i wytacza¢ w ustawieniach wyodrebniania.
Dostepne obiekty nielingwistyczne

Mozliwe jest wyodrebnianie obiektow nielingwistycznych zawartych w tabeli. Nazwa typu jest ujgta w nawiasy.

Tabela 40. Obiekty nielingwistyczne, ktére moga by¢ wyodrebniane

Adresy (<Address>)
Aminokwasy (<Aminoacid>)

Waluty (<Currency>)

Daty (<Date>)

Opdznienie (<Delay>)

Cyfry (<Digit>)

Adresy e-mail (<email>)

Adresy HTTP/URL (<url>)

Adres IP (<IP>

Organizacje (<Organization>)
Procenty (<Percent>)

Produkty (<Product>)

Biatka (<Gene>)

Numery telefonow (<PhoneNumber>)
Godziny (<Time>)

Numery ubezpieczenia spotecznego w USA (<SocialSecurityNumber>)
Wagi i miary (<Weights-Measures>)

Czyszczenie tekstu przed przetwarzaniem

Zanim rozpocznie si¢ wyodrgbnianie obiektow nielingwistycznych, tekst wejsciowy jest czyszczony. W tym kroku
wprowadzane sa nastgpujace tymczasowe zmiany umozliwiajace rozpoznanie i wlasciwe wyodrgbnienie obiektow
nielingwistycznych:
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» Kazda sekwencja dwoch lub wigcej spacji zamieniana jest na jedna spacje.
* Znaki tabulacji sa zastgpowane spacjami.

* Pojedyncze znaki konica wiersza lub ciagi takich znakow sa zastgpowane spacja, a wiele ciagdw znaku konca
wiersza zamienianych jest na oznaczenie konca akapitu. Koniec wiersza moze by¢ oznaczony znakiem powrotu
karetki (CR), znakiem wysuwu wiersza (LF) albo oboma takimi znakami.

* Znaczniki HTML i XML sa tymczasowo usuwane i ignorowane.

Definicje wyrazen regularnych

W przypadku wyodrgbniania obiektow nielingwistycznych niekiedy konieczne jest zmodyfikowanie lub uzupehienie
definicji wyrazen regularnych. Stuzy do tego sekcja Regular Expression Definitions na karcie Advanced Resources.
Wiecej informacji zawiera [Rozdziat 17, “Informacje o zasobach zaawansowanych”, na stronie 185]

Plik jest podzielony na odrebne sekcje. Pierwsza sekcja nosi nazwe [macros]. Oprocz tej sekeji istnieja takze
dodatkowe sekcje — po jednej dla kazdego obiektu nielingwistycznego. Do tego pliku mozna dodawac nowe sekcje. W
kazdej sekcji reguty sa ponumerowane (regexpl, regexp? i tak dalej). Reguty musza mie¢ kolejne numery od 1 do n.
Kazda przerwa w numeracji spowoduje catkowite zawieszenie przetwarzania pliku.

W pewnych przypadkach obiekt jest zalezny od jezyka. Obiekt uznaje si¢ za zalezny od jezyka, jesli parametr jezyka w
pliku konfiguracyjnym jest dla tego obiektu rézny od 0. Wigcej informacji zawiera temat[“Konfiguracja” na stronie]
Gdy obiekt jest zalezny od jezyka, nazwe sekcji nalezy poprzedzi¢ nazwa jezyka, na przyktad
[english/PhoneNumber]. Ta sekcja zawiera¢ bedzie reguty majace zastosowanie tylko do angielskich numerdw
telefonow, gdy obiekt PhoneNumber bedzie miat przypisany jezyk numer 2.

Wazne! Jesli po zmodyfikowaniu tego lub innego pliku w edytorze mechanizm wyodrgbniania przestanie dziata¢
zgodnie z oczekiwaniami, mozna skorzysta¢ z opcji Reset to Original na pasku narzgdzi, aby przywrdci¢ pierwotna
standardowa zawartos$¢ pliku. Przy modyfikacji tego pliku niezbegdny jest pewien poziom wiedzy na temat wyrazen
regularnych. Jesli potrzebna jest dodatkowa pomoc, nalezy skontaktowac si¢ z firma IBM Corp.

Znaki specjalne . [] {} O\ *+ 2|~ $

Wszystkie znaki dopasowywane sa do samych siebie, z wyjatkiem nastgpujacych znakdw specjalnych, ktére petnia
szczegolne funkcje w wyrazeniach: .[{()\*+?|*$. Aby uzy¢ ktoregokolwiek z tych znakow dostownie, nalezy
poprzedzi¢ go w definicji ukosnikiem odwrotnym (\).

Zalézmy, ze probujemy wyodregbnia¢ adresy WWW. W takich obiektach znak kropki jest bardzo wazny, dlatego nalezy
poprzedza¢ go ukosnikiem odwrotnym, na przyktad:

www\. [a-z]+\.[a-z]+
Operatory powtorzen i kwantyfikatory ? + * {}

Aby uzyskac bardziej elastyczne definicje, mozna w wyrazeniach regularnych stosowac kilka standardowych symboli
wieloznacznych. Sa to symbole: * ? +

*  Gwiazdka * oznacza zero lub wiecej wystqpier poprzedzajacego ja tancucha. Na przyktad ab*c pasuje do "ac",
"abc", "abbbc" itd.

*  Znak plus + oznacza jedno lub wiecej wystqpien poprzedzajacego go tancucha. Na przyktad ab+c pasuje do "abc",
"abbc", "abbbc", ale nie do "ac".

* Znak zapytania ? oznacza zero wystqpien lub jedno wystqpienie poprzedzajacego go tancucha. Na przyktad
modell?ing pasuje do "modeling" i "modeling".

* Odgraniczenie powtorzenia nawiasami {} oznacza granice powtorzenia Na przyktad

[0-9]{n} pasuje do dowolnej cyfry powtorzonej doktadnie n razy. Na przyktad [0-9]{4} pasuje do “1998”, ale nie do
“33”, ani nie do “19983”.

[0-9]{n,} pasuje do dowolnej cyfry powtdrzonej n lub wiecej razy. Na przyktad [0-9]{3,} pasuje do “799” lub “1998”,
ale nie do “19”.
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[0-9]{n,m} pasuje do dowolnej cyfry powtdrzonej od n do m razy wiqcznie. Na przyktad [0-9]{3,5} pasuje do “199”,
“1998” lub “19983”, ale nie do “19”, ani nie do “7199835”.

Opcjonalne spacje i faczniki

W niektorych przypadkach konieczne jest umieszczenie w definicji opcjonalnej spacji. Na przyktad, gdybysmy chcieli
wyodrebnia¢ nazwy walut, takie jak "uruguayan pesos", "uruguayan peso", "uruguay pesos", "uruguay peso", "pesos"
lub "peso", konieczne byloby uwzglednienie faktu, ze moga one sktadac sig¢ z dwoch wyrazow rozdzielonych spacja. W
takim przypadku definicjg nalezy zapisa¢ w postaci (uruguayan |uruguay )?pesos?. Poniewaz po wyrazie
uruguayan lub uruguay w kombinacji z pesos/peso wystepuje spacja, opcjonalna spacje nalezy umiesci¢ w sekwencji
opcjonalnej (uruguayan |uruguay ). Gdyby spacja nie byta umieszczona w sekwencji opcjonalnej, np.
(uruguayan|uruguay)? pesos?, to wyrazenie nie pasowatoby do “pesos” lub “peso”, poniewaz spacja traktowana
bytaby jak znak wymagany.

Jesli interesuje nas lista elementdw obejmujaca znak facznika (-), to facznik musi by¢ umieszczony na koncu listy. Na
przyktad, jesli szukamy przecinka (,) lub tacznika (-), to definicja powinna zawiera¢ liste [,-], a nie [-,].

Kolejno$¢ tancuchéw na listach i w makrach

Nalezy zawsze definiowac najdtuzsza sekwencje przed krotszymi. W przeciwnym razie najdtuzsza sekwencja nigdy nie
zostanie odczytana, poniewaz dopasowana zostanie ta krdtsza. Na przyktad, gdybysmy szukali tancucha “billion” lub
“bill”, to wyraz “billion” musi by¢ zdefiniowany przed “bill”. A zatem, na przyktad, (billion|bill), a nie (bill|billion).
Dotyczy to takze makr, poniewaz makra sa listami fancuchow.

Kolejnos¢ regut w sekeji definicji

Definiuj jedna regule w jednym wierszu. W kazdej sekcji reguly sa ponumerowane (regexpl, regexp?2 i tak dalej).
Reguly musza mie¢ kolejne numery od 1 do n. Kazda przerwa w numeracji spowoduje catkowite zawieszenie
przetwarzania pliku. Aby dezaktywowa¢ wpis, umies¢ symbol # na poczatku kazdego wiersza definicji danego
wyrazenia regularnego. Aby aktywowacé wpis, usun symbol # z poczatku wiersza.

W kazdej sekcji najbardziej zawgzajace reguly musza by¢ zdefiniowane przed najbardziej ogdlnymi, aby przetwarzanie
odbywato sig prawidlowo. Na przyktad, jesli szukamy daty w postaci “miesiqc rok” i w postaci “miesiqc”, to reguta
“miesiqc rok” musi by¢ zdefiniowana przed regula “miesiqc”. Oto wlasciwa definicja:

#6# January 1932
regexpl=$ (MONTH) ,? [0-9] {4}

#@# January
regexp2=$ (MONTH)

and not

#6# January
regexpl=$ (MONTH)

#0@# January 1932
regexp2=$ (MONTH) ,? [0-9] {4}

Korzystanie z makr w regutach
Jesli w kilku regutach ma by¢ uzywana ta sama sekwencja, mozna skorzysta¢ z marka. Wowczas ewentualna zmiang

definicji sekwencji trzeba bedzie wprowadzi¢ tylko raz, a nie we wszystkich regutach, ktére si¢ do niej odwotuja.
Zatézmy na przyktad, ze mamy nastgpujace makro:

MONTH=((january|february|march|april|june|july|august|september|october|
november |december) | (jan|feb|mar|apr|may|jun|jul|aug|sep|oct|nov|dec)(\.)?)

Kazde odwotanie do nazwy makra musi by¢ ujete w $(), na przyktad: regexp1=$(MONTH)
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Wszystkie makra musza by¢ zdefiniowane w sekcji [macros].

Normalizacja

Podczas wyodrgbniania obiektow nielingwistycznych napotkane obiekty sa normalizowane w taki sposob, by zostaty
pogrupowane zgodnie z predefiniowanymi formatami. Na przyktad symbole walut i rownowazne im oznaczenia
stowne sa traktowane jako tozsame. Wpisy uzywane do normalizacji sa wymienione w sekcji Normalization na karcie
Advanced Resources. Wigcej informacji zawiera|[Rozdzial 17, “Informacje o zasobach zaawansowanych”, na stronie|
Plik jest podzielony na odrgbne sekcje.

Wazne! Ten plik jest przeznaczony tylko dla uzytkownikéw zaawansowanych. Jest mato prawdopodobne, ze wystapi
potrzeba jego modyfikacji. Jesli potrzebna jest dodatkowa pomoc, nalezy skontaktowac si¢ z firma IBM Corp.

Reguty formatowania normalizacji
* W jednym wierszu umieszczaj tylko jeden wpis normalizacyjny.
+ Scisle przestrzegaj podziatu pliku na sekcje. Nie mozna dodawaé nowych sekcji.

* Aby dezaktywowac wpis, umies¢ symbol # na poczatku odpowiedniego wiersza. Aby aktywowaé wpis, usun symbol
# z poczatku wiersza.

Daty zapisane w jezyku angielskim a normalizacja

Domyslnie daty w szablonie dla jezyka angielskiego sa rozpoznawane w formacie amerykanskim, tj.: miesiac, data,
rok. Aby zmieni¢ format na dzien, miesiac, rok, nalezy dezaktywowac wiersz ,,format:US” (dodajac # na poczatku
wiersza) i aktywowac wiersz ,,format:UK” (usuwajac # z poczatku tego wiersza).

Konfiguracja

W pliku konfiguracji obiektow nielingwistycznych mozna aktywowac i dezaktywowac typy obiektow
nielingwistycznych, ktére maja by¢ wyodrgbniane. Dezaktywacja niepotrzebnych obiektéw moze przyspieszy¢
przetwarzanie. Aktywacji i dezaktywacji dokonuje si¢ w sekcji Configuration na karcie Advanced Resources. Wigcej
informacji zawiera [Rozdziat 17, “Informacje o zasobach zaawansowanych”, na stronie 185} Jesli wiaczone jest
wyodrebnianie obiektdw nielingwistycznych, to mechanizm wyodrgbniania odczytuje ten plik konfiguracji w trakcie
wyodrebniania, aby okreslic, ktore typy obiektow nielingwistycznych powinny by¢ wyodrebniane.

W pliku tym obowiazuje nastgpujaca sktadnia:
#nazwa<TAB>Jezyk<TAB>Kod

Tabela 41. Skiadnia pliku konfiguracji.

Etykieta kolumny Opis

#name Nazwa, za posrednictwem ktorej obiekty nielingwistyczne beda identyfikowane w dwoch
pozostatych plikach wymaganych do wyodrgbniania obiektow nielingwistycznych. W uzywanych
tutaj nazwach rozrézniana jest wielkos¢ liter.

Language Jezyk dokumentow . Najlepiej jest wybrac¢ konkretny jezyk. Istnieje jednak réwniez opcja Any.
Mozliwe opcje to: 0 = dowolny jezyk uzywany, gdy wyrazenie regexp nie jest charakterystyczne dla
jezyka i moze by¢ uzywane w kilku szablonach z réznymi jezykami; przyktad: IP/URL/adres e-mail;
1 = francuski; 2 = angielski; 4 = niemiecki; 5 = hiszpanski; 6 = holenderski; 8 = portugalski; 10 =
whoski.

Code Kod czgséci mowy. Wigkszos¢ obiektow, z nielicznymi wyjatkami, ma kod ,,s”. Mozliwe wartosci to:
s = slowo zatrzymujace; a = przymiotnik; n = rzeczownik. Aktywne obiekty nielingwistyczne sa
najpierw wyodrebniane, a nastgpnie stosowane sa do nich wzorce wyodrgbniania w celu okreslenia
ich rol w szerszym kontekscie. Na przyktad wartosciom procentowym przypisywana jest rola ,,a”.
Zalozmy, ze jako obiekt nielingwistyczny zostanie wyodrgbniony wyraz 30%. Zostatby on
zidentyfikowany jako przyrostek. Teraz, gdyby tekst zawierat wyrazy ,,30% salary increase”
(30-procentowy wzrost wynagrodzenia), to obiekt ,,30%” zostalby dopasowany do wzorca czgsci
mowy ,,ann” (przymiotnik rzeczownik rzeczownik).
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Kolejnos¢ definiowania obiektow

Kolejnos¢, w jakiej obiekty sa zadeklarowane w tym pliku, jest istotna i wptywa na sposob ich wyodrebniania. Sa one
stosowane w kolejnosci, w jakiej sa wymienione. Zmiana kolejnosci wptynie na uzyskiwane wyniki. Najbardziej
jednoznaczne obiekty nielingwistyczne powinny by¢ zdefiniowane przed bardziej ogélnymi.

Na przyktad obiekt nielingwistyczny ,,Aminoacid” jest zdefiniowany w nastepujacy sposob:
regexpl=($(AA)-7$ (NUM))

gdzie $(AA) odpowiada ,,(alalarg|asn|asp|cys|gin|glu|gly|his|ile|leu|lys|met|phe|pro|ser)”, czyli konkretnym
3-literowym sekwencjom oznaczajacym konkretne aminokwasy.

Z drugiej strony obiekt nielingwistyczny ,,Gene” jest bardziej ogolny i zdefiniowany w nastgpujacy sposob:

regexpl=p[0-9]{2,3}
regexp2=[a-z]{2,4}-7[0-9]{1,3}-?[r]
regexp3=[a-z]{2,4}-7[0-9]{1,3}-7p?

Jesli w sekcji konfiguracji obiekt ,,Gene” zostanie zdefiniowany przed obiektem ,,Aminoacid”, to ,,Aminoacid” nigdy
nie zostanie wykryty, poniewaz regexp3 z definicji obiektu ,,Gene” zawsze zostanie dopasowane jako pierwsze.

Reguly formatowania konfiguracji

* Wpisy w kolumnach rozdzielaj znakiem TAB.

* Nie usuwaj zadnych wierszy.

* Przestrzegaj sktadni przedstawionej w powyzszej tabeli.

* Aby dezaktywowac wpis, umies¢ symbol # na poczatku odpowiedniego wiersza. Aby aktywowaé wpis, usun symbol
# z poczatku wiersza.

Obstuga jezykéw

W kazdym ze wspodtczesnych jezykow istnieja charakterystyczne sposoby wyrazania pojg¢, budowania zdan i
stosowania skrotow. W sekcji Language Handling mozna edytowaé wzorce wyodregbniania, wymusza¢ definicje dla
takich wzorcow i deklarowa¢ skréty dla jezyka wybranego z listy rozwijanej Language.

* Wzorce wyodrgbniania
* Definicje wymuszone
* Skroty

Wzorce wyodrebniania
Podczas wyodrgbniania informacji z dokumentéw mechanizm wyodrebniania stosuje zestaw wzorcow wyodrgbniania

czesci mowy do budowania ,,stosdw” wyrazow w tekscie w celu wykrycia terminow kandydackich (wyrazow i fraz) do
wyodrgbnienia. Mozna dodawac lub modyfikowa¢ wzorce wyodrgbniania.

Do czg$ci mowy naleza elementy gramatyczne, takie jak rzeczowniki, przymiotniki, przystowki, imiona, inicjaty,
partykutly itd. Szereg takich elementdéw sktada si¢ na wzorzec wyodrebniania czgSci mowy. W produktach IBM Corp.
do eksploracji tekstu kazda cze$¢ mowy reprezentuje jeden znak, dzieki czemu tatwiej jest definiowa¢ wlasne wzorce.
Na przyktad przymiotnik reprezentuje mata litera a. Zestaw obslugiwanych kodéw wyswietlany jest domyslnie w
gornej czesci sekcji kazdego z domyslnych wzorcow wyodrebniania wraz z zestawem zapiséw wzorcow i przyktadow,
ktore utatwiaja zrozumienie zasad poshugiwania sig¢ kodami.

Regutly formatowania wzorcéw wyodrebniania
* Jeden wzorzec na wiersz.

* Aby dezaktywowa¢ wzorzec, umies$¢ znak # na poczatku wiersza.
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Kolejnos¢ wzorcow wyodrebniania na liscie jest bardzo wazna, poniewaz mechanizm wyodrgbniania odczytuje dana
sekwencj¢ wyrazow tylko raz i przypisuje ja do pierwszego pasujacego wzorca wyodrgbniania.

Obstugiwane kody czesci mowy

Ponizej znajduje si¢ spis wszystkich obstlugiwanych kodéw czesci mowy zdefiniowanych w jezyku angielskim
skompilowanego stownika.

Wszystkie czgsci mowy uzywane do konkretnego szablonu sa wyswietlane u géry Advanced Resources > Extraction
patterns.

Glowna réznica migedzy podstawowym szablonem zasobow a szablonem opinii polega na tym, ze w szablonie
podstawowym uzywane sa podstawowe okreslniki (,,d”) i przyimki (,,c”), a w szablonie opinii ich rozbudowane
odpowiedniki (,,e” i,,r”’). Ponadto w szablonie opinii wszystkie wyrazy zawierajace czgsci mowy ,,a” 1,,Q” sa
przetwarzane wylacznie jako ,,Q”. We wszystkich szablonach opinii uzycie ,,0”, ,,1” 1,,2” jest ograniczone.
PatrzAdvanced Resources > Language Handling (English) > Forced Definitions and Extraction patterns.

Inne szablony w jezyku angielskim moga uzywac czgsci mowy, ktérych nie wymieniono w stowniku (na przyktad ,,w”
i,,W” w szablonie analizy rynku). Jednak w takim wypadku te cz¢$ci mowy sa przypisane do konkretnych wyrazéow w
obszarze Advanced Resources > Forced Definitions.

Tabela 42. Obstugiwane kody czesci mowy

Code Znaczenie Przyklad
a przymiotnik abdominal, blue...
w nieuzywany nieuzywany
b przystowek frequently, often, very, ...
P nieuzywany nieuzywany
c przyimek ,,0f”
Z kod wewngtrzny dla wyrazow o
nieprawidtowej pisowni
d okreslnik ,the”
D nieuzywany nieuzywany

o

rozbudowany okreslnik

the, an, my, your...

E nieuzywany nieuzywany
f imie John, Mary...
F nieuzywany nieuzywany
g nieuzywany nieuzywany
G przymiotniki narodowosci french, american...
h nieuzywany nieuzywany
H nieuzywany nieuzywany
i nieuzywany nieuzywany
I nieuzywany nieuzywany
j nieuzywany nieuzywany
J nieuzywany nieuzywany
k nieuzywany nieuzywany
K nieuzywany nieuzywany
1 nieuzywany nieuzywany
L nieuzywany nieuzywany
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Tabela 42. Obstugiwane kody czesci mowy (kontynuacja)

Code Znaczenie Przyklad
m przymiotnik lub nieznana czgs¢ dog, ibm
mowy
M nieuzywany nieuzywany
n rzeczownik pies
N nieuzywany nieuzywany
) spojnik and”, | . &”
(0] nieuzywany nieuzywany
p imiestow bierny abandoned, accessorized...
P nieuzywany nieuzywany
q nieuzywany nieuzywany
Q kwalifikator expensive, small, good, ...
r rozbudowany przyimek of, among, against, from...
R nieuzywany nieuzywany
] stop lista dowolne stowo, ktore nie jest potrzebne do wyodregbnienia
S nieuzywany nieuzywany
t tytut mrs., mrs, captain, brig., ...
T przymiotniki techniczne tumor-restricted... (wszystkie ,,T” sa rowniez ,,a”)
u nieznane wedtug definicji, nie
wystepuja w stowniku
U nieuzywany nieuzywany
\% czasownik eat, eats, ate, eating, ...
\Y bezokolicznik eat, ...
w nieuzywany nieuzywany
w nieuzywany nieuzywany
X czasownik positkowy be
X nieuzywany nieuzywany
y przyimki w nazwiskach von, di, de, ... (stuzy do wyodrgbniania nazw osob: John von Doe)
Y nieuzywany nieuzywany
z nieuzywany nieuzywany
Z nieuzywany nieuzywany
przystowek wyrazajacy opinig Tylko w szablonach opinii. Patrz Advanced resources > Language
Handling (English) > Forced Definitions.
1 ,,t0” w opiniach Patrz Advanced resources > Language Handling (English) > Forced
Definitions
2 okreslony kwalifikator Tylko w szablonach opinii. Patrz Advanced resources > Language
Handling (English) > Forced Definitions.
3 nieuzywany nieuzywany
4 nieuzywany nieuzywany
5 nieuzywany nieuzywany
6 nieuzywany nieuzywany
7 nieuzywany nieuzywany
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Tabela 42. Obstugiwane kody czesci mowy (kontynuacja)

Code Znaczenie Przyklad
8 nieuzywany nieuzywany
9 nieuzywany nieuzywany

Definicje wymuszone

Podczas wyodrebniania informacji z dokumentéw mechanizm wyodregbniania przeszukuje tekst i przypisuje kazdy
napotkany wyraz do czesci mowy. W niektorych przypadkach ten sam wyraz moglby petni¢ wigcej niz jedna rolg,
zaleznie od kontekstu. Jesli chcesz wymusié traktowanie wyrazu zawsze jako okreslonej czg¢$ci mowy lub catkowicie
wykluczy¢ wyraz z przetwarzania, mozesz zrobi¢ to w sekcji Forced Definition na karcie Advanced Resources.
Wigcej informacji zawiera[Rozdziat 17, “Informacje o zasobach zaawansowanych”, na stronie 185

Aby wymusi¢ traktowanie danego wyrazu jako okreslonej czesci mowy, musisz doda¢ w tej sekcji wiersz o formacie:

termin:kod

Tabela 43. Opis sktadni.

Pozycja Opis
termin Nazwa terminu.
code Jednoznakowy kod reprezentujacy czg$¢ mowy. Mozna wymieni¢ maksymalnie sze$¢ roznych czgsci mowy dla

jednego terminu pojedynczego. Ponadto mozna zapobiec wyodrgbnianiu wyrazu w wyrazy ztozone/frazy,
korzystajac z kodu s (mata litera), na przyktad dodatkowe:s.

Reguty formatowania definicji wymuszonych

* Jeden wiersz na wyraz.

* Terminy nie moga zawiera¢ dwukropkow.

* Aby catkowicie zablokowa¢ wyodrebnianie wyrazu, uzyj kodu czgsci mowy S.

* Maksymalnie sze$¢ kodow czgsci mowy na wiersz. Obstugiwane kody czesci mowy sa wyswietlane w sekcji
Extraction Patterns. Wiecej informacji zawiera temat [“Wzorce wyodrebniania” na stronie 192}

* Aby uzyska¢ dopasowania czgsciowe, uzyj gwiazdki (*) jako symbolu wieloznacznego na koncu fancucha. Na
przyktad wprowadzenie add*:s spowoduje, ze takie wyrazy, jak add, additional, additionally, addendum i
additive nigdy nie beda wyodrgbniane jako termin ani jako czg$¢ terminu ztozonego. Jesli jednak dopasowany
wyraz jest jawnie zadeklarowany jako termin w skompilowanym stowniku lub na liscie wymuszonych definicji, to
nadal bedzie wyodregbniany. Na przyktad wprowadzenie zaréwno add*:s, jak i addendum:n, spowoduje, ze
znaleziony w tekscie wyraz addendum zostanie wyodrgbniony.

Skroéty
Gdy mechanizm wyodregbniania przetwarza tekst, z zasady traktuje kazda napotkana kropke jako koniec zdania.
Zwykle takie zatozenie jest poprawne, jednak ten sposob traktowania kropek nie ma zastosowania, gdy tekst zawiera

skroty.

Jesli podczas wyodrgbniania terminow z tekstu okazuje sig, ze niektore skroty sa traktowane nieprawidtowo, nalezy je
jawnie zadeklarowac w tej sekcji.

Uwaga: Jesli skrét wystepuje juz w definicji synonimu lub jest zdefiniowany jako termin w stowniku typu, to nie
trzeba go tutaj dodawac.

Reguty formatowania skrotow
* Definiyj jeden skrot w jednym wierszu.
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Rozdziat 18. Informacje o regutach powigzan w tekscie

Analiza powiazan w tekscie (TLA — Text link analysis) to technika dopasowywania wzorcow stuzaca do
wyodregbniania relacji istniejacych w tekscie w oparciu o zestaw regut. Gdy przy wyodrgbnianiu wlaczona jest analiza
powiazan w tekscie, dane tekstowe sa pordwnywane z tymi regutami. Po znalezieniu dopasowania wzorzec analizy
powiazan jest wyodrgbniany i prezentowany. Reguty te definiuje sig¢ na karcie Text Link Rules.

Na przyktad samo wyodregbnienie poje¢ odzwierciedlajacych proste cechy organizacji moze nie dostarczy¢
warto$ciowej wiedzy. Jednak stosujac technikg TLA, mozna ujawni¢ powiazania migedzy réznymi organizacjami lub
osoby powiazane z organizacja. Technik¢ TLA mozna tez zastosowa¢ do wyodrebniania opinii o takich zagadnieniach,
jak odczucia 0sob o danym produkcie lub ustudze.

Aby skorzysta¢ z techniki TLA, musisz mie¢ do dyspozycji zasoby zawierajace reguty analizy powiazan w tekscie.
Woybierajac szablon, mozna zorientowac sig, ktore szablony zawieraja reguty TLA, po obecnosci lub braku ikony w
kolumnie TLA.

Wzorce analizy powiazan w tekscie sa znajdowane w danych tekstowych na etapie dopasowywania wzorcow podczas
wyodrebniania. Na tym etapie reguly sa porownywane z danymi tekstowymi, a gdy zostanie znalezione dopasowanie,
informacja ta jest wyodrgbniana jako wzorzec. Niekiedy zachodzi potrzeba przeprowadzenia poglebionej analizy
powiazan w tekscie lub zmiany sposobu dopasowania. Mozna w takich przypadkach dostroi¢ reguty, dostosowujac je
do specyficznych potrzeb. Stuzy do tego karta Text Link Rules.

Uwaga: Obstuge zmiennych wycofano w wersji 13. Zamiast nich nalezy korzysta¢ z makr. Wigcej informacji zawiera
temat [‘Praca z makrami” na stronie 202]

Gdzie opracowywaé reguty powigzan w tekscie

Uzytkownik moze edytowac i tworzy¢ reguty bezposrednio na karcie Text Link Rules w widoku Template Editor lub
Resource Editor. Aby zorientowac sig, w jaki sposob reguty moga wyszukiwac tekst, mozna uruchomi¢ symulacj¢ na
tej karcie. W trakcie symulacji procedura jest uruchamiana tylko na probie danych symulacji i reguly powiazan w
tekscie sa stosowane w celu sprawdzenia, czy jakiekolwiek wzorce pasuja do tej proby. Wszystkie reguty, ktdre pasuja
do tekstu, sa nastepnie wyswietlane w panelu symulacji. Na podstawie dopasowan mozna w razie potrzeby
zmodyfikowac reguty i makra, aby zmienic sposob, w jaki tekst jest dopasowywany.

W odréznieniu od innych zasobow zaawansowanych, reguty TLA sa charakterystyczne dla biblioteki, dlatego mozna
uzywac tylko regut TLA z jednej biblioteki na raz. Z poziomu Template Editor lub Resource Editor przejdz do karty
Text Link Rules. Na tej karcie mozna okresli¢ w szablonie biblioteke zawierajaca reguty TLA, ktorych cheesz uzy¢
lub ktore checesz zmodyfikowac. Z tego powodu zaleca si¢ przechowywanie wszystkich regul w jednej bibliotece,
chyba ze istnieje bardzo konkretny powdd, by tego nie robic.
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Rysunek 41. Karta Text Link Rules

Od czego zacza¢

Istnieje kilka sposobow rozpoczgcia pracy z edytorem na karcie Text Link Rules:

* Rozpocznij od symulacji wynikow na probie tekstu i zmodyfikuj lub utworz reguty dopasowania na podstawie

wynikdéw wyodrgbniania wzorcow uzyskanych za pomoca biezacego zestawu regut.
* Utwdrz nowa regule od poczatku lub zmodyfikuj istniejaca regule.

* Pracuj bezposrednio w widoku zrédtowym.

Kiedy modyfikowaé lub tworzy¢é reguty

Wprawdzie reguly analizy powiazan w tekscie dostarczane z kazdym szablonem sa czgsto wystarczajace do

wyodrebnienia wielu prostych lub ztozonych relacji z tekstu, niekiedy jednak konieczne moze by¢ wprowadzenie
pewnych zmian do tych regut lub utworzenie wlasnych regut. Na przyktad:

* Aby ujawni¢ pojgcie lub relacjg, ktora nie jest wyodrgbniana w oparciu o istniejace reguly, poprzez utworzenie
nowej reguty lub makra.

* Aby zmieni¢ domyslne zachowanie typu dodanego do zasobow. Zwykle wymaga to edycji makra, takiego jak
mTopic lub mNonLingEntities. Wigcej informacji zawiera temat[“Makra specjalne: mTopic, mNonLingEntities.|

[SEP” na stronie 204]

198

IBM SPSS Modeler Text Analytics 18.1.1 — podrgcznik uzytkownika




* Aby dodawac nowe typy do istniejacych regut analizy powiazan w tekscie i do makr. Na przyktad, jesli uwazasz, ze
typ <Organization> jest zbyt szeroki, mozesz utworzy¢ nowe typy dla organizacji z réznych sektoréw gospodarki,
takich jak <Pharmaceuticals>, <Car Manufacturing>, <Finance> i tak dalej. W takim przypadku nalezy
zmodyfikowac reguly analizy odsylaczy tekstowych i/lub utworzy¢ makro, aby uwzgledniac te nowe typy i
odpowiednio je przetwarzac.

* Aby dodac¢ typy do istniejacej reguty analizy powiazan w tekscie. Zatozmy na przyktad, ze uzytkownik ma regule,
ktéra wychwytuje tekst john doe called jane doe, ale chce, aby ta reguta, ktéra wychwytuje komunikacje
telefoniczna (called), wychwytywata takze wymiang wiadomosci e-mail. Mozna doda¢ do reguty typ obiektu
nielingwistycznego oznaczajacy adres e-mail, aby wychwytywata ona réwniez takie teksty, jak: johndoe @
ibom.com emailed janedoe @ ibm.com.

* Aby nieznacznie zmodyfikowac istniejaca regule, zamiast tworzy¢ nowa. Zatézmy na przyktad, ze uzytkownik ma
regute, ktora znajduje tekst Xyz is very good, ale chce, aby ta reguta wychwytywala rowniez tekst Xyz is very, very
good.

Symulowanie wynikow analizy powigzan w tekscie

Aby utatwi¢ sobie definiowanie regut analizy powiazan w tekscie i lepiej zrozumie¢, w jaki sposob okreslone zdania sa
dopasowywane podczas analizy, czgsto warto wybra¢ przykladowy fragment tekstu i przeprowadzi¢ symulacjg. W
trakcie symulacji, procedura jest uruchamiana tylko na prébie danych symulacji i reguty powiazan w tekscie sa
stosowane w celu sprawdzenia, czy jakiekolwiek wzorce pasuja do tej proby. Celem jest uzyskanie wynikdéw symulacji,
a nastepnie uzycie tych wynikow do udoskonalenia regut, utworzenia nowych i uzyskania lepszej orientacji w dziataniu
mechanizmu dopasowywania. Dla kazdego fragmentu tekstu (zdania, wyrazu lub klauzuli, w zaleznosci od kontekstu)
wynik symulacji zawiera zbior leksemow i wszelkie reguly TLA, ktore ujawnity wzorzec w tym tekscie. Leksem jest
to dowolny wyraz lub wielowyrazowa fraza zidentyfikowana w procesie wyodrgbniania.

W odréznieniu od innych zasobow zaawansowanych, reguty TLA sa charakterystyczne dla biblioteki, dlatego mozna
uzywac tylko regut TLA z jednej biblioteki na raz. Z poziomu Template Editor lub Resource Editor przejdz do karty
Text Link Rules. Na tej karcie mozna okresli¢ w szablonie biblioteke zawierajaca reguty TLA, ktorych cheesz uzy¢
lub ktére cheesz zmodyfikowac. Z tego powodu zaleca sig przechowywanie wszystkich regut w jednej bibliotece,
chyba ze istnieje bardzo konkretny powdd, by tego nie robic.

Wazne! Jesli uzywany jest plik danych, to powinien zawierac krotki tekst, aby czas przetwarzania byt jak najkrotszy.
Celem symulacji jest sprawdzenie, w jaki sposob tekst jest interpretowany, i zrozumienie dzialania regut w odniesieniu
do tego tekstu. Te informacje utatwia uzytkownikowi pisanie i edytowanie wlasnych regut. Aby uzyskac bardziej
kompletny zestaw danych, uzyj wezla analizy powiazan w tekscie lub uruchom strumien z sesja interaktywna i
wiaczonym wyodrebnianiem TLA. Ta symulacja stuzy tylko do testowania i tworzenia regut.

Definiowanie danych dla symulaciji

Aby zorientowac sig, w jaki sposdb reguty moga wyszukiwac tekst, mozna uruchomic¢ symulacj¢ na probie danych.
Pierwszym krokiem jest zdefiniowanie danych.

Definiowanie danych

1. Kliknij przycisk Define data w panelu symulacji w dolnej czgsci karty Text Link Rules. Jesli dane nie zostaty
weczesniej zdefiniowane, zamiast tego wybierz kolejno opcje Tools > Run Simulation z menu. Zostanie otwarty
kreator danych symulacji.

2. Okresl typ danych, wybierajac jedna z nastgpujacych opcji:

* Paste or enter text directly Dostepne jest pole tekstowe, w ktorym mozna wklei¢ tekst ze schowka lub rgcznie
wprowadzi¢ tekst, ktory ma zosta¢ przetworzony. Mozna wprowadzi¢ jedno zdanie na kazdy wiersz lub uzy¢
znakdw interpunkcyjnych, takich jak kropki lub przecinki, do podziatu zdania. Po wprowadzeniu tekstu mozna
rozpocza¢ symulacje, klikajac opcje Run Simulation.

* Specify a file data source Ta opcja wskazuje, ze ma zosta¢ przetworzony plik, ktory zawiera tekst. Kliknij
przycisk Next, aby przej$¢ do kroku kreatora, w ktorym mozna zdefiniowac plik do przetworzenia. Po wybraniu
pliku mozna rozpocza¢ symulacjg, klikajac opcje Run Simulation. Obslugiwane sa nastepujace typy plikow:
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Axt i .text. Wybrany plik jest odczytywany w trakcie symulacji bez wstepnego przetwarzania. Caty plik jest
traktowany w taki sam sposob, jak w przypadku potaczenia wezta File List lub Text Mining.

Wazne: Jesli uzywany jest plik danych, to powinien zawiera¢ krotki tekst, aby czas przetwarzania byt jak
najkrotszy. Celem symulacji jest sprawdzenie, w jaki sposob tekst jest interpretowany, i zrozumienie dziatania regut
w odniesieniu do tego tekstu. Te informacje ulatwia uzytkownikowi pisanie i edytowanie wlasnych regut. Aby
uzyska¢ bardziej kompletny zestaw danych, uzyj wezta analizy powiazan w tekscie lub uruchom strumien z sesja
interaktywna i wltaczonym wyodrebnianiem TLA. Ta symulacja stuzy tylko do testowania i tworzenia regut.

3. Aby rozpocza¢ proces symulacji, kliknij przycisk Run Simulation. Zostanie wyswietlone okno dialogowe
postepu. Jesli uzytkownik jest w sesji interaktywnej, podczas symulacji uzywane sa ustawienia wyodrgbniania
aktualnie wybrane w ses;ji interaktywnej (sekcja Tools > Extraction Settings w widoku Concepts and Categories).
Jesli uzywane jest okno Template Editor, podczas symulacji uzywane sa domyslne ustawienia wyodrgbniania, ktore
sa takie same jak te pokazane na karcie Expert wezta Text Link Analysis. Aby uzyska¢ wiecej informacji, patrz
[Zrozumienie wynikéw symulacji’}

Zrozumienie wynikéw symulaciji

Aby zorientowac si¢, w jaki sposob reguly moga wyszukiwac tekst, mozna uruchomi¢ symulacj¢ na probie danych i
przejrze¢ jej wyniki. Nastgpnie mozna zmieni¢ zestaw regut, aby lepiej pasowat do danych. Po zakonczeniu
wyodrgbniania i symulacji zostang wyswietlone wyniki symulacji.

Dla kazdego ,,zdania” zidentyfikowanego podczas wyodrebniania przedstawianych jest kilka informacji, w tym
doktadna tre$¢ zdania, leksemy znalezione w tym zdaniu, a takze wszystkie reguly, ktore pasowaly do tekstu w zdaniu.
Przez ,,zdanie” rozumiemy wyraz, zdanie lub klauzule, w zaleznosci od tego, w jaki sposob mechanizm wyodrebniania
podzielit tekst na porcje.

Leksem jest to dowolny wyraz lub wielowyrazowa fraza zidentyfikowana w procesie wyodrgbniania. Na przyktad w
zdaniu My uncle lives in New York mechanizm wyodrgbniania moze znalez¢ nast¢pujace leksemy: my, uncle, lives, in i
new york. Ponadto wyraz uncle (wujek) moglby zosta¢ wyodrgbniony jako pojecie typu <Unknown> (nieznanego), a
nazwa new york moglaby zosta¢ wyodrgbniona jako pojecie typu <Location> (miejsce). Wszystkie pojecia sa
leksemami, ale nie wszystkie leksemy sa pojeciami. Pojgcia moga by¢ takze innymi makrami, literatami tancuchowymi
i odstgpami migdzy wyrazami. Pojgciami moga by¢ tylko te wyrazy lub frazy, ktére maja przypisany typ.

Gdy uzytkownik pracuje w sesji interaktywnej lub edytorze zasobow, operuje na poziomie poj¢é. Reguly TLA sa
bardziej szczegotowe, a w definicji reguty moga by¢ uzywane pojedyncze leksemy ze zdania, nawet jesli nie sa nigdy
wyodregbniane i przypisywane do typow. Mozliwos¢ wykorzystania leksemow, ktére nie sa pojeciami, zapewnia
wigksza elastycznos¢ dziatania regut, pozwalajac na wychwytywanie zlozonych relacji w tekscie.

Jesli w danych symulacji istnieje wigcej niz jedno zdanie, mozna przechodzi¢ do przodu i do tylu migdzy wynikami,
klikajac przyciski Next i Previous.

W przypadkach gdy zdanie nie pasuje do zadnej reguty TLA w wybranej bibliotece (nazwa biblioteki podana jest
powyzej drzewa na tej karcie), wyniki sa traktowane jako niezgodne, a przyciski Next Unmatched i Previous
Unmatched sa wlaczone, aby uzytkownik wiedzial, ze istnieje tekst, dla ktorego zadna reguta nie znalazta
dopasowania, i mogt szybko przechodzi¢ do tych przypadkow.

Po utworzeniu nowych regul, edycji regut lub zmianie zasobow badz ustawieniu wyodrgbniania mozna ponownie
uruchomi¢ symulacj¢. Aby ponownie uruchomié¢ symulacje, kliknij przycisk Run Simulation w panelu symulacji.
Ponownie zostana uzyte te same dane wejsciowe.

W wynikach symulacji sa przedstawione nastgpujace pola i tabele:

Input text. Rzeczywiste ,,zdanie” zidentyfikowane przez proces wyodregbniania w danych symulacyjnych

zdefiniowanych w kreatorze. Przez ,,zdanie” rozumiemy wyraz, zdanie lub klauzulg, w zaleznos$ci od tego, w jaki
sposob mechanizm wyodrgbniania podzielit tekst na porcje.
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System View. Zbior leksemdw rozpoznanych przez proces wyodrebniania.

* Input Text Token. Kazdy leksem znaleziony w tekscie wejsciowym. Pojgcie leksemu zostato zdefiniowane
wczesniej w tym temacie.

* Typed As. Jesli leksem zostat zidentyfikowany jako pojecie i zostal mu przypisany typ, to powiazana nazwa typu
(np. <Unknown>, <Person>, <Location>) jest wyswietlana w tej kolumnie.

* Matching Macro. Jesli leksem zostat dopasowany do istniejacego makra, to nazwa tego makra jest wyswietlana w
tej kolumnie.

Rules Matched to Input Text. W tej tabeli wyswietlane sa wszystkie reguty TLA, ktére zostaty dopasowane na
podstawie tekstu wejsciowego. Dla kazdej dopasowanej reguty zostanie wyswietlona nazwa regulty w kolumnie Rule
Output i powiazane wartosci wyjsciowe dla tej reguty (pary pojecie + typ). Mozna klikna¢ dwukrotnie nazwe
dopasowanej reguty, aby otworzy¢ regut¢ w panelu edytora powyzej panelu symulacji.

Przycisk Generate Rule. Po kliknigciu tego przycisku w panelu symulacji nowa reguta zostanie otwarta w oknie
edytora regul powyzej panelu symulacji. Tekst wejsciowy zostanie wykorzystany jako przyktad. Podobnie, kazdy
leksem z przypisanym typem lub dopasowany do makra w trakcie symulacji jest automatycznie wstawiany w kolumnie
Elements w tabeli Rule Values. Jesli leksem ma okreslony typ i pasuje do makra, to dla uproszczenia w regule bedzie
uzywane makro. Na przyktad, jesli uzywane sa podstawowe zasoby jezyka angielskiego, zdanie ,,/ like pizza” moze
podczas symulacji otrzymac typ <Unknown> i zosta¢ dopasowane do makra mTopic. W takim przypadku wartos¢
mTopic zostanie uzyta jako element w wygenerowanej regule. Wigcej informacji zawiera temat [‘Praca z regutami
powiazan w tekécie” na stronie 205}

Nawigacja wsrod regut i makr w drzewie

Jesli podczas wyodregbniania prowadzona jest analiza powiazan w teksScie, stosowane sg regulty TLA zapisane w
bibliotece wybranej na karcie Text Link Rules.

W odroéznieniu od innych zasobow zaawansowanych, reguly TLA sa charakterystyczne dla biblioteki, dlatego mozna
uzywac tylko regut TLA z jednej biblioteki na raz. Z poziomu Template Editor lub Resource Editor przejdz do karty
Text Link Rules. Na tej karcie mozna okresli¢ w szablonie biblioteke zawierajaca reguty TLA, ktorych cheesz uzy¢
lub ktore checesz zmodyfikowac. Z tego powodu zaleca si¢ przechowywanie wszystkich regul w jednej bibliotece,
chyba ze istnieje konkretny powdd, by tego nie robic.

Mozesz okresli¢ biblioteke, w ktdrej chcesz pracowaé na karcie Text Link Rules, wybierajac t¢ biblioteke do listy
rozwijanej Use and store text link analysis rules in: na tej karcie. Jesli podczas wyodrgbniania prowadzona jest
analiza powiazan w tekscie, stosowane sa reguty TLA zapisane w bibliotece wybranej na karcie Text Link Rules. Z
tego powodu, jesli zdefiniowano reguly powiazan w tekscie (reguty TLA) w wigcej niz jednej bibliotece, tylko
pierwsza biblioteka, w ktorej znaleziono reguty TLA, zostanie uzyta do analizy powiazan w tekscie. Z tego powodu
zaleca si¢ przechowywanie wszystkich regut w jednej bibliotece, chyba zZe istnieje bardzo konkretny powod, by tego
nie robic.

Po wybraniu makra lub reguty w drzewie zawarto$¢ tego elementu jest wyswietlana w panelu edycji po prawe;j stronie.
Jesli klikniesz prawym przyciskiem myszy dowolny element w drzewie, zostanie otwarte menu kontekstowe
czynnosci, takich jak:

» Utworzenie nowego makra w drzewie, a nastgpnie otwarcie go w edytorze do prawe;j stronie.

» Utworzenie nowej reguly w drzewie, a nastgpnie otwarcie jej w edytorze do prawej stronie.

» Utworzenie nowego zestawu regut w drzewie.

* Wycinanie, kopiowanie i wklejanie elementow dla uproszczenia edycji.

» Usuwanie makr, regul i zestawow regut z zasobow.

* Wylaczanie makr, regut i zestawdw regul, aby byty ignorowane podczas przetwarzania.

* Przenoszenie regut w gdore lub w dot w celu zmiany kolejno$¢ przetwarzania.

Ostrzezenia w drzewie
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Ostrzezenia w drzewie sa wyswietlane z zottym trojkatem i poinformuja, ze moze wystapic¢ problem. Zatrzymaj
wskaznik myszy nad niepoprawnym makrem lub reguta, aby wyswietli¢ objasnienie kontekstowe. W wigkszoSci
przypadkow zostanie wyswietlone objasnienie takie, jak: Warning: No example provided; Enter an example, ktore
oznacza, ze nalezy wprowadzi¢ odpowiedni przyktad.

Jesli nie masz przyktadu lub jesli przyktad nie jest zgodny z regula, nie bedzie mozna uzy¢ funkcji Get Tokens, dlatego
zaleca sig, aby wprowadzi¢ tylko jeden przyklad na kazda regule.

Gdy reguta jest pod§wietlona na z6tto, oznacza to, ze edytor TLA nie zna danego typu lub makra. Komunikat bedzie
podobny do nastepujacego: Warning: Unknown type or macro. Informuje on, ze element zdefiniowany w widoku
zrodtowym w postaci $nazwam na przyktad $myType, nie jest typem istniecjacym w bibliotece, ani nie jest makrem.

Aby zaktualizowa¢ dane w mechanizmie sprawdzania sktadni, nalezy przetaczy¢ si¢ do innej reguty lub makra; nie
trzeba niczego rekompilowac. Na przyktad, jesli reguta A wyswietla ostrzezenie, poniewaz brakuje przyktadu, kliknij
gorna lub dolna regule, a nastgpnie wroc¢ do reguty A, aby sprawdzié, czy teraz jest poprawna.

Praca z makrami

Makra moga uproscic¢ strukturg regut analizy powiazan w tekscie, poniewaz umozliwiaja grupowanie typdw, innych
makr i literatow (wyrazow) za pomoca operatora LUB (|). Korzys¢ ze stosowania makr polega nie tylko na mozliwosci
wielokrotnego uzycia tego samego makra w wielu regutach analizy powiazan w tekscie, lecz takze na propagowaniu
zmiany w makrze do wszystkich regut, w ktorych jest stosowane. Wigkszos$¢ gotowych regut TLA dostarczanych z
produktem zawiera predefiniowane makra. Makra sa widoczne u gory drzewa w lewym panelu karty Text Link Rules.

W wynikach symulacji sa przedstawione nastgpujace pola i tabele:

Name. Unikalna nazwa identyfikujaca makro. Zaleca si¢ poprzedzanie nazw makr mala litera m, co pozwoli na szybkie
identyfikowanie makr w regutach. Odwotujac si¢ do makr w regutach (recznie, tj. poprzez edycjg bezposrednia lub w
widoku zrodlowym), nalezy stosowaé przedrostek $, aby mechanizm wyodrebniania wiedzial, ze ma wyszukac¢ nazwe
makra. Jesli jednak przeciagniesz i upuscisz nazwe makra lub dodasz makro z menu kontekstowego, to program
automatycznie rozpozna makro i nie doda znaku $.

Tabela Macro Value.

* Szereg wierszy odzwierciedlajacych wszystkie mozliwe wartosci, jakie to makro moze reprezentowac. W
wartosciach tych rozrézniana jest wielkos¢ liter.

* Warto$ci moga by¢ typami, literatami tancuchowymi, odstgpami miedzy wyrazami, makrami lub dowolnymi
kombinacjami tych elementéw. Wigcej informacji zawiera [‘Elementy obstugiwane w regutach i makrach” na stronie|
210

* Aby wprowadzi¢ wartos¢ elementu w makrze, kliknij dwukrotnie wiersz, w ktorym chcesz pracowaé. Pojawi si¢
edytowalne pole, w ktorym mozna wprowadzi¢ odwotanie do typu, odwotanie do makra, literat tancuchowy albo
odstep migdzy wyrazami. Zamiast tego mozna klikna¢ w komorce prawym przyciskiem myszy, aby wyswietli¢
menu kontekstowe z lista czgsto uzywanych makr, nazw typow i nazw typow nielingwistycznych. Aby odwotac sig
do typu lub makra, nalezy poprzedzi¢ nazwe makra lub typu znakiem ,,$”. Na przyktad $mTopic jest odwotaniem
do makra mTopic. Wprowadzajac wiecej niz jeden argument, nalezy uzywac nawiasow ( ) do zgrupowania
argumentow lub znaku | oznaczajacego logiczne LUB.

* Zapomoca przyciskow po prawej stronie tabeli Macro Value mozna dodawac i usuwac z niej wiersze.

* Kazdy element nalezy wprowadza¢ w osobnym wierszu. Na przyktad, aby utworzy¢ makro reprezentujace 3 literaly
tancuchowe, takie jak am LUB was LUB is, nalezatoby wprowadzi¢ kazdy literat w osobnym wierszu, a tabela
zawieralaby wowczas 3 wiersze.

Tworzenie i edytowanie makr

Uzytkownik moze tworzy¢ nowe lub edytowac istniejace makra. Nalezy przestrzega¢ wskazowek i opisow wiasciwych
dla edytora makr. Wiecej informacji zawiera temat[“Praca z makrami”|
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Tworzenie nowych makr

1. Z menu wybierz opcje Tools > New Macro. Mozesz tez klikna¢ ikong New Macro na pasku narzedzi drzewa, aby
otworzy¢ nowe makro w edytorze.

2. Wprowadz unikalna nazwg i zdefiniuj elementy wartosci makra.
3. Po zakonczeniu kliknij przycisk Apply, aby sprawdzi¢, czy nie wystapity bledy.

Edytowanie makr

1. Kliknij nazweg makra w drzewie. Makro zostanie otwarte w panelu edytora po prawej stronie.
2. Wprowadz zmiany.

3. Po zakonczeniu kliknij przycisk Apply, aby sprawdzi¢, czy nie wystapity btedy.

Wylaczanie i usuwanie makr
Wylaczanie makr

Jesli cheesz, aby makro byto ignorowane podczas przetwarzania, mozesz je wylaczy¢. Moze to powodowac ostrzezenia
lub btedy w regutach, ktore wciaz odwotuja si¢ do wytaczonego makra. Nalezy zachowac ostroznos¢ podczas usuwania
1 wylaczania makr.

1. Kliknij nazwe makra w drzewie. Makro zostanie otwarte w panelu edytora po prawej stronie.
2. Kliknij prawym przyciskiem myszy na nazwie.

3. Z menu kontekstowego wybierz opcj¢ Disable. Ikona makra staje si¢ szara, a samo makro staje si¢ nieedytowalne.
Usuwanie makr

Jesli cheesz sig pozby¢ si¢ makra, mozesz je usunac¢. Moze to powodowacé lub btedy w regutach, ktore weiaz odwotuja
si¢ do usunigtego makra. Nalezy zachowac ostroznos¢ podczas usuwania i wytaczania makr.

1. Kliknij nazwe makra w drzewie. Makro zostanie otwarte w panelu edytora po prawej stronie.
2. Kliknij prawym przyciskiem myszy na nazwie.

3. Z menu kontekstowego wybierz opcj¢ Delete. Makro zniknie z listy.

Sprawdzanie, zapisywanie i anulowanie

Stosowanie zmian w makrach

Po kliknigciu poza edytorem makra lub wybraniu opcji Apply makro jest automatycznie przegladane w poszukiwaniu
bledow. Jesli zostanie znaleziony btad, nalezy wyeliminowa¢ go przed przejsciem do innej czgsci aplikacji.

Jednak mniej powazne bledy powoduja wyswietlenie jedynie ostrzezenia. Na przyktad, jesli makro zawiera
niekompletne lub nieprzywotywane definicje typow lub innych makr, zostanie wyswietlony komunikat ostrzegawczy.
Po kliknigciu przycisku Apply jakiekolwiek nieskorygowane ostrzezenia spowoduja, ze po lewej stronie nazwy makra
w drzewie regut i makr w lewym panelu pojawi si¢ ikona ostrzezenia.

Zastosowanie makra nie oznacza, ze makro zostanie trwale zapisane. Zastosowanie spowoduje sprawdzanie
poprawnosci reguly i zgloszenie ewentualnych bledoéw i ostrzezen.

Zapisywanie zasobow w sesji pracy z interaktywnym pulpitem roboczym

1. Aby zapisa¢ zmiany wprowadzone w zasobach podczas sesji w interaktywnym panelu roboczym, dzigki czemu
mozna je bedzie wykorzysta¢ przy nastgpnym uruchomieniu strumienia, nalezy:

» Zaktualizowa¢ wezel modelowania, aby mie¢ pewno$¢, ze bedzie mozna uzyskac te same zasoby przy
nastegpnym uruchomieniu strumienia. Wigcej informacji zawiera temat[“Aktualizowanie weztéw modelowania i
apisywanie” na stronie 76| Nastepnie nalezy zapisaé strumien. Chcac zapisaé strumien, nalezy zrobi¢ to w
oknie glownym IBM SPSS Modeler po zmianie wgzta modelowania.
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2. Aby zapisa¢ zmiany wprowadzone w zasobach podczas sesji w interaktywnym panelu roboczym, dzigki czemu
mozna je bedzie wykorzysta¢ w innych strumieniach, nalezy:

+ Zaktualizowa¢ uzywany szablon lub utworzy¢ nowy. Wiecej informacji zawiera temat [“Tworzenie i modyfikowanie|
[szablonow” na stronie 152} Nie spowoduje to zapisania zmian dla biezacego wezta (patrz poprzedni krok).

* Lub zaktualizowa¢ uzywany pakiet TAP. Wigcej informacji zawiera temat|“Aktualizowanie pakietow analizy tekstu”|

Zapisywanie zasobow w oknie Template Editor

1. Nalezy najpierw opublikowa¢ biblioteke. Wigcej informacji zawiera temat [ ‘Publikowanie bibliotek” na stronie 171}

2. Nastegpnie nalezy zapisa¢ szablon za pomoca opcji File > Save Resource Template w menu.

Anulowanie zmian makra

1. Aby odrzuci¢ zmiany, kliknij przycisk Cancel.

Makra specjalne: mTopic, mNonLingEntities, SEP

Szablon Opinions (i jemu podobne) oraz szablony Basic Resources zawieraja dwa marka specjalne o nazwach mTopic
i mNonLingEntities.

mTopic

Domyslnie makro mTopic grupuje wszystkie zawarte w szablonie typy, ktore prawdopodobnie maja zwiazek z opinia,
takie jak nastepujace typy z biblioteki Core : <Person> (osoba), <Organization> (organizacja), <Location>
(miejsce) i tak dalej, pod warunkiem Ze typ nie jest typem opinii (na przyktad <Negative> (negatywna) lub
<Positive> (pozytywna)) badz typem zdefiniowanym jako obiekt nielingwistyczny na karcie Advanced Resources.

Za kazdym razem, gdy uzytkownik tworzy nowy typ w szablonie Opinions (lub podobnym), program zaktada, ze o ile
ten typ nie jest okreslony w innym makrze lub sekcji obiektow nielingwistycznych karty Advanced Resource, bgdzie
traktowany tak samo, jak inne typy zdefiniowane w makrze mTopic.

Zatdzmy, ze utworzyliSmy w zasobach nowe typy na podstawie szablonu Opinions: <Vegetables> (warzywa) i
<Fruit> (owoce). Nie musimy wprowadza¢ zadnych zmian, by nowe typy byly traktowane tak samo, jak typy mTopic,
mozemy wigc automatycznie ujawniac opinie pozytywne, negatywne, neutralne i kontekstowe dotyczace nowych
typow. W trakcie wyodregbniania zdanie ,,/ enjoy broccoli, but I hate grapefruit” (Lubig brokuty, ale nie cierpi¢
grejpfrutow) wygeneruje 2 wzorce wynikowe:

broccoli <Vegetables> + like <Positive>

grapefruit <Fruit> + dislike <Negative>

Jesli jednak chcemy traktowac te typy inaczej niz pozostale typy z makra mTopic, mozemy doda¢ nazwe typu do
istniejacego makra, na przyktad mPos, by zgrupowac wszystkie typy opinii pozytywnych, lub utworzy¢ nowe makro,

do ktorego bedzie si¢ mozna pozniej odwotywaé w jednej lub wielu regutach.

Wazne! Jesli utworzony zostanie nowy typ, taki jak <Vegetables>, to zostanie on uwzgledniony jako typ w makrze
mTopic, ale jego nazwa nie bedzie jawnie widoczna w definicji makra.

mNonLingEntities
Podobnie, jesli dodamy nowe obiekty nielingwistyczne w sekcji Nonlinguistic Entities karty Advanced Resources, to

beda one automatycznie przetwarzane jako typy z makra mNonLingEntities, chyba ze nakazemy inaczej. Wigcej
informacji zawiera temat [‘Obiekty nielingwistyczne” na stronie 188

SEP
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Dostepne jest takze predefiniowane makro SEP, ktére odpowiada globalnemu separatorowi zdefiniowanemu na
komputerze lokalnym, z reguly przecinkowi (,).

Praca z regutami powiazan w tekscie

Reguta analizy powiazan w tekscie to zapytanie boolowskie, ktore jest uzywane do przeprowadzenia dopasowania w
zdaniu. Reguly analizy powiazan w tekscie zawiera jeden lub wigcej z nastgpujacych argumentow: typy, makra, literaly
fancuchowe lub odstgpy migdzy wyrazami. Aby mozna byto wyodrebni¢ wyniki TLA, potrzebna jest co najmniej jedna
regula analizy powiazan w tekscie.

W edytorze regul na karcie Text Link Rules wy$wietlane sa nastgpujace obszary i pola:
Pole Name. Unikalna nazwa reguly powiazan w tekscie.

Pole Example. Opcjonalnie mozna uwzgledni¢ przyktadowe zdanie lub sekwencjg stow, ktora zostataby wychwycona
przez tg regule. Zaleca si¢ podawanie przyktadow. W edytorze mozna wygenerowac leksemy na podstawie przyktadu,
aby zobaczy¢, w jaki sposob tekst bedzie dopasowywany do reguty i jakie wyniki zostalyby wygenerowane. Leksem
jest to dowolny wyraz lub wielowyrazowa fraza zidentyfikowana w procesie wyodrgbniania. Na przyktad w zdaniu My
uncle lives in New York mechanizm wyodregbniania moze znalez¢ nastepujace leksemy: my, uncle, lives, in i new york.
Ponadto wyraz uncle (wujek) moglby zosta¢ wyodrebniony jako pojecie typu <Unknown> (nieznanego), a nazwa new
york mogtaby zosta¢ wyodrebniona jako pojecie typu <Location> (miejsce). Wszystkie pojecia sa leksemami, ale nie
wszystkie leksemy sa pojeciami. Pojecia moga by¢ takze innymi makrami, literatami tancuchowymi i odstgpami
migdzy wyrazami. Pojgciami moga by¢ tylko te wyrazy lub frazy, ktére maja przypisany typ.

Tabela Rule Value. Ta tabela zawiera elementy reguty, ktore sa uzywane w celu dopasowania reguly do zdania. Mozna
dodawac lub usuwac wiersze tabeli za pomoca przyciskow po jej prawej stronie. Tabela zawiera 3 kolumny:

* Kolumna Element. Wprowadz wartosci lub kombinacje wartosci typow, literatow tancuchowych, odstepow miedzy
wyrazami (<Any Token>) lub makr. Wigcej informacji zawiera temat[“Elementy obstugiwane w regutach i
[makrach” na stronie 210} Kliknij dwukrotnie komorke elementu, aby wprowadzi¢ informacje bezposrednio. Zamiast
tego mozna klikna¢ w komorce prawym przyciskiem myszy, aby wyswietli¢ menu kontekstowe z lista czgsto
uzywanych makr, nazw typdw i nazw typdw nielingwistycznych. Nalezy pamigtaé, ze wpisujac informacje
bezposrednio w komoéree, nalezy poprzedzi¢ nazwe typu z makra lub typu znakiem $, np. $mTopic dla makra
mTopic. Kolejnos¢ tworzenia wierszy elementow wplywa na sposob, w jaki reguta zostanie dopasowana do tekstu.
Podajac wiecej niz jeden argument, nalezy uzywac¢ nawiaséw () do grupowania argumentdw i znaku | jako
logicznego operatora LUB. Nalezy pamigtaé, ze w wartosciach rozrozniana jest wielkos¢ liter.

* Kolumna Quantity. Wskazuje minimalna i maksymalna liczbg wystapien elementu wymagana, by zostat uznany za
dopasowany. Na przyktad, jesli chcesz zdefiniowa¢ odstep (lub szereg wyrazow) o dlugosci od 0 do 3 wyrazow,
mozesz wybra¢ opcje Between 0 and 3 z listy lub wprowadzi¢ liczby bezposrednio w oknie dialogowym. Warto$cia
domyslna jest ,,Exactly 17, czyli doktadnie 1 wyraz. W niektorych przypadkach element powinien by¢ opcjonalny.
Woéwczas bedzie mial minimum réwne 0, a maksimum wigksze od 0 (tj. 0 lub 1, pomigdzy 0 i 2). Nalezy zwrocic
uwage, ze pierwszy element w regule nie moze by¢ opcjonalny, co oznacza, ze nie moze mie¢ minimum réwnego 0.

* Kolumna Example Token. Po kliknigciu przycisku Get Tokens program dzieli tekst z pola Example na leksemy i
wypetnia t¢ kolumng leksemami, ktore pasuja do elementéw zdefiniowanych przez uzytkownika. Mozna réwniez
wyswietli¢ te elementy w tabeli wynikowe;.

Tabela Rule Output Kazdy wiersz w tej tabeli definiuje sposéb, w jaki wynikowy wzorzec TLA zostanie
przedstawiony w wynikach. Wynik reguty moze zawiera¢ wzorce obejmujace maksymalnie szes¢ par kolumn
pojecie/para, z ktorych kazda reprezentuje jeden parametr. Na przyktad wzorzec typow <Location> + <Positive>
sktada si¢ z dwoch parametrow, czyli 2 par pojgcie/typ.

Uwaga: Terminy w kolumnie Element tabeli Rule Value lub w dowolnej z kolumn Concept tabeli Rule Output nie
moga zaczynac si¢ od zadnego z nast¢pujacych znakow: *, #, %, N, *, -, 5, <, >, /,\, "

Jezyk zapewnia swobode wyrazania tych samych ogolnych pojec na wiele roznych sposobow, dlatego mozesz
zdefiniowa¢ wiele roznych regut w celu wychwytywania tego samego ogolnego pojecia. Na przyktad tekst "Paris is a
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place I love" i tekst "I really, really like Paris and Florence" odzwierciedlaja to samo ogolne pojecie — ze Paryz jest
lubiany — ale wyrazone w rozny sposob. By je wychwycic, potrzeba dwdch réznych regut. Latwiej jest jednak
pracowac z wynikowymi wzorcami, jesli podobne pojecia sa pogrupowane. Z tego powodu, cho¢ mozesz mie¢ 2 rdézne
reguly wychwytujace te 2 frazy, mozesz zdefiniowac ten sam wynik dla obu regut, na przyktad jako wzorzec typow
<Location> + <Positive>. Taki wynik bedzie odzwierciedlat znaczenie obu tekstow. Jak wida¢, wyniki nie zawsze
odzwierciedlaja strukturg i kolejnosci wyrazow w tekscie oryginalnym. Ponadto taki wzorzec typow moze pasowa¢ do
innych fraz i generowac takie wzorce pojec, jak: paris + like i tokyo + like.

Aby utatwi¢ sobie szybkie i bezbledne definiowanie wynikdéw, mozna uzy¢ menu kontekstowego, aby wybiera¢
elementy, ktére maja by¢ ujete w wynikach. Mozna takze przeciagac i upuszcza¢ elementy z tabeli Rule Value do
wynikow. Na przyktad, jesli masz regute, ktora zawiera odwotanie do makra mTopic w wierszu 2 tabeli Rule Value, i
chcesz, by ta warto$¢ znalazta si¢ w wynikach, mozesz po prostu przeciagna¢ i upusci¢ element mTopic do pierwszej
pary kolumn w tabeli Rule Output. Spowoduje to automatyczne wpisanie pojgcia i typu w parze. A jesli chcesz, aby
wyniki rozpoczynaly si¢ od typu zdefiniowanego przez trzeci element (wiersz 3) z tabeli Rule Value, przeciagnij typ z
tej tabeli do komorki Type 1 w tabeli wynikowej. Tabela zostanie zaktualizowana i pojawi si¢ w niej odwotanie do
wiersza w nawiasie (3).

Mozesz takze recznie wprowadzac takie odwotania do tabeli, klikajac dwukrotnie komoérke w kolumnie Concept, a
nastepnie wprowadzajac symbol $, po ktérym nastepuje numer wiersza, na przykltad $2, aby odwotac si¢ do elementu
zdefiniowanego w wierszu 2 tabeli Rule Value. Wprowadzajac informacje recznie, nalezy rowniez zdefiniowac
kolumng Type; wprowadz symbol #, po ktorym nastgpuje numer wiersza, na przyktad #2, aby odwolac sig do
elementu zdefiniowanego w wierszu 2 tabeli Rule Value.

Mozna stosowac obie metody tacznie. Zatozmy, ze masz typ <Positive> w wierszu 4 warto$¢ tabeli Rule Value.
Mozesz przeciagna¢ go do kolumny Type 2, a nastepnie klikna¢ dwukrotnie komorke w kolumnie Concept 2, po
czym recznie wprowadzi¢ stowo not przed typem. Kolumna wynikowa zawierataby wartos¢ not (4) lub, jesli jestes
trybie edycji lub trybie kodu zrodtowego, wartos¢ not $4. Teraz mozna klikna¢ prawym przyciskiem myszy w
kolumnie Type 1 i wybrac, na przyktad, makro o nazwie mTopic. Taka definicja wyniku mogtaby wygenerowa¢ taki
wzorzec pojecia, jak: car + bad.

Wigkszos$¢ regut ma tylko jeden wiersz wynikdw, ale istnieja przypadki, gdy mozliwy i pozadany jest wigcej niz jeden
wynik. W takim przypadku nalezy zdefiniowa¢ jeden wynik na kazdy wiersz tabeli Rule Output.

Wazne: Nalezy pamigtaé, ze podczas wyodrebniania wzorcow TLA wykonywane sa takze inne operacje
lingwistyczne. Jesli wigc definicja wyniku ma warto$¢ t$3\t#3, oznacza to, ze wzorzec bedzie zawieral ostateczne
pojecie trzeciego elementu i ostateczny typ trzeciego elementu po wykonaniu kompletnego przetwarzania
lingwistycznego (wyszukiwania synonimdéw i innych operacji grupowania).

* Show output as. Domyslnie opcja References to row in Rule Value table jest zaznaczona, a wynik jest
wyswietlany przy uzyciu odwotan liczbowych do wierszy, zgodnie z definicja na karcie Rule Value. Jesli wezesniej
kliknigto opcj¢ Get Tokens i masz leksemy w kolumnie Example Tokens tabeli Rule Value, mozna wy$wietli¢
wyniki dla tych konkretnych leksemow, wybierajac odpowiednia opcje.

Uwaga: Jesli w tabeli wynikowej nie ma wystarczajacej liczby wynikowych par pojecie/typ, mozna dodaé kolejna
parg, klikajac przycisk Add na pasku narzedzi edytora. Jesli obecnie wyswietlane sa 3 pary i klikniesz przycisk Add, to
do tabeli dodane zostana 2 kolumny (Concept 4 i Type 4). Oznacza to, ze tabela wynikowa dla wszystkich regut bedzie
zawierala 4 pary. Istnieje roOwniez mozliwo$¢ usunigcia nieuzywanych par, o ile zadna z regul w zestawie regul w tej
bibliotece nie korzysta z usuwanych par.

Przyktadowa reguta

Zatézmy, ze zasoby zawieraja nastgpujace reguly analizy powiazan w tekscie oraz ze wlaczono wyodrebnianie
wynikow TLA:
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Cutput columns:

Wigwy Source

Mame: |DDDB_nut + Megative + topic

Example: |there izn't anything that | disliked sbout the product

Rule “alue table:

|Elemerd |Quarrt'rty |Example Token
1 v MSUpROrthegy Exactly 1 iznt “
2 = Ooari
anythir an a | one
3 Ehing“?)) 9 1@ v I ) Exactly 1 anything
'
4 = Between 0 and 2 that i
5 m MhEY Exactly 1 disliked o
B [ sbout | with | in ) Exactly 1 about
i = Ooari
& | et Dar1 the b
Rule Output table:
Concept 1 |Type 1 |Concept 2 Type 2 |Concept 3 Type 3
product (90 & Products (90 no dislike (51 Positi.

Showy output as: @ References to rovw in Rule Value table @ Specific token from example

Rysunek 42. Karta Text Link Rules: edytor regut

Przy kazdym wyodrgbnianiu mechanizm wyodrebniania odczyta kazde zdanie i sprobuje przeprowadzi¢ dopasowanie

zgodnie z nastgpujaca sekwencja:

Tabela 44. Przyktad sekwencji wyodrebniania

Element Opis argumentow
(wiersz)
1 Pojecie z jednego z typdw reprezentowanych przez makra mPos lub mNeg albo z typu <Uncertain>.
2 Pojecie, ktéoremu przypisano jeden z typow reprezentowanych przez makro mTopic.
3 Jeden z wyrazdw reprezentowanych przez makro mBe.
4 Opcjonalny element, 0 lub 1 wyraz, tzw. odstep miedzy wyrazami lub <Any Token>
5 Pojecie, ktéremu przypisano jeden z typéw reprezentowanych przez makro mTopic.

W tabeli wynikowej widzimy, ze od reguly oczekuje si¢ wzorca, ktory obejmuje pojecia lub typy odpowiadajace makru
mTopic zdefiniowane w wierszu 5 tabeli Rule Value + pojecia lub typy odpowiadajace makru mPos, mNeg badz
typowi <Uncertain> zdefiniowane w wierszu 1 tabeli Rule Value. Wzorcem tym moze by¢: sausage + like lub

<Unknown> + <Positive>.

Tworzenie i edytowanie regut

Mozna tworzy¢ nowe reguty lub edytowac istniejace. Nalezy przestrzega¢ wskazowek i opisow wiasciwych dla edytora

regut. Wigcej informacji zawiera temat[“Praca z regutami powiazan w tekscie” na stronie 205|

Tworzenie nowych regut

1. Z menu wybierz opcje Tools > New Rule. Mozna tez klikna¢ ikong New role na pasku narzgdzi drzewa, aby

otworzy¢ nowa regute w edytorze.

2. Wprowadz unikalna nazwe i zdefiniuj elementy wartosci reguly.
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3. Po zakonczeniu kliknij przycisk Apply, aby sprawdzi¢, czy nie wystapity bledy.

Edytowanie regut

1. Kliknij nazwe reguly w drzewie. Reguta zostanie otwarta w panelu edycji po prawej stronie.
2. Wprowadz zmiany.

3. Po zakonczeniu kliknij przycisk Apply, aby sprawdzi¢, czy nie wystapity btedy.

Wytaczanie i usuwanie regut
Wylaczanie regut

Jesli cheesz, aby reguta bylta ignorowana podczas przetwarzania, mozesz ja wyltaczy¢. Nalezy zachowaé ostrozno$é¢
podczas usuwania i wytaczania regut.

1. Kliknij nazwe reguty w drzewie. Reguta zostanie otwarta w panelu edycji po prawe;j stronie.
2. Kliknij prawym przyciskiem myszy na nazwie.

3. Z menu kontekstowego wybierz opcje Disable. Ikona reguly staje sig szara, a sama regula staje si¢ nieedytowalna.
Usuwanie regut

Jesli cheesz sig pozby¢ reguty, mozesz ja usunaé. Nalezy zachowac ostroznos¢ podczas usuwania i wytaczania regut.
1. Kliknij nazwe reguly w drzewie. Reguta zostanie otwarta w panelu edycji po prawej stronie.

2. Kliknij prawym przyciskiem myszy na nazwie.

3. Z menu kontekstowego wybierz opcj¢ Delete. Reguta zniknie z listy.

Sprawdzanie, zapisywanie i anulowanie

Stosowanie zmian w regutach

Po kliknigciu poza edytorem reguty lub wybraniu opcji Apply reguta jest automatycznie przegladana w poszukiwaniu
btedow. Jesli zostanie znaleziony btad, nalezy wyeliminowac go przed przejsciem do innej czgsci aplikacji.

Jednak mniej powazne bledy powoduja wyswietlenie jedynie ostrzezenia. Na przyktad, jesli reguta zawiera
nickompletne lub nieprzywolywane definicje typow lub makr, zostanie wyswietlony komunikat ostrzegawczy. Po
kliknigciu przycisku Apply jakiekolwiek nieskorygowane ostrzezenia spowoduja, ze po lewej stronie nazwy makra w
drzewie regut i makr w lewym panelu pojawi si¢ ikona ostrzezenia.

Zastosowanie reguly nie oznacza, ze regula zostanie trwale zapisana. Zastosowanie spowoduje sprawdzanie
poprawnosci reguly i zgltoszenie ewentualnych bledow i ostrzezen.

Zapisywanie zasobow w sesji pracy z interaktywnym pulpitem roboczym

1. Aby zapisa¢ zmiany wprowadzone w zasobach podczas sesji w interaktywnym panelu roboczym, dzigki czemu
mozna je bedzie wykorzysta¢ przy nastgpnym uruchomieniu strumienia, nalezy:

» Zaktualizowa¢ wezet modelowania, aby mie¢ pewnos$¢, ze bedzie mozna uzyskac te same zasoby przy
nastepnym uruchomieniu strumienia. Wigcej informacji zawiera temat |“Aktualizowanie wezlow modelowania i
[zapisywanie” na stronie 76| Nastepnie nalezy zapisa¢ strumien. Chcac zapisaé strumien, nalezy zrobié to w
oknie glownym IBM SPSS Modeler po zmianie w¢zta modelowania.

2. Aby zapisa¢ zmiany wprowadzone w zasobach podczas sesji w interaktywnym panelu roboczym, dzigki czemu
mozna je bedzie wykorzysta¢ w innych strumieniach, nalezy:
» Zaktualizowa¢ uzywany szablon lub utworzy¢ nowy. Wigcej informacji zawiera temat
[modyfikowanie szablonéw” na stronie 152| Nie spowoduje to zapisania zmian dla biezacego wezla (patrz
poprzedni krok).

* Lub zaktualizowaé¢ uzywany pakiet TAP. Wigcej informacji zawiera temat[“Aktualizowanie pakietow analizy|
ftekstu” na stronie 129|
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Zapisywanie zasobow w oknie Template Editor

1. Nalezy najpierw opublikowa¢ biblioteke. Wigcej informacji zawiera temat [ ‘Publikowanie bibliotek” na stronie 171}

2. Nastgpnie nalezy zapisa¢ szablon za pomoca opcji File > Save Resource Template w menu.

Anulowanie zmian w regutach

1. Aby odrzuci¢ zmiany, kliknij przycisk Cancel w panelu edytora.

Kolejnos¢ przetwarzania regut

Jesli podczas wyodrgbniania prowadzona jest analiza powiazan w tekscie, ,,zdanie” (klauzula, wyraz, fraza) bedzie
dopasowywane do kolejnych regut, dopdki nie zostanie stwierdzona zgodnos¢ lub nie zostanie zbadania ostatnia reguta.
Potozenie w drzewie okresla kolejnos¢, w jakiej reguly sa badane. Zgodnie ze sprawdzona procedura reguty nalezy
uporzadkowac¢ od najbardziej zawezajacych do najbardziej ogolnych. Najbardziej zawgzajace reguty powinny by¢
umieszczone w gornej czesci drzewa. Aby zmieni¢ polozenie konkretnej reguty lub zestawu regul, wybierz opcje Move
up lub Move down z menu kontekstowego drzewa regut i makr albo uzyj przyciskow strzalek w gére i w dot na pasku
narzedzi.

W widoku zrodiowym nie mozna zmieni¢ kolejnosci regut, przenoszac je w edytorze. Im wyzej reguta jest wyswietlana
w widoku zrodtowym, tym wczesniej bedzie przetwarzana. Zaleca si¢ zmienianie kolejnosci regul wytacznie w
drzewie, co pozwoli unikna¢ problemow z kopiowaniem/wklejaniem.

Wazne! W poprzednich wersjach produktu IBM SPSS Modeler Text Analytics wymagane byly unikalne, liczbowe
identyfikatory regul. Poczawszy od wersji 18.1.1 mozna jedynie wskaza¢ kolejnos¢ przetwarzania poprzez
przenoszenie reguty w gore lub w dot w drzewie lub przez okreslenie ich pozycji w widoku zrédta.

Zalézmy na przyktad, ze tekst zawiera nastgpujace dwa zdania:

1 love anchovies

1 love anchovies and green peppers

Dodatkowo przyjmijmy, ze istnieja dwie reguly analizy powiazan w teks$cie z nastgpujacymi wartosciami:

I Element |Guarrt'rt\,f Example Token
1 = Positive |Exactly 1
2 o MDet Ooari
3 v MTopic Exactly 1
4
3
E
i
Element |Guarrt'rty Example Token
1 = Positive |Exxactly 1
2 o MDet Ooari
3 m MTopic Exactly 1
4 [ p@SEP | and | ar ) Hqor2
B m MDet Dort
E o MTopic Exactly 1
i

Rysunek 43. 2 regutly przyktadowe

W widoku zrédtowym warto$ci reguly moga wyglada¢ nastepujaco:
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A: value = $Positive $mDet? $mTopic

B: value = $Positive $mDet? $mTopic ($SEP|and|or){1,2} $mDet? $mTopic

Jesli reguta A jest wyzej w drzewie niz reguta B, to reguta A bedzie przetwarzana jako pierwsza, a pierwsze zdanie /
love anchovies and green peppers zostanie dopasowane do $Positive $mDet? $mTopic i wygeneruje niekompletny

wzorzec wynikowy (anchovies + like), poniewaz regula nie szukata 2 dopasowan do $mTopic.

Dlatego, aby wychwyci¢ prawdziwe znaczenie tekstu, najbardziej zawezajaca reguta, w tym przypadku B, musi zosta¢
umieszczona wyzej w drzewie niz regula bardziej ogdlna, w tym przypadku A.

Praca z zestawami regut (wiele przejsc¢)

Zestawy regut sa przydatnym rozwiazaniem do grupowania pokrewnych regut w drzewie regut i makr, pozwalajacym
na przetwarzanie danych w wielu przejsciach. Definicja zestawu regut sktada sig tylko z jego nazwy i stuzy do
porzadkowania regut w uzytecznych grupach. W niektorych kontekstach tekst jest zbyt skomplikowany i
zréznicowany, by mozna byto go przetworzy¢ w jednym przejsciu. Na przyktad tekstowe dane wywiadowcze moga
zawiera¢ informacje o powiazaniach migdzy osobami, ktore dadza si¢ ujawni¢ na podstawie metody kontaktu (x
zadzwonit do y), relacji rodzinnych (v jest szwagrem x), transakcji pienigznych (x przelal 1000 zi na konto y) i tak dale;j.
W takim przypadku przydatna jest mozliwo$¢ tworzenia specjalnych zestawow regut analizy powiazan w tekscie, z
ktérych kazda dotyczy¢ bedzie okreslonego rodzaju relacji, np. ujawniania kontaktow, ujawniania powiazan rodzinnych
itd.

Aby utworzy¢ zestaw regul, wybierz opcje ,,Create Rule Set” z menu kontekstowego drzewa regut i makr lub z paska
narzedzi. Mozna teraz tworzy¢ nowe reguly bezposrednio pod weztem zestawu regut w drzewie i przenosic istniejace
reguly do zestawu regut.

Podczas wyodrgbniania z uzyciem zasobdw, w ktdrych reguty sa pogrupowane w zestawy, mechanizm wyodrgbniania
musi wielokrotnie przechodzi¢ przez tekst, aby w kazdym przejsciu dopasowywac inny rodzaj wzorcow. W ten sposob
jedno ,,zdanie” moze by¢ dopasowane do kazdej reguty w zestawie regut, a bez zestawu regut byloby dopasowane
tylko do jednej reguty.

Uwaga: Jeden zestaw moze zawiera¢ maksymalnie 512 regut.

Tworzenie nowych zestawow regut

1. Z menu wybierz kolejno opcje Tools > New Rule Set. Zamiast tego mozesz klikna¢ ikong New Rule Set na pasku
narzedzi drzewa. Zestaw regut pojawi si¢ w drzewie regul.

2. Dodaj nowe reguty do tego zestawu lub przenie$ do niego istniejace reguty.

Wylaczanie zestawow regut
1. Kliknij prawym przyciskiem myszy nazwg zestawu regut w drzewie.

2. Z menu kontekstowego wybierz opcj¢ Disable. Zestaw regut stanie sig szary, a wszelkie zawarte w nim reguly
takze beda wyltaczone i ignorowane podczas przetwarzania.

Usuwanie zestawow regut
1. Kliknij prawym przyciskiem myszy nazwg zestawu regut w drzewie.

2. Z menu kontekstowego wybierz opcje Delete. Zestaw regut i zawarte w nim reguly zostana usunigte z zasobow.

Elementy obstugiwane w regutach i makrach

Jako wartosci parametrow w regutach analizy powiazan w tekscie oraz makrach dopuszczalne sa nastgpujace
argumenty:

Makra
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Makra mozna uzy¢ bezposrednio w regule analizy powiazan w tekscie lub w innym makrze. Jesli wprowadzasz nazwe
makra r¢eznie lub w widoku zrodtowym (a nie wybierasz jej z menu kontekstowego), koniecznie poprzedz ja znakiem
dolara ($), na przyktad $mTopic. W nazwach makr rozrézniana jest wielkos¢ liter. W menu kontekstowych mozna
wybiera¢ dowolne makra zdefiniowane w danej chwili na karcie Text Link Rules.

Typy

Mozna pisa¢ bezposrednio w tresci reguly analizy powiazan w tekscie lub w makrze. Jesli wprowadzasz nazwe typu
recznie lub w widoku zrodtowym (a nie wybierasz jej z menu kontekstowego), koniecznie poprzedz ja znakiem dolara
($), na przyktad $Person. W nazwach typow rozrézniana jest wielko$¢ liter. Korzystajac z menu kontekstowego,
mozesz wybra¢ dowolny typ z obecnie uzywanego zestawu zasobow.

Proba odwotania si¢ do nierozpoznanego typu spowoduje wyswietlanie komunikatu ostrzegawczego, a do czasu
wyeliminowania problemu obok reguty w drzewie regut i makr widoczna bedzie ikona ostrzezenia.

Literaty fancuchowe

Aby uwzgledni¢ informacje, ktore nigdy nie zostaly wyodrebnione z analizowanego tekstu, mozna zdefiniowac literat
tancuchowy, a mechanizm wyodrgbniania bedzie poszukiwat tego literatu. Wszystkim wyodrebnionym wyrazom lub
frazom przepisane zostaty typy i dlatego nie mozna ich uzywaé w literatach fancuchowych. Jesli uzyjesz wyrazu, ktory
zostal wyodrgbniony, to zostanie on zignorowany, nawet jesli ma przypisany typ <Unknown>.

Literat tancuchowy moze sktadac si¢ z jednego lub wigkszej liczby stow. Przy definiowaniu listy literatow

fancuchowych obowiazuja nastgpujace reguty:

» Liste tancuchow nalezy uja¢ w nawiasy, np. (his). Chcac wskazac kilka alternatywnych literatéw tancuchowych,
nalezy rozdzieli¢ je separatorem LUB, na przyktad (alan|the) lub (his|hers|its).

* Mozna uzywa¢ wyrazoéw prostych lub ztozonych.

* Wyrazy na liscie nalezy rozdziela¢ znakiem |, ktory petni funkcjg logicznego operatora LUB.

 Jesli cheesz wyszukiwac zarowno forme pojedyncza, jak i mnoga, wprowadz obie. Program nie generuje
automatycznie roznych form gramatycznych wyrazu.

* Uzywaj tylko matych liter.

* Aby wielokrotnie uzywac¢ tych samych literalow tancuchowych, zdefiniuj je jako makro i uzywaj tego makra w
innych makrach i regulach analizy powiazan w tekscie.

* Jesli tancuch zawiera kropki lub taczniki, to nalezy uwzgledni¢ je w literale. Na przyktad, aby wyszukiwaé w tekscie
taricuch a.k.a, wprowadz literalnie litery i kropki: a.k.a.

Operator wykluczenia

Znak ! stuzy jako operator wykluczenia, ktory powoduje, Ze zanegowane w ten sposob wyrazenie nie zajmie
okreslonego miejsca. Operator wykluczenia mozesz doda¢ wytacznie recznie, bezposrednio edytujac komorke (kliknij
komorke dwukrotnie w tabeli Rule Value lub Macro Value table) lub w widoku zrédtowym. Na przyktad, jesli do
reguly analizy powiazan w tekécie dodasz zapis $mTopic @{0,2} !|($Positive) $Budget, to program bedzie
wyszukiwat teksty zawierajace (1) termin przypisany do dowolnego z typéw w makrze mTopic, (2) odstep migdzy
wyrazami o dhlugosci od zera do dwdch wyrazow, (3) nie bedzie wyszukiwat instancji terminu przypisanego do typu
<Positive>, (4) termin przypisany do typu <Budget>. Taka reguta moze wychwyci¢ "cars have an inflated price tag"
(samochody o zawyzonych cenach), ale zignorowalaby frazg "store offers amazing discounts" (sklep oferuje
fantastyczne znizki).

Aby skorzystac z tego operatora, nalezy recznie wpisa¢ wykrzyknik i nawiasy do komorki elementu, po uprzednim
dwukrotnym kliknigciu tej komorki.

Odstepy migdzy wyrazami (<Any Token>)
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Odstep miedzy wyrazami, okreslany tez symbolem <Any Token> definiuje przedziat liczby leksemdw, ktore moga by¢
obecne migedzy dwoma elementami. Odstgpy miedzy wyrazami sa przydatne przy dopasowywaniu bardzo podobnych
fraz, ktore moga rézni¢ si¢ tylko nieznacznie ze wzgledu na obecnos$¢ dookreslnikow, przedimkow, przymiotnikdw lub
innych podobnych wyrazow.

Tabela 45. Przykiad elementéw w tabeli Rule Value bez odstepu miedzy wyrazami

# Element

! E
Nieznane

2 CHE
mBeHave

3 £
Dodatnie

Uwaga: W widoku zrédlowym ta warto$¢ jest zdefiniowana jako: $Unknown $mBeHave $Positive

Pasuje ona zdania takie jak "the hotel staff was nice”, gdzie hotel staff nalezy do typu <Unknown>, was nalezy do
makra mBeHave, a nice ma typ <Positive>. Ale nie znajdzie zdania “the hotel staff was very nice”.

Tabela 46. Przyktad elementdw w tabeli Rule Value z odstepem miedzy wyrazami ( <Any Token>)

# Element

! £
Nieznane

2 EHE
mBeHave

3 =

4 i ]
Dodatnie

Uwaga: W widoku zrédlowym ta warto$¢ jest zdefiniowana jako: $Unknown $mBeHave @{0,1} $Positive

Jesli do reguty dodasz odstep migdzy wyrazami, reguta znajdzie zaréwno zdanie “the hotel staff was nice”, jak i zdanie
“the hotel staff was very nice”.

W widoku zrédtowym lub podczas bezposredniej edycji odstgp migdzy wyrazami oznaczony jest jako @{#,#}, gdzie
@ oznacza odstep migdzy wyrazami, a {#,#} okresla minimalna i maksymalna liczbg wyrazéw migdzy
poprzedzajacym a nastgpujacym elementem. Na przyktad @{1,3} powoduje, ze dwa okreslone elementy zostana
znalezione, jesli miedzy nimi znajduje si¢ co najmniej jeden wyraz, ale nie wigcej niz trzy wyrazy. @{0,3} powoduje,
ze dwa okreslone elementy zostana znalezione, jesli migdzy nimi znajduje si¢ 0, 1, 2 lub 3 wyrazy, ale nie wigcej niz
trzy.
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Przegladanie i praca w trybie zrédtowym

Dla kazdej reguty i makra edytor TLA generuje bazowy kod zrdédlowy, ktdry jest uzywany przez mechanizm
wyodrebniajacy do dopasowywania i generowania wynikow analizy TLA. Jesli preferujesz pracg bezposrednio z
kodem, mozesz wyswietli¢ ten kod zrédlowy i1 edytowaé go bezposrednio. W tym celu kliknij przycisk ,,View Source”
w gornej czgsci edytora. Nastapi przejscie do aktualnie wybranej reguty lub makra i pod$wietlenie tego elementu.
Jednak zaleca sig korzystanie z paneli edytora, co ograniczy ryzyko popetnienia bigdow.

Po zakonczeniu przegladania lub edycji zrédta kliknij opcje Exit Source. Jesli wprowadzisz niepoprawna sktadnig
reguly, trzeba bedzie ja skorygowac przed wyjsciem z widoku zrédlowego.

Wazne: W przypadku edycji w widoku zrédtowym zdecydowanie zaleca si¢ edytowanie regul i makr pojedynczo. Po
zakonczeniu edycji makra nalezy sprawdzi¢ poprawnos$¢ wynikow, przeprowadzajac wyodrebnianie. Jesli wynik jest
zadowalajacy, zaleca si¢ zapisanie szablonu przed wprowadzeniem nast¢pnej zmiany. Jesli wynik jest niezadowalajacy
lub wystapit btad, nalezy przywroci¢ zapisane zasoby.

Makra w widoku zrodtowym

[macro]
name = nazwa_makra
value = ([type_name|macro_name|literal string|word gap])

Tabela 47. Wpisy makr

[macro] Kazde makro musi zaczynac si¢ od wiersza ze stowem [macro], ktére wyznacza poczatek makra.
name Nazwa definicji makra. Kazda nazwa musi by¢ unikalna.
value Kombinacja jednego lub wigkszej liczby typow, literalow tancuchowych, odstepow migdzy wyrazami lub

makr. Wiecej informacji zawiera[“Elementy obstugiwane w regutach i makrach” na stronie 210} Wprowadzajac
wigcej niz jeden argument, nalezy uzywac nawiasow () do zgrupowania argumentow lub znaku |
oznaczajacego logiczne LUB.

Oprocz wskazowek i zasad sktadniowych przedstawionych w sekcji dotyczacej makr z praca w widoku zrodtowym
wiaze si¢ koniecznos¢ przestrzegania kilku dodatkowych wytycznych, ktore nie sa wymagane podczas pracy w widoku
edytora. Podczas pracy z makrami w trybie kodu zrodtowego nalezy tez przestrzegac nastepujacych zasad:

* Kazde makro musi zaczyna¢ si¢ od wiersza ze stowem [macro], ktére wyznacza poczatek makra.

* Aby wylaczy¢ element, nalezy umieséci¢ wskaznik komentarza (#) na poczatku wiersza.

Przyklad. W tym przykladzie zdefiniowano makro o nazwie mTopic. mTopic oznacza obecno$¢ terminu pasujacego
do jednego z nastgpujacych typoéw: <Product>, <Person>, <Location>, <Organization>, <Budget> lub
<Unknown>.

[macro]

name=mTopic

value=($Unknown|$Product|$Person|$Location|$0rganization|$Budget|$Currency)

Reguty w widoku zrédtowym

[pattern(ID)]

name = nazwa_wzorca

value = [$nazwa_typu|nazwa_makra|odstepy miedzy wyrazami|literaty traficuchowe]
output = $digit[\t]#digit[\t]$digit[\t]#digit[\t]$digit[\t]#digit[\t]

Tabela 48. Wpisy regut

[pattern (<ID>)] | Wskazuje poczatek tej reguly analizy powiazan w tekscie i udostgpnia unikalny identyfikator liczbowy
okreslajacy kolejnos¢ przetwarzania.

name Okresla unikalna nazwg tej reguly analizy powiazan w tekscie.
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Tabela 48. Wpisy regut (kontynuacja)

value Okresla sktadnig i argumenty, ktdre maja by¢ dopasowywane do tekstu. Wigcej informacji zawiera temat
[Elementy obstugiwane w regutach i makrach” na stronie 210]

wyniki Format wyjsciowy dla wynikowych wzorcow wykrytych w tekscie. Wyniki nie zawsze odzwierciedlaja
doktadne pozycje pierwotnych elementow w tekscie zrodtowym. Ponadto mozna zdefiniowac wiersze
wynikow dla jednej reguly analizy powiazan w tekscie, umieszczajac kazdy wynik w osobnym wierszu.

Sktadnia wynikow:
* Wyniki nalezy oddziela¢ kodem tabulacji \t, na przyktad $1\t#1\t$3\t#3

* $ i numer oznacza termin pasujacy do argumentu zdefiniowanego w parametrze o tym numerze. Zatem $1
oznacza termin pasujacy do pierwszego argumentu zdefiniowanego dla wartosci.

* #1inumer oznacza nazwg typu elementu na tej pozycji. Jesli element jest lista literatéw tancuchowych,
przypisany zostanie typ <Unknown>.

» Wartos¢ Nul\Null nie spowoduje utworzenia zadnych wynikow.

Oprocz wskazowek i zasad sktadniowych przedstawionych w sekcji dotyczacej regut z praca w widoku zrodtowym
wiaze si¢ koniecznos¢ przestrzegania kilku dodatkowych wytycznych, ktore nie sa wymagane podczas pracy w widoku
edytora. Podczas pracy z regutami w trybie kodu zrodtowego nalezy tez przestrzegac nastepujacych zasad:

* Definiujac dwa lub wigksza liczbg elementow, nalezy ujac je w nawiasy, niezaleznie od tego, czy sa opcjonalne (na
przyktad ($Negative|$Positive) ub ($mCoord|$SEP)?). $SEP oznacza przecinek.

* Pierwszy element w regule analizy powiazan w tekscie nie moze by¢ opcjonalny. Na przyktad nie mozna rozpoczac¢
od value = $mTopic? ani value = @{0,1}.

* Mozliwe jest powiazanie ilosci (lub liczby wystapien) z leksemem. Jest to przydatne, jesli chcemy zdefiniowac jedna
regule, ktora obejmuje wszystkie przypadki, zamiast pisa¢ osobne reguly dla kazdego przypadku. Na przyktad,
mozna uzy¢ literatu fancuchowego ($SEP|and), probujac znalez¢ , (przecinek) albo wyraz and. Jesli uzupelnisz
definicje o ilos¢, literal przyjmie posta¢ ($SEP|and){1,2} i pasuje do kazdego z nastepujacych wystapien: "," "and"
u, andll.

* Miedzy nazwa makra a znakami $ 1 ? nie sa dozwolone spacje w warto$ci reguty analizy powiazan w tekscie.

* Spacje nie sa dozwolone w definicji wynikdw reguty analizy powiazan w tekscie.

* Aby wylaczy¢ element, nalezy umiesci¢ wskaznik komentarza (#) na poczatku wiersza.

Przyklad. Zatozmy, ze zasoby zawieraja nastgpujaca reguly analizy TLA oraz ze wlaczono wyodrgbnianie wynikow
TLA:

## Jean Doe was the former HR director of IBM in France
[pattern(201)]

name= 1 201

value = $Person ($SEP|$mDet|$mSupport|as|then){1,2} @{0,1} $Function
(of [with|for|in|to|at) @{0,1} $0Organization @{0,2} $Location

output = $INt#I\t$A\t#4\tE7\t#7\t$9\t#9

Przy kazdym wyodregbnianiu mechanizm wyodrebniania odczyta kazde zdanie i sprobuje przeprowadzi¢ dopasowanie
zgodnie z nastgpujaca sekwencja:

Tabela 49. Przyktad sekwencji wyodrebniania

Pozycji w Opis argumentéw
zbiorze
1 Nazwisko osoby ($Person),
2 Jeden albo dwa sposrod nastepujacych elementow: przecinek ($SEP), okreslnik ($mDet), czasownik pomocniczy

($mSupport), fancuchy ,,then” lub ,,as”,
0 lub 1 wyraz (@{0,1})
Funkcja ($Function)
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Tabela 49. Przyktad sekwencji wyodrebniania (kontynuacja)

Pozycji w Opis argumentow
zbiorze
5 Jeden z nastepujacych tancuchow: ,,0f”, ,with”, . for”, .in”, ,.t0” lub ,,at”,
6 0 lub 1 wyraz (@{0,1})
7 Nazwa organizacji ($Organization)
8 0, 1 lub 2 wyrazy (@{0,2})
9 Nazwa miejsca ($Location)

Ta reguta analizy powiazan w tekscie znalaztaby takie zdania Iub frazy, jak:
Jean Doe, the HR director of IBM in France

Jean Doe was the former HR director of IBM in France

IBM appointed Jean Doe as the HR director of IBM in France

Ta przyktadowa reguta analizy powiazan w tekscie wygenerowataby nastgpujace wyniki:
jean doe <Person> hr director <Function> ibm <Organization> france <Location>

Gdzie:

* jean doe odpowiada elementowi $1 (pierwszemu elementowi reguty TLA), a <Person> to typ terminu jean doe
(#1),

* hr director to termin odpowiadajacy elementowi $4 (4. elementowi w regule TLA), a <Function> to typ terminu hr
director (#4),

* ibm to termin odpowiadajacy $7 (7. element 7 w regule TLA), a <Organization> to typ terminu ibm. (#7),

« france to termin odpowiadajacy elementowi $9 (9. elementowi w regule TLA), a <Location> to typ terminu france
#9).

Zestawy regut w widoku zrédtowym
[set(<ID>)]

Gdzie [set (<ID>)] oznacza poczatek zestawu regut i zawiera unikalny identyfikator liczbowy okreslajacy kolejnos¢
przetwarzania zestawow.

Przyklad. Nastepujace zdanie zawiera informacje na temat osob, ich funkcji w ramach firmy, a takze aktywnosci firmy
w obszarze fuzji/przejec.

Org1 Inc has entered into a definitive merger agreement with Org2 Ltd, said John Doe, CEO of Org2 Ltd.

Mozna zapisa¢ jedna regute z kilkoma wynikami, by uwzgledni¢ wszystkie mozliwe wyniki, na przyktad:

## Orgl Inc entered into a definitive merger agreement with Org2 Ltd, said
John Doe, CEO of Org2 Ltd.

[pattern(020)]

name=020

value = $0rganization @{0,4} $ActionNouns @{0,6} $mOrg @{1,2}
$Person @{0,2} $Function @{0,1} $Organization

output = $I\t#1\t$3\t#3\t§5\t#5

output = $7\t#7\t$9\t#9\t$11\t#11

co spowoduje wygenerowanie nastgpujacych 2 wzorcéw wynikowych:
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» org1 inc<Organization> + merges with <ActiveVerb> + org2 Iltd<Organization>
* john doe <Person> + ceo <Function> + org2 Itd<Organization>

Wazne! Nalezy pamigtac, ze podczas wyodregbniania wzorcow TLA wykonywane sa takze inne operacje lingwistyczne.
W tym przypadku na etapie grupowania synonimow termin merger zostanie zgrupowany z terminem merges with. A
poniewaz merges with nalezy do typu <ActiveVerb>, to ta nazwa typu pojawi sie w ostatecznym wynikowym wzorcu
TLA. Jesli wiec definicja wyniku ma warto$¢ t$3\t#3, oznacza to, ze wzorzec bedzie zawierat ostateczne pojecie
trzeciego elementu i ostateczny typ trzeciego elementu po wykonaniu kompletnego przetwarzania lingwistycznego
(wyszukiwania synonimdw i innych operacji grupowania).

Zamiast pisa¢ skomplikowane reguty, takich jak przedstawiona powyzej, czgsto tatwiej jest operowac na dwdch
regutach. Pierwsza bedzie wyspecjalizowana wyszukiwaniu wzmianek o fuzjach i przejeciach:

[set(1)]

## Orgl Inc has entered into a definitive merger agreement with Org2 Ltd

[pattern(44)]

name=firm + action + firm_0044

value=$mOrg @{0,20} $ActionNouns @{0,6} $mOrg

output (1)=$1\t#1\t$3\t#3\t$5\t#5

i zwroci org1 inc<Organization> + merges with <ActiveVerb> + org2 Itd <Organization>

Druga bedzie wyspecjalizowana w wyszukiwaniu osob/funkcji/firm:

[set(2)]

## said John Doe, CEQ of Org2 Ltd

[pattern(52)]

name=individual + role + firm_0007

value=$Person @{0,3} $mFunction (at|of)? ($mOrg]|$Media|$Unknown)
output (1)=$1\t#1\t$3\tFunction\t$5\t#5

i zwroci john doe <Person> + ceo <Function> + org2 ltd <Organization>
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Uwagi
Informacje te zostaty opracowane dla produktow i ustug oferowanych na catym $wiecie.

Produktow, ushug lub opcji opisywanych w tym dokumencie IBM nie musi oferowac¢ we wszystkich krajach.
Informacje o produktach i ustugach dostgpnych w danym kraju mozna uzyskac¢ od lokalnego przedstawiciela IBM.
Odwotanie do produktu, programu lub ustugi IBM nie oznacza, ze mozna uzy¢ wytacznie tego produktu, programu lub
ustugi IBM. Zamiast nich mozna zastosowac¢ ich odpowiednik funkcjonalny pod warunkiem, ze nie narusza to praw
wtasnosci intelektualnej IBM. Jednakze cata odpowiedzialno$¢ za oceng przydatnosci i sprawdzenie dzialania
produktu, programu lub ustugi pochodzacych od producenta innego niz IBM spoczywa na uzytkowniku.

IBM moze posiada¢ patenty lub ztozone wnioski patentowe na towary i ustugi, o ktorych mowa w niniejszej publikacji.
Przedstawienie niniejszej publikacji nie daje zadnych uprawnien licencyjnych do tychze patentow. Pisemne zapytania
w sprawie licencji mozna przesyta¢ na adres:

IBM Director of Licensing
IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

U.S.A.

Zapytania dotyczace zestawow znakow dwubajtowych (DBCS) nalezy kierowac do lokalnych dziatéw whasnosci
intelektualnej IBM (IBM Intellectual Property Department) lub wysta¢ je na pismie na adres:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokio 103-8510, Japonia

INTERNATIONAL BUSINESS MACHINES CORPORATION DOSTARCZA TE PUBLIKACJE W STANIE, W
JAKIM SIE ZNAJDUIJE ("AS IS") BEZ UDZIELANIA JAKICHKOLWIEK GWARANCII (REKOJMIE ROWNIEZ
WYLACZA SIE), WYRAZNYCH LUB DOMNIEMANYCH, A W SZCZEGOLNOSCI DOMNIEMANYCH
GWARANCIJI PRZYDATNOSCI HANDLOWEJ, PRZYDATNOSCI DO OKRESLONEGO CELU ORAZ
GWARANCIJI, ZE PUBLIKACJA TA NIE NARUSZA PRAW OSOB TRZECICH. Ustawodawstwa niektorych
krajow nie dopuszczaja zastrzezen dotyczacych gwarancji wyraznych lub domniemanych w odniesieniu do pewnych
transakcji; w takiej sytuacji powyzsze zdanie nie ma zastosowania.

Informacje zawarte w niniejszej publikacji moga zawiera¢ niescistosci techniczne lub bledy drukarskie. Informacje te
sa okresowo aktualizowane, a zmiany te zostana uwzglednione w kolejnych wydaniach tej publikacji. IBM zastrzega
sobie prawo do wprowadzania ulepszen i/lub zmian w produktach i/lub programach opisanych w tej publikacji w
dowolnym czasie, bez wczesniejszego powiadomienia.

Wszelkie wzmianki w tej publikacji na temat stron internetowych innych podmiotow zostaly wprowadzone wylacznie
dla wygody uzytkownika i w zadnym wypadku nie stanowia zachety do ich odwiedzania. Materiaty dostepne na tych
stronach nie sa czgscia materiatdéw opracowanych dla tego produktu IBM, a uzytkownik korzysta z nich na wlasna
odpowiedzialnos¢.

IBM ma prawo do uzywania i rozpowszechniania informacji przystanych przez uzytkownika w dowolny sposob, jaki
uzna za wlasciwy, bez zadnych zobowiazan wobec ich autora.
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Licencjobiorcy tego programu, ktorzy chcieliby uzyskaé¢ informacje na temat programu w celu: (i) wdrozenia wymiany
informacji migdzy niezaleznie utworzonymi programami i innymi programami (facznie z tym opisywanym) oraz (ii)
wspolnego wykorzystywania wymienianych informacji, powinni skontaktowacé si¢ z:

IBM Director of Licensing
IBM Corporation

North Castle Drive, MD-NCI119
Armonk, NY 10504-1785

U.S.A.

Informacje takie moga by¢ udostegpnione, o ile spelnione zostana odpowiednie warunki, w tym, w niektorych
przypadkach, zostanie uiszczona stosowna optata.

Licencjonowany program opisany w niniejszej publikacji oraz wszystkie inne licencjonowane materiaty dostgpne dla
tego programu sa dostarczane przez IBM na warunkach okreslonych w Umowie IBM z Klientem, Migdzynarodowe;j
Umowie Licencyjnej IBM na Program lub w innych podobnych umowach zawartych miedzy IBM i uzytkownikami.

Dane dotyczace wydajnosci i cytowane przyktady zostaly przedstawione jedynie w celu zobrazowania sytuacji.
Faktyczne wyniki dotyczace wydajnosci moga si¢ r6zni¢ w zalezno$ci do konkretnych warunkéw konfiguracyjnych i
operacyjnych.

Informacje dotyczace produktow innych podmiotéw niz IBM zostaty uzyskane od dostawcow tych produktow, z ich
publicznych ogtoszen lub innych dostgpnych publicznie zrodet. IBM nie testowal tych produktow i nie moze
potwierdzi¢ doktadnosci pomiarow wydajnosci, kompatybilnosci ani zadnych innych danych zwiazanych z tymi
produktami. Pytania dotyczace mozliwosci produktéw innych podmiotow nalezy kierowa¢ do dostawcdw tych
produktow.

Wszelkie stwierdzenia dotyczace przysztych kierunkéw rozwoju i zamierzen IBM moga zosta¢ zmienione lub
wycofane bez powiadomienia.

Publikacja ta zawiera przyktadowe dane i raporty uzywane w codziennej pracy. W celu kompleksowego ich
zilustrowania, podane przyktady zawieraja nazwiska osob prywatnych, nazwy przedsigbiorstw oraz nazwy produktow.
Wszystkie te nazwy/nazwiska sa fikcyjne i jakiekolwiek podobienstwo do istniejacych nazw/nazwisk jest catkowicie
przypadkowe.

Znaki towarowe

IBM, logo IBM i ibm.com sa znakami towarowymi lub zastrzezonymi znakami towarowymi International Business
Machines Corp. zarejestrowanymi w wielu systemach prawnych na calym swiecie. Pozostate nazwy produktow i ustug
moga by¢ znakami towarowymi IBM lub innych przedsigbiorstw. Aktualna lista znakéw towarowych IBM dostgpna
jest w serwisie WWW IBM, w sekcji "Copyright and trademark information" Informacje o prawach autorskich i
znakach towarowych), pod adresem [www.ibm.com/legal/copytrade.shtmi]

Intel, logo Intel, Intel Inside, logo Intel Inside, Intel Centrino, logo Intel Centrino, Celeron, Intel Xeon, Intel SpeedStep,
Itanium i Pentium sa znakami towarowymi lub zastrzezonymi znakami towarowymi Intel Corporation lub
przedsigbiorstw podporzadkowanych Intel Corporation w Stanach Zjednoczonych i w innych krajach.

Linux jest zastrzezonym znakiem towarowym Linusa Torvaldsa w Stanach Zjednoczonych i/lub w innych krajach.

Microsoft, Windows, Windows NT oraz logo Windows sa znakami towarowymi Microsoft Corporation w Stanach
Zjednoczonych i/lub w innych krajach.

UNIX jest zastrzezonym znakiem towarowym The Open Group w Stanach Zjednoczonych i/lub w innych krajach.

Java oraz wszystkie znaki towarowe i logo dotyczace jezyka Java sa znakami towarowymi lub zastrzezonymi znakami
towarowymi Oracle i/lub przedsigbiorstw afiliowanych.
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Indeks

Znaki specjalne

! symbole A * § w synonimach 181
& | () operatory regut 121
*lib 169

A

adresy (obiekt nielingwistyczny) 188
adresy IP (obiekt nielingwistyczny) 188
Adresy URL 13, 14
aktualizowanie 1
biblioteki 170, 171
szablony 152, 160
wezly modelowania 76
zasoby wezta i szablon 160
aktywacja obiektow nielingwistycznych 191
aminokwasy (obiekt nielingwistyczny) 188
analiza powiazan w tekscie (TLA) 47, 71,
139, 141, 197, 198, 199, 200, 201, 205, 207,
208, 209, 213
argumenty 210
edytor regut 197
edytowanie makriregut 197
eksplorowanie wzorcow 139
filtrowanie wzorcow 142
kiedy modyfikowa¢ 198
kolejnos¢ przetwarzania regut 209
makra 202
nawigacja wérod regut i makr 201
od czego zacza¢ 198
okreslanie, ktore biblioteki 197, 201
ostrzezenia w drzewie 201
panel data 143
Panel Visualization 148
przetwarzanie wielokrokowe 210
tryb zrédtowy 213
w weztach modelowania text mining 24
wezel TLA 47
wykres sieciowy 148
wylaczanie i usuwanie regut 208
wyniki symulacji 199, 200
wyswietlanie wykresow 148
analiza tekstu 2
antypowiazania 104

B

bez kategorii 92

biatka (obiekt nielingwistyczny) 188

biblioteka Budget 174

biblioteka Core 174

biblioteka Opinions 174

biblioteki 73, 165, 173
aktualizowanie 171
biblioteka Budget 174
biblioteka Core 174
biblioteka Opinions 174
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zmiana nazwy 168
biblioteki (domyslne) dostarczone z
produktem 165
bledy pisowni 187
budowanie

kategorie 2, 6, 101, 102, 105, 106, 107,

108, 109, 110, 113
skupienia 134
budowanie indeksu mapy poje¢ 86
budowanie kategorii 6, 101, 102
klasyfikacja wyjatkow powiazan 104
metoda wywodzenia rdzeni poje¢ 110

technika regut wspotwystgpowania 110

technika sieci semantyki 110

technika wtaczania poje¢ 110
buforowanie

Kanaty informacyjne WWW 13

wyniki wyodrgbniania danych w sesji

C

cyfry (obiekt nielingwistyczny) 188
czg$¢ mowy 192,195

D

dane
analiza powiazan w tekscie 139
budowanie kategorii 102, 105, 110
filtrowanie wynikow 83, 142
grupowanie 133
optymalizacja wynikow 86
panel data 99, 143
restrukturyzacja 50
tworzenie kategorii 91, 101, 113
wyodrgbnianie 79, 80, 140
wyodrgbnianie wzorcow powiazan w
tekscie 139
daszek (A) 181
daty (obiekt nielingwistyczny) 188, 191
definicje 95, 98
definicje wymuszone 192, 195
deskryptory 92

deskryptory (kontynuacja)
edytowanie w kategoriach
kategorie 95, 98
skupienia 137
wybor najlepszych 96
dezaktywacja obiektow
nielingwistycznych 191
dodawanie
biblioteki publiczne 166
deskryptory 96
dzwigki 75,76
elementy opcjonalne 182

131

lista termindéw do wykluczenia

pojecia do kategorii 130
synonimy 87, 181

termindéw do stownikow typow

typy 88
dokumenty 99, 143
lista 55
domyslne biblioteki 165
dopasowanie tekstu 99

E

e-mail (obiekt nielingwistyczny)

edycja
kategorie 130, 131
optymalizacja wynikow
wyodrgbniania 86
reguly kategorii 122

183

176

188

edytor zasobow 73, 151, 152, 153, 155, 185
152

modyfikowanie szablondw

przetaczanie si¢ migdzy zasobami

tworzenie szablonow 152
eksploracja tekstu 2
eksportowanie

biblioteki publiczne 169

predefiniowane kategorie

szablony 161
elementy opcjonalne 180

definicja 180

docelowy 182

dodawanie 182

usuwanie wpisow 182
etykieta

127

w celu ponownego uzycia kanaty

informacyjne WWW 13
etykiety kategorii 99

F

filtrowanie bibliotek 168
filtrowanie wynikow 83, 142
format daty

obiekty nielingwistyczne
format kompaktowy 125
format weigty 126

191

153

Formaty HTML dla kanatéw informacyjnych

WWW 13, 14
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Formaty RSS dla kanatow informacyjnych
WWW 13,14

G

generowanie form odmienionych
176
generowanie weziow i modeli
uzytkowych 76
godziny (obiekt nielingwistyczny) 188
gwiazdka (*)
stownik wykluczen 183
synonimy 181

173, 175,

H

HTTP/URL (nonlinguistic) 188

ignorowanie poje¢ 89

importowanie
biblioteki publiczne 169
predefiniowane kategorie 123
szablony 161

indeks mapy poje¢ 86

informacje z sesji 23, 24, 26

interaktywny pulpit roboczy 23, 24, 26, 67,

76
istotno$¢ odpowiedzi i kategorii 100

J

Jezyk
ustawianie jezyka docelowego dla
zasobow 187
jezyk docelowy 187

K

kategorie 19, 91, 92, 98, 130
budowanie 101, 102, 105, 110
deskryptory 95, 96, 98
dodawanie do 130
edycja 130, 131
etykiety 99
istotno$¢ 100
komentarze 99
modele uzytkowe kategorii eksploracji

tekstu 25
nazwy 99
ocenianie 92
optymalizacja wynikow 130
pakiety analizy tekstu 127, 128, 129
przenoszenie 131
reczne tworzenie 113
scalanie 132
splaszczanie 131
strategie 94
tworzenie 94, 109, 113
tworzenie nowej pustej kategorii 113
usuwanie 132
uzupetnianie 105, 110
wilasciwosci 99
zmiana nazwy 113

klawisze skrotow 77, 78
kolor czcionki 175
kolory
dla typow i termindw 175
stownik wykluczen 183
synonimy 181
ustawianie opcji kolorow 75
kolory niestandardowe 75
kolumna docs 92
komentarze
kategorii 99
komponentyzacja 105
komponentyzacja terminéw 105
konstruktor wyrazen 78

L

lektory ekranowe 77,78

liczba mnoga wyrazow 175
liczebnos¢ 109

liczebnos$¢ typu 109

lista rozszerzen w wezle file list 11
literaty tancuchowe 210

L

tadowanie szablonéw zasobow 26, 47, 160
faczenie kategorii 132

makra 202,203
mNonLingEntitities 204
mTopic 204

maksymalna liczba kategorii do

utworzenia 102

mapowanie poje¢ 84

mapy poje¢ 84, 86
budowanie indeksu 86

metoda wywodzenia rdzeni pojec¢

110

minimalna warto$¢ powiazania 102

mNonLingEntitities 204

model uzytkowy text mining 8
wilasciwosci modelu TMWBModelApplier

uzywane w skryptach 62

modele uzytkowe 23

generowanie z interaktywnego pulpitu
roboczego 76

102, 105,

modele uzytkowe kategorii 19, 23, 25, 39
modele uzytkowe poje¢ 19, 23, 25, 30, 31
modele uzytkowe kategorii 19, 39

budowanie za posrednictwem pulpitu 24
budowanie za posrednictwem wezta 25
generowanie 76
karta Fields 42
karta Model 39
karta podsumowania 42
karta Settings 40
pojecia jako zmienne albo rekordy 40
przyktad 42
wyniki 39

modele uzytkowe poje¢ 19, 30
budowanie za posrednictwem wezta 25
karta Fields 34
karta Model 31
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modele uzytkowe poje¢ (kontynuacja)
karta podsumowania 34
karta Settings 33
pojecia jako zmienne albo rekordy 33
pojecia uzywane do oceniania 31
przyktad 35
synonimy 32

mTopic 204

N

nawigacja za pomoca skrotow
klawiaturowych 77
nazewnictwo
biblioteki 168
kategorie 99
stowniki typow 179
nazwa kategorii 92
normalizacja 191
nowe kategorie 113
numery telefonéw (obiekt
nielingwistyczny) 188
numery ubezpieczenia spotecznego (obiekt
nielingwistyczny) 188

o)

obiekty nielingwistyczne
adresy 188
adresy e-mail 188
adresy HTTP/URL 188
adresy I[P 188
aminokwasy 188
biatka 188
cyfry 188
daty 188
format daty 191
godziny 188
normalizacja, NonLingNorm.ini 191
numery telefonow 188
numery ubezpieczenia spotecznego w
USA 188
procenty 188
wagi i miary 188
waluty 188
wlaczanie i wylaczanie 191
wyrazenia regularne, RegExp.ini 189
obliczanie warto$ci powiazan na podstawie
podobienstwa 135
ocenianie 92
pojecia 32
odmienione formy 105, 173, 175, 176
odstepy migdzy wyrazami 210
odtwarzanie zasobow 162
ogranicznik 75
ogranicznik globalny 75
opcje 74
opcje dzwigku 76
opcje sesji 75
opcje wyswietlania (kolory) 75
opcje dopasowania 173, 175, 176
opcje dzwigku 76
operator reguty I 121
operator reguty LUB 121
operator regulty NIE 121
operator wykluczenia 210



operatory boolowskie 121
operatory w regutach & | I() 121
optymalizacja wynikow
dodawanie poje¢ do typow 88
dodawanie synoniméw 87
kategorie 130
tworzenie typow 88
wykluczanie poje¢ 89
wymuszanie wyodrgbnianie pojgcia 90
wyniki wyodrgbniania 86
otwieranie szablonow 159

P

pakiety analizy tekstu 127, 128, 129
fadowanie 129
pakiety analizy tekstu *.tap 127, 128, 129
panel data
przycisk wyswietlania 92
widok kategorii i poje¢ 99
widok text link analysis 143
panel kategorii 92
panel Visualization 145
Widok Text Link Analysis 148
wykres sieciowy poje¢ 147
wykres sieciowy poje¢ TLA 148
wykres sieciowy skupien 147, 148
wykres sieciowy typu 148
pliki .doc/.docx/.docm do eksploracji
tekstu 11
pliki .htm/.html files do eksploracji tekstu 11
pliki .pdf do eksploracji tekstu 11
pliki .ppt/.pptx/.pptm do eksploracji
tekstu 11
pliki .rtf do eksploracji tekstu 11
pliki .shtml do eksploracji tekstu 11
pliki .txt/.text do eksploracji tekstu 11
pliki .xIs/.xlsx/.xIsm do eksploracji tekstu 11
pliki .xml do eksploracji tekstu 11
Pliki Microsoft Excel .xls/.xlsx
eksportowanie predefiniowanych
kategorii 127
importowanie predefiniowanych
kategorii 123
plaski format listy 124
pojecia 19, 31
dodawanie do kategorii 95, 98, 130
dodawanie do typow 88
filtrowanie 83
jako zmienne albo rekordy przy
ocenianiu 33, 40
mapy poje¢ 84
najlepsze deskryptory 96
tworzenie typow 86
w kategoriach 95, 98
w skupieniach 137
wykluczanie z wyodrgbniania 89
wymuszanie wyodrgbniania 90
wyodrgbnianie 79
ponowne uzycie
Kanaty informacyjne WWW 13
wyniki wyodrgbniania danych w sesji 24
powiazania w skupieniach 133
powiazania wewngtrzne 133
powiazania zewngtrzne 133
predefiniowane kategorie 123, 127
format kompaktowy 125

predefiniowane kategorie (kontynuacja)

format weigty 126

ptaski format listy 124
przeciaganie i upuszczanie 113
przenoszenie

kategorie 131

stowniki typow 179
przetwarzanie wielokrokowe 210
przycisk oceniania 92
przycisk wyswietlania 92
publikowanie 171

biblioteki 170

dodawanie bibliotek publicznych 166
pulpit roboczy 23, 24, 26

R

ramki kodu 123
reguty 207
edycja 122
operatory boolowskie 121
sktadnia 114
technika regut wspotwystepowania 108
tworzenie 121
usuwanie 122
reguty kategorii 114, 120, 121, 122
na podstawie wspotwystapien poje¢ 102,
105, 108, 110
przyktady 120
reguly wspotwystgpowania 102, 105, 110
sktadnia 114
z wyrazow synonimicznych 102, 105,
110
rekordy 99, 143

S

scalanie kategorii 132
sekcje obstugi jezykow 185, 192
definicje wymuszone 192, 195
skroty 192, 195
wzorce wyodrgbniania 192
separatory 75
separatory tekstu 75
sktadniki
dodawanie do stownika wykluczen 183
kolor 175
odmienione formy 173
opcje dopasowywania 173
wymuszanie terminow 178
znajdowanie w edytorze 167
skroty 192, 195
skroty klawiaturowe 77, 78
skupienia 24, 70, 133
budowanie 134
deskryptory 137
eksplorowanie 136
informacje 133
warto$ci powiazan na podstawie
podobienstwa 135
wykres sieciowy poje¢ 147
wykres sieciowy skupien 147, 148
stownik typow 165
dodawanie terminéw 176
elementy opcjonalne 173
przenoszenie 179

stownik typow (kontynuacja)
synonimy 173
tworzenie typow 175
typy wbudowane 174
usuwanie 180
wytaczanie 180
wymuszanie terminow 178
zmiana nazwy 179
stownik typu Budget 174
stownik typu Location 174
stownik typu Negative 174
stownik typu Organization 174
stownik typu Person 174
stownik typu Positive 174
stownik typu Product 174
stownik typu Uncertain 174
stownik typu Unknown 174
stownik wykluczen 165, 183
stownik zastapien 165, 180, 181, 182
stowniki 73, 173
typy 165,173
wykluczenia 165, 173, 183
zastapienia 165, 173, 180
sptaszczanie kategorii 131
symulowanie wynikow analizy powiazan w
tekscie 199, 200
definiowanie danych 199
synchronizowanie bibliotek 170, 171
synonimy 86, 180
definicja 180
dodawanie 87, 181
kolory 181
symbole ! A *§ 181
terminy docelowe 181
usuwanie wpiséw 182
w modelach uzytkowych poje¢ 32
wyjatki grupowania rozmytego 187
szablony 5,47, 73,139, 151, 155
importowanie i eksportowanie 161

modyfikowanie lub zapisywanie jako 152

okno dialogowe fadowania szablonu
zasobow 26

otwieranie szablonow 159

przetaczanie si¢ migdzy szablonami 153

przywracanie 162

TLA 153

tworzenie kopii zapasowej 162

tworzenie na podstawie zasobow 152

usuwanie 161

zapisywanie 160

zmiana nazwy 161

szablony zasobow 5, 47,73, 139, 151, 155

T

tabele 78

technika regut wspotwystgpowania 102, 105,

108, 110

technika sieci semantyki 102, 105, 107, 110
technika wiaczania poje¢ 102, 105, 106, 110
techniki

liczebnos¢ 109

przeciaganie i upuszczanie 113

reguly wspotwystgpowania 102, 105,

108, 110
sieci semantyczne 102, 105, 107, 110
wiaczanie poje¢ 102, 105, 106, 110
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techniki (kontynuacja)

wywodzenie rdzenia pojecia 102, 105,
110
techniki lingwistyczne 2
Template Editor 155, 156, 159, 160, 161, 162

aktualizowanie zasobow w wezle 160
biblioteki zasobow 165
importowanie i eksportowanie 161
otwieranie szablonow 159
usuwanie szablonéw 161
wychodzenie z edytora 162
zapisywanie szablonéw 160
zmiana nazwy szablonéw 161
terminy
dodawanie do typow 176
terminy docelowe 181
terminy poje¢ 32
TextMiningWorkbench, wlasciwosci uzywane
w skryptach 61
TLA 153
TMWBModelApplier, whasciwosci uzywane w
skryptach 62
tryb dzielenia na podzbiory 21
tryb edycji 149
tryb eksploracji 149
tworzenie
biblioteki 166
elementy opcjonalne 182
kategorie 25,94, 101, 113
kategorie z regutami 114
reguly kategorii 114, 121
stowniki typéw 175
synonimy 86, 87, 181
szablon na podstawie zasobow 152
szablony 160
typy 88
wezly modelowania i modele uzytkowe
kategorii 76
wykluczanie pozycji stownika 183
tworzenie kategorii 6, 91
korzystanie z technik 105
metody 94

reguty wspolwystgpowania 102, 105, 108
reczne 113
sieci semantyczne 102, 105, 107

stosowanie technik grupowania 102

techniki lingwistyczne 101, 110

techniki oparte na liczebnosci 109

wilaczanie poje¢ 102, 105, 106

wywodzenie rdzenia pojecia 102, 105
tworzenie kopii zapasowej zasobow 162
tworzenie szablonow z zasobow 152
typy 173

dodawanie poje¢ 86

filtrowanie 83, 142

kolor domyslny 75, 175

liczebnos¢ typu 109

stowniki 165

tworzenie 175

typy wbudowane 174

wyodrgbnianie 79

znajdowanie w edytorze 167
tytuty 55
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U

uruchom interaktywny pulpit roboczy 23
ustawienia 74, 75, 76
ustawienia wyswietlania 75
usuwanie
biblioteki 169
elementy opcjonalne 182
kategorie 132
reguly kategorii 122
stowniki typow 180
synonimy 182
szablony zasobow 161
wykluczone wpisy 183
wylaczanie bibliotek 168
uzupetnianie kategorii 110

W

wagi/miary (obiekt nielingwistyczny) 188
waluty (obiekt nielingwistyczny) 188
warto$ci powiazan 135
wartosci powiazan na podstawie
podobienstwa 135
wartosci procentowe (obiekt
nielingwistyczny) 188
wezet file list 8, 11, 12
karta Settings 11
lista rozszerzen 11
pozostate karty 12
przyktad 12
Wrhasciwosci skryptow 59
wezel jezyka 11, 17, 60
karta Settings 17
Wihasciwosci skryptow 60
wezel modelowania eksploracja tekstu 8, 19,
20, 59
aktualizowanie 76
generowanie nowego wezta 76
karta Expert 27
karta Fields 21
karta Model 23
przyktad 29
wiasciwosci wezta TextMiningWorkbench
uzywane w skryptach 61

wezel proby
podczas eksploracji tekstu 29
wezel przegladarki 8, 55, 56

do eksploracji tekstu 55
karta Settings 55
przyktad 56
wezel Text Link Analysis
64
buforowanie wynikéw analizy TLA 51
karta Expert 49
karta Fields 47
przyktad 51
restrukturyzacja danych 50
Wiasciwoscei skryptow 64
wyniki 50
wezet Web Feed 8, 11, 13, 14, 59
etykieta na potrzeby buforowania i
ponownego uzycia 13
karta Content 16
karta Input 13
karta Records 14
przyktad 16

8,47, 49, 50, 51,
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wezet Web Feed (kontynuacja)
Wrhasciwosci skryptow 59
wezty
analiza powiazan w tekscie
file list 8, 11
jezyk 17
model uzytkowy poje¢ 30
model uzytkowy text mining 8
modele uzytkowe kategorii 39
przegladarka eksploracji tekstu 8, 55
Web Feed 8, 13
wezet modelowania eksploracja tekstu 8,
20
wezly zrodtowe
file list 8, 11
Web Feed 8, 13
widok kategorii 1 pojgé
panel data 99
panel kategorii 92
widok skupien 70
widoki na interaktywnym pulpicie roboczym
analiza powiazan w tekscie 71
categories and concepts 67, 91
edytor zasobow 73
skupienia 70
wlasciwosci 74, 75, 76
kategorie 99
wlasciwosci languageidentifier 60
wiasciwosci webfeednode 59
wlasciwosci wezla filelistnode w
skryptach 59
wlasciwosci wezta textlinkanalysis 64
wlaczanie obiektow nielingwistycznych 191
wspotuzytkowanie bibliotek 170
aktualizowanie 171
dodawanie bibliotek publicznych 166
publikowanie 171
wszystkie dokumenty 92
wybieranie poj¢¢ uzywanych przy
ocenianiu 32
wyciszanie dzwigku 76
wyjatki grupowania rozmytego
wyjatki powiazan 104
wykluczanie
na podstawie powiazan kategorii 104
poje¢ z wyodrgbniania 89
wylaczanie bibliotek 168
wytaczanie stownikow 180, 182
wylaczanie wpisow wykluczen 183
z wykluczania rozmytego 187
wykres sieciowy poje¢ 147
wykres sieciowy poje¢ TLA 148
wykres sieciowy typu 148
wykres stupkowy kategorii 146
wykres/tabela sieciowa kategorii 146
wykresy 148
edycja 149
mapy poje¢ 84
tryb eksploracji 149
wykres sieciowy poje¢ 147
wykres sieciowy poje¢ TLA 148
wykres sieciowy skupien 147, 148
wykres sieciowy typu 148
wykresy sieciowe
wykres sieciowy poje¢ 147
wykres sieciowy poje¢ TLA 148
wykres sieciowy skupien 147, 148

8,47

67,91

185, 187



wykresy sieciowe (kontynuacja) zawijanie kolumn 75

wykres sieciowy typu 148 zmiana
wykrzyknik () 181 szablony 153, 159
wylaczanie zmiana nazwy
biblioteki 168 biblioteki 168
obiekty nielingwistyczne 191 kategorie 113
stowniki synonimow 187 stowniki typow 179
stowniki typéw 180 szablony zasobow 161
stowniki wykluczen 183 Zmienna identyfikacyjna 47
stowniki zastapien 182 zmienne dokumentow 55
wymuszanie znajdowanie i zastgpowanie (zasoby
sktadniki 178 zaawansowane) 186
wyodrgbnianie poje¢ 90 znajdowanie terminow i typow 167
wyniki wyodrgbniania 79 znak dolara (§) 181

filtrowanie wynikow 83, 142
wyodrebnianie 1,2, 5,49, 79, 80, 165, 173
optymalizacja wynikow 86
terminy pojedyncze 5
wymuszanie wyrazow 90
wyniki wyodrgbniania 79
Wzorce TLA 140
wzorce z danych 47
wyswietlanie
analiza powiazan w tekscie 148
biblioteki 168
dokumenty 55
skupienia 147
wyswietlanie kolumn w panelu danych 143
wyswietlanie kolumn w panelu kategorii 92
wzorce 24,47,79, 139, 141, 197, 201, 205
argumenty 210
edytor regut powiazan w tekscie 197
przetwarzanie wielokrokowe 210
wzorce poje¢ 141
wzorce typow 141
wzorce wyodrgbniania 192

Z

zamykanie sesji 77
zapisywanie
interaktywny pulpit roboczy 76
Kanaty informacyjne WWW 13
szablony 160
wyniki wyodrgbniania danych w sesji 24
zasoby 162
zasoby jako szablony 152
zarzadzanie
biblioteki lokalne 168
biblioteki publiczne 169
kategorie 130
zasoby
biblioteki domyslne dostarczone z
produktem 165
edycja zasobow zaawansowanych 185
przetaczanie si¢ miedzy zasobami z
szablonow 153
przywracanie 162
tworzenie kopii zapasowej 162
zasoby lingwistyczne 47, 165
pakiety analizy tekstu 127, 128, 129
szablony 151
szablony zasobow 155
zasoby zaawansowane 185
znajdowanie i zastgpowanie w
edytorze 186
zastgpowanie zasobow z szablonu 153
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